Symantec™ Workflow 8.0 User Guide

Legal Notice

Copyright © 2016 Symantec Corporation. All rights reserved.

Symantec, the Symantec Logo, the Checkmark Logo are trademarks or registered trademarks of Symantec Corporation or its affiliates in the U.S. and other countries. Other names may be trademarks of their respective owners.

This Symantec product may contain third party software for which Symantec is required to provide attribution to the third party (“Third Party Programs”). Some of the Third Party Programs are available under open source or free software licenses. The License Agreement accompanying the Software does not alter any rights or obligations you may have under those open source or free software licenses. Please see the Third Party Legal Notice Appendix to this Documentation or TPIP ReadMe File accompanying this Symantec product for more information on the Third Party Programs.

The product described in this document is distributed under licenses restricting its use, copying, distribution, and decompilation/reverse engineering. No part of this document may be reproduced in any form by any means without prior written authorization of Symantec Corporation and its licensors, if any.

THE DOCUMENTATION IS PROVIDED “AS IS” AND ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH DISCLAIMERS ARE HELD TO BE LEGALLY INVALID. SYMANTEC CORPORATION SHALL NOT BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, PERFORMANCE, OR USE OF THIS DOCUMENTATION. THE INFORMATION CONTAINED IN THIS DOCUMENTATION IS SUBJECT TO CHANGE WITHOUT NOTICE.

The Licensed Software and Documentation are deemed to be commercial computer software as defined in FAR 12.212 and subject to restricted rights as defined in FAR Section 52.227-19 “Commercial Computer Software - Restricted Rights” and DFARS 227.7202, et seq. “Commercial Computer Software and Commercial Computer Software Documentation,” as applicable, and any successor regulations, whether delivered by Symantec as on premises or hosted services. Any use, modification, reproduction release, performance, display or disclosure of the Licensed Software and Documentation by the U.S. Government shall be solely in accordance with the terms of this Agreement.
Symantec Corporation
350 Ellis Street
Mountain View, CA 94043

http://www.symantec.com
Technical Support

Symantec Technical Support maintains support centers globally. Technical Support’s primary role is to respond to specific queries about product features and functionality. The Technical Support group also creates content for our online Knowledge Base. The Technical Support group works collaboratively with the other functional areas within Symantec to answer your questions in a timely fashion. For example, the Technical Support group works with Product Engineering and Symantec Security Response to provide alerting services and virus definition updates.

Symantec’s support offerings include the following:

- A range of support options that give you the flexibility to select the right amount of service for any size organization
- Telephone and/or Web-based support that provides rapid response and up-to-the-minute information
- Upgrade assurance that delivers software upgrades
- Global support purchased on a regional business hours or 24 hours a day, 7 days a week basis
- Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our website at the following URL:

support.symantec.com

All support services will be delivered in accordance with your support agreement and the then-current enterprise technical support policy.

Contacting Technical Support

Customers with a current support agreement may access Technical Support information at the following URL:

support.symantec.com

Before contacting Technical Support, make sure you have satisfied the system requirements that are listed in your product documentation. Also, you should be at the computer on which the problem occurred, in case it is necessary to replicate the problem.

When you contact Technical Support, please have the following information available:

- Product release level
- Hardware information
- Available memory, disk space, and NIC information
- Operating system
- Version and patch level
- Network topology
- Router, gateway, and IP address information
- Problem description:
  - Error messages and log files
  - Troubleshooting that was performed before contacting Symantec
  - Recent software configuration changes and network changes

Licensing and registration

If your Symantec product requires registration or a license key, access our technical support Web page at the following URL:

www.symantec.com/business/support/

Customer service

Customer service information is available at the following URL:

www.symantec.com/business/support/

Customer Service is available to assist with non-technical questions, such as the following types of issues:

- Questions regarding product licensing or serialization
- Product registration updates, such as address or name changes
- General product information (features, language availability, local dealers)
- Latest information about product updates and upgrades
- Information about upgrade assurance and support contracts
- Information about the Symantec Buying Programs
- Advice about Symantec's technical support options
- Nontechnical presales questions
- Issues that are related to CD-ROMs, DVDs, or manuals
Support agreement resources

If you want to contact Symantec regarding an existing support agreement, please contact the support agreement administration team for your region as follows:

- Asia-Pacific and Japan: customercare_apj@symantec.com
- Europe, Middle-East, and Africa: semea@symantec.com
- North America and Latin America: supportsolutions@symantec.com
### Technical Support

![Image](https://via.placeholder.com/150)

### Section 1  Introducing Workflow

<table>
<thead>
<tr>
<th>Chapter 1  Introducing Workflow</th>
</tr>
</thead>
<tbody>
<tr>
<td>28</td>
</tr>
</tbody>
</table>

- About Symantec Workflow .......................... 28
- How Workflow works .................................. 29
- What you can do with Workflow ................. 30
- Other things to know ................................. 31
- About the Workflow Solution Center ............. 31
- Downloading Workflow content from the Solution Center 31
- Workflow video library ................................ 32
- Where to get more information .................... 36

### Chapter 2  Understanding Workflow concepts

<table>
<thead>
<tr>
<th>Core architectural components of Workflow</th>
</tr>
</thead>
<tbody>
<tr>
<td>39</td>
</tr>
</tbody>
</table>

- About Workflow Designer ........................... 41
- About Workflow Server ............................... 42

### Section 2  Installing and upgrading Workflow

<table>
<thead>
<tr>
<th>Chapter 3  Preparing your Workflow installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>46</td>
</tr>
</tbody>
</table>

- About installing Workflow .......................... 46
- Assembling your Workflow team .................... 47
- Configuration options for Workflow installations 49
- Workflow scalability ................................... 50
- Recommendations for scaling the Workflow Server and its dedicated SQL Server .......................... 52
- About load balancing your Workflow environment 53
- SQL Server configuration options for Workflow ........ 54
- Hard drive configuration options for an off-box SQL Server 55
- Throughput metrics of SQL Server for Workflow .................. 56
- Database sizing for SQL Server for Workflow .................. 57
Chapter 4 Installing Workflow ........................................................ 65
Process for installing Workflow ..................................................... 65
Information to collect for your Workflow installation ..................... 66
Setting up the Workflow computer ................................................. 69
  Installing SQL Server support components on the Workflow computer ................................................................. 71
Creating a dedicated service account ............................................. 73
Downloading the Workflow Installer ............................................. 74
Installing Workflow .................................................................... 74
  Configuring the dedicated account to be your Process Manager’s run-time service account ................................................. 92

Chapter 5 Upgrading Workflow ..................................................... 94
Process for upgrading Workflow ................................................... 94
Upgrading Workflow .................................................................. 96

Section 3 Configuring Workflow .................................................. 98

Chapter 6 Configuring Workflow ................................................ 99
Process for configuring Workflow ............................................... 99
Performing post-migration tasks .................................................. 101

Chapter 7 Managing Active Directory connections ...................... 103
About Active Directory synchronization ..................................... 104
Configuring Active Directory sync profiles ................................ 105
Managing Active Directory server connections ............................ 107
Adding Active Directory server connections ............................... 108
Editing the settings of an Active Directory server connection ........ 109
Deleting an Active Directory server connection ........................... 110
Testing an Active Directory server connection ............................ 111
Selecting Active Directory as the authentication method ................ 112
Managing Active Directory sync profile schedules ...................... 112
### Chapter 9 About workflow projects

- About Workflow Designer Project Types .................................................. 147
  - About Web Application Project Types ........................................ 148
  - About Decision Only Project Types .......................................... 149
  - About Workflow Project Types ............................................... 150
  - About Forms (Web) Project Types ..................................... 150
  - About Integration Project Types ........................................ 152
  - About Monitoring Project Types ...................................... 152

**Workflow Designer tool** ................................................ 152
- About the project workspace .................................................. 153
- About the component toolbox .................................................. 154
- Searching for components in the component toolbox ............. 154
- Searching for components in an open workflow project ........ 156
- About Project metadata and property tabs ........................... 156
- About Workflow Designer project trees .................................. 157
- About project metadata .......................................................... 157
- Viewing the project metadata .................................................. 158
- Project data tabs ................................................................. 158
- Viewing project data tabs ....................................................... 170
- Generating project reports ....................................................... 170
- Setting up how a project runs .................................................. 171

### Chapter 10 About workflow components

- About workflow components ..................................................... 173
- Start and End components ......................................................... 174
- Adding components to a project .................................................. 175
- Connecting components ............................................................ 175
- Component editors ..................................................................... 176
- Viewing component help ............................................................ 176
- Viewing the component help (wiki pages) ............................. 176
- Contributing to the component pages ..................................... 177
- Copying components to another model ................................ 179
- Copying properties to other components ................................ 179
- Adding components to your personal library .......................... 180

### Chapter 11 Working with projects

- About project data ................................................................. 181
- About data types ..................................................................... 182
- About input and output data for project models ..................... 183
- About input and output variables for components ................ 184
- About mapping data ............................................................... 185
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About the filter generator</td>
<td>263</td>
</tr>
<tr>
<td>Table Source page</td>
<td>263</td>
</tr>
<tr>
<td>Column Manager page</td>
<td>265</td>
</tr>
<tr>
<td>About the query script generator</td>
<td>265</td>
</tr>
<tr>
<td>Connection page</td>
<td>266</td>
</tr>
<tr>
<td>Connection String page</td>
<td>267</td>
</tr>
<tr>
<td>Properties Name page</td>
<td>268</td>
</tr>
<tr>
<td>Fields page</td>
<td>269</td>
</tr>
<tr>
<td>About the stored procedure caller generator</td>
<td>269</td>
</tr>
<tr>
<td>Connection page</td>
<td>269</td>
</tr>
<tr>
<td>Connection String page</td>
<td>271</td>
</tr>
<tr>
<td>Properties Name page</td>
<td>272</td>
</tr>
<tr>
<td>Fields page</td>
<td>273</td>
</tr>
<tr>
<td>About the Multiple generator container</td>
<td>273</td>
</tr>
<tr>
<td>Generators Management page</td>
<td>273</td>
</tr>
<tr>
<td>Creating components in the Multiple generator container</td>
<td>273</td>
</tr>
<tr>
<td>Editing components in the Multiple generator container</td>
<td>274</td>
</tr>
<tr>
<td>About the table generator</td>
<td>274</td>
</tr>
<tr>
<td>Connection page</td>
<td>275</td>
</tr>
<tr>
<td>Connection String page</td>
<td>276</td>
</tr>
<tr>
<td>Components page</td>
<td>277</td>
</tr>
<tr>
<td>Select components page</td>
<td>278</td>
</tr>
<tr>
<td>About the fast table generator</td>
<td>278</td>
</tr>
<tr>
<td>About the DTD generator</td>
<td>278</td>
</tr>
<tr>
<td>File Selecting page</td>
<td>279</td>
</tr>
<tr>
<td>Schema Editing page</td>
<td>279</td>
</tr>
<tr>
<td>Read/Write components page</td>
<td>279</td>
</tr>
<tr>
<td>About the XML Schema generator</td>
<td>280</td>
</tr>
<tr>
<td>About the Excel generator</td>
<td>280</td>
</tr>
<tr>
<td>Definitions page</td>
<td>280</td>
</tr>
<tr>
<td>Null strings page</td>
<td>280</td>
</tr>
<tr>
<td>Read/Write components page</td>
<td>281</td>
</tr>
<tr>
<td>Rows page</td>
<td>281</td>
</tr>
<tr>
<td>Customize columns page</td>
<td>282</td>
</tr>
<tr>
<td>Definitions Editing page</td>
<td>282</td>
</tr>
<tr>
<td>About the Active Directory generator</td>
<td>283</td>
</tr>
<tr>
<td>Connection page</td>
<td>283</td>
</tr>
<tr>
<td>About the SharePoint Lists generator</td>
<td>284</td>
</tr>
<tr>
<td>Setup Connection page</td>
<td>285</td>
</tr>
<tr>
<td>Select Lists page</td>
<td>285</td>
</tr>
<tr>
<td>Components page</td>
<td>286</td>
</tr>
<tr>
<td>About the Fixed Length generator</td>
<td>287</td>
</tr>
<tr>
<td>File selecting page for Fixed Length generator</td>
<td>288</td>
</tr>
</tbody>
</table>
Chapter 14 Working with Webforms

About Web forms ................................................................. 313
About creating a Web form .................................................. 313
About using data to build a Web form ................................. 314
About ThisFormData ............................................................ 315
Setting up a custom event on a form ..................................... 315
About form components ....................................................... 316
  Common properties in form components .......................... 316
  Auto Exit Page On Timer .................................................... 319
  Button Group .................................................................... 320
  Drop Down Menu .............................................................. 321
  Dynamic Button ................................................................. 322
  Image Button .................................................................... 325
  Image Map ........................................................................ 326
  Link Button ....................................................................... 326
  Hover Button .................................................................... 327
  Spell Check Button ............................................................ 328
  Spell Check ........................................................................ 328
  Ajax Label .......................................................................... 329
  ASCII Merge Label ............................................................ 329
  HTML Editor ...................................................................... 330
  HTML Merge ...................................................................... 330
  Image Button List ............................................................... 331
  List Items .......................................................................... 332
  Panel ................................................................................. 333
  Mail to Button .................................................................... 333
  Mask Edit .......................................................................... 334
  Multiline Text Box .............................................................. 335
  Numeric Stepper ................................................................. 336
  Numeric Text Box ............................................................... 337
  Text Box ........................................................................... 338
  Google Maps ....................................................................... 339
  Advanced Check Box List .................................................. 340
  Check Box .......................................................................... 341
  Check Box List .................................................................... 342
  Calendar ............................................................................. 343
  Date Picker ......................................................................... 344
  Date Time Picker ............................................................... 345
### Section 5 Using Process Manager

#### Chapter 16 About Process Manager

- About Process Manager ............................................................... 385
- Opening Process Manager .......................................................... 386
- About Process Manager pages ................................................... 387
- Process Manager tabs ................................................................. 387
- About Process Manager and tasks ................................................. 388
- About profiles ............................................................................. 389
- Setting your opening portal page .................................................. 389
- Symbols in Process Manager ...................................................... 389
- About the Process View page ...................................................... 390
- About document types ............................................................... 392
- Actions in the Process View page ................................................ 392
- Setting the Process View page to open another task ................. 393
- About the tag cloud .................................................................... 394

#### Chapter 17 Managing the portal

- About the Manage Pages page ................................................... 396
- Adding new Process Manager pages ............................................ 397
- Add Page page .......................................................................... 399
- New Page Wizard: Step 2 page .................................................... 400
- Viewing the settings of a page ...................................................... 401
- Adding a root page ..................................................................... 401
- Importing a page ........................................................................ 402
- Going to a page .......................................................................... 403
- Adding a sub-page ...................................................................... 403
- About customizing Process Manager pages ............................... 404
- Enabling the customization of a Process Manager page ............... 404
- Customizing a Process Manager page (administrator) .................. 405
- Customizing your Process Manager pages (non-administrator) ... 406
- Process Manager master settings ................................................. 406
- About the Process Manager portal master settings ...................... 419
- Editing the Process Manager portal master settings .................... 419
- Options on the Site Actions drop-down list .................................. 420
- Adding a Web Part to a Process Manager page ............................ 422
- Editing a Web Part on a Process Manager page ............................ 423
- Sharing a Process Manager page ............................................... 424
- Editing a Process Manager page ................................................ 425
- Deleting a page .......................................................................... 426
Chapter 18 Managing Workflow processes in Process Manager

About the Workflow tab ................................................................. 433
Delegating tasks ........................................................................ 434
Opening a task by ID ................................................................. 434
Performing an action on multiple tasks at once ......................... 435
Viewing a task or process in Process Manager ......................... 435
Setting up users to view the process view page ......................... 435
Setting up workflow task integration between Workflow Designer and Process Manager ................. 436

Chapter 19 Managing documents in Process Manager

About document management ....................................................... 439
About the Documents page ........................................................... 440
About the actions that you can perform on documents ................. 441
About simple and advanced files in the document manager ........ 442
Adding a new document (Simple file) .............................................. 443
Adding a new document (Advanced file) ........................................ 444
Searching for documents .............................................................. 445
Adding a document category ......................................................... 445
Editing a document category ......................................................... 446
Adding a document subcategory .................................................... 447
Category and Subcategory dialog boxes ....................................... 447
Deleting a document category ....................................................... 449
Displaying the document category history .................................... 450
Adding documents to additional categories ................................. 451
Using the document viewer ......................................................... 451
Setting category permissions for a document .............................. 452
Creating expected document messages ....................................... 453
Add Advanced Document dialog box .......................................... 454
Downloading documents .............................................................. 455
Downloading ZIP files .................................................................. 456
Viewing documents .................................................................
Viewing document versions .......................................................... 457
Viewing the document history ........................................................ 457
Editing document data .................................................................. 458
Adding a new document version .................................................... 458
Promoting a document version ...................................................... 459
Setting document permissions ....................................................... 460
Emailing documents .................................................................... 460
Deleting documents .................................................................... 461
Adding a document with a workflow project ................................. 462

Chapter 20  Managing the Knowledge Base and discussions in
Process Manager .......................................................................... 464

About the knowledge base and discussions ................................. 465
Managing categories ..................................................................... 466
Adding a knowledge base article ................................................... 467
Adding a Bulletin board ............................................................... 468
Adding a Wiki ............................................................................. 468
Adding a FAQ ............................................................................ 469
Working with articles .................................................................... 469
Adding a new entry to an article .................................................... 470
Setting permissions for a knowledge base entry ........................... 471
Adding a discussion ..................................................................... 472
Working with discussions ............................................................. 472
Adding a new thread to a discussion .............................................. 473

Chapter 21  Managing schedules in Process Manager .................... 474

About schedules .......................................................................... 474
Adding a schedule ....................................................................... 475
Add Schedule dialog box ............................................................. 476
Working with schedules ............................................................... 477

Chapter 22  Managing data in Process Manager .............................. 479

About data management .............................................................. 479
Working with document types ..................................................... 480
Working with document category types ...................................... 481
Adding a user relationship type ................................................... 482
About the Lists and Profiles page ................................................ 483
Adding a profile definition .......................................................... 483
Editing a profile definition .......................................................... 485
Viewing profiles ........................................................................ 486
Deleting a profile definition .......................................................... 486
Adding a new sub report .............................................................. 544
Creating a standard report ............................................................ 545
Setting up or modifying the data in standard reports .................... 546
Customizing the layout of grid standard reports ............................ 547
Setting up or modifying Web Service access for standard reports .... 548
Customizing filtering and sorting for standard reports .................... 549
Modifying standard reports .......................................................... 550
Setting permissions for reports .................................................... 551
Exporting a report definition ......................................................... 551
Copying a report ......................................................................... 552
Adding reports to a portal page ..................................................... 553
Adding report categories ............................................................. 553
Adding report sub categories ......................................................... 554
Deleting report categories ............................................................ 554
Setting report category permissions .............................................. 556
Adding reports to additional categories ........................................... 556
Deleting reports .......................................................................... 557
Add/Edit Standard Report dialog box ............................................ 557
Displaying reports in print view .................................................... 560
Importing report categories ........................................................ 560
Importing reports ....................................................................... 561
Adding a report schedule ............................................................ 561
Applying a schedule to a report ..................................................... 562

Section 6 Integrating Workflow ................................................... 567

Chapter 28 Integrating Workflow with the Symantec Management Platform ........................................... 568

About Workflow and the Symantec Management Platform .......... 568
  About how Workflow connects to the Symantec Management Platform ........................................ 569
  Setting up your first use of Workflow Designer with the Symantec Management Platform ............ 571
  About design-time and run-time Symantec Management Platform credentials ............................. 572
  Running the Symantec Management Platform component generators ........................................ 573
Workflow Enterprise Management page ..................................... 574
  About Workflow environments .................................................. 576
Workflow Enterprise Management Environment page ................. 576
Workflow Enterprise Management Workflow Servers page .......... 583
Chapter 43  Workflow Explorer ................................................................. 638

About Workflow Explorer ................................................................. 638
Viewing Workflow Explorer ............................................................... 639
About SymQ ................................................................................... 639
    About logging with SymQ ............................................................ 640
SymQ Configuration page ................................................................. 641
    Adding to SymQ configurations .................................................. 641
    Changing an exchange configuration type ................................... 642
    Adding a new exchange configuration ........................................ 642
    Adding a new exchange in an exchange configuration .................. 643
    Editing and deleting exchanges ............................................... 643
Current Running Processes page ...................................................... 644
    Configuring logging levels ...................................................... 645
SymQ Explorer page ..................................................................... 645
    About exchanges ................................................................... 646
    Exchange properties ............................................................. 650
    Monitoring message exchanges .............................................. 650
Log Viewer page ........................................................................ 651
    Viewing log messages ........................................................... 651
Credential page ........................................................................... 651
Business TimeSpan Configuration page ........................................... 652
Directory Servers Groups page ...................................................... 652
    Setting up Service Catalog failover ........................................... 653
    Adding the directory servers that provide failover support .......... 654
    Adding server groups ............................................................ 655
    Establishing failover for Service Catalog processes ................. 656

Section 8  Settings and reference material ....................................... 657

Chapter 44  Workflow Designer preferences ..................................... 658
    Editing Workflow Designer preferences .................................... 658
Chapter 45  Symantec Component Datatypes .................................... 659
    Symantec component datatypes ................................................ 659
Appendix A  Workflow support matrix .............................................. 663
    Workflow 8.0 support matrix .................................................. 663
Introducing Workflow

- Chapter 1. Introducing Workflow
- Chapter 2. Understanding Workflow concepts
Introducing Workflow

This chapter includes the following topics:

- About Symantec Workflow
- How Workflow works
- What you can do with Workflow
- Other things to know
- About the Workflow Solution Center
- Workflow video library
- Where to get more information

About Symantec Workflow

Symantec Workflow is a graphical .NET application and security process development framework.

You can use Workflow to build business and security processes, which are definable, repeatable, controllable, auditable, and reduce overall workload. The Workflow framework also lets you create Workflow processes that integrate Symantec tools into your organization's unique business processes.

For more information, see the following topics:

See “About Symantec Workflow” on page 31.

See “How Workflow works” on page 29.

See “What you can do with Workflow” on page 30.

See “Core architectural components of Workflow” on page 39.
How Workflow works

Workflow is a security process development framework that you can use to create both automated business processes and security processes. These processes provide for increased repeatability, control, accountability, and a reduced overall workload. The Workflow framework lets you create the processes that integrate tools into your organization's unique business processes. Workflow works with directories, data stores, and both Symantec and non-Symantec applications.

After Workflow is deployed, it can be initiated in a number of ways:

- By an end user using a service catalog request
- By another application using an Internet service call
- By an auto-initiated predefined schedule
- By responding automatically to environmental changes

Workflow processes can also allow for human interface points when a process calls for someone to make a decision with accountability.

The applications that you design can create human interaction through a variety of user interfaces. You can create human interaction through email, web forms, or a task list.

In addition to workflow capabilities, Workflow includes Process Manager. Process Manager is a web portal for managing the various parts of a workflow process, such as tasks, documents, and data. Process Manager can be integrated with Active Directory for user authentication, proper access control, and user management.

You can also customize Process Manager. For example, you can change pages, symbols, and Web Parts, to create an interface to meet your needs. You can also add new pages to Process Manager that embed Process Manager content or embed content from the Internet or other servers.

You can also run the Symantec ServiceDesk Solution on Workflow.

See “What you can do with Workflow” on page 30.

See “Core architectural components of Workflow” on page 39.
What you can do with Workflow

You can use Workflow to automate your business processes. You can create an application that follows a predefined workflow.

Your workflow applications can:

- Take actions based on predefined criteria.
- Monitor hardware and software.
- Coordinate interactions with other applications.
- Coordinate human interactions.
- Leverage data from the Symantec CMDB and use features of the Symantec Management Platform.
- Use the Process Manager (web portal) for human interactions.
- Use the Process Manager (web portal) to manage the various parts of workflow processes.

Table 1-1  What you can do with Workflow

<table>
<thead>
<tr>
<th>Use case</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make data actionable</td>
<td>Most applications create data records. You can take actions based on these records.</td>
</tr>
<tr>
<td>Automate work</td>
<td>You can use Workflow to run scripts, procedures, Internet services, or tasks.</td>
</tr>
<tr>
<td>Extend an existing application</td>
<td>You can leverage existing application functionality to enhance the application.</td>
</tr>
<tr>
<td>Integrate user groups and applications</td>
<td>You can integrate user groups and applications to create a complete business solution.</td>
</tr>
<tr>
<td>Control processes</td>
<td>You can integrate control and accountability into your IT security and business processes.</td>
</tr>
<tr>
<td>Access templates and component packs</td>
<td>You can download workflow templates and workflow component packs from the Workflow Solution Center. See “About the Workflow Solution Center” on page 31.</td>
</tr>
</tbody>
</table>

See “About Symantec Workflow” on page 28.
See “Core architectural components of Workflow” on page 39.
See “How Workflow works” on page 29.
Other things to know

The following are things to know about this release. If additional information about an item or feature is available, a corresponding article link is provided.

See “About Symantec Workflow” on page 28.

About the Workflow Solution Center

The Workflow Solution Center is a repository inside the Workflow Manager. The Solution Center organizes and delivers Workflow content.

The following types of content are available for download from the Solution Center:

- Workflow templates
- Updated Workflow component packs
- Videos, screen shots, and instructions about how to implement the templates and the component packs

To access the Solution Center, open Workflow Manager. The Solution Center is located in the left pane along with the other folders, such as Recent, Favorites, and Local.

You can also provide comments about and vote on templates by logging in to Symantec Connect.

See “Downloading Workflow content from the Solution Center” on page 31.

Downloading Workflow content from the Solution Center

In Workflow Manager, you can access the Solution Center Contents. In the left pane, when you click Solution Center, the Solution Center content is displayed in the right pane, content such as packages and component packs.

See “About the Workflow Solution Center” on page 31.

The Solution Center content is hosted on Symantec Connect. The first time you select content from the Solution Center, you must log on to Symantec Connect. Each time you open a new Workflow Manager session you must log in again to Connect to access the Solution Center content.

To download content from the Workflow Solution Center

1. Open Workflow Manager.
2. In the left pane, click Solution Center.
3 In the right pane, in the **Sort by** drop-down list, select how you want to sort the Solution Center contents.

You can also filter on specific content. Select one of the options to the right of the **filter** symbol.

4 In the right pane, under **Solution Center**, next to the content that you want to download, select the template name, template icon, or **Details**.

5 On the template page, click the link to download the content.
   - **Templates download as** `.package` files. Open the downloaded `.package` file to unpack and install the template.
   - **Components packs download as** `.DLL` files. Save the `.DLL` files to any location, and add them to your projects as you would import any component into a project.
   
     See "**Importing components into a project**" on page 215.

6 To add comments about or vote on a template, log in to Symantec Connect.

### Workflow video library

This following table lists videos that are available on Symantec Connect.

For an updated list, see the following link. To filter for Workflow, select **Workflow Solution** in the **All Products** drop-down.

www.symantec.com/connect/endpoint-management/videos

You can also join the Workflow Group on Connect and subscribe to receive updates for all new videos, articles, and templates.

www.symantec.com/connect/ogproduct/symantec-workflow

<table>
<thead>
<tr>
<th><strong>Table 1-2</strong> Workflow video library</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
</tr>
<tr>
<td>Publishing a Workflow Project (Part 1) Video</td>
</tr>
<tr>
<td>Title</td>
</tr>
<tr>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>Publishing a Workflow Project (Part 2) Video</td>
</tr>
<tr>
<td>Publishing a Workflow Project (Part 3) Video</td>
</tr>
<tr>
<td>Publishing a Workflow Project (Part 4) Video</td>
</tr>
<tr>
<td>Adding Custom JavaScript in Workflow Web Forms Video</td>
</tr>
<tr>
<td>Using the Web App Project Type in Workflow Video</td>
</tr>
<tr>
<td>Create a Workflow using the Service Catalog Request Template - Part 1</td>
</tr>
<tr>
<td>Title</td>
</tr>
<tr>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Using the Script generator in Workflow</td>
</tr>
<tr>
<td>Using the Report Generator in Workflow</td>
</tr>
<tr>
<td>Getting Started with Workflow : Installation</td>
</tr>
<tr>
<td>Creating and Executing SMP Tasks in Workflow</td>
</tr>
<tr>
<td>Active Directory Sync Setup in Workflow Process Manager</td>
</tr>
<tr>
<td>Using Advanced Math the 'Easy Way' in Workflow Solution</td>
</tr>
</tbody>
</table>
**Table 1-2**  Workflow video library *(continued)*

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Filter Generator in Workflow Solution</td>
<td>This is a how to video on using the filter generator in the Workflow Solution. In this video, you will see how to create a filter generator integration library, import the library into the Process Manager, and use a new filter for generating a UserPhoneNumber report.</td>
<td><a href="http://www.symantec.com/connect/videos/using-filter-generator-workflow-solution">www.symantec.com/connect/videos/using-filter-generator-workflow-solution</a></td>
</tr>
<tr>
<td>Extending Mobile Management Solution with Workflow</td>
<td>This is a video showing a general overview of the Mobile Bulk Actions workflow process and a deeper dive into the underlying Workflow and how it hangs together.</td>
<td><a href="http://www.symantec.com/connect/videos/demo-extending-mobile-management-solution-workflow">www.symantec.com/connect/videos/demo-extending-mobile-management-solution-workflow</a></td>
</tr>
<tr>
<td>Editing Assets with the NS Resource Model and Workflow</td>
<td>This 13-minute video shows two examples of editing Altiris assets using Workflow in conjunction with the NS Resource Model. Specifically, the first example dynamically updates the serial number of a computer, while the second example adds a new cost item to an asset in the CMDB. The sample project that was designed for the video is available for download as well.</td>
<td><a href="http://www.symantec.com/connect/videos/editing-assets-ns-resource-model-and-workflow">www.symantec.com/connect/videos/editing-assets-ns-resource-model-and-workflow</a></td>
</tr>
<tr>
<td>Workflow Panels and Form Visibility</td>
<td>This video demonstrates how to create dynamic web forms. Specifically, it shows how to organize sections and groups of related components on a web form with panels, and then how to have a radio button selection change which panel is shown and which is hidden. It also demonstrates how to use custom events to have a selection on one control disable or hide another control. Using these techniques, you can more effectively present the appropriate controls and labels on a single form based on previous data entry and selections.</td>
<td><a href="http://www.symantec.com/connect/videos/workflow-panels-and-form-visibility">www.symantec.com/connect/videos/workflow-panels-and-form-visibility</a></td>
</tr>
<tr>
<td>Majority Approvals in Parallel Workflow</td>
<td>This video demonstrates how to use the Embedded Merge Component to wait for a configurable scenario to occur before advancing further into the project. For example, waiting for 3 out of 5 CAB members to approve or reject a request before proceeding.</td>
<td><a href="http://www.symantec.com/connect/videos/majority-approvals-parallel-workflow">www.symantec.com/connect/videos/majority-approvals-parallel-workflow</a></td>
</tr>
<tr>
<td>Get Active Directory Reports in AD with Workflow</td>
<td>This video will demonstrate how to get a manager's direct reports out of Active Directory.</td>
<td><a href="http://www.symantec.com/connect/videos/get-active-directory-reports-ad-workflow">www.symantec.com/connect/videos/get-active-directory-reports-ad-workflow</a></td>
</tr>
</tbody>
</table>
### Table 1-2  Workflow video library (continued)

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Manager Reporting Using External Data</td>
<td>If you've done Process Manager reporting in the past, you're probably aware of how to build and customize reports using Process Manager data. But did you know you can use the exact same GUI report-writer to create reports against your own custom data source and database queries? This video shows you how to do just that.</td>
<td><a href="http://www.symantec.com/connect/videos/process-manager-reporting-using-external-data">www.symantec.com/connect/videos/process-manager-reporting-using-external-data</a></td>
</tr>
<tr>
<td>Workflow and UNIX (via SSH)</td>
<td>This video shows you how to run dynamic commands against a UNIX or Linux server from your Symantec Workflow process. The commands are run using the SSH protocol (via the command-line plink.exe from Quest) so that all communications between the Workflow and UNIX server are secure. The video walks you through a simple example to run a UNIX command on the target server, illustrating the flexibility of Symantec Workflow to interact with even non-Windows environments.</td>
<td><a href="http://www.symantec.com/connect/videos/workflow-and-unix-ssh-updated">www.symantec.com/connect/videos/workflow-and-unix-ssh-updated</a></td>
</tr>
<tr>
<td>Automating Tasks in the Notification Server with Workflow</td>
<td>This video shows you how to automate a client-side task or job from the Symantec Management Platform using Workflow.</td>
<td><a href="http://www.symantec.com/connect/videos/automating-tasks-notification-server-workflow">www.symantec.com/connect/videos/automating-tasks-notification-server-workflow</a></td>
</tr>
<tr>
<td>AD Self-Service Password Reset with Workflow Solution (Part 1)</td>
<td>This video shows an example of an Active Directory self-service password reset workflow. Part 1 shows a demonstration of the process. Part 2 then shows how to implement the project in your own environment. See this video for a link to part 2.</td>
<td><a href="http://www.symantec.com/connect/videos/ad-self-service-password-reset-workflow-solution-part-1">www.symantec.com/connect/videos/ad-self-service-password-reset-workflow-solution-part-1</a></td>
</tr>
</tbody>
</table>

### Where to get more information

Use the following documentation resources to learn about and use this product.

### Table 1-3  Documentation resources

<table>
<thead>
<tr>
<th>Document</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release Notes</td>
<td>Information about new features and important issues.</td>
<td>The <strong>Supported Products A-Z</strong> page, which is available at the following URL: <a href="http://www.symantec.com/business/support/index?page=products">http://www.symantec.com/business/support/index?page=products</a>. Open your product's support page, and then under <strong>Common Topics</strong>, click <strong>Release Notes</strong>.</td>
</tr>
</tbody>
</table>
### Table 1-3 Documentation resources (continued)

<table>
<thead>
<tr>
<th>Document</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
</table>
| User Guide| Information about how to use this product, including detailed technical information and instructions for performing common tasks. | - The Documentation Library, which is available in the Symantec Management Console on the Help menu.  
- The Supported Products A-Z page, which is available at the following URL:  
  Open your product's support page, and then under Common Topics, click Documentation. |
| Help      | Information about how to use this product, including detailed technical information and instructions for performing common tasks.  
Help is available at the solution level and at the suite level.  
This information is available in HTML help format. | The Documentation Library, which is available in the Symantec Management Console on the Help menu.  
Context-sensitive help is available for most screens in the Symantec Management Console.  
You can open context-sensitive help in the following ways:  
- Click the page and then press the F1 key.  
- Use the Context command, which is available in the Symantec Management Console on the Help menu. |

In addition to the product documentation, you can use the following resources to learn about Symantec products.

### Table 1-4 Symantec product information resources

<table>
<thead>
<tr>
<th>Resource</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud Unified Help System</td>
<td>All available IT Management Suite and solution guides are accessible from this Symantec Unified Help System that is launched on cloud.</td>
<td><a href="http://help.symantec.com/Welcome?context=ITMS8.0">http://help.symantec.com/Welcome?context=ITMS8.0</a></td>
</tr>
</tbody>
</table>
### Table 1-4

<table>
<thead>
<tr>
<th>Resource</th>
<th>Description</th>
<th>Location</th>
</tr>
</thead>
</table>

The links to various groups on Connect are as follows:

- Deployment and Imaging  
- Discovery and Inventory
- ITMS Administrator
  [http://www.symantec.com/connect/groups/itms-administrator](http://www.symantec.com/connect/groups/itms-administrator)
- Mac Management
  [http://www.symantec.com/connect/groups/mac-management](http://www.symantec.com/connect/groups/mac-management)
- Monitor Solution and Server Health
- Patch Management
  [http://www.symantec.com/connect/groups/patch-management](http://www.symantec.com/connect/groups/patch-management)
- Reporting
  [http://www.symantec.com/connect/groups/reporting](http://www.symantec.com/connect/groups/reporting)
- ServiceDesk and Workflow
- Software Management
  [http://www.symantec.com/connect/groups/software-management](http://www.symantec.com/connect/groups/software-management)
- Server Management
  [http://www.symantec.com/connect/groups/server-management](http://www.symantec.com/connect/groups/server-management)
- Workspace Virtualization and Streaming
Understanding Workflow concepts

This chapter includes the following topics:

- Core architectural components of Workflow
- About Workflow Designer
- About Workflow Server

Core architectural components of Workflow

The following table outlines the core architectural components of Workflow.

See “About Symantec Workflow” on page 28.
See "Workflow scalability" on page 50.
### Table 2-1: Core architectural components of Workflow

<table>
<thead>
<tr>
<th>Core architectural component</th>
<th>Description</th>
</tr>
</thead>
</table>
| Symantec Solution Workflow (Symantec Management Platform component) | This component is automatically installed on the Symantec Management Platform, and lets you execute the following operations:  
- Lets you access and download the Workflow installer (`Symantec.Workflow.Setup.exe`).  
- Lets you use Workflow Enterprise Management to manage your Workflow environments, which include Workflow Servers, Workflow projects, and Workflow processes.  
See “Workflow Enterprise Management page” on page 574. |
| Workflow Designer | This is a tool that you use to design processes, and contains the components that are used to build workflow projects. The Workflow Designer lets you execute the following operations:  
- Lets you design, edit, test, and publish workflow projects.  
- Lets you publish completed processes on a Workflow Server.  
See “About Workflow Designer” on page 41. |
| Workflow Server | This is a run-time engine or execution engine for all Workflow Servers, and lets you execute the following operations:  
- Lets you run and manage published workflow projects.  
- Handles all background processing for Workflow Designer and Process Manager.  
See “About Workflow Server” on page 42. |
| Process Manager | A web portal that you use to interact with and manage published the workflow projects that require human interactions, and lets you execute the following operations:  
- Lets you view and manage tasks.  
- Lets an administrator user to view the reports on running processes.  
- Lets you store documents, articles, and schedules to share.  
You should install Process Manager should be installed on a central Process Manager server.  
See “About Process Manager” on page 385. |
### About Workflow Designer

Workflow Designer is the tool used to design processes. It contains components you can arrange into processes and then publish to a Workflow Server. Workflow Designer should be installed on computers other than the Symantec Management Platform host.

Workflow Designer lets you design, test, and publish workflow projects. It contains the components that you can arrange into processes. You can publish completed processes to a Workflow Server. After you publish a Project, you can re-open it in Workflow Designer, edit it, and republish it.

In a standard configuration, a Workflow Designer computer publishes completed workflow projects to a central Workflow Server computer. Workflow Server is installed

---

**Table 2-1** Core architectural components of Workflow (continued)

<table>
<thead>
<tr>
<th>Core architectural component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Manager database</td>
<td>The database stores the Process Manager details such as groups, users, and permissions and stores persistent Workflow data. The database must reside on the SQL Server computer.</td>
</tr>
<tr>
<td>Client tools</td>
<td>Workflow client tools are support applications for Workflow. The following list describes the client tools:</td>
</tr>
</tbody>
</table>
|                             | - **Business TimeSpan Editor**  
                                | Manages the information about the work hours and holidays for your organization. |
|                             | - **Credentials Manager**  
|                             | - **Critical Errors Viewer**  
|                             | - **License Status Manager**  
|                             | - **Local Machine Info Editor**  
|                             | - **Log Viewer**  
|                             | - **Messaging Console**  
|                             | - **Screen Capture Utility**  
|                             | - **Server Extensions Configurator**  
|                             | - **Task Tray Tool**  
|                             | - **Tool Preferences Editor**  
|                             | - **Web Forms Theme Editor**  
                                | Lets you create new themes for the web forms that you can use in form components (for example, Form Builder). |
|                             | - **Workflow Explorer**  

automatically on every computer that is running Workflow Designer. Process Manager can be installed on a central Process Manager server.

You must be a member of the local Administrators group to use Workflow Designer. If you are not an administrator you receive an error when you attempt to create and compile Projects.

See “Core architectural components of Workflow” on page 39.

About Workflow Server

Workflow Servers run and manage published workflows as Internet services in IIS. Workflow Servers are any computers that serve as publishing destinations for your projects. You can publish a project without moving it to a Workflow Server. For example, you can create a publishing directory without moving it to a Workflow Server. However, publishing most commonly means moving the project to a Workflow Server.

See “Core architectural components of Workflow” on page 39.

Workflow Server runs on every computer running Workflow Designer. However, Symantec recommends that you establish at least one central, designated server to run Workflow Server. Workflow Designer computers can publish to this server. If you install Workflow Server only on the Workflow Designer computer, you can publish processes only to the local computer.

When you install Workflow, you can install only Workflow Server on a computer. Installing only Workflow Server enables that computer to be a publishing destination for Workflow Designer computers.

To publish a project from a Workflow Designer computer to a Workflow Server computer, you must have two-way communication between the computers. All communication links through inbound and outbound Internet services using HTTP communication.

When projects are published, they appear in IIS as an available Internet service. Symantec Management Console or another caller that communicates with Workflow Server can then call the published projects.

Workflow Server computers can interact with Workflow Designer computers and Symantec Management Platform computers in multiple ways. The following graphics illustrate some of these relationships.
Figure 2-1  Multiple Workflow Designer computers publishing to a single Workflow Server computer

Workflow Designer  
Copies workflow which becomes a Web service on Server  
Workflow Server

Workflow Designer  
Copies workflow which becomes a Web service on Server  
Workflow Designer

Understanding Workflow concepts  
About Workflow Server
Figure 2-2  Multiple Workflow Server computers processing requests from one Symantec Management Platform server

Workflow Solution
( on Symantec Management Console )

Two-way communication to run workflow project

Workflow Server

Workflow Server

Workflow Server

See “Server Extensions Configurator” on page 617.
See “Installing Workflow” on page 74.
Installing and upgrading Workflow

- Chapter 3. Preparing your Workflow installation
- Chapter 4. Installing Workflow
- Chapter 5. Upgrading Workflow
Preparing your Workflow installation

This chapter includes the following topics:

- About installing Workflow
- Assembling your Workflow team
- Configuration options for Workflow installations
- Workflow scalability
- About installing Workflow Solution in FIPS-enabled environment
- About upgrading to Workflow Solution in FIPS-enabled environment

About installing Workflow

Symantec Workflow is delivered as a component of the Symantec Management Platform.

Workflow has only one installer, which you can access after you install the Symantec Management Platform. You use the Symantec Installation Manager to install the Symantec Management Platform. You can then access the Workflow Installer in the Symantec Management Console under Manage > Workflows.

Although you have some flexibility with which of the Workflow architectural components you install, Workflow Server must be installed on every Workflow computer. Therefore, every Workflow installation installs Workflow Server automatically.

Because Workflow Server is installed on all Workflow computers, you can publish your Workflow projects to any Workflow computer. However, Symantec recommends
setting up a designated production Workflow Server computer. A designated production Workflow Server computer lets you create one central location to publish all your production-ready Workflow projects.

You do not have to install Workflow Designer or Process Manager when you install Workflow Server. In a typical production environment, install Process Manager only on your central production Workflow Server, and install Workflow Designer only on design computers. In a development and a testing environment, install Process Manager and Workflow Designer on a design computer.

Symantec Workflow supports both Windows authentication and SQL authentication. However, Windows authentication is recommended for the following reasons:

- Connection string information is stored in the Web.config files of Workflow projects.
- Windows authentication also adds a layer of security.
- Windows authentication is easier to modify.

See “Assembling your Workflow team” on page 47.
See “Configuration options for Workflow installations” on page 49.
See “Workflow scalability” on page 50.
See “Installing Workflow” on page 74.
See “Process for upgrading Workflow” on page 94.

Assembling your Workflow team

To use Workflow successfully, ensure that the right people with the right skills are available to design, develop, run, and maintain the processes that you want to orchestrate. Executive-level support is valuable and highly desirable for any Workflow integration project that you undertake.
Table 3-1 Required roles and skills

<table>
<thead>
<tr>
<th>Role</th>
<th>Skills</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name:</td>
<td></td>
<td>You need someone on your team who possesses IIS-specific skills and can ensure that the processes have the correct security and rights.</td>
</tr>
<tr>
<td><strong>Network administrator with IIS knowledge</strong></td>
<td>Ensure that IIS processes function correctly and securely.</td>
<td>This team member can make the difference between building a process that works only until it is deployed and one that runs well in production.</td>
</tr>
<tr>
<td>Name:</td>
<td></td>
<td>The Workflow administrator needs a solid working knowledge of the following software:</td>
</tr>
<tr>
<td><strong>Workflow administrator</strong></td>
<td>Build, modify, and maintain workflows.</td>
<td>■ SQL so that he or she understands the background processes that run as part of a workflow</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ IIS to understand and resolve conflicts that may occur with Internet services</td>
</tr>
<tr>
<td>Name:</td>
<td>Envision and map an elegant business process.</td>
<td>You need someone who can see the big picture. The analyst must look at the proposed process from start to finish and identify which pieces need human intervention and which pieces to automate.</td>
</tr>
<tr>
<td><strong>Business systems analyst</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Preparing your Workflow installation
Assembling your Workflow team
Table 3-1  Required roles and skills (continued)

<table>
<thead>
<tr>
<th>Role</th>
<th>Skills</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Name: Altiris network administrator (optional) | If you plan to integrate one or more Altiris products from Symantec, you need a team member who can perform advanced administration tasks. This team member should be skilled with each application to be integrated with Workflow. | For example, if you plan to create a workflow that lets you orchestrate patch management, you need someone who has the administrator rights and privileges to perform the following tasks:  
  - Create policies.  
  - Specify delivery times.  
  - Create targets for the patch rollout.  
  - Verify that patches were rolled out and installed. |
| Name: <Other administrator> (optional)    | If you plan to integrate one or more products from other vendors, you need a team member who can perform advanced administration tasks with each product. For example, if you plan to use the VMware vShield product, you need a skilled vShield administrator. |                                                                                                                                         |

See “About installing Workflow” on page 46.
See “Configuration options for Workflow installations” on page 49.

Configuration options for Workflow installations

Before you run the Workflow Installer, you should decide the installation configuration that you want to use. After you have made those decisions, proceed with running the installer.

You can install the pieces of Workflow in a number of different configurations based on organizational need.

Refer to the following list for some common installation configurations:

- Testing configurations
Testing configurations commonly install all of the pieces of Workflow on a single server. Alternately, you can install Workflow Server and Process Manager on virtual machines to simulate a multi-server configuration for testing purposes.

- Designer configurations
  Designer configurations commonly install only Workflow Server and Workflow Designer on a development computer. The task tray application on the development computer is configured with the Workflow Server and the Process Manager server that are used for production publishing.

See “About installing Workflow” on page 46.
See “Assembling your Workflow team” on page 47.
See “Installing Workflow” on page 74.

**Workflow scalability**

System requirements for Symantec Workflow vary depending on the scenario in which you plan to use Workflow. Symantec assumes that you use Symantec Management Platform with Workflow, although most features of Workflow can be executed independent of the platform.

The recommended configurations apply to situations in which the utilization load of the Workflow system is not well-defined. Utilization load is proportionate to the frequency of process execution, and then multiplied by the amount of data in the process. The number of active simultaneous processes and the time it takes an external system to respond to the Workflow system affects the processing speed.

In nearly all scenarios it is appropriate to include the following configurations:

- One or more developer workstations
- One lab environment configuration

If you plan to leverage Symantec Management Platform for additional products, such as client management, server management, or asset management, observe the following Symantec recommendations:

- Increase the hardware capacity of the platform server to reflect additional SQL load requirements.
- Install Workflow Server on a separate production server.

For more information, refer to *IT Management Suite Installation and Upgrade Guide* and *IT Management Suite Planning for Implementation Guide*.

See “Recommendations for scaling the Workflow Server and its dedicated SQL Server” on page 52.
When scaling your Workflow environment, you must consider the following principal factors:

Table 3-2  Principal factors for scaling the Workflow environment

<table>
<thead>
<tr>
<th>Factor</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Future growth</td>
<td>- Considerations for scaling your Workflow environment should include any expansion plans for the next three years, if possible.</td>
</tr>
<tr>
<td></td>
<td>- As your organization grows, your number of incidents, changes, and problems grows in accordance.</td>
</tr>
<tr>
<td></td>
<td>- As your incidents, changes, and problems grow, so does the number of technicians that are needed to handle your service needs.</td>
</tr>
<tr>
<td>Symantec Management Platform</td>
<td>- You must also scale your instance of the Symantec Management Platform to meet the needs of your environment and for optimal performance.</td>
</tr>
<tr>
<td></td>
<td>For information about the Symantec Management Platform requirements, refer to <em>IT Management Suite Installation and Upgrade Guide</em> and <em>IT Management Suite Planning for Implementation Guide</em>.</td>
</tr>
<tr>
<td>Workflow servers</td>
<td>- You install the Process Manager portal on the Workflow Server.</td>
</tr>
<tr>
<td></td>
<td>- The Process Manager portal is where you manage and resolve incidents, problems, and changes. This portal is also where you manage and add to your knowledge base.</td>
</tr>
<tr>
<td></td>
<td>- The maximum number of technicians working in the Process Manager portal at one time determines the number of Workflow servers your environment needs. The number of technicians is the primary scaling factor used to determine how many Workflow servers that you install.</td>
</tr>
</tbody>
</table>
Table 3-2  Principal factors for scaling the Workflow environment (continued)

<table>
<thead>
<tr>
<th>Factor</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Server configuration</td>
<td>Recommendations for scaling your SQL Server configuration depend on what you want to do in your Workflow environment. You install the Process Manager database on the SQL Server. The throughput of the SQL Server is the primary consideration for configuring your SQL Server for optimal performance to meet your Workflow needs. The throughput considerations are Input/Output per second and concurrent SQL transactions, which relate to the peak number of tickets that are processed each day.</td>
</tr>
</tbody>
</table>

Recommendations for scaling the Workflow Server and its dedicated SQL Server

You can perform any of the following types of configurations during installation of Workflow Solution or upgrade to Workflow Solution:

- **On-box configuration**
  
  An on-box configuration is when you install the SQL Server locally on the Workflow Server. Installing the SQL database locally does not result in maximum performance, but it can deliver acceptable performance.

- **Off-box configuration**
  
  An off-box configuration is when you install the SQL Server on a separate server from the Workflow Server. In such case, the SQL Server performs much better, because the SQL Server offloads the work of data processing and frees resources for Workflow Server processing.

**Note:** Starting from Symantec Management Platform 8.0 and Workflow Solution 8.0, the 32-bit version of Microsoft SQL Server is not supported.
### Table 3-3 Principal Workflow and SQL Server components for scaling the Workflow environment

<table>
<thead>
<tr>
<th>Component</th>
<th>Evaluation</th>
<th>Small or lab environment</th>
<th>Medium environment</th>
<th>Large environment</th>
<th>Load balanced environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Two cores</td>
<td>Four cores</td>
<td>Eight cores</td>
<td>Eight cores</td>
<td>Eight cores per server</td>
</tr>
<tr>
<td>RAM</td>
<td>8 GB</td>
<td>8 GB</td>
<td>16 GB</td>
<td>32 GB</td>
<td>32 GB per server</td>
</tr>
<tr>
<td><strong>SQL Server</strong></td>
<td>On-box</td>
<td>Off-box</td>
<td>Off-box</td>
<td>Off-box</td>
<td>Off-box</td>
</tr>
<tr>
<td>Processor</td>
<td>One core</td>
<td>Four cores</td>
<td>Eight cores</td>
<td>Eight cores</td>
<td>Eight cores</td>
</tr>
<tr>
<td>Disk speed</td>
<td>SAS 10k</td>
<td>SAS 10k in high-performance disk array</td>
<td>SSD or SAS in RAID 10 configuration</td>
<td>SAS 15k in high-performance disk array</td>
<td>SSD or SAS 15k equivalent in a high-performance disk array</td>
</tr>
<tr>
<td>Disk capacity</td>
<td>80 GB</td>
<td>80 GB</td>
<td>120 GB</td>
<td>200 GB</td>
<td>400 GB</td>
</tr>
<tr>
<td>RAM</td>
<td>16 GB</td>
<td>16 GB</td>
<td>24 GB</td>
<td>32 GB</td>
<td>48 GB</td>
</tr>
</tbody>
</table>

See “SQL Server configuration options for Workflow” on page 54.

### About load balancing your Workflow environment

Load balancing lets you prepare for scalability and growth to your Workflow environment. Setting up a load-balanced environment requires preparation and planning. It also adds some additional maintenance overhead. You must consider load balancing before installation, upgrades, and updates.

**Note:** You must set up your load-balanced environment before you install Workflow. You cannot introduce load balancing during or afterwards.
You should plan your implementation schedule to allow for adequate testing. You should set up an environment according to the recommendations in this chapter. The main reason for setting up a load-balanced environment is that you need additional server resources to keep up with your environment’s load.

The following are examples of increased loads:

- Each additional installation of the Workflow Server, you put more of a load on your SQL server.
- The more technicians you have processing tickets, the greater the number of concurrent SQL transactions.
- The more process tickets that are generated each day, the more SQL server resources are required. Additional Workflow servers can help to maintain system responsiveness as your usage levels increase.

For instructions on how to set up load balancing, see the following appendix in this guide. You must read through the instructions in the appendix before beginning your Workflow installation. You cannot introduce load balancing during or after installation.

See “About load balancing” on page 665.

### SQL Server configuration options for Workflow

The following information provides guidelines for SQL Server configuration for a Workflow (Process Manager) Database server. You can follow these guidelines to tune the performance of the SQL Server that hosts the Process Manager database. These guidelines are not exclusive, and additional configuration options may be appropriate depending on the specifics of your environment. For detailed information about SQL Server configuration, refer to Microsoft’s documentation.

<table>
<thead>
<tr>
<th>Table 3-4</th>
<th>SQL Server configuration options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Consideration</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Hardware: processors and memory</td>
<td>Having sufficient processors and memory lets you tune the performance of your SQL Server. 4 to 8 cores are common in well-performing environments.</td>
</tr>
</tbody>
</table>
### Table 3-4 SQL Server configuration options (continued)

<table>
<thead>
<tr>
<th>Consideration</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disk drive channel configuration</td>
<td>How you configure the disk drives and the controllers that interface those to your SQL server has a large influence on your overall performance. You can use disk drive channel configuration recommendations to maximize throughput and tune the performance of your SQL Server. See &quot;Hard drive configuration options for an off-box SQL Server&quot; on page 55.</td>
</tr>
<tr>
<td>Database sizing</td>
<td>You can use database sizing guidelines to help tune the performance of your SQL Server.                                                                                                                     See “Database sizing for SQL Server for Workflow” on page 57.</td>
</tr>
<tr>
<td>Memory management</td>
<td>You can use memory management guidelines to help tune the performance of your SQL Server.                                                                                                                   See “Memory management options for SQL Server performance” on page 58.</td>
</tr>
</tbody>
</table>

### Hard drive configuration options for an off-box SQL Server

Data throughput of the SQL Server is a key consideration for Workflow performance. The way that you configure your disk drives in SQL Server has a key influence on throughput. The hard drive speed also has an influence on throughput. It is recommended to use high performance hard disks. For example, you can use 10k rpm to 15k rpm SAS drives in a striped array.

For the best performance, make sure that the operating system, SQL data file, TempDB database, and the log file each have a dedicated volume, and associated controller channel. The data file requires both high read-write performance and redundancy. RAID 10 and RAID 0+1 are good configurations for the data file. RAID 0+1 has similar throughput as RAID 10, but its configuration helps simplify additional storage growth. RAID level 5 is not ideal for the database performance because it requires additional Read/Write activities for parity.

The TempDB database needs high read-write performance, but redundancy is not necessary. The TempDB database acts as a temporary working area for many processes. The TempDB database requires very high speed; however, it is not used for storage, and it is cleared regularly.

The transaction log also requires high disk throughput for optimal system performance. It should be hosted on a RAID 10.
In all of these options, the key factor is the end result that resides on separate physical disk and drive controller hardware. The best performance and maximum efficiencies are when that configuration rule is applied. Care should be taken if SAN or NAS storage is used to assure performance and efficiency. SAN and NAS storage arrays are often carved into logical volumes. These logical volumes are for optimizing space usage, and allowing multiple servers and applications to access (share) the same physical devices. This causes disk contention and slow performance. If you plan to use SAN or NAS, it is best to have this requirement discussed and planned for during implementation. Include the storage administrators in the planning.

Table 3-5  Example of an off-box SQL Server disk configuration

<table>
<thead>
<tr>
<th>Component</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system RAID 1 Mirror</td>
<td>RAID 1 Mirror</td>
</tr>
<tr>
<td>Data file</td>
<td>RAID 10 or RAID 0+1</td>
</tr>
<tr>
<td>TempDB database</td>
<td>RAID 0 (Striping)</td>
</tr>
<tr>
<td>Transaction log</td>
<td>RAID 10 or RAID 0+1</td>
</tr>
</tbody>
</table>

See “SQL Server configuration options for Workflow” on page 54.

See “Throughput metrics of SQL Server for Workflow” on page 56.

Throughput metrics of SQL Server for Workflow

The Process Manager database has high throughput requirements. Input/Outputs per second (IOPS) are used to measure the throughput. You can use the following IOPS metrics to select the right disk performance for your SQL Server.

The database that is represented here serves 20,000 endpoints and 20 concurrent console sessions and 45 maximum persistent connections over 2311 concurrent transactions. It represents SQL performance statistics during a one hour time period during peak hour processing.

Table 3-6  SQL data file Input/Output per second

<table>
<thead>
<tr>
<th>Metric</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of I/O per second</td>
<td>238.7</td>
</tr>
<tr>
<td>Percent of writer I/O per second</td>
<td>98%</td>
</tr>
</tbody>
</table>
Database sizing for SQL Server for Workflow

Limited concerns exist in the sizing of the Workflow database. Most customers even with large environments seldom see database file sizes grow much larger than 20-40 GB. The average database size ranges from 4-15 GB.

Allow between 750 KB and 1 MB of space in the database for every 1,000 service tickets. This sizing does not account for database fragmentation beyond initial creation. The database maintenance strategy that you use also influences your database size.

See “SQL Server configuration options for Workflow” on page 54.

See “Hard drive configuration options for an off-box SQL Server” on page 55.

### Table 3-6  SQL data file Input/Output per second (continued)

<table>
<thead>
<tr>
<th>Metric</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percent of read I/O per second</td>
<td>2%</td>
</tr>
</tbody>
</table>

### Table 3-7  TempDB database Input/Output per second

<table>
<thead>
<tr>
<th>Metric</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of I/O per second</td>
<td>130</td>
</tr>
<tr>
<td>Percent of writer I/O per second</td>
<td>49%</td>
</tr>
<tr>
<td>Percent of read I/O per second</td>
<td>51%</td>
</tr>
</tbody>
</table>

### Table 3-8  Log files Input/Output per second

<table>
<thead>
<tr>
<th>Metric</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of I/O per second</td>
<td>593.8</td>
</tr>
<tr>
<td>Percent of writer I/O per second</td>
<td>100%</td>
</tr>
<tr>
<td>Percent of read I/O per second</td>
<td>0%</td>
</tr>
</tbody>
</table>
Autogrow is a SQL Server setting you can use to help with unexpected data growth. However, do not rely on autogrow to manage your database file sizes. As with any key application, you must monitor the database and have proper maintenance tasks in place.

To choose your autogrow setting, estimate the expected maximum sizes of the data file and the transaction log file. To estimate this size you can monitor the growth of these files in a pre-production environment. Set the autogrow increment for your data file and transaction log files to 10 to 20 percent higher than your initial estimate.

Do not use the autoshrink feature with Workflow. Auto shrink runs periodically in the background. It consumes CPU and I/O cycles, which can cause unexpected performance degradation. Autoshrink can continually shrink and re-grow the data files. This process causes fragmentation of the database file. This fragmentation may degrade both sequential transfers and random accesses. If Autoshrink is required in your environment, please schedule it to run only after normal work hours.

To further improve performance, you should defragment and re-index the database after its initial installation.

The Process Manager SQL Server should not host additional third-party database applications. The load and I/O traffic of Workflow are sufficient to require a dedicated SQL Server. You can have a single SQL instance that shares a single TempDB database, or multiple database instances can each have a dedicated TempDB database. Multiple database instances minimize risk for potential contention but require more disk arrays.

You may require the individual Process Manager databases of each Workflow Server to exist on a separate instance. They may need to be separate instances to avoid TempDB database contention.

See “SQL Server configuration options for Workflow” on page 54.

Memory management options for SQL Server performance

Memory management is an important part of tuning SQL Server performance. Various options are provided for your review and consideration. However, using 64-bit SQL and configuring SQL to use all of the memory that is provided is recommended for optimal Workflow performance.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3GB</td>
<td>This 32-bit Windows boot option limits the operating system to 1 GB of RAM, reserving 3 GB for applications.</td>
</tr>
</tbody>
</table>
### Table 3-9  SQL Server memory configuration options (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum server memory</td>
<td>■ This SQL setting limits the memory that SQL can consume.</td>
</tr>
<tr>
<td>PAE</td>
<td>■ This 32-bit Windows boot option allows SQL Server to use more than 4GB of RAM.</td>
</tr>
</tbody>
</table>
| AWE                         | ■ This SQL option allows SQL Server to use more than 2 GB of RAM.  
■ If the server has more than 2 GB of physical memory, enable AWE memory in SQL Server. This memory mode is recommended.  
■ When AWE is enabled, SQL Server always attempts to use AWE-mapped memory. It uses wrapped memory or all memory configurations, including computers that provide applications with less than 3 GB of user mode address space.  
■ If AWE memory is enabled in SQL, make sure that the SQL Server account has the correct Lock Pages in Memory setting. Both AWE and the Lock Pages in Memory setting can benefit 64-bit SQL Servers as well as 32-bit SQL Servers. |
| Windows memory usage        | ■ Set Windows memory usage to favor Programs over System Cache. SQL Server does its own data caching to improve performance.                                                                           |
| 32-bit OS                   | ■ If you use a 32-bit OS, make sure that PAE is enabled at the hardware level.  
■ Enabling PAE lets SQL Server use AWE to map physical memory addresses higher than 4GB.                                                                                                                |
| 64-bit SQL (Recommended SQL configuration) | ■ This option eliminates the memory limitations that are associated with 32-bit systems.  
■ By using a 64-bit operating system (Windows Server 2008 RS SP1) and 64-bit SQL, you do not need to use PAE or AWE.  
■ SQL Server 2008 x64 is recommended for dedicated SQL Servers with more than 4 GB of physical memory.                                                                                       |

See “SQL Server configuration options for Workflow” on page 54.

**Recommended SQL Server hardware**

The following are general hardware recommendations for most environments with Workflow Solution. Depending on your specific circumstances, the appropriate hardware may vary.
### Table 3-10  Workflow hardware recommendations for Microsoft SQL Server

<table>
<thead>
<tr>
<th>Component</th>
<th>Evaluation</th>
<th>Small or lab environment</th>
<th>Medium environment</th>
<th>Large environment</th>
<th>Load balanced environment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>One core</td>
<td>Four cores</td>
<td>Eight cores</td>
<td>Eight cores</td>
<td>Eight cores</td>
</tr>
<tr>
<td>Disk Speed</td>
<td>SAS 10k</td>
<td>SAS 10k in high-performance disk array</td>
<td>SSD or SAS in RAID 10 configuration</td>
<td>SAS 15k in high-performance disk array</td>
<td>SSD or SAS 15k equivalent in a high-performance disk array</td>
</tr>
<tr>
<td>Disk Capacity</td>
<td>80 GB</td>
<td>80 GB</td>
<td>120 GB</td>
<td>200 GB</td>
<td>400 GB</td>
</tr>
<tr>
<td>RAM</td>
<td>16 GB</td>
<td>16 GB</td>
<td>24 GB</td>
<td>32 GB</td>
<td>48 GB</td>
</tr>
</tbody>
</table>

### Supported operating systems for Workflow

The support matrix provides an overview of the primary Workflow components and their supported operating systems.

See “Process for upgrading Workflow” on page 94.

### Server configuration options for the Workflow installation

The Workflow installation requires that you dedicate certain servers: a Symantec Management Platform, a Workflow Server, and an SQL Server.

See “Installing Workflow” on page 74.

The server configuration that you use for a Workflow installation depends on your environment, datacenter design, and budget.

Requirements for server configurations

A server configuration is valid if it meets the following requirements:

- Microsoft SQL Server is installed on either a 32-bit server or a 64-bit server. Symantec recommends that you use a 64-bit server.
- The Symantec Management Platform and the Workflow Solution software are installed on a 64-bit server.
- Workflow is installed on a 64-bit server. Separate from the Symantec Management Platform.
The most commonly-used configurations are as follows:

- SQL Server is installed off-box for both the Symantec Management Platform and Workflow. See Figure 3-1.
- The Symantec Management Platform and Workflow share an off-box SQL Server installation. See Figure 3-2.

Examples of additional configurations are as follows:

- SQL Server is installed off-box for either the Symantec Management Platform or Workflow.
- SQL Server is installed on-box for either the Symantec Management Platform or Workflow, or both.
- One of the applications uses an on-box installation of SQL Server and shares it with the other application.
- One of the applications uses an on-box installation of SQL Server and the other application uses an off-box installation of SQL Server.

Symantec does not support the following server configuration:

- Symantec Management Platform with Workflow Solution software installed on the same server as the Workflow application software.

**Note:** The Symantec Management Platform with Workflow Solution must be installed to a separate server than the actual Workflow application server.

Figure 3-1 Both Symantec Management Platform and Workflow have their own off-box SQL Server
About installing Workflow Solution in FIPS-enabled environment

From Workflow Solution 8.0 with the implementation of support for FIPS-enabled environment, a new key is generated for every individual server where Workflow Solution is installed. Key generation is independent of the FIPS-enabled environment and happens even if the server is not FIPS enabled. Encryption data is stored in the generated key.

During the Workflow Solution installation, in the **Maintenance** page, the **Show Import Key Page** check box option is added to display the **Import Key** page. When you install Workflow Solution on a new computer, it is not mandatory to select the **Show Import Key Page** option.

The two main scenarios where the encryption key is required are:

- Reuse of the Workflow Solution 8.0 database using the **Update Existing Database** option.
  
  - For example, if you install Workflow Solution 8.0 on a computer and create a Process Manager database, and then install Workflow Solution 8.0 on a different computer, but want to reuse the existing Process Manager database.
  
  - In this scenario where you want to connect to or use the same database on two different servers, you must export the key that is generated when you install Workflow Solution on a server. Import the same key when you install Workflow Solution on another server that connects to or uses the same database.
Importing the key is a mandatory step while connecting to the same database. If you attempt to use the same database without importing the key, an error message is displayed and you cannot proceed with the installation.

- Use of a settings or input.xml file that is generated from a Workflow Solution 8.0 server
  - For example, if you install Workflow Solution 8.0 on a computer and generate the settings file (input.xml) during installation, and reuse the generated settings file while installing Workflow Solution 8.0 on a different computer.
  - During installation of Workflow Solution 8.0, you can use the input.xml configuration settings file that is generated either from another Workflow Solution 8.0 server or from Workflow Solution 7.6 server.
    - An imported key is required when you use the input.xml from another Workflow Solution 8.0 server.
    - A key is not required if the input.xml is from Workflow Solution 7.6 server.

Exporting the key file during installation

When the Workflow Solution 8.0 installation completes, an Export Encryption Key dialog box displays. Use this dialog box to export the encryption key. You must provide a password to protect the key file. During import, ensure to use the same password.

Exporting the key file after installation

To export the key after installing Workflow Solution 8.0, use the lbutil.exe tool as follows:

From the command prompt, enter the following command:

```
<InstallDirectory>\Tools\lbutil.exe -exportKmskey -kmsFileLocation "<FolderPathToExportKey\filename.txt>" -password "<password>"
```

Note: When you install Workflow Solution 8.0 and want to connect to an older database, disable FIPS during installation and enable FIPs after the installation is complete.

See “About upgrading to Workflow Solution in FIPS-enabled environment” on page 64.
About upgrading to Workflow Solution in FIPS-enabled environment

After upgrading to Workflow Solution 8.0, a new key file is generated. During the upgrade process, the data in the database and the file system is decrypted using the old encryption key and is re-encrypted using the new encryption key.

- **On-box upgrade**
  During an upgrade to Workflow Solution 8.0, there is no need to import an encryption key.

- **Off-box upgrade**
  Before an off-box upgrade, you must add the following value to the registry:
  
  <HKLM\SOFTWARE\Wow6432Node\TransparentLogic.com\WorkflowServer>
  
  **Name:** mode
  **Type:** REG_SZ
  **Value:** upgrade

**Note:** Only a clean install of Workflow Solution 8.0 is supported on the FIPS-enabled computer. You must upgrade on a FIPS-disabled computer and then enable FIPS, if required.

See “About installing Workflow Solution in FIPS-enabled environment” on page 62.
Installing Workflow

This chapter includes the following topics:

- Process for installing Workflow
- Information to collect for your Workflow installation
- Setting up the Workflow computer
- Downloading the Workflow Installer
- Installing Workflow

Process for installing Workflow

This instruction outlines the process for installing Workflow.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Collect the information that you need for Workflow</td>
<td>During the Workflow installation and initial configuration, you must enter certain information about your environment and the type of installation that you plan to perform. See &quot;Information to collect for your Workflow installation&quot; on page 66.</td>
</tr>
<tr>
<td></td>
<td>installation and initial configuration.</td>
<td></td>
</tr>
<tr>
<td>Step 2</td>
<td>Prepare the Workflow computer for installation.</td>
<td>Before you download the Workflow Installer on the Workflow computer, specific features of the base operating system must be enabled and configured. For an off-box SQL Server configuration, additional components must be installed on the Workflow computer. See &quot;Setting up the Workflow computer&quot; on page 69.</td>
</tr>
</tbody>
</table>
Table 4-1  Process for installing Workflow (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 3</td>
<td>Download the Workflow Installer.</td>
<td>In the Symantec Management Console, you can access a page that lets you download the Workflow Installer. Download the installer to any computer on which you plan to install Workflow. See “Downloading the Workflow Installer” on page 74.</td>
</tr>
<tr>
<td>(Optional) Step 5</td>
<td>Configure your dedicated run-time service account.</td>
<td>Workflow selects the IIS Application Pool accounts and the NETWORK SERVICE account to be your Process Manager’s run-time accounts by default. However, Symantec recommends that you use a dedicated service account to be the Process Manager’s run-time account. If using a dedicated account, configure this account to be your Process Manager’s run-time service account. See “Configuring the dedicated account to be your Process Manager’s run-time service account” on page 92.</td>
</tr>
</tbody>
</table>

See “Process for upgrading Workflow” on page 94.

**Information to collect for your Workflow installation**

During the Workflow installation and initial configuration, you must enter certain information about your environment and the type of installation that you plan to perform.

See “Installing Workflow” on page 74.

Collecting this information is a step in the process for installing Workflow.

See “Process for installing Workflow” on page 65.
### Table 4-2: Information to collect for your Workflow installation

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Corresponding information from your environment</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symantec Management Platform computer name</td>
<td>The IP address, fully qualified domain name, or common name of the computer on which the Symantec Management Platform is installed. &lt;br&gt; <strong>Note:</strong> You can use Workflow without a connection to an instance of the Symantec Management Platform. However, if you want to use power of Workflow Enterprise Management to manage your Workflow environments and the Workflow Repository to manage your workflow projects, you must configure a connection to a Symantec Management Platform computer.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Symantec Management Platform domain name</td>
<td>The domain name of the computer on which the Symantec Management Platform is installed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Symantec Management Platform computer credentials</td>
<td>The user name and password with which the Workflow computer can access the Symantec Management Platform computer.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Base URL of the Workflow computer</td>
<td>The IP address and the fully qualified domain name of the Workflow computer. &lt;br&gt; Should be the address that users use to access the Process Manager portal. &lt;br&gt; <strong>Note:</strong> If you plan to use SSL/HTTPS encryption to install Workflow, the Base URL value must match the Issued To name on the SSL certificate.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data source for the Process Manager database</td>
<td>The IP address or the domain name of the computer on which to install the Process Manager database. &lt;br&gt; It must reside on the SQL server.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 4-2  Information to collect for your Workflow installation (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Corresponding information from your environment</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Manager administrator</td>
<td>The user name and password of the administrator who can access the Process Manager portal. You must use an email account format for the user name. For example: <a href="mailto:admin@symantec.com">admin@symantec.com</a> Symantec recommends that you use a native account so that the account does not rely on any external systems. This account is created during installation so that it is available for the administrator who first logs on to Process Manager. If you use an Active Directory account, this account uses the password that you provide during installation until that account synchronizes with Active Directory. After installation, it uses the accounts Active Directory password. The Workflow computer must be able to access the Active Directory server to complete the Process Manager authentication after synchronization.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Installation account and its connection authentication method | Workflow requires an installation account to connect to the target SQL instance during installation only. The connection authentication method determines the type of installation account that is needed. The options are as follows:

- **Windows Integrated Security** authentication
  Use a domain account with the `sysadmin` server role on the target SQL instance. **Note**: You must log in to Windows with this account when performing your Workflow installation.

- **MS SQL Server Security** authentication
  Use an SQL account with the `sysadmin` server role for the target SQL instance. **Note**: If you plan to use this authentication method, the target database server must be configured to support SQL authentication. |                                                  |                                                                    |
Table 4-2  Information to collect for your Workflow installation (continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Corresponding information from your environment</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Optional) Dedicated service account</td>
<td>Workflow selects the <strong>IIS Application Pool</strong> accounts and the <strong>NETWORK SERVICE</strong> account to be your Process Manager’s run-time accounts by default. However, Symantec recommends that you use a dedicated service account to be the Process Manager’s run-time account. <strong>Note:</strong> This dedicated account must be set up in the target SQL instance. This account is added to the <strong>db_owner</strong> role on the Process Manager database during installation.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Setting up the Workflow computer

The Workflow computer requires specific features of the base operating system to be enabled and configured. Additional components must be installed for off-box SQL Server. Skipping any of the configuration steps may result in a failed installation.

This instruction is a step in the process for installing Workflow.

See “Process for installing Workflow” on page 65.

Table 4-3  Setting up the Workflow computer for Workflow installation

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Install and configure server roles and web services.</td>
<td>Install the <strong>Application Server</strong> and the <strong>Web Server (IIS)</strong> roles on the Workflow computer. You must also add the <strong>IIS 6 Management Compatibility</strong> role service to the <strong>Web Server (IIS)</strong> role.</td>
</tr>
</tbody>
</table>
### Table 4-3 Setting up the Workflow computer for Workflow installation (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Configure firewall security.</td>
<td>Configure or disable the firewall to properly allow HTTP, HTTPS, and email protocol traffic on the Workflow computer.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Disable User Access Control (UAC).</td>
<td>Disable UAC on the Workflow computer to avoid experiencing permission errors when accessing Workflow Manager, creating projects, or opening projects.</td>
</tr>
</tbody>
</table>
| Step 4     | Install SQL Server support components.           | For off-box SQL instances, you must install additional SQL Server components on the Workflow computer.  
|            |                                                  | See “Installing SQL Server support components on the Workflow computer” on page 71.               |
| Step 5     | Set up the Workflow installation account.         | Set up an account to use to connect to the target SQL instance during installation only.         |
|            |                                                  | The options are as follows:                                                                      |
|            |                                                  | - If **Windows Integrated Security** authentication is used:                                     |
|            |                                                  |   - Set up a domain account with the sysadmin server role for the target SQL instance.          |
|            |                                                  |     **Note:** You must log in to Windows with this account when performing your Workflow installation. |
|            |                                                  | - If **MS SQL Server Security** authentication is used:                                          |
|            |                                                  |   - Set up a SQL account with the sysadmin server role for the target SQL instance.             |
|            |                                                  |     **Note:** If you plan to use this authentication method, the target database server must be configured to support SQL authentication. |
| (Optional) | Step 6 Create a dedicated service account.        | Workflow selects the IIS Application Pool accounts and the NETWORK SERVICE account to be your Process Manager’s run-time accounts by default. However, Symantec recommends that you use a dedicated service account to be the Process Manager’s run-time account.  
|            |                                                  | **Note:** This dedicated account must be set up in the target SQL instance. This account is added to the db_owner role on the Process Manager database during installation.  
|            |                                                  | See “Creating a dedicated service account” on page 73.                                           |
Table 4-3  Setting up the Workflow computer for Workflow installation (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Optional)</td>
<td>Step 7</td>
<td>Set up the Workflow computer for SSL/HTTPS encryption.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Prepare your Workflow computer so that you can enable SSL/HTTPS encryption</td>
</tr>
<tr>
<td></td>
<td></td>
<td>during installation:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Obtain your SSL certificate.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Record the <strong>Issued To</strong> name on the certificate for later.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> The <strong>Issued To</strong> name on the SSL certificate must match the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>name or IP of your server. If it does not, you must create a DNS Alias</td>
</tr>
<tr>
<td></td>
<td></td>
<td>record (CNAME in Microsoft parlance) in DNS so that the name on the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>certificate can be resolved.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Apply the certificate and configure your HTTPS port bindings in Windows</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Server IIS settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Verify that you can access the default webpage in IIS using SSL/HTTPS.</td>
</tr>
</tbody>
</table>

Installing SQL Server support components on the Workflow computer

If the SQL Server instance is not on the same computer as Workflow, you must install additional SQL Server components on the Workflow computer. These components are part of a feature pack for Microsoft SQL Server.

See “Supported operating systems for Workflow” on page 60.

This task is a step in the process for setting up the Workflow computer.

See “Setting up the Workflow computer” on page 69.
To install SQL Server support components on the Workflow computer

1. Log on to the Workflow computer with the Workflow installation account.

2. Depending on your SQL Server version, download the correct feature pack from the following locations:


3. Install the following components from the feature pack:
   - Microsoft SQL Server Native Client
   - Microsoft ADOMD.NET
   - Microsoft SQL Server Management Objects (SMO)

Note: Depending on your version of SQL Server, Microsoft may require you to install additional feature pack components. For example, you may be required to install SQL Server CLR Types feature pack components before installing Microsoft SQL Server Management Objects (SMO).
Creating a dedicated service account

Workflow selects the **IIS Application Pool** accounts and the **NETWORK SERVICE** account to be your Process Manager’s run-time accounts by default. However, Symantec recommends that you use a dedicated service account to be the Process Manager’s run-time account.

---

**Note:** This dedicated account must be set up in the target SQL instance. This account is added to the **db_owner** role on the Process Manager database during installation.

---

This task is a step in the process for setting up the Workflow computer.

See “Setting up the Workflow computer” on page 69.


To create a dedicated service account

1. Create a new user account as follows:

   - Use the Computer Management tool. Create a new local user account.
   - Use the Active Directory and Computers tool. Create a new domain account.

2. Name the account appropriately.

   For example: `<WorkflowService>`

3. Uncheck **User must change password at next logon** and check **Password never expires**.

   Make sure that you use a strong password for the account.

4. Assign the **ASP.NET** permissions to the new account by running the following command from a command prompt:

   ```
   aspnet_regiis -ga MachineName\AccountName
   ```

   The **MachineName** is the name of your server or the domain name, if you use a domain account.

   The **AccountName** is the name of your custom account.
Downloading the Workflow Installer

Before you can install Workflow, you must download the Workflow installer to your computer.

This instruction is a step in the process for installing Workflow.

See “Process for installing Workflow” on page 65.

To download the Workflow Installer

1. On the computer where you plan to install Workflow, open a browser and log on to the Symantec Management Console.
   - Open Internet Explorer
   - Type http://<FQDN>/altiris/console
   - In the Windows Security dialog box, type your credentials and click OK.

2. In the Symantec Management Console, on the Manage menu, click Workflows.

3. In the left pane, expand Workflows and then click Download Workflow Server and Designer.

4. In the right pane, in the Downloads section, click Download Workflow Server and Designer.

5. Save the Workflow Installer to your computer.

See “Installing Workflow” on page 74.

Installing Workflow

The Symantec Workflow Solution Setup Wizard guides you through the installation of Workflow. During installation, you can select which features of the Workflow to install.

See “About Workflow Server” on page 42.

See “Configuration options for Workflow installations” on page 49.

See “Server configuration options for the Workflow installation” on page 60.

See “Downloading the Workflow Installer” on page 74.

See “Process for upgrading Workflow” on page 94.

This task is a step in the process for installing Workflow.

See “Process for installing Workflow” on page 65.

Symantec recommends the following two Workflow configurations:
Table 4-4  Recommend Workflow configurations

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Features</th>
</tr>
</thead>
</table>
| Workflow Server production computer, Workflow test computer, or Workflow design computer | You can install all the Workflow features:  
  ■ Workflow Server  
  ■ Workflow Designer  
  ■ Process Manager Portal  
  ■ Process Manager Database  
  In a production environment, you install the Process Manager database off-box on your SQL Server.  
  In a test environment, you can install the Process Manager database on-box, but first, you must install SQL Server on your testing computer. |
| Workflow design computer                         | You can install the following Workflow features:  
  ■ Workflow Designer  
  ■ Workflow Server |

Figure 4-1  Workflow design computers publishing to a Workflow Server production computer
To install Workflow

1. Log in to the Workflow computer.
   
   If you plan to use a Windows Integrated Authentication account for your Workflow installation account, you must log in as this account.

   
   If a message appears to let you know that the computer does not meet all requirements, close the wizard, and install the missing items.

3. In the Open File - Security Warning dialog box, click Run.


5. On the Maintenance page, click New Install. In the Settings section, perform any of the following actions:

   Check Use Settings File. Lets you import the installation settings from an XML settings file that was created during a previous Workflow installation.

   Typically, you use this settings file for support purposes or when you need to reinstall Workflow.

   The saved settings appear in the pages of the Symantec Workflow Solution Setup Wizard as you step through the installation.
Check **Show Advanced Settings During Installation**. Let you configure the advanced settings by displaying additional pages in the **Symantec Workflow Solution Setup Wizard**.

If you do not select this option, the default settings are used in those instances.

When you select this option, the following pages and settings appear:

- **Install Location** page
  Lets you specify the Workflow installation folder and the **Start** menu folder for the Workflow shortcuts.

- **Workflow Designer Tasks** page
  Lets you configure the Workflow Designer settings.

- **Database Replication** page
  Lets you configure and create a database that replicates certain data from the Process Manager database. You can replicate the data for archiving purposes or for historical data reporting.

- **System Accounts Access** page
  Lets you specify which accounts on your system are granted access to the Process Manager database. These accounts are used to run queries on the database.

- **Process Manager Configuration** page
  Lets you name and configure the Process Manager virtual directory.

- **SymQ ORM** page
  Lets you specify how to enable communications between the Process Manager database and the workflow details. The workflow details include data such as task assignments and deadlines.

When you are finished, click **Next**.
6 On the **Server Roles** page, select the following options:

**Note:** For load balancing information about background processing:
See "Installing the Front End Servers" on page 672.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Workflow Server</strong></td>
<td>Lets you install the Workflow Server software. The Workflow Server software is the server-side software that includes the workflow extensions that are required to run the core workflow processes. Workflow Server is required for all Workflow installation situations.</td>
</tr>
<tr>
<td><strong>Background Processing</strong></td>
<td>Lets you enable timeouts and escalations for your workflow processes. Unless you have a specific reason for turning off background processing, Symantec recommends that you leave this option checked. <strong>Note:</strong> For load balancing information about background processing: See “Optional instructions for setting up a dedicated background processing server” on page 676.</td>
</tr>
<tr>
<td><strong>Workflow Designer</strong></td>
<td>Lets you install the Workflow Designer tool, which lets you create and edit workflow processes. Unless you have a specific reason for not requiring Workflow Designer in your Workflow installation scenario, Symantec recommends that you leave this option checked.</td>
</tr>
<tr>
<td><strong>Process Manager Portal</strong></td>
<td>Lets you install the Process Manager portal. The Process Manager portal is a web portal that lets you manage the various parts of a workflow process such as tasks, documents, and data. Unless you install Workflow Designer on a workstation, Symantec recommends that you leave this option checked. The Process Manager portal is required for Process Manager database installation.</td>
</tr>
</tbody>
</table>
Process Manager Database  Lets you set up the Process Manager database.

Unless you install Workflow Designer on a workstation, Symantec recommends that you leave this option checked.

Process Manager database is required for Process Manager portal installation.

When you are finished, click Next.

7  (Installing Process Manager only) On the IIS Restart Confirmation page, read the message about IIS restarting, and if you are ready to continue, click Next.

8  (Advanced Setting) On the Install Location page, specify the following information:

Install Location  Lets you specify where to install Workflow.

The default installation location is as follows:

C:\Program Files\Symantec\Workflow\  

Start Menu Folder  Lets you determine where to install the Program shortcuts.

Do not create shortcuts  

- You can use the default Start menu path and folder name:
  
  Symantec\Workflow  

- You can type the path and the folder name in the Start menu in which to create the Program shortcuts.
- You can choose not to create shortcuts.

When you are finished, click Next.
9 On the **Server Configuration** page, select and type the following information:

**Note:** For load balancing information about server configuration:

See “**Things to note during installation**” on page 671.

<table>
<thead>
<tr>
<th>Table Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Web Site</strong></td>
<td>Lets you specify the IIS website to which your projects are published by default. You must use the website name as it is listed in IIS. The drop-down list contains the websites that are available in IIS.</td>
</tr>
<tr>
<td><strong>Base URL</strong></td>
<td>Lets you specify the IP address, Fully Qualified Domain Name (FQDN) or NETBIOS equivalent for the Workflow Server computer. If you type this information, make sure that it is resolvable. You do not need to include the scheme prefix (http:// or https://). <strong>Note:</strong> If you use SSL/HTTPS encryption, the <strong>Base URL</strong> address must match the <strong>Issued To</strong> name on the SSL certificate that you installed in IIS.</td>
</tr>
<tr>
<td><strong>Use SSL (https://)</strong></td>
<td>Lets you use secure (encrypted) connections to the Workflow Server computer. <strong>Note:</strong> This option does not configure IIS to use SSL. You must have already configured IIS with an HTTPS certificate and bindings.</td>
</tr>
<tr>
<td><strong>Task Tray Application Run when installation completes</strong></td>
<td>Starts the Task Tray Application when the installation finishes. This application runs in the task tray and provides access to the shortcuts that let you administer and troubleshoot the Workflow installation.</td>
</tr>
</tbody>
</table>

When you are finished, click **Next**.

10 (Advanced Setting) (Installing Workflow Designer only) On the **Workflow Designer Tasks** page, select any of the following options:
These options let you determine if and where the Workflow Designer shortcuts are installed. By default, Desktop is checked.

Workflow Designer Shortcuts
- Desktop
- Quick Launch

Old Tool Preferences refers to the task tray application settings and the Workflow Designer tool settings. These settings can be carried over from a previous Workflow installation when you upgrade to Workflow.

You can configure Workflow Designer to use old tool preferences after installation. On the Windows Start menu, click All Programs > Symantec > Workflow > Workflow Designer > Tools > ToolPreferencesEditor.

When you are finished, click Next.
11 (Optional) On the **SMP Server Credentials** page, check **Use SMP**, and select and type the information for the Workflow to Symantec Management Platform connection.

You can use Workflow without a connection to an instance of the Symantec Management Platform. You can still create, edit, and publish workflow projects. However, if you want to use power of Workflow Enterprise Management to manage your Workflow environments and your Workflow projects, you must configure a connection to a Symantec Management Platform computer.

You can configure a Symantec Management Platform connection during installation. After installation, you can add, edit, and remove Symantec Management Platform connections with Workflow Explorer. On the Workflow Server computer, open Workflow Explorer. In the toolbar at the top of the page, click **Credentials**. In the left pane, click **Symantec Management Platform**.

<table>
<thead>
<tr>
<th>Name of the Symantec Management Platform computer</th>
<th>Lets you specify the name of the Symantec Management Platform computer to which you want to connect your Workflow Server computer. If you use multiple versions of the Symantec Management Platform, specify the one that you want to use manage your Workflow environments.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain</td>
<td>Lets you specify the domain for the user who is specified in the credentials. If you use a Symantec Management Platform computer account, you can leave this text box blank.</td>
</tr>
<tr>
<td>User name</td>
<td>Lets you enter the credentials that the Workflow Server computer can use to interact with the Symantec Management Platform computer. The credentials must be for a user who has administrative rights.</td>
</tr>
<tr>
<td>Password</td>
<td></td>
</tr>
<tr>
<td><strong>Use HTTPS</strong></td>
<td>Lets you use secure (encrypted) connections from the Workflow Server computer back to the Symantec Management Platform computer. If you use SSL on the Symantec Management Platform, you need to check <strong>Use HTTPS</strong>.</td>
</tr>
<tr>
<td><strong>Test</strong></td>
<td>Lets you validate your connection information and the connection to the Symantec Management Platform computer.</td>
</tr>
</tbody>
</table>

For more information about using Workflow with the Symantec Management Platform:
See “About Workflow and the Symantec Management Platform” on page 568.

When you are finished, click Next.

12 (Installing Process Manager only) On the Database Connection page, specify the following information:

Note: For load balancing information about the database connection:
See “Things to note during installation” on page 671.

<table>
<thead>
<tr>
<th>Data Source</th>
<th>Lets you type the IP address or the domain name of the SQL Server on which to install the Process Manager database.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Base</td>
<td>Lets you type the name of the Process Manager database. You should use a unique name, such as <code>&lt;ProcessManager&gt;</code>. Database names cannot contain spaces.</td>
</tr>
<tr>
<td>Connect using</td>
<td>Lets you specify the authentication method for Workflow to connect to the Process Manager database.</td>
</tr>
<tr>
<td></td>
<td>The options are as follows:</td>
</tr>
<tr>
<td></td>
<td>■ Windows Integrated Security</td>
</tr>
<tr>
<td></td>
<td>■ MS SQL Server Security</td>
</tr>
<tr>
<td></td>
<td>■ Windows Integrated Security</td>
</tr>
<tr>
<td></td>
<td>Lets you use a domain account. This option uses the currently logged in user’s Windows account. This account requires <code>sysadmin</code> permissions on the SQL Server.</td>
</tr>
<tr>
<td></td>
<td>■ MS SQL Server Security</td>
</tr>
<tr>
<td></td>
<td>Lets you use an SQL account. When you select this option, you can type a valid User ID and Password. If you plan to use this authentication method, the target database server must be configured to support SQL authentication.</td>
</tr>
<tr>
<td>Test</td>
<td>Lets you validate your connection information and the connection to the server. If the test fails, check the authentication settings first. They are the most common cause of connection failures.</td>
</tr>
</tbody>
</table>

When you are finished, click Next.
13  (Installing Process Manager only) On the **Database Configuration** page, verify the Server source and database name.

This information is obtained from the **Database Connection** page. This information is for the computer on which to install the Process Manager database.

(Optional) To generate your database using a case-sensitive collation, check **Make database case sensitive**.

This option provides compatibility with other databases that are case-sensitive, and your reporting needs require SQL to query data across both databases.

Normally, this option is not required. The recommended configuration is to leave this option unchecked.

When you are finished, click **Next**.

14  (Optional) (Advanced Setting) (Installing Process Manager only) On the **Database Replication** page, check **Install Replication Database**, and select and type the following information:

This option lets you create and configure a database that replicates data from the Process Manager database. In the Process Manager, on the **Replication Schedule List** page, you can set up replication schedules and specify which data from the Process Manager database you want to replicate.

- **Data Source**
  - Lets you type the IP address or the domain name of the SQL Server on which to install the replication database.
  - Typically, the replication database resides on the same SQL Server computer as the Process Manager database.

- **Data Base**
  - Lets you type the name of the replication database. You should use a unique name, such as `<ProcessManagerReplication>`.
  - Database names cannot contain spaces.
Connect using

- **Windows Integrated Security**
  Lets you use a domain account.
  This option uses the currently logged in user’s Windows account. This account requires sysadmin permissions on the SQL server.

- **MS SQL Server Security**
  Lets you use an SQL account.
  When you select this option, you can type a valid **User ID** and **Password**.
  If you plan to use this authentication method, the target database server must be configured to support SQL authentication.

Test

Lets you validate your connection information and the connection to the server.

If the test fails, check the authentication settings first. They are the most common cause of connection failures.

When you are finished, click Next.

15 (Advanced Setting) (Installing Process Manager only) On the System Accounts Access page, specify the system accounts that can access the Process Manager database.

Workflow selects the IIS APPPOOL accounts and the NETWORK SERVICE account, by default. However, Symantec recommends that you use a dedicated service account instead of the default accounts.

**Specify which accounts on your system will be granted access to database**

Lets you select which accounts should be granted access to the Process Manager database.

If using a dedicated service account, you can uncheck all default options.

**Specify additional account if needed and press "Add"**

Lets you add any additional accounts that should be granted access to the Process Manager database.

**Add**

If using a dedicated service account, you can enter that account here.

When you are finished, click Next.
16 (Advanced Setting) (Installing Process Manager only) On the Process Manager Configuration page, specify the following information to configure the Process Manager:

- **Virtual Directory**
  - Lets you specify the name of the Process Manager virtual directory. The default name is `ProcessManager`.
  - This directory name forms the last part of the URL through which users access the Process Manager.

- **Shortcuts**
  - Desktop
  - Quick Launch
  - Lets you determine if and where to install the Process Manager shortcuts.

- **User Welcome Message**
  - Sends welcome message to users as they’re added to the portal
  - Lets you send an email message to new users when they are added to the Process Manager.

- **Critical Errors**
  - This option lets you decide where to write the errors that occur when you debug or execute published workflows.
    - When this option is checked, errors are written to the Process Manager database.
    - When this option is unchecked, errors are written to the CMDB of the Symantec Management Platform connection that you specified previously on the SMP Server Credentials page.

If you do not configure a Symantec Management Platform connection on the SMP Server Credentials page, this option is checked and enforced.

When you are finished, click Next.

17 (Installing Process Manager only) On the Process Manager Authentication page, specify the credentials for the administrator account as follows:

The administrator account is used to set up and manage users, permissions, and other settings in the Process Manager.
**User ID**

Let you enter the ID for the administrator account. You must use an email account format for the user ID. For example:

<admin@symantec.com>

- Symantec recommends that you use a native account so that the account does not rely on any external systems. This account is created during installation so that it is available for the administrator who first logs on to Process Manager.
- If you use an Active Directory account, this account uses the password that you provide during installation until that account synchronizes with Active Directory. After installation, it uses the accounts Active Directory password. The Workflow computer must be able to access the Active Directory server to complete the Process Manager authentication after synchronization.

**Password**

Lets you type the password for the administrator account.

**Retype Password**

If you use a native admin account and, you need to change the administrator password after installation, you can use the ChangeAdminPassword.exe.

**Note:** If you change the Administrator password, you must also update the password manually in the Local Machine Info on all computers that point to the Process Manager.

When you are finished, click **Next**.

**18** On the **Workflow Persistence** page, select where to store workflow details data, such as task assignments and deadlines.

**Note:** For load balancing information about workflow persistence and the database connection:

See “Installing the Front End Servers” on page 672.
Workflow Persistence

Lets you specify where to store workflow details. Select one of the following options:

- **Based on exchange**
  The data is stored on the Workflow Server’s File System. This method is less secure than the SQL Server-based storage.
  
  **Note:** Symantec recommends that you do not select this option for production environments.

- **Based on SQL Server Database**
  The data is stored on a SQL server. Symantec recommends that you select this option.

Database Connection

Lets you select the SQL Server on which to store the workflow details. Select one of the following options:

- **Use Process Manager Settings**
  Lets you use the same SQL Server as the Process Manager database. Symantec recommends that you select this option.

- **Custom Settings**
  Lets you store the workflow details in a separate database and specify the connection to the SQL Server on which the database resides. This option is used in rare cases only.
  
  If you choose to use a separate database, you must configure it outside of the Workflow installation using the step 19.

19 In the **Custom Settings**, enter the following fields to configure the database outside of the Workflow installation:

- **Data Source**
  Lets you type the IP address or the domain name of the SQL Server on which to install the replication database.

- **DataBase**
  Lets you type the name of the database. You should use a unique name and it must not contain spaces.
Connect using

- **Windows Integrated Security**
  Lets you use a domain account. This option uses the currently logged in user’s Windows account. This account requires *sysadmin* permissions on the SQL server.

- **MS SQL Server Security**
  Lets you use an SQL account. When you select this option, you can type a valid *UserID* and *Password*. If you plan to use this authentication method, the target database server must be configured to support SQL authentication.

Test

Lets you validate your connection information and the connection to the server.

If the test fails, check the authentication settings first. They are the most common cause of connection failures.

When you are finished, click **Next**.
20 (Advanced Setting) On the **SymQ ORM** page, enable communications between the Process Manager database and the workflow details.

The **SymQ ORM** (Object Relational Mapper) provides an exchange for the data that is passed between the Workflow processes and the Process Manager database. The ORM runs in the background when you use Workflow.

The ORM controls how the process data is stored in the database. The ORM allows for the real-time, dynamic reflection of the data in the database as you enter it in Workflow.

Typically, you select the same settings on this page as you did previously on the **Workflow Persistence** page.

| **No Setup** | Does not let you store the process data and does not let you connect the Object Relational Mapper (ORM). Processes that require multiple user interactions can work only if you store the process data. For example, you create a project that assigns tasks based on a stored task ID. If you do not store that ID, no one can retrieve the task details. |
| **Use Process Manager Settings** | Lets you store the process data. Also lets you use the Process Manager settings to connect the Object Relational Mapper (ORM) using the same SQL server as the Process Manager database. The Process Manager settings are the ones that you specified previously on the **Workflow Persistence** page, in SQL Server settings. Symantec recommends that you use these settings if you install Process Manager. |
| **Custom Settings** | Lets you store the process data in a separate database and specify the connection to the SQL Server on which the database resides. The **Custom Settings** option is used in rare cases only. If you choose to use this option, you must configure all the **Custom Settings** using the step 21. |

21 In the **Custom Settings**, enter the following fields to establish a connection with the database:

| **Data Source** | Lets you type the IP address or the domain name of the SQL Server on which to install the replication database. |
Lets you type the name of the database. You should use a unique name and it must not contain spaces.

Connect using

- **Windows Integrated Security**
  Lets you use a domain account. This option uses the currently logged in user’s Windows account. This account requires *sysadmin* permissions on the SQL server.

- **MS SQL Server Security**
  Lets you use an SQL account. When you select this option, you can type a valid **UserID** and **Password**. If you plan to use this authentication method, the target database server must be configured to support SQL authentication.

Test

Lets you validate your connection information and the connection to the server.

If the test fails, check the authentication settings first. They are the most common cause of connection failures.

When you are finished, click **Next**.

22 On the **System Check** page, review the results of the system check to verify that you meet all the installation requirements.

(Optional) **Save Warnings and Errors To File** symbol (paper with checkmark).

Lets you save an XML file that contains all the settings that you used for the installation.

Typically, you use this settings file for support purposes or when you need to reinstall Workflow.

(Optional) **Save Warnings and Errors To File** symbol (paper with caution sign).

Lets you save a log that contains the descriptions of any warnings and failures that occurred during installation.

When you are finished, click **Next**.

23 On the **Ready To Install** page, review your installation settings, and if they are correct, click **Install**.

24 On the **Installing** page, you can view the installation status.
After the wizard displays the **Installation Finished Successfully** message, click **Finish**.

(Optional) (Using a dedicated service account only) Configure your dedicated service account to be the Process Manager's run-time service account.

See “Configuring the dedicated account to be your Process Manager’s run-time service account” on page 92.

Configuring the dedicated account to be your Process Manager’s run-time service account

Workflow selects the **IIS Application Pool** accounts and the **NETWORK SERVICE** account to be your Process Manager’s run-time accounts by default. However, Symantec recommends that you use a dedicated service account to be the Process Manager’s run-time account.

After you finish installing Workflow, you must configure the dedicated account to be your Process Manager's run-time account.

This task is an optional step in the process for installing Workflow.

See “Process for installing Workflow” on page 65.

To configure the dedicated service account to be your Process Manager’s run-time service account

1. Open Internet Information Services (IIS) Manager.
2. In the left pane, under **Connections**, expand your server name, and click **Application Pools**.
3. In the **Application Pools** pane, right-click **ProcessManagerPool** and click **Advanced Settings**.
4. On the **Advanced Settings** page, in the **Process Model** section, click **Identity**. Then, to the right of **ApplicationPoolIdentity**, click the … symbol.
5. In the **Application Pool Identity** dialog box, click **Custom account** and then click **Set**.
6. In the **Set Credential** dialog box, type your dedicated service account credentials and click **OK**.
   
   Make sure that the user name format is Domain\User.
7. In the **Application Pool Identity** dialog box, click **OK**.
8. Close Internet Information Services (IIS) Manager.
10. In the right pane, right-click **Symantec Workflow Server** and click **Properties**.
11 In the **Symantec Workflow Server Properties (Local Computer)** dialog box, on the **Log On** tab, click **This account**.

12 In the **This account** text box, type the name of or browse for your dedicated service account, click **Apply**, and then click **OK**.

13 Close Services.

14 Reset IIS to apply your changes.

- Open the command prompt.
- Type `iisreset`, and then press **Enter**.
Upgrading Workflow

This chapter includes the following topics:

- Process for upgrading Workflow
- Upgrading Workflow

Process for upgrading Workflow

Upgrading Workflow consists of three parts:

- Upgrade Workflow Solution.
  When you upgrade the Symantec Management Platform you upgrade Workflow Solution. Upgrading the Solution upgrades the Workflow Enterprise Management pages in the Symantec Management Console and the Workflow Installer.

  Upgrading the Solution does not upgrade Workflow Server on the Symantec Management Platform computer. You use the Workflow Installer to upgrade Workflow Server.

- Upgrade your Workflow computers (test, production, and then design).
  You use the Workflow Installer to upgrade your Workflow computers.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Back up your projects.</td>
<td>Create packages for all your projects, and store these packages on a safe directory. Save and check in all the projects that are opened for editing. Close active Workflow Designer applications.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Back up the Process Manager database.</td>
<td>Create a backup of your Process Manager database. Store the database backup on a safe directory.</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Step 3</td>
<td>Install Workflow in a testing environment.</td>
<td>Install Workflow in a testing environment, or upgrade your existing Workflow testing environment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Installing Workflow” on page 74.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Upgrading Workflow” on page 96.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When you install or upgrade your Workflow testing computer, make sure that you configure a connection to a Symantec Management Platform computer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The version of the platform should match the version of Workflow.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Revise your projects.</td>
<td>Open each project and make the necessary changes so that it is compatible with new version of Workflow and the Symantec Management Platform.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Publish revised projects.</td>
<td>Publish your revised projects to the Workflow Server computer.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Test revised projects.</td>
<td>Conduct thorough tests to ensure that your projects work properly. If you encounter any problems, fix the project and republish.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you have 6.x projects that interact with the Symantec Management Platform or with external, non-Workflow APIs, pay special attention to testing these projects. If the platform APIs or external APIs have changed, your projects can be affected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Warning:</strong> Symantec recommends that you test all processes thoroughly before you publish them to a production environment. Publishing untested processes in a production environment can cause significant problems.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Upgrade Workflow on your production computer.</td>
<td>If your production computer and SQL Server computer meet the system requirements, upgrade Workflow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Supported operating systems for Workflow” on page 60.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Upgrading Workflow” on page 96.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If your production computer and SQL Server computer do not meet the system requirements, do a clean install of Workflow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Installing Workflow” on page 74.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Upgrade Workflow on your design computer.</td>
<td>If your design computer meets the system requirements, upgrade Workflow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Supported operating systems for Workflow” on page 60.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Upgrading Workflow” on page 96.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If your design computer does not meet the system requirements, do a clean install of Workflow on a new design computer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Installing Workflow” on page 74.</td>
</tr>
</tbody>
</table>
You can upgrade to Workflow Solution as long as your Workflow computers and SQL computer meet the system requirements. The supported upgrade paths of Workflow Solution from the earlier release versions to the latest release version are as follows:

See “Supported operating systems for Workflow” on page 60.

If your Workflow environment does not meet the system requirements, you need to perform a clean install.

See “Installing Workflow” on page 74.

To upgrade Workflow

1. Download the Workflow Installer to your Workflow computer.
   - In the Symantec Management Console, on the Manage menu, click Workflows.
   - In the left pane, expand Workflows and then click Download Workflow Server and Designer.
   - In the right pane, in the Downloads section, click Download Workflow Server and Designer.
   - Save the Workflow Installer to your computer.


3. In the Open File - Security Warning dialog box, click Run.


5. On the Maintenance page, click Upgrade and then click Next.
   - The Workflow Installer interrogates your Workflow computer and uses that information to populate the pages of the installer during upgrade.

6. On the System Check page, review the results of the system check to verify that you meet all the installation requirements. When you are finished, click Next.
7 On the Ready To Install page, click Install.

Note: Symantec does not recommend modifying your information during upgrade. If you do, your Workflow system may not operate properly after upgrade.

8 On the Installing page, you can view the upgrade status.

9 After the wizard displays the Installation Finished Successfully message, click Finish.
Configuring Workflow

- Chapter 6. Configuring Workflow
- Chapter 7. Managing Active Directory connections
Configuring Workflow

This chapter includes the following topics:

■ Process for configuring Workflow
■ Performing post-migration tasks

Process for configuring Workflow

Once you have installed Workflow, you are ready to configure it.

You can migrate the links to all your published projects of earlier versions to the current version of Symantec Management Platform when you install Symantec Workflow through the Symantec Management Platform.

Migrating your published projects does not bring them over to the Symantec Management Platform server in a functional form. All projects of the earlier versions must be updated and republished on the Symantec Management Platform server.

See “About installing Workflow” on page 46.

To migrate links to published projects

1. In Symantec Management Console, click Manage > Workflows and install Symantec Workflow.

2. At the end of the installation, click Run Notification Migration Wizard, and then click Finish.

3. In the dialog box that appears, click Get Migration Wizard install package for Notification Server data report. Do not click OK.
4 In the open dialog box, copy the **Symantec_Migration_Package** file to your Notification Server computer.

For reference, the migration package on your Symantec Management Platform server is in the following location:

    C: > Program Files > Symantec Installation Manager > MigrationPackage

5 On your Notification Server computer, run the **Symantec_Migration_Package** executable file.

6 In the pre-launch dialog box, click **Ok**.

7 Complete Notification Server upgrade wizard. When you see the **Exporter Configuration** dialog box, on the left, uncheck all the solutions except for Workflow Solution, and then click **Next**.

   If Workflow Solution does not appear in the list, quit migration.

8 Click **Next** even if you see the message, Fails to meet baseline requirements.

   If you see a dialog box indicating that the product readiness check is not satisfied by Workflow, click **Yes**.

9 Click **Next**.

10 When the data export finishes, click **Finish**.

11 Navigate to **C: > Program Files > Altiris > Upgrade > Data** and copy the newly created .adb file over to your Symantec Management Platform server.

   The files in **C: > Program Files > Altiris > Upgrade > Data** are named by the date. Make sure that you get the file with the correct date.

12 After you have copied over the .adb file, on the Notification Server computer, in the **Migration Wizard Instructions** dialog box, click **OK**.

13 In the resulting dialog box, click **Browse**, and select the ADB file that you moved from Notification Server computer.
14 Click Next.

15 In the Exporter Configuration dialog box, on the left, uncheck all the solutions except Workflow Solution, and then click Next.

If Workflow Solution does not appear in the list, quit migration.

16 Complete the wizard.

17 To see your migrated links, open the Symantec Management Console and click Manage > Workflows.

Your migrated project links appear in the tree structure on the left under Published Workflows.

Performing post-migration tasks

If you have performed a migration from an old Workflow Server to a new Workflow Server, then you must manually perform a few configuration tasks after the migration is completed.

A migration is when you execute a fresh installation of latest version of Workflow Server on a new computer, and then use the data from old Workflow Server in the new Workflow Server. The used data may be database, configuration files, custom plug-ins, and so on.

To execute post-migration tasks, complete the following steps:

1 If computer name or IP address were changed after the migration, then complete the following steps on the new Workflow Server:

   - Update the Workflow environment using the Symantec Management Console.
     To update the Workflow environment, you must delete the old servers, and add the new servers in the environment from the Symantec Management Console.

   - Update Symantec Management Platform information for all endpoints using the Credentials Manager.
     You can add credentials in Credentials Manager for the Symantec Management Platform server and solutions. After you have added credentials for certain products, Workflow has access to those products. See “Adding credentials in Credentials Manager” on page 604.

   - Edit the affected computer's settings using Workflow Designer on all endpoints, by executing the following steps:
     - On the Workflow Designer computer, in the notification area, right-click the task tray application, and then click Settings.
In the Machine Settings dialog box, in the left pane, under Local Machine Info, click Servers, and then, on the right, click Add.

In the Edit Object dialog box, modify the computer settings, and then click OK.

2 Manually copy the following Process Manager directories from the old Workflow Server to the new Workflow Server:

- Process Manager Database
- C:\Symantec\Workflow\Workflow Deploy
- C:\Program Files\Altiris\Workflow\Data
- C:\Program Files\Altiris\Workflow\Server Extensions\localserversetup.xml
- C:\Program Files\Altiris\Workflow\ProcessManager\Plugins
- C:\Program Files\Altiris\Workflow\ProcessManager\ProfileServices
- C:\Program Files\Altiris\Workflow\ProcessManager\LuceneFullTextSearch
- Saved path of replication schedule and report schedule
- If the old Workflow Server contained published workflow projects, then the projects must be redeployed manually on the new Workflow Server.
Managing Active Directory connections

This chapter includes the following topics:

- About Active Directory synchronization
- Configuring Active Directory sync profiles
- Managing Active Directory server connections
- Adding Active Directory server connections
- Editing the settings of an Active Directory server connection
- Deleting an Active Directory server connection
- Testing an Active Directory server connection
- Selecting Active Directory as the authentication method
- Managing Active Directory sync profile schedules
- Adding Active Directory sync profile schedules
- Editing an Active Directory sync profile schedule
- Deleting an Active Directory sync profile schedule
- Managing Active Directory sync profiles
- Adding Active Directory sync profiles
- Editing an Active Directory sync profile
- Deleting an Active Directory sync profile
About Active Directory synchronization

If your organization chooses to use Active Directory authentication as its authentication method for Workflow, Workflow can synchronize with Active Directory. This synchronization lets you add and update Active Directory users and organizational units and groups in the Process Manager database. During synchronization, the user, units, and groups data from Active Directory update the user, units, and group data that are in the Process Manager database. The Process Manager database does not store Active Directory passwords or other sensitive Active Directory information.

After you connect Workflow to an Active Directory server, you can add Active Directory sync profiles. These sync profiles let you import the entire Active Directory Forest, Active Directory domain or specific organizational units and groups to the Process Manager database. These units and groups are not the same as the organizational groups that Workflow uses to categorize users.

The communication between Workflow and Active Directory occurs by means of LDAP queries against the Active Directory database. Workflow provides several ways to initiate the synchronization:

The Active Directory synchronization performs the following actions:

- Imports and updates the Active Directory users in Workflow
- Imports and updates the Active Directory organizational units and groups in Workflow

When you use Active Directory authentication, you still can create user accounts and organizational units in Workflow. For example, you might create an account for a short-term contractor who you do not want to add to Active Directory.

After you install Workflow, you can set up your Active Directory server connections, synchronization schedules, and sync profiles. Workflow can then synchronize with Active Directory to obtain new and updated users and groups.
Active Directory synchronization affects the changes and deletions of Workflow user accounts as follows:

- When you delete a user from Active Directory, the user is not deleted from Workflow. The user is only disabled in Workflow.
- Any changes that you make to a user in Workflow are overwritten during the next synchronization.

If you edit user information or delete a user in Active Directory instead, the information is updated in Workflow during the next synchronization. This rule applies to the users group, manager, and organizational unit information.

See “Configuring Active Directory sync profiles” on page 105.

### Configuring Active Directory sync profiles

If your organization chooses to use Active Directory authentication as its authentication method for Workflow, you can configure Active Directory sync profiles. You can use these sync profiles to target an entire Active Directory domain, organizational units and groups, or specific LDAP queries.

After you configure your Active Directory sync profiles, Workflow can synchronize these sync profiles with Active Directory. During synchronization, Workflow can obtain new and updated users and organizational units and groups.

After you configure your Active Directory sync profiles, you can add, edit, or delete your Active Directory server connections, sync profile schedules, and sync profiles. You can manage your Active Directory server connections in Workflow Explorer. You can manage your Active Directory sync profile schedules and sync profiles in Workflow.

See “About Active Directory synchronization” on page 104.

**Table 7-1** Process for configuring an Active Directory sync profile

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Add Active Directory server connections.</td>
<td>In Workflow Explorer, you can connect Workflow with your Active Directory servers. See “Adding Active Directory server connections” on page 108.</td>
</tr>
</tbody>
</table>
## Table 7-1  Process for configuring an Active Directory sync profile (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 2 | Select **Active Directory Authentication** as the authentication type. | In Workflow, you can select Active Directory as your authentication method.  
See “Selecting Active Directory as the authentication method” on page 112.  
Note that after you select Active Directory as your authentication method, you do not need to do it again. Active Directory is now your authentication method. |
| Step 3 | Add automatic sync profile schedules. | In Workflow, you can add automatic Active Directory sync profile schedules.  
See “Adding Active Directory sync profile schedules” on page 113.  
When adding your Active Directory sync profiles, you can use these schedules to schedule the following synchronizations:  
- Update synchronization  
- Full synchronization |
| Step 4 | Add Active Directory sync profiles. | In Workflow, you can add sync profiles for your Active Directory server connections.  
See “Adding Active Directory sync profiles” on page 119. |
| Step 5 | (Optional) Test an Active Directory server connection. | In Workflow, you can test each Workflow to Active Directory server connection.  
See “Testing an Active Directory server connection” on page 111. |
| Step 6 | (Optional) Manually perform a full synchronization for an Active Directory sync profile. | In Workflow, you can manually run full synchronization for the Active Directory sync profiles that you specify.  
See “Running a full Active Directory sync profile synchronization manually” on page 126. |
| Step 7 | (Optional) Manually perform a full Active Directory synchronization for all Active Directory sync profiles. | In Workflow, you can manually perform full synchronization for all your Active Directory sync profiles.  
See “Synchronizing all Active Directory sync profiles manually” on page 128. |
Table 7-1  Process for configuring an Active Directory sync profile (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 8</td>
<td>(Optional) Check the status of an Active Directory sync profile synchronization.</td>
<td>In Workflow, you can view information about the users and organizational units and groups that are synchronized. You can also view the status of the Active Directory sync profile synchronization. See &quot;Checking the status of an Active Directory sync profile synchronization&quot; on page 129.</td>
</tr>
</tbody>
</table>

**Managing Active Directory server connections**

In Workflow Explorer, you can add one or more Active Directory server connections. After you add your Active Directory server connections, you may need to edit the settings of an Active Directory server connection. You may also need to delete an Active Directory server connection. In Workflow Explorer, you can manage your Active Directory server connections.

After you add your Active Directory server connections, you can then add sync profile schedules and sync profiles for them. You can use these sync profile schedules to schedule update and full synchronizations with Active Directory. You can use these sync profiles to import data from Active Directory to the Process Manager database. You can import the entire domain, organizational units and groups on the Active Directory server, or for specific LDAP queries. In Workflow, you can manage these sync profile schedules and sync profiles.

See “About Active Directory synchronization” on page 104.

Table 7-2  Process for managing Active Directory server connections

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Add Active Directory server connections.</td>
<td>In Workflow Explorer, you can connect Workflow with your Active Directory servers. See “Adding Active Directory server connections” on page 108.</td>
</tr>
</tbody>
</table>
Table 7-2  Process for managing Active Directory server connections (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 3    | (Optional) Delete an Active Directory connection.  | In Workflow Explorer, you can delete an Active Directory server connection.  
See “Deleting an Active Directory server connection” on page 110. |
| Step 4    | (Optional) Test an Active Directory server connection. | In Workflow, you can test the Active Directory server connection.  
See “Testing an Active Directory server connection” on page 111.  
Note that you can only test an Active Directory server connection after you add a sync profile for that server connection. |

**Adding Active Directory server connections**

If your organization uses Active Directory authentication as its authentication method for Workflow, you may need to add one or more Active Directory server connections. In Workflow Explorer, you can add Active Directory server connections at any time. For example, you might need to connect to an Active Directory server in a new location.

See “Configuring Active Directory sync profiles” on page 105.

See “Managing Active Directory server connections” on page 107.

Before you add an Active Directory server connection, you need to collect the following information:

- NETBIOS domain name of the Active Directory server computer
- Credentials for Active Directory  
  The user name and password of an account that can connect to the Active Directory and retrieve user information

**To add Active Directory server connections**

1. On the computer on which Workflow Designer is installed, click **Start > All Programs > Symantec > Workflow Designer > Tools > Workflow Explorer**.

2. On the **Symantec Workflow Explorer** screen in the toolbar at the top of the screen, click **Credentials**.

3. In the left pane, click **Active Directory**.
4 In the right pane, click Add New.

5 In the New AD Connection Profile dialog box under Remote Security, enter the IP address or computer name of the domain controller in the Domain Controller field. We recommend that you make sure the domain controller is available by pinging the address. In the Domain field, enter the NETBIOS Domain name. Then enter the credentials for the domain controller.

6 Under Connection Parameters, change the Default Timeout setting, if necessary.

7 Under General, type the name of the profile.

8 If this profile is the default profile, check Is Default.

9 Under Remote Security, type the NETBIOS name of the domain that you want to authenticate.

10 Type the user name and password.

11 Click OK.

12 Repeat steps 4 through 11 for each additional server connection.

13 Close Workflow Explorer.

14 (Optional) If you have not selected Active Directory as your authentication method, then you need to select Active Directory Authentication as your authentication method.

   See “Selecting Active Directory as the authentication method” on page 112.

### Editing the settings of an Active Directory server connection

After you add your Active Directory server connections, you may need to edit the settings of an Active Directory server connection. In Workflow Explorer, you can edit any of the Active Directory servers to Workflow connections. For example, if you need to change the user name and password for an Active Directory server connection, you can change it.

If you need to convert native users to Active Directory users, you can do so in Process Manager Active Directory Settings. These settings appear in the Workflow Portal on the Master Settings page.

See “Managing Active Directory server connections” on page 107.
To edit the settings of an Active Directory server connection

1. On the computer on which Workflow Designer is installed, click **Start > All Programs > Symantec > Workflow Designer > Tools > Workflow Explorer**.

2. On the Symantec Workflow Explorer screen in the toolbar at the top of the screen, click **Credentials**.

3. In the left pane, click **Active Directory**.

4. In the right pane, select the Active Directory server connection profile that you want to edit.

5. In the right pane, click **Edit**.

6. In the **Edit AD connection settings** dialog box, edit the settings as needed.

7. When you are finished, click **OK**.

8. Close Workflow Explorer.

9. After you edit the settings of an Active Directory server connection, any existing Active Directory Sync Profiles must be opened and resaved.

   (Optional) After you edit the settings of an Active Directory server connection, you may want to test the server connection.

   See “Testing an Active Directory server connection” on page 111.

## Deleting an Active Directory server connection

After you add your Active Directory server connections, you may need to delete an Active Directory server connection. In Workflow Explorer, you can delete an Active Directory server connection. For example, you may need to replace your current Active Directory server computer. In Workflow Explorer, you can delete that server connection.

**Note:** You cannot delete an Active Directory server connection that any of your Active Directory sync profiles currently use to import data. Before you can delete that Active Directory server connection, you must perform one of the following actions: Delete all the sync profiles for that Active Directory server connection, or switch all the sync profiles to another server connection. You can delete an Active Directory server connection only after it is no longer used by any of your sync profiles.

See “Managing Active Directory server connections” on page 107.
See “Managing Active Directory sync profiles” on page 117.
To Delete an Active Directory server connection
1. On the computer on which Workflow Designer is installed, click Start > All Programs > Symantec > Workflow Designer > Tools > Workflow Explorer.
2. On the Symantec Workflow Explorer screen in the toolbar at the top of the screen, click Credentials.
3. In the left pane, click Active Directory.
4. In the right pane, select the Active Directory server connection profile that you want to delete.
5. In the right pane, click Delete.
6. In the confirmation message dialog box, click OK.

Testing an Active Directory server connection

After you configure your Active Directory sync profiles, you can test any of your Active Directory server connections. For example, you may want to test the server connection before you run a manual synchronization or after an automatic synchronization fails. In Workflow, you can test the connection on the Active Directory Sync Profiles page.

Note: If the connection test fails, report it to the administrator who manages your Active Directory servers.

See “Configuring Active Directory sync profiles” on page 105.
See “Managing Active Directory server connections” on page 107.
See “Managing Active Directory sync profiles” on page 117.

To test an Active Directory server connection
1. In the Workflow portal, click Admin > Active Directory > Sync Profiles.
2. On the Active Directory Sync Profiles page, under Active Directory Sync Profiles, at the far right of the specific sync profile name, click the Actions symbol (orange lightning), and click Test AD Server.
3. After you view the message that reports the success or failure of the connection, you can close the message dialog box.
Selecting Active Directory as the authentication method

If you want to use Active Directory as your authentication method for Workflow, you must first add an Active Directory server connection. Then, you can select Active Directory as your authentication method in the Workflow Portal on the Master Settings page.

Note: You do not need to reselect Active Directory as your authentication method to add additional Active Directory server connections or sync profiles.

After you select Active Directory as your authentication method, you can add Active Directory sync profiles for your Active Directory server connections.

See “Configuring Active Directory sync profiles” on page 105.
See “Adding Active Directory server connections” on page 108.

To select Active Directory as the authentication method

1. In the Workflow portal, click **Admin > Portal > Master Settings**.
2. On the Master Settings page, expand the **Process Manager Active Directory Settings** section.
3. In **Process Manager Active Directory Settings** section, check **Active Directory Authentication**.
4. (Optional) In the **Process Manager Active Directory Settings** section, select any of the other options that are appropriate for your environment. You can also type information for the Active Directory users that you do not want to import to Workflow.
5. Scroll down to the bottom of the Master Settings page and click **Save**.

Managing Active Directory sync profile schedules

In Workflow, you can add Active Directory sync profile schedules. These schedules let you schedule automatic update and full synchronizations between your sync profiles and the Active Directory servers to which they are connected. After you add your Active Directory sync profile schedules, you may need to edit a sync profile schedule. You may also need to delete a sync profile schedule. In Workflow, you can manage your Active Directory sync profile schedules.

See “Managing Active Directory sync profiles” on page 117.
### Table 7-3

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 1 | Add automatic synchronization schedules. | In Workflow, you can add automatic Active Directory sync profile schedules. See “Adding Active Directory sync profile schedules” on page 113. When adding or editing your Active Directory sync profiles, you can use these schedules to schedule the following synchronizations:  
- Update synchronization  
- Full synchronization |

### Adding Active Directory sync profile schedules

In Workflow, you can add Active Directory sync profile schedules so that they are available when adding your Active Directory sync profiles.

For example, you add an Active Directory server connection. You know the organizational units and groups that you want your Active Directory sync profiles to import from Active Directory to the Process Manager database. Now, you need to add Active Directory sync profile schedules. After you add these schedules, you can use them to schedule an update and full synchronization when adding these Active Directory sync profiles.
Note: Name your Active Directory sync profile schedules so that you can easily associate them with the sync profiles to which you want to assign them. If you ever need to edit the synchronization schedules for any of your Active Directory sync profiles, you must do so on the Active Directory Sync Profile Schedule page. You cannot edit the schedule while editing an Active Directory sync profile; you can only select a different schedule or add a new one.

After you add your Active Directory sync profile schedules, they appear in the drop-down lists for the Schedule For Full Sync Profile or Schedule For Update Sync Profile fields. These fields appear in the Add Schedule for Active Directory Server dialog box. This dialog box appears during the addition of an Active Directory sync profile.

The Schedule For Update Sync Profile field lets you schedule an automatic synchronization that only updates the changes that have been made to Active Directory since the last synchronization. The Schedule For Full Sync Profile field lets you schedule an automatic synchronization that updates the entire Active Directory domain or entire organizational units or groups.

See “Configuring Active Directory sync profiles” on page 105.

See “Managing Active Directory sync profiles” on page 117.

See “Managing Active Directory sync profile schedules” on page 112.

See “Methods for synchronizing Active Directory sync profiles” on page 125.

To add Active Directory sync profile schedules

1. In the Workflow portal, click Admin > Active Directory > Sync Profile Schedule.

2. On the Active Directory Sync Profile Schedule page, at the far right of the Active Directory Sync Profile Schedule title bar, click the Add Sync Profile Schedule symbol (green plus sign).

3. In the Sync Profile Schedule dialog box, enter the following information:

   Name  
   Lets you name your synchronization schedule.
Select type of schedule  
Lets you select when you want the synchronization to occur.

The following options let you make additional choices for when the synchronization occurs:

- **Weekly**  
  Lets you select which day or days of the week you want the synchronization to occur.

- **Monthly**  
  Lets you specify which day of the month you want the synchronization to occur.

- **One time only**  
  Lets you select the date that you want the one time synchronization to occur.

Start time  
Lets you select what time you want the synchronization to start.

4  When you are finished, click **Save**.

5  Repeat steps 2 through 4 to add more Active Directory sync profile schedules.

**Editing an Active Directory sync profile schedule**

After you add your Active Directory sync profile schedules, you can edit any synchronization schedule. In Workflow, you can edit an Active Directory sync profile schedule. For example, after you add an Active Directory sync profile schedule, you discover that it interferes with a maintenance schedule. Now, you need to change the start time of a full synchronization or the time that you want the synchronization to occur.

**Note:** The changes that you make to an Active Directory sync profile schedule affect any of the sync profiles to which you added that schedule.

After you edit an Active Directory sync profile schedule, the edited schedule appears in the drop-down lists for the **Schedule For Full Sync Profile** or **Schedule For Update Sync Profile** fields. These fields appear in the **Edit Schedule for Active Directory Server** dialog box. This dialog box appears during the edit of an Active Directory sync profile.

The **Schedule For Update Sync Profile** field lets you schedule an automatic synchronization that only updates the changes that have been made to Active Directory since the last synchronization. The **Schedule For Full Sync Profile** field
lets you schedule an automatic synchronization that updates the entire Active Directory domain or entire organizational units or groups.

See “Managing Active Directory sync profile schedules” on page 112.

See “Managing Active Directory sync profiles” on page 117.

To edit an Active Directory sync profile schedule

1 In the Workflow portal, click Admin > Active Directory > Sync Profile Schedule.

2 On the Active Directory Sync Profile Schedule page, at the far right of the specific sync profile schedule name, click the Actions symbol (orange lightning), and click Edit AD Sync Profile Schedule.

3 In the Edit Active Directory Sync Profile Schedule dialog box, edit any of the following information:

   Name
   Lets you name your synchronization schedule.

   Select type of schedule
   Lets you select when you want the synchronization to occur.
   The following options let you make additional choices for when the synchronization occurs:
   - Weekly
     Lets you select which day or days of the week you want the synchronization to occur.
   - Monthly
     Lets you specify which day of the month you want the synchronization to occur.
   - One time only
     Lets you select the date that you want the one time synchronization to occur.

   Start time
   Lets you select what time you want the synchronization to start.

4 When you are finished, click Save.

Deleting an Active Directory sync profile schedule

After you add your Active Directory sync profile schedules, you can delete update or full synchronization schedules. In Workflow, you can delete an Active Directory sync profile schedule. For example, you may need to delete an obsolete schedule.
Note: You cannot delete a sync profile schedule that any of your Active Directory sync profiles currently use. You must edit all sync profiles that use that schedule and select a different update or full synchronization schedule for them to use.

After you delete your Active Directory sync profile schedule, it no longer appears in the drop-down lists for the Schedule For Full Sync Profile or Schedule For Update Sync Profile fields. These fields appear in the Add Schedule for Active Directory Server or Edit Schedule for Active Directory Server dialog boxes. These dialog boxes appear during the addition or edit of an Active Directory sync profile.

See “Managing Active Directory sync profile schedules” on page 112.

See “Editing an Active Directory sync profile schedule” on page 115.

See “Managing Active Directory sync profiles” on page 117.

To delete an Active Directory sync profile schedule

1  In the Workflow portal, click Admin > Active Directory > Sync Profile Schedule.

2  On the Active Directory Sync Profile Schedule page, at the far right of the specific sync profile schedule name, click the Actions symbol (orange lightning), and click Delete Schedule.

3  In the confirmation message dialog box, click OK.

Managing Active Directory sync profiles

After you add your Active Directory server connections and select Active Directory as your authentication method, you can then add sync profiles for the connections. You can also edit and delete Active Directory sync profiles. In Workflow, you can manage your Active Directory sync profiles.

You can use these Active Directory sync profiles to import data from Active Directory to the Process Manager database. You can target the entire domain, organizational units and groups on the Active Directory server, or specific LDAP queries. You manage these sync profiles in the Workflow portal.

Before you begin adding your Active Directory sync profiles, you can add synchronization schedules for the sync profiles. After you add or edit an Active Directory sync profile, you may want to run a full synchronization manually before the next scheduled, automatic synchronization.

See “Managing Active Directory server connections” on page 107.

See “Managing Active Directory sync profile schedules” on page 112.
See “Methods for synchronizing Active Directory sync profiles” on page 125.

Table 7-4  Process for managing Active Directory sync profiles

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 1 | Add automatic synchronization schedules.                               | In Workflow, you can add automatic Active Directory sync profile schedules.  
|        |                                                                        | See “Adding Active Directory sync profile schedules” on page 113.  
|        |                                                                        | When adding or editing your Active Directory sync profiles, you can use these schedules to schedule the following synchronizations.  
|        |                                                                        | ■  Update synchronization  
|        |                                                                        | ■  Full synchronization  
| Step 2 | Add Active Directory sync profiles.                                    | In Workflow, you can add sync profiles for your Active Directory server connections.  
|        |                                                                        | See “Adding Active Directory sync profiles” on page 119.  
| Step 3 | (Optional) Edit automatic synchronization schedules.                   | In Workflow, you can edit an automatic Active Directory sync profiles schedule.  
|        |                                                                        | See “Editing an Active Directory sync profile schedule” on page 115.  
| Step 4 | (Optional) Delete an automatic synchronization schedule.               | In Workflow, you can delete an automatic Active Directory sync profiles schedule.  
|        |                                                                        | See “Deleting an Active Directory sync profile schedule” on page 116.  
| Step 5 | (Optional) Edit an Active Directory sync profile.                     | In Workflow, you can edit an Active Directory sync profile.  
|        |                                                                        | See “Editing an Active Directory sync profile” on page 122.  
| Step 6 | (Optional) Delete an Active Directory sync profile.                   | In Workflow, you can delete an Active Directory sync profile.  
|        |                                                                        | See “Deleting an Active Directory sync profile” on page 124.  |
Table 7-4  Process for managing Active Directory sync profiles (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 7</td>
<td>(Optional) Manually perform a full synchronization for an Active Directory sync profile.</td>
<td>In Workflow, you can manually perform full synchronizations for the Active Directory sync profile that you specify.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Running a full Active Directory sync profile synchronization manually” on page 126.</td>
</tr>
<tr>
<td>Step 8</td>
<td>(Optional) Manually perform an update synchronization for an Active Directory sync profile.</td>
<td>In Workflow, you can manually perform update synchronizations for the Active Directory sync profile that you specify.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Running an update Active Directory sync profile synchronization manually” on page 127.</td>
</tr>
<tr>
<td>Step 9</td>
<td>(Optional) Manually perform a full synchronization for all Active Directory sync profiles.</td>
<td>In Workflow, you can manually perform full synchronizations for all your Active Directory sync profiles.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Synchronizing all Active Directory sync profiles manually” on page 128.</td>
</tr>
<tr>
<td>Step 10</td>
<td>(Optional) Check the status of an Active Directory sync profile synchronization.</td>
<td>In Workflow, you can view information about the users and groups that are synchronized and the status of the Active Directory sync profile’s synchronization.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See &quot;Checking the status of an Active Directory sync profile synchronization&quot; on page 129.</td>
</tr>
<tr>
<td>Step 11</td>
<td>(Optional) Test an Active Directory server connection.</td>
<td>In Workflow, you can test each Active Directory server connection.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, the synchronization of an Active Directory sync profile fails. You may want to test the Active Directory server connection.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Testing an Active Directory server connection” on page 111.</td>
</tr>
</tbody>
</table>

Adding Active Directory sync profiles

If your organization uses Active Directory authentication as its authentication method for Workflow, you may need to add Active Directory sync profiles. These sync profiles let you import data from Active Directory to the Process Manager database. After you add your Active Directory server connections, you can add sync profiles
for those connections. In Workflow, you can add Active Directory sync profiles at any time.

You can add Active Directory sync profiles to target the entire forest, entire domain, organizational units and groups on the Active Directory server, or specific LDAP queries. For example, you add a new organizational unit to Active Directory. You can add a sync profile for it in the Workflow portal.

See “Configuring Active Directory sync profiles” on page 105.

See "Managing Active Directory sync profiles" on page 117.

See “Methods for synchronizing Active Directory sync profiles” on page 125.

To add Active Directory sync profiles

1. In the Workflow portal, click Admin > Active Directory > Sync Profiles.

2. On the Active Directory Sync Profiles page, at the far right of the Active Directory Sync Profiles title bar, click the Actions symbol (orange lightning), and click Add AD Sync Profile.

3. In the Add Active Directory Sync Profile dialog box, enter the following information:
   - AD Sync Profile Name
   - Select Connection
   - AD Server Email Domain
   - Auto Create User On Initial Login
   - AD Users Default Groups


4. When you are finished, click Next.

   Note that if you do not enter the critical information or a connection cannot be made, a warning is displayed and you cannot proceed.
5 In the Add Active Directory Sync Profile dialog box under Synchronization Option, select one of the following options:

- **Entire Forest**: Connects Workflow with your entire Active Directory Forest. You can select the root domain or the individual child domains under Active Directory.

- **Domain**: Connects Workflow with your entire Active Directory. By default, none of the domains are selected. The domain in bracket dynamically displays the domain that is configured in the credential profile.

- **Organization units**: Connects Workflow with one or more Active Directory organizational units, which you select from the tree view that appears in this dialog box. The tree view displays the organization units that are defined in the specified Active Directory.

- **Groups**: Connects the Workflow with one or more Active Directory groups, which you select from the tree view that appears in this dialog box. The tree view displays the groups that are defined in the specified Active Directory.

- **Specify LDAP Queries**: Connects Workflow to a specific LDAP Query.

Use the **Refresh Forest** button to refresh and display the Active Directory servers that are available in the Active Directory Forest.

6 When you are finished, click **Next**.

7 In the Add Active Directory Field Mapping dialog box, select which fields in Active Directory you want to map to which fields in Process Manager and click **Next**.

Note that normally you do not need to change any field mapping settings. Symantec recommends that you do not change any mappings to key fields, such as Primary Email ID (Email address), first names, and last names.
In the **Add Schedule for Active Directory Server** dialog box, select a schedule in the drop-down lists for **Schedule For Full Sync Profile** and **Schedule For Update Sync Profile**.

Note that if the proper schedules do not appear in the drop-down lists for **Schedule For Full Sync Profile** or **Schedule For Update Sync Profile**, you must add schedules. Click **Add Schedule**, add your schedules, and click **Save**. Repeat the process if you need to add another schedule. When you are done, the added schedules appear in the drop-down lists.

See “Adding Active Directory sync profile schedules” on page 113.

When you are finished, click **Finish**.

### Editing an Active Directory sync profile

After you add your Active Directory sync profiles, you can edit the settings for any sync profile. In Workflow, you can change the sync profile settings to target a different organizational unit or group on the Active Directory server. You can map a different Active Directory field to a Process Manager field.

See “Managing Active Directory sync profiles” on page 117.

#### To edit an Active Directory sync profile

1. In the Workflow portal, click **Admin > Active Directory > Sync Profiles**.

2. On the **Active Directory Sync Profiles** page, at the far right of the specific sync profile name, click the **Actions** symbol (orange lightning), and click **Edit AD Sync Profile**.

3. In the **Edit Active Directory Sync Profiles** dialog box, you can edit the following information:
   - **AD Sync Profile Name**
   - **Select Connection**
   - **AD Server Email Domain**
   - **Auto Create User On Initial Login**
   - **AD Users Default Groups**


4. When you are finished, click **Next**.

   Note that if you do not enter the critical information or a connection cannot be made, a warning is displayed and you cannot proceed.
In the **Edit Active Directory Sync Profile** dialog box under **Synchronization Option**, you can select a different target for the synchronization. If the target of your synchronizations has changed, select one the following options:

- **Entire Domain**
  Synchronizes Workflow with your entire Active Directory.

- **Organization units**
  Synchronizes Workflow with one or more Active Directory organizational units, which you select from the tree view that appears in this dialog box. The tree view displays the organization units that are defined in the specified Active Directory.

- **Groups**
  Synchronizes Workflow with one or more Active Directory groups, which you select from the tree view that appears in this dialog box. The tree view displays the groups that are defined in the specified Active Directory.

- **Specify LDAP Queries**
  Synchronizes Workflow to a specific LDAP Query.

When you are finished, click **Next**.

In the **Edit Active Directory Field Mapping** dialog box, you can edit which fields in Active Directory you want to map to which fields in Process Manager.

Note that normally you do not need to change any field mapping settings. Symantec recommends that you do not change key fields mapping, such as Primary Email ID (Email address), first names, and last names.

When you are finished, select one of the following options:

- **Save**
  If you do not want to edit the sync profile schedules, click **Save**. The dialog box closes, your changes are saved, and you are finished.

- **Next**
  If you want to edit the sync profile schedules, click **Next**. Go to step 9.

Note that editing a sync profile schedule means selecting or adding a different schedule. If you want to edit the sync profile schedule, you must edit it from the **Active Directory Sync Profiles Schedule** page.

See “**Editing an Active Directory sync profile schedule**” on page 115.
9 In the **Edit Schedule for Active Directory Server** dialog box, you can select a different schedule in the drop-down lists for **Schedule For Full Sync Profile** and **Schedule For Update Sync Profile**.

Note that if the proper schedule does not appear in the drop-down lists for **Schedule For Full Sync Profile** or **Schedule For Update Sync Profile**, you must add a schedule. Click **Add Schedule**, add your schedules, and click **Save**. When you are done, the added schedule appears in the drop-down lists.

See “Adding Active Directory sync profile schedules” on page 113.

10 When you are finished, click **Finish**.

### Deleting an Active Directory sync profile

After you add your Active Directory sync profiles, you can delete any of the Active Directory sync profiles that you no longer need. For example, you may need to delete an obsolete sync profile. In Workflow, you can delete that Active Directory sync profile.

See “Managing Active Directory sync profiles” on page 117.

**To delete an Active Directory sync profile from Workflow**

1 In the Workflow portal, click **Admin > Active Directory > Sync Profiles**.

2 On the **Active Directory Sync Profiles** page, under **Active Directory Sync Profile**, at the far right of the specific sync profile name, click the **Actions** symbol (orange lightning), and click **Delete AD Sync Profile**.

3 In the confirmation message dialog box, click **OK**.

### Add Active Directory Sync Profiles and Edit Active Directory Sync Profiles dialog boxes

If your organization uses Active Directory authentication for its authentication method for Workflow, you need to add Active Directory sync profiles. You may also need to edit an Active Directory sync profile. During the addition or edit of your Active Directory sync profiles, you open the **Add AD Sync Profile** or the **Edit AD Sync Profile** dialog box. These dialog boxes let you add information for a new Active Directory sync profile or edit an existing one.

See “Adding Active Directory sync profiles” on page 119.

See “Editing an Active Directory sync profile” on page 122.
Table 7-5 Options on the Add Active Directory Sync Profiles dialog box and Edit Active Directory Sync Profiles dialog boxes

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD Sync Profile Name</td>
<td>Lets you specify a name for the sync profile.</td>
</tr>
<tr>
<td>Select Connection</td>
<td>Lets you choose which Active Directory server connection you want the sync profile to target.</td>
</tr>
</tbody>
</table>
| AD Server Email Domain        | Lets you specify an email address for the users that you obtain from Active Directory. Use the following format: domain.com  
Workflow requires that all users have an email address, but Active Directory does not. This domain is appended to the user name of any user who does not have an email address.|
| Auto Create User On Initial Login | Lets you have a Workflow user account created automatically when a new user logs on.  
A new user who logs on to Workflow is authenticated against the Process Manager database. If the user does not have an account there, and this check box is checked, the user is authenticated against Active Directory. If the user has an Active Directory account, a mirror account is created in the Process Manager database. |
| AD Users Default Groups       | Lets you select the group to which users are added when their accounts are created automatically.  
The All Users group is the most typical selection.  
This option is available when the following check box is checked: Auto Create User on Initial Login. |

Methods for synchronizing Active Directory sync profiles

When your organization uses Active Directory authentication as its authentication method for Workflow, Workflow can synchronize with Active Directory. The synchronization lets you add and update Active Directory users and groups in the Process Manager database. You can add automatic synchronization schedules to your Active Directory sync profiles. You can also manually run Active Directory sync profile synchronizations.

When Workflow synchronizes with Active Directory, you can view information about the users and groups that are synchronized and the status of the synchronization. See “About Active Directory synchronization” on page 104.
See “Configuring Active Directory sync profiles” on page 105.

See “Managing Active Directory sync profiles” on page 117.

See “Checking the status of an Active Directory sync profile synchronization” on page 129.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run automatic update and full synchronizations.</td>
<td>In Workflow, you can add automatic Active Directory sync profile schedules.</td>
</tr>
<tr>
<td></td>
<td>See “Adding Active Directory sync profile schedules” on page 113.</td>
</tr>
<tr>
<td></td>
<td>When adding your Active Directory sync profiles, you can use these schedules to schedule the following synchronizations:</td>
</tr>
<tr>
<td></td>
<td>■ Update synchronization</td>
</tr>
<tr>
<td></td>
<td>■ Full synchronization</td>
</tr>
<tr>
<td></td>
<td>See “Adding Active Directory sync profiles” on page 119.</td>
</tr>
<tr>
<td>Manually run a full synchronization.</td>
<td>In Workflow, you can manually run a full Active Directory sync profile synchronization at any time.</td>
</tr>
<tr>
<td></td>
<td>This process lets you run a full synchronization on the specified Active Directory sync profile.</td>
</tr>
<tr>
<td></td>
<td>See “Running a full Active Directory sync profile synchronization manually” on page 126.</td>
</tr>
<tr>
<td>Manually run an update synchronization.</td>
<td>In Workflow, you can manually run an update Active Directory sync profile synchronization at any time.</td>
</tr>
<tr>
<td></td>
<td>This process lets you synchronize an Active Directory sync profile with only the changes that have been made to it since the last synchronization.</td>
</tr>
<tr>
<td></td>
<td>See “Running an update Active Directory sync profile synchronization manually” on page 127.</td>
</tr>
<tr>
<td>Manually synchronize all the Active Directory sync profiles.</td>
<td>In Workflow, you can manually run a full synchronization of all your Active Directory sync profiles at any time.</td>
</tr>
<tr>
<td></td>
<td>This process lets you synchronize all your sync profiles for each Active Directory server connection.</td>
</tr>
<tr>
<td></td>
<td>See “Synchronizing all Active Directory sync profiles manually” on page 128.</td>
</tr>
</tbody>
</table>

**Running a full Active Directory sync profile synchronization manually**

In Workflow, you can manually synchronize an Active Directory sync profile with Active Directory at any time between the automatic synchronization intervals. For
example, when you add a new Active Directory sync profile, you can manually synchronize it immediately instead of waiting for the next automatic synchronization. This process runs a full synchronization as follows:

- If the Active Directory sync profile includes the entire Active Directory server domain, the entire domain is synchronized.
- If the Active Directory sync profile includes only specific Active Directory organizational units or groups, the entire contents of those units and groups are synchronized.

See “About Active Directory synchronization” on page 104.
See “Configuring Active Directory sync profiles” on page 105.
See “Managing Active Directory sync profiles” on page 117.
See “Methods for synchronizing Active Directory sync profiles” on page 125.

**Warning:** Any users that are connected to Process Manager might be disconnected during the synchronization.

You can check the status of the synchronization during the process or after the process finishes.

See “Checking the status of an Active Directory sync profile synchronization” on page 129.

**To run a full Active Directory sync profile synchronization manually**

1. In the Workflow portal, click Admin > Active Directory > Sync Profiles.
2. On the Active Directory Sync Profiles page, under Active Directory Sync Profiles, at the far right of the specific sync profile name, click the Actions symbol (orange lightning), and click Run Reset Sync Profile.
3. When the dialog box that announces the start of the synchronization appears, you can close it.

---

**Running an update Active Directory sync profile synchronization manually**

In Workflow, you can manually run an update synchronization of an Active Directory sync profile with Active Directory at any time between automatic synchronization intervals. With this synchronization process, you synchronize only the changes that were made to Active Directory since the last synchronization.
For example, after you add or remove users in Active Directory, you want to apply those changes to Active Directory sync profile immediately. You can check the status of the synchronization during the process or after the process finishes.

See “About Active Directory synchronization” on page 104.

See “Managing Active Directory sync profiles” on page 117.

See “Methods for synchronizing Active Directory sync profiles” on page 125.

See “Checking the status of an Active Directory sync profile synchronization” on page 129.

To run an update Active Directory sync profile synchronization manually

1. In the Workflow portal, click Admin > Active Directory > Sync Profiles.

2. On the Active Directory Sync Profiles page, under Active Directory Sync Profiles, at the far right of the specific sync profile name, click the Actions symbol (orange lightning), and click Run Update Sync Profile.

3. When the dialog box that announces the start of the synchronization appears, you can close it.

Synchronizing all Active Directory sync profiles manually

In Workflow, you can manually synchronize all your Active Directory sync profiles with all Active Directory servers to which Workflow is connected. For example, you might need to recover after a power loss. This synchronization method includes the synchronization of all the Active Directory sync profiles for each Active Directory server connection.

See “About Active Directory synchronization” on page 104.

See “Configuring Active Directory sync profiles” on page 105.

See “Managing Active Directory sync profiles” on page 117.

See “Methods for synchronizing Active Directory sync profiles” on page 125.

To synchronize all Active Directory sync profiles

1. In the Workflow portal, click Admin > Active Directory > Sync Profiles.

2. On the Active Directory Sync Profiles page, at the far right of the Active Directory Sync Profiles title bar, click the Actions symbol (orange lightning), and click Run AD Sync Profile.

3. When the dialog box that announces the start of the synchronization appears, you can close it.
Checking the status of an Active Directory sync profile synchronization

When Workflow synchronizes with Active Directory, you can view information about the users and groups that are synchronized and the status of the synchronization. For example, if your Active Directory is large, you might periodically check the status as the synchronization runs. If a synchronization is not running, the status check shows information for the last synchronization that occurred. For example, you can verify that an overnight synchronization completed successfully. You can check the status of an Active Directory synchronization in the Workflow portal from the Active Directory Sync Profiles page.

See “Configuring Active Directory sync profiles” on page 105.

See “Managing Active Directory sync profiles” on page 117.

See “Methods for synchronizing Active Directory sync profiles” on page 125.

To check the status of an Active Directory sync profile synchronization

1 In the Workflow portal, click Admin > Active Directory > Sync Profiles.

2 On the Active Directory Sync Profiles page, under Active Directory Sync Profiles, at the far right of the specific sync profile name, click the Actions symbol (orange lightning), and click Check Sync Status.

3 The Sync Process Status dialog box opens and displays status of the sync profile synchronization. AD Server Domain Names are arranged in a hierarchy.

4 To check the status of the synchronization process during the synchronization, you can click Refresh to update the display.

5 When you are finished viewing the status information, click Close.
Using Workflow Manager

- Chapter 8. Introducing Workflow Manager
- Chapter 9. About workflow projects
- Chapter 10. About workflow components
- Chapter 11. Working with projects
- Chapter 12. About workflow project models
- Chapter 13. Working with the component generators
- Chapter 14. Working with Webforms
- Chapter 15. Working with tasks
Introducing Workflow Manager

This chapter includes the following topics:

- About Workflow Manager
- Opening Workflow Manager
- Creating a new folder in Workflow Manager
- Creating a new Project in Workflow Manager
- Searching and filtering Projects in Workflow Manager
- Opening a Project in Workflow Manager
- Viewing and editing Project information in Workflow Manager
- Comparing Projects with Workflow Manager
- About the Workflow Repository
- Viewing the Workflow Repository
- Importing or checking in (adding) Projects to the Workflow Repository
- Checking in (creating versions) Projects to the Workflow Repository
- Checking out Projects from the Workflow Repository
- Locking and unlocking Projects in the Workflow Repository
- Connecting to a Workflow Repository
About Workflow Manager

You use Workflow Manager to access and manage existing workflow projects and to create new Projects. You use Workflow Manager to configure and manage specific settings such as tool preferences and server information. These settings are available in the **Tools** menu.

You also use Workflow Manager to launch Workflow Designer when you want to create, edit, or publish a Project.

See "Workflow Designer tool" on page 152.

See “Editing Workflow Designer preferences” on page 658.

Workflow Manager uses folders to group Projects by location. The default Workflow Manager folders are as follows:

**Recent**
- Shows all Projects that were recently opened or created.

**Favorites**
- Shows all Projects that were added as favorite Projects.
- To add a Project to this folder, select a Project in one of the other folders and then click **Add to Favorites**.

**Local**
- Shows all Projects that are on your local server.

**Symantec Management Platform**
- Shows all Projects that are in a Symantec Management Platform's Workflow Repository. The folder name is either the IP address or name of the Symantec Management Platform.
- Symantec Management Platform connections are registered in the Credentials Manager. If your Workflow Server is connected to a Workflow Repository, a folder with the IP address or name of the Symantec Management Platform appears.

See “Connecting to a Workflow Repository” on page 145.

When you select a folder, a number of actions appear at the top of the right pane such as the **Open** and **Edit** actions. Not all actions are available for all folders. Some of the available actions are as follows:

**New**
- Lets you create a new workflow project.

See “Creating a new Project in Workflow Manager” on page 134.

**Open**
- Lets you open the selected Project in Workflow Designer.

See “Opening a Project in Workflow Manager” on page 135.
Edit

Lets you edit the name, tags, and description of a Project.

See “Viewing and editing Project information in Workflow Manager” on page 136.

Add to Favorites

Lets you add the selected Project to the Favorites folder.

To add a Project to this folder, select a Project in one of the other folders and then click Add to Favorites.

Package

Lets you create a package file of the selected Project.

Refresh

Lets you refresh the folder.

Remove

Lets you remove the selected Project from the Favorites or Recent folder.

The Project is still available in the Local or Symantec Management Platform folder.

Duplicate

Lets you create a duplicate of the selected Project.

Move

Lets you move the selected Project to another folder.

See “Creating a new folder in Workflow Manager” on page 134.

Delete

Lets you delete the selected Project.

Note: When you delete Project, you delete it from the hard drive.

See “Opening Workflow Manager” on page 133.

See “Searching and filtering Projects in Workflow Manager” on page 135.

See “Comparing Projects with Workflow Manager” on page 137.

See “Core architectural components of Workflow” on page 39.

Opening Workflow Manager

Workflow Manager lets you access and manage workflow projects.

To open Workflow Manager

◆ Click Start > All Programs > Symantec > Workflow Designer > Workflow Manager.

See “Workflow Designer tool” on page 152.

See “About Workflow Manager” on page 132.
Creating a new folder in Workflow Manager

You can use Workflow Manager to create organizational folders. You can create new folders inside the Local folder on the Workflow Server. You can also create new folders inside the Symantec Management Platform folder in the Workflow Repository on the Symantec Management Platform.

To create a new folder
1. In Workflow Manager, in the left pane, select the appropriate top-level folder. For example, to create a new folder inside the Local folder, click Local.
2. In the toolbar at the top of the left pane, click NewFolder.
3. In the CreateFolder dialog box, in the Name field, type the folder name.
4. Click OK.

See “About the Workflow Repository” on page 138.
See “About Workflow Manager” on page 132.
See “Opening Workflow Manager” on page 133.

Creating a new Project in Workflow Manager

You use Workflow Manager to create new Projects. Selecting the correct Project type is the first step in creating a successful workflow project. Each Project type has its own set of available components and settings. These components and settings let you create specific functionality within a workflow project.

Note: After you select a Project type and begin building a Project, you cannot convert the Project to another Project type. If you decide to change Project types during Project development, you must start over in a new Project.

See “About Workflow Designer Project Types” on page 147.

To create a new Project
1. In Workflow Manager, in the left pane, select the folder in which you want to store the Project.
   For example, if you want to store the Project on the Workflow Server, click the Local folder. If you want to store the Project in the Workflow Repository, select the folder with the IP address or name of the Symantec Management Platform.
2. In the toolbar at the top of the right pane, click New.
3. In the New Project dialog box, on the Project Types tab, select a Project type.
4 In the **Name** field, type the name of your new Project.
5 Click **OK**.

The new Project opens in Workflow Designer.

See “About Workflow Manager” on page 132.
See “Opening Workflow Manager” on page 133.

### Searching and filtering Projects in Workflow Manager

You use Workflow Manager to access your workflow projects. You can use Workflow Manager to search for Projects and filter your results. You can search by Project names, descriptions, and tags. You can filter search results by Project name or type. You can also sort the Projects.

**To search for Projects**

1 In Workflow Manager, in the left pane, select **Recent**, **Favorites**, or the folder in which you want to search.
2 In the upper right corner, in the **Search** field, type at least part of the name, description, or tags for the Project.
3 Press **Enter**.

**To filter Projects**

1 In Workflow Manager, in the right pane, in the **Name Filter** field, type at least part of the Project name.
2 (Optional) Select a Project type listed next to the **Name Filter** field.

For example, to view all the workflow project types, click **Workflow**.

See “Viewing and editing Project information in Workflow Manager” on page 136.
See “About Workflow Manager” on page 132.
See “Opening Workflow Manager” on page 133.

### Opening a Project in Workflow Manager

You use Workflow Manager to access your workflow projects. You use Workflow Manager to locate your Projects and then open them in Workflow Designer.
To open a Project

1. In Workflow Manager, in the left pane, select the folder that contains the Project that you want to open.
2. In the right pane, double-click the Project.
3. Workflow Manager opens the Project in Workflow Designer.

See “About Workflow Manager” on page 132.
See “Opening Workflow Manager” on page 133.

Viewing and editing Project information in Workflow Manager

You can use Workflow Manager to edit Project information. Project information refers to the name, description, and tags of a Project.

To view and edit Project information

1. In Workflow Manager, in the right pane, right-click a Project and then click **Edit**.
2. Make changes to the following Project information, as needed:

   **Name**
   
   (Project name)
   
   If you change a Project's name, the new name appears in Workflow Manager; however, the Project name in the file system does not change.

   **Tags**
   
   (Classifiers that are added to your Project)
   
   A Project tag can refer to a specific component that is used in the Project, a Project function, a development team name, and other classifiers.
   
   Because you can search for Projects by the information in their tags, create a tag that makes the Project searchable.
   
   See “Searching and filtering Projects in Workflow Manager” on page 135.

   **Description**
   
   (Projects functional description)
   
   Symantec recommends that you use a description that includes the general function and dependencies of the Project.

3. Click **OK**.

See “About Workflow Manager” on page 132.
See “Opening Workflow Manager” on page 133.
Comparing Projects with Workflow Manager

Workflow Manager lets you compare two Projects to see the differences between them. You can use this feature to manage Project versions. For example, if a later version of a Project does not function properly, you can compare it to an earlier, functional version.

Finding the differences between the versions can help you locate the source of the problem. You can also select the changes individually and import them from one Project to another.

To compare Projects

1. In Workflow Manager, in the toolbar at the top of the page, click **Tools > Compare Projects**.

   Workflow Manager opens Workflow Designer.

2. In the **Import Project** dialog box, to the right of the **Destination project** field, click **Browse**.

3. Double-click the Project (the **.symWorkflow** file) that you want to use for the Destination Project.

   The Destination Project is the Project that you want to compare to the Source Project.

4. To the right of the **Source project** field, click **Browse**.

5. Double-click the Project (the **.symWorkflow** file) that you want to use for the Source Project.

   The Source Project is the Project to which the Destination Project is compared.

6. Click **Next** to advance through the categories.

   These changes refer only to changes in data between the two Projects. Changes in components are displayed in the main comparison.

   The changes may refer to the following Project details:
   - Project libraries
   - Project properties
   - Project resources
   - Project models

7. Click **Finish**.

   Both Projects open in Workflow Designer where they are displayed side by side.
8 To import a change from the Source Project to the Destination Project, check the modified components, and click **Import**.

9 (Optional) If there are additional models listed under the **Primary models**, you can go to individual tabs to see the changes for each model. Check the changes to import them for your associated models.

10 Close Workflow Designer.

11 In the **Save Project** dialog box, select a save option.

12 (Optional) Check **Open project** on close.

13 Click **Save**.

See “About Workflow Manager” on page 132.

See “Opening Workflow Manager” on page 133.

---

**About the Workflow Repository**

Workflow projects can be stored locally on the Workflow Server, or they can be stored in the Workflow Repository on the Symantec Management Platform. The Workflow Repository is a central location that lets you store, access, create versions, and view versions of your workflow projects and component libraries.

The Workflow Repository resides on the Symantec Management Platform on which you install Symantec Workflow Solution. You can access the Repository in the Symantec Management Console on the **Workflow Enterprise Management** page.

See “Viewing the Workflow Repository” on page 140.

Before you can use Workflow Manager to access the Workflow Repository on the Symantec Management Platform you must do the following:

- Have the **Workflow Repository Users** permission granted from the Symantec Management Platform.

- Connect the Workflow Server to the Symantec Management Platform.

  See “Connecting to a Workflow Repository” on page 145.
Table 8-1 What you can manage with the Repository

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Workflow projects | ■ You can store the workflow projects that you create in the Repository, such as **Web Application**, **Workflow**, **Forms (Web)**, **Decision Only**, and **Monitoring** Project types.  
                   ■ Once a workflow project is saved to the Repository, anyone with access to the Repository can access your Project. |
| Component libraries | ■ You can store component libraries (**Integration** Project type) that you create in the Repository.  
                              ■ Once a component library is saved to the Repository, anyone with access to the Repository can access your component library.  |

After you connect to and have permissions to access the Workflow Repository, you use Workflow Manager to do the following in the Workflow Repository:

- **Create Projects**  
  You can create Projects and save them in the Repository.  
  See “Creating a new Project in Workflow Manager” on page 134.

- **Open Projects**  
  You can open Projects that are stored in the Repository.  
  See “Opening a Project in Workflow Manager” on page 135.

- **Import or check in Projects**  
  You can add Projects on the Workflow Server to the Repository so that others can access to them.  
  See “Importing or checking in (adding) Projects to the Workflow Repository ” on page 141.

- **Check for Project changes and access the latest version of Projects**  
  You can check to see if changes were made to Projects in the Repository.  
  Before you can open a Project, you must check it out in the Repository to copy it locally to the Workflow Server.  
  See “Checking out Projects from the Workflow Repository” on page 144.

- **Create versions of Projects**  
  You create a new version of a Project each time you check it in to the Repository.  
  See “Checking in (creating versions) Projects to the Workflow Repository” on page 142.

- **Lock Projects**
You can lock a Project in the Repository so that others cannot check in changes while you make changes to the Project.  
See “Locking and unlocking Projects in the Workflow Repository” on page 144.  
See “About Workflow Manager” on page 132.

Viewing the Workflow Repository

The Workflow Repository is on the Symantec Management Platform. You can view the Repository in the Symantec Management Console on the Workflow Enterprise Management page.

You can also view the Projects in the Repository in Workflow Manager. However, you must use the Workflow Manager application to check out, lock, open, edit, check in, or import Projects to the Repository.

Note: Before you can view the Repository the Workflow Server must be connected to the Symantec Management Platform. You must also have the Workflow Repository Users permission granted from the Symantec Management Platform.

See “Connecting to a Workflow Repository” on page 145.

To view the Repository in Workflow Manager

1 In Workflow Manager, in the left pane, expand a folder with the IP address or name of the Symantec Management Platform.

2 Click the subfolders to view the Projects that they contain.

To view the Repository in the Workflow Enterprise Management page

1 In the Symantec Management Console, click Manage > Workflows.

2 In the left pane, click Workflow Enterprise Management.

3 In the right pane, click Repository.

4 Click the subfolders to view the Projects that they contain.

See “Workflow Enterprise Management page” on page 574.

See “About the Workflow Repository” on page 138.

See “About Workflow Manager” on page 132.
Importing or checking in (adding) Projects to the Workflow Repository

You can add Projects to the Workflow Repository by importing the Project files or checking in the Projects. You can add workflow projects and component libraries. When you import or check in a Project that is stored on the Workflow Server, you create a copy of the Project in the Repository.

**Note:** To import a Project in to the Repository, the Project should be closed. To check in (add) a Project to the Repository, the Project must be open.

**To import a Project to the Workflow Repository**

1. In Workflow Manager, in the left pane, expand the folder with the IP address or name of the Symantec Management Platform.
2. Select the subfolder into which you want to import the Project.
3. In the right pane, click **Import**.
4. In the **Open** dialog box, select the Project file (the `.symWorkflow` file) that you want to import and then click **Open**.
   
   Note that the Project that you select should be closed.
5. In the **Import Project** dialog box, perform the following actions, as needed:

   **Name** field  
   Type the name of the Project.

   **Description** field  
   Type a description of the Project.

   Symantec recommends that you use a description that includes the general function and dependencies of the Project.

   **Delete local copy** check box  
   Check **Delete local copy** to delete the copy of the Project from the Workflow Server.

6. Click **OK**.
To check in (add) a Project to the Workflow Repository

1. In Workflow Designer, click **File > Check In Project**.

   **Note:** If the Project is already stored in the Workflow Repository, the **Check In** dialog box opens and lets you create a version of the Project.

   See “Checking in (creating versions) Projects to the Workflow Repository” on page 142.

2. In the **Check In Project** dialog box, click **Yes**.

3. In the **Create Repository Project** dialog box, perform the following actions, as needed:

   - **Name**
     - Type the name of the Project.
   - **Description field**
     - Type a description of the Project.
     - Symantec recommends that you use a description that includes the general function and dependencies of the Project.
   - **Delete local copy check box**
     - Check **Delete local copy** to delete the copy of the Project from the Workflow Server.

4. Select or create the folder in which you want to add the Project.

5. Click **Create**.

6. Click **OK**.

   The Project is added to the Workflow Repository and reopens in Workflow Designer.

   See “About the Workflow Repository” on page 138.

   See “Connecting to a Workflow Repository” on page 145.

---

**Checking in (creating versions) Projects to the Workflow Repository**

You can create versions of Projects that are stored in the Workflow Repository. Each time you check in a Project to the Workflow Repository, you create a version of the Project.
You can roll back to a previous version of a Project. You can also export a previous version of a Project and save it as a new Project. To view the versions of a Project, right-click the Project and click **View Versions**.

You can check in versions of a Project while you make changes to it. You check in a version of a Project after you save and close it. If a Project has some changes that are not checked in to the Workflow Repository, an **edit** symbol (paper and pencil) appears. The **edit** symbol is displayed in the upper right corner of the Project thumbnail in Workflow Manager.

**To check in (create) a version of a Project (Project is open)**

1. In Workflow Designer, in the toolbar at the top of the page, click **File > Check In Project**.

   **Note:** If the Project is not currently stored in the Workflow Repository, the **Check in Project** dialog box opens. The message in the dialog box asks if you want to add the Project to the Repository.

   See “Importing or checking in (adding) Projects to the Workflow Repository” on page 141.

2. In the **Check In** dialog box, in the **Notes** field, type your notes for the version.

3. Click **Check In**.

   You can continue making changes to the Project.

**To check in (create) a version of a Project (Project is closed)**

1. In Workflow Manager, in the Workflow Repository, select the Project whose changes need to be checked in.

   The Project should have the edit symbol (paper and pencil) in the upper right corner of the Project thumbnail.

2. In the toolbar at the top of the right pane, click **Check In**.

3. In the **Check In** dialog box, type your notes for the version and a label as needed.

4. When you are finished, click **OK**.

5. When the Project is checked in, click **OK**.

See “About the Workflow Repository” on page 138.

See “Connecting to a Workflow Repository” on page 145.
Checking out Projects from the Workflow Repository

You can check out Projects from the Workflow Repository. When you check out a Project from the Repository, you can view the changes that were made to the Project. You also copy the Project locally to the Workflow Server.

Before you open a Project, you must check it out from the Repository so that the latest version is copied locally to the Workflow Server. You can check out workflow projects and component libraries.

**Note:** When you check out a Project from the Repository, others can still check it out, open it, make changes, and check in those changes. To prevent others from checking in changes to the Project that you plan to work on, you must first lock the Project.

See “Locking and unlocking Projects in the Workflow Repository” on page 144.

To check out a Project from the Repository

1. In Workflow Manager, in the Workflow Repository, select the Project that you want to check out.

2. In the toolbar at the top of the right pane, click **Check Out**.

   The **Check Out** dialog box opens to display changes to the current version.

3. Click **OK**.

See “About the Workflow Repository” on page 138.

See “Connecting to a Workflow Repository” on page 145.

Locking and unlocking Projects in the Workflow Repository

You can use Workflow Manager to lock and unlock Projects in the Workflow Repository. When you lock a Project, other users cannot check in changes to that Project. When a Project is locked, a **lock** symbol is displayed in the upper right corner of the Project thumbnail in Workflow Manager.

As a best practice, Symantec recommends that you lock a Project before you check it out and edit it.
Note: When you lock a Project, you must still check out the Project from the Workflow Repository to copy it locally to the Workflow Server.

See “Checking out Projects from the Workflow Repository” on page 144.

When you have finished making changes and checked in the Project, unlock it. You can also unlock a Project from the Workflow Enterprise Management page in the Symantec Management Console, but you cannot lock a Project from this page.

To lock a Project in the Workflow Repository
1 In Workflow Manager, in the Workflow Repository, select the Project that you want to lock.
2 In the right pane, right-click the Project and click Lock.

To unlock a Project in the Workflow Repository
1 In Workflow Manager, in the Workflow Repository, select the Project that you want to unlock.
2 In the right pane, right-click the Project and click Unlock.

To unlock a Project in the Repository from the Workflow Enterprise Management page
1 In the Symantec Management Console, click Manage > Workflows.
2 In the left pane, expand Workflows and then click Workflow Enterprise Management.
3 In the right pane, click the Repository tab.
4 Locate and select the Project that you want to unlock.
5 Click Unlock Project.

See “About the Workflow Repository” on page 138.

Connecting to a Workflow Repository

The Workflow Repository resides on all Symantec Management Platform on which you install Symantec Workflow Solution. You use Workflow Explorer to connect your Workflow Server to the Repository. A Workflow Server can connect to multiple repositories, and multiple Workflow Servers can share a Repository.

Note: Before you can access the Repository, you must have the Workflow Repository Users permission granted from the Symantec Management Platform.
To connect to a Workflow Repository

1. Click **Start > Programs > Symantec > Workflow > Workflow Designer > Tools > Workflow Explorer**.

2. In Workflow Explorer, in the toolbar at the top of the page, click **Credentials**.

3. In the left pane, click **Symantec Management Platform**.

4. In the right pane, click **Add**.

5. In the **New SMP Credentials** dialog box, type the following information for the Symantec Management Platform:

   | **Machine name or IP Address** | Type the server name or IP address of the Symantec Management Platform. |
   | **Domain**                   | Type the domain to which the Symantec Management Platform belongs. |
   | **User Name**                | Type the credentials that the Workflow Server can use to interact with the Symantec Management Platform. The credentials must be for a user who has administrative rights. |
   | **Password**                 | |
   | **Use HTTPS** check box      | Check this check box to use secure (encrypted) connections from the Workflow Server back to the Symantec Management Platform. If you use SSL on the Symantec Management Platform, you need to check **Use HTTPS**. |
   | **Default SMP check box**    | Check this check box to use this Symantec Management Platform connection as the default profile. |
   | **SMP Version**              | In the **SMP Version** drop-down list, select the version of the Symantec Management Platform to which you want to connect. |

6. When you are finished, click **OK**.

7. Close Workflow Explorer.

8. Restart Workflow Manager.

9. In Workflow Manager, in the left pane, in the Symantec Management Platform folder, you can access the Repository.

See “About the Workflow Repository” on page 138.

See “Viewing the Workflow Repository” on page 140.
About workflow projects

This chapter includes the following topics:

- About Workflow Designer Project Types
- Workflow Designer tool
- Setting up how a project runs

About Workflow Designer Project Types

You can categorize projects into Project Types. You control the actions that your project can perform by selecting the appropriate Project Type. Before you start a new project, you must first select a Project Type. Let your business requirements and the required user interactions determine the Project Type that you select. For example, you can use the Forms (Web) project to produce web forms for single user interaction. You can use the Workflow project to produce the forms that require multiple party interactions to accomplish a task.

Each Project Type has the components that are specific to the project's intended functionality; therefore, not all components are available in every Project Type. For example, you can only access Workflow components from within a Workflow project.

After you select a Project Type and begin creating your project, you cannot change the Project Type. If the Project Type ends up not fitting your needs, you must select a different one and begin again. You may be able to export some of the components from your current project into your new project. However, some components are specific to a Project Type. For example, you can use forms components in the Forms (Web) projects, but you cannot use form components in the Decision Only projects.
Project Types can be tied together using features within Workflow Designer. However, you should choose each project according to how you use it in your business.

The following are available Project Types:

- **Web Application**
  See “About Web Application Project Types” on page 148.

- **Decision Only**
  See “About Decision Only Project Types” on page 149.

- **Workflow**
  See “About Workflow Project Types” on page 150.

- **Forms (Web)**
  See “About Forms (Web) Project Types” on page 150.

- **Integration**
  See “About Integration Project Types” on page 152.

- **Monitoring**
  See “About Monitoring Project Types” on page 152.

### About Web Application Project Types

Use Web Application Project Types when you need to use multiple models in the same project. The Web Application Project Type acts as a container that allows Service, Dialog, and Workflow Models to exist within the same project. A Service Model is similar to a Decision Only project. A Dialog Model is similar to a Forms (Web) project. A Workflow Model is similar to a Workflow project. By default, when you use the Web Application Project Type to create a new project, you start with two models: the Workflow and Dialog Models. You can add or remove Workflow, Dialog, and Service Models as required.

For example, you need to create a complex procedure that requires a Workflow project, a Decision Only project, and a Forms (Web) project. Instead of creating, managing, testing, exporting, and integrating three different projects, you can use the Web Application Project Type to create a single project with all the functionality of the Workflow, Decision Only, and Forms (Web) projects.

---

**Note:** The Web Application cannot auto start based on a schedule or environmental variable. If you need this functionality, you must use a Workflow or Monitoring Project Type.

The Web Application Project Type lets you control how your project is structured and consumed by letting you define multiple entry points such as webpages, web
services, and service methods for a single project. On the Publishing tab, you can use the Add option to create your entry points. You can add webpages and web services directly. You can only add a service method after you have added a web service.

The Web Application Project Type lets you control how your project functions when it moves between different models. You can continue to use the Linked Model component to move the process between models while staying within the same session (Session ID). You can also invoke a new session (new Session ID) when moving between models by using the new Start Workflow component. This component lets you invoke only workflow models, and it lets you return the new Session ID of the invoked Workflow Model.

For example, you have a hardware refresh process that contains a specific flow of activities that must occur for each computer. You can create a request form that lets the end-user import a list of multiple computers. The single request form in a dialog model can invoke several unique sessions of the workflow model, one for each computer, without the need to create, integrate, test, and manage multiple workflow projects.

For more information about the Web Application Project type, see the Using the Web App Project Type in Workflow Video at

https://www-secure.symantec.com/connect/videos/using-web-app-project-type-workflow-video

See “About the Service Catalog Request Template” on page 677.

See “About Workflow Designer Project Types” on page 147.

See “About Decision Only Project Types” on page 149.

See “About Workflow Project Types” on page 150.

See “About Forms (Web) Project Types” on page 150.

### About Decision Only Project Types

Use Decision Only Project Types when you require all of the logic capabilities of Workflow, but you do not require any user interaction. Use a Decision Only project for a project that interacts primarily with back-end systems, or that consists mostly of business decisions. You can use it for business rules and to make automated decisions. You can also use it when you need to process information without user involvement. For example, a Decision Only project is ideal for a process that screens loan applications. This project is also ideal for a process that pre-populates the documents that require signatures. The Decision Only project can handle thousands of transactions per second, and it runs as a web service or as a DLL. It can use the Integration generators for connecting to databases, web services, and so forth.
Decision Only projects can be published as DLLs. Developers writing other software applications can use these projects.

See “About Workflow Designer Project Types” on page 147.

About Workflow Project Types

Use Workflow Project Types when you require task-based user interactions. A Workflow Project Type is ideal for the projects that create tasks for users and take steps based on user decisions. Workflow projects contain special components called Workflow components: for example, Dialog Workflow. Workflow components pause execution and wait for user interaction. Workflow projects are the only type of project that can create a task and then delay execution until the user completes the task. Workflow components have properties to control the behavior of delivering a task. They also have properties to set conditions on how to deliver a task, and set how long to wait for a task. In addition, Workflow components have properties to control how to handle a task that waits too long for a response. These components are available only in Workflow Project Types.

Workflow and Forms (Web) projects are the two Project Types that use forms. In a Workflow project, the user is invited to the form by a task. In a Forms (Web) project, the user actively opens the form, usually through a link.

In a Workflow project, human interaction occurs primarily through a user interface, such as Process Manager, or through email. Workflow projects are ideal for document routing, document approval, human resources requests, and IT department approvals.

The Workflow Project Type is the most commonly used project type in Workflow. Workflow Project Types have more available functionality than any other Project Type. You can use Workflow projects to create tasks. These projects also include all of the logic capabilities of Workflow, and they can interact with disparate systems by using generated components.

See “About Workflow Designer Project Types” on page 147.

About Forms (Web) Project Types

Use Forms (Web) Project Types when you need user interaction immediately in a web form. A Forms (Web) project is ideal for a project that interacts with a single user in a web form. Forms (Web) projects are linear, user interface-based processes.
**Note:** In Symantec Workflow, 7.1 SP1 and earlier, Workflow provided a Forms (Windows) Project Type. This Project Type was deprecated in Symantec Workflow 7.1 SP2. If you used a previous version of Symantec Workflow and created Forms (Windows) projects, those existing projects still function.

The Workflow and Forms (Web) Project Types use forms. In a Workflow project, the user is invited to the form by a task. In a Forms (Web) project, the user actively opens the form, usually through a link.

You can use a Forms (Web) project to produce the following forms: Web forms, Cisco Phone forms, and Blackberry forms. You can quickly create the forms that have the graphics and the themes that let a user enter information or make a decision about information. When you use a Forms (Web) project that uses web forms, you can create the ASPX applications that run on Microsoft IIS.

Forms (Web) projects are ideal for web surveys and statistical display, such as a Dashboard. They are also ideal for non-task-based management applications, such as a conference room reservation application.

See "About Workflow Designer Project Types" on page 147.

You can use a Forms (Web) project to create applications for mobile devices. You create mobile-enabled forms in the same way that you create regular web forms, with some limitations on form controls and display. Workflow-type projects can also be set to use mobile forms.

You can set your Forms (Web) project to use mobile forms in the **Publishing** tab of your project.

The settings for Forms (Web) projects are as follows:

- **Default**: Use the web setting.
- **Web**: Use this setting if your project displays forms for full web displays only.
- **Mobile**: Use this setting if your project displays forms for mobile web displays only.
- **MobileAndWeb**: Use this setting if your project can display in either full web displays or mobile web display. The **MobileAndWeb** setting displays your web forms normally unless they are accessed from a mobile device. The mobile display may make some form controls unusable. Symantec recommends that you thoroughly test the web forms projects that use the **MobileAndWeb** setting.
About Integration Project Types

Use Integration Project Types when you need to create the new components or datatypes that you use in projects of other types. Integration projects do not use component configurations to create processes. They create the components and datatypes that you use in projects of other types. Integration projects use the integration engine and custom parameters to generate code. This code can be compiled or used as raw source code. For the Symantec Management Platform, Integration projects are used to build Task, Resource, ASDK, and Report components.

See “About Workflow Designer Project Types” on page 147.

About Monitoring Project Types

Use Monitoring Project Types when you need the logic capabilities of Workflow without user interaction, and you want the project to run on a schedule. A Monitoring project is ideal for an analytical, logic-based application that runs on a schedule in the background of other processes. Events and schedules usually invoke Monitoring projects. You can publish a Monitoring project as a task tray application, a Windows desktop service, or a web service.

You can use the Monitoring project to monitor the pulse of your business. For example, you can use a Monitoring project to run a scheduled troubleshooting script that monitors another application. You can also use it to monitor data for certain conditions and take some action as a result. In addition, you can use it to monitor hardware, check databases, monitor incoming faxes, and start a new workflow.

See “About Workflow Designer Project Types” on page 147.

Workflow Designer tool

The Workflow Designer tool lets you create and edit Projects. The Workflow Designer tool contains toolbars, a Project tree, a component toolbox, and a workspace.

See “About workflow components” on page 173.
See “About the project workspace” on page 153.
See “About the component toolbox” on page 154.
See “Searching for components in the component toolbox” on page 154.
See “About Project metadata and property tabs” on page 156.
See “About Workflow Designer project trees” on page 157.
See “About project metadata” on page 157.
See “Viewing the project metadata” on page 158.
See “Project data tabs” on page 158.
See “Viewing project data tabs” on page 170.
See “Generating project reports” on page 170.

Table 9-1  Workflow Designer navigation

<table>
<thead>
<tr>
<th>Navigation type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Context Menus</td>
<td>As you begin using Workflow Designer, you can right-click at any time to see the context-specific options. The options change based on what you select within the development environment.</td>
</tr>
<tr>
<td>Tool tips</td>
<td>To assist with learning and navigation, each symbol displays a tool tip when you hover over a selection.</td>
</tr>
<tr>
<td>Windows Tack</td>
<td>The tack symbol appears throughout Workflow Designer windows, typically on toolbars. It is located to the right of the toolbox window. You can click on the symbol to hide a pane that is not needed.</td>
</tr>
<tr>
<td>Embedded Uls</td>
<td>The ellipsis symbol (…) appears throughout Workflow Designer. This option displays when there is an embedded UI that you can use to configure a field. For example, the ellipsis displays next to the Description and Override Background Color fields when you double-click Start.</td>
</tr>
<tr>
<td>Views</td>
<td>You can view your Workflow Designer Project in the Diagram view and the Browser view. The Diagram view is the most efficient way to view your Project. The Browser view shows a lower level of detail and organization.</td>
</tr>
</tbody>
</table>

About the project workspace

The project workspace is the main portion of the Workflow Designer window. The workspace is where you add and configure the components that create a Project. You can use the workspace to lay out a logical path that the components in your Project can take.

You can drag components from the component toolbox into the workspace. Drag the component directly on a line to snap the component into place.

See “Workflow Designer tool” on page 152.
About the component toolbox

The component toolbox contains all of the components that are available to use in your Project. You can add more components by importing them.

See “Importing components into a project” on page 215.

The component toolbox has tabs to make it easier for you to find your components.

See “About Project metadata and property tabs” on page 156.

You can search for components by name in the search box to find them in the component toolbox.

See “Searching for components in the component toolbox” on page 154.

The tabs in the component toolbox are as follows:

- **Components**: Contains a listing of all of the components that are currently visible to your Project. The components are divided and organized into the categories that are based on their functionality. The components tab contains two ways to locate components: a search box and a component tree.

- **Library**: Displays the components that you have added to your personal library. Your personal library usually contains the components that you have made changes to and want to re-use.

  See “Adding components to your personal library” on page 180.

- **Images**: Lets your search for components based on the image that is associated with the component. You can find a component by expanding and collapsing the image tree.

Searching for components in the component toolbox

In an open Project in Workflow Designer, all available components are in the component toolbox.

See “About the component toolbox” on page 154.

You can use the search box to find components in the component toolbox. You can search for components by name.

The terms that are commonly used in component names are as follows:

- **Collection**: Refers to the components that work with array values. For example, *Configurable Collection Filter*.

- **Text**: Refers to the components that work with text (string) values. For example, *Extract Text from Text*.
<table>
<thead>
<tr>
<th>Component Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>Refers to the components that work with data of any type. For example, <strong>Add New Data Element</strong>.</td>
</tr>
<tr>
<td>Decision</td>
<td>Refers to the components that contain decision models. For example, <strong>Decision Table</strong>. The <strong>Decision Table</strong> library is not available by default. See “Importing components into a project” on page 215.</td>
</tr>
<tr>
<td>Values</td>
<td>Refers to the components that work with multiple variables. For example, <strong>Add Values</strong>.</td>
</tr>
<tr>
<td>Convert</td>
<td>Refers to the components that convert a value from one data type to another data type. For example, <strong>Convert String To Date</strong>.</td>
</tr>
<tr>
<td>Get</td>
<td>Refers to the components that retrieve values. For example, <strong>Get Day of Year</strong>.</td>
</tr>
<tr>
<td>Add</td>
<td>Refers to the components that add two or more values. For example, <strong>Add Days</strong>.</td>
</tr>
<tr>
<td>Subtract</td>
<td>Refers to the components that subtract a value from another value. For example, <strong>Subtract Days</strong>.</td>
</tr>
<tr>
<td>Dialog</td>
<td>Refers to the components that include a form. For example, <strong>Dialogue Workflow</strong> (in workflow project types), and <strong>Terminate Window and Close Dialogue</strong> (in web forms Project types).</td>
</tr>
<tr>
<td>User</td>
<td>Refers to the components that work with users from various systems (such as Process Manager and Active Directory). For example, <strong>Add User</strong>.</td>
</tr>
<tr>
<td>Create</td>
<td>Refers to the components that make something new, such as a variable or an object. For example, <strong>Create Directory</strong>.</td>
</tr>
<tr>
<td>Exception</td>
<td>Refers to the components that work with the errors that occur in the process. For example, <strong>Exception Trigger</strong>.</td>
</tr>
<tr>
<td>Configurable</td>
<td>Refers to the components that have at least one embedded decision model that must be configured. For example, <strong>Configurable Collection Filter</strong>.</td>
</tr>
<tr>
<td>Rule</td>
<td>Refers to the components that make decisions based on input data. All rule components have multiple outcome paths. For example, <strong>Equals Rule</strong>.</td>
</tr>
<tr>
<td>Remove</td>
<td>Refers to the components that delete values or objects. For example, <strong>Remove Data</strong>.</td>
</tr>
</tbody>
</table>
Searching for components in an open workflow project

In an open workflow project in Workflow Designer, you can search for the components that you added to the process.

When you search for a component, Workflow Designer searches all of the models (including embedded models) for the component. This search feature does not find components in the component toolbox.

See “Searching for components in the component toolbox” on page 154.

You can search for a component by its default name or by a name you have given it. You can also search by the component type or by the description of the component.

To search for components in an open workflow project

1. In an open project in Workflow Designer, in the left pane, click Find Components.

2. In the Search field, type the name, type, or description of a component that you want to find in your project.

   After you type, Workflow Designer searches automatically.

3. (Optional) When your search results appear, double-click any component to navigate to it, or right-click on it and select an option.

4. (Optional) Check Filter by type, and then in the Type drop-down list, select a filter.

About Project metadata and property tabs

Project metadata and property tabs contain the information that applies to an entire Project. Metadata refers to the information that describes the Project. Property tabs contain the settings and data that you can use in your Project. You can view the metadata tabs and the property tabs for an open Project in Workflow Designer. To view these tabs, click on the Project name (the top item) in the tree structure on the left.

See “About project metadata” on page 157.

See “Project data tabs” on page 158.
About Workflow Designer project trees

A Workflow Designer project tree appears on the left side of an open project in Workflow Designer. The project tree is an organizational representation of your project.

The project tree displays the following items:

- **Name**
  The project name is the top item in the project tree structure.
  See “About project metadata” on page 157.

- **Model name**
  Models are sections of a process.
  See “About project models” on page 222.

- **Model input and output data**
  See “Models tab” on page 163.

- **Model documentation**
  Designers use model documentation to explain a model for future reference.
  See “Project documentation” on page 214.

About project metadata

Project metadata is the highest level of data that describes a project. When you open a project in Workflow Designer, you can click on the project name and view its metadata.

See “Viewing the project metadata” on page 158.

See “About Workflow Designer project trees” on page 157.

A project has only one set of project metadata.

When you click the project name in the project tree structure, in the right pane, you can view the metadata that appear at the top of the Project tab.

The properties of project metadata are as follows:

- **Name**
  This property is the name of the project that you set when you first created the project.

- **Type**
  This property is the type of project that you set when you first created the project.
  The project types are Workflow, Decision Only, Integration, and Forms (Web).
  This data is not editable.
Note: In Symantec Workflow, 7.1 SP1 and earlier, Workflow offered a Forms (Windows) option. This Project Type was deprecated in Symantec Workflow 7.1 SP2. If you used a previous version of Symantec Workflow and created Forms (Windows) Project Types, those existing projects still function.

- **Description**
  This property is a general description of the project.

- **Author mail**
  This property is the email address of the person who created the project. Include an email address to help users and designers contact the author.

- **Creation date**
  This property is the date when the project was created. This data is not editable.

- **Service ID**
  By default, this property is a global unique identification (GUID) for the project.

- **Translation ID**
  By default, this property is a global unique identification (GUID) for the project.

All of the data that is in right pane at the top of the Project tab is metadata. You can modify some metadata.

See “Symantec component datatypes” on page 659.

### Viewing the project metadata

Project metadata is to the highest level of data that describes a project.

See “About project metadata” on page 157.

**To view project metadata**

1. In an open project in Workflow Designer, in the left pane, click on the project name.

2. In the right pane, view the project metadata.

### Project data tabs

Project data tabs organize the project data that is one level lower than metadata. In an open project, you can access the data tabs by clicking on the name of the project. This name is the top item in the tree structure in the left pane.

See “Viewing project data tabs” on page 170.

See “About project metadata” on page 157.
### Table 9-2  Project data tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Resources</strong></td>
<td>Lets you add any file to your project. When you add a resource to a project, you add a file that compiles with the project data so that the project always has immediate access to the file. For example, if you use a number of images in your project, you can add those images as resources so that your project has reliable access to them. This action also lets you keep the images unchanged. Resources are similar to project properties and global data. Symantec recommends that you use resources and project properties instead of global data wherever possible. When you publish your project, all project resources are compiled with the project code. If you package your project, all project resources are compiled with the package; resources go wherever the package goes. See “Resources tab” on page 161.</td>
</tr>
<tr>
<td><strong>Libraries</strong></td>
<td>Lets you manage the libraries (component .DLL files) that are available in the component toolbox. You can add libraries or remove libraries. See “Libraries tab” on page 162. See “About the component toolbox” on page 154. See “Importing components into a project” on page 215.</td>
</tr>
<tr>
<td><strong>Models</strong></td>
<td>Displays the models that are contained within the project. See “Models tab” on page 163. See “About project models” on page 222.</td>
</tr>
<tr>
<td><strong>Publishing</strong></td>
<td>Displays the information and the settings that you use to govern project publishing to Workflow Server. See “Publishing tab” on page 164.</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Lets you manage project properties. Project properties are the values that you can use in your project. Project properties are similar to resources and global data. Symantec recommends that you use resources and project properties instead of global data wherever possible. See “Properties tab” on page 167.</td>
</tr>
<tr>
<td>Tab</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Storage Preferences</strong></td>
<td>Lets you set specific parameters (serialization, datatype, and so on) for the data that you use within the project. See “Storage Preferences tab” on page 168.</td>
</tr>
<tr>
<td><strong>Reporting</strong></td>
<td>Lets you configure how your project relates to Process Manager. If you do not publish your project to Process Manager, disregard this tab. See “Reporting tab” on page 169.</td>
</tr>
<tr>
<td></td>
<td>The items in the reporting tab are as follows:</td>
</tr>
<tr>
<td></td>
<td>- Add Process Component</td>
</tr>
<tr>
<td></td>
<td>Clicking this option adds a Global Logging Capture component to your process. Without this component, your project cannot communicate with Process Manager.</td>
</tr>
<tr>
<td></td>
<td>- Process Prefix</td>
</tr>
<tr>
<td></td>
<td>This property is the term that is prefixed to the instance number of your project in Process Manager. For example, the first instance of a project with a prefix of <strong>IM</strong> appears as <strong>IM-00001</strong> in Process Manager.</td>
</tr>
<tr>
<td></td>
<td>- Pad Char</td>
</tr>
<tr>
<td></td>
<td>This property is the character that pads the instance number of your project in Process Manager. For example, the first instance of a project with a prefix of <strong>IM</strong> and a pad character of <strong>0</strong> appears as <strong>IM-00001</strong> in Process Manager.</td>
</tr>
<tr>
<td></td>
<td>- Pad Length</td>
</tr>
<tr>
<td></td>
<td>This property is the number of the pad characters in the instance number of your project in Process Manager. For example, the first instance of a project with a prefix of <strong>IM</strong>, a pad character of <strong>0</strong>, and a pad length of <strong>4</strong> appears as <strong>IM-00001</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Data Saving Mode</td>
</tr>
<tr>
<td></td>
<td>This property refers to the manner in which your project communicates with Process Manager. Symantec recommends that you leave it set to <strong>Messaging</strong>.</td>
</tr>
<tr>
<td><strong>Global Data</strong></td>
<td>Lets you manage global data. Global data refers to the data that is universally accessible in your project. You can access global data in any model without configuring input values. Project properties are similar to resources and global data. Symantec recommends that you use resources and project properties instead of global data wherever possible.</td>
</tr>
</tbody>
</table>
Table 9-2  Project data tabs (continued)

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Properties</td>
<td>Lets you manage application properties. Application properties refer to the data elements that you make available to a multiple-project application that connects to Process Manager. If you do not publish your project to Process Manager, disregard this tab. If no application properties appear after you click <strong>Use Application Properties</strong>, in the Workflow task tray application, add a Process Manager server that has application properties.</td>
</tr>
</tbody>
</table>

**Resources tab**

Each project requires external libraries, or resources, to run. Resource files provide projects with additional information, functionality, or option definitions. Resources may include Dynamic Linked Libraries (called libraries) and .CONFIG files, which contain configuration options. You can use the **Add** command option to add resources to your project.

See “Workflow Designer tool” on page 152.

Table Properties:

- **Name**
  - This box contains the logical name of the resource.

- **Type**
  - This box contains a description of the type of resource. You can edit some resource types. To edit a resource type, choose a new resource type in the **Resource Type** box of the resource.

- **Description**
  - This box holds a description of the resource. You can edit the description of the resource by entering a description in the resource's Description cell.

- **Last Modified**
  - This option is a non-editable box that displays the date of the last resource modification.

- **Copy Local**
  - Select if you want to create a local copy of a resource. Local copies are placed in the project directory. For example, if a resource originally is located at C:\Resources, selecting **Copy Local** places a copy of the resource on the C:\LogicBaseProjects\MaestroProject1\ directory.

- **Publish**
Select if you want your resource files to be published with the project. When the project is published, some common resources may be available on the Workflow Server or the computer system to which you publish your project. Those resources do not require publishing. Customized libraries should be deployed so they are available to all users. These libraries are rare on other systems.

- **Debug Only**
  Select this option if the resource should only be used when debugging your application. The file or resource must be available on the Workflow Server.

- **Invocation Target**
  If you select this option, the resource is invoked upon project execution. Invoking a resource means it must be loaded or executed before the project is loaded. The libraries that the project initially requires must be invoked before the project can be executed.

- **Show In Project Tree**
  This box contains the name of the resource. The name of the resource is the location of the resource file.

- **Original Path**
  This box contains the directory for the original resource file. The original resource file is referenced and left in place if you do not select Copy Local. It is copied to the Workflow Designer project directory if you select Copy Local.

### Libraries tab

This tab lets you manage the libraries (in .DLL format) that your project uses. The libraries that are added and used on this tab are local to the project. Upon installation, Workflow Designer core libraries are already uploaded for use on a project. You can add or remove additional Workflow Designer libraries, external libraries, or the custom libraries that an Integration generator creates.

See “Workflow Designer tool” on page 152.

Click **Add** to add libraries to the project.

**Table Properties:**

- **Name**
  This box contains the name of the library. This name is also the location of the library file.

- **Description**
  This box contains a description of the library, which can be edited by entering a description in the resource's **Description** box.

- **Debug Only**
Select this option if the library should only be used when you debug your application.

- **Copy Local**
  Select this option if you want to create a local copy of a resource. Local copies are placed in the project directory, which is located at C:\LogicBaseProjects\ProjectName\.

- **Publish**
  Select this option to require that the library is published with the project.

- **Last Modify Date**
  This option is a non-editable box that displays the date of the last library modification.

- **Original Path**
  To the right of the path, click the ... symbol to change the original path of the library.

**Models tab**

This tab provides a list of the models in your project. The Primary model is created upon project creation. It contains all the main components and project functionality. To cut down on the component clutter in the primary model, create sub-models. Sub-models can perform specific tasks. The primary model executes the sub-models.

See “Workflow Designer tool” on page 152.

See “About project models” on page 222.

Table properties are as follows:

- **Name**
  This box contains the name of the models that are included in your project. If you want to rename a model, edit the model's name in this box.

- **File Name**
  This property is a non-editable box that holds the name of the .MODEL file that is associated with your project's models. Each model in a project has an accompanying .MODEL file (stored in your project's folder) which holds model information and data.

- **Execution Method**
  This box contains the execution method of the model.

- **Return Type**
  Some models manipulate data and return a value upon completion of the model. For example, a model may ask for the user's name as input and return it to the primary model as a return variable. If a model returns a value, it must return a
value of a certain datatype. The first name of a user, for example, would be of type String, because names are stored as text. To edit the return type for a model, enter a datatype in this box.

- **Primary**
  Select this property if the model is the primary model. One model must be the primary model in a project. The primary model is executed first in a project, and acts as the base for all other models.

- **Invocation Target**
  Select this property if the model must be invoked before project execution. Invoking a model loads it and sets any relevant properties. For example, if a project needs a user's name to run, and the model acquires the user's name, it may need to be invoked before project execution so that the user's name is available when the primary model executes.

**Publishing tab**
This tab lets you set options regarding your project, which appears to users and developers after the project is published and running.

See "Workflow Designer tool" on page 152.

The following describe the fields in the **Publishing** tab.

**General options** are as follows:

- **Name Space**
  Enter the namespace of a project. This option is a unique text identifier used to differentiate your project from others. This namespace also serves to identify the components that are involved in your project.

- **URL**
  Enter the URL of your organization's home page. This URL is viewable and is useful in streamlining technical support or feedback.

**Primary service options** are as follows:

- **Service Name**
  Enter a name for your web service, if wanted. The web service is launched as [servicename].aspx on the Workflow Server. Users then connect to your .ASPX file to use the functions of your web service.

- **Method Name**
  To operate your projects after they are deployed as web services, users must invoke methods. The primary method that acts to execute your primary model must be given a name, so users can identify it. Enter into this box the name you want to give your primary method. The default is Execute, which indicates that the functions of your project should execute.
Service Return Class Name
Data that are returned from your web service is placed in a special class, so it may be handled easily by users. Classes are bundles of the data that are organized in a particular way. The class that is used to return data from your web service must be given a name. Enter a name for your return class in this box.

Authentication Type
You can select one of the following authentication types:
- Anonymous authentication
- Windows authentication
- Basic authentication

The Business Time Span Config options are as follows:

Business Time Span Config
Click the ... symbol to override the business hours for your project. The Time Span settings that occur in components take precedence over the project's Time Span settings. Time Span settings that occur in this project take precedence over global Time Span settings.

Workflow Type
Sets the ways that a project can run.

See "Publishing a project" on page 197.

Web service
Starts when a user makes a request (for example, through a Smart task in Helpdesk Solution or a resource Item Action).

Auto Start
The Workflow Server monitors an event and when that event happens, the workflow runs. For example, when an email appears in a mailbox, a particular workflow runs.

Form Start
Starts with a dialog workflow form that requires user input (for example, salary advance requests or vacation requests). When a Form Start workflow starts, the workflow is processed until it gets to a Dialog Workflow component. The first workflow component you have must be a Dialog Workflow component.

Dialog Settings
These settings are for how you want web forms in Dialog workflow components to end. These are default project level settings. Component level settings take precedence over these.
Use Default End Page
Select to show the Workflow Designer end page (this page states that the process has ended when a user clicks out of the web form).

Redirect To Page At End
Enter the URL redirect for the end page.

Redirect To Page At End Parameter
Enter the URL parameter redirect for the end page.

Center Forms On Page
Select to center all web forms on the page.

Default Theme
Select the default theme you want to use for all web forms.

Form Dialog Type
Select the form dialog type you want to use for all web forms.

These settings appear when Auto Start is selected in the Workflow Type section.

Start With Primary Model
Select if you want this project to auto start with the primary model instead of another model.

Run Auto Start Until Does Not Start
Select if you want to keep running the Auto Start component until it no longer has data to process.
For example, suppose the Auto Start component monitors a database and processes a row at a time. If the auto start schedule is set to monitor the component daily and there are 500 new rows in the database, if this check box is selected, auto start continues to run until there are no longer any rows to process. Auto Start then waits until the next scheduled time to run.
If, in the previous example, this check box is not selected, only one row is processed each time Auto Start runs according to the schedule.

Schedule
Click the ... symbol, to run the schedule for the Auto Start component.

Data To Expose

Properties To Expose
Lets you add project data to be exposed externally. This option lets you provide methods on your workflow service that lets users inspect or set your properties.

Workflow Runtime Settings

Allow External Workflow Tracking IDs
Select to provide an external tracking ID for the process. If this option is selected, when a request is made to start the workflow, a process tracking ID needs to be provided. The tracking ID that is provided must be unique.

- **Allow Workflow Abortions**
  Select to let administrators stop an unfinished task in a workflow.

- **Data Cleanup Policy**
  Select the cleanup policy you want for your project. If you select to clean up data, all file system data gets removed on either a model or a project exit.

- **Generate Hook For Auto Run**
  Select to allow the Workflow Server to periodically try to run this project. When you publish this project to a Workflow Server, this project registers itself as being able to run automatically. If this option is not selected, the project timeouts and escalations, reminders, and autostarts may not work correctly.

### Properties tab

Projects require the data that is taken as input, to run. This input data, can be set in this tab. Properties may include varying pieces of information, ranging from a user's name to a URL. Properties are available as variables in your projects.

You may edit your properties, remove properties you no longer need, or add new ones using the Editing options.

See "Workflow Designer tool" on page 152.

Editing options are as follows:

- **Add Property**
  Click this option to add a new property to your property list. This option adds a new entry to the property list. You may then edit your new property by editing the values to its **Property Name** and **Property Value** fields.

- **Add Password Property**
  Click this option to add a password property. After the property is added, a row is entered to edit the property name and password value. Click the ... symbol to configure the default password.

- **Convert To Password Property**
  To convert an existing property to a password property, select a row in the properties table and click **Convert to Password Property**. Click the ... symbol to configure the default password.

- **Remove Property**
  Click this option to remove a selected property. Properties are selected if there is an arrow located to the property's left.
Table Properties are as follows:

- **Name**
  Enter a name for your property. The default property, `BaseUrlToProject`, holds a reference to your project’s URL. The property names are displayed in your projects as variables.

- **Category**
  Enter a category for your property.

- **Value**
  Enter a value for your property. This value is entered into your project whenever you make reference to your property.

- **Description**
  Enter a description for your property.

**Storage Preferences tab**

This tab lets you set preferences for storing the data types that are in your project.

See “Viewing project data tabs” on page 170.

You can also configure ORM data types in the **Storage Preferences** tab.

See “About object-relational mapping (ORM) data types” on page 194.

See “Using an object-relational mapping (ORM) data type in a project” on page 195.

**Table 9-3** Options on the **Storage Preferences** tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Type</td>
<td>This option specifies the data type to which you want to change the storage preference.</td>
</tr>
<tr>
<td>Serialization Preference</td>
<td>This option specifies how the data is stored.</td>
</tr>
<tr>
<td>Externalize Data</td>
<td>This option lets you store the datatype in its own SymQ message.</td>
</tr>
<tr>
<td>Store Array Items Individually</td>
<td>This option lets you store each item in an array in its own SymQ message.</td>
</tr>
<tr>
<td>Store To Exchange Preference</td>
<td>This option specifies which SymQ exchange to store the data.</td>
</tr>
<tr>
<td>Clean Up Messages On Process End</td>
<td>This option specifies whether to delete the SymQ messages when the process finishes.</td>
</tr>
<tr>
<td>Debug Storage Property Name</td>
<td>This option specifies a prefix for the debug queue name.</td>
</tr>
</tbody>
</table>
### Table 9-3  
Options on the **Storage Preferences** tab (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage Property Name</td>
<td>This option specifies a prefix for the queue name.</td>
</tr>
</tbody>
</table>

### Reporting tab

This tab lets you set up project reporting with Process Manager.

See **“Workflow Designer tool” on page 152.**

- **Add Process Component**  
  Adds the component to your project that enables reporting (Global Logging Capture).

- **Process Prefix**  
  The prefix that appears in front of the reporting numbers.

- **Pad Char**  
  The character that gets placed at the beginning of the reporting numbers.

- **Pad Length**  
  The length you want for the reporting numbers.

- **Data Saving Mode**  
  The mode to save the report data. SymQ uses **Messaging** mode, and Process Manager web Services uses **Async** and **Sync** modes.

- **Process Data Queue**  
  Specifies to which SymQ exchange to send reporting data. By default, LBME.ReportingQueue sends the data to Process Manager.

- **Reporting Sequence Source**  
  How the system generates the unique reporting ID for each process. When you use Process Manager to report the data, **ProcessManagerReportingSequenceGenerator** should be used.

### Global Data tab

The global data tab contains the data that is available everywhere in the project. When you add global data variables, you can use those variables in any component in your project. You can even use global data variables in linked and embedded models without mapping them.

After you publish your project, you can also set the values of global data variables with web service method calls. All projects that have global data also have the web service methods that you can use to edit the values.

If your project connects to a Symantec Management Platform server, the connection information is saved in global data. You do not need to create global data variables...
to connect to a Symantec Management Platform computer; they are created automatically.

The Symantec Management Platform global data variables (such as `NSAuthenticationToken`) get their values from Credentials Manager.

See “About Credentials Manager” on page 603.

See “Workflow Designer tool” on page 152.

**Application properties tab**

Application properties are sets of the properties that you can create in Process Manager and share across multiple workflows. The tab shows the profiles that you created in Process Manager.

When you select **Use Application Properties**, all the variables become available in your project.

See “Workflow Designer tool” on page 152.

**Viewing project data tabs**

Project data tabs organize the project data that is one level lower than metadata.

See “Project data tabs” on page 158.

**To view project data tabs**

1. In an open project in Workflow Designer, in the left pane, click on the project name.
   
   The project metadata and property tabs appear in the right pane.

2. In the right pane, view the project data tabs.

**Generating project reports**

You can generate reports for a project. These reports include images of your project workspace, data on project performance, and data on project locations, connections, and options.

Reports are saved in the `Install Path\Altiris\Workflow Designer\WorkflowProjects\[project name]\reports` directory.

See “Workflow Designer tool” on page 152.

While most reports you are familiar with provide specific information to the project designer or user, in this case, these reports eventually provide information directly to the Workflow Server.
To generate project reports

1. In an open project in Workflow Designer, right-click the project name in the tree structure on the left.
   
   The project name is the top item in the tree structure.

2. Click Generate Reports.

   After the reports are generated, you can open an index page or view the directory that the reports are in.

Setting up how a project runs

The following are ways a project can be set up to run:

- **Webservice Start**
  
  Starts when a user makes a request (for example, through a Smart task in Helpdesk Solution or a resource Item Action). To start a web service workflow, you select a resource or a Smart task, right-click, and select the workflow.

- **Form Start**
  
  Starts with a dialog workflow form that requires user input (for example, salary advance requests or vacation requests). When a Form Start workflow starts, the workflow is processed until it gets to a Dialog Workflow component. The first workflow component you have must be a Dialog Workflow component. Form Start workflows can be started when a user right-clicks on an asset or a data class in the Symantec Management Console.

- **Auto Start**
  
  The Workflow Server monitors an event and when that event happens, the workflow runs. For example, when an email appears in a mailbox, a particular workflow runs.

To set up how you want a project to run

1. In the Workflow Designer Tool, in the project pane, select the project name.
   
   See “Workflow Designer tool” on page 152.

2. In the right pane, click the Publishing tab.

3. Scroll down to the Workflow Type section and select one of the following:
   
   - Webservice
   - Auto Start
   - Form Start
Based on the workflow type you select, appropriate properties appear in the Dialog Settings section.

Webservice and Form Start workflows can be published onto the Workflow Server and enabled to run on the Symantec Management Console. Form Start workflows can be created in the Symantec Management Console as published workflows or as Item Actions that are tied to data classes. Webservice workflows can be created in the Symantec Management Console in a service catalog as Helpdesk Solution Smart tasks, Task Server tasks, or as Item Actions.
About workflow components

This chapter includes the following topics:

- About workflow components
- Start and End components
- Adding components to a project
- Connecting components
- Component editors
- Viewing component help
- Viewing the component help (wiki pages)
- Contributing to the component pages
- Copying components to another model
- Copying properties to other components
- Adding components to your personal library

About workflow components

Workflow components are the building blocks of workflow projects. They are graphical representations of single functions in a workflow. Workflow Designer contains the components that you can use to create a workflow. You can use these components to create a process in the workspace of Workflow Designer.
Not all components are available in every Project type. For example, you cannot use form components in a Decision-type Project. Each Project type has the components that are specific to it.

Workflow Designer includes many hand-coded Symantec components. Most of the hand-coded components are available immediately, but some are available only by running component generators.

Symantec components work with different parts of the Symantec Management Platform. Each component has a unique function. Some components work with resources, tasks, and activities in the Symantec Management Console. Some components work with Symantec solutions (such as Deployment Solution). All Symantec components have a live connection to the Symantec Management Platform server. This connection lets components view available resources and tasks, and perform actions against them as part of a workflow.

To use Symantec components in your Project, your Project must have a Create Notification Server Credentials component with valid credentials.

Components that are available for use in your Project are listed in the component toolbox of Workflow Designer. Use the search box to quickly find components by name.

Some components do not appear in the component toolbox by default. These components must be imported before you can use them in your Project.

See “About Workflow Designer Project Types” on page 147.

See “About the component generators” on page 240.

See “About design-time and run-time Deployment Server connection settings” on page 590.

See “Importing components into a project” on page 215.

Start and End components

Start and End components begin and end your projects. They are always required, unless you use an auto-start component (such as Configurable Auto Start) instead of a regular start component.

Some end components can map data out of a model. The components have this function only in secondary models in the project tree structure or in embedded models.

See “About workflow components” on page 173.
Adding components to a project

When you open a project in Workflow Designer, some components automatically appear in the workspace. Most projects contain a Start component and an End component. Some projects contain a Create Notification Server Credentials component. All other components are in the component toolbox.

See “About the component toolbox” on page 154.

To add components to a project

1. In an open project in Workflow Designer, in the component toolbox, find the component you want to add to your project.
   To find a component, search for it in the search bar, or look for it in the component folders.

2. When you find the component you want to add, click on it and drag it onto the workspace.
   If you drag-and-drop a component from the component toolbox directly onto an existing component connection, the component is connected automatically.

Connecting components

In an open project in Workflow Designer, when you drag-and-drop a component onto the workspace, it is not connected to any other components. Components must be connected to function. A component must have a connection for its input path and for all of its outcome paths.

If you drag-and-drop a component from the component toolbox directly onto an existing component connection, the component is connected automatically.

You cannot connect to some components, such as a Start component or an Auto Start component (for example, Configurable Auto Start).

See “Adding components to a project” on page 175.

To connect components

1. In an open project in Workflow Designer, drag-and-drop a component from the component toolbox onto the workspace.

2. Click on the component that you added to the workspace.
   Gray nodes appear around the component. The nodes are the connection points.
3 Click on one of the gray nodes by the component, and drag it toward another component.
   A blue line and arrow appear. The line and arrow represent the component connection.
4 Release your mouse click when the blue line and arrow connect with another component.

Component editors
Every component has a component editor. You can view a component's editor by double-clicking the component. Editors contain the properties that configure how a component runs.

When you configure a component editor, first configure the required properties that are marked with a red warning.

See “About input and output variables for components” on page 184.

Viewing component help
Most components have embedded help that describes the component's function and tells you how to set up the component. Component help includes general information about the component (for example, description and usage). Component help also includes specific information about the individual properties of the component (for example, datatype).

See “About workflow components” on page 173.

To view component help
1 In an open project in Workflow Designer, add a component to the workspace.
2 Right-click on the component, and then click Help.

Viewing the component help (wiki pages)
Symantec Connect has created a wiki page for each component that is included with the default installation of Workflow. This new component wiki model makes structured, community-based content available at its point of use.

You can also add or suggest changes to content in the wiki pages.

See “Contributing to the component pages” on page 177.
You can access the component help (wiki pages) as follows:
To view a component's help (wiki pages) from Workflow Designer

1. Open a project in Workflow Designer.
2. In the Toolbox, right-click a component and then click Help.
   
   You can also right-click a component in the project workspace.
3. On the component's help page, click the Online Help tab.

To view a component's wiki page on Symantec Connect

1. Log in to Symantec Connect.
2. Open the Endpoint Management Articles page.

   https://www.symantec.com/connect/endpoint-management/articles
3. In the All Authors drop-down list, click SymantecWorkflowTeam.
4. After the list of component articles populates, select a component.

Contributing to the component pages

Symantec Connect has created a wiki page for each component that is included with the default installation of Workflow. This new component wiki model makes structured, community-based content available at its point of use.

You can access these wiki pages from Workflow Designer as part of each component's Online Help. You can also access these wiki pages on Symantec Connect.

See “Viewing the component help (wiki pages)” on page 176.

You can earn Symantec Connect points by adding your knowledge, use cases, and examples to the component wiki pages. Suggested changes or additions must be approved. If the moderator approves your suggestions, the wiki page is updated, your user name is added to the page's Collaborators list, notifications are sent, and Connect points are awarded.

You can contribute to the component wiki pages as follows:

From Workflow Designer

To contribute to a component's wiki page from Workflow Designer
To contribute to a component's wiki page from Workflow Designer

1. Open a project in Workflow Designer.
2. In the Toolbox, right-click a component and then click Help.
   - You can also right-click a component in the project workspace.
3. On the component's help page, click the Online Help tab.
4. On the Online Help tab, in the upper right corner, click Login to Symantec Connect and log into Symantec Connect.
5. On the component’s page, click SUGGEST CHANGES.
6. In the Proposed body text section, enter the information that you want to add or the changes you want to make to the existing content.
7. In the Submitter Comments section, provide a short summary of your additions or changes to help the moderator approve your suggestions.
   - Note that comments are required.
8. When you are finished, click Submit Changes.
   - Your suggested changes are sent to a moderator for approval.

To contribute to a component's wiki page on Symantec Connect

1. Log in to Symantec Connect.
2. Open the Endpoint Management Articles page.
   - https://www.symantec.com/connect/endpoint-management/articles
3. In the All Authors drop-down list, click SymantecWorkflowTeam.
4. After the list of component articles populates, select a component.
5. On the component’s page, click SUGGEST CHANGES.
6. In the Proposed body text section, enter the information that you want to add or the changes you want to make to the existing content.
7. In the Submitter Comments section, provide a short summary of your additions or changes to help the moderator approve your suggestions.
   - Note that comments are required.
8. When you are finished, click Submit Changes.
   - Your suggested changes are sent to a moderator for approval.
Copying components to another model

A single project can have many models. You can copy all of a model or part of a
model to other models within the project.

See “About project models” on page 222.

You can also copy components from one project to another; however, some
components may not copy successfully. For example, you cannot copy a Form
Building component into a Decision-type project.

You can copy components when you work with large projects. You can design and
test parts of the project in isolation from the main project, and then transfer the
tested sections back.

See “About workflow components” on page 173.

To copy components to another model

1. In an open project in Workflow Designer, in the workspace, select the
   components to copy by dragging a window around them.
2. Click the Copy Components to Model symbol on the option bar.
3. Select your copy preference
   The following table describes the copy preferences:
   - Replace with embedded model component.
     Click to replace the selected components with an embedded model
     component.
   - Copy to new model.
     Click to copy the selected components to a new model. Replace
     components with a link to the new model places the selected components
     in an embedded model component.
   - Copy to existing model.
     Click to copy the selected components to an existing model.
4. Click OK.

Copying properties to other components

You can copy common properties from one component to another. You can also
copy the entire component if you need multiple identical components with the same
configuration. However, you can also use the copy properties function. Use this
function if multiple components share a property and you want to distribute a certain
configuration to all of the components at once.
See “About workflow components” on page 173.

To copy properties to other components

1 In an open project in Workflow Designer, in the workspace, select the components to copy by dragging a window around them.

   The first component that you select is the component from which the properties are copied.

2 Click the Copy Properties symbol on the option bar.

3 Select the properties that you want to copy.

   The selected properties are copied from the first selected component to all other selected components.

4 Click OK.

Adding components to your personal library

You can save configured components in your personal library and use them later. The personal library is in the component toolbox under the Library tab.

See “About the component toolbox” on page 154.

To add components to your personal library

1 From the Workflow Designer tool, in the workspace, right-click on a component and then click Save Component To Library.

2 Enter the name you want and click OK.

To view components in personal library

1 From the Workflow Designer tool, in the toolbox, click the Library tab.

   You can view the components by name, type, and date.

2 Locate your component in one of the folders.
Working with projects

This chapter includes the following topics:

- About project data
- Publishing a project
- Project documentation
- Validating a project model
- Importing components into a project
- Importing a workflow model
- Installing a Monitoring project as a Windows service application
- Packaging a project
- Testing a project
- Running a load test
- Reloading a project
- Starting and stopping a Windows service Monitoring application
- Starting and stopping a task tray Monitoring application

About project data

Every Workflow project needs data to operate. Components and models operate on data. Many components require input variables to do their jobs, and many components create output variables.

Data for a project can be introduced while the project is running, or it can be introduced before the project runs. While the project is running, data can come from
a number of sources. Data can come from a database query in a database, user input in a form, a web service call, and so on. Data can be introduced before the project runs by adding values to a project's input data or by using constant values for component input data.

You can create user-defined data types with Integration-type projects.

See “About Integration Project Types” on page 152.

If you create a user-defined type, you must import the compiled DLL into your project before the data type is available.

See “Importing components into a project” on page 215.

See “About data types” on page 182.

See “About input and output data for project models” on page 183.

About data types

Workflow Designer handles data based on its data type. A data type is a data classification that describes the nature of the data. For example, a variable with a value of 15, may be of data type integer.

See “About project data” on page 181.

Workflow components handle data according to data type. For example, a Get Current Date component produces an outcome variable of type Date (Date Time).

See “Symantec component datatypes” on page 659.

Data types are categorized in two major divisions: "simple" data types and complex data types.

Table 11-1 Datatypes

<table>
<thead>
<tr>
<th>Datatype</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Simple&quot; data type</td>
<td>The most basic set of data types. This data type classifies only one piece of data (although that data can be in an array). It does not have multiple properties like the complex data types. Examples of this data type include: number (integer or decimal), text, Boolean, and date time.</td>
</tr>
</tbody>
</table>
Table 11-1  Datatypes (continued)

<table>
<thead>
<tr>
<th>Datatype</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complex data type</td>
<td>A data object with multiple properties. This data type combines data into a data object with a single, meaningful name. For example, a complex data type that is called <strong>Employee</strong> might include the following properties: <strong>Name</strong> (text), <strong>EmployeeID</strong> (number), <strong>IsRetired</strong> (true or false), and <strong>CellPhoneNumber</strong> (number).</td>
</tr>
<tr>
<td>Custom data type</td>
<td>A complex data type that is unique to Workflow. This data type is used in projects to pull together related data from the Symantec database into relevant groupings. See “Symantec component datatypes” on page 659.</td>
</tr>
<tr>
<td>User-defined data type</td>
<td>A complex data type that a user creates. You can create a user-defined data type for any pieces of data that you want to group together into a single object. For example, you may want to create a data type that is called user to hold user data (First Name, Address, and Telephone Number). By creating a user-defined type, you can speed project functions and simplify how you work with data types. Without the user-defined type, you may be required to have several individual variables to organize and work with user data. With the user-defined type, you would only need one variable. See “Generating components” on page 259.</td>
</tr>
<tr>
<td>Object-relational mapping data type</td>
<td>A data type that uses SymQ to map dynamically to a database. See &quot;About object-relational mapping (ORM) data types&quot; on page 194.</td>
</tr>
</tbody>
</table>

About input and output data for project models

Every model can have input and output data. Input and output data for project models are optional. Most projects do not need input or output data. If you use input or output data, you can edit them in an open project in Workflow Designer. Input and output data are located model names in the project tree structure. Use input data to declare what values must be available to the project before the project runs. Use output data to declare what values must come out of the project. You can set different input and output data for each model of a project.
About input and output variables for components

Almost all components require data to do their jobs, and many components create output data after they have done their jobs. You set input and output data for a component in the component editor.

See “Component editors” on page 176.

For example, the Add Values component requires two pieces of data to do its job: First Value and Second Value. These pieces of data are the input data for the component. The Add Values component also has a property that is called Output Variable Name, which refers to output data for the component.

You can set input data for a component in a number of ways. For example, when you set the First Value property for an Add Values component you have three options: Process Variables, Dynamic Model, and Constant Value. Other components have other options for setting input data. For some components, such as the For Each Element In Collection component, you must set a data type before you can set input data.

The options for setting component input data are as follows:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Variables</td>
<td>Lets you select a variable from the process. Process variables include any data that is available on the data stream, such as project properties, global data, and output variables from other components. A process variable is not available unless it is introduced to the process before a component in which you intend to use it. If a variable is introduced to the process after a component, you cannot use that variable in that component.</td>
</tr>
<tr>
<td>Constant Values</td>
<td>Lets you set a constant value. Constant values are not static values.</td>
</tr>
<tr>
<td>Multiple Mapping</td>
<td>Lets you map an array into an array.</td>
</tr>
<tr>
<td>Single Mapping</td>
<td>Lets you map a single value into a single value.</td>
</tr>
<tr>
<td>Dynamic Model</td>
<td>Lets you configure a dynamic model to determine the value. When you use this method, always map the value in the End component of the dynamic model.</td>
</tr>
</tbody>
</table>
Dynamic Value

About mapping data

Mapping data refers to copying the value of one variable into another variable. When you map data, you establish a connection between two variables so they have the same value. The two variables that you use for data mapping can be in two separate complex data types. However, the two variables that you use for data mapping must be of the same "simple" data type (except for convertible types).

You can map a Text data type property in one complex data type to a Text data type property in another complex data type.

In an open project in Workflow Designer, you can map data in many places.

See “Opening the data mapping editor” on page 187.

See “Opening the data mapping editor in Single Value Mapping and Multiple Value Mapping components” on page 188.

See “About the data mapping editor” on page 186.

See “About data mapping conversions” on page 189.

See “About data mapping conversions” on page 189.

See “Creating a data mapping assignment” on page 190.

Table 11-2  Some places that you can map data in a project in Workflow Designer

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Value Mapping</td>
<td>This component lets you map single values into other single values.</td>
</tr>
<tr>
<td>component</td>
<td>This component lets you map values using the full data mapping editor.</td>
</tr>
<tr>
<td></td>
<td>See “About the data mapping editor” on page 186.</td>
</tr>
<tr>
<td>Multiple Value Mapping</td>
<td>This component lets you map array values into other array values.</td>
</tr>
<tr>
<td>component</td>
<td>This component lets you map values using the full data mapping editor.</td>
</tr>
<tr>
<td></td>
<td>See “About the data mapping editor” on page 186.</td>
</tr>
</tbody>
</table>
Table 11-2  Some places that you can map data in a project in Workflow Designer (continued)

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special End components</td>
<td>Some End components have embedded data mapping. For example, End components in Embedded Model components. You can also map data in the End components of dynamic models. For example, you can configure the input values of some of the components (such as the Add Values component) to use Dynamic Models. You can map data in the End components of these models. When you map data in End components, you do not have access to the full data mapping editor. In End components, you can map only one variable to one other variable.</td>
</tr>
<tr>
<td>Input data for the components that take array values</td>
<td>For components (such as the Add Items to Collection component) that can take array input data, you can map values. You have two mapping options when you add input data: <strong>Multiple Mapping</strong> and <strong>Single Mapping</strong>. When you use these options, you can map values using the full mapping editor. See “About the data mapping editor” on page 186.</td>
</tr>
</tbody>
</table>

About the data mapping editor

The data mapping editor lets you configure data mapping between single values or arrays. You can access the data mapping editor in many places in an open project in Workflow Designer.

See “About mapping data” on page 185.
See “Opening the data mapping editor” on page 187.
See “Opening the data mapping editor in Single Value Mapping and Multiple Value Mapping components” on page 188.

The data mapping editor has four columns: root target, Data definitions, a column that shows the mapping connections, and a column for the destination data type.

The root target column shows the source complex data type. Complex data types can have nested complex data types. If your complex data type has a nested complex data type, that data type appears under the primary data type in the column. You can change which data type appears in this column by changing the complex data type with which this data mapping editor works.

The data definitions column shows the properties in the source complex data type. The individual properties that you see in this column are the source properties that
you should map into the destination properties. You can expand a complex data type to see its properties.

The column that is between the source data type and the destination data type columns shows the mapping connections. After you make mapping connections, you can right-click on connections and take actions on them.

See “Creating a data mapping assignment” on page 190.

The column on the right shows the properties of the destination complex data type. The individual properties that you see in this column are the destination properties into which you should map data.

When you map one property into another property, a blue line appears. This line represents the relationship between the two properties. You can right-click on this line for options. If you see a red line, the mapping definition is invalid. You can only map two variables that are of the same "simple" data type (except for convertible types).

### Opening the data mapping editor

The data mapping editor lets you configure data mappings between single values or arrays. The following procedure explains how to open the data mapping editor in the Add Items To Collect component. This procedure can also be applied to the other component that can use data mappings to define the input data.

You can access the data mapping editor in many places in an open project in Workflow Designer.

See “About mapping data” on page 185.

**To open the data mapping editor in the Add Item To Collect component**

1. In an open project in Workflow Designer, add the Add Items To Collect component to the workspace.
   
   See “Adding components to a project” on page 175.

2. Double-click on the component to open the Add Items To Collect Editor.

3. On the **Definitions** tab, to the right of the **Data Type** field, click the … symbol and set the data type to a complex data type (such as `.FileDataType`).

   Some components require you to define the complex data type for the component.

4. To the right of the **Items To Add** field, click the … symbol and perform one of the following actions to open the data mapping editor:

   - Map single values (non-array items).
   - Check **Single Mapping** and then click **Edit**.
Map arrays

- Check **Multiple Mapping** and then click **Edit**.
  
  The multiple mapping option requires you to define the data type and the variable for the source array.
- In the **Edit Object** dialog box, to the right of the **Source Array Type** field, click the ... symbol and select the data type that you want to map.
- To the right of the **Create Item For Each** field, click the ... symbol and select the variable that you want to map.
- To the right of the **Target Mapping Definition** field, click the ... symbol.

5 In the **Data Mapping** dialog box, map and validate your data mappings, and then click **OK**.

Opening the data mapping editor in Single Value Mapping and Multiple Value Mapping components

The data mapping editor lets you configure data mapping between single values or arrays. The following procedures explain how to open the data mapping editor in the Single Value Mapping and Multiple Value Mapping components.

You can access the data mapping editor in many places in an open project in Workflow Designer.

See “About mapping data” on page 185.

To open the data mapping editor in a Single Value Mapping component

1 In an open project in Workflow Designer, add a Single Value Mapping component to the workspace.

   See “Adding components to a project” on page 175.

2 Double-click on the component to open the **Single Value Mapping Editor**.

3 On the **Configuration** tab, under **Mapping**, to the right of the **Target Type** field, click the ... symbol and set the **Data Type** to a complex data type (such as .FileDataType).

4 Under **Output**, to the right of the **Output Variable Name** field, click the ... symbol and select a variable.

5 Under **Mapping**, to the right of the **Mapping Definition** field, click the ... symbol to open the data mapping editor.

6 In the **Data Mapping** dialog box, map and validate your data mappings, and then click **OK**.
To open the data mapping editor in a Multiple Value Mapping component

1. In an open project in Workflow Designer, add a Multiple Value Mapping component to the workspace.
   See “Adding components to a project” on page 175.

2. Double-click on the component to open the **Multiple Value Mapping Editor**.
   The Multiple Value Mapping component requires you to define the data type and the variable for the source array.

3. On the **Configuration** tab, under **Mapping**, to the right of the **Target Type** field, click the ... symbol and set the **Data Type** to a complex data type (such as `.FileDataType`).

4. Under **Output**, to the right of the **Output Variable Name** field, click the ... symbol and select a variable.

5. Under **Input**, to the right of the **Source Array Type** field, click the ... symbol and select the data type that you want to map.

6. Under **Mapping**, to the right of the **Target Mapping Definition** field, click the ... symbol to open the data mapping editor.

7. In the **Data Mapping** dialog box, map and validate your data mappings, and then click **OK**.

---

**About data mapping conversions**

You can convert the data mapping definitions that you create in the data mapping editor.

See “About the data mapping editor” on page 186.

When you convert a data mapping definition, you set the definition to use new source data. You can use a constant value, a process variable, or a merged value. By using data sources, you convert the definition from using a property in the source data type.

See “About input and output variables for components” on page 184.

You can mix data sources in your mapping definitions. For example, you can map one property in a complex data type to a property in another data type. Then, you can set another property to use a process variable. You do not need to set all of the definitions in the same way.

Data mapping conversions have the same effect as creating a mapping assignment.

---

**About data mapping assignments**

You can create data mapping assignments in the data mapping editor.
Data mapping assignments refer to the data mapping definitions that use an alternate source for input data. You can create three kinds of assignments:

- **ProcessMappingAssignment**
- **MergeMappingAssignment**
- **ConstantMappingAssignment**

### Table 11-3 Types of mapping assignments

<table>
<thead>
<tr>
<th>Mapping assignment</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProcessMappingAssignment</td>
<td>Sets a mapping definition that uses a process variable.</td>
</tr>
<tr>
<td>MergeMappingAssignment</td>
<td>Sets a mapping definition that uses a text value that you can set in the advanced text creator.</td>
</tr>
<tr>
<td>ConstantMappingAssignment</td>
<td>Sets a mapping definition that uses a constant value.</td>
</tr>
</tbody>
</table>

Creating a data mapping assignment

You can create data mapping assignments in the data mapping editor.

1. In the data mapping editor, click on the property for which you want to create an assignment.
2. Click **Create assignment**.
3. Click one of the assignment options.
   - See “About data mapping assignments” on page 189.
   - The data mapping assignment appears as a half-line.
4. Double-click the half-line to edit it.
5. If you selected **MergeMappingAssignment** or **ConstantMappingAssignment**, set a value for the assignment.
6. If you selected **ProcessMappingAssignment**, create a model and map the value that you want in the End component.
About project properties

Project properties are the static data elements that are globally accessible in a project. In an open project in Workflow Designer, the project properties are located under the Properties tab.

See “Properties tab” on page 167.

Project properties are similar to global data except for a few key differences. Global data cannot be edited in the properties.config file. You can write to global data, but you can only read project properties. Also, global data values can be different for each invoked instance of the process. Project properties stay constant across all instances.

The project properties are as follows:

- Project properties stay constant across all instances of the project.
- Project properties are stored with the project files in properties.config
- Project properties are only Text (string) data type.
- Project properties are accessible anywhere in your project.
  Use project properties like you use any other data element. Project properties appear as a separate node in the variable picker.
  Remember, project properties are visible only in the components that take Text (string) type data.
- After you publish a project with project properties, you can edit the values of the properties in the properties.config file without having to publish again.

By default properties.config is located in C:\Program Files\Symantec\Workflow\WorkflowDeploy\Release\Project Name.

Symantec recommends that you use project properties for environment settings (such as a SQL server connection string). Instead of setting environment settings as static variables in your process, use project properties. If the environment settings change in the future, you can easily edit them in the properties.config file.

Although project properties can be only Text (string) data type, you can enter other data, such as a date or a number. If you use these alternative values, use components in your project to translate the values into Text (string) type. For example, you can use a Get Number From String or Convert String To Date component to convert Text data into Number data. You can also set a project property to be a password property. Password properties are masked values. Password properties are useful for other things than passwords, such as database connection strings (which often contain passwords). Use password properties to mask any value that you do not want all future designers to have access to when they work on your project.
Project properties also have description and category fields. Symantec recommends that you include a description of all of your properties. Categories are optional. If you have a number of related properties, you may want to create categories to group them together.

Notice that the defined categories show up as headers in the Properties Editor during publishing.

About application properties

Application properties are the data definitions that are stored in Process Manager for multiple different processes to use. Application properties are used when multiple processes that connect to Process Manager need to use the same data. For example, you can create application properties for mail server settings. These properties might include a server name and a no-reply email address.

You can use application properties to create widely available and easily edited data.

Application properties exist in profiles in Process Manager. A profile is a group of data that is related to a process instance. After application properties have been saved as a profile, processes can use the profile.

See “About project properties” on page 191.

If you have administrator permissions in Process Manager, you can create application properties. Application properties are set in Process Manager under the Admin tab > Data > Application Properties. After you have created application properties, you can use those settings in any workflow project that has access to Process Manager. In your project, you can access application properties in project data under the Application Properties tab.

See “Creating application properties in Process Manager” on page 529.

Application properties have three elements: profile definition, profile definition values, and instances. The following table describes these three elements:

<table>
<thead>
<tr>
<th>Table 11-4</th>
<th>Elements of application properties</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Element</strong></td>
<td><strong>Description</strong></td>
</tr>
</tbody>
</table>
| Profile definition | Application properties are stored in a profile. The profile must be defined before you can populate it with values. Application properties do not exist separately; they exist only in groups.  
|                  | After you have created it, the name of your profile definition appears in Workflow Designer.  
|                  | See “Accessing application properties in Workflow Designer” on page 194. |
### Table 11-4  Elements of application properties (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile definition values</td>
<td>Profile definition values are the individual properties of the application properties. When creating definition values you do not create their actual values; you merely create them as empty data elements.</td>
</tr>
<tr>
<td>Instances</td>
<td>Profile definition instances are the actual values of application properties. Each instance has a value and an instance name. Create more than one instance if you want to change definition values regularly. Multiple instances are ready-made values; if you have more than one in place you can switch between them in Workflow Designer.</td>
</tr>
</tbody>
</table>

### About working with project and application properties

Best practices for project properties are as follows:

- Use project properties for the high-level data that may change periodically, such as environment settings.
- Use project properties only for the values that can remain constant across all instances of a process. Use global data for the values that can change between instances.
- If you need to change the value of a property for a project that is already published, edit the properties.config file of the project.

Best practices for application properties are as follows:

- Use application properties for any variables that multiple processes in the same application use, and that have access to Process Manager. See “About Process Manager” on page 385.
- To temporarily change the value of an application property, create a new instance of the property. For example, if you change to a new mail server temporarily, add new instances of the server information properties. When you need to change servers, you can switch property instances instead of editing the values.

### Creating application properties in Process Manager

Application properties must be created in Process Manager before you can use them in any workflow project. You can create application properties if you have administrator permissions in Process Manager.
To create application properties in Process Manager

1. In Process Manager, click Admin > Data > Application Properties.
2. In the upper right corner, click the green plus symbol.
3. Name and describe your application properties, and then click Next.
   Name your properties based on their purpose (for example, the name of the department or application that uses them).
4. Add profile definition values, and then click Save.
   Profile definitions are the individual properties of your application properties. Think of them as individual project properties. They can be data elements such as server name, IP address, or a true element or a false element.
5. When you have finished adding profile definitions, click Next.

See “About application properties” on page 192.

Accessing application properties in Workflow Designer

After you have created application properties in Process Manager, you can access and use them in Workflow Designer.

See “Creating application properties in Process Manager” on page 529.

To access application properties in Workflow Designer

1. In an open project in Workflow Designer, in the tree structure on the left, select the project name.
   The project name is the top item in the tree structure.
2. In the right pane, click the Application Properties tab.
   If your project has access to the Process Manager, all of the available application properties appear.

About object-relational mapping (ORM) data types

Object-relational mapping (ORM) data types communicate with a database. The data in the data type is mapped to the data in the database so that the two sets of data have the same value. This mapping is accomplished through exchanges in SymQ.

You can create an ORM data type with the User-Defined Type with Database Mapping component generator.

See “About the User Defined Type with Database Mapping generator” on page 298.

The benefits of using an ORM data type are as follows:
- Helps preserve data
  By using an ORM data type, your process data is periodically saved in a database. During run-time, if your process loses its data, the data is still preserved in the database.

- Lets you avoid using database upload components
  ORM data types automatically upload process data to a database. Therefore, you do not need to use uploading components.

- Guarantees that your process and your database use the same data type
  ORM data types do not constantly store their data to a database. Constant communication with the database would significantly slow down the process. ORM data types store data to a database in various places in your process.

ORM data types store data in a process as follows:

- When a process runs a Save External Data Component
- Before a process runs a Form Builder component

In your process, when you want the ORM data type to store its data to the database, use a Save External Data component. You do not need to configure this component. When this component is invoked in a process, it causes all of the existing ORM types to store their data.

Using an object-relational mapping (ORM) data type in a project

You must create an ORM data type and configure it in your project before you can use it.

Table 11-5  Process for using an ORM data type in a project

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Create the ORM data type</td>
<td>You can create an ORM data type with the User-Defined Type with Database Mapping component generator. See “About the User Defined Type with Database Mapping generator” on page 298.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Import the ORM data type into your process</td>
<td>You must import the compiled DLL file of the ORM data type before you can use it in your project. See “Importing components into a project” on page 215.</td>
</tr>
</tbody>
</table>
### Table 11-5  Process for using an ORM data type in a project (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 3</td>
<td>Configure the project's storage preferences</td>
<td>You must configure the ORM data type in your project's <strong>Storage Preferences</strong> tab before you can use it in your project. See “Configuring an ORM data type on the Storage Preferences tab” on page 196.</td>
</tr>
</tbody>
</table>

After you have completed these steps, you are ready to use the ORM data type in your project. To introduce your ORM data type to your project, configure an Add New Data Element component to use your ORM data type.

### Configuring an ORM data type on the Storage Preferences tab

If you want to use an ORM data type in your project, you must first configure it on the **Storage Preferences** tab.

See “**Storage Preferences tab**” on page 168.

**Note:** You cannot configure an ORM data type in your project unless you have already imported it into your project.

See “**Importing components into a project**” on page 215.

**To configure an ORM data type on the Storage Preferences tab**

1. In an open project in Workflow Designer, click the **Storage Preferences** tab. See “**Viewing project data tabs**” on page 170.

2. On the **Storage Preferences** tab, click **Configure Database Types**.

3. Set **Exchange Storage Name**.

   This property is the name of the SymQ exchange that is used to store data in a database. You can configure this exchange in Workflow Explorer.

See “**About Workflow Explorer**” on page 638.
4 Set **Debug Exchange Storage Name**

This property is the name of the SymQ exchange that stores data in a database when you run the project in the debugger. You can configure this exchange in Workflow Explorer.

See “About Workflow Explorer” on page 638.

5 Select all of the ORM data types that you want to use in your project, and then click **OK**.

The data types that you added appear on the **Storage Preferences** tab.

## Publishing a project

When a project is finished, you publish it from the Workflow Designer to Workflow Server using the publishing wizard. Publishing is the act of moving the project from your test environment to your production environment so that it is ready to be run. The publishing wizard lets you publish to one or more Workflow Servers.

See “Setting up Workflow Designer to publish to multiple Workflow Servers” on page 212.

Every published project resides on Workflow Server.

The following checklist describes the steps for publishing.

Before you publish, your project must be valid and should be ready for a production environment.

### Table 11-6 Process for publishing a project

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add the destination server to the task tray application.</td>
<td>Every published workflow resides in Workflow Server on a computer. This computer can be the local design computer, a designated Workflow Server, or some other computer. The destination computer must be added to the task tray application. If the destination computer has already been added to the task tray application, you do not need to add it again. See “Adding a server in the task tray application” on page 210.</td>
</tr>
<tr>
<td>Set project’s publishing options.</td>
<td><strong>Note:</strong> This step is only for workflow and monitoring type projects. Publishing options determine how you can publish a project, what start type or deployment type you can set to a project. See “Setting the publishing options of a project” on page 199.</td>
</tr>
</tbody>
</table>
Table 11-6  Process for publishing a project (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a publishing format.</td>
<td>Publishing format refers to the means by which you move a project to the destination server. You can view the publishing format options by clicking the publishing symbol in the toolbar of an open project in Workflow Designer. See “About publishing formats” on page 201.</td>
</tr>
</tbody>
</table>

See “About Workflow Server” on page 42.

Publishing options of a project

Publishing options determine how you can publish a project, what start type or deployment type you can set to a project.

Start types refer to how a process is invoked. The start type that you choose may affect which options you have while you publish. For example, only a project that is set to Form Start can be published to Process Manager Forms.

Deployment type is how the application runs once it is deployed. Deployment type refers only to Monitoring-type projects.

Configure publishing options under the Publishing tab in a project's settings. Refer to the following table to determine what start type you should use.

See “Publishing a project” on page 197.

Table 11-7  Publishing options by Project Type

<table>
<thead>
<tr>
<th>Project type</th>
<th>Start options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow</td>
<td>Workflow-type projects have three publishing options:</td>
</tr>
</tbody>
</table>
|              | ■ Webservice  
|              | A project that is set to **Webservice** starts when a web service call invokes it.                                                                                                                            |
|              | ■ Auto Start   
|              | A project that is set to **Auto Start** must begin with an Auto Start component. These components wait for events. This event can happen in the Symantec Management Console or in another program, as long as the Workflow Server can monitor it. |
|              | ■ Form Start   
|              | A project that is set to **Form Start** starts when a user clicks a link to see a form.                                                                                                                       |
### Table 11-7 Publishing options by Project Type (continued)

<table>
<thead>
<tr>
<th>Project type</th>
<th>Start options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decision Only</td>
<td>Decision Only projects have no publishing options because they are always web services.</td>
</tr>
<tr>
<td>Integration</td>
<td>Integration-type projects do not have any publishing options because they are not published. Integration projects generate components; they are not processes.</td>
</tr>
<tr>
<td>Monitoring</td>
<td>Monitoring-type projects have three deployment types:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Webservice</strong></td>
</tr>
<tr>
<td></td>
<td>A project that is set to <strong>Webservice</strong> starts when a web service call invokes it.</td>
</tr>
<tr>
<td></td>
<td>• <strong>WindowsService</strong></td>
</tr>
<tr>
<td></td>
<td>A project that is set to <strong>WindowsService</strong> starts when a <strong>WindowsService</strong> call invokes it.</td>
</tr>
<tr>
<td></td>
<td>• <strong>TaskTrayApplication</strong></td>
</tr>
<tr>
<td></td>
<td>A project that is set to <strong>TaskTrayApplication</strong> becomes an application that you can invoke in the task tray. This option lets you share and control your published project more easily than if you published it as a web or windows service.</td>
</tr>
</tbody>
</table>

| Forms (Web)       | Forms (Web) Project Types are always **Form Start**.                         |

### Setting the publishing options of a project

You need to set the publishing options of your project if you have either a workflow or a monitoring type project.

See “Publishing options of a project” on page 198.

See “Deploying a project” on page 203.

This task is a step in the process for publishing a project.

See “Publishing a project” on page 197.

**To set publishing options of a project**

1. In Workflow Designer, open the project that you want to publish.
2. In the project pane on the left, click the name of your project. This name is the top item in the tree structure.
3. On the **Publishing** tab, perform one of the following actions:
If you have a workflow type project

Select one of the following workflow types:

- Webservice
- Auto Start
- Form Start

See “Publishing options of a project” on page 198.
If you have a monitoring type project

To publish the project as a Windows service, take the following actions:

- Under Schedule, click the ... symbol, and then set the schedule for the application. You can change the schedule at any time after the application is published.
- Under Deployment, in the Deployment Type drop-down list, click Windows Service.
- Click OK.

The options for the Windows Service install are generated to an XML file, DeploymentInfo.config, in the publishing directory. The configuration file contains the schedule and Windows Service configuration settings.

See “Installing a Monitoring project as a Windows service application” on page 216.

See “Starting and stopping a Windows service Monitoring application” on page 219.

To publish the project as a task tray application, take the following actions:

- Under Schedule, click the ... symbol, and then set the schedule for the application. You can change the schedule at any time after the application is published.
- Under Deployment, in the Deployment Type drop-down list, click TaskTrayApplication.
- Click OK.

The publishing options are generated to an XML file, DeploymentInfo.config, in the project's publishing directory. You can edit publishing options after you publish. The publishing directory also contains the publishing run schedule in the schedule.lbschedule file. You can edit this file with the Workflow Schedule Editor (Start > All Programs > Symantec > Workflow Designer > Tools > Schedule Editor).

See “Starting and stopping a task tray Monitoring application” on page 220.

5 Publish your project.

See “Deploying a project” on page 203.

About publishing formats

You can publish a project in one of the default publishing formats: compressed file, directory, server, and installer. These options are available in every project type.
You see these formats in Workflow Designer when you click the publishing symbol in the toolbar. These formats are different means of moving a project to a Workflow Server. Each format compiles the process code differently to give you different implementation options.

### Table 11-8 Publishing formats

<table>
<thead>
<tr>
<th>Publishing format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publish Project</td>
<td>Publishes a project to the local server and also to the remote servers. These servers can exist in one or more environments that are set up in the Symantec Management Platform. See “Publishing a project” on page 197.</td>
</tr>
<tr>
<td>Create Publishing Zip File</td>
<td>Creates a compressed file that contains all of the files in your project. Use this format when you need to transfer your project files across an Internet connection. For example, you may need to publish your project onto a computer to which you do not have access from your design computer. In such a case you can create a compressed file and send it easily (through email or otherwise) to the destination computer. See “Creating publishing zip file” on page 205.</td>
</tr>
<tr>
<td>Create Publishing Directory</td>
<td>Creates a directory on the local computer that contains all of the files in your project. Use this format when you need to publish your project to a nearby computer to which you do not have access from your design computer. For example, you can put the directory onto a removable drive and deliver it to the destination computer. See “Creating a publishing directory” on page 205.</td>
</tr>
<tr>
<td>Create Publishing Installer</td>
<td>Creates an installer for your project. The installer contains all of the files in your project. Use this format when you need to give the project files to someone who does not know where to put the files on a computer. The installer helps a user put the project files in the correct location on the destination computer. See “Creating and running a workflow project installer” on page 205.</td>
</tr>
</tbody>
</table>
Table 11-8  Publishing formats (continued)

<table>
<thead>
<tr>
<th>Publishing format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Publish to Process Manager Forms</td>
<td>Creates a link in the Process Manager service catalog. The project is published to Workflow Server, but the link is created in the service catalog so that you can launch it through Process Manager. You can use this publishing format to publish to the ServiceDesk service catalog. This publishing format is available only in Workflow-type and Webforms-type projects. Workflow-type projects must be set to Form-Start before they can use this publishing format. This publishing format is available only if you have a Process Manager server registered in the task tray application. See “Adding a server in the task tray application” on page 210.</td>
</tr>
<tr>
<td>Publish Project as DLL</td>
<td>Generates the project as a DLL file. You can use this DLL file in many contexts, such as a project in Microsoft Visual Studio. This publishing format is an option only for Decision Only-type projects.</td>
</tr>
<tr>
<td>Publish Project as EXE</td>
<td>Generates the project as a standard EXE file that can be run in any environment. This publishing format is an option only for Decision Only-type projects.</td>
</tr>
</tbody>
</table>

Deploying a project

You can publish a project to the local server and also to the remote servers. These servers can exist in one or more environments that are set up in the Symantec Management Platform.

See “Publishing a project” on page 197.

To deploy a project

1. Workflow Designer window, open the project you want to publish.
2. On the File menu, click Publish Project > Publish Project.
3 In the **Publish Project** dialog box, on the **Deployment Targets** page, set the virtual directory name, and check environments or standalone servers to publish the project.

The **Deployment Targets** page displays the servers that are registered with the Symantec Management Platform. These servers are the available deployment targets. Environments are listed at the top of the page and standalone servers are listed below. Standalone servers are unmanaged individual servers to which you can publish.

If you choose to publish to a managed environment, which is indicated by the lock icon, you must have the permission to do so. This permission is the specific permission granted under the security menu in the Symantec Management Platform. You might not have the permission to publish to a managed environment. In this case an email is automatically sent to the user who manages the Symantec Management Platform. The letter contains a request for that person to do the publishing for you from the console.

4 On the **Properties** page, on the tab that contains the default settings for your deployment target computer, make your changes, and then click **Next**.

5 (Optional) Step 5 only applies to publishing Forms (Web) type of project.

On the **Publish to Process Manager Forms?** page, check the Process Manager servers that you want to use to publish your projects to Process Manager Forms.

Type the required credentials, and click **Next**.

---

**Note:** Credentials must be admin credentials for ProcessManager.

6 On the **Summary** page, review the summary of the publishing details, and then click **Next** to begin the publishing process.

7 On the **Publishing Workflow** page, review the status messages of your publishing targets.

Click **Finish**.

8 (Optional) To verify that your project published to Process Manager, log on to your Process Manager page.

See “**Opening Process Manager**” on page 386.

On the **Submit Request** tab, confirm that your project is listed in the service catalog.
Creating publishing zip file

After you edit your project, you can create a compressed file of your project. You can use a compressed project file to transfer your project somewhere else for further editing, or to manually publish it to a computer.

See “Publishing a project manually” on page 207.

To create a compressed project file

1. Open your project in Workflow Designer.
2. Click File > Publish Project > Create Publishing Zip File.
3. Select a file destination.
4. Click Save.

The system prompts you for publishing configuration parameters (these are set during development typically and do not need to be changed here).

See “About the properties of a workflow model” on page 208.

Creating a publishing directory

After you edit your project, you can create a publishing directory of your project. The publishing directory includes all of the files for your project. Create a publishing directory if you publish your project manually.

See “Publishing a project manually” on page 207.

To create a publishing directory

1. Open your project in Workflow Designer.
2. Click File > Publish Project > Create Publishing Directory.
3. Select a location for your directory.
4. Click OK.

Creating and running a workflow project installer

After you edit your project, you can create an installation file. You can run the file to publish the project on any computer that has Workflow Server installed. After you have created it, move the installation file to the computer where you want to publish your project.

See “Publishing a project manually” on page 207.
To create a workflow installation file

1. Open the project for which you want to create an installation file.
2. Click File > Publish Project > Create Publishing Installer.
3. In the Publishing Installer Info dialog box, next to the Path to Installer, click the ... symbol, to choose the location that you want to save the file to.
4. Make necessary changes, and then click OK.

See “About the properties of a workflow model” on page 208.

5. Click one of the following options:
   - Click Run Installer if you want to immediately launch the installation wizard on your computer.
   - Click Open Directory if you want to open the directory where you saved your installation file. This action takes you to your installation file so that you can transfer it or run it on your computer.
   - Close this window.

To run the installer

1. Find the installation file that you created.
   Workflow Designer saves by default in the following location: C:\Program Files\Symantec\Workflow Designer\Workflow Projects.

2. In the project folder, open the Setup folder.

3. Double-click the .exe setup file.

4. Complete the wizard.

Publishing a Monitoring-type project as a task tray application with an installer

You do not have to directly publish a Monitoring-type project as a task tray application. You can also use an installer. However, it must be installed on a computer where workflow is installed.
To publish a Monitoring-type project as a task tray application with an installer

1. After creating an installer for the Monitoring-type project, move the publishing package to the computer where you want to publish the application.
   
   See “Creating and running a workflow project installer” on page 205.

2. Run the installer on the computer where you want to publish the application.
   
   The installed executable becomes a task tray application.

3. (Optional) If you want the project to run automatically, you can add the project to the Windows Startup folder.

Publishing a project manually

You can publish a project manually. You create an installation file, a publishing directory, or a compressed file of your project. Then you move the project files to the destination computer. You cannot move project files to a computer to publish the project. You must first make an installation file, a publishing directory, or a compressed file of your project.

See “About publishing formats” on page 201.

You can only publish a project manually to computers that have Workflow Server installed.

See “About installing Workflow” on page 46.

To publish a project manually

1. In Workflow Manager, open the project that you want to publish manually.

2. Create an installation file, a publishing directory, or a compressed file of your project.
   
   See “About publishing formats” on page 201.

3. If you created an installation file, move the file to any directory on the destination computer, and then run it.
   
   See “Creating and running a workflow project installer” on page 205.

4. If you created a publishing directory, move the directory into the WorkflowDeploy directory on the destination computer.
   
   This directory is usually located in C:\Program Files\Symantec\Workflow.
If you created a compressed file, move the compressed file into the **WorkflowDeploy** directory on the destination computer, and then uncompress it.

This directory is usually located in `C:\Program Files\Symantec\Workflow`.

Configure the web server to recognize the application.

See “Creating a virtual directory in IIS” on page 213.

### Configuring the root URL

Root URL refers to where a process is published. Server Extensions use localhost as the default Root URL, but you should change this setting based on how accessible you want your process to be. If you leave the root URL set to localhost, your published processes are accessible only from the local computer. You should set the Root URL to an address that resolves from any computer that accesses your published projects. For example, when you configure for intranet access, set the Root URL to the computer name or internal IP address where you published your project. When you configure for Internet access, set the Root URL to the domain name or external IP address where you published your project.

See “About the properties of a workflow model” on page 208.

To configure the root URL

1. Open Server Extensions Configurator.
   - On the Windows **Start** menu, click **All Programs > Symantec > Workflow Designer > Tools > Server Extensions Configurator**.
2. In the **Server Extensions Configurator** dialog box, under **Deployment**, to the right of the **Deployment Info** box, click the ... symbol.
3. In the **Edit Object** dialog box, in the **Root URL** box, replace `http://localhost/` with the appropriate computer name, domain name, or IP address, and then click **OK**.
4. In the **Server Extensions Configurator** dialog box, click **OK**.
5. In the confirmation dialog box, click **Yes** to save changes, and then click **OK**.
6. Click **Yes** to restart server extensions and apply changes.

### About the properties of a workflow model

The properties of a workflow project are set during development, but you can change them during the publishing process. In an open project, you can access the project properties in the **Properties** tab. However, password properties are encrypted and cannot be edited by hand.
Applications can have different properties that need to be configured on a publishing basis. However, all applications have a property called BaseURLtoProject. This property refers to the Root URL property that is set in the Server Extensions Configurator. The root URL property typically overwrites the BaseURLtoProject property in your project, except when you publish by creating a publishing director.

You can change any project properties. Always refer to the project's documentation before you make any changes.

You can also change a project's properties manually in the properties.config file in the Project folder.

The following example of a properties.config file shows the properties:

```xml
<?xml version="2.0" ?>

<ArrayOfApplicationProperty

xmlns:xsd="http://www.w3.org/2001/XMLSchema"

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">

<ApplicationProperty>

<PropertyName>BaseURLToProject</PropertyName>

<PropertyValue>http://localhost/DeployedApp2726</PropertyValue>

</ApplicationProperty>

<ApplicationProperty>

<PropertyName>UserIDOnDatabase</PropertyName>

<PropertyValue>sa</PropertyValue>

</ApplicationProperty>

<ApplicationProperty>

<PropertyName>PasswordOnDatabase</PropertyName>

</ApplicationProperty>

</ArrayOfApplicationProperty>
```
Adding a server in the task tray application

See "Publishing a project" on page 197.

The Workflow task tray application runs in your computer's task tray. In Windows, the task tray is located on the right side of the Start bar. Before you publish projects to a Workflow Server, you must register information about that server in the task tray application.

To add a server in the task tray application

1. On the Workflow Designer computer, in the notification area, right-click the task tray application, and then click Settings.

2. In the Machine Settings dialog box, in the left pane, under Local Machine Info, click Servers, and then, on the right, click Add.
3 In the **Edit Object** dialog box, configure the server that you want to add. When you are finished, click **OK**.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nickname</td>
<td>(Optional) An arbitrary short name that you can use to easily identify your computer. This name appears in the list of available computers in the task tray application.</td>
</tr>
<tr>
<td>Group Name</td>
<td>(Optional) An arbitrary group name. Use computer group names to organize your publishing targets (such as the production group and the testing group).</td>
</tr>
<tr>
<td>IP address</td>
<td>The IP address of the computer that you add.</td>
</tr>
<tr>
<td>Deployment Root URL</td>
<td>The root URL of the computer that you add.</td>
</tr>
<tr>
<td>Relative Path</td>
<td>The phrase that is appended to the end of the Deployment Root URL to access Process Manager. Do not change this setting unless you need to use a different phrase to access Process Manager.</td>
</tr>
<tr>
<td>Port number</td>
<td>The port that is used to access Process Manager.</td>
</tr>
<tr>
<td>User ID</td>
<td>The user name that is used to access Process Manager. If you publish a process to this computer that accesses Process Manager, the process uses this user name for authentication.</td>
</tr>
</tbody>
</table>
| Password            | The password that is used to access Process Manager. If you publish a process to this computer that accesses Process Manager, the process uses this password for authentication.  
 **Note:** If you change this password, you must also update the password manually in the **Local Machine Info** on all computers that point to the Process Manager. |
| Store Password      | Sets whether the Process Manager password is stored for processes to use. Leave this setting turned on unless you have a specific reason for turning it off. |
| Use HTTPS           | Sets whether Process Manager is accessed with HTTPS instead of HTTP.       |
| Server port number  | The port that Server Extensions uses to communicate with this computer.     |
Server Role

Sets which roles this computer has. This setting is important. Make sure that you assign the correct roles to the server that you add. For example, if your server is running Process Manager, make sure that the Process Manager role is selected.

4 In the **Machine Settings** dialog box, click **OK**.

**Setting up Workflow Designer to publish to multiple Workflow Servers**

When you have finished editing a project in Workflow Designer, you can publish it to a Workflow Server using the publishing wizard. The publishing wizard lets you publish to one or more Workflow Servers.

See “Publishing a project” on page 197.

To set up Workflow Designer to publish to multiple Workflow Servers

1 In Workflow Manager, click **Tools > Edit Machine Info**.

   See “About Workflow Manager” on page 132.

2 In the **Machine Settings** dialog box, in right pane, under **Servers**, click **Add**.

3 In the **Edit Object** dialog box, under **Server Details**, in the **Nick Name** box, type a nickname for the Workflow Server.

   This name is used when you publish a project.

4 In the **IP address** box, type the IP address of the Workflow Server.

5 In the **Deployment Root URL** box, type the root URL for the Workflow Server.

6 Click **OK**.

   Repeat steps 2 through 6 for each Workflow Server to which you want to publish.

7 In the **Machine Settings** dialog box, click **OK**.

   When you publish a project, you can select from the Workflow Servers that you have added.

**Tracking the status of a published workflow**

When a published workflow runs, you can check its status. If you publish to Process Manager, you can check the status of the running workflow if the project is configured to display status data. This data displays in the process view page.

See “About the Process View page” on page 390.
If you do not publish to Process Manager, you can still check the status of the workflow. Every workflow that is published has a Web service for tracking its status. You can query this service or make Web service calls to the workflow to get workflow status.

**To track the status of a workflow in Process Manager**

1. Open Process Manager.
2. Click **Reports**, and in the left pane, click **Default**.
3. Click **Process Viewer**.
4. Find the process that you want to view, and expand it.
   - Only the processes that have been set up to register process data appear.
5. Click on the instance of the process that you want to view.

**To track the status of a workflow in IIS**

1. On the server hosting the published workflow, open the IIS Web site of your workflow.
2. In the right pane, right-click **WorkflowManagementService.asmx**, and then click **Browse**.
3. When the Workflow Management Service opens in a browser, you can view different status reports on the project.

### Creating a virtual directory in IIS

Publishing to a compressed file or directory requires you to create a virtual directory to point to your published project. Your virtual directory in IIS must point to your application.

See “Creating publishing zip file” on page 205.

See “Creating a publishing directory” on page 205.

The installer and the direct publishing methods perform these steps for you.

See “About publishing formats” on page 201.

**To create a virtual directory in IIS**

1. On the computer where the project is published, open Internet Information Services (IIS) Manager.
   - To do that: on the Windows **Start** menu, in the Search box, type **Internet Information Services (IIS) Manager**, and then press **Enter**.
2. In the left pane, expand the computer in which you want the new application to reside.
3  Expand Sites.
4  Right-click the Web site in which you want the application to reside, and select Add Virtual Directory.
5  Configure the new virtual directory.

This virtual directory appears as a directory in the IIS browser.

**Project documentation**

A project can be documented using the Documentation tab. For a project, the documentation should provide the high-level description of the workflow process, plus any additional details relevant to the workflow configuration. However, it is there for you to use as wanted.

Annotation components are provided that let you place documentation in your project. You can also edit component names by double-clicking on the name. We recommend that you change component names whenever possible to reflect their functionality in the project.

See “About Workflow Designer project trees” on page 157.

**Validating a project model**

A valid workflow has no errors in individual component configuration, component connections, or project configuration. For example, if you do not have links out of your Start component or into your End component, you have validation errors.

See “About project models” on page 222.

When you validate a project you examine the reliability of the project. During design time, Workflow Designer shows you validation errors with red exclamation mark circles. You can also validate your project manually.

The project model needs to be valid before you can test or publish it to your Workflow Server.

**To validate a project model**

1  In an open project in Workflow Designer, on the toolbar, click the Validate Project symbol.

   A detailed message appears identifying problem areas.

2  Alternately, hover over or double-click a component to initiate text explaining invalid parts.
Importing components into a project

In an open project in Workflow Designer, you can add components to the component toolbox. By default, each project type has its own set of available components in the component toolbox. If the component that you want to use is not available by default, you can import it.

See “About the component toolbox” on page 154.

Workflow Designer provides libraries of the components that you can import into your projects as you need them. You can import the standard libraries of components or the custom libraries that you create with component generators.

See “About the component generators” on page 240.

To import components into a project

1. In an open project in Workflow Designer, in the Toolbox pane, click Import Components.

2. In the Add Library To Project dialog box, select the libraries that you want to add to the component toolbox of your project:

   - Add available default component libraries
     In the left pane, click Local, in the right pane, select the libraries that you want to add to your project, and then, in the bottom pane, click Add.

   - Add recently used libraries
     In the left pane, click Recent, in the right pane, select the libraries that you want to add to your project, and then, in the bottom pane, click Add.

   - Add custom libraries
     In the bottom pane, click New Integration Library, and then, in the New Library dialog box, add a custom library.

   - Add the libraries that are not found in the default, recently used, or custom libraries
     In the bottom pane, click Browse, and then, in the Select Libraries dialog box, add a library.

3. Click OK.

The added components appear under branches with an orange star that displays in the component toolbox.

Importing a workflow model

You can share models between projects, from any Workflow Designer.
See “About project models” on page 222.

Importing external models has the following benefits:

- Helps promote reuse among projects
- Isolates a complex or a distinct process configuration to simplify the model

To import workflow models

1. In an open project in Workflow Designer, in the Project pane, right-click the name of the project at the top of the tree structure, and then, click Import Model.
2. Search for and select the model you want to import.
3. Click Open.

Installing a Monitoring project as a Windows service application

To install a monitoring project as a Windows service application

1. Move the publishing package to the server and either unpack the compressed file or run the installer, depending on the publishing method chosen. If the publishing method is installer, the executable installs as a Windows service.
2. If the publishing method is a compressed file or directory, run InstallUtil.exe MonitoringAgentService.exe in the bin directory of the publishing package. This action installs the .NET Windows service with the service manager.
3. Configure the Startup Type parameter in the Services Administration tool if you want the service to launch automatically.

See “About Monitoring Project Types” on page 152.

Packaging a project

Packaging a project lets you save all your package data and accompanying libraries in a single, distributable file. Packing a project also lets you share your project with others easily. To load a packaged project, import it in the Workflow Designer loading window.

See “About Workflow Designer Project Types” on page 147.
To package a project

1. In an open project in Workflow Designer, click the project name in the tree structure on the left.
   
   The project name is the top item in the tree structure.

2. Click File > Package Project.

3. In the Packaging Options dialog box, select from the following:
   - Include Custom Libraries
     Select to include all custom libraries with the project.
   - Exclude Core Libraries
     Select to exclude the libraries that are included with the Workflow Designer installation.
   - Exclude Libraries in Search Path
     Select to exclude all external libraries from the project.
   - Package as template
     Select to package the project as a template.

4. Click OK.

Testing a project

A project can be tested at any time during creation. You test a project by running it in the debugger. We recommend testing your project often to make sure that it works properly. You can test a project only when it is fully valid. A project is fully valid when there are no validation errors (component connection or configuration errors).

See “Validating a project model” on page 214.

While you test a project, if there are errors, an error report is shown in a dialog box. The error report displays a list of error messages. Each error message displays the cause, the error location, and the point where the component failed.
To test a project

1. In Workflow Designer, on the toolbar, click the **Run Project**.

2. In the **Debugging Form** dialog box, in the left pane, click **Execute** to run the project.

   During testing, the project generates execution data to use for debugging.

3. (Optional) In the **Set Input Values** dialog box, add the required data to continue testing.

   To successfully execute a project, any input data that is required must be provided, unless set to **Null Allowed**.

   If the project encounters any errors while it runs in the debugger, the debugger displays an exception. If the project is valid, it executes properly and displays the project's output.

   As the project functionality executes within the Model tab, the entire project is highlighted. The yellow highlighting indicates the project has executed the highlighted component or connection. If a project returned an error (an exception), the arrow stops at the component that caused the error.

---

**Running a load test**

Workflow Manager has a load-testing capability in the debugger. This option is a trivial load tester and should not replace a more advanced production environment load tester. Use the Workflow Manager load tester to ensure that your workflow project functions properly.

See “About project data” on page 181.

To run a load test

1. In Workflow Manager, open the workflow project that you want to test.

2. On the toolbar, click the **Run Project** symbol.

3. In the **Debugging Form** dialog box, in the left pane, right-click **Execute**, and then, click **Load Test**.

4. Type thread, execution, and pause variables, and then click **Start**.

5. Once the test is done, you can view the test results.

   To view the results again, click **Results**.
Reloading a project

Reloading your project closes your project workspace and re-opens it. Reloading a project is useful if your project is malfunctioning, or if you want to undo the changes that were made since opening your project. You are prompted to see if you want to save your project before you reload it.

Saving your project lets you reload your original work area from the last saved edition and start over.

See “Testing a project” on page 217.
See “Validating a project model” on page 214.

To reload a project

1. In Workflow Designer, in an open project, in the Project pane, at the top of the tree structure, right-click the name of the project, and then, click Reload Project.

2. In the confirmation dialog box, do one of the following:
   - Yes
     Click if you want to save the project before reloading it.
   - No
     Click if you do not want to save the project before reloading it.
   - Cancel
     Click to return to the project without reloading it.

Starting and stopping a Windows service Monitoring application

The monitoring Windows service runs like any other Windows service.

See “Installing a Monitoring project as a Windows service application” on page 216.
See “About Monitoring Project Types” on page 152.

To start a Windows service Monitoring project

1. Open Windows Services.
   - Click Start > Control Panel > System and Security > Administrative Tools > Services.

2. In the Services dialog box, in the right pane, right-click MonitoringAgentService, and then, click Start.

3. Click OK.
The application executes according to the run instructions that are in the agent.properties file.

To stop a Windows service Monitoring project

1. Open Windows Services.
   - Click Start > Control Panel > System and Security > Administrative Tools > Services.
2. In the Services dialog box, in the right pane, right-click MonitoringAgentService, and then, click Stop.
3. Click OK.

Monitoring stops safely, but it may take a few moments.

Starting and stopping a task tray Monitoring application

The monitoring Windows service runs like any other Windows service.

See “About Monitoring Project Types” on page 152.

See “Publishing a Monitoring-type project as a task tray application with an installer” on page 206.

To start the application

1. Locate MonitoringAgentTrayApp.exe.
   - Unless you changed the default location when you installed Symantec Workflow, MonitoringAgentTrayApp.exe is in C:\Program Files\Symantec\Workflow\Designer\bin.
2. Double-click MonitoringAgentTrayApp.exe.
3. In the notification area, right-click the new task tray icon, and then, click Start.

The application starts to execute according to the run instructions that are in the agent.properties file.

To stop the application

1. On the Workflow computer, in the notification area, right-click the monitoring agent.
2. On the monitoring agent menu, click Stop, or click Exit.

Monitoring stops safely, but it may take a few moments.
About workflow project models

This chapter includes the following topics:

- About project models
- Creating a project model
- Critical errors model
- Secondary models
- Parent and child models
- Where models exist
- Models and model components
- About Linked and Embedded model components
- Data contracts between models
- Adding input data to a secondary model
- Adding output data to a secondary model
- About the Linked Model Component
- About the Embedded Model component
- About other model components
- About the Dynamic Linked Model component
- About the template component model
About project models

Project models are containers of logic in a project. Project models exist in the project tree on the left in an open workflow project.

See “About Workflow Designer project trees” on page 157.

When you open a new project in Workflow Designer, two models are automatically created: the Primary model and the Critical Errors model. In an open project in Workflow Designer, these models appear in the project tree structure in the left pane.

You can add other models to your project. Models that you add to a project are called secondary models. Secondary models also appear as items in the project tree structure. Secondary models can work with other models or run independently (depending on their configuration). You can add an unlimited number of secondary models to a project.

You can validate and import models.

See “Validating a project model” on page 214.

See “Importing a workflow model” on page 215.

Use the Linked Model component to invoke a model from another model. If secondary models are linked to other models with the Linked Model component or the Dynamic Linked Model component, they are called linked models.

See “Creating a project model” on page 223.

See “Critical errors model” on page 223.

See “Secondary models” on page 224.

See “Parent and child models” on page 225.

See “Where models exist” on page 225.

See “Models and model components” on page 225.

See “About Linked and Embedded model components” on page 226.

See “Data contracts between models” on page 227.

See “Adding input data to a secondary model” on page 227.
Creating a project model

You can create models in an open project in Workflow Designer. A project’s models are displayed in the tree structure in the left pane of an open project. Created models are referred to as secondary models.

See “About project models” on page 222.

Your Primary Model may become congested, or it may have multiple components that perform similar functions. By creating new models, you can reduce the complexity of the primary model. You can also assign the specific tasks that can be accessed repeatedly from your Primary Model.

To create a project model

1. In Workflow Designer, open the workflow project in which you want to create a model.
   
   See “About Workflow Designer” on page 41.

2. In the Project pane, right-click the name of the project at the top of the tree structure.

3. Click New Model.

4. Name the model and select a parent model.

   Use a name that indicates the function and purpose of the model.

5. Click OK.

   After you click OK the model appears in the project tree structure.

Critical errors model

The critical errors model is a default model in all Workflow projects. When you first open a project, the critical errors model appears on the left in the project tree structure under the primary model. You can edit the critical errors model.

See “About project models” on page 222.

The critical errors model handles all of the unhandled exceptions for a project. All projects should be designed with error handling. However, if there is no error handling in a project, the critical errors model handles all of the errors.

All errors that the critical errors model handles are logged. The critical errors viewer lets you view all of the critical error logs.
Symantec recommends that you do not use the critical errors model as your primary means of error handling. Once the process has entered this model, it cannot return to the primary model. You should always design your projects with error handling in each model.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Begins the model.</td>
</tr>
<tr>
<td>Report Critical Error</td>
<td>Creates a log entry for the error.</td>
</tr>
<tr>
<td>Exception Component</td>
<td>Throws an exception and ends the process.</td>
</tr>
</tbody>
</table>

### Secondary models

Secondary models are any model you add to your project’s tree structure. Using secondary models provides the following benefits:

- **Break down larger processes into smaller, distinct sub-processes**
  When you break down larger processes, you help maintain organization and generally makes the main workflow more readable.
  For this benefit, the models are dependent on each other, and so need to communicate. When the project runs, it does not run the models from top to bottom in the tree structure as you might think. Rather, it runs the models when they are called in the process. A Linked Model or Dynamic Linked Model component does the calling.
  Also, when project models are dependent on each other, a data contract needs to be set up between them.

- **Create multiple independent models that are grouped together as one project**
  For this benefit, the models are independent of each other, and so do not need to communicate. The models are bundled together in one project, but do not rely on each other.
  Also, no data contract needs to be set up between the models.

Secondary models can be invoked independently of the project in which they were published, which is most useful when you have a number of smaller, related but independent processes. By creating these processes in secondary models in a single project, you can manage them more easily while designing and publishing. After publishing, you can invoke any of the secondary models through the same web service layer (as long as you do not set the models to be invoked).

See “About the Dynamic Linked Model component” on page 236.
Parent and child models

Before you work with linked or embedded models you should be familiar with the concepts of a "parent model" and "child model." A parent model is a model which calls upon a second model to do some work and the child model is the model that is called. Embedded models are always child models because they are always invoked in the course of another model. Secondary models are not necessarily child models because they can be set as individual invocation targets.

Where models exist

Linked Models do not exist in the same place that Embedded Models exist. When you use a Linked Model in a process, the model is in the project tree structure. When you use an Embedded Model in a process, the model is in the workspace. The model in the workspace can be confusing, because both kinds of models have an icon in the workspace. Embedded Models exist in their icons in the workspace, but Linked Model icons only point to the model that exists in the project tree structure.

An important distinction for understanding the difference between the two kinds of models: When you edit a Linked Model (by adding components, deleting components, or any other configuration change), you edit the model that exists in the project tree structure. Thus, when you edit a Linked Model, your changes are applied to every instance of the model throughout the process. When you edit an Embedded Model, you edit only a single instance of it. Thus, when you edit an Embedded Model, your changes are not applied to any other Model in the process.

Models and model components

Models should not be confused with model components. "Models" refers to the primary or the secondary models that are listed in a project’s tree structure. Models are not components. Models contain logic on the project level. They can work with other models or operate independently of them. Every project has at least one model - a primary model - and can have an unlimited number of secondary models.

"Model components" refers to components that either contain logic on the component level, or point to a project model. Embedded models contain logic on the component
Components with Embedded models include: Embedded Model component, Dialog Workflow (contains three embedded models), any component that can use a dynamic model (for example, Drop Down List and Add Items to Collection). Only two components point to a project model: the Linked Model component and the Dynamic Linked Model component.

See “About Linked and Embedded model components” on page 226.

**About Linked and Embedded model components**

The Linked Model and Embedded Model components are in some ways similar to other components: they have a representative icon, you can rename them, and they have input and output paths. Yet they function very differently from a typical component. The Linked and Embedded Model components contain other components rather than performing any function themselves. Think of the Linked and Embedded Model components as independent processes that run within the context of another process.

See “About the Linked Model Component” on page 228.
See “About the Embedded Model component” on page 233.

Using Models provides the following benefits:

- Breaks down the larger processes into smaller, distinct sub-processes that are contained in linked models.
  Breaking down larger processes helps maintain organization and generally makes the main workflow more "readable."

- Re-uses a Linked or Embedded Model that is repeated throughout a process. After you have configured a Linked Model, you can drag it into your process as many times as you like. This increases efficiency because repetitive portions of the process can be reused. Reusing Linked Models also aids in maintenance. If changes are required to this part of the process, they need to be made only once and are automatically conveyed throughout the rest of the process.
  This function explains the name “Linked Model.” A given Linked Model is “linked” to all instances of itself in a project, so that the changes that are made to one model occur in all instances of that model.
  You can also reuse an Embedded Model. Because Embedded Models contain their own model, you can reuse them by copying and pasting.

- Caching
  After a Linked or Embedded model has run, it can cache its data. If the model appears again in the process, the cached data is immediately available so the model does not have to run again.
Data contracts between models

Secondary models do not automatically share data with other models. Every project model is a separate process with the variables that exist only within itself. Project models do not automatically understand how to relate to one another unless you set up a data contract between them. A data contract is a declaration of what variables a model needs as input data, and what variables it returns as output data. This contract is configured in the input and the output data properties of a model. Locate these properties under the model name in the project tree on the left.

See “About project models” on page 222.

Adding input data to a secondary model

Any data you add to the input data of a model, is available to the model. All data that needs to come into a model must be added to the input data of a model.

For example, if a model needs to compare two variables that are created in another model, the variables must be added to input data.

If you add data to a secondary input data of a model, remember that the data still needs to be mapped through a Linked Model or Dynamic Linked Model component.

See “Mapping input data in a Linked Model component” on page 229.

Each input variable needs to be of the same type as the variable to which it is mapped.

To add input data to a secondary model

1. In an open project in Workflow Designer, under a secondary model click **Input Data**.

   If you do not see **Input Data**, expand the items under the **Linked Model**.

2. In the right pane, click **Add**.

3. Add and configure as many variables as the secondary model needs.

   You can name input variables however you want to, but the best practice is to use the variable names from the process. For example, if the secondary model uses a process variable that is called `Value1`, create a variable in input data that is called `Value1`. 
Adding output data to a secondary model

If a linked model needs to pass data back to the parent model, it must be configured with output data. All data that needs to come out of the model must be added to output data.

For example, if the linked model compares two variables and renders an outcome for use outside of the model, that data should be passed out as output data.

Output data is not always necessary. For example, if the secondary model writes data to a database instead of handing it back to the process, output data is unnecessary.

Output data is configured similarly to input data. Configure one variable for each piece of data that the secondary model passes out. Each output variable needs to be of the same type as the variable to which it maps.

See “Mapping output data from a Linked Model component” on page 231.

To add output data to a secondary model

1. In Workflow Designer, in an open project, in the Project pane, under a secondary model in the tree structure, click Output Data.
   - If you do not see Output Data, expand the items under the model name.
2. In the right pane, click Add.
3. Add and configure as many variables as need to be passed out.

About the Linked Model Component

The Linked Model component points to a model in the project tree structure. The component can also be called the “Link Models” component, because it links two project models together. Think of the Linked Model component as a trigger that causes a secondary model to run within the context of another model. It serves as a command that is inserted into the middle of the process flow. When the process flow hits the Linked Model, it says, “Run model X”. When that model has run, the process flow resumes after the Linked Model component. You can use Linked Model in your primary model or even other linked models.

Using Linked Models provides the following benefits:

- Breaks down the larger processes into smaller, distinct sub-processes that are contained in the secondary models that are linked with Linked Model components.
  When you break down larger processes into smaller, you can maintain organization and generally makes the main workflow more readable.
Re-uses a secondary model throughout a process.

After you have configured a secondary model, you can invoke it in your process as many times as you want. This increases efficiency by letting you re-use repetitive sections of logic. Reusing secondary models also makes process changes easier. If you need to change a secondary model, you have to change it only once, even if it is used multiple times throughout the process.

This function explains the name “Linked Model”. A given Linked Model is “linked” to all instances of itself in a project, because all instances point to the same secondary model.

Caching

After a Linked Model component has run, it can cache its data. If the model appears again in the process, the cached data is immediately available so the model doesn’t have to run again.

You can add a Linked Model component by dragging the component from the toolbox, or by dragging a project model from the project tree structure. If you drag it from the toolbox, the component needs to be configured to a project model. If you drag a project model onto the workspace, a Linked Model component appears automatically.

Because Linked Models point to secondary models, at least one secondary model must exist for a Linked Model component to work.

See “Creating a project model” on page 223.

The concepts of a “parent model” and “child model” are very important when you work with Linked Models.

See “Parent and child models” on page 225.

See “Secondary models” on page 224.

Mapping input data in a Linked Model component

Before you can use a process variable in your Linked Model, you must map the value of the process variable into its corresponding input data variable. You must create input variables before you can map any variables.
To map input data in a Linked Model component

1. In an open project in Workflow Designer, right-click a Linked Model component, and then click Edit Component.

2. In the Editor dialog box, on the Configuration tab, under Mapping, to the right of Start Mapping, to the right of each variable that you want to map, click the … symbol.

   **Note:** Start Mapping refers to input variables; Return Mapping refers to output variables.

All the variables that you have added to the input data of a model, appear in the component editor of the Linked Model. If you do not see a variable that you want to map, add that variable to the input data of the model.

See “Adding input data to a secondary model” on page 227.

3. In the Select Output dialog box, do one of the following:

   - Use a default value for a variable. Click Use DefaultValue. This option is active only if you set a default value on an input variable.
   - Use a null value for a variable. Click Null Value. This option is active only if you set an input variable to allow a null value.
   - Pick a variable to map into the variable. Click Value From Data, and then click the … symbol. In the Select Variable dialog box, click the variable, and then click OK.
   - Assign a constant value to the variable. Click Create Value. Under Data, in the Value box, type a value.

4. When you are finished, click OK.

   The variable names on the left side represent the variables that are created in the Linked Model input data. The matching variable names on the right side represent the process variables whose values are to be acted on in the Linked Model.

5. In the Editor dialog box, click OK.
Mapping output data from a Linked Model component

Before you can use a variable from a linked model in a process, you must map the variable into its corresponding process variable. Mapping output data is similar to mapping input data, except that it has to be done in two places.

See “Mapping input data in a Linked Model component” on page 229.

This mapping is done in the following places in the Linked Model:

- Linked Model component editor
- End components inside the Linked Model

To map output data from a Linked Model component

1. In an open project in Workflow Designer, right-click a Linked Model component, and then, click Edit Component.

2. In the Editor dialog box, on the Configuration tab, under Mapping, to the right of Return Mapping, to the right of each variable that you want to map, click the ... symbol.

   **Note:** Start Mapping refers to input variables; Return Mapping refers to output variables.

All the variables that you have added to the output data of the model, appear in the component editor of the Linked Model. If you do not see a variable that you want to map, add that variable to the output data of the model.

See “Adding input data to a secondary model” on page 227.

3. In the Select Output dialog box, do one of the following:

   - Use a default value for a variable. Click Use Default Value.
     This option is active only if you set a default value on an output variable.

   - Use a null value for a variable. Click Null Value.
     This option is active only if you set an output variable to allow a null value.

   - Pick a variable to map into the variable. Click Value From Data, and then click the ... symbol.
     ■ In the Select Variable dialog box, click the variable, and then click OK.
Assign a constant value to the variable.  

- Click **Create Value**.
- Under **Data**, in the **Value** box, type a value.

4 When you are finished, click **OK**.

The variable names on the left side represent the variables that are created in the Linked Model output data. The matching variable names on the right side represent the process variables whose values are to be passed out from the Linked Model.

5 In the **Editor** dialog box, click **OK**.

To map data from the Linked Model’s End component

1 Double-click the **Linked Model** component.

2 Double-click the **End** component inside the model.

3 In the **End Editor** dialog box, on the **Configuration** tab, to the right of **Mapping**, to the right of each variable that you want to map, click the … symbol.

4 In the **Select Output** dialog box, do one of the following:

- **Use a default value for a variable.**
  
  Click **Use Default Value**.
  
  This option is active only if you set a default value on an output variable.

- **Use a null value for a variable.**
  
  Click **Null Value**.
  
  This option is active only if you set an output variable to allow a null value.

- **Pick a variable to map into the variable.**
  
  Click **Value From Data**, and then click the … symbol.
  
  In the **Select Variable** dialog box, click the variable, and then click **OK**.

- **Assign a constant value to the variable.**
  
  Click **Create Value**.
  
  Under **Data**, in the **Value** box, type a value.

5 When you are finished, click **OK**.

6 In the **Editor** dialog box, click **OK**.
Linked Model set up

To set up a Linked Model

1. Create a model in the project tree structure.
   See “Creating a project model” on page 223.

2. Configure the input and the output data of the Linked Model.
   See “Adding input data to a secondary model” on page 227.
   See “Adding output data to a secondary model” on page 228.
   See “Mapping input data in a Linked Model component” on page 229.
   See “Mapping output data from a Linked Model component” on page 231.

About the Embedded Model component

This component contains its own model. Think of the Embedded Model component as an isolated chunk of business logic that has a data contract with its parent model. You can use embedded models in your primary model, or even other embedded models. Using Embedded Models lets you break down larger processes into smaller, distinct subprocesses. Breaking down larger processes helps maintain organization and makes the main workflow more readable.

You can drag and drop an Embedded Model component from the component toolbox and use it immediately in your process.

The concepts of a "parent model" and "child model" are very important when you work with Linked Models.

See “Parent and child models” on page 225.

Configuring output data

No input data needs to be added to Embedded Models because they can see all process data. However, Embedded Models do not automatically make their data available back to their parent models. Any data from the Embedded Model that the parent model needs to use must be configured as output data.

Two phases are used in configuring the Embedded Model:

1. Add output data.
   See “Adding output data to an Embedded Model component” on page 234.

2. Map output data.
   See “Mapping output data in an Embedded Model End component” on page 235.
Adding output data to an Embedded Model component

If an Embedded Model needs to pass data back to the parent model, it must be configured with output data. All data that needs to come out of an Embedded Model must be added to output data.

In some scenarios output data is not necessary. For example, if the child model writes data to a database instead of handing it back to the process, there is no need to use output data.

To determine what variables to add to output data, consider this question: “What variables exist inside this Embedded Model that the parent model needs to know about to accomplish its work?” For example, if the Embedded Model compares two variables and renders an outcome to be used in the parent model, that parent model must have access to the outcome data. After you have answered this question, you are ready to add data to the Embedded Model.

To add output data to an Embedded Model component

1. In the parent model of your process, right-click the Embedded Model component, and then click Edit Component.
2. Next to the Output Data field, click the ... symbol.
3. In the Edit Parameters dialog box, click Add.

Create one or more variables to match variables in the Embedded Model. If you have not yet created the process inside the Embedded Model, you may not know what variables you need to output. In this case, make the process first, then return to this step at the end.

See “About the Embedded Model process” on page 235.

4. Configure each variable to match its corresponding variable.

Each variable being created as output data is a piece of data that must be passed back to the parent model. For example, if your Embedded Model contains a logical (true or false) data element named CorrectAnswer that the parent model needs to see, create an output variable of the same name.

5. Click OK.

Embedded Model set up

When you use the Embedded model component there are two phases of setup:

1. Configure the Embedded Model component's output variables.

See “Configuring output data” on page 233.

2. Create the Embedded Model process.
Mapping output data in an Embedded Model End component

Data mapping refers to a transfer of value, where one variable is pointed at another variable which takes the value of the first. For example, if a variable called Variable1 with a value of “person” is mapped into a variable called Variable2, “person” becomes the value of Variable2.

You need to map data in the End component(s) of the Embedded Model only if you have configured output data. If the Embedded Model does not need to output any of its data, you do not need to configure its End components.

After you have added output data to the Embedded Model, the End components inside the model gain a data mapping capability. Any output data from the Embedded Model must be mapped to existing model variables.

To map data in the Embedded Model End component

1. Double-click the Embedded Model component.
2. Double-click the End component.
3. In the End Editor dialog box, click Value From Data, and then click the ... symbol.
4. Locate and select the variable from which you want to map data, and then click OK.

About the Embedded Model process

An embedded model can make use of nearly all components available within Workflow Designer, but there are a few notable exceptions. Linked Models, Form Builders, and Workflow components (for example, Dialog Workflow) cannot be used in embedded models. Keep in mind these limitations as you build the model.

Build the Embedded Model exactly as you do the primary model. Embedded Models require no special component configuration. One exception is the End components. If you want to make data from the Embedded Model available to the outside process, you must map that data out of the End component.

In some scenarios (such as an Embedded Model that performs a true decision or a false decision), using two End components is preferable.
About other model components

The Linked and Embedded Model components each have a derived component that has a slight variation in function.

The following are two derived model components:

- **Dynamic Linked Model**
  
  See “About the Dynamic Linked Model component” on page 236.

- **Embedded Rule Model**
  
  See “About the Embedded Rule Model component” on page 237.

About the Dynamic Linked Model component

The Dynamic Linked Model component takes the concept of linked models one step further than basic Linked Model components. The basic Linked Model component represents only one secondary model (the model in the project tree structure to which it corresponds). However, the Dynamic Linked Model can represent any secondary model in the project tree structure. It uses a process variable to dynamically select which secondary model it represents, rather than a constant setting. Thus, the Dynamic Linked Model can choose a secondary model programmatically, adding a great deal of flexibility to your process design.

The majority of the process for setting up the Dynamic Linked Model component is identical to the process of the basic Linked Model component. However, the Dynamic Linked Model component has two properties that the basic Linked Model component does not have: Template Component Model Name and Component Model Variable Name.

See “About the template component model” on page 236.

See “About the component model variable name” on page 237.

About the template component model

Here we see the Dynamic Linked Model's two unique properties in the top of the editor: Template Component Model Name and Component Model Variable Name. The first of these, Template Component Model Name, refers to a “template” model from which the Dynamic Linked Model borrows data mapping definitions. A Dynamic Linked Model must use a template model because it can map only one set of Start and Return Mapping variables.

This concept is the most difficult concept in the Dynamic Linked Model component. The Dynamic Linked Model requires a template model for data mapping because data mapping cannot be defined dynamically. Dynamic Linked Models do not support
different mapping configurations for different secondary models. During design-time, a Dynamic Linked Model does not know which secondary model it represents; thus, it also does not know what input and output data it should have, or how those values should be mapped.

See “About the Dynamic Linked Model component” on page 236.

About the component model variable name

The second property unique to the Dynamic Linked Model component, Component Model Variable Name, tells the component which secondary model it represents. Whatever model name is passed to this variable must correspond exactly to one of the model names that is listed in the project model tree.

Once you provide a text variable in the Component Model Variable Name field, you can set the value of this variable programmatically. Thus, you can make the secondary model selection dynamically.

See “About the Dynamic Linked Model component” on page 236.

About the Embedded Rule Model component

The Embedded Rule Model component takes the concept of embedded models one step further than basic Embedded Model components. This component operates exactly like an Embedded Model component, but with one additional feature: multiple outcome paths. This component is designed to be a custom rule component that functions according to the components and outcome paths that you add. You can add any components to an Embedded Rule Model that you can to a basic Embedded Model. You are not restricted to only rule components. You can also add as many outcome paths as you want.

You can use Embedded Rule Models in your primary model or any sub-models. Using Embedded Rule Models, you can break down larger processes into smaller, distinct sub-processes. Breaking down larger processes helps maintain organization and generally makes the main workflow more “readable.”

See “Models and model components” on page 225.

When you use the Embedded Rule Model component there are two distinct phases to the setup:

- Build the Embedded Rule Model process.
  See “About the Embedded Rule Model process” on page 238.
- Configure the End component(s) of the secondary model.
  See “About the End Components of the Embedded Rule Model” on page 238.
About the Embedded Rule Model process

An Embedded Rule Model can make use of nearly all components available within Workflow Designer, but there are a few notable exceptions. Linked Models, Form Builders, and Workflow components (for example, Dialog Workflow) cannot be used in Embedded Rule Models.

Build the Embedded Model exactly as you do the primary model. Embedded Models require no special component configuration. One exception is the End component. Each End component must be configured to represent an outcome path. If you do not need more than one outcome path, use a regular Embedded Model component rather than an Embedded Rule Model component.

See “About the Embedded Rule Model component” on page 237.

About the End Components of the Embedded Rule Model

The End components in an Embedded Rule Model give the component its multiple paths. Each End component contains a property called “Resulting Path.” This value is the outcome path to which an individual End component points. For example, if an End component has a Resulting Path of “Send to Manager,” that End component points to an outcome path called “Send to Manager.” When an End component is added to the Embedded Rule Model process, a matching output path is automatically generated.

See “About the Embedded Rule Model component” on page 237.
Working with the component generators

This chapter includes the following topics:

- About the component generators
- Creating a new integration project
- Creating an automation library
- Exporting and importing configurable items of an automation library service using Process Manager
- Adding custom data type to an existing automation library
- Generating components
- Symantec workflow component generators
- Adding an assembly to a generator
- About the filter generator
- About the query script generator
- About the stored procedure caller generator
- About the Multiple generator container
- About the table generator
- About the fast table generator
- About the DTD generator
- About the XML Schema generator
About the component generators

Workflow Designer provides the component generators that let you create your own component libraries. Component generators let you create customized components with specific functionality. You can use custom components like you use any standard components.

You can access the component generators in two locations in Workflow Designer. You can create a new Integration-type project, or you can click Create Integration Library in an open project under the component toolbox.

See “About Integration Project Types” on page 152.
See “About the component toolbox” on page 154.

Almost all of the generators create the components that you can use in your projects. However, some generators do not create components. For example, the User Defined Type generator creates data types.

See “About the User Defined Type generator” on page 303.

You can use the component generators to create the custom components that interact with various systems and files, including the following:

- Database Tables
- Database Stored Procedures
- CSV Files
- Fixed Length Values
- Microsoft InfoPath
- Microsoft Excel

You can also create custom (user-defined) data types.

After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them.

See “Importing components into a project” on page 215.

You can also share custom components with others in your organization.

Component generators use a wizard to guide you through the component creation process.

See “About the component generators” on page 240.

See “Generating components” on page 259.

See “Symantec workflow component generators” on page 261.

See “About Workflow Designer Project Types” on page 147.

The component generators are as follows:

Filter Generator

Creates reports by drawing data from different tables.

See “About the filter generator” on page 263.
Query/Script Generator  Generates the components that submit and process user-specified SQL against a user-specified database. Lets you query a variety of database providers and drivers such as SQL, Oracle, ODBC, and OLEDB. The components that you create with this generator can be fully customized.
See “About the query script generator” on page 265.

Stored Procedure Caller Generator  Generates the components that run a user-specified stored procedure against a user-specified database.
See “About the stored procedure caller generator” on page 269.

Table Generator  Generates the table-related components from a user-specified table in a user-specified database. Components that are created with this generator can perform operations on the tables in a database. These components can add tables, record to a table, rename a table, read information from a table, or add fields to a table.
See “About the table generator” on page 274.

Fast Table Generator  Identical to table generator, except with fewer options. All component types are automatically generated instead of being user-defined.
See “About the fast table generator” on page 278.

DTD Generator  Generates read and write components based on a user-specified document type definition file (.DTD). DTD is used in the creation of XML files.
See “About the DTD generator” on page 278.

XML Schema Generator  Generates read and write components based on a user-specified XML Schema Definition file (.XSD).
See “About the XML Schema generator” on page 280.

Excel Generator  Generates read and write components based on a user-specified Excel spreadsheet file (.xls).
See “About the Excel generator” on page 280.

InfoPath Generator  Generates read and write components based on a user-specified Office InfoPath file (.XSN).
Generates read and write components to let you add, remove, or modify entities in your Active Directory server. These components support Active Directory schema customization and let you use Active Directory information in your workflow projects.

See “About the Active Directory generator” on page 283.

Generates the components to add and remove items in a SharePoint task list. These components also handle document exchanges to and from the document repository in SharePoint. This generator inspects the SharePoint list to discover all of the available columns and transposes them into properties in a component.

See “About the SharePoint Lists generator” on page 284.

 Generates a read and write component and a customized data type (used for inputs and outputs) to handle fixed-length pieces of information. Fixed-length information can be user data (such as names, SS numbers, and email addresses), impersonal data such as dates, or other static format data. The Fixed length type generator wizard guides you through the process of creating a data type that is specific to your data.

See “About the Fixed Length generator” on page 287.

Generates read and write components and data types against a fixed position file. This generator is similar to the separated values generator without the delimiter.

See “About the Fixed Length generator (extended)” on page 289.

Generates read and write components based on a user-specified comma-separated file (.csv).

See “About the Separated Values generator” on page 291.

Generates read and write components based on user-specified comma-separated values (.csv).

See “About the Separated Values generator (extended)” on page 294.
<table>
<thead>
<tr>
<th>Generator</th>
<th>Description</th>
<th>See “About the…” on page</th>
</tr>
</thead>
<tbody>
<tr>
<td>LDAP Generator</td>
<td>Generates the components that interact with the directory entries in an LDAP server. This generator inspects the LDAP schema and creates components and data types to interact with the structures in your LDAP environment.</td>
<td>294</td>
</tr>
<tr>
<td>Web Service Caller Generator</td>
<td>Generates the components that make calls to user-specified Web services. You can select the specific methods that are available in the Web Service Description Language (WSDL) and use them within workflows. The components that you create with this generator can communicate with, post requests to, and read responses from dynamic Web services.</td>
<td>294</td>
</tr>
<tr>
<td>User Defined Type with DB Mapping</td>
<td>Generates the user-defined types with the database mapping that you can use in your project. This generator does not create components like most of the component generators; it creates data types. Database mapping refers to a special feature of Workflow Designer. Data in an ORM data type communicates with corresponding data in a database. The data in the data type is mapped to the data in the database so that the two sets of data have the same value. This mapping is accomplished through exchanges in SymQ.</td>
<td>298</td>
</tr>
<tr>
<td>User-Defined Type</td>
<td>Generates the user-defined types that you can use in your project. Does not create components, but exposes user-defined types and structures when you add or import the integration library into your workflow.</td>
<td>303</td>
</tr>
<tr>
<td>Component Generator</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Custom Workflow Interaction</td>
<td>Generates the components that are similar to the <strong>Dialog Workflow</strong> component except without a dialog model. Custom workflow components create a task and a standard Web page for users to complete the task. You define the input data, output data, and output paths. Although this generator lets you quickly create a task and an interface, Symantec recommends that you use the Dialog Workflow component instead. Use the Custom Workflow interaction generator when you have a separate, custom-built user interface. See “About the Custom Workflow Interaction generator” on page 306.</td>
<td></td>
</tr>
<tr>
<td>WCF Service Caller Generator</td>
<td>The WCF Service Caller generator lets you create the components that make calls to WCF services.</td>
<td></td>
</tr>
<tr>
<td>ASDK component generator</td>
<td>The ASDK generator runs after it is installed. This generator creates components out of ASDK method calls. ASDK methods change less frequently than task and resources change. However, when you make a change to an ASDK method in a component, the component must regenerate. See “About the ASDK Component generator” on page 308.</td>
<td></td>
</tr>
<tr>
<td>ASDK Tasks component generator</td>
<td>The Task generator runs after it is installed. This generator gathers ASDK tasks on the Symantec Management Console. A task is an action that is taken on a resource or a collection of resources. Tasks are managed in the Symantec Management Console, and any component that is generated must be regenerated to reflect changes from the Symantec Management Console. See “About the ASDK Tasks Component generator” on page 308.</td>
<td></td>
</tr>
<tr>
<td>Component Generator</td>
<td>Description</td>
<td>See “About the ...” on page</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Reports component generator</td>
<td>The Report generator runs after it is installed. This generator gathers all of the reports that are available in the Symantec Management Console. For every report that is available, one component is created. Each report component represents a SQL query that retrieves and stores structured data back in a collection within a workflow.</td>
<td>308</td>
</tr>
<tr>
<td>Resource component generator</td>
<td>The Resource generator runs during installation. This generator gathers all of the resources that are available on the Symantec Management Console. A resource is usually a tangible item such as a computer, telephone, or printer. A resource has data and associations to other resources on the Symantec Management Console. Resources are managed in the Symantec Management Console. Any components that are generated must be regenerated to reflect changes from the Symantec Management Platform.</td>
<td>308</td>
</tr>
<tr>
<td>.NET Library Generator</td>
<td>Generates the components that execute .NET code in a DLL. After you select a DLL and a class or method that you want to use, this generator creates a custom component. This component can invoke and leverage code in the selected DLL. With the components that are created with this generator, you can invoke the properties and methods of other components.</td>
<td>309</td>
</tr>
<tr>
<td>Multiple Generator Container</td>
<td>Does not generate components. Lets you group your generators and assemblies into one .DLL library file. By using a multiple generator container, you can import numerous generators and assemblies into your project with only one container file.</td>
<td>273</td>
</tr>
<tr>
<td>Remedy Connector</td>
<td>Generates the components that run interactions against a Remedy server.</td>
<td></td>
</tr>
</tbody>
</table>
Script Generator

Generates the components that run user-specified C# code or script.

See “About the Script generator” on page 309.

Creating a new integration project

Workflow provides multiple integration points.

See “About the component generators” on page 240.

Use Symantec component generators to create the components that integrate with database tables, other web services, XML files, Excel, and other file types. You can also create custom workflow components and create compatible libraries from other .NET libraries.

Every new project that is created in Workflow Designer already includes the libraries for Resource, ASDK, and Task component generators as a default.

To create a new integration project

1. In Workflow Manager, at the top of the page, on the toolbar, click File > New Project.
2. In the New Project dialog box, on the Project Types tab, click Integration.
3. In the Name box, type the name of your project.
4. (Optional) If you do not want to save your project to the default location, to select a new location, to the right of the Directory box, click Browse.

   Note: If you selected a folder in the left pane and used the New option at the top of the right pane, your New Project dialog box does not contain the Directory box. If you want to use a different location than the one you originally selected, you must click Cancel and start again.

5. Click OK.
6. In the Create Generator dialog box, in the Generator types field, select the required Generator.
7. In the Name box, type a name for your generator, and then click OK.
   You can use the actual name of the generator that you select or create a new name.
8. Use the generator wizard to configure the generator.
9. In the Generators Management dialog box, click OK.
Creating an automation library

A set of rulesets is known as the automation library. The automation library includes the components that allow comprehensive and complete automation of processes.

Creating and using a new automation library involves the following tasks:

■ Creating an automation library in Workflow Manager
■ Using the newly-created automation library in Process Manager portal

Creating an automation library in Workflow Manager

You can create a new automation library for the existing Incident Management, Change Management, Problem Management services, or create a new service.

To create an automation library using Workflow Manager

1. Create an Integration Library with User Defined Type with DB Mapping (ORM) generator type, by executing the following steps:
   ■ On the computer, click Start > All Programs > Symantec > Workflow Designer > Workflow Manager.
   ■ In the Workflow Manager application, click File > New Project.
   ■ In the New Project window, under the Project Types tab, click Integration.
   ■ Specify the project name, browse and select the workflow directory, and then click OK.
   ■ In the Create Generator dialog box, select the User Defined Type with DB Mapping (ORM) from the Authoring generator type, and then click OK.

2. Add process data class to the newly-created generator, by executing the following steps:
   ■ In the Type Designer window for the newly-created generator, click Add > Add process data class.
   ■ In the Add Type dialog box, specify the name, and then click Add.
   ■ In the Type Designer window for the newly-created generator, click Add Property.
   ■ In the Add Property dialog box, specify the following preferences, and then click Add:
User interface element | Description
--- | ---
**Name** field | Specify the name for the property.
**Type** list | The data type of the property. If you want to use a data type that is not available in the list, you can import it in an assembly. See “Adding an assembly to a generator” on page 262.
**One or Many** options | Specifies whether the property is a single value or an array. Select the **One** option or the **Many** option.
**Override field name** check box | Specifies whether the name of the property overwrites the name of the column with the name of this property. This property applies only if the target column already exists and has a name that is different from the name of the property.
To enable this property, select the check box and then enter a name in the adjoining field.
**Override Type Converter** check box | Specifies whether the generator uses a type converter other than the default. By default the generator uses the `GenericRelationalMappingFieldConverter`.
To enable this property, select the check box and then select a new type converter that is available from the adjoining list.
**Override SQL Data Type** check box | Specifies whether the property uses a SQL data type other than the default. The default SQL data type appears in the `SQLDateTypeReadOnly` property.
To enable this property, select the check box and then enter a new SQL data type for this property to use.
**Indexed** check box | Creates a database index on the field. This option improves the query performance when you query by the field if your table contains a large amount of data.

3. After you have entered the required properties, click **Next**.
4. On the **Indexes** page, specify the type, and click **Add** to add indexes to the properties that you created in the **Type Designer** page. Click **Next**.
5. On the **Settings** page, specify the namespace to identify the generated component library, and then click **Next**.
6. On the **Components** page, select the data types for which you want to create components, and then click **Finish**.

A new integration library with a DB Mapping (ORM) generator type is created.
7. On the Generators Management page, click Add.
8. In the Create Generator dialog box, select the Automation Library Generator from the Enterprise Resources generator type, specify the name, and then click OK.
9. In the Automation Library Generator wizard, specify the following options:
   - In the Automation Library Generator dialog box, read the instructions, and then click Next.
   - In the Choose Service ID dialog box, select the Specify Service ID option, specify the required entries, and then click Next.
   - In the Select Process Data (ORM) Types dialog box, select the newly-created ORM process data type, and then click Finish.
10. In the Integration Library dialog box, click Compile and Close. A new automation library is created.

Using the newly-created automation library in Process Manager portal
After you create an automation library, you can import the newly-created automation library, and use the service type and data types from the Process Manager portal.

To use the newly-created automation library in the Process Manager portal
1. Log on to the Process Manager portal with an administrator account, preferably native admin account. For example, admin@symantec.com.
2. Click Admin > Portal > Plugin Upload.
3. In the page that is displayed, execute the following steps:
   - Select Plugin Type as Automation Library.
   - In the Upload Plugin field, browse and select the .dll file of the newly-created automation library from the following path: C:\Program Files\Symantec\Workflow\Shared\customlib
   - Click Upload.
4. Restart Internet Information Services (IIS) to reflect the changes in the process automation by executing the following steps:
   - Open the command prompt file, and type iisreset.
   - Verify that the Internet services are successfully restarted message is displayed in the command prompt.
5. Refresh the Process Manager portal and then click Admin > Process Automation.

The newly-added service is displayed in the Available Services list. You can then add rulesets, rules, conditions, email templates, and reports for the newly-created service.

Exporting and importing configurable items of an automation library service using Process Manager

You can use Process Manager to export and import the following configurable items of an automation library service:

- Rulesets
- SLA Levels
- Email Templates
- Data Mapping

Exporting a ruleset

In the Process Manager portal, you can export a ruleset in the form of an XML file.

---

**Note:** If the ruleset uses any other item such as Email Templates, Escalations, Milestones, Business Hours, SLA levels, or Data Mappings in the rule, then these additional items are also exported along with the ruleset.

---

To export a ruleset in the Process Manager portal:

1. Click Admin > Process Automation.
2. From the Available Services section, expand your automation library and then click Service Dashboard.
3. From the Service Dashboard section, click the Actions button (orange lightning) on the right side of the ruleset that you want to export and click Export Ruleset.
4. Save the ruleset XML file.

Importing a ruleset

In the Process Manager portal, you can import a ruleset in the form of an XML file from a local directory. While importing a ruleset, the XML file is validated to check
if the ruleset has the same name as an existing ruleset. If you get the `Rule set Name is already in use. Please change the Rule set name in xml and try importing again` error, then modify the XML file and try importing again.

Note: If the XML file that you want to import has a ruleset that uses other items such as Email Templates, Escalations, Milestones, Business Hours, SLA Levels, or Data Mappings, then these additional items will also get imported along with the ruleset. If any of the additional items has the same name as an existing item, then the existing item will not be overwritten.

To import a ruleset in the Process Manager portal:

1. Click `Admin > Process Automation`.
2. From the `Available Services` section, expand your automation library and then click `Service Dashboard`.
3. From the `Service Dashboard` section, click `Import Ruleset`.
4. In the `Import Ruleset` dialog box, click `Browse` and select the ruleset XML file that you want to import, and then click `Import`.

The imported ruleset should appear in the `Service Dashboard` section.

Exporting an SLA Level

In the Process Manager portal, you can export an SLA Level in the form of an XML file.

Note: The Escalations, Milestones, and Business Hours that are used in the SLA Level are also exported along with the SLA Level.

To export an SLA Level in the Process Manager portal:

1. Click `Admin > Process Automation`.
2. From the `Available Services` section, expand your automation library and then click `Service Dashboard`.
3. From the `Actions` section, click `Manage SLA Levels`.
4. From the `SLA Levels` section, click the `Actions` button (orange lightning) on the right side of the SLA Level that you want to export and click `Export SLA Level`.
5. Save the SLA Level XML file.
Importing an SLA Level

In the Process Manager portal, you can import an SLA Level in the form of an XML file from a local directory. While importing an SLA Level, the XML file is validated to check if the SLA Level has the same name as an existing SLA Level. If you get the error, then modify the XML file and try importing again.

Note: If the XML file that you want to import has an SLA Level that uses other items such as Escalations, Milestones, Business Hours, or Data Mappings, then these additional items will also get imported along with the SLA Level. If any of the additional items has the same name as an existing item, then the existing item will not be overwritten.

To import an SLA Level in the Process Manager portal:

1. Click Admin > Process Automation.
2. From the Available Services section, expand your automation library and then click Service Dashboard.
3. From the Actions section, click Manage SLA Levels.
4. From the SLA Levels section, click the Import SLA Level button.
5. In the Import SLA Level dialog box, click Browse and then select the SLA Level XML file that you want to import, and then click Import.

The imported SLA Level should appear in the SLA Levels section.

Exporting an Email Template

In the Process Manager portal, you can export an Email Template in the form of an XML file.

To export an Email Template in the Process Manager portal:

1. Click Admin > Process Automation.
2. From the Available Services section, expand your automation library and then click Service Dashboard.
3. From the Actions section, click Manage Email Templates.
4. From the Email Templates section, click the Actions button (orange lightning) on the right side of the Email Template that you want to export and click Export Email Template.
5. Save the Email Template XML file.
Importing an Email Template

In the Process Manager portal, you can import an Email Template in the form of an XML file from a local directory. While importing an Email Template, the XML file is validated to check if the Email Template has the same name as an existing Email Template. If you get the error Email Template Name is already in use. Please change the Email Template name in xml and try importing again, then modify the XML file and try importing again.

To import an Email Template in the Process Manager portal:

1. Click Admin > Process Automation.
2. From the Available Services section, expand your automation library and then click Service Dashboard.
3. From the Actions section, click Manage Email Templates.
4. From the Email Templates section, click the Import Email Template button.
5. In the Import Email Template dialog box, click Browse and then select the Email Template XML file that you want to import, and then click Import.

The imported Email Template should appear in the Email Templates section.

Exporting a Data Mapping

In the Process Manager portal, you can export a Data Mapping in the form of an XLSX file.

To export a Data Mapping in the Process Manager portal:

1. Click Admin > Process Automation.
2. From the Available Services section, expand your automation library and then click Service Dashboard.
3. From the Actions section, click Manage Data Mapping.
4. From the Data Mapping section, select the required item and then click the Export Data Mapping button on the right side of Name menu bar.
5. Save the Data Mapping XLSX file.

Importing a Data Mapping

In the Process Manager portal, you can import a Data Mapping in the form of an XLSX file from a local directory.
To import a Data Mapping in the Process Manager portal:

1. Click **Admin > Process Automation**.
2. From the **Available Services** section, expand your automation library and then click **Service Dashboard**.
3. From the **Actions** section, click **Manage Data Mapping**.
4. From the **Data Mapping** section, click the **Import Data Mapping** button on the right side of **Name** menu bar.
5. In the **Import Data Mapping** dialog box, click **Browse** and then select the Data Mapping XLSX file that you want to import, and then click **Import**.

The imported Data Mapping should appear in the **Data Mapping** section.

---

**Adding custom data type to an existing automation library**

Custom data type is a complex data type that is unique to Workflow. This data type is used in projects to pull together related data from the Symantec database into relevant groupings.

Adding custom data types to existing automation library involves the following tasks:

- Adding custom data type to existing automation library using Workflow Manager
- Using the newly-created data type in existing processes using the Process Manager portal

**Adding custom data type to existing automation library using Workflow Manager**

You can add new data types to an existing automation library in Workflow Manager for the Incident Management, Change Management, or Problem Management processes.

To add a custom data type to an existing automation library

1. Create an Integration Library with User Defined Type with DB Mapping (ORM) generator type, by executing the following steps:
   - On the computer, click **Start > All Programs > Symantec > Workflow Designer > Workflow Manager**.
   - In the Workflow Manager application, click **File > New Project**.
   - In the **New Project** window, under the **Project Types** tab, click **Integration**.
Specify the project name, browse and select the workflow directory, and then click OK.

In the Create Generator dialog box, select the User Defined Type with DB Mapping (ORM) from the Authoring generator type, and then click OK.

2. Add process data class to the newly-created generator, by executing the following steps:

- In the Type Designer window for the newly-created generator, click Add > Add process data class.
- In the Add Type dialog box, specify the name, and then click Add.
- In the Type Designer window for the newly-created generator, click Add Property.
- In the Add Property dialog box, specify the following preferences, and then click Add:

<table>
<thead>
<tr>
<th>User interface element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name field</td>
<td>Specify the name for the property.</td>
</tr>
<tr>
<td>Type list</td>
<td>The data type of the property. If you want to use a data type that is not available in the list, you can import it in an assembly. See “Adding an assembly to a generator” on page 262.</td>
</tr>
<tr>
<td>One or Many options</td>
<td>Specifies whether the property is a single value or an array. Select the One option or the Many option.</td>
</tr>
<tr>
<td>Override field name check box</td>
<td>Specifies whether the name of the property overwrites the name of the column with the name of this property. This property applies only if the target column already exists and has a name that is different from the name of the property. To enable this property, select the check box and then enter a name in the adjoining field.</td>
</tr>
<tr>
<td>Override Type Converter check box</td>
<td>Specifies whether the generator uses a type converter other than the default. By default the generator uses the GenericRelationalMappingFieldConverter. To enable this property, select the check box and then select a new type converter that is available from the adjoining list.</td>
</tr>
</tbody>
</table>
### User interface element

| **Override SQL Data Type** check box | Specifies whether the property uses a SQL data type other than the default. The default SQL data type appears in the **SQL Date Type Read Only** property. To enable this property, select the check box and then enter a new SQL data type for this property to use. |
| **Indexed** check box | Creates a database index on the field. This option improves the query performance when you query by the field if your table contains a large amount of data. |

3. After you have entered the required properties, click **Next**.

4. On the **Indexes** page, specify the type, and click **Add** to add indexes to the properties that you created in the **Type Designer** page. Click **Next**.

5. On the **Settings** page, specify the namespace to identify the generated component library, and then click **Next**.

6. On the **Components** page, select the data types for which you want to create components, and then click **Finish**.

   A new integration library with a DB Mapping (ORM) generator type is created.

7. On the **Generators Management** page, click **Included Libraries**.

8. On the **Project Libraries** dialog box, click **Add**.

9. On the **Add Library To Project** dialog box, browse and select existing automation library to which you want to add custom data types. For example, the **Symantec.ServiceDesk.IM.Automation.dll** to bind the custom data with the Incident Management Automation Library. Click **Add > OK**.

10. On the **Project Libraries** dialog box, click **Close**.

11. On the **Generators Management** page, click **Add**.

12. In the **Create Generator** dialog box, specify the following preferences, and then click **OK**:
   - Specify the name for the generator.
   - Under **Enterprise Resource**, select **Automation Library Generator**.

13. In the **Automation Library Generator** wizard, specify the following options:
   - In the **Automation Library Generator** dialog box, read the instructions, and then click **Next**.
In the Choose Service ID dialog box, select the Use Existing Automation Library option, select the recently-added automation library from Automation Library list. For example, Incident Management. Click Next.

Note: Only the preinstalled ServiceDesk automation libraries can be included, and not the custom automation libraries.

In the Select Process Data (ORM) Types dialog box, select the newly-created process data type, and then click Finish.


The new data classes are created using Workflow Manager, and are available for use in the Process Manager portal.

Using the newly-created data type in existing processes using the Process Manager portal

You can use the newly-created data types for the existing Incident Management, Change Management, or Problem Management processes.

To use the newly-created data type in existing processes

1. Log on to the Process Manager portal with an administrator account, preferably native admin account. For example, admin@symantec.com.

2. Click Admin > Portal > Plugin Upload.

3. In the page that is displayed, execute the following steps:

   a. Select Plugin Type as Automation Library.

   b. In the Upload Plugin field, browse and select the .dll file of the newly-created automation library from the following path:
      C:\Program Files\Symantec\Workflow\Shared\customlib

   c. Click Upload.

4. Restart Internet Information Services (IIS) to reflect the changes in the process automation by executing the following steps:

   a. Open the command prompt file, and type iisreset.

   b. Verify that the Internet services are successfully restarted message is displayed in the command prompt.

5. Refresh the Process Manager portal and then click Admin > Process Automation.
The newly-added service is displayed next to Incident Management service. Additionally, the new data type is also added to the conditions, actions, email templates, and reports of the Incident Management service.

6. (Optional) Use the newly-added data type in rule conditions of existing rulesets, by executing the following steps:
   - On Incident Management Service Dashboard, expand the Incident Management <newly-created data type name> service, and then click Service Dashboard.
   - Click any ruleset and add a rule or modify an existing rule for the ruleset. You can now add the new data type as a condition while creating a rule or modifying an existing rule.

7. (Optional) Use the newly-added data type in email templates, by executing the following steps:
   - On Incident Management Service Dashboard, expand the Incident Management <newly-created data type name> service, and then click Service Dashboard.
   - On the Actions pane in the left, click Manage Email Templates > Add Email Template.
   - The newly-created data types are available as fields when you create a template or modify an existing template.

8. (Optional) Use the newly-added data type in reports, by executing the following steps:
   - On the Process Manager portal, click Admin > Reports.
   - In the Report Categories pane on the left, click Incident Management.
   - On the list of reports that are displayed in the window, click Add > Add Standard Report.
   - In the Add Standard Report page, after you select to Add Data Source, the newly-created data types are available as fields.

Generating components

You can use the Integrator project type to generate components. When you generate components, the generator produces a component library. The component library
Working with the component generators

Generating components

may contain one or more components, and it is saved as a .DLL file in the projects folder (C:\Program Files\Symantec\Workflow\Workflow Projects).

After you generate components, you can import the component libraries to use them in a project.

See “About the component generators” on page 240.

See “About Workflow Designer Project Types” on page 147.

See “Importing components into a project” on page 215.

You can generate components in two ways. You can create a new Integration Project Type.

You can also use the Create Integration Library option in an open project under the component toolbox. When you create an Integration Library within a project, the library is associated with that project.

To generate components by creating a new Integration Project Type

1 In Workflow Manager, click File > New Project.
   See “About Workflow Manager” on page 132.

2 In the New Project dialog box, on the Project Types tab, click Integration.

3 In the Name box, type a name for your component library.

4 (Optional) If you do not want to save your Integration project to the default location, browse for, and select a different location.

5 Click OK.

6 In the Create Generator dialog box, in the Generator types area, select the generator that you want to run.

7 In the Name box, type the name for the generator, and then click OK.

8 Use the wizard to configure the generator that you selected.

To generate components by using the Create Integration Library option

1 In Workflow Designer in an open project, under Toolbox, click New Integration Library.
   See “About the component toolbox” on page 154.

2 In the New Library dialog box, type the name for your component library.

3 (Optional) If you do not want to save your Integration Library to the default location, browse for, and select a different location.

4 Click OK
5 In the Create Generator dialog box, in the Generator types area, select the generator that you want to run.
6 In the Name box, type the name for the generator, and then click **OK**
7 Use the wizard to configure the generator that you selected.

**Symantec workflow component generators**

Workflow Designer has eight Symantec component generators. These generators are divided into two groups: generators for the Symantec Management Platform 6.5 (Notification Server 6.5) and generators for the Symantec Management Platform 7.0 and above. The only difference between the generators is the version of the Symantec Management Platform with which their components communicate. The generators are as follows: ASDK, ASDK Tasks, Reports, and Resource. Each Symantec generator builds or rebuilds custom libraries of the Symantec components that are available. After these custom libraries are built, you can use the newly generated Symantec components in your projects.

Each Symantec component generator is an Integration-type project.

See “Running the Symantec Management Platform component generators” on page 573.

See “About the component generators” on page 240.

See “About Workflow Designer Project Types” on page 147.

**Table 13-1** The Symantec Management Platform 6.5 and 7.0 generators

<table>
<thead>
<tr>
<th>Symantec generator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASDK component generator</td>
<td>The ASDK generator is run after installation by the workflow developer. It creates components out of ASDK method calls. ASDK methods change less frequently than task and resources change on the Symantec Management Console. However, any changes to an ASDK method that is contained within a component requires the components to be regenerated.</td>
</tr>
<tr>
<td>ASDK Tasks</td>
<td>The Task generator is run after installation by the workflow developer. It gathers ASDK tasks on the Symantec Management Console. A task is an action that is taken on a resource or a collection of resources. Tasks are managed in the Symantec Management Console. Any component that is generated needs to be regenerated to reflect changes from the Symantec Management Console.</td>
</tr>
</tbody>
</table>
### Table 13-1  The Symantec Management Platform 6.5 and 7.0 generators (continued)

<table>
<thead>
<tr>
<th>Symantec generator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reports generator</td>
<td>The Report generator is run after installation by the workflow developer. It gathers all of the reports that are available in the Symantec Management Console. For every report that is available, one component is created. Each report component represents a SQL query that retrieves and stores structured data back in a collection within a workflow.</td>
</tr>
<tr>
<td>Resource component generator</td>
<td>The Resource generator is run during installation. It gathers all of the resources that are available on the Symantec Management Console. A resource is usually a tangible item such as a computer, telephone, or printer. Resources have data and associations to other resources on the Symantec Management Console. Resources are managed in the Symantec Management Console. The components that are generated must be regenerated to reflect changes from the Symantec Management Platform.</td>
</tr>
</tbody>
</table>

---

### Adding an assembly to a generator

When you first open a component generator, you can add assemblies. By adding assemblies, you can use custom data when you run a component generator. For example, you can add an assembly of a custom data type. Then, when you run the User Defined Type generator, you can use that custom data type in the wizard.

See “About the component generators” on page 240.

See “Types Designer page” on page 304.

To add an assembly to a generator

1. When you run a component generator, on the Select a Generator page, click **Load External Libraries**.
2. Click the generator that you want to run, and then click **OK**.
   A dialog box that lets you load external libraries opens.
3. In the **Dynamic Type Included Assemblies** dialog box, click the ... symbol.
4. Navigate to the assembly that you want to add, click it, and then click **Open**.
5. After you have added all of the external libraries that you want to add, click **OK**.
   The generator opens, and the assemblies that you added are available for you to use.
About the filter generator

The filter generator lets you create a data set that you can use to build Process Manager reports. The filter generator outputs a DLL that can be uploaded into Process Manager using the Admin plug-in upload.

You may need to restart IIS before the Admin plug-in is available.

After the Admin plug-in is uploaded, the Source table appears in the report build under the connection context name that you input into the generator.

The default connection context points to the Process Manager database. You can manage the connection contexts in Process Manager under Admin > Reports > Connection Context List.

See “Table Source page” on page 263.

After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them.

See “Importing components into a project” on page 215.

See “About the component generators” on page 240.

Table Source page

The Table Source page is a page in the Filter generator wizard. This page lets you configure a database provider, a connection string, a table, and the settings that control how the report is made.

See “About the filter generator” on page 263.

See “Column Manager page” on page 265.

Table 13-2 Properties on the Table Source page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider</td>
<td>The kind of database that you want to use.</td>
</tr>
<tr>
<td>Connection string</td>
<td>The string that the generated components use to connect and authenticate to the target database. Use the drop-down list to see the sample connection strings that you can use to create your own. Click Test Connection to test the validity of your connection string.</td>
</tr>
<tr>
<td>Table Name</td>
<td>The name of the table in your database that you use to create the report.</td>
</tr>
</tbody>
</table>
### Table 13-2  Properties on the Table Source page (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow this filter set to be used with other filters</td>
<td>Sets whether the filter set that you create can be joined with another filter set.</td>
</tr>
<tr>
<td>Use distinct</td>
<td>Sets whether the filter query uses distinct results.</td>
</tr>
<tr>
<td>Source table</td>
<td>The first table for the join.</td>
</tr>
<tr>
<td></td>
<td>For example, in the following query, <strong>User</strong> is the source table:</td>
</tr>
<tr>
<td></td>
<td><code>select * from User u inner join UserGroup ug on u.UserId = ug.UserId</code></td>
</tr>
<tr>
<td>Source column</td>
<td>The first column for the join.</td>
</tr>
<tr>
<td></td>
<td>For example, in the following query, <code>u.UserId</code> is the first column:</td>
</tr>
<tr>
<td></td>
<td><code>select * from User u inner join UserGroup ug on u.UserId = ug.UserId</code></td>
</tr>
<tr>
<td>Join type</td>
<td>Select the Inner or the Outer join.</td>
</tr>
<tr>
<td></td>
<td>An inner join returns only the rows from the Source table where there is a match on the join table.</td>
</tr>
<tr>
<td></td>
<td>An outer join returns all rows in the Source table with null for the Join table data if no match is found.</td>
</tr>
<tr>
<td>Join table</td>
<td>The table to join.</td>
</tr>
<tr>
<td></td>
<td>For example, in the following query, <strong>UserGroup</strong> is the table to join:</td>
</tr>
<tr>
<td></td>
<td><code>select * from User u inner join UserGroup ug on u.UserId = ug.UserId</code></td>
</tr>
<tr>
<td>Join table alias</td>
<td>The join table alias.</td>
</tr>
<tr>
<td></td>
<td>For example, in the following query, <strong>ug</strong> is the alias:</td>
</tr>
<tr>
<td></td>
<td><code>select * from User u inner join UserGroup ug on u.UserId = ug.UserId</code></td>
</tr>
<tr>
<td></td>
<td>A join table alias is needed because one query can use the same table several times.</td>
</tr>
</tbody>
</table>
Table 13-2  Properties on the Table Source page (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Join column</td>
<td>The column to join. For example, in the following query, <code>ug.UserId</code> is the column to join: select * from User u inner join UserGroup ug on u.UserId = ug.UserId</td>
</tr>
</tbody>
</table>

Column Manager page

This page lets you choose which columns you want to use in the report.

See “About the filter generator” on page 263.
See “Table Source page” on page 263.

Table 13-3  Properties on the Column Manager page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group columns by table name</td>
<td>This property lists the columns by table name.</td>
</tr>
<tr>
<td>Ignore all IDs</td>
<td>Unchecks any key fields.</td>
</tr>
<tr>
<td>Assemblies</td>
<td>This property lets you enter the assembly path of assemblies to include.</td>
</tr>
</tbody>
</table>

About the query script generator

The query script generator lets you create the components that submit and process user-specified SQL against a user-specified database. You can query a variety of database providers and drivers including SQL, Oracle, ODBC, OLEDB, and more. The components that you create with this generator can be fully customized.

See “Connection page” on page 266.
See “Connection String page” on page 267.
See “Properties Name page” on page 268.
See “Fields page” on page 269.

After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them.

See “Importing components into a project” on page 215.
Connection page

The Connection page is a page in the Query/Script generator wizard. On this page you configure a connection string, SQL query, and query parameters.

See “About the query script generator” on page 265.

Table 13-4 Properties on the Connection page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select provider</td>
<td>The database provider that you want to query.</td>
</tr>
<tr>
<td>Connection string</td>
<td>The string that the generated components use to connect and authenticate to the target database. Use the drop-down list to see the sample connection strings that you can use to create your own. Click <strong>Test Connection</strong> to test your connection string.</td>
</tr>
<tr>
<td>Query example</td>
<td>A sample query that you can use to create your own query. The query example changes based your database provider.</td>
</tr>
</tbody>
</table>
Table 13-4 Properties on the Connection page (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL query</td>
<td>The SQL query that the generated components use to get data from the target database. Choose one of the following parameter settings:</td>
</tr>
<tr>
<td></td>
<td>- All Db Parameters Declares all of the parameters from your query. This option makes all of the query parameters appear as properties in the component editors.</td>
</tr>
<tr>
<td></td>
<td>- No Db Parameters Declares no parameters from your query. This option makes no query parameters appear as properties in the component editors.</td>
</tr>
<tr>
<td></td>
<td>- Mixed mode Declares only the parameters that you choose from your query. This option lets you choose which parameters appear as properties in the component editors. Use this option when you use parameters in your query that you want to be hidden from the user. You can set which parameters are declared by clicking Find Input Parameters and then setting the Db Parameter property on the parameter.</td>
</tr>
<tr>
<td></td>
<td>Click Execute queries separated, splitting by this char if you have multiple queries that you do not want to run simultaneously. For example, you can use this option if your queries handle large amounts of data. You can also use this option if a query is dependent on the function that a previous query performs.</td>
</tr>
<tr>
<td></td>
<td>Click Find Input Parameters to populate a list of parameters that are included in your query.</td>
</tr>
<tr>
<td>Query Parameters</td>
<td>All of the parameters that are contained in your query string. For example, if your query string includes the parameters for the employee name and the employee ID, these parameters are listed as separate items. When the components are generated, these parameters become properties on the component editors.</td>
</tr>
</tbody>
</table>

Connection String page

The Connection page is a page in the Query/Script generator wizard. On this page you configure how the generated components access the connection string.
See “About the query script generator” on page 265.

The connection string is configured on the Connection page.

See “Connection page” on page 266.

**Table 13-5 Properties on the Connection String page**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection String Generation</strong></td>
<td>The way the generated components access the connection string. The generated components can access the connection string in one of the following ways:</td>
</tr>
<tr>
<td></td>
<td>❏ <strong>Populate into component</strong> Populates the connection string into a property in the generated components.</td>
</tr>
<tr>
<td></td>
<td>❏ <strong>Use project property</strong> Uses an existing project property as the connection string. See “About project properties” on page 191. If you use this option, set the name of the project property in the <strong>Project Property Name</strong> property.</td>
</tr>
<tr>
<td></td>
<td>❏ <strong>Use and populate Project property</strong> Uses an existing project property and populates it with the connection string that you set on the Connection page. See “Connection page” on page 266.</td>
</tr>
<tr>
<td></td>
<td>❏ <strong>Leave blank</strong> Does not provide a connection string for the generated components. Use this option if you want to set the connection string in the component editor.</td>
</tr>
<tr>
<td><strong>Project Property Name</strong></td>
<td>The project property that provides the connection string for the generated components. You can set this property if you use the <strong>Use project property</strong> or <strong>Use and populate Project property</strong>.</td>
</tr>
</tbody>
</table>

**Properties Name page**

The Properties Name page is a page in the Query/Script generator wizard. On this page you can change the name of the properties that appear in the editors of your generated components. If you do not change the names of the properties, the default name is the same as the parameter name.
For example, if you have a parameter called @LastName, you can change the property name so that it appears as Last Name.

See “About the query script generator” on page 265.

Fields page

The Fields page is a page in the Query/Script generator wizard. On this page you set the output fields for the generated components.

See “About the query script generator” on page 265.

About the stored procedure caller generator

This generator lets you create the components that run a user-specified stored procedure against a user-specified database. You can call a stored procedure from a variety of database providers and drivers (for example, SQL and Oracle). The components that you create with this generator can be fully customized.

See “Connection page” on page 266.
See “Connection String page” on page 267.
See “Properties Name page” on page 268.
See “Fields page” on page 269.

After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them.

See “Importing components into a project” on page 215.

Connection page

The Connection page is a page in the Query/Script generator wizard. On this page you configure a connection string, SQL query, and query parameters.

See “About the query script generator” on page 265.

Table 13-6 Properties on the Connection page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select provider</td>
<td>The database provider that you want to query.</td>
</tr>
</tbody>
</table>
### Table 13-6  Properties on the Connection page (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection string</td>
<td>The string that the generated components use to connect to the target database. Use the drop-down list to see the sample connection strings that you can use to create your own string. Click <strong>Test Connection</strong> to test your connection string.</td>
</tr>
<tr>
<td>Query example</td>
<td>A sample query that you can use to create your own query. The query example changes based on your database provider.</td>
</tr>
</tbody>
</table>
| SQL query               | The SQL query that the generated components use to get data from the target database. Choose one of the following parameter settings:  
  - **All Db Parameters**  
    Declare all parameters from your query. This option makes all of the query parameters appear as properties in the component editors.  
  - **No Db Parameters**  
    Declares no parameters from your query. This option makes no query parameters appear as properties in the component editors.  
  - **Mixed mode**  
    Declares only the parameters that you choose from your query. This option lets you choose which parameters appear as properties in the component editors. Use this option when you use parameters in your query that you want to be hidden from the user. You can set which parameters are declared by clicking **Find Input Parameters** and then setting the **Db Parameter** property on the parameter.  
    Click **Execute queries separated, splitting by this char** if you have multiple queries that you do not want to run simultaneously. For example, you can use this option if your queries are large. You can also use this option if a query is dependent on the function that a previous query performs.  
    Click **Find Input Parameters** to populate the list of the parameters that are included in your query. |
Table 13-6  Properties on the Connection page (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query Parameters</td>
<td>All of the parameters that are contained in your query string. For example, if your query string includes the parameters for an employee name and an employee ID, these parameters are listed as separate items. When the components are generated, these parameters become properties on the component editors.</td>
</tr>
</tbody>
</table>

Connection String page

The Connection page is a page in the Query/Script generator wizard. On this page you configure how the generated components access the connection string.

See “About the query script generator” on page 265.

The connection string is configured on the Connection page.

See “Connection page” on page 269.
Table 13-7 Properties on the Connection String page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection String Generation</td>
<td>The way the generated components access the connection string.</td>
</tr>
<tr>
<td></td>
<td>The generated components can access the connection string in one of the following ways:</td>
</tr>
<tr>
<td></td>
<td>■ Populate into component: Populates the connection string into a property in the generated components.</td>
</tr>
<tr>
<td></td>
<td>■ Use project property: Uses an existing project property as the connection string.</td>
</tr>
<tr>
<td></td>
<td>See “About project properties” on page 191.</td>
</tr>
<tr>
<td></td>
<td>If you use this option, set the name of the project property in the Project Property Name property.</td>
</tr>
<tr>
<td></td>
<td>■ Use and populate Project property: Uses an existing project property and populates it with the connection string that you set on the Connection page.</td>
</tr>
<tr>
<td></td>
<td>See “Connection page” on page 269.</td>
</tr>
<tr>
<td></td>
<td>■ Leave blank: Does not provide a connection string for the generated components. Use this option if you want to set the connection string in the component editor.</td>
</tr>
<tr>
<td>Project Property Name</td>
<td>The project property that provides the connection string for the generated components. You can set this property if you use Use project property or Use and populate Project property.</td>
</tr>
</tbody>
</table>

Properties Name page

The Properties Name page is a page in the Query/Script generator wizard. On this page you can change the name of the properties that appear in the editors of your generated components. If you do not change the names of the properties, the default name is the same as the parameter name.

For example, if you have a parameter called @LastName, you can change the property name so that it appears as Last Name.

See “About the query script generator” on page 265.
Fields page

The Fields page is a page in the Query/Script generator wizard. On this page you set the output fields for the generated components.

See “About the query script generator” on page 265.

About the Multiple generator container

This generator does not generate components; it puts the components that other generators create into a single DLL file. Use the Multiple generator container when you need to generate multiple components around a single theme or a single project. For example, for a project that interacts with SQL Server, use can this container to create a single DLL. The single DLL can include custom query components and table generators. That way you have only one library to import into your project.

See “Generators Management page” on page 273.

See “Creating components in the Multiple generator container” on page 273.

See “Editing components in the Multiple generator container” on page 274.

After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them.

See “Importing components into a project” on page 215.

Generators Management page

The Connection page is the only page of the Multiple generator container wizard. On this page you launch other component generators or add assemblies.

See “About the Multiple generator container” on page 273.

Table 13-8 Generators Management page options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Included Libraries</td>
<td>The assemblies that the components that you create in the Multiple generator container must reference.</td>
</tr>
<tr>
<td>Generators</td>
<td>The generators that are available for you to use to create components.</td>
</tr>
</tbody>
</table>

Creating components in the Multiple generator container

The Multiple Generator Container is only a container; it is not an actual component generator. You can run the other component generators within the Multiple Generator
Container to create components. Components that you create inside of the container are compiled as a single DLL. Almost all of the component generators are available in the Multiple generator container.

See “About the Multiple generator container” on page 273.

To create components in the Multiple generator container

1. In the Generators Management page of the Multiple generator container, right-click Generators.
2. Click Add Generator, and then click a generator in the list. Some of the generators have different names than they do outside of the Multiple generator container. If you do not see the generator you need, it may have a different name. For example, the Web Service Caller generator is called DynamicWebServiceGenerator.
3. Enter a name for the new Integration-type project, and then click OK.
4. Complete the wizard of the generator hat you selected.
5. When you have finished, you can add another component generator. If you are finished with the Multiple generator container, click OK, and then click Compile and close.

Editing components in the Multiple generator container

After you have used the Multiple generator container to create components, you can open the individual projects in the container to edit them.

See “About the Multiple generator container” on page 273.

To edit components in the Multiple generator container

1. In the Workflow Designer Loading Screen, open the Multiple generator container Integration-type project.
2. Click Adjust Definitions.
3. Expand Generators to see all of the individual projects in the container.
4. Right-click on the project that you want to edit, and then click Show Wizard.
5. After you make your edits, finish the wizard, and then click Recompile and close.

About the table generator

The table generator generates table-related components (retrieve data, drop table, read table, and so on) from a user-specified table in a user-specified database.
Components that are created with this generator can perform operations on the tables in a database. The components can add tables, record to a table, rename a table, read information from a table, or add fields to a table.

See “Connection page” on page 275.

See “Connection String page” on page 276.

See “Components page” on page 277.

See “Select components page” on page 278.

After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them.

See “Importing components into a project” on page 215.

Connection page

The Connection page is a page in the table generator wizard. On this page you configure a connection string, database table, and table definition.

See “About the table generator” on page 274.

Table 13-9  Properties on the Connection page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select provider</td>
<td>The database provider that you want to query.</td>
</tr>
<tr>
<td>Connection string</td>
<td>The string that the generated components use to connect and authenticate to the target database. Use the drop-down list to see the sample connection strings that you can use to create your own. Click Test Connection to test the validity of your connection string.</td>
</tr>
<tr>
<td>Table or view</td>
<td>The table or view for which you want to generate components. The drop-down list displays all of the tables and views that are available in the database that is specified in the connection string.</td>
</tr>
<tr>
<td>Table SQL Name</td>
<td>Lets you leave the table name as it is, by default, or add escape characters. Use brackets or quotation marks when your table name conflicts with a keyword.</td>
</tr>
<tr>
<td>Fill Table Definition</td>
<td>Returns the table definition to the generator wizard.</td>
</tr>
</tbody>
</table>
Table 13-9 Properties on the Connection page (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Select Fields     | After you click Fill Table Definition, you can configure settings for the table's columns.  
Configure the following settings: |
|                   | ■ Column Name  
Declares a name for a column. |
|                   | ■ Property Name  
Declares a property name. |
|                   | ■ Field Type  
Declares a type of the field. |
|                   | ■ Is Key  
Declares if the column is a key for the table. |
|                   | ■ Use in Components  
Declares which columns you want to use in the generated components. |
|                   | ■ Can be Null  
Declares if the values in that column can be null. |
|                   | ■ Use quoting  
Declares to use quoting around the column name. If a column name has a space in it, this setting is turned on when you click Fill Table Definition. |
|                   | ■ Identity  
Declares if the column uses an identity. |
|                   | ■ Provider Type  
Overrides the Field Type value with a different data type. Use this setting if you need to convert the data from the recognized data type to a data type that is similar but different. |

Connection String page

The Connection page is a page in the table generator wizard. On this page you configure how the generated components access the connection string.

See “About the table generator” on page 274.

The connection string is configured on the Connection page.

See “Connection page” on page 275.
Table 13-10  Properties on the Connection String page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection String Generation</td>
<td>The way the generated components access the connection string. The generated components can access the connection string in one of the following ways:</td>
</tr>
<tr>
<td></td>
<td>■ Populate into component</td>
</tr>
<tr>
<td></td>
<td>■ Use project property</td>
</tr>
<tr>
<td></td>
<td>■ Use and populate Project property</td>
</tr>
<tr>
<td></td>
<td>■ Leave blank</td>
</tr>
<tr>
<td>Project Property Name</td>
<td>The project property that provides the connection string for the generated components. You can set this property if you use the Use project property or Use and populate Project property options.</td>
</tr>
</tbody>
</table>

Components page

The Components page is a page in the table generator wizard. It lets you set the namespace and category for your generated components, and it lets you select which components you want to generate. Depending on your database configuration, some of the components may not be available. For example, if you do not set any column as the key, the Read records (by key), Write records, and Delete records components are not available.

See “About the table generator” on page 274.
Table 13-11 Properties on the Components page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Components category</td>
<td>The category in the component toolbox in which the generated components appear. You can add subcategories in the following format: <code>category.subcategory</code>.</td>
</tr>
<tr>
<td>Component namespace</td>
<td>The component namespace that is used to identify data from the generated component library. The namespace serves to differentiate data if you have another identically named data type.</td>
</tr>
<tr>
<td>Database entity class name</td>
<td>The data type that is used to handle the data from the generated components.</td>
</tr>
<tr>
<td>Standard components</td>
<td>You can select any of the available components to be generated. You can also change the names of the generated components.</td>
</tr>
</tbody>
</table>

Select components page

The Select components page is a page in the table generator wizard. It lets you specify individual components to retrieve individual pieces of data. You can create a single component to retrieve all of the available data. You can also create the separate components that retrieve separate pieces of data.

See “About the table generator” on page 274.

About the fast table generator

The fast table generator is a reduced version of the table generator.

See “About the table generator” on page 274.

After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them.

See “Importing components into a project” on page 215.

About the DTD generator

This generator creates read and write components based on a user-specified document type definition file (.DTD). DTD files are used in the creation of XML files. They contain the arbitrary parameters that provide a format for XML data.
The components that you create with this generator enforce a schema for their input values and output values.

See “File Selecting page” on page 279.

See “Schema Editing page” on page 279.

See “Read/Write components page” on page 279.

File Selecting page

The File Selecting page is a page in the DTD generator wizard. On this page you specify a DTD file that this generator uses as a template.

The DTD file that you provide must contain a readable DTD schema.

See “About the DTD generator” on page 278.

Schema Editing page

The Schema Editing page is a page in the DTD generator wizard. This page is optional. On this page you can edit the schema that the DTD file provides.

See “About the DTD generator” on page 278.

Read/Write components page

The Read/Write components page is a page in the DTD generator wizard. It lets you set properties for the read and write components.

See “About the DTD generator” on page 278.

Table 13-12 Properties on the Read/Write components page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root Type Name</td>
<td>The component namespace that is used to identify data from the generated component library. The namespace serves to differentiate data if you have another identically named data type.</td>
</tr>
<tr>
<td>Type Name</td>
<td>The data type that is used to handle the data from the generated components.</td>
</tr>
<tr>
<td>Read Component Name</td>
<td>The name of the read component.</td>
</tr>
<tr>
<td>Write Component Name</td>
<td>The name of the write component.</td>
</tr>
</tbody>
</table>
About the XML Schema generator

The XML Schema generator has the same function as the DTD generator. However, the XML Schema generator uses XML files.

See “About the DTD generator” on page 278.

About the Excel generator

This generator generates read and write components based on a user-specified Excel spreadsheet file (.XLS or .XLSX). Based on a template spreadsheet, the generator creates the standard components that you can use with other spreadsheets.

See “Definitions page” on page 280.
See “Null strings page” on page 280.
See “Read/Write components page” on page 281.
See “Rows page” on page 281.
See “Definitions Editing page” on page 282.

Definitions page

The Definitions page is a page in the Excel generator wizard. It lets you select an Excel file to use as the template spreadsheet. The generator analyzes the columns and the data types, and uses this information to generate components.

See “About the Excel generator” on page 280.

Null strings page

The Null strings page is a page in the Excel generator wizard. It lets you declare which strings should be considered null and what the default value for null fields should be. You set the null values by data type.

See “About the Excel generator” on page 280.

Table 13-13 Properties on the Null strings page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logical Types</td>
<td>The data types for which you can set null string values. Because each data type can have a different null value, set the null strings and the value for each data type.</td>
</tr>
</tbody>
</table>
Table 13-13  Properties on the Null strings page (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Null strings</td>
<td>The strings that are recognized as null. You can add none, one, or multiple null strings. Add all of the strings that should be treated as null values.</td>
</tr>
<tr>
<td>Default value</td>
<td>The default value to use for null fields.</td>
</tr>
</tbody>
</table>

Read/Write components page

The Read/Write components page is a page in the Excel generator wizard. It lets you set properties for the read and write components.

See “About the Excel generator” on page 280.

Table 13-14  Properties on the Read/Write components page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Namespace</td>
<td>The component namespace that is used to identify data from the generated component library. The namespace serves to differentiate data if you have another identically named data type.</td>
</tr>
<tr>
<td>Type Name</td>
<td>The data type that is generated to handle the data from the generated components.</td>
</tr>
<tr>
<td>Read Component Name</td>
<td>The name of the Excel read component.</td>
</tr>
<tr>
<td>Write Component Name</td>
<td>The name of the Excel write component.</td>
</tr>
<tr>
<td>Components category</td>
<td>The category in the component toolbox in which the generated components appear. You can add subcategories in the following format: category.subcategory.</td>
</tr>
</tbody>
</table>

Rows page

The Rows page is a page in the Excel generator wizard. It lets you select which row is the column names row and which rows are the data rows. Select only one row as the names row, and select at least one row as a data row.

See “About the Excel generator” on page 280.
Table 13-15  Properties on the Rows page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row#</td>
<td>The row number as it appears in the template spreadsheet.</td>
</tr>
<tr>
<td>Is Data Row</td>
<td>Declares if the row is a data row.</td>
</tr>
<tr>
<td>Is Names Row</td>
<td>Declares if the row is the row that contains the column names.</td>
</tr>
</tbody>
</table>

Customize columns page

The Customize columns is a page in the Excel generator wizard. It lets you select the column names and data types for each column. By default, the columns are named according to the values in the names row of the template spreadsheet. By default, the data types are set according to the values in the data rows of the template spreadsheet.

See “About the Excel generator” on page 280.

Table 13-16  Properties on the Customize columns page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column #</td>
<td>The column number as it appears in the template spreadsheet.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the column. The names are populated based on the values in the column names row. You can change the existing column name or add it if it is blank.</td>
</tr>
<tr>
<td>Use Column</td>
<td>Declares if a column is used in the generated components. Uncheck any column that you want the generated components to ignore.</td>
</tr>
<tr>
<td>Format</td>
<td>You cannot edit this value.</td>
</tr>
<tr>
<td>Type</td>
<td>The data type that is used in the column. You can change the data type if the default data type is not accurate.</td>
</tr>
</tbody>
</table>

Definitions Editing page

The Definitions Editing page is a page in the Excel generator wizard. This page is optional; it lets you edit the names of the columns before you generate components. It requires you to declare a name for every column if one is not already declared.
See “About the Excel generator” on page 280.

About the Active Directory generator

The Active Directory generator generates read and write components. These components let you add, remove, or modify entities in your Active Directory Server. These components support Active Directory schema customization and let you use Active Directory information and settings in your workflow projects.

See “Connection page” on page 283.

After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them.

See “Importing components into a project” on page 215.

Connection page

The Connection page is a page in the Active Directory generator wizard. It lets you configure a connection to an LDAP server.

See “About the Active Directory generator” on page 283.

Table 13-17 Properties on the Connection page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Directory Server</td>
<td>The URL or server name of the LDAP computer to which you want to connect. Depending on your network configuration, you might be able to use the IP address of the LDAP computer.</td>
</tr>
</tbody>
</table>

Configure the following properties for the LDAP server:

- **Port**
  The Active Directory server query port. Use the default port (389) unless your organization uses another port.

- **Timeout in Seconds**
  The timeout setting for Active Directory queries.

- **Bind Anonymously**
  Sets the connection not to use any credentials.

- **Use the account of the currently logged user**
  Sets the connection to use the credentials of the current user.
Table 13-17  Properties on the Connection page (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>The user name that is used to connect to the LDAP computer. By default the wizard supplies the following value: \texttt{cn=Manager,dc=mycompany,dc=com}. This string refers to the following values:</td>
</tr>
<tr>
<td></td>
<td>\begin{itemize}                                                                                         \item \texttt{cn}  \quad A user name that the LDAP computer recognizes. \item \texttt{dc}  \quad The domain of the LDAP computer. \item \texttt{dc}  \quad The top-level domain (such as \texttt{com} or \texttt{local}). \end{itemize}</td>
</tr>
<tr>
<td></td>
<td>You do not need to use the default value for this property. You can create your own value. For example, you may be able to use a value such as \texttt{administrator@mycomputername} in your LDAP computer configuration. Do not use the top-level domain in your user name.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for the user name that you entered.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>The password for the user name that you entered.</td>
</tr>
<tr>
<td>Distinguished Name</td>
<td>The name of the LDAP computer and its appended tag. By default, the wizard supplies the following value: \texttt{dc=mycompany,dc=com}. This string refers to the following values:</td>
</tr>
<tr>
<td></td>
<td>\begin{itemize}                                                                                         \item \texttt{dc}  \quad The domain of the LDAP computer. \item \texttt{dc}  \quad The top-level domain (such as \texttt{com} or \texttt{local}). \end{itemize}</td>
</tr>
</tbody>
</table>

About the SharePoint Lists generator

The SharePoint Lists generator generates the components that add or remove items in a SharePoint task list. These components can also handle document exchanges with the document repository in SharePoint. This generator inspects the SharePoint list to discover all of the available columns and then transposes them into properties in a component.

See “Setup Connection page” on page 285.
See “Select Lists page” on page 285.

See “Components page” on page 286.

After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them.

See “Importing components into a project” on page 215.

Setup Connection page

The Setup Connection page is a page in the SharePoint Lists generator wizard. On this page you configure the SharePoint computer for which you want to create components. If necessary, you also enter credentials on this page.

Your design computer should be in the same domain as the SharePoint computer.

See “About the SharePoint Lists generator” on page 284.

<table>
<thead>
<tr>
<th>Table 13-18 Properties on the Setup Connection page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Properties</strong></td>
</tr>
<tr>
<td>URL</td>
</tr>
<tr>
<td>Use Authentication</td>
</tr>
<tr>
<td>Username</td>
</tr>
<tr>
<td>Password</td>
</tr>
<tr>
<td>Domain</td>
</tr>
</tbody>
</table>

Select Lists page

The Select Lists page is a page in the SharePoint Lists generator wizard. On this page you set the lists for which you want to generate components. The lists that appear here are the lists that exist in SharePoint. If none of the lists meets your need, you can create a new one in SharePoint. You can select individual lists, or you can click Select All.

See “About the SharePoint Lists generator” on page 284.
Components page

The Components page is a page in the SharePoint Lists generator wizard. On this page you set the kinds of components that you want to generate. You can also use this page to configure some of the settings for your components.

See “About the SharePoint Lists generator” on page 284.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add/Update Items</strong></td>
<td>Sets whether the generator creates components to add or update items in a SharePoint list.</td>
</tr>
<tr>
<td><strong>Delete Items</strong></td>
<td>Sets whether the generator creates components to delete items in a SharePoint list.</td>
</tr>
<tr>
<td><strong>Search Items</strong></td>
<td>Sets whether the generator creates components to search existing items in a SharePoint list.</td>
</tr>
<tr>
<td><strong>Generate Lists Data Types for update components</strong></td>
<td>Declares whether the generator creates the data types that are used in the generated update components. These data types are created based on the properties for the items in the target lists.</td>
</tr>
<tr>
<td><strong>Generate Lists Data Types for query components</strong></td>
<td>Declares whether the generator creates the data types that are used in the generated query components. These data types are created based on the properties for the items in the target lists.</td>
</tr>
<tr>
<td><strong>Namespace</strong></td>
<td>The component namespace that is used to identify data from the generated component library. The namespace serves to differentiate data if you have another identically named data type.</td>
</tr>
<tr>
<td><strong>Components Category</strong></td>
<td>The category in the component toolbox in which the generated components appear. You can add subcategories in the following format: category.subcategory.</td>
</tr>
</tbody>
</table>
Table 13-19 Properties on the Components page (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lists WebService URL</td>
<td>The way the generated components access the connection string. The generated components can access the connection string in one of the following ways:</td>
</tr>
<tr>
<td></td>
<td>- Populate into component Populates the connection string into a property in the generated components.</td>
</tr>
<tr>
<td></td>
<td>- Use project property Uses an existing project property as the connection string. See “About project properties” on page 191. If you use this option, set the name of the project property in the Project Property Name property.</td>
</tr>
<tr>
<td></td>
<td>- Use and populate Project property Uses an existing project property and populates it with the connection string that you set for the Project Property Name project property.</td>
</tr>
<tr>
<td></td>
<td>- Leave blank Does not provide a connection string for the generated components. Use this option if you want to set the connection string in the component editor of each component individually.</td>
</tr>
<tr>
<td></td>
<td>- Project Property Name The name of the project property that contains the connection string. This project property is automatically added to your project when you add one of the generated components to the workspace.</td>
</tr>
</tbody>
</table>

About the Fixed Length generator

The Fixed Length generator creates data types and read and write components based on a specific fixed-length file. Fixed-length files are the plain text files that have the values that are a certain number of characters long. Fixed-length information can be user data (such as names, email addresses, and so forth), impersonal data such as dates, and other static format data. The Fixed Length-type generator wizard guides you through the process of creating a data type specific to your data.

See “Null strings page” on page 288.

See “Date masks page” on page 288.
See “Read/Write components page” on page 289.
See “Definitions Editing page” on page 289.
After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them.
See “Importing components into a project” on page 215.

File selecting page for Fixed Length generator

The File Selecting page is a page in the Fixed Length generator wizard. On this page the incoming fixed-length data file is parsed into field definitions.
Select **First row is field names** if you want to make the field names the first row in the file.
See “About the Fixed Length generator” on page 287.

Null strings page

The Null strings page is a page in the Fixed Length generator wizard. It lets you declare which strings should be considered null and what the default value for null fields should be. You set the null values by data type.
See “About the Fixed Length generator” on page 287.

Table 13-20: Properties on the Null strings page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logical Types</td>
<td>The available data types. Because each data type can have a different null value, set the null strings and value for each data type.</td>
</tr>
<tr>
<td>Null strings</td>
<td>The strings that are recognized as null. You can add none, one, or multiple null strings. Add all of the strings that should be treated as null values.</td>
</tr>
<tr>
<td>Default value</td>
<td>The default value to use for null fields.</td>
</tr>
</tbody>
</table>

Date masks page

The Date masks page is a page in the Fixed Length generator (extended) wizard. It is an optional page. On this page you set the format for the dates that are in the fixed-length file.
For example, if your fixed-length file uses the format `mm/dd/yyyy`, enter this value.
See “About the Fixed Length generator” on page 287.

Read/Write components page

The Read/Write components page is a page in the Fixed Length generator wizard. It lets you set properties for the read and write components.

See “About the Fixed Length generator” on page 287.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Namespace</td>
<td>The component namespace that is used to identify the generated component library. The namespace serves to differentiate data if you have another identically named library.</td>
</tr>
<tr>
<td>Type Name</td>
<td>The data type that is used to handle the data from the generated components.</td>
</tr>
<tr>
<td>Read Component Name</td>
<td>The name of the read components that this generator creates.</td>
</tr>
<tr>
<td>Write Component Name</td>
<td>The name of the write components that this generator creates.</td>
</tr>
</tbody>
</table>

Definitions Editing page

The Definitions Editing page is a page in the Fixed Length generator wizard. This optional page lets you edit the names of the columns before you generate components. It requires you to declare a name for every column if one is not already declared.

See “About the Fixed Length generator” on page 287.

About the Fixed Length generator (extended)

The extended Fixed Length File generator has the same functionality as the regular Fixed Length File generator. However, the Fixed Length File (extended) generator does not require you to use an existing file. Instead of using an existing file, you enter definitions for the entries in the file.

The generator uses the values that you enter to create a data type that is used in the components that it creates. With the regular Fixed Length File generator, this data type is created with the entries in the existing file.
After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them.

See “Importing components into a project” on page 215.

Definitions Editing page

The Definitions Editing page is a page in the Fixed Length file generator (extended) wizard. This optional page lets you edit the names of the columns before you generate components. It requires you to declare a name for every column if one is not already declared.

See “About the Fixed Length generator (extended)” on page 289.

Null strings page

The Null strings page is a page in the Fixed Length generator (extended) wizard. It lets you declare which strings should be considered null and what the default value for null fields should be. You set the null values by data type.

See “About the Fixed Length generator (extended)” on page 289.

Table 13-22 Properties on the Null strings page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logical Types</td>
<td>The available data types. Because each data type can have a different null value, set the null strings and value for each data type.</td>
</tr>
<tr>
<td>Null strings</td>
<td>The strings that are recognized as null. You can add none, one, or multiple null strings. Add all of the strings that should be treated as null values.</td>
</tr>
<tr>
<td>Default value</td>
<td>The default value to use for null fields.</td>
</tr>
</tbody>
</table>

Date masks page

The Date masks page is a page in the Fixed Length generator (extended) wizard. It is an optional page. On this page you set the format for the dates that are in the fixed-length file.
For example, if your fixed-length file uses the format mm/dd/yyyy, enter this value.

See “About the Fixed Length generator (extended)” on page 289.

Read/Write components page

The Read/Write components page is a page in the Fixed Length generator (extended) wizard. It lets you set the properties for the read and write components.

See “About the Fixed Length generator (extended)” on page 289.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Namespace</td>
<td>The component namespace that is used to identify the generated component library. The namespace differentiates data if you have another identically named library.</td>
</tr>
<tr>
<td>Type Name</td>
<td>The data type that is used to handle the data from the generated components.</td>
</tr>
<tr>
<td>Read Component Name</td>
<td>The name of the read components that this generator creates.</td>
</tr>
<tr>
<td>Write Component Name</td>
<td>The name of the write components that this generator creates.</td>
</tr>
</tbody>
</table>

About the Separated Values generator

This generator lets you create the components that work with separated values files. Separated values files refer to plain text files (usually .csv files) that have a series of values that are separated by a delimiter. A comma is a common delimiter.

The Separated Values generator uses a file that you specify as a template. The generator reads the file and creates a data type and components based on the contents of the file.

See “Definitions page” on page 292.
See “Null strings page” on page 292.
See “Date masks page” on page 293.
See “Read/Write components page” on page 293.
See “Definitions Editing page” on page 294.
After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them. See “Importing components into a project” on page 215.

Definitions page

The Definitions page is a page in the Separated Values generator wizard. On this page you set the separated values file and some information about the contents of the file.

See “About the Separated Values generator” on page 291.

Table 13-24 Properties on the Definitions page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileName</td>
<td>The name of the file that is used as a template for the data type and components that this generator creates. This file is a plain text file (usually a .csv file) that has a series of values. A delimiter separates the values. A comma is a common delimiter. Separated values files should not be confused with Fixed Length files. See “About the Fixed Length generator” on page 287.</td>
</tr>
<tr>
<td>First row is field name</td>
<td>Sets whether the first row in the separated values file contains the names of the fields in the file. For example, the first row in your separated values file can represent field names like Name and DOB. The generator uses the values that are in the first row of your file as the property names in the data type that it creates.</td>
</tr>
<tr>
<td>Separator</td>
<td>The delimiter character that separates each value in the file.</td>
</tr>
<tr>
<td>Default Encoding</td>
<td>The type of text encoding your separated values file uses.</td>
</tr>
</tbody>
</table>

Null strings page

The Null strings page is a page in the Separated Values generator wizard. It lets you declare which strings should be considered null and what the default value for null fields should be. You set the null values by data type.

See “About the Separated Values generator” on page 291.
Table 13-25  Properties on the Null strings page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logical types</td>
<td>The data types for which you can set null string values. Because each data type can have a different null value, set the null strings and value for each data type.</td>
</tr>
<tr>
<td>Null strings</td>
<td>The strings that are recognized as null. You can add none, one, or multiple null strings. Add all the strings that should be treated as null values.</td>
</tr>
<tr>
<td>Default value</td>
<td>The default value to use for null fields.</td>
</tr>
</tbody>
</table>

Date masks page

The Date masks page is a page in the Separated Values generator wizard. It is an optional page. On this page you set the format for the dates that are in the separated values file.

For example, if your file uses the format `mm/dd/yyyy` for dates, enter this value.

See “About the Fixed Length generator” on page 287.

Read/Write components page

The Read/Write components page is a page in the Separated Values generator wizard. It lets you set properties for the read and write components.

See “About the Excel generator” on page 280.

Table 13-26  Properties on the Read/Write components page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Namespace</td>
<td>The component namespace that is used to identify data from the generated component library. The namespace differentiates data if you have another identically named data type.</td>
</tr>
<tr>
<td>Type Name</td>
<td>The data type that is used to handle the data from the generated components.</td>
</tr>
<tr>
<td>Read Component Name</td>
<td>The name of the read component.</td>
</tr>
<tr>
<td>Write Component Name</td>
<td>The name of the write component.</td>
</tr>
</tbody>
</table>
Definitions Editing page

The Definitions Editing page is a page in the Separated Values generator wizard. On this page you check the definitions that were set for the field names on the Definitions page. You can change the definitions if they are not correct.

If no field names exist, you can enter them on this page. Type all of the field names that exist in your separated values file. For example, if your file contains field names like *Name* and *DOB*, type those names. Also, set a data type for each field.

Errors appear at the bottom of the page.

See “About the Separated Values generator” on page 291.

About the Separated Values generator (extended)

The Separated Values generator (extended) has the same functionality as the regular Separated Values generator. However, it does not require a file.

See “About the Separated Values generator” on page 291.

After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them.

See “Importing components into a project” on page 215.

About the LDAP generator

The LDAP generator has the same functionality as the Active Directory generator.

See “About the Active Directory generator” on page 283.

About the Web Service Caller generator

This generator lets you create the components that make calls to user-specified Web services. With this generator, you can use specific methods in the Web Service Description Language (WSDL). The components that this generator creates can communicate with, post requests to, and read responses from dynamic Web services.

See “Select URLs page” on page 295.
See “Namespaces and Categories page” on page 295.
See “Select components page” on page 297.
See “Properties page” on page 297.
After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them. See “Importing components into a project” on page 215.

Select URLs page

The Select URLs page is a page in the Web Service Caller generator wizard. On this page you configure the Web service that the components that this generator creates uses.

See “About the Web Service Caller generator” on page 294.

Table 13-27  Properties on the Select URLs page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Source Type</strong></td>
<td>The type of Web service that you want to use. You may need to configure additional properties depending on which type of Web service you choose.</td>
</tr>
<tr>
<td></td>
<td>The following list describes each option:</td>
</tr>
<tr>
<td></td>
<td>■ <strong>Process Manager Directory Service</strong></td>
</tr>
<tr>
<td></td>
<td>Uses a Process Manager Directory Web service.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>WSDL File</strong></td>
</tr>
<tr>
<td></td>
<td>Uses a WSDL file.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>URL with authentication</strong></td>
</tr>
<tr>
<td></td>
<td>Uses a Web service with an accessible URL that requires authentication.</td>
</tr>
<tr>
<td></td>
<td>■ <strong>URL</strong></td>
</tr>
<tr>
<td></td>
<td>A Web service with an accessible URL that does not require authentication.</td>
</tr>
<tr>
<td><strong>URL</strong></td>
<td>The URL of the Web service that you want to use.</td>
</tr>
<tr>
<td><strong>Select known types manually</strong></td>
<td>Sets whether you manually select data types for the Web service data types. If you do not turn on this setting, the generator creates a data type to handle the Web service data.</td>
</tr>
</tbody>
</table>

Namespaces and Categories page

The Namespaces and Categories page is a page in the Web Service Caller generator wizard. On this page you configure naming options for the components that this generator creates. You also set information about where the Web service URL is stored for use by the component in your process.
See “About the Web Service Caller generator” on page 294.

Table 13-28 Properties on the Namespaces and Categories page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Namespace</td>
<td>The component namespace that is used to identify data from the generated component library. The namespace differentiates data if you have another identically named data type.</td>
</tr>
<tr>
<td>Default Category</td>
<td>The category in the component toolbox in which the generated components appear. You can add subcategories in the following format: category.subcategory.</td>
</tr>
<tr>
<td>Default Web Service URL</td>
<td>The URL that the generated components use by default. This URL should be the same as the URL that you configured on the Select URLs page.</td>
</tr>
<tr>
<td></td>
<td>See “Select URLs page” on page 295.</td>
</tr>
<tr>
<td>Name Pattern</td>
<td>The naming pattern that this generator uses when it creates the Web service components. By default it uses a &lt;methodname&gt;Component pattern. This means that each component is named with the name of the Web service method and the word Component (for example, GetUsersComponent).</td>
</tr>
<tr>
<td>Generate code for HTTP Proxy</td>
<td></td>
</tr>
</tbody>
</table>
Table 13-28 Properties on the Namespaces and Categories page (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default URL Generation</td>
<td>Sets how the generated components access the Web service URL.</td>
</tr>
<tr>
<td>■ Populate into component</td>
<td>Populates the Web service URL into a property in the generated components.</td>
</tr>
<tr>
<td>■ Use project property</td>
<td>Uses an existing project property for the Web service URL.</td>
</tr>
<tr>
<td>See “About project properties” on page 191.</td>
<td>If you use this option, set the name of the project property in the Project Property Name property.</td>
</tr>
<tr>
<td>■ Use and populate Project property</td>
<td>Uses an existing project property and populates it with the Web service URL that you set in the Default Web Service URL property.</td>
</tr>
<tr>
<td>■ Leave blank</td>
<td>Does not provide a Web service URL for the generated components. Use this option if you want to set the connection string in each individual component editor.</td>
</tr>
<tr>
<td>Security</td>
<td>Lets you enable and configure Web service security.</td>
</tr>
</tbody>
</table>

Select components page

The Select components page is a page in the Web service Caller generator wizard. On this page you select the components that you want the generator to create. In the right pane, select all of the components that you want to create. The names of the components reflect their respective Web service methods unless you changed the Name Pattern property on the Namespaces and Categories page. See “Namespaces and Categories page” on page 295. You can click Test to test each component. See “About the Web Service Caller generator” on page 294.

Properties page

The Properties page is a page in the Web service Caller generator wizard. On this page you can change the name of the data variables that appear as component properties in the generated components. Each data variable represents a value
from the Web service. You can click on the property name in the After column and change it.

See “About the Web Service Caller generator” on page 294.

About the User Defined Type with Database Mapping generator

This generator lets you create the user-defined object-relational mapping data types that you can use in your projects. This generator does not create components like most of the other generators. Instead, it creates user-defined object relational mapping data types.

See “About object-relational mapping (ORM) data types” on page 194.

Database mapping refers to a special feature of Workflow Designer. Object-relational mapping data types communicate with a database. The data in the data type is mapped to the data in the database so that the two sets of data have the same value. This mapping is accomplished through exchanges in SymQ.

See “About SymQ” on page 639.

After you create a data type with the User Defined Type with Database Mapping editor, you can import that data type into your project.

See “Importing components into a project” on page 215.

Workflow Designer by default has hundreds of the data types that you can use in your projects. You can also use the User Defined Type with Database Mapping generator to create new data types. With this generator you can create complex data types with database mapping that you can use in your projects immediately.

Complex data types are the data objects that can contain properties. Properties are individual values within the data type. A data type can have an unlimited number of properties. With the User Defined Type with Database Mapping generator you can create data types and configure them with properties.

You can also add entire data types to other data types as if they were properties. You can embed an unlimited number of data types in other data types.

You can add assemblies to the generator so that you can use them when you create data types and properties. By adding assemblies, you can use custom data types in the data types that you create. For example, you can set a property to use a custom data type if you added the assembly for that data type. You can add assemblies only when you first open the generator wizard.

See “Types Designer page” on page 304.

See “Settings page” on page 306.
Types Designer page

The Types Designer page is a page in the User Defined Type with Database Mapping generator wizard. On this page you create new data types and configure them with properties.

The Add option lets you add a new data type, a choice list, or a sub data type to an existing data type.

See “About the User Defined Type generator” on page 303.

The following table describes these terms:

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Type</td>
<td>A regular data type that you can create and then configure with properties.</td>
</tr>
<tr>
<td>Sub Data Type</td>
<td>A data type that is embedded in another data type. This option is available after you create at least one primary data type.</td>
</tr>
<tr>
<td>Choice List</td>
<td>An enumerated type. Create a choice list if you want to create a data type with the properties that only accept the values that you specify.</td>
</tr>
</tbody>
</table>

See “Adding a data type in the user-defined type with database mapping generator” on page 299.

See “Adding a property to a data type in the user-defined type with database mapping generator” on page 300.

See “Adding a sub data type to a data type in the user-defined type generator” on page 301.

See “Adding a choice list in the user-defined type generator” on page 302.

Adding a data type in the user-defined type with database mapping generator

You can add a data type in the Types Designer page of the User Defined Type with Database Mapping generator. All of the data types have default data: Base Type, and Attributes. You do not need to edit this data.

See “Types Designer page” on page 299.

To add a data type

1. In the Types Designer page of the User Defined Type generator, click Add > Add Data Type.

2. Type a name for the data type.
3 Set the **Base Type** property.

Use the default setting (**AbstractRelationalMappingObject**) unless you want to use an existing data type for the base type. The base type sets

4 Set the **Override TableName** property.

This property applies only if the target database table already exists and has a name that is different from the name of the data type. If you want to use the table name that is set in the database, do not turn on this property. If you want to overwrite the name of the table with the name of this data type, turn on this property.

5 Click **OK**.

---

**Adding a property to a data type in the user-defined type with database mapping generator**

In the Types Designer page of the User Defined Type with Database Mapping generator, you can add a property to a data type.

See “**Types Designer page**” on page 299.

**To add a property to a data type**

1 In the Types Designer page of the User Defined Type generator, click on the data type to which you want to add a property.

2 Click **Add Property**.
3 Type a name for the property, and set its properties.

The following table describes the properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The data type of the property. If you want to use a data type that is not available in the list, you can import it in an assembly. See “Adding an assembly to a generator” on page 262.</td>
</tr>
<tr>
<td>Elements</td>
<td>Sets whether the property is a single value or an array.</td>
</tr>
<tr>
<td>Override Field Name</td>
<td>Sets whether the name of the property overwrites the name of the column with the name of this property. This property applies only if the target column already exists and has a name that is different from the name of the property. If you turn on this property, enter a name in the Field Name property.</td>
</tr>
<tr>
<td>Override Type Converter</td>
<td>Sets whether the generator uses a type converter other than the default. By default the generator uses the GenericRelationalMappingFieldConverter. If you turn on this property, set a new type converter.</td>
</tr>
<tr>
<td>Override SQL Data Type</td>
<td>Sets whether the property uses a SQL data type other than the default. The default SQL data type appears in the SQL Date Type Read Only property. If you turn on this property, set a new SQL data type for this property to use.</td>
</tr>
<tr>
<td>SQL Date Type</td>
<td>The SQL data type that this property uses.</td>
</tr>
<tr>
<td>Indexed</td>
<td>Creates a database index on the field. This option improves the query performance when you query by the field if your table contains a large amount of data.</td>
</tr>
</tbody>
</table>

4 Click OK.

The property appears underneath the data type that contains it.

**Adding a sub data type to a data type in the user-defined type generator**

In the Types Designer page of the User Defined Type with Database Mapping generator, you can add a sub data type. This option is available after you create at least one primary data type.
See “Types Designer page” on page 299.

To add a sub data type to a data type

1 In the Types Designer page of the User Defined Type with Database Mapping generator, click **Add > Add Sub Data Type**.

2 Click on the primary data type to which you want to add the sub data type.

3 Type a name for the sub data type.

4 Set the **Base Type** property.

   Use the default setting is **AbstractRelationalMappingObject** unless you want to use an existing data type for the base type.

5 Set the **Override Table Name** property.

   This property applies only if the target database table already exists and has a name that is different from the name of the data type. If you want to use the table name that is set in the database, do not turn on this property. If you want to overwrite the name of the table with the name of this data type, turn on this property.

6 Click **OK**.

   The new sub data type appears in the right pane under the primary data type.

Adding a choice list in the user-defined type generator

In the Types Designer page of the User Defined Type with Database Mapping generator, you can add a choice list.

See “Types Designer page” on page 299.

To add a choice list

1 In the Types Designer page of the User Defined Type generator, click **Add > Add Choice List**.

2 Type a name for the choice list, and then click **Add**.

   The new choice list appears in the right pane.

Indexes page

The Indexes page is a page in the User Defined Type with Database Mapping generator wizard. This page is optional. On this page you can add indexes to the properties that you created on the Types Designer page.

See “Types Designer page” on page 299.
The indexes that you can add on this page create indexes for columns in the SQL table. The properties that you created on the Types Designer page represent columns in the SQL table. When you add indexes to those properties in the Indexes page, you add indexes to their corresponding columns.

See “About the User Defined Type with Database Mapping generator” on page 298.

**Settings page**

The Settings page is a page in the User Defined Type with Database Mapping generator wizard. On this page you set the namespace and category of the user-defined type that you created.

The namespace refers to a naming scheme that is used to identify the generated component library. The namespace differentiates the library if you have another identically named library.

The category refers to the category in the component toolbox in which the generated components appear. You can add subcategories in the following format: `category.subcategory`.

See “About the User Defined Type with Database Mapping generator” on page 298.

**Components page**

The Components page is a page in the User Defined Type with Database Mapping generator wizard. On this page you select the data types for which you want to create components.

See “About the User Defined Type with Database Mapping generator” on page 298.

**About the User Defined Type generator**

This generator lets you create the user-defined types that you can use in your projects. The User Defined Type generator does not create components like most of the other generators. Instead, it creates user-defined types.

After you create a data type with the User Defined Type editor, you can import that data type into your project to use it.

See “Importing components into a project” on page 215.

Workflow Designer by default has hundreds of data types to use in your projects. You can also use the User Defined Type generator to create a new data type. With this generator you can create complex data types to use in your projects immediately.

Complex data types are the data objects that can contain properties. Properties are individual values within the data type. A data type can have an unlimited number
of properties. With the User Defined Type generator, you can create data types and configure them with properties.

You can also add entire data types to other data types as if they were properties. You can embed an unlimited number of data types in other data types.

You can add assemblies to the generator so that you can use them when you create data types and properties. By adding assemblies, you can use custom data types in the data types that you create. For example, you can set a property to use a custom data type if you added the assembly for it. You can add assemblies after you open the generator wizard.

See “Types Designer page” on page 304.
See “Settings page” on page 306.

Types Designer page

The Types Designer page is a page in the User Defined type generator wizard. On this page you create new data types and configure them with properties.

The Add option lets you add a new data type, a choice list, or a sub data type to an existing data type.

See “About the User Defined Type generator” on page 303.

The following table describes these terms:

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data Type</strong></td>
<td>A regular data type that you can create and then configure with properties.</td>
</tr>
<tr>
<td><strong>Sub Data Type</strong></td>
<td>A data type that is embedded in another data type. This option is available after create at least one primary data type.</td>
</tr>
<tr>
<td><strong>Choice List</strong></td>
<td>An enumerated type. Create a choice list if you want to create a data type with the properties that only accept the values that you specify.</td>
</tr>
</tbody>
</table>

See “Adding an assembly to a generator” on page 262.
See “Adding a data type in the user-defined type generator” on page 305.
See “Adding a property to a data type in the user-defined type generator” on page 305.
See “Adding a sub data type to a data type in the user-defined type generator” on page 305.
See “Adding a choice list in the user-defined type generator” on page 302.
Adding a data type in the user-defined type generator

In the Types Designer page of the User Defined Type generator, you can add a data type. All of the data types have default data: **Base Type**, and **Attributes**. You do not need to edit this data.

See “Types Designer page” on page 304.

To add a data type

1. In the Types Designer page of the User Defined Type generator, click **Add > Add Data Type**.
2. Type a name for the data type, and then click **Add**.
   
   The new data type appears in the right pane.

Adding a property to a data type in the user-defined type generator

In the Types Designer page of the User Defined Type generator, you can add a property to a data type that you have created.

See “Types Designer page” on page 304.

To add a property to a data type

1. In the Types Designer page of the User Defined Type generator, click on the data type to which you want to add a property.
2. Click **Add Property**.
3. Type a name for the property, and set its simple data type.
4. Click **Add**.
   
   The property appears below the data type that contains it.

Adding a sub data type to a data type in the user-defined type generator

In the Types Designer page of the User Defined Type generator, you can add a sub data type. This option is available after you create at least one primary data type.

See “Types Designer page” on page 304.
To add a sub data type to a data type

1. In the Types Designer page of the User Defined Type generator, click Add > Add Sub Data Type.
2. Click on the primary data type to which you want to add the sub data type.
3. Type a name for the sub data type, and then click Add.

The new sub data type appears in the right pane under the primary data type.

Settings page

The Settings page is a page in the User Defined Type generator wizard. On this page you set the namespace of the user-defined type that you created.

The namespace refers to a naming scheme that is used to identify the generated component library. The namespace differentiates the library if you have another identically named library.

See “About the User Defined Type generator” on page 303.

About the Custom Workflow Interaction generator

The Custom Workflow Interaction generator lets you create a workflow component with multiple output paths. The component that this generator creates is very similar to the Approval Workflow component and the Dialog Workflow component.

Symantec recommends that you use the Dialog Workflow component with this generator instead of the Approval Workflow component or a component that you create. However, you must design a Web form if you use the Dialog Workflow component and you want to include a form. The components that you create with the Custom Workflow Interaction generator do not require you to design a Web form. The component creates a form automatically. You define what data the form expects and what outcome paths it has.

At run-time the component creates an unstylized HTML page in which the user enters data.

See “General Information page” on page 307.
See “Expose Data From Component page” on page 307.
See “Result Paths page” on page 307.

After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them.

See “Importing components into a project” on page 215.
General Information page

The General Information page is a page in the Custom Workflow Interaction generator wizard. On this page you set the name and other settings for the component that this generator creates.

See “About the Custom Workflow Interaction generator” on page 306.

Table 13-29  Properties on the General Information page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component Name</td>
<td>The name of the custom workflow component that you want to create. Provide</td>
</tr>
<tr>
<td></td>
<td>a name that expresses the purpose of the component. For example, if you</td>
</tr>
<tr>
<td></td>
<td>create a component that includes survey questions, you can name your</td>
</tr>
<tr>
<td></td>
<td>component SurveyQuestions.</td>
</tr>
<tr>
<td>Component Namespace</td>
<td>The component namespace that is used to identify the generated component</td>
</tr>
<tr>
<td></td>
<td>library. The namespace differentiates the library if you have another</td>
</tr>
<tr>
<td></td>
<td>identically named library.</td>
</tr>
<tr>
<td>Allow complex types</td>
<td>Sets whether your component accepts complex data types.</td>
</tr>
</tbody>
</table>

Expose Data From Component page

The Expose Data From Component page is a page in the Custom Workflow Interaction generator wizard. On this page you set the data variables that you expect users to enter on the form.

You can add and configure as many variables as you want.

See “About the Custom Workflow Interaction generator” on page 306.

Result Paths page

The Result Paths page is a page in the Custom Workflow Interaction generator wizard. On this page you set the outcome paths for the form and a data definition for each outcome path. The data definitions refer to the data variables that each path uses for its output data.

See “About the Custom Workflow Interaction generator” on page 306.

About the WCF Service Caller generator

After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them.
About the ASDK Component generator

The ASDK generator runs after it is installed, and it creates components out of ASDK method calls. ASDK methods change less frequently than tasks and resources. However, you must regenerate a component after you make any changes to an ASDK method that the component contains.

See "Running the Symantec Management Platform component generators" on page 573.

See “Symantec workflow component generators” on page 261.

About the ASDK Tasks Component generator

The Task generator runs after it is installed. It gathers ASDK tasks on the Symantec Management Console. A task is an action that is taken on a resource or a collection of resources. Tasks are managed in the Symantec Management Console. The components that are generated must be regenerated to reflect changes from the Symantec Management Console.

See "Running the Symantec Management Platform component generators" on page 573.

See “Symantec workflow component generators” on page 261.

About the Reports Component generator

The Report runs after it is installed. It gathers all of the reports that are available in the Symantec Management Console. For every report that is available, one component is created. Each report component represents a SQL query that retrieves and stores structured data back in a collection within a workflow.

See “Running the Symantec Management Platform component generators” on page 573.

See “Symantec workflow component generators” on page 261.

About the Resource Component generator

The Resource generator runs during installation. It gathers all of the resources that are available on the Symantec Management Console. A resource is usually a tangible item such as a computer, telephone, or printer. A resource has data and
associations to other resources on the Symantec Management Console. Resources are managed in the Symantec Management Console. The components that are generated must be regenerated to reflect changes from the Symantec Management Platform.

See “Running the Symantec Management Platform component generators” on page 573.

See “Symantec workflow component generators” on page 261.

About the .NET Library generator

The .NET Library generator generates the components that execute .NET code in a DLL. After you select a DLL and a class or method that you want to use, this generator creates a custom component. This component can invoke and leverage code in the selected DLL. You can invoke the properties and methods of other components using the components that you created with this generator.

After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them.

See “Importing components into a project” on page 215.

About the Script generator

The Script generator component generates the components that run user-specified C# code.

See “Input page” on page 309.

See “Static Variables page” on page 310.

See “Result Paths page” on page 310.

See “General Information page” on page 310.

See “Script Code page” on page 311.

After you create custom components, you can use them in your workflow projects. You must import the custom components into your project before you can use them.

See “Importing components into a project” on page 215.

Input page

The Input page is a page in the Script generator wizard. On this page you create input variables for your component. The variables that you configure on this page
appear as input boxes in the component editor of the component that this generator creates. You can create an unlimited number of input variables.
Create all of the input variables that you want to exist in your script component.
See “About the Script generator” on page 309.

Static Variables page
The Static Variables page is a page in the Script generator wizard. On this page you create static variables for your script component. You can create an unlimited number of static variables.
See “About the Script generator” on page 309.

Result Paths page
The Result Paths page is a page in the Script generator wizard. On this page you create outcome paths for your script component.
By default the generator is set to use Single Path, which means that your script component has only one outcome path. If you change the setting to Multiple Paths, you can configure more than one outcome path.
See “About the Script generator” on page 309.

<table>
<thead>
<tr>
<th>Table 13-30</th>
<th>Properties on the Result Paths page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Property</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Path Name</td>
<td>The name of an outcome path that you want to add to your script component. After you enter a name, click Add New Output Path to add it.</td>
</tr>
<tr>
<td>Output Paths</td>
<td>The outcome paths for your script component.</td>
</tr>
<tr>
<td>Add New Output Path</td>
<td>Adds the name of the outcome path that you entered in Path Name.</td>
</tr>
<tr>
<td>Remove Selected Output Path</td>
<td>Removes the selected outcome path.</td>
</tr>
</tbody>
</table>

General Information page
The General Information page is a page in the Script generator wizard. On this page you set the name and other settings for the component that this generator creates.
See “About the Script generator” on page 309.

Table 13-31 Properties on the General Information page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Component Name</strong></td>
<td>The name of the custom workflow component that you want to create. Provide a name that expresses the purpose of the component. For example, if you create a component that reads a file, you can name your component <em>CustomReadFile</em>.</td>
</tr>
<tr>
<td><strong>Component Namespace</strong></td>
<td>The component namespace that is used to identify the generated component library. The namespace serves to differentiate the library if you have another identically named library.</td>
</tr>
</tbody>
</table>

**Script Code page**

The Script Code page is a page in the Script generator wizard. On this page you write the script code for your component.

The input and static variables that you configured appear at the top of the Script Code page. You do not need to edit these values on this page. If you want to edit these values, return to the Input page and Static Variables page.

See “Input page” on page 309.

See “Static Variables page” on page 310.

Enter your script code in the right pane of the Script Code page. Use C# code.

See “About the Script generator” on page 309.
Working with Webforms

This chapter includes the following topics:

- About Web forms
- About creating a Web form
- About using data to build a Web form
- About ThisFormData
- Setting up a custom event on a form
- About form components
- About themes
- Adding a theme to a form
- Editing a form theme
- Creating a form theme
- About form theme best practices
- About themes in Workflow Solution 8.0
- About form templates
- Creating a form template
- Applying a form template
About Web forms

You can build Web forms in Workflow Designer and use them in your workflow processes. Workflow Designer includes the components that let you build Web forms. These Web forms are fully customizable.

The components that let you build Web forms are as follows:

- **Form Builder**: The most common Web forms component in Workflow Designer. Use the Form Builder component as your basic Web forms component. This component includes all of the forms controls that you can use to create a form.

- **Terminating Form Builder**: A Web forms component that shows a final screen. Unlike the Form Builder component, this component does not require you to add an outcome path. When a form in this component is displayed at run-time, the process continues to the next component. The process does not wait for the user to exit the form.

The Form Builder and Terminating Form Builder components are not available in all project types.

You can use the Form Builder and Terminating Form Builder components in the following types of projects:

- **Webforms-type projects**: You can use the Form Builder or Terminating Form Builder components anywhere in Webforms-type projects. See “About Forms (Web) Project Types” on page 150.

- **A Dialog Workflow component in a Workflow-type project**: You cannot use the Form Builder or Terminating Form Builder components in the primary model of a Workflow-type project. However, you can use these Web forms components in the dialog model of a Dialog Workflow component.

About creating a Web form

You can create a Web form in a Form Builder or Terminating Form Builder component in Workflow Designer.

See “About Web forms” on page 313.
Building a form is similar to building a workflow process. The form editor (in a Form Builder or Terminating Form Builder component) contains a component toolbox and a workspace. The component toolbox in a form editor contains different components than the component toolbox in the primary project model.

See “About form components” on page 316.

When you create a Web form, there are two main areas of design: functionality and appearance.

### Table 14-1  Functionality and appearance of a Web form

<table>
<thead>
<tr>
<th>Area of design</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Functionality</td>
<td>Form components such as buttons, text boxes, and radio buttons make up the functionality of your form. You can also add custom scripts to a form for additional functionality. See “Setting up a custom event on a form” on page 315.</td>
</tr>
<tr>
<td>Appearance</td>
<td>The appearance of your form is affected most by the theme that you apply to it. See “About themes” on page 365.</td>
</tr>
</tbody>
</table>

Typical principles of process building also apply to creating a Web form. Like regular workflow components, many form components (such as the List Select component) require data to perform their jobs. Like regular workflow components, form components also have component editors. You can edit any form component by double-clicking it.

You must configure the appearance and functionality of a form when you create a Web form. You may also need to configure the Web form component itself (either Form Builder or Terminating Form Builder component). These components also have the component editors that you can open when you right-click, and then click Edit Component.

### About using data to build a Web form

You use data to build a Web form as you use data in the primary project model. Some form components (such as the List Select component) have input and output data. You can use regular process data for the input data for a form component. You can also use the output data of a form component in the primary project model. Typical data rules apply. For example, you can use a form component’s output data only after the component is invoked in the process.
Web forms have one unique data feature: **ThisFormData**. With this feature, you can use the output data of form components when you configure other components on the same form.

See “About ThisFormData” on page 315.

### About ThisFormData

**ThisFormData** is a type of variable that is available to form components (such as Text Box). With **ThisFormData**, you can use the output data of form components when you configure other components on the same form. For example, if a Text Box component has an output variable that is called **Text1**, that variable appears in the form’s **ThisFormData**. You can use this variable in another component on the same form (such as the List Select component).

Use **ThisFormData** when you want to use a user-defined value on the same form in which the value is entered.

**ThisFormData** is especially useful when you use the **Post Form On Value Change** property on form components (such as Text Box). During run-time, a **ThisFormData** variable on the form does not appear until a user provides a value and the form refreshes. You can also use a Dynamic Update Panel to refresh only a section of the form.

See “Dynamic Update Panel” on page 358.

See “Common properties in form components” on page 316.

### Setting up a custom event on a form

Custom events refer to custom JavaScripts that you can implement on either individual form components (such as Text Box) or on the form itself. You can set custom events in the component editors of almost all of the form components and on any form itself.

To use a custom event, you must know what JavaScript you want to implement. Workflow Designer does not have any preconfigured custom events.

**Setting up a custom event on a form component**

1. In an open form component (such as Form Builder), add a component to the workspace (such as a Text Box).
2. Open the component’s editor by double-clicking it.
3. Under the **Functionality** tab, under **Custom Events**, click **Add**.
4. For the **Event** property, select when you want your custom event to be invoked.
5 For the Event Handler property, add the JavaScript.
6 Click OK to exit the editor.

Setting up a custom event on a form itself
1 In an open form component (such as Form Builder), right-click on the background of the form, and then click Edit Form.
2 Click on the Behavior tab.
3 Add a custom event, or add a general script that applies to the form when it loads.

You can add the following types of events:
- BodyCustomEvent (applies your script inside of the body tags of your form).
- FormCustomEvent (applies your script inside of the form tags of your form).
4 For the Script box, click the ... symbol, and then add your script.
5 Click OK.

About form components

Form components are the controls that you can use to design forms in components such as the Form Builder and Terminating Form Builder. You use form components exactly like regular process components, except you do not connect them to each other.

Some form components (such as the Button component) create an outcome path on the form builder component. Some form components (such as the Text Box component) do not create an outcome path on the form builder component. Also, some components (such as the Text Box component) have output data. Some components (such as the Line component) do not have output data.

Double-click on a form component to edit it.

See “About Web forms” on page 313.

Common properties in form components

All form components have some unique properties. However, most components share some properties.
### Table 14-2  Functionality tab common properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Output Paths              | The data settings for the form's outcome paths. For each outcome path, select one of the options for the component's output data. You can select one of the following options:  
  - Required  
    Requires the component to have output data for this outcome path. If you select this option, users cannot leave the form through this outcome path without providing a value.  
  - Optional  
    Does not require the component to have output data for this outcome path. The component exposes the data to the data stream if it exists.  
  - Ignored  
    Ignores the output data from the component on this outcome path. If you select this option, the component's output data is not available on the data stream at design-time or at run-time. |
| Output Data               | The name of the output variable from the component.                                                                                          |
| Post Form On Value Change | Declares whether the form refreshes when the value of the component is changed. Use this setting when you use a ThisFormData variable.  
  See “About ThisFormData” on page 315.                                                                                     |
| Optional Data Component IDs | The other components on the form that have optional output data for this component.                                                            |
| Required Data Component IDs | The other components on the form that have required output data for this component.                                                            |
| Custom Events             | Custom events for this component.  
  See “Setting up a custom event on a form” on page 315.                                                                                 |
| Ask Confirmation          | Sets whether a confirmation message appears when the user clicks an item. If you select this property, set the confirmation message to display to the user.   |
| Control ID                | A special ID you can give to this control. You can use control IDs when you create custom behavior for your forms, such as adding a script.       |
### Table 14-2  Functionality tab common properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab Index</td>
<td>The tab order for this component.</td>
</tr>
<tr>
<td>Tab Stop</td>
<td>Sets whether this component is in the tab order.</td>
</tr>
<tr>
<td>Visible</td>
<td>Sets whether the component is visible to the user at run-time.</td>
</tr>
<tr>
<td>Required error message</td>
<td>The message that users see when they do not provide the required data before they try to exit the form.</td>
</tr>
<tr>
<td>Use Custom Validation</td>
<td>Declares whether the component uses custom validation instead of using only the default validation.</td>
</tr>
<tr>
<td>Custom Validation Model</td>
<td>The model that defines the custom validation. The validation outcomes are set in the End components of this model.</td>
</tr>
</tbody>
</table>

### Table 14-3  Appearance tab common properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component Size</td>
<td>The size of the component as it appears at run-time, in pixels.</td>
</tr>
<tr>
<td>Overflow Behavior</td>
<td>How the component formats overflow content. You can select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>■ Overflow</td>
</tr>
<tr>
<td></td>
<td>This option lets overflow content run off of the display.</td>
</tr>
<tr>
<td></td>
<td>■ Clip</td>
</tr>
<tr>
<td></td>
<td>This option removes all of the overflow content. No data is lost with this option; it means only that some of the data is not displayed.</td>
</tr>
<tr>
<td></td>
<td>■ Scroll</td>
</tr>
<tr>
<td></td>
<td>This option adds a scroll bar to make the overflow content accessible.</td>
</tr>
<tr>
<td>Text</td>
<td>The text that appears on the component at run-time.</td>
</tr>
<tr>
<td>Style</td>
<td>The style of everything on the component. Style settings are optional.</td>
</tr>
<tr>
<td>Theme Style</td>
<td>The theme style for the component.</td>
</tr>
<tr>
<td></td>
<td>See “About themes” on page 365.</td>
</tr>
</tbody>
</table>
### Table 14-4  Settings tab common properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component Class Name</td>
<td>The component namespace.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of this instance of the component. This property is not the default description; it applies to only one instance of the component.</td>
</tr>
<tr>
<td>Location</td>
<td>The coordinates where this component is located in the workspace.</td>
</tr>
<tr>
<td>Name</td>
<td>A name for this instance of the component. This property is not the default name; it applies to only this instance of the component.</td>
</tr>
<tr>
<td>Override Background Color</td>
<td>Sets the background color for the component.</td>
</tr>
<tr>
<td>To Do</td>
<td>A property for saving a list of the work that you still need to do with the component. Use this field to help you remember what still needs to be done.</td>
</tr>
<tr>
<td>Is Enabled</td>
<td>Declares whether this component is active. If you do not want this component to function in the process, deselect this property.</td>
</tr>
</tbody>
</table>

### Auto Exit Page On Timer

The Auto Exit Page On Time component exits the page based on a user-defined timeframe. It does not close the browser window in which the form appears. Rather, it exists out of an outcome path that it creates on the form component. The Auto Exit Page On Timer component is an invisible component that runs in the background of a form. Use this component when you want to exit a form based on elapsed time. For example, on a form that displays the data that changes, you can use this component to refresh every five minutes. The process reenters the form and displays the refreshed data.

### Table 14-5  Properties on the Auto Exit Page On Timer component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path Name</td>
<td>The name of the outcome path that this component creates on the form component.</td>
</tr>
<tr>
<td>Refresh Minutes</td>
<td>How many minutes this component waits before it exits the page.</td>
</tr>
</tbody>
</table>
Table 14-5 Properties on the Auto Exit Page On Timer component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh Seconds</td>
<td>How many seconds this component waits before it exits the page.</td>
</tr>
<tr>
<td>Other properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Button Group

This component creates a group of buttons that output a single variable with a value based on the button that you clicked. Use this component when you want to quickly create a number of buttons.

When you first add this component to your form, you must provide the following properties:

- **Output data**
  The output data variable name.

- **Path Name**
  The button group outcome path.

Table 14-6 Properties in the Button Group component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path Name</td>
<td>The name of the outcome path that this component creates.</td>
</tr>
<tr>
<td>Optional Data Component IDs</td>
<td>The other components on the form that have optional output data for this component.</td>
</tr>
<tr>
<td>Required Data Component IDs</td>
<td>The other components on the form that have required output data for this component.</td>
</tr>
<tr>
<td>Output Data</td>
<td>The name of the output data variable.</td>
</tr>
</tbody>
</table>
### Table 14-6  Properties in the Button Group component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>The number of buttons and possible values.</td>
</tr>
<tr>
<td></td>
<td>Each item requires the following properties:</td>
</tr>
<tr>
<td></td>
<td>■ Value</td>
</tr>
<tr>
<td></td>
<td>The value that this button gives to this component’s output data variable.</td>
</tr>
<tr>
<td></td>
<td>■ Text</td>
</tr>
<tr>
<td></td>
<td>The text that appears on the button.</td>
</tr>
<tr>
<td></td>
<td>■ Image</td>
</tr>
<tr>
<td></td>
<td>The image that displays on the button. This property is not required.</td>
</tr>
<tr>
<td>Repeat Columns</td>
<td>Sets how the buttons are arranged in repeating columns.</td>
</tr>
<tr>
<td>Repeat Direction</td>
<td>Sets whether the button columns appear vertically or horizontally.</td>
</tr>
<tr>
<td>Other properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

### Drop Down Menu

This component displays a drop-down menu to a user in which each menu item has its own output path. You can configure this component to appear in a number of ways on the form: for example, an option, a link, or an image. You can also configure how many items appear in the drop-down menu.

Use this component when you want the process to exit the form immediately after the user clicks an item in the drop-down menu: for example, if you want the form to refresh with new data based on the item that the user selects in the drop-down menu. You can set the other components on the form to display values based on the value of the drop-down menu output.
Table 14-7  Properties in the Drop Down Menu component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Items</td>
<td>The items that appear in the drop-down list. Each item requires the following properties:</td>
</tr>
<tr>
<td></td>
<td>■ Path Name The name of the outcome path that is associated with this menu item.</td>
</tr>
<tr>
<td></td>
<td>■ Text The text of the menu item as it appears at run-time.</td>
</tr>
<tr>
<td>Menu Pop-up Position</td>
<td>Where the drop-down menu appears in relation to the drop-down option.</td>
</tr>
<tr>
<td>Menu Style</td>
<td>The style of the items that displays on the drop-down menu.</td>
</tr>
<tr>
<td>Menu Width</td>
<td>How wide the drop-down menu is in pixels.</td>
</tr>
<tr>
<td>Pop-up Menu Show Mode</td>
<td>Sets the action that reveals the drop-down menu.</td>
</tr>
<tr>
<td>Visual Mode</td>
<td>Sets what the drop-down menu option looks like at run-time.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Dynamic Button

This button component displays a drop-down menu to users. The items in the drop-down menu can be one of four types.

Table 14-8  Menu item types

<table>
<thead>
<tr>
<th>Item type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link</td>
<td>A link to a website.</td>
</tr>
<tr>
<td>Path</td>
<td>An outcome path on the main form component.</td>
</tr>
<tr>
<td>Alternate dialog</td>
<td>A secondary dialog model in a Dialog Workflow component.</td>
</tr>
<tr>
<td>Sub dialog</td>
<td>A secondary forms model in a dialog model.</td>
</tr>
</tbody>
</table>

Use the Dynamic Button component when you want to include a variety of responses in a single button. Because of its versatility, the Dynamic Button component can take the place of other button components.
When you configure the items for this component, you have many options. You can add items from one or more of the following data sources: process variables, constant values, multiple mapping, single mapping, or dynamic model.

The following list describes when you should use each of these options:

- **Process Variables**  
  Use this option when you have a variable in your process that you want to use as an item in the Dynamic Button component. The variable must be a `DynamicItem` data type variable.

- **Constant Values**  
  Use this option when you want to hard-code the items in the Dynamic Button component.

- **Multiple Mapping**  
  Use this option when you want to map an array of values into another array of values. Usually this option is used in cases where you want to use an array that is not of the `DynamicItem` data type.

- **Single Mapping**  
  Use this option when you want to map a single value into another single value. Usually this option is used in cases where you want to use a value that is not a `DynamicItem` data type.

- **Dynamic Model**  
  Use this option when you want to add a model in the Dynamic Button component that determines the items. In the dynamic model, use multiple End components with different item lists, and add decision components to determine which End component the model uses.
### Table 14-9  Properties in the Dynamic Button component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Items | The items that are available on the button during run-time. **Link** items require the following properties:  
  - **Item Type**  
    The functionality of the item. **Link** is a link to a website. **Path** is an outcome path on the main form component. **Alternate dialog** is a secondary dialog model in a Dialog Workflow component. And **Sub dialog** is a secondary forms model in a dialog model.  
  - **Text**  
    The text that labels the item in the drop-down list.  
  - **URL**  
    (Link only) The URL to the website for this item. **Path** items require the following properties:  
  - **Text**  
    The text that labels the item in the drop-down list.  
  - **Path Name**  
    The name of the path that this item creates on the main form component. **Alternate dialog** items require the following properties:  
  - **Text**  
    The text that labels the item in the drop-down list.  
  - **Open In New Window**  
    Sets whether the alternate dialog opens in another window.  
  - **Show Only Selected Responses**  
    Sets the alternate dialog to show only the selected responses.  
  - **Pass Process Manager Session ID**  
    Sets whether the alternate dialog uses the current Process Manager session ID.  
  - **Process Actions**  
    The names of the process actions in your Dialog Workflow component. **Sub dialog** items require the following properties:  
  - **Text**  
    The text that labels the item in the drop-down list.  
  - **Open In New Window**  
    Sets whether the alternate dialog opens in another window.  
  - **Post Current Data Before Opening**  
    Sets whether the data on the current form is exposed.  
  - **Window Title**  
    The title of the new window.  
  - **Forms Model**  
    The model that contains the form that opens when the user clicks this item. |
Table 14-9  Properties in the Dynamic Button component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Pop-up Position</td>
<td>Where the drop-down menu appears in relation to the drop-down button.</td>
</tr>
<tr>
<td>Menu Style</td>
<td>The style of the items that displays on the drop-down menu.</td>
</tr>
<tr>
<td>Menu Width</td>
<td>How wide the drop-down menu is in pixels.</td>
</tr>
<tr>
<td>Pop-up Menu Show Mode</td>
<td>Sets the action that reveals the drop-down menu.</td>
</tr>
<tr>
<td>Visual Mode</td>
<td>Sets what the drop-down menu button looks like at run-time.</td>
</tr>
</tbody>
</table>

Image Button

This component lets you use an image for a button on your form. The image can come from a number of sources (URL, file system, resource). This component has the same functionality as a regular button component.

Table 14-10  Properties in the Image Button component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path Name</td>
<td>The name of the outcome path.</td>
</tr>
<tr>
<td>Image Source</td>
<td>Sets where the image comes from.</td>
</tr>
<tr>
<td></td>
<td>You must configure one of the following settings based on the option that</td>
</tr>
<tr>
<td></td>
<td>you choose:</td>
</tr>
<tr>
<td></td>
<td>• Image URL</td>
</tr>
<tr>
<td></td>
<td>The URL from which this component gets its image.</td>
</tr>
<tr>
<td></td>
<td>For example: <a href="http://www.google.com/images/logo.gif">http://www.google.com/images/logo.gif</a></td>
</tr>
<tr>
<td></td>
<td>• File Data</td>
</tr>
<tr>
<td></td>
<td>The file path, name, type, and length of the image that is used in this</td>
</tr>
<tr>
<td></td>
<td>component.</td>
</tr>
<tr>
<td></td>
<td>• Resource</td>
</tr>
<tr>
<td></td>
<td>The project resource from which this component gets its image.</td>
</tr>
<tr>
<td></td>
<td>See “Project data tabs” on page 158.</td>
</tr>
<tr>
<td>Alternate Text</td>
<td>The text that is displayed if no image is found.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>
Image Map

This component lets you display an image with hot spots, which are the areas on the image that a user can click. The hot spot that the user clicks determines the Image Map's output data.

This component has only one output path. If you want the route to process based on the user's choice, use a Matches Rule component. Configure this component to evaluate the value of the output variable.

**Table 14-11** Properties in the Image Map component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path Name</td>
<td>The name of this component's outcome path.</td>
</tr>
<tr>
<td>Output Data</td>
<td>The name of the output variable. This variable has the value of the hot spot that the user clicks.</td>
</tr>
<tr>
<td>Image</td>
<td>The image that is used for the image map.</td>
</tr>
<tr>
<td>Alternate Text</td>
<td>The text that is displayed if no image is found.</td>
</tr>
<tr>
<td>Tool tip</td>
<td>The text that is displayed in the tool tip. The tool tip appears when the user hovers over the image.</td>
</tr>
<tr>
<td>Hot Spots</td>
<td>The map of the image that defines hot spots. Click the ... symbol to open the hot spot editor. In the hot spot editor, you can add rectangle and circle hot spots. The Name value in the lower left corner is the value for each hot spot. At run-time when the user clicks a hot spot, this value is used for the component output value.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Link Button

This component lets you use a link on your form that acts like a button. When a user clicks the link, the form exits through an output path.

When you first add this component to your form, you are prompted to provide a path name. The path name refers to the output path that this component creates out of the form.
Table 14-12  Properties in the Link Button component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path Name</td>
<td>The name of this component's outcome path.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Hover Button

This component displays a drop-down list of links when the user hovers on it. The Hover Button component is very similar to the Drop Down Menu component. However, the Hover Button component menu items are URLs, and they do not correspond to an outcome path on the form component.

Table 14-13  Properties in the Hover Button component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>The items that appear in the drop-down list. Each item requires the following properties:</td>
</tr>
<tr>
<td></td>
<td>■ Text</td>
</tr>
<tr>
<td></td>
<td>The text of the menu item as it appears at run-time.</td>
</tr>
<tr>
<td></td>
<td>■ URL</td>
</tr>
<tr>
<td></td>
<td>The name of the outcome path that is associated with this menu item.</td>
</tr>
<tr>
<td></td>
<td>■ Open In New Window</td>
</tr>
<tr>
<td></td>
<td>Sets whether the URL is accessed in a new window. If you do not select this option, the</td>
</tr>
<tr>
<td></td>
<td>website opens in the browser window workflow form when you click a menu item.</td>
</tr>
<tr>
<td>Menu Pop-up Position</td>
<td>Where the drop-down menu appears in relation to the drop-down button.</td>
</tr>
<tr>
<td>Menu Style</td>
<td>The style of the items that displays on the drop-down menu.</td>
</tr>
<tr>
<td>Menu Width</td>
<td>How wide the drop-down menu is in pixels.</td>
</tr>
<tr>
<td>Pop-up Menu Show Mode</td>
<td>Sets the action that reveals the drop-down menu.</td>
</tr>
<tr>
<td>Visual Mode</td>
<td>Sets what the drop-down menu button looks like at run-time.</td>
</tr>
</tbody>
</table>
Table 14-13  Properties in the Hover Button component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Spell Check Button

This component lets users check the spelling of a single text field on the form. You can use the Spell Check Button component with only the Text Box and Multiline Text Box components. You cannot use the Spell Check Button with the HTML editor or the specialized text components (such as Masked Edit and Auto Complete).

Use the Spell Check Button component when you want to add a spell check option to a single field. Usually this component is used in a link style, discreetly placed at the bottom of a large text box. The Spell Check Button component is similar to the Spell Check component.

See “Spell Check” on page 328.

Table 14-14  Properties in the Spell Check Button component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Component</td>
<td>The text box component that is checked for proper spelling.</td>
</tr>
<tr>
<td>Visual Mode</td>
<td>Sets what the button looks like at run-time.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Spell Check

This component adds a universal spell checker for all text that is entered in Text Box or Multiline Text Box components. The Spell Check component does not check spelling for the HTML editor or the specialized text components (such as Masked Edit and Auto Complete). This component runs invisibly on the form and dynamically shows spelling errors by underlining them in red. Users can right-click on the spelling errors and choose from correction options.

Use the Spell Check component when you want to add a universal spell checker that runs invisibly on your form. The Spell Check component is similar to the Spell Check Button component.

See “Spell Check Button” on page 328.
Table 14-15  Properties in the Spell Check component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wait Period</td>
<td>The amount of time, in milliseconds, that the component waits between spell checks.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Ajax Label

This component lets you add a label with the dynamic content that refreshes. This component has an embedded model (called Label Text Model) that you can use to dynamically determine what content you want to display. The data that is mapped in the End component of this model is the data displayed on the label. This component also has a refresh timer to update the content of the label.

Use this component when you need to use a label with a dynamically updating value. For example, this component can update a numeric display of statistics on a form. The statistics are drawn from a database and are refreshed to show the current value of the data.

Table 14-16  Properties in the Ajax Label component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label Text Model</td>
<td>A model for determining what the label displays. Add the components that you need to determine the content of the label. Map the content variable in the End component of this model.</td>
</tr>
<tr>
<td>Refresh Interval</td>
<td>The amount of time between each refresh.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

ASCII Merge Label

This component lets you merge and display multiple ASCII text variables.

Use the ASCII Merge label when you need to use a label with the ASCII text that is set dynamically at run-time.

This component is similar to the HTML Merge component except that it uses ASCII text data.

See “HTML Merge” on page 330.
Table 14-17  Properties in the ASCII Merge Label component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>The text that displays on the label at run-time. In the text editor you can add constant text, and you can add ASCII text variables from the process.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

### HTML Editor

This component gives users full HTML text editing capabilities for the text that they enter on a form.

Use this component when you want to let users format the text that they enter. Make sure that your project can handle HTML text before you use this component. For example, you cannot display HTML text in an ASCII Merge Label component.

See “About text box components” on page 362.

Table 14-18  Properties in the HTML Editor component

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default HTML</td>
<td>Text that appears in the editor when users first enter the form.</td>
</tr>
<tr>
<td>Always Use Default HTML</td>
<td>Sets whether the default HTML always appears. Use this setting if you want the default HTML to overwrite any text that users may have entered after leaving and returning to the form.</td>
</tr>
<tr>
<td>Show Tab Strip</td>
<td>Sets whether to display the tabs that are at the bottom of the editor.</td>
</tr>
<tr>
<td>Show Toolbar</td>
<td>Sets whether to display the toolbar that is at the top of the editor.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

### HTML Merge

This component lets you merge and display multiple HTML text variables.

Use the HTML Merge component when you need to use a label with the HTML text that is set dynamically at run-time.
This component is similar to the ASCII Merge Label component, except that it uses HTML text data.

See “ASCII Merge Label” on page 329.

### Table 14-19 Properties in the HTML Merge component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>The text that displays on the label at run-time. In the text editor you can add constant text and HTML text variables from the process.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

### Image Button List

This component displays buttons with images on your form. The component can display one or more buttons, and each button can have a unique image.

Use this component when you want to have a group of buttons that display images. Each button has its own output value. You can set this component to allow one or more of the buttons to be clicked.

When you first add this component to your form, you are prompted to provide the following properties:

- **Output Name**
  The name of the output variable.

- **Path Name**
  The name of the outcome path that this component uses to output its data.

- **Is Required**
  Declares whether the output variable data is required on the outcome path.

### Table 14-20 Properties in the Image Button List component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output data</td>
<td>The name of the output variable.</td>
</tr>
</tbody>
</table>
Table 14-20  Properties in the Image Button List component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>The image buttons that appear on the component. Each item requires the following properties:</td>
</tr>
<tr>
<td></td>
<td>■ Value</td>
</tr>
<tr>
<td></td>
<td>The output value for the item.</td>
</tr>
<tr>
<td></td>
<td>■ Text</td>
</tr>
<tr>
<td></td>
<td>The text that appears on the button.</td>
</tr>
<tr>
<td></td>
<td>■ Image</td>
</tr>
<tr>
<td></td>
<td>The image that appears on the button before it is clicked.</td>
</tr>
<tr>
<td></td>
<td>■ Selected Image</td>
</tr>
<tr>
<td></td>
<td>The image that appears on the button after it is clicked.</td>
</tr>
<tr>
<td>Selected Items</td>
<td>The items from the Items list that you want to be selected by default when the user enters the form. Add only the items that are from the Items list, and use the value of the item to register it in the Selected Items list.</td>
</tr>
<tr>
<td>Selection Mode</td>
<td>Declares if the user can select one button or more than one button at a time.</td>
</tr>
<tr>
<td>Repeat Direction</td>
<td>Sets how the buttons are arranged in repeating columns.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

List Items

This component lets you format and display a list of items on your form. This component is commonly used to display an array.

Use this component when you have a number of items that you want to display as a list.

Table 14-21  Properties in the List Items component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Type</td>
<td>The data type of the items that you want to display.</td>
</tr>
<tr>
<td>Items</td>
<td>The items that you want to display. You can add process variables, constant values, the values that a dynamic model determines, or any combination of these.</td>
</tr>
</tbody>
</table>
### Table 14-21 Properties in the List Items component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Format</td>
<td>The format for how the list items appear on the form. In the advanced text creator, the <em>list_item</em> variable on the left represents a single item in the list. The formatting that you apply to this variable is used to format all of the items in the list at run-time.</td>
</tr>
<tr>
<td>Text When Items Are Empty</td>
<td>Text that appears in the component at run-time if there are no items to display.</td>
</tr>
<tr>
<td>Items Padding</td>
<td>Vertical space between the list items.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

### Panel

This component lets you create an organizational panel on your form. Use the Panel component when you want to create sections on your form that contain the form components that you want to move together. You can put any form component on a Panel component.

The settings of a panel have an effect on the form components that you add. For example, if you set the panel to be invisible, the components it contains are also invisible. During design-time, when you move a Panel component on the form, the components it contains move with it.

The Panel component has no unique properties.

See “Common properties in form components” on page 316.

### Mail to Button

This component creates a button on your form that lets users send an email. The Mail to Button component uses a `mailto:` syntax in a browser.

Use this component when you want users to be able to edit and send an email to an address that you specify.

The Mail to Button component is similar to the following components:

- Mail to Image
  - Has the same functionality as the Mail to Button component, except that the button appears as an image.
- Mail to Link
Has the same functionality as the Mail to Button component, except that the button appears as a link.

**Table 14-22  Properties in the Mail to Button component editor**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>The receiving email address. Use the <strong>mailto:</strong> prefix when you set the email address.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See &quot;Common properties in form components&quot; on page 316.</td>
</tr>
</tbody>
</table>

**Mask Edit**

This component lets you create a customized text box for users to fill out. You can use the Mask Edit component to configure the format of the input that users type in the text box. For example, you can configure the component to format input as a standard telephone number or as a state abbreviation.

Use the Mask Edit component when you want users to follow a particular, consistent format with the text that they enter.

See "About text box components" on page 362.

When you first add this component to your form, you are prompted for the following settings:

- **Output Name**
  The name of the output variable.

- **Path Name**
  The name of the outcome path that this component uses to output its data.

- **Is Required**
  Declares whether the output variable data is required on the outcome path.

**Table 14-23  Properties in the Mask Edit component editor**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always use initial value</td>
<td>Sets whether the initial value always displays when the user first enters the form.</td>
</tr>
<tr>
<td>Initial Value</td>
<td>The value that appears in the text box when the user first enters the form.</td>
</tr>
<tr>
<td>Mask Edit Type</td>
<td>The input format for the text box.</td>
</tr>
</tbody>
</table>
Table 14-23  Properties in the Mask Edit component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>Sets whether the text box is editable.</td>
</tr>
<tr>
<td>Escape HTML</td>
<td>Sets whether the component converts ASCII escape sequences into HTML counterparts: for example, &lt;HEAD&gt; becomes &lt;HEAD&gt;.</td>
</tr>
<tr>
<td>Text Box Mode</td>
<td>Sets the overall format of the text box.</td>
</tr>
<tr>
<td>Maximum Length</td>
<td>Sets the maximum number of characters that can appear in the text box.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Multiline Text Box

This component lets users input the text that is more than one line long. The Multiline Text Box wraps text when it gets to the edge of the text box instead of stretching like the standard Text Box component. Use this component when you expect the user to input a significant amount of text.

See “About text box components” on page 362.

When you first add this component to your form, you are prompted for the following settings:

- **Output Name**
  The name of the output variable.

- **Path Name**
  The name of the outcome path that this component uses to output its data.

- **Is Required**
  Declares whether the output variable data is required on the outcome path.

Table 14-24  Properties in the Multiline Text Box component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Value</td>
<td>The value that appears in the text box when a user first enters the form.</td>
</tr>
<tr>
<td>Always use initial value</td>
<td>Sets whether the initial value always displays when a user first enters the form.</td>
</tr>
<tr>
<td>Read Only</td>
<td>Sets whether the text box is editable.</td>
</tr>
</tbody>
</table>
Table 14-24  Properties in the Multiline Text Box component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escape HTML</td>
<td>Sets whether the component converts ASCII escape sequences into their HTML counterparts: for example, &amp;lt;HEA&amp;rt; becomes &lt;HEAD&gt;.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

### Numeric Stepper

This component shows a number and has options to let users increment and decrement the value. You can customize the possible values that users can select by setting maximum and minimum values, and the number format (decimal, integer, and so on).

Use this component when you want users to select a number within the parameters that you set. For example, you can use this component on a survey form in which users rank their satisfaction between one and five.

Table 14-25  Properties in the Numeric Stepper component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Mode</td>
<td>The data type format for the number that displays in the component. The data type that you select affects the possible values that users can select. For example, the Decimal data type includes decimal places, but the Integer data type does not.</td>
</tr>
<tr>
<td>Max Decimal Places</td>
<td>The number of possible decimal places on the number that a user selects. This option is only for the data types that can have decimal places: for example, the Decimal data type.</td>
</tr>
<tr>
<td>Number Style</td>
<td>The style for the number break format.</td>
</tr>
<tr>
<td>Initial Value</td>
<td>The value that appears in the text box when a user first enters the form.</td>
</tr>
<tr>
<td>Always use initial value</td>
<td>Sets whether the initial value always displays when a user first enters the form.</td>
</tr>
<tr>
<td>Minimum Value</td>
<td>The minimum value possible for the user to select.</td>
</tr>
<tr>
<td>Maximum Value</td>
<td>The maximum value possible for the user to select.</td>
</tr>
</tbody>
</table>
Table 14-25  Properties in the Numeric Stepper component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step Size</td>
<td>The amount of increment or decrement each time the user clicks the up or down arrow.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Numeric Text Box

This component lets users input only a numeric value into the text box. The Numeric Text Box works like the regular Text Box component, except that it accepts only numeric values. You can set which kind of numeric values this component accepts: for example, decimal, integer, and so on.

See “Text Box” on page 338.

Use this component when you want to restrict user input to only numeric values.

See “About text box components” on page 362.

When you first add this component to your form, you are prompted for the following settings:

- **Output Name**
  The name of the output variable.

- **Path Name**
  The name of the outcome path that this component uses to output its data.

- **Is Required**
  Declares whether the output variable data is required on the outcome path.

Table 14-26  Properties in the Numeric Text Box component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Mode</td>
<td>The data type format for the number that displays in the component. The data type that you select affects the possible values that users can select. For example, the Decimal data type includes decimal places, but the Integer data type does not.</td>
</tr>
<tr>
<td>Max Decimal Places</td>
<td>The number of possible decimal places on the number that a user selects. This option is only for the data types that can have decimal places: for example, the Decimal data type.</td>
</tr>
</tbody>
</table>
Table 14-26  Properties in the Numeric Text Box component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number Style</td>
<td>The style for the number break format.</td>
</tr>
<tr>
<td>Always use initial value</td>
<td>Sets whether the initial value always displays upon first entering the form.</td>
</tr>
<tr>
<td>Initial Value</td>
<td>The value that appears in the text box when a user first enters the form.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

**Text Box**

This component lets users enter text. The Text Box component is the standard text entry component in Workflow forms design.

Use this component when you want to let users enter a small amount of text (a few words or less). You cannot put any restrictions on what kind of text users can enter into the Text Box component. If users enter too much text, the text box may stretch.

You can also use a Multiline Text Box component to let users enter a large amount of text.

See “Multiline Text Box” on page 335.

See “About text box components” on page 362.

When you first add this component to your form, you are prompted for the following settings:

- **Output Name**
  - The name of the output variable.

- **Path Name**
  - The name of the outcome path that this component uses to output its data.

- **Is Required**
  - Declares whether the output variable data is required on the outcome path.

**Table 14-27**  Properties in the Text Box component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Value</td>
<td>The value that appears in the text box when a user first enters the form.</td>
</tr>
</tbody>
</table>
### Table 14-27  Properties in the Text Box component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always use initial value</td>
<td>Sets whether the initial value always displays upon first entering the form.</td>
</tr>
<tr>
<td>Read Only</td>
<td>Sets whether the text box is editable.</td>
</tr>
<tr>
<td>Escape HTML</td>
<td>Sets whether the component converts ASCII escape sequences into their HTML counterparts: for example, &lt;HEAD&gt; becomes &lt;HEAD&gt;.</td>
</tr>
<tr>
<td>Text Box Mode</td>
<td>Sets how the text box handles the entered text in one of the following ways:</td>
</tr>
</tbody>
</table>
|                           | ■ SingleLine  
|                           |   Keeps the text on a single line. If the user enters a large amount of text, the text box stretches. |
|                           | ■ Multiline  
|                           |   Breaks the text into multiple lines if the user enters a large amount of text. |
|                           | ■ Password  
|                           |   Masks the entered text. |

### Google Maps

This component lets you display a location with Google Maps.

See “About form components” on page 316.

### Table 14-28  Properties in the Google Maps component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>The address for the location that is shown on the map.</td>
</tr>
<tr>
<td>Google Key</td>
<td>A key for the Google Maps API.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>
Advanced Check Box List

This component lets you add a check box to your form that has advanced functionality.

The Advanced Check Box List component includes the following advanced features:

- Tool tips for individual items in the list.
- Items can be checked by default.
- Items can be Web links.
- Output data can be an array.
- Item value can be a process variable, dynamic value, dynamic model, or constant value.

The Advanced Check Box List component is similar to the Check Box component and the Check Box List component.

See “Check Box” on page 341.

See “Check Box List” on page 342.

Use the Advanced Check Box List component when you want users to answer a series of customized yes or no questions. For example, you can use a dynamic model to set the value of some of the items in the list based on user interaction.

**Table 14-29** Properties in the Advanced Check Box List component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repeat Columns</td>
<td>The number of columns in which the list is displayed.</td>
</tr>
<tr>
<td>Repeat Direction</td>
<td>The orientation of the columns.</td>
</tr>
</tbody>
</table>
Table 14-29  Properties in the Advanced Check Box List component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>The items that display in the list. Each item has the following settings:</td>
</tr>
<tr>
<td></td>
<td>■ Value The value that the item creates in the component's output data if</td>
</tr>
<tr>
<td></td>
<td>the item is clicked.</td>
</tr>
<tr>
<td></td>
<td>■ Tool tip The message that appears when a user hovers over the item.</td>
</tr>
<tr>
<td></td>
<td>■ Checked Sets whether the item is checked by default.</td>
</tr>
<tr>
<td></td>
<td>■ Web Link Declares whether the item is a link to a URL.</td>
</tr>
<tr>
<td></td>
<td>■ URL The URL for the item if it is set to be a Web link.</td>
</tr>
<tr>
<td>Is Output Data Array</td>
<td>Sets whether the output data for this component is an array value. The output data can be an array value only if you set the value of the individual items to be an array value.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Check Box

This component lets you add a check box to your form. The Check Box component outputs a logical (true or false) value. Use this component when you want users to answer a yes or no question.

This component is similar to the Check Box List component and the Advanced Check Box List component.

See “Advanced Check Box List” on page 340.

See “Check Box List” on page 342.

Table 14-30  Properties in the Check Box component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default State</td>
<td>Sets whether the component is checked by default.</td>
</tr>
</tbody>
</table>
Table 14-30 Properties in the Check Box component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always Use Default State</td>
<td>Sets whether the default state is always used, even if the user changes the default state, leaves the form, and then reenters the form. If this property is selected, the form always uses the default state, regardless of what the user previously selected on the form.</td>
</tr>
<tr>
<td>Web Link</td>
<td>Sets whether the item is a link to a URL.</td>
</tr>
<tr>
<td>URL</td>
<td>The URL for the item if it is set to be a Web link.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Check Box List

This component lets you add a list of check boxes to your form. Use the Check Box List component when you want users to answer a series of yes or no questions. For example, you can use this component to display a series of settings for a user profile.

When you first add this component to your form, you are prompted for the following settings:

- **Data Type**
  The data type that is used for the values of the items in the list.

- **Items**
  The items in the check box list.

- **Output Name**
  The name of the output variable.

- **Path Name**
  The name of the outcome path that this component uses to output its data.

- **Is Required**
  Declares whether the output variable data is required on the outcome path.

The Check Box List component is similar to the Advanced Check Box List component and the Check Box component.

See “Advanced Check Box List” on page 340.

See “Check Box” on page 341.
Table 14-31  Properties in the Check Box List component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>The items that appear in the check box list.</td>
</tr>
<tr>
<td>Selected Items</td>
<td>The items from the <strong>Items</strong> list that you want to be already selected when the user enters the form. Only add items from the <strong>Items</strong> list, and use the value of the item to register it in the <strong>Selected Items</strong> list.</td>
</tr>
<tr>
<td>Always Use Selected Items</td>
<td>Declares whether the selected items are always used, even if the user changes which items are selected, leaves the form, and then reenters the form. If this property is selected, the form always uses the selected items settings, regardless of what the user previously selected on the form.</td>
</tr>
<tr>
<td>This List Is Static</td>
<td>Declares whether you have configured this list to dynamically update its items.</td>
</tr>
<tr>
<td>Repeat Columns</td>
<td>Sets how the options are arranged in repeating columns.</td>
</tr>
<tr>
<td>Repeat Direction</td>
<td>Sets whether the option columns appear vertically or horizontally.</td>
</tr>
<tr>
<td>Stretch Component To Items Size</td>
<td>Does not break the text of the list item to display it fully.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Calendar

This component lets users select a date. Use this component when you want users to enter a date by clicking a day on a calendar display.

When you first add this component to your form, you are prompted for the following settings:

- **Output Name**
  The name of the output variable.

- **Path Name**
  The name of the outcome path that this component uses to output its data.

- **Is Required**
  Declares whether the output variable data is required on the outcome path.
### Table 14-32  Properties in the Calendar component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Today</td>
<td>Sets whether the calendar display first appears with the current date selected. If you do not select this property, provide a different date.</td>
</tr>
<tr>
<td>Style</td>
<td>The calendar style.</td>
</tr>
<tr>
<td>Next Previous Format</td>
<td>The format for the two options that are at the top of the calendar.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

### Date Picker

This component lets users pick a date from a calendar pop-up that appears when they click a drop-down list. Use this component when you want a compact way for users to enter a date.

When you first add this component to your form, you are prompted for the following settings:

- **Output Name**
  - The name of the output variable.

- **Path Name**
  - The name of the outcome path that this component uses to output its data.

- **Is Required**
  - Declares whether the output variable data is required on the outcome path.

### Table 14-33  Properties in the Date Picker component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Today</td>
<td>Declares whether the calendar display first appears with the current date selected. If you do not select this property, provide a different date.</td>
</tr>
<tr>
<td>Drop Down Image</td>
<td>The image that is displayed on the drop-down menu. This image is not the calendar itself.</td>
</tr>
<tr>
<td>Min Date</td>
<td>The earliest date that a user can select.</td>
</tr>
<tr>
<td>Max Date</td>
<td>The latest date that a user can select.</td>
</tr>
</tbody>
</table>
Date Time Picker

This component lets users pick a date from a calendar that appears when they click a drop-down list and a time. This component saves space on your form by not using a full Calendar component or Time Picker component. Use this component when you want users to be able to select a date and time. The date value and the time value are combined in a single output variable.

When you first add this component to your form, you are prompted for the following settings:

- **Output Name**
  The name of the output variable.

- **Path Name**
  The name of the outcome path that this component uses to output its data.

- **Is Required**
  Declares whether the output variable data is required on the outcome path.

### Table 14-34  Properties in the Date Time Picker component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Today</td>
<td>Declares whether the calendar display first appears with the current date selected. If you do not select this property, provide a different date.</td>
</tr>
<tr>
<td>Time default value</td>
<td>The default time value in the time picker.</td>
</tr>
<tr>
<td>Obey time zone</td>
<td>Declares whether the time output data is converted to the local time zone. If you select this property, specify a time zone. The time zone that you specify is the time zone from which you expect the time to come. For example, running in UTC and set to obey the UTC+1:00 time zone, the component adds one hour from the entered value.</td>
</tr>
<tr>
<td>Display Mode</td>
<td>The display format.</td>
</tr>
<tr>
<td>Drop Down Image</td>
<td>The image that is displayed on the drop-down menu. This image is not the calendar itself.</td>
</tr>
</tbody>
</table>
Table 14-34 Properties in the Date Time Picker component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min Date</td>
<td>The earliest date that a user can select.</td>
</tr>
<tr>
<td>Max Date</td>
<td>The latest date that a user can select.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Drop Down List

This component lets users select an item from a drop-down list. Use this component when you want users to select one item from a list.

When you first add this component to your form, you are prompted for the following settings:

- **Data Type**
  The data type that is used for the values of the items in the list.

- **Items**
  The items in the drop-down list.

- **Output Name**
  The name of the output variable.

- **Path Name**
  The name of the outcome path that this component uses to output its data.

- **Is Required**
  Declares whether the output variable data is required on the outcome path.

Table 14-35 Properties in the Drop Down List component

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>The items in the drop-down list.</td>
</tr>
<tr>
<td>Selected Item</td>
<td>The item from the Items list that you want to be already selected when the user enters the form. Add only an item from the Items list, and use the value of the item to register it in the Selected Items list.</td>
</tr>
</tbody>
</table>
Table 14-35  Properties in the Drop Down List component (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always Use Selected Item</td>
<td>Declares whether the selected item is always used, even if the user changes which item is selected, leaves the form, and then reenters the form. If this property is selected, the form always uses the selected item settings, regardless of what the user previously selected on the form.</td>
</tr>
<tr>
<td>Display Blank Item</td>
<td>Declares whether a blank item appears as one of the items in the drop-down list.</td>
</tr>
<tr>
<td>This List Is Static</td>
<td>Declares whether you have configured this list to dynamically update its items.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

List Box

This component lets users select one or more items from a list that is fully visible. When you first add this component to your form, you are prompted for the following settings:

- **Data Type**
  The data type that is used for the values of the items in the list.

- **Items**
  The items in the drop-down list.

- **Output Name**
  The name of the output variable.

- **Path Name**
  The name of the outcome path that this component uses to output its data.

- **Is Required**
  Declares whether the output variable data is required on the outcome path.

Table 14-36  Properties in the List Box component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>The items in the drop-down list.</td>
</tr>
</tbody>
</table>
Table 14-36 Properties in the List Box component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected Items</td>
<td>The items from the <strong>Items</strong> list that you want to be already selected when the user enters the form. Add only items from the <strong>Items</strong> list, and use the value of the item to register it in the <strong>Selected Items</strong> list.</td>
</tr>
<tr>
<td>This List Is Static</td>
<td>Declares whether you have configured this list to dynamically update its items.</td>
</tr>
<tr>
<td>Selection Mode</td>
<td>Declares whether users can select one or more items.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

**List Select**

This component shows a formatted list of items from a collection and lets the user select one item. The List Select component is an attractive alternative to grid components and drop-down components because you can format how the items appear in the list. The List Select component lets you format the list however you want. For example, you can put a line between the items or make the list items bold.

You can also create more than one action that users can take on an item.

For example, the List Select component can be configured with some items and two possible outcomes for each item. Each outcome creates an outcome path on the form, and has an output variable with the value of the selected item.

If you have city names as an array of text values, the configuration can be as follows:

**Houston**

Select | Get Details

**Norfolk**

Select | Get Details

**Sydney**

Select | Get Details

**London**

Select | Get Details

This component is configured in the component’s **Item Format** property as follows:
Notice that the list contains only one item, the \_select\_list\_item\_. The formatting that is applied to this item is applied to all of the items that appear in the list at run-time.

Use this component when you want to list items with multiple actions that users can take.

The List Select component has an output variable called `selecteditem` (by default). This variable has the value of the selected item.

**Table 14-37** Properties in the List Select component editor

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outcomes</td>
<td>The selection options for each item in the list. Each outcome you add creates an outcome path on the form.</td>
</tr>
<tr>
<td>Use Whole Item as Outcome Link</td>
<td>Declares whether the item itself functions as the outcome link. This setting is an option only if you have a single outcome added to the Outcomes list.</td>
</tr>
<tr>
<td>Text When Items Are Empty</td>
<td>Text that appears in the component at run-time if there are no items to display.</td>
</tr>
<tr>
<td>Items</td>
<td>The array of items to be displayed in the list.</td>
</tr>
<tr>
<td>Item Format</td>
<td>How each item appears in the list. In the Advanced Text Creator, the variable <code>_select_list_item_</code> represents a single item in the list. The formatting you create around this variable is used for each item in the list during run-time.</td>
</tr>
<tr>
<td>Items Padding</td>
<td>The amount of space between each item in the list.</td>
</tr>
<tr>
<td>Selected Item Variable</td>
<td>The variable name of the selected item.</td>
</tr>
</tbody>
</table>
Table 14-37  Properties in the List Select component editor (continued)

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Decision Model</td>
<td>Declares whether your list creates outcomes based on a decision model.</td>
</tr>
<tr>
<td></td>
<td>If you use a decision model, you can configure it with the outcomes that are available in the <strong>Item Format</strong> Advanced Text Creator. Creating outcomes in the decision model lets you create customized outcome links for each item in the list. For example, you use list addresses. You can create a link that merges the address in a URL for directions or location for each address. The decision model runs once for each item in the list so that each item can have customized links. Use the Merge Text component in the decision model if you want to create a URL by merging some dynamic text with some static text. Map the output data of this component into the model outputs in the model's End component.</td>
</tr>
<tr>
<td>Model Outputs</td>
<td>Output data for the decision model. The output data you add here appears in the End component of the decision model to be mapped.</td>
</tr>
<tr>
<td>Other properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

**Radio Button List**

This component lets users select one item out of a list of items that are displayed as radio buttons.

When you first add this component to your form, you are prompted for the following settings:

- **Data Type**
  The data type that is used for the values of the items in the list.

- **Items**
  The items in the drop-down list.

- **Output Name**
  The name of the output variable.

- **Path Name**
  The name of the outcome path that this component uses to output its data.
Is Required
Declares whether the output variable data is required on the outcome path.

Table 14-38  Properties in the Radio Button List component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>The items that appear in the radio button list.</td>
</tr>
<tr>
<td>Selected Item</td>
<td>The item from the Item list that you want to be already selected when the user enters the form. Add only one item from the Item list, and use the value of the item to register it in the Selected Item list.</td>
</tr>
<tr>
<td>Always Use Selected Item</td>
<td>Sets whether the selected item is always used, even if the user changes which items are selected, leaves the form, and then reenters the form. If this property is selected, the form always uses the selected item settings, regardless of what the user previously selected on the form.</td>
</tr>
<tr>
<td>This List Is Static</td>
<td>Sets whether you have configured this list to dynamically update its items.</td>
</tr>
<tr>
<td>Repeat Columns</td>
<td>Sets how the options are arranged in repeating columns.</td>
</tr>
<tr>
<td>Repeat Direction</td>
<td>Sets whether the option columns appear vertically or horizontally.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Time Picker

This component lets users pick a time from an incremental display.

When you first add this component to your form, you are prompted for the following settings:

- **Output Name**
  The name of the output variable.

- **Path Name**
  The name of the outcome path that this component uses to output its data.

- **Is Required**
  Declares whether the output variable data is required on the outcome path.
Table 14-39  Properties in the Date Picker component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default value</td>
<td>The time that is displayed on the component by default.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Auto Complete Text Box

This component lets users enter text in a text box with the autocomplete suggestions that appear as they type. Use this component when you want to use a text box and you know what suggestions to offer.

See “About text box components” on page 362.

When you first add this component to your form, you are prompted for the following settings:

- **Output Name**
  The name of the output variable.

- **Path Name**
  The name of the outcome path that this component uses to output its data.

- **Is Required**
  Declares whether the output variable data is required on the outcome path.

Table 14-40  Properties in the Auto Complete Text Box component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Value</td>
<td>The value that appears in the text box when a user first enters the form.</td>
</tr>
<tr>
<td>Always Use Initial Value</td>
<td>Sets whether the initial value is always displayed upon first entering the form.</td>
</tr>
<tr>
<td>Escape HTML</td>
<td>Sets whether the component converts ASCII escape sequences into their HTML counterparts: for example, &lt;HEAD&gt; becomes &lt;HEAD&amp;gt.;</td>
</tr>
<tr>
<td>Maximum Length</td>
<td>The maximum number of characters that users can enter in the text box.</td>
</tr>
<tr>
<td>Completion Interval</td>
<td>How often, in milliseconds, the component suggests completion items.</td>
</tr>
</tbody>
</table>
### Table 14-40  Properties in the Auto Complete Text Box component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completion Items</td>
<td>A model for declaring possible completion items. Completion items must be text data type values. You can declare one or more completion items in the model. Map the completion items in the End component. For example, you can add an Add New Data Element component and configure it with an array of text items. Then you can map the array in the End component. You can configure the component to suggest completion items based on what the user has already typed. Add a Configurable Collection Filter component in the Completion Items model to add logic. You can configure the Filter Model of the Configurable Collection Filter to compare the user input with the Element value. Use the This Form Data variable for the user input, and the Element value for each item to be compared.</td>
</tr>
<tr>
<td>Completion Set Count</td>
<td>Sets a number variable for limiting the number of completion items to display. You can use this variable in the Completion Items model.</td>
</tr>
<tr>
<td>Enable Caching</td>
<td>Sets whether the text box uses value caching.</td>
</tr>
<tr>
<td>Minimum Prefix Length</td>
<td>The number of characters that are required before the component.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

### Line

This component lets you add a line to your form. The Line component has no functionality; it serves only to improve how your form looks. Use the Line component when you want to create a visual break on your form.

### Table 14-41  Properties in the Line component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orientation</td>
<td>The direction of the line.</td>
</tr>
<tr>
<td>Width</td>
<td>How wide the line is.</td>
</tr>
</tbody>
</table>
Table 14-41  Properties in the Line component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Page Refresh Check

This component lets you refresh a form based on configurable rules. Use the Page Refresh Check component when you want your form to refresh based on some change in data (for example, user input). This component is invisible on the form at run-time.

If you want to refresh your form based on a time interval, use the Refresh Page On Timer component.

Table 14-42  Properties in the Page Refresh Check component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Should Refresh Page</td>
<td>The model that contains the rules for refreshing the page. You can add any rules that you want in this model, and you should map the value (logical true or false) into the End component. For example, you can add a True/False Rule component to check the value of a Check Box component on your form (in This Form Data).</td>
</tr>
<tr>
<td>Check Interval</td>
<td>The amount of time before the component runs the rules model. The component runs the rules model repeatedly based on this interval.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Grid

This component lets you display data to users in a grid format, and it lets users optionally edit or select the data. You can display only complex data type variables (usually arrays) in a Grid component because the grid requires multiple columns of data. Columns correspond with properties in complex data types, and rows correspond with instances of that data.
Use this component when you have a large amount of data that you want to display all at once. This component is one of the few components that lets you display an array of complex data type values that users can edit.

Table 14-43 Properties in the Grid component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid mode</td>
<td>Defines the functionality of the grid.</td>
</tr>
<tr>
<td></td>
<td>You can set this property to one of the following modes:</td>
</tr>
<tr>
<td></td>
<td>• Select Items</td>
</tr>
<tr>
<td></td>
<td>Users can select one or more items from the grid, and these items become output data.</td>
</tr>
<tr>
<td></td>
<td>• Editing Items</td>
</tr>
<tr>
<td></td>
<td>Users can edit the grid boxes by double-clicking on them.</td>
</tr>
<tr>
<td></td>
<td>• Read-only</td>
</tr>
<tr>
<td></td>
<td>Data is only displayed; users cannot select or edit the data.</td>
</tr>
<tr>
<td>Item Source</td>
<td>(Applies to only the Select Items and Read-only modes.) The data variable from which the grid gets its data.</td>
</tr>
<tr>
<td>Primary Key Property</td>
<td>Declares the property on the complex data type that is the primary key.</td>
</tr>
<tr>
<td>Grid data is array</td>
<td>(Applies only to the Editing Items mode.) Declares whether the grid should expect an array of data or only a single instance.</td>
</tr>
<tr>
<td>Grid data</td>
<td>(Applies only to the Editing Items mode.) The data variable from which the grid gets its data.</td>
</tr>
<tr>
<td>Allow Add New Row</td>
<td>(Applies only to the Editing Items mode.) Declares whether users can add a new row to the grid.</td>
</tr>
<tr>
<td>Allow Delete Row</td>
<td>(Applies only to the Editing Items mode.) Declares whether users can delete a row from the grid.</td>
</tr>
<tr>
<td>Allow Multiselection Mode</td>
<td>(Applies only to the Select Items mode.) Declares whether users can select more than one item from the grid.</td>
</tr>
<tr>
<td>Default Selected Row</td>
<td>(Applies only to the Select Items mode.) Declares the row that is selected by default.</td>
</tr>
<tr>
<td>Selected Item</td>
<td>(Applies only to the Select Items mode.) The output variable name for the selected item.</td>
</tr>
</tbody>
</table>
Table 14-43  Properties in the Grid component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Columns</td>
<td>The columns that display the properties in the complex data type input data. You can add, delete, or edit the columns.</td>
</tr>
<tr>
<td>Allow Paging</td>
<td>Declares whether the grid data can be broken up over multiple pages. During run-time, numbers for the multiple pages appear as links in the lower right-hand corner.</td>
</tr>
<tr>
<td>Page Size</td>
<td>The number of rows that display per page.</td>
</tr>
<tr>
<td>Current Style Preset</td>
<td>The style of the grid.</td>
</tr>
<tr>
<td>Allow Change Columns Size</td>
<td>Declares whether users can adjust the size of the columns.</td>
</tr>
<tr>
<td>Allow Move Columns</td>
<td>Declares whether users can change the order of the columns.</td>
</tr>
<tr>
<td>Allow Sorting Columns</td>
<td>Declares whether users can sort the columns so that items are displayed in either ascending or descending order.</td>
</tr>
<tr>
<td>View Type</td>
<td>The view setting for the grid.</td>
</tr>
<tr>
<td>Enable Filtering Data</td>
<td>(Applies only to the Editing Items mode.) Declares whether the grid uses a validation model to filter grid input. Use this property if you want to limit the values that users are allowed to enter.</td>
</tr>
<tr>
<td>Filter Model</td>
<td>The model that contains the filtering rules. Configure this model with the rules that evaluate the Element variable.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

**Button Download**

This component lets users click a button on your form to download a file to their computer. The file can be stored in the Workflow Server computer’s file system, or it can be stored in the process data.

Use this component when you need to let users download a file that is not available on an externally accessible website. If the file is accessible on an externally accessible website, use a link to that location.
See “Link Button” on page 326.

### Table 14-44 Properties in the Button Download component editor

<table>
<thead>
<tr>
<th>Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Type</td>
<td>Declares whether to store the downloaded file on the host server or as a file data type in process memory. Use the <strong>File System</strong> setting only if you know that the location of the file never changes.</td>
</tr>
<tr>
<td>File Path</td>
<td>(Applies only to the <strong>File System</strong> source type.) The file system path to the file that users want to download.</td>
</tr>
<tr>
<td>File name</td>
<td>(Applies only to the <strong>File System</strong> source type.) The name of the file that users want to download.</td>
</tr>
<tr>
<td>Override Mime Type</td>
<td>Declares whether this component leaves the default file extension on the downloaded file. Use this option when the file extension prevents this component from working properly.</td>
</tr>
<tr>
<td>Mime Type</td>
<td>The override data type for the file.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

### Input File

This component lets users upload a file. After a user has uploaded a file, the file data becomes available on the data stream.

Use this component when you want to let users upload a file. For example, on a report page, users can upload a spreadsheet file. The file is then saved to a file system with the Write File component.

When you first add this component to your form, you are prompted for the following settings:

- **Output Name**
  The name of the output variable.

- **Path Name**
  The name of the outcome path that this component uses to output its data.

- **Is Required**
  Declares whether the output variable data is required on the outcome path.
Table 14-45  Properties in the Input File component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename File</td>
<td>Declares whether the component renames the uploaded file. Use this option when you want to standardize the file names of incoming files. For example, if users upload report spreadsheets you can set the name in the dynamic model to ReportSpreadsheet1 with an incrementing number.</td>
</tr>
<tr>
<td>File name</td>
<td>The new name of the uploaded file.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

Dynamic Update Panel

This component lets you create a section on your form that refreshes the components it contains without having to exit the form. Refreshing a section of a form means that the form does not flash like it does when the entire form is refreshed. Use the Dynamic Update Panel component when you want to discreetly update the form to reflect user interaction.

For example, a form calculates severity based on user selections. The calculated severity displays in an ASCII Merge Label component. The Post Form On Value Change property is turned on in the Radio Button List components. When the user makes a selection, the panel updates to reflect the user selection.

Table 14-46  Properties in the Dynamic Update Panel component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Dynamic Update Panel component has no unique properties.</td>
<td>The Dynamic Update Panel component works on a specific property of other form components: the Post Form On Value Change property. If this property is turned on, and if the component is contained within a Dynamic Update Panel, the panel updates when its value is changed.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>
Sub Dialog

This component lets you add a dialog box that opens inside of another form. Use the Sub Dialog component when you want to display a form within a form.

For example, on a complex survey form you want users to be able to click a link and see instructions for each text box. Use a Sub Dialog component that is labeled as **Instructions** under each text box.

<table>
<thead>
<tr>
<th>Table 14-47</th>
<th>Properties in the Sub Dialog component editor</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Property</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Opening Mode</td>
<td>Declares whether the sub dialog box opens in a new browser window or in a virtual window in the current browser.</td>
</tr>
<tr>
<td>Window Width</td>
<td>How wide, in pixels, the sub dialog box is.</td>
</tr>
<tr>
<td>Window Height</td>
<td>How tall, in pixels, the sub dialog box is.</td>
</tr>
<tr>
<td>Post Current Data Before Opening</td>
<td>Declares whether the main form posts its data before it opens the sub dialog box. By enabling this property, all data is updated for use in the sub dialog box.</td>
</tr>
<tr>
<td>Window Title</td>
<td>The title that appears on the sub dialog box.</td>
</tr>
<tr>
<td>Forms Model</td>
<td>The model that contains the actual form that is displayed in the sub dialog box.</td>
</tr>
<tr>
<td></td>
<td>Your configuration should include the following components:</td>
</tr>
<tr>
<td></td>
<td>■ Form Builder component</td>
</tr>
<tr>
<td></td>
<td>Add a Form Builder component and configure it with the controls that you want to display in the sub dialog box.</td>
</tr>
<tr>
<td></td>
<td>■ Terminate Window and Close Dialog component</td>
</tr>
<tr>
<td></td>
<td>This component closes the sub dialog box when the user exits.</td>
</tr>
<tr>
<td>Visual Mode</td>
<td>How the entry to the sub dialog box displays on the form.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>
Arrow Up Down

This component displays a title and a corresponding arrow in a grid pattern. The rules that you set in an embedded model determine the direction and the color of the arrow.

Use this component when you want to use colored arrows to create a quick reference for users to see the status of some items. For example, you can use this component to display mild, moderate, or severe changes in website activity. In this case, you can use green, yellow, and red for each level, respectively. The arrow points up or down to show the direction of the change.

Table 14-48  Properties in the Arrow Up Down component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items</td>
<td>The titles and corresponding arrows that appear on the component.</td>
</tr>
<tr>
<td></td>
<td>When you add an item, you are required to configure the following properties:</td>
</tr>
<tr>
<td></td>
<td>■ Title</td>
</tr>
<tr>
<td></td>
<td>The text of the item. The item title can be set only as a constant value.</td>
</tr>
<tr>
<td></td>
<td>■ Arrow</td>
</tr>
<tr>
<td></td>
<td>The model that determines the direction and the color of the arrow. Set</td>
</tr>
<tr>
<td></td>
<td>the values in the End component. You may want the direction and the</td>
</tr>
<tr>
<td></td>
<td>color of the arrow to be determined dynamically. In this case, set rules</td>
</tr>
<tr>
<td></td>
<td>in the model (such as a Decision Table) that calculates direction and</td>
</tr>
<tr>
<td></td>
<td>color based on other data. Other data may include previous user input</td>
</tr>
<tr>
<td></td>
<td>or time and date information.</td>
</tr>
</tbody>
</table>

Other Properties  See “Common properties in form components” on page 316.

Multi-State Image

This component lets you display multiple images based on the rules that you configure. The Multi-State Image component is commonly used on Dashboards.

Use this component when you want to change the appearance of your form based on the rules that you configure. For example, use this component to configure a site to display one of 10 different images of its employees based on random selection.
This component is very similar to the Signal Dot Dashboard component. See “Signal Dot Dashboard” on page 361.

**Table 14-49** Properties in the Multi-State Image component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image States</td>
<td>The images that can be displayed in the component.</td>
</tr>
<tr>
<td>Image Selection Model</td>
<td>The model that determines which image is displayed. Set the outcome of this model in the End component. You can use multiple End components to set multiple outcomes. For example, a site displays different images of its employees. One of 10 possible images is displayed at a time. A Create Random Number component creates a number between 1 and 10. A Matches Rule component matches the random number with its outcome paths that resolve in one of 10 End components. Each End component represents an image.</td>
</tr>
<tr>
<td>Default State</td>
<td>The image that displays by default.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

**Signal Dot Dashboard**

This component lets you display multiple signal images based on the rules that you configure. Use this component to create a quick reference for users to check the status of something. The signal dot changes appearance based on the rules that you configure. For example, you can configure the signal dot to show the status of servers based on the rules for traffic volume.

This component is very similar to the Multi-State Image component. See “Multi-State Image” on page 360.

**Table 14-50** Properties in the Signal Dot Dashboard component editor

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image States</td>
<td>The images that can be displayed in the component. You can use the default images or you can add your own.</td>
</tr>
</tbody>
</table>
Table 14-50  Properties in the Signal Dot Dashboard component editor (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Selection Model</td>
<td>The model that determines which image is displayed. Set the outcome of this</td>
</tr>
<tr>
<td></td>
<td>model in the End component. Use multiple End components to set multiple</td>
</tr>
<tr>
<td></td>
<td>outcomes.</td>
</tr>
<tr>
<td>Default State</td>
<td>The image that displays by default.</td>
</tr>
<tr>
<td>Other Properties</td>
<td>See “Common properties in form components” on page 316.</td>
</tr>
</tbody>
</table>

About text box components

You can use a number of different text box components on your form. Each text box component has unique features.

Table 14-51  Text box components and features

<table>
<thead>
<tr>
<th>Component</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Box</td>
<td>This component includes the following features:</td>
</tr>
<tr>
<td></td>
<td>■ Single-line text entry</td>
</tr>
<tr>
<td></td>
<td>If users enter too much text, the box may stretch.</td>
</tr>
<tr>
<td></td>
<td>■ Initial value</td>
</tr>
<tr>
<td></td>
<td>You can set the text that this component displays by default.</td>
</tr>
<tr>
<td></td>
<td>■ ASCII text</td>
</tr>
<tr>
<td></td>
<td>This component outputs standard ASCII text.</td>
</tr>
<tr>
<td></td>
<td>See “Text Box” on page 338.</td>
</tr>
<tr>
<td></td>
<td>This component is the most basic text box component.</td>
</tr>
<tr>
<td></td>
<td>Use this component when you want to let users enter a small amount of</td>
</tr>
<tr>
<td></td>
<td>text (a few words or less). You cannot put any restrictions on the kind</td>
</tr>
<tr>
<td></td>
<td>of text that users can enter.</td>
</tr>
</tbody>
</table>
Table 14-51 Text box components and features (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Complete Text Box</td>
<td>This component includes the following features:</td>
</tr>
<tr>
<td></td>
<td>■ Auto completion suggestions</td>
</tr>
<tr>
<td></td>
<td>You can configure the suggestions that this component shows to the user at run-time.</td>
</tr>
<tr>
<td></td>
<td>■ Single-line text entry</td>
</tr>
<tr>
<td></td>
<td>If users enter too much text, the box may stretch.</td>
</tr>
<tr>
<td></td>
<td>■ Initial value</td>
</tr>
<tr>
<td></td>
<td>You can set the text that this component displays by default.</td>
</tr>
<tr>
<td></td>
<td>■ ASCII text</td>
</tr>
<tr>
<td></td>
<td>This component outputs standard ASCII text.</td>
</tr>
<tr>
<td></td>
<td>See “Auto Complete Text Box” on page 352.</td>
</tr>
<tr>
<td></td>
<td>Use this component when you want to use a text box, and you know the value that the user may enter.</td>
</tr>
<tr>
<td>Numeric Text Box</td>
<td>This component includes the following features:</td>
</tr>
<tr>
<td></td>
<td>■ Numeric value restriction</td>
</tr>
<tr>
<td></td>
<td>You can configure the kind of numeric value (decimal, integer, and so on) that users can input.</td>
</tr>
<tr>
<td></td>
<td>■ Single-line text entry</td>
</tr>
<tr>
<td></td>
<td>If users enter too much text, the box may stretch.</td>
</tr>
<tr>
<td></td>
<td>■ Initial value</td>
</tr>
<tr>
<td></td>
<td>You can set the text that this component displays by default.</td>
</tr>
<tr>
<td></td>
<td>■ ASCII text</td>
</tr>
<tr>
<td></td>
<td>This component outputs standard ASCII text.</td>
</tr>
<tr>
<td></td>
<td>See “Numeric Text Box” on page 337.</td>
</tr>
<tr>
<td></td>
<td>Use this component when you want to restrict user input to numeric values only.</td>
</tr>
<tr>
<td>Component</td>
<td>Features</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Multiline Text Box</td>
<td>This component includes the following features:</td>
</tr>
<tr>
<td></td>
<td>■ Multiline capability</td>
</tr>
<tr>
<td></td>
<td>■ Initial value</td>
</tr>
<tr>
<td></td>
<td>You can set the text that this component displays by default.</td>
</tr>
<tr>
<td></td>
<td>■ ASCII text</td>
</tr>
<tr>
<td></td>
<td>This component outputs standard ASCII text.</td>
</tr>
<tr>
<td></td>
<td>See “Multiline Text Box” on page 335.</td>
</tr>
<tr>
<td></td>
<td>Use this component when you expect users to input a significant amount of text.</td>
</tr>
</tbody>
</table>

| Mask Edit Text Box     | This component includes the following features:                         |
|                        | ■ Entry restriction                                                      |
|                        | You can set the format that is enforced on the text that users enter.    |
|                        | ■ Single-line text entry                                                 |
|                        | If users enter too much text, the box may stretch.                       |
|                        | ■ Initial value                                                          |
|                        | You can set the text that this component displays by default.            |
|                        | ■ ASCII text                                                            |
|                        | This component outputs standard ASCII text.                              |
|                        | See “Mask Edit” on page 334.                                            |
|                        | Use the Mask Edit component when you want users to follow a particular, consistent format with the text that they enter. |
Table 14-51  Text box components and features (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>Features</th>
</tr>
</thead>
</table>
| Percent Edit | This component includes the following features:  
  - Entry restriction  
    All numeric values are converted to a percentage, and you can restrict the minimum value and the maximum value.  
  - Single-line text entry  
    If users enter too much text, the box may stretch.  
  - Initial value  
    You can set the text that this component displays by default.  
  - ASCII text  
    This component outputs standard ASCII text.  
  Use this component when you want users to enter a percentage, and you want that percentage to be in the following format: ###.##% |
| HTML Editor | This component includes the following features:  
  - Multiline capability  
  - HTML editing  
  - HTML text  
    This component outputs HTML text. By using HTML text, you may restrict where you can use the text in other parts of your process.  
  - Initial value  
    You can set the text that this component displays by default.  
  See “HTML Editor” on page 330.  
  Use this component when you want to let users format the text that they enter. Make sure that your project can handle HTML text before you use this component. For example, you cannot display HTML text in an ASCII Merge Label component. |

About themes

Form themes are design styles for the forms that include background, control, and text formatting. You can apply a theme to any form component, such as Form Builder or Terminating Form Builder. Use form themes when you want to improve
the appearance of your form and maintain a uniform style across all of your forms. You can apply one of the many preset form themes to your form, or you can create your own with the Web forms Theme Editor.

See “About the Web forms theme editor” on page 635.

You can add different themes to different forms in the same project. However, you can also set a default project theme that is applied to all of your forms.

The two parts of a form theme are as follows:

- **Background style**: The part of a form theme that frames in the form. The background is composed of a series of images that make up the border and workspace on a form.
- **Control style**: The part of a form theme that determines the control styling. Although every control can be stylized, usually only the most commonly used controls (such as the Text Box component) are stylized.

See “Adding a theme to a form” on page 366.
See “Editing a form theme” on page 367.
See “Creating a form theme” on page 367.
See “About form theme best practices” on page 369.
See “About themes in Workflow Solution 8.0” on page 369.

### Adding a theme to a form

You can apply a theme to any form component, such as Form Builder or Terminating Form Builder. Use form themes when you want to improve the appearance of your form and maintain a uniform style across all of your forms.

See “About themes” on page 365.
See “Editing a form theme” on page 367.

**To add a theme to a form**

1. Open the Web form Editor by double-clicking a form component (for example, Form Builder) in your project.
2. In the upper left corner, click the **Select Theme** option.
3. If you want to use a theme in the **Available themes** pane, click that theme, and then click **OK**.
4 If there is no theme in the Available themes pane, or if you want to use a different theme, click the Edit Project Themes option.

5 Click Add.

6 In the left pane, click a theme, and then click OK.

7 Click Close.

8 In the Available themes pane, click the theme that you added, and then click OK.

Editing a form theme

You can edit any form theme that you want to apply. You can change everything about every theme, including background style and control styles.

See “About themes” on page 365.

See “Adding a theme to a form” on page 366.

To edit a form theme

1 Open the Web form Editor by double-clicking a form component in your project (for example, Form Builder).

2 In the upper left corner, click Select Theme.

3 If you want to edit a theme in the Available themes pane, click that theme, and then click Edit Selected Theme.

4 If you want to edit a theme that is not in the Available themes pane, add that theme to the project themes, then select it, and click Edit Selected Theme.

See “Adding a theme to a form” on page 366.

5 Edit any of the properties of the theme.

See “About the Web forms theme editor” on page 635.

6 Click OK.

Creating a form theme

You can create new form themes using the Web forms Theme Editor. After you have created a form theme, you can use your theme in any form component (such as the Form Builder component).

Before you can create a theme, you must have the images that you want to use in your theme. You need eight images for a background. Backgrounds are not a single image; they are a series of repeated, layered images.
You can also use images for control styles, such as the Button component.

See “About themes” on page 365.

**To create a form theme background style**

1. Open the Web forms Theme Editor (Start > Programs > Symantec > Workflow Designer > Tools > WebForms Theme Editor).
2. Click **File > New**.
3. Click **Theme > Add Image**, and then add an image you need to create your theme. Add all the images you need for your theme.

   All the images you add appear under the **Images** header in the tree structure in the left pane.

4. Under the **Border Setup** tab, enter the width (in pixels) of the left, right, top, and bottom images of the theme background.

   Remember that the left border images and the right border images must be the same width as the corner images. Also, the top images and the bottom images must be the same height as the corner images.

5. Under the **Border Images** tab, set which image you want to use for each section of the background.

6. (Optional) Under the **Background** tab, set the background color, page color, and background image.

   Symantec recommends setting the background and the page color to white and using no background image. The background image refers to the image that fills the middle of the background.

7. (Optional) Under the **Size** tab, set the fixed size of the theme background.

   Symantec recommends not using a fixed size unless the background style requires it. If you use a fixed size, users cannot resize the form during design-time.

**To create a form theme control style**

1. In the Web forms Theme Editor, click **Theme > Add Standard Control Style** or **Add Custom Style**.

   Symantec recommends using only standard control styles unless the control you want to edit is not available in the standard control styles.

2. Under the **Font** tab, configure the font settings.

   These settings are applied to all text that appears in this control style.
About form theme best practices

Follow these best practices when working with form themes.

- Always create a new theme instead of editing an existing theme. All edited themes are overwritten when Workflow is installed. The editing work that you did is lost when you reinstall or upgrade Workflow.

- If you want to edit an existing theme, make a copy of the theme file, rename it, and then edit the new file.

- Create a new folder in C: > Program Files > Symantec > Workflow > Designer > Themes for new or custom themes.

- When you edit a theme, do not remove images unless you have the original image file.

- When you create a theme background, first create the entire background in a graphics editor, and then cut the image into separate pieces.

- When you use a background image for a control style, use an image that has a symmetrical pattern that can be repeated horizontally or vertically.

See “About themes” on page 365.

About themes in Workflow Solution 8.0

If you install Workflow Solution 8.0 for the first time, only the following themes will be available in the <Install directory>\Designer\Themes folder:

- Default
- ServiceDesk
- Symantec

Note: From Workflow Solution 8.0, themes with the resolution of 600x400 are not available from the Themes folder and Workflow Designer.
Backing up the Themes folder before an upgrade to Workflow Solution 8.0

After an upgrade to Workflow Solution 8.0, all the existing themes are erased and a new Themes folder is created that contains Default, ServiceDesk, and Symantec themes.

You must take a backup of the `<Install directory>\Designer\Themes` folder in the case of the following scenarios:

- If you require a deprecated theme after the upgrade.
- If you have customized any of the Default, ServiceDesk, and Symantec themes and want to reuse them after the upgrade.
- If you have created a new theme that you want to use after the upgrade.

About form templates

Form templates are form control layout and style standards. You should use form templates specifically with labels (for example, the HTML Merge component). Templates restrict which components you can add to them. For example, you cannot add a Text Box component. Templates have component restrictions because data problems arise when the same data-entry components are used on multiple forms.

You can use templates in any form component (such as the Form Builder component). Use templates to create a standard set of controls that you can apply immediately to any form and edit easily across all of your forms. Templates determine the location and the style of the controls that you want to apply to a form. When you make changes to a template, those changes are applied to every form with that template. This capability makes it easy to create a consistent, easily editable form layout across multiple forms.

Templates apply to only one project. You can use a template in any form in your project, but you cannot use that template outside of the project.

See “Creating a form template” on page 370.
See “Applying a form template” on page 371.

Creating a form template

You can create a form template in any form component (such as a Form Builder component). Use form templates to create a consistent, easily editable control layout that you can apply across all your forms. After you create a template you can apply it to any form in your project. When you make changes to a template, those changes are applied to every form with that template.
See “About form templates” on page 370.

See “Applying a form template” on page 371.

To create a form template

1 In an open project in Workflow Designer, add a form component to the workspace.

You can add form components in Webforms-type projects. You can also add form components in some of the components that are in Workflow-type projects: for example, the dialog model of the Dialog Workflow component.

2 Double-click the form component to open the form editor.

3 Right-click on the workspace, click Templates, and then click New Template.

4 Name your template.

Use a name that represents a single, reusable form layout such as End User View.

5 In the template editor, add of the all the components that you want to use on your form.

Symantec recommends that you use only labels and other non-functioning components in your template. The components that you add to the template cannot be moved or edited in the main form editor. Add only the components that you do not need to edit often.

6 When you have finished designing your form template, click OK.

In the main form editor, notice that the components that you added to the template appear on the form. The lock symbol and the arrow symbol show that the component is part of the form template. You cannot edit the component in the main form editor. If you want to edit the component, double-click it to open the template editor.

Applying a form template

You must create a form template before you can apply it to a form.

See “Creating a form template” on page 370.

You can apply a form template to any form component. Use form templates to create a consistent, easily editable control layout that you can apply across all of your forms.

See “About form templates” on page 370.
To apply a form template

1 In an open project in Workflow Designer, add a form component to the workspace.

   You can add form components in Webforms-type projects. You can also add form components in some components in Workflow-type projects: for example, the dialog model of the Dialog Workflow component.

2 Double-click the form component to open the form editor.

3 Right-click on the workspace, click Templates, and then click the template that you want to add to your form.

   The components that are part of the template that you selected appear on your form with a lock symbol and an arrow symbol.
About using tasks

Task integration refers to setting up a workflow process to communicate with a task handling system, such as Process Manager or SharePoint. Task integration refers not only to delivering a task to a task list but also to tracking task progress. Your workflow process can handle the entire task process: task creation, progress tracking and reporting, and task completion. Workflow can integrate with four different task systems.
Table 15-1  Description of task sources

<table>
<thead>
<tr>
<th>Task Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AltirisTaskSource</td>
<td>Creates tasks in Altiris Help Desk 6.5.</td>
</tr>
<tr>
<td>DefaultTaskSource</td>
<td>Creates a task in the internal task manager of Workflow. Tasks that are created in this task manager do not appear in any portal or interface but exist invisibly in data. Most commonly, the assigned user gets a link to the task in an email. See “Delivering a task in an email” on page 377.</td>
</tr>
<tr>
<td>ProcessManagerTaskSource</td>
<td>This task source creates a task in the Process Manager portal. Tasks that are created here can be assigned to Process Manager users.</td>
</tr>
<tr>
<td>ActiveDirectoryTaskSource</td>
<td>This task source gives you access to Active Directory users. It does not create a task in Active Directory.</td>
</tr>
<tr>
<td>SharePointTaskSource</td>
<td>This task source creates a task in SharePoint. Tasks that are created here can be assigned to SharePoint users.</td>
</tr>
</tbody>
</table>

See “About the Dialog Workflow component and tasks” on page 374.
See “Setting task source in a Dialog Workflow component” on page 375.

About the Dialog Workflow component and tasks

Tasks are one of the most central concepts in Workflow. A task is a piece of work that can be assigned to a specific person. Tasks can be any step in a business flow that requires human interaction from approve and reject, review and close, to installing and configuring a piece of hardware. The Dialog Workflow component is the main source of tasks in Workflow. Part of the function of the Dialog Workflow component is to create tasks. A Dialog Workflow component can create a task in any of the following places: Process Manager, SharePoint, Altiris Help Desk 6.5, and the default task manager (an internal task manager for workflow processes). These options are available in the Assignments tab of the Dialog Workflow editor. The two most common places the Dialog Workflow component creates tasks is DefaultTaskSource and ProcessManagerTaskSource.

In addition to creating tasks, the Dialog Workflow component can also assign tasks to individuals. This means that the task appears in the specific task list of the assigned person.

See “Setting task source in a Dialog Workflow component” on page 375.
Setting task source in a Dialog Workflow component

The Dialog Workflow component creates and assigns tasks. With the help of the Dialog Workflow component you can create and assign tasks using one of four task sources.

<table>
<thead>
<tr>
<th>Task Source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AltirisTaskSource</td>
<td>Creates tasks in Altiris Help Desk 6.5.</td>
</tr>
<tr>
<td>DefaultTaskSource</td>
<td>Creates a task in Workflow’s internal task manager. Tasks that are created in this task manager do not appear in any portal or interface but exist invisibly in data. Most commonly, the assigned user gets a link to the task in an email. See “Delivering a task in an email” on page 377.</td>
</tr>
<tr>
<td>ProcessManagerTaskSource</td>
<td>Creates a task in the Process Manager portal. Tasks that are created here can be assigned to Process Manager users.</td>
</tr>
<tr>
<td>ActiveDirectoryTaskSource</td>
<td>Gives you access to Active Directory users. It does not create a task in Active Directory.</td>
</tr>
<tr>
<td>SharePointTaskSource</td>
<td>Creates a task in SharePoint. Tasks that are created here can be assigned to SharePoint users.</td>
</tr>
</tbody>
</table>

By default, AltirisTaskSource, DefaultTaskSource, and ProcessManagerTaskSource are available in a Dialog Workflow component. If you want to make the ActiveDirectoryTaskSource and SharePointTaskSource libraries available, you must import them into the project.

See “Importing components into a project” on page 215.

To set task source in the Dialog Workflow component

1. In an open Workflow-type project, add a Dialog Workflow component to the workspace.
2. Open the component editor.
   Double-click the Dialog Workflow icon in the workspace to open its editor.
3. Under the Assignments tab, click the Task Source Type drop-down list.
4. Select a task source, and then click OK.
Setting a task assignment in a Dialog Workflow component

You should assign any tasks that you create with the ProcessManagerTaskSource. This assignment is not true of tasks that were created with the DefaultTaskSource, because those tasks are available only through an email, and the email is sent only to the person who needs to perform the task. With ProcessManagerTaskSource, however, the task is created generically in the Process Manager portal without any specific assignment.

See “About the Dialog Workflow component and tasks” on page 374.

You have four options while you configure an assignment.

Table 15-3   Description assignment options

<table>
<thead>
<tr>
<th>Assignment option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provide Value</td>
<td>Lets you provide a constant value for the assignment. If you use a constant value, make sure that it is an accurate value which authenticates. For example, if you use the ProcessManagerTaskSource, your constant value must match a registered user in Process Manager. If you use the constant value &quot;<a href="mailto:manager@company.com">manager@company.com</a>&quot;, then that value must also identify a user in Process Manager.</td>
</tr>
<tr>
<td>From List</td>
<td>Lets you choose from a list of users in your task source target. For example, if your task source target is Process Manager, the From List option lets you choose from a list of Process Manager users. This list is dynamically populated from the list of registered users in Process Manager. If you use another task source target such as SharePoint, the user list is populated from that source.</td>
</tr>
<tr>
<td>Search List</td>
<td>Lets you search from a list of users from your task source target. This option is helpful if your task source target contains many users.</td>
</tr>
<tr>
<td>From Process</td>
<td>Lets you use a process variable for the assignment.</td>
</tr>
</tbody>
</table>
To set a task assignment in a Dialog Workflow component

1. In an open process, open the Dialog Workflow component editor. Double-click the component to open its editor.

2. On the Assignments tab, under Task Assignments, to the right of the applicable Assignments box, click the ... symbol.

3. Click Add.

4. Add an assignment from one of the available sources, and then click OK.

5. (Optional) Add more assignments.

Delivering a task in Process Manager and email

Using the ProcessManagerTaskSource configuration, with a little extra configuration you can deliver a task in Process Manager and in an email. Delivering a task in the portal and in an email helps to ensure the following:

- That the user sees the task (in an email).
- That the user cannot misplace it (because it stays in the portal task list).

If the user works the task through email, Process Manager removes it from the user’s task list. If the user performs the task through Process Manager, the email link becomes inoperable.

To deliver a task in Process Manager and email

1. In an open workflow project, open a Dialog Workflow component's editor. Double-click the component to open its editor.

2. On the Assignments tab, set the Task Source Type to ProcessManagerTaskSource.

3. On the Assignments tab, assign the task to the appropriate user.

   See “Setting a task assignment in a Dialog Workflow component” on page 376.

4. On the Interaction Setup tab, set the Start Process to send an email.

   See “Delivering a task in an email” on page 377.

Delivering a task in an email

You can deliver a task to a user in an email message using the Dialog Workflow component. Delivering a task in an email message is a good way to make sure that
the user sees the task. However, the tasks that are sent in this way can be easily lost among a user's other email messages.

You can deliver tasks to users in multiple ways. You can choose one of these other methods instead of sending an email or combine the methods to deliver a task in multiple ways.

See “Delivering a task in Process Manager and email” on page 377.

See “Setting task source in a Dialog Workflow component” on page 375.

To deliver a task in an email

1. In an open workflow project, open the Dialog Workflow component's editor.
   
   Double-click the component to open its editor.

2. On the **Event Configuration** tab, click the ... symbol next to the Start Process.
   
   This option opens the Start Process editor, which by default contains only a start and an end component.

3. Add a **Send Email** component to the workspace, and connect all three components.

4. Open the Send Email component's editor.
   
   Double-click the component to open its editor.

5. Configure the Send Email component.
   
   Set the From Address, To Address, and Subject.

6. Configure the actual email message.
   
   Click the ... symbol next to the HTML content. From the left panel, drag **ResponsePageLink** onto the email palette. This option adds a link in the email to the dialog that is contained in the Dialog Workflow component.

7. Click **OK** to exit the content editor.

8. Click **OK** to exit the email editor.

9. Click **OK** to exit the start process editor.

**Escalations and timeouts**

Escalations and timeouts apply to only Workflow-type components (such as Dialog Workflow). Escalations raise the urgency and visibility of necessary user input as a workflow nears timeout. Timeouts redirect, restart, or close a workflow if it has not received necessary user input by the defined deadline. Escalations and timeouts run automatically after they have been defined. When the allotted time expires, an
escalation or timeout is triggered automatically. You can configure escalation and timeout timeframes.

Not all workflow components have escalations and timeouts. For example, the Wait on External Event component does not wait for human interaction so it does not escalate the task.

Sometimes escalations and timeouts fail because of authentication issues in IIS. If your escalations and timeouts fail, enable anonymous access to AutoInvokeDelegateService.asmx and WorkflowManagementService.aspx in the project directory of the published project in IIS.

Escalations and timeouts cannot occur more frequently than the Workflow Job Server is set to check for process events. For example, if your Job Server is set to check every five minutes, escalations and timeouts cannot happen more frequently than five minutes. In this case, if you set escalations and timeouts to occur more frequently (for example, in two minutes), even though they do not break, they do not appear until the Job Server checks for events.

See “Server Extensions Configurator” on page 617.
See “Setting escalations and timeouts” on page 379.

Setting escalations and timeouts

Escalations and timeouts are configured in the individual components to which they apply. For example, you can set a workflow component (such as Dialog Workflow) to escalate in two days and timeout in seven. Escalations and timeouts are also dependent on the Workflow Job Server. Escalations and timeouts cannot happen more frequently than the Workflow Job Server is set to check for process events.

See “Server Extensions Configurator” on page 617.

The scheduling service can be triggered using any mechanism that would normally be used for this type of intermittent system triggered event. Symantec provides a windows service for this mechanism. This service (Windows Job Service) is included in the Symantec Workflow install.

To set escalations and timeouts

1. In an open Workflow-type project in Workflow Designer, add a Workflow-type component (such as Dialog Workflow) to the workspace.

2. Open the component’s editor
   Double-click the component to open its editor.
3 Find and set the escalation and the timeout properties.

These properties appear in different places for different Workflow-type components. For the Dialog Workflow component they appear under the Event Configuration tab.

4 Click OK to close the editor.

About using business time spans

Business time spans let you define the working days and hours for your organization. You can define daily working hours, weekends, and holidays. You can use the business hours to restrict when certain events happen in a workflow process.

For example, in a Dialog Workflow component in Workflow Designer, you can set a Late Date and a Due Date for the task that the component creates. If you do not want the dates to occur on weekends or holidays; use a business time span to define when they can occur.

You can set a business time span in three places: in the Business TimeSpan Editor, in a project's Publishing tab, or in individual components. The Business TimeSpan Editor creates global business time spans. You can use global business time spans in any project. After you create a business time span in the Business TimeSpan Editor, you can use that time span in any project without additional configuration.

See “About the Business TimeSpan Editor ” on page 600.

See “Creating a business time span in an individual component” on page 382.

When you set a business time span in a project's Publishing tab, that time span applies to only the local project.

See “Publishing tab” on page 164.

See “Creating a business time span in the publishing tab” on page 381.

When you set a business time span in an individual component, that time span applies only to the local component.

You can also add business hour components to your workflow projects in Workflow Designer (such as the Add Business Hours component). These components do not change the business time span that you have configured elsewhere. They only change the business hour variables that you have in your process, respecting the business time span for the project. For example, if you use an Add Business Hours component to add six hours to its input date, the component adds the time as it falls within business hours. If the component is set up to use 9:00-17:00 for daily business hours, it does not add hours after 17:00. When it adds the six hours, if they fall after 17:00 the component adds them to the next business day starting at 9:00.
Creating a business time span in the publishing tab

You can set a business time span in a project's Publishing tab.

You can also create a business time span in the Business TimeSpan Editor or in individual components.

See “About using business time spans” on page 380.

See “Creating a business time span in an individual component” on page 382.

See “About the Business TimeSpan Editor” on page 600.

To create a business time span in a project’s publishing tab

1. Open a project in Workflow Designer.
   - You can open a project of any type (Workflow-type, Monitoring-type, and so on).

2. In the project tree structure in the left pane, click the name of the project.
   - The name of the project is the top item in the tree structure.

3. Click the Publishing tab.

4. Click the ... symbol next to Business Time Span Config.

5. Add holidays.
   - The following table describes the properties for adding a holiday:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Holiday ID</td>
<td>The name of the holiday.</td>
</tr>
<tr>
<td>Date</td>
<td>The date on which the holiday occurs.</td>
</tr>
<tr>
<td>Description</td>
<td>An optional description of the holiday. This description appears only in the Business TimeSpan Editor.</td>
</tr>
</tbody>
</table>

6. Add weekend days.
   - When you add days to the Weekends property, you define which days are considered weekend days every week.

7. In the General tab, configure the daily business hours.
Creating a business time span in an individual component

You can create a business time span in some components in Workflow Designer. These components include the Dialog Workflow component and business hours components (such as the Add Business Hours component).

You can also create a business time span in the project's **Publishing** tab or in the Business TimeSpan Editor.

See “Creating a business time span in the publishing tab” on page 381.

The following steps describe how to set a business time span in a Dialog Workflow component.

**To create a business time span in an individual component**

1. Open a Workflow-type project in Workflow Designer.
2. Add a Dialog Workflow component to the workspace, and then double-click it to open its editor.
3. On the **Assignments** tab, click **Set Late Date And Due Date**.
4. To the right of the **Late Date** box, click the **...** symbol.
5. Click **Dynamic Value**, and then click **Edit**.
6. Set the **Business Time Span Config Usage** value.

The following table describes the options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>UseGlobal</strong></td>
<td>Sets the component to use the business time span as it is configured in the Business TimeSpan Editor.</td>
<td>“About the Business TimeSpan Editor” on page 600.</td>
</tr>
<tr>
<td><strong>UseProject</strong></td>
<td>Sets the component to use the business time span as it is configured in the project's publishing tab.</td>
<td>“Creating a business time span in the publishing tab” on page 381.</td>
</tr>
<tr>
<td><strong>UseCustom</strong></td>
<td>Sets the component to use its own business time span. If you choose this option, a new property appears in the component editor (<strong>Business Time Span Config</strong>).</td>
<td></td>
</tr>
</tbody>
</table>
7 If you selected **UseCustom**, to the right of the **Business Time Span Config** box, click the ... symbol.

8 In the business hours editor, add holidays.

   The following table describes the properties for adding a holiday:

   **Holiday ID**  The name of the holiday.
   **Date**  The date on which the holiday occurs.
   **Description**  An optional description of the holiday. This description appears only in the Business TimeSpan Editor.

9 Add weekend days.

   When you add days to the **Weekends** property, you define which days are considered weekend days every week.

10 In the **General** tab, configure the daily business hours.

11 Click **OK**.
Section 5

Using Process Manager

- Chapter 16. About Process Manager
- Chapter 17. Managing the portal
- Chapter 18. Managing Workflow processes in Process Manager
- Chapter 19. Managing documents in Process Manager
- Chapter 20. Managing the Knowledge Base and discussions in Process Manager
- Chapter 21. Managing schedules in Process Manager
- Chapter 22. Managing data in Process Manager
- Chapter 23. Managing the service catalog in Process Manager
- Chapter 24. Managing accounts in Process Manager
- Chapter 25. Performing administrative tasks in Process Manager
- Chapter 26. Mobile Process Manager
- Chapter 27. Reporting in Process Manager
About Process Manager

This chapter includes the following topics:

- About Process Manager
- Opening Process Manager
- About Process Manager pages
- Process Manager tabs
- About Process Manager and tasks
- About profiles
- Setting your opening portal page
- Symbols in Process Manager
- About the Process View page
- About document types
- Actions in the Process View page
- Setting the Process View page to open another task automatically
- About the tag cloud

About Process Manager

Process Manager is a Web portal that lets you manage the various parts of a workflow process such as tasks, documents, data, and so on. Process Manager lets you create teams, processes, document repositories, libraries, Wikis, FAQs, and more quickly and easily. You can launch or schedule a process, assign tasks
to users, and track the task progress. Users can see what the status of processes are, what is late, and where to find the information they need.

See “Core architectural components of Workflow” on page 39.

Process Manager also has a graphical interface that is intuitive and easy to use.

Process Manager is also thoroughly customizable. You can change pages, symbols, web parts, and so on to create an interface that works for you. You can also add new pages to Process Manager that embed either Process Manager content, or content from the Web or other servers. Process Manager lets you design a hierarchy of pages that suit your specific needs. This capability lets you work the way you want to work within a larger process framework.

You can also customize pages to combine and display information in a logical, coherent manner. For example, users can create a custom symbol on the main page for a process document repository. The symbol makes it easy to locate the document repository. Users can also create a page with the content that is extracted from existing external Web sites, as well as queries from inside Process Manager. For example, a project manager can create a page that has the following information: current metrics for the process, a list of tasks that are due, postings to the FAQ and Wiki, and the current prices of various stocks.

See “Process Manager tabs” on page 387.

See “Symbols in Process Manager” on page 389.

See “About document management” on page 439.

See “About the knowledge base and discussions” on page 465.

Opening Process Manager

Process Manager is a Web portal that you open in a Web browser. You can open Process Manager using two different methods. If Process Manager is installed on your computer, you can open it in the Programs menu. If Process Manager is not installed on your computer, you can access it by typing a URL in a Web browser.

See “About Process Manager” on page 385.

You can set the default opening page.

See “Setting your opening portal page” on page 389.
To open Process Manager in a Web browser

1. Open a Web browser.
2. Type the URL for a computer that has Process Manager installed: for example, http://10.113.0.85/ProcessManager.
   You must have network access to the Process Manager Computer.
3. Type your credentials, and then click Login.

About Process Manager pages

The Process Manager portal is made up of Process Manager pages. When you log on to Process Manager, your permissions determine the Process Manager pages that are available to you. If you cannot access a Process Manager page that is described in this documentation, then you may not have the appropriate permission.

See “About Process Manager” on page 385.

The Process Manager pages can be customized for the entire organization. These pages can be customized for users, groups, organizational groups, or permission groups. Administrators have permission to customize Process Manager pages and to grant customization permissions to other Process Manager users.

You can add new home pages to the main interface, and you can add sub-pages to home pages. Each page can have the content that is derived from inside of the Process Manager system. Each page can also have the content that is gathered from other sources to which your system has access: for example, network servers or the World Wide Web. These pages let you use Process Manager as a portal both to the Web and to the existing Process Manager repository. You can create the content and the displays that you need to work more efficiently.

To create a new page or sub-page for an existing home page, use the Site Actions link in the top right of the Process Manager portal.

See “About customizing Process Manager pages” on page 404.

See “Admin tab” on page 528.

Process Manager tabs

Process Manager is an integrated application that is composed of several major modules. A tab in the Process Manager portal represents each module.

You can also create your own modules to customize the interface to suit your requirements. The permissions that the administrator assigns may restrict access to some parts of these modules.
See “About Process Manager” on page 385.

Table 16-1  Default tabs in Process Manager

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documents</td>
<td>Contains a document repository that lets you manage files.</td>
</tr>
<tr>
<td>Knowledge Base</td>
<td>Contains a knowledge base, discussion forum, and schedules. You can use the knowledge base to create wiki articles and other media. You can use the discussion forum to host discussions and moderate discussions. You can use the schedules manager with processes, and show deliverable deadlines and other events.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Lets you view existing tasks and invoke workflow processes. The Service Catalog contains workflow processes that you published to Process Manager.</td>
</tr>
<tr>
<td>Admin</td>
<td>Lets the administrator change settings. Administrators can manage permissions. Administrators can also manage the applications that are used in the process, the processes and subprocesses, and the behavior and look of Process Manager.</td>
</tr>
<tr>
<td>Submit Request</td>
<td>Lets you invoke workflow processes. The Service Catalog contains workflow processes that you published to Process Manager.</td>
</tr>
<tr>
<td>Reports</td>
<td>Lets you view reports on workflow processes.</td>
</tr>
</tbody>
</table>

About Process Manager and tasks

Tasks are one of the most important parts of Process Manager. The main function of Process Manager is to organize your interaction with Workflow processes. The primary way you interact with processes is with tasks.

By default, tasks appear in the Workflow Task List, which is found on the Workflow tab (as well as some other locations).

All of the tasks that are in Process Manager come from a Workflow process. You cannot create tasks directly in Process Manager without using a Workflow process.

See “Setting up workflow task integration between Workflow Designer and Process Manager” on page 436.

After you create a task in Process Manager, you can access the task in a task list. The task opens in a process view page.
About profiles

Profiles are the custom data definitions that you can use to organize and sort items in Process Manager. You can create profiles for service catalog items, tasks, reports, documents, processes, accounts, schedules, repository items, articles, and more. Profiles are like custom data types: you can create a profile with the property values that you can set for individual instances of the profile.

Use profiles when you want to attach information to an item about how to use that item in Process Manager. For example, you can create a profile that keeps track of confidential documents. You can apply this profile to all of the documents in the document manager, and then you can sort the documents by their confidentiality. With this profile you can also decide how a workflow process handles a document. If you use a document in a workflow process, you can check its confidentiality setting and use it in different ways based on the value.

See “About the Lists and Profiles page” on page 483.

Setting your opening portal page

When you log on to the Process Manager portal, the portal opens to a specific page. Initially, your permissions determine which page opens. However, you can set a different page to open when you log on. This page does not have to be the one that is labeled the Home page.

See “Opening Process Manager” on page 386.

To set your opening page

1. In the Process Manager portal, open the page that you want to make your home page.
2. At the bottom of the portal window, click Make Home Page.

Symbols in Process Manager

Process Manager has several symbols that represent different actions. You may not be able to see some of the symbols based on your permission level. All of the symbols are available to administrator users.

See “About Process Manager” on page 385.
Table 16-2  Symbols in Process Manager

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Symbol" /></td>
<td>Hides or shows content within a Web part.</td>
</tr>
<tr>
<td><img src="image2" alt="Symbol" /></td>
<td>Takes an action. When you click this symbol you are given additional options, such as edit, delete, or add new.</td>
</tr>
<tr>
<td><img src="image3" alt="Symbol" /></td>
<td>Takes an action, searches, and changes reports, respectively. These three symbols often appear together. See “Options for customizing a Process Manager page list” on page 428.</td>
</tr>
<tr>
<td><img src="image4" alt="Symbol" /></td>
<td>Adds a new item to the list.</td>
</tr>
<tr>
<td><img src="image5" alt="Symbol" /></td>
<td>Adds a new reference item to the list, such as a report.</td>
</tr>
<tr>
<td><img src="image6" alt="Symbol" /></td>
<td>Adds a new category or division to the list, such as a report category.</td>
</tr>
<tr>
<td><img src="image7" alt="Symbol" /></td>
<td>Launches a service catalog item.</td>
</tr>
</tbody>
</table>

About the Process View page

This page lets you view and work with a running workflow task or process. The Process View pages always display some general information about a process. These pages also usually include the actions that you can take. The Process View page is one of the most important pages in Process Manager.

The Process View page appears when a user clicks on a link to a running process in Process Manager. Users typically access this link in the task list on the Workflow tab. Users can also access this link in the process list or in a report.

See “About the Workflow tab” on page 433.
See “Viewing a task or process in Process Manager” on page 435.
A published workflow can have a Process View page if the process is configured as a process and if the process publishes to Process Manager.

See “Setting up workflow task integration between Workflow Designer and Process Manager” on page 436.

The Process View page displays information about how a process is configured. By using certain special components (such as the Set Process State/Status component) in your process, you can communicate process information to Process Manager. This process information (such as process status) appears on the Process View page.

You can configure a workflow project so that its Process View page displays the process history that identifies what has been done in the process. You can also configure the project so that the Process View page displays actions and the permissions that are associated with the process.

In a Process View page, process metadata appears in the top section. The process description and history appear under the metadata on the left side. All of this information can come from various sources within the process. For example, the description may come from a textbox in a Web form that a user has filled out. A developer may also hard-code the description. The process components in Workflow Designer identify where this information comes from.

The right side of a Process View page usually contains a number of actions. The **Page Selector** lets you choose from all of the Process View page layouts that are available. **Other Actions** are listed under the page selector. In this case, only the respond action is available for the user.

### Table 16-3 Default sections on the Process View page

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top section (unlabeled)</td>
<td>Provides a quick view of the task’s details and statistics. This section also contains the following action links:</td>
</tr>
<tr>
<td></td>
<td>■ Refresh</td>
</tr>
<tr>
<td></td>
<td>■ Add Comment</td>
</tr>
<tr>
<td></td>
<td>■ Edit Process</td>
</tr>
<tr>
<td></td>
<td>Opens the <strong>Add Comment to Process</strong> dialog box.</td>
</tr>
<tr>
<td></td>
<td>Opens the <strong>Edit Process</strong> dialog box, which lets you edit some of the process details that appear in the top section.</td>
</tr>
<tr>
<td>Select page</td>
<td>Lets you switch between the <strong>Full Process View</strong> and the <strong>Basic Process View</strong>.</td>
</tr>
<tr>
<td>Open Chat on Process</td>
<td>Lets you initiate an instant messenger-type conversation with a process contact or other worker. The chat function provides a real-time setting in which to perform troubleshooting.</td>
</tr>
</tbody>
</table>
### Table 16-3  Default sections on the Process View page (continued)

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>(Read only) Displays the description that was entered during the task’s initial creation.</td>
</tr>
<tr>
<td>Documents</td>
<td>Displays any documents that are attached to the process or task and lets you attach additional documents.</td>
</tr>
<tr>
<td>History</td>
<td>Displays a record for each action that has occurred within the process. For example, a record can represent a status change, a task, or a user comment. Within the History section, you can view information about each record.</td>
</tr>
<tr>
<td>Actions</td>
<td>Lists the actions that you can take to effectively work the task. The actions that appear depend on the type of task that you open. For example, when a support technician opens an incident, the available actions include resolving the incident, escalating the incident, and suggesting a self-service resolution. Some of the actions are common to all of the tasks. For example, most types of tasks let you send an email or search the knowledge base.</td>
</tr>
</tbody>
</table>

### About document types

Document types are categories that help classify documents. Document types are a listing of types of documents that have been uploaded to the portal. By default, when you upload a document whose type has not been registered, the document gets added automatically to the documents type list.

See “Working with document types” on page 480.

### Actions in the Process View page

In a Process View page with a default configuration, Actions are shown as links under the process metadata. Usually there is one main link for the primary action of the task (such as Respond) and other links for secondary actions.

Some default actions such as Edit and Remove Task are available on all tasks. Other actions are set in components in your project (usually the Dialog Workflow component). You can edit actions or create new actions in the component editor of the component that is responsible for them.

See “About the Process View page” on page 390.

Depending on how your process is configured, the following actions may appear in a process view page:
To edit a task
1. In the process view page, click **Edit**.
2. Edit the properties for the task.
   
   For example, you can raise the **Priority** or change the **Due Date**.
   
   You may not be able to edit all of the properties for the task, depending on your permissions.
3. Click **Save**.

To change the assignment of a task
1. In the process view page, click **Assignments**.
2. Pick the assignment type (**User**, **Group**, and so on).
3. Set the user to be assigned.
4. Set an assignment date range.
   
   After this date range, the task is reassigned to you if it is not yet complete.
5. Click **Add**.

To postpone a task
1. In the process view page, click **Postpone**.
2. Set a date for the task to reappear in your task list, and then click **Postpone**.

To remove a task
1. In the process view page, click **Remove Task**.
2. Enter a description for why you want to remove the task, and then click **Remove**.

See “Viewing a task or process in Process Manager” on page 435.
See “About the Manage Pages page” on page 396.

Setting the Process View page to open another task automatically

You can set the Process View page to open another task automatically after you complete a task. Use this setting if you have multiple tasks and you do not want to return to the main task list after you complete each task.

See “About the Process View page” on page 390.
See “Viewing a task or process in Process Manager” on page 435.
You can set the Process View page to open another task automatically in the following ways:

**Change the URL manually**

With a Process View page open, you can change the URL so that it opens the next task after you finish the first task. You must change the URL manually every time you open a new Process View page.

**Create a process that sets a new URL**

You can create a workflow process that edits the Process View page URL so that it opens another task after you finish the first task.

To set the Process View page to open another task automatically

1. Open a Process View page in Process Manager.
   
   In the task list in Process Manager, click a task to open a Process View page. (The task that you click must be part of a process that supports Process View pages.)

2. In the URL of the Process View page, after the `TaskID`, append this phrase to the end of the URL: `&SuggestNextProcessID=1`.
   
   If your Process View page does not have a URL bar, change your browser settings to open on a new tab.

3. After changing the URL, press **Enter** to reload the page with the correct URL.

4. Complete the task as usual.
   
   After you complete the task, a dialog box appears to redirect you to the next task. If you close the Process View page and open another one, you must change the URL again.

---

**About the tag cloud**

The tag cloud lets you tag documents and filter by that tag later. When you add a document, you can add a list of tags that is comma-separated. On the **Documents** tab of Process Manager, there is a **Tags Cloud** Web part that shows a distinct list of these tags. You can click on a tag to bring up all documents with that tag.

See “About the Documents page” on page 440.

See “Adding a new document (Simple file)” on page 443.

See “Adding a new document (Advanced file)” on page 444.
Managing the portal

This chapter includes the following topics:

- About the Manage Pages page
- Adding new Process Manager pages
- Add Page page
- New Page Wizard: Step 2 page
- Viewing the settings of a page
- Adding a root page
- Importing a page
- Going to a page
- Adding a sub-page
- About customizing Process Manager pages
- Enabling the customization of a Process Manager page
- Customizing a Process Manager page (administrator)
- Customizing your Process Manager pages (non-administrator)
- Process Manager master settings
- About the Process Manager portal master settings
- Editing the Process Manager portal master settings
- Options on the Site Actions drop-down list
- Adding a Web Part to a Process Manager page
About the Manage Pages page

The Manage Pages page is located in Process Manager under Admin > Portal > Manage Pages. This page lets you control the pages in Process Manager.

Users can add new pages to Process Manager that embed either Process Manager contents, or content from the Web or other servers. By letting users design a hierarchy of pages, Process Manager lets users work the way they want to work within a larger project framework.

See “About Process Manager pages” on page 387.
See “About customizing Process Manager pages” on page 404.
See “Going to a page” on page 403.
See “Editing a Process Manager page” on page 425.
See “Deleting a page” on page 426.
See “Adding a sub-page” on page 403.
See “Moving a page up or down” on page 427.
See “Exporting a page” on page 427.
Adding new Process Manager pages

You can create new Process Manager pages. Permissions control the ability to create Process Manager pages. The administrator role automatically has the permission to create Process Manager pages. However, any user or group can be granted the permission to create Process Manager pages. The permission for adding Process Manager pages is: Portal.CanAddPages.

See “About the Manage Pages page” on page 396.

When you create a new Process Manager page, a tab is added to the main Process Manager interface with the title that you assign. You can use Process Manager pages as a high-level organizational unit for the content that is covered in sub-pages under the Process Manager page. You can also have a one-page portal that displays the specific information that you access regularly.

You can obtain content for these pages from any source that your system can access. For example, you can create a Process Manager page that gathers information from the Web, and then assembles and displays it a specific way. You can also create a Process Manager page that gathers statistics from different locations within Process Manager and displays it in sub-pages. The layout and content of these pages is up to you.

The content of the new Process Manager page is similar to the standard page type that you select. However, this page can be customized specifically to your requirements.
To create a new Process Manager page

1 In the Process Manager portal, in the Site Actions drop-down list, click Add Root Page or Add Sub Page.

2 In the New Page Wizard: Step 1 page, click the page type, and then click Next.

- **Document Library**
  Contains the document files (files such as text documents or graphics that you can manually retrieve from Process Manager or use in your Workflow projects). A documents library page is usually a subset of the Documents root page in Process Manager.

- **Articles (Diary)**
  An article that lets you enter text regularly. This article may be for personal or process use (or a combination of the two).

- **Wiki (NotePad)**
  Creates a wiki similar to those in the Articles module. However, the wiki is specific to your use (or shared with those with whom you choose to share).

- **FAQ (Frequently Asked Questions)**
  Creates a FAQ page similar to those in the Articles module. However, the page is specific to your use (or shared with those with whom you choose to share).

- **Discussion**
  Creates a discussion forum that you can share.

- **Form Library**
  Contains the forms. These forms are usually a subset of the forms in the larger Process Manager system.

- **Web Part**
  Contains content that you define in HTML format or that is gathered from the Web.

- **Site Aggregator**
  Contains content from the Web that is gathered from one or more sources and is displayed as a single unit.

- **Menu Placeholder**
  Adds a menu item that has no page with which it is associated.

3 For the document library, articles, wiki, FAQ, discussion, form library, and menu placeholder page types, do the following:
   - Enter the name for the root page.
Click **Create Page**.

4. For Web part pages, enter the information on the page.  
   See “Add Page page” on page 399.

5. For Site Aggregator pages, enter the information on the page.  
   See “New Page Wizard: Step 2 page” on page 400.

---

**Add Page page**

This page lets you define a new page in the Process Manager portal. It appears when you add a new Web part Process Manager page.

See “Adding new Process Manager pages” on page 397.

See “About the Manage Pages page” on page 396.

**Table 17-1 Options on the Add Page page**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Name</td>
<td>The text that appears in the menu for the page, regardless of where it appears in the menu hierarchy. This field is required.</td>
</tr>
<tr>
<td>Description</td>
<td>An optional description of the page that appears only in the page administration screen. It is used as a reference for managing the Process Manager pages.</td>
</tr>
</tbody>
</table>
| Include In Menu | Includes the page in the menu that you specified. If you do not select this check box, there is no menu path to the page.  
Do not select this check box if you want to create a page that can only be linked through custom content on another page. |
| Is Mobile Page  | Enables the page to be accessible by a mobile device.                                                                                                                                                      |

See "About mobile Process Manager" on page 537.
Table 17-1  Options on the Add Page page (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template Page</td>
<td>Selects the template page that you want to use for the Process Manager page. The template page specifies the number of zones that you add to the Process Manager page. Each Process Manager page is made up of Web parts, and the template page determines the size and number of Web parts on the page. Each entry on the template page drop-down list has a percentage number. This number indicates how many Web parts the page is broken into and how big those parts are. To create a single Web part, choose the 100% option. A “100%/66%/33%” template page divides the page in two. The top part takes half of the page, and the bottom half is divided into two subparts. One subpart is 66% and the other subpart is 33% of the page. This division lets you choose the page layout that best meets your page requirements. You can also specify URLs for help and image pages on the Portal Page Edit window, as well as set any parameters that you want. The last two check boxes indicate whether the page is enabled when you save it, and whether to allow users to personalize the page. This field is required.</td>
</tr>
<tr>
<td>Help URL</td>
<td>Includes a URL to a separate page that you created and that has help content. If you add a help URL to the page, you get a help link in the footer bar. This link lets you provide contextual help for a page.</td>
</tr>
<tr>
<td>Image URL</td>
<td>The path to the icon image for the main menu.</td>
</tr>
<tr>
<td>Default Parameters</td>
<td>A default URL query string for the page.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Enables the page when you save it. This field is required.</td>
</tr>
<tr>
<td>Allow User</td>
<td>Allows the users to further personalize the Process Manager page.</td>
</tr>
<tr>
<td>Personalization</td>
<td></td>
</tr>
<tr>
<td>Add New Permission</td>
<td>Adds the permissions to the Process Manager page.</td>
</tr>
</tbody>
</table>

New Page Wizard: Step 2 page

This page lets you define a new site aggregator page in the Process Manager portal. It appears when you add a new Site Aggregator Process Manager page. See “Adding new Process Manager pages” on page 397.
### Table 17-2  Options on the New Page Wizard: Step 2 page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page name</td>
<td>The name for this page.</td>
</tr>
<tr>
<td>URL</td>
<td>The URL for this page.</td>
</tr>
<tr>
<td>Pass Session</td>
<td>The session ID that this page passes.</td>
</tr>
<tr>
<td>Pass Email Address</td>
<td>The email address that this page passes.</td>
</tr>
</tbody>
</table>

### Viewing the settings of a page

In Process Manager, under **Admin > Portal > Manage Pages**, you can view the settings of a page.

See “About Process Manager pages” on page 387.

**To view the settings of a page**

1. In the Process Manager portal, on the **Admin** tab, click **Portal > Manage Pages**.
2. In the **Pages List**, click a page.
   - The page settings appear in the right page.

### Adding a root page

In Process Manager, under **Admin > Portal > Manage Pages**, you can add a root page.

Root pages appear as tabs in Process Manager (such as **Workflow** and **Reports**).

See “About Process Manager pages” on page 387.

**To add a root page**

1. In the Process Manager portal, on the **Admin** tab, click **Portal > Manage Pages**.
2. In the **Pages List**, click the **Add Root Page** symbol (the green plus sign).
3 In the **Add Root Page** dialog box, enter the following information:

- **Menu Name**: The name of the root page. This name appears in the primary portal tab bar.
- **Description**: A description of the function of the page.
- **Include In Menu**: Sets whether the root page appears in the tab bar.
- **Template Page**: Sets how the sections of your page are organized. The percentages refer to the percentage across the page that a section extends.
- **Help URL**: A URL for the Help link in the bottom bar of the page.
- **Image URL**: A URL for the page image.
- **Default Parameters**: The default parameters for the page's data handling.
- **Enabled**: Sets whether the page is activated.
- **Allow User Personalization**: Sets whether users can personalize the page.
- **This is a Process View Page**: Sets whether this page functions as a Process View Page.

4 Click **Permissions** to set which users can access the page.

5 Set the permission type (User, Group, Organization, Permission), and then click **Pick**.

6 Search for the user, group, organization, or permission to receive the permission.

7 Click the permissions that you want to add.
   
   When the permission has a red X, the permission is not granted. When it has a green check mark, it is granted. (You can also click **Allow All**, **Deny All**, or **Inherit All**.)

8 Click **Add**.

9 When you have finished adding permissions, click **Save**.

**Importing a page**

In Process Manager, under **Admin > Portal > Manage Pages**, you can import a page.

See “About Process Manager pages” on page 387.
To import a page

1. In the Process Manager portal, on the Admin tab, click Portal > Manage Pages.
2. In the Pages List, click the Import Page symbol (the page with the green plus sign).
3. Enter the following information for the page:
   - Select File: The Web page file that you want to import.
   - Existing page: Sets how Process Manager handles the imported page if a duplicate page exists.

Going to a page

In the Manage Pages page in Process Manager, you can go directly to existing pages. The Manage Pages page is located under Admin > Portal > Manage Pages.

See “Admin tab” on page 528.

See “About the Manage Pages page” on page 396.

To go directly to a page

1. In the Process Manager portal, on the Admin tab, click Portal > Manage Pages.
2. In the left pane, select the page to which you want to go.
3. In the right pane, click Go To Page.

Adding a sub-page

You can add a sub-page to an existing page in the Process Manager Manage Pages page. The Process Manager pages are accessed by clicking on the module name (such as Documents). Sub-pages are accessed by clicking a sub-tab in a module.

You can create sub-pages for a sub-page, which allows further granularity of information.

See “About the Manage Pages page” on page 396.
To add a sub-page

1. In the Process Manager portal, select the module to which you want to add a sub-page.
2. Select Site Actions > Add Sub Page.
3. Follow the steps for adding a root page.

See “Adding new Process Manager pages” on page 397.

About customizing Process Manager pages

The Process Manager portal is made up of pages from which all Process Manager activities are performed. The Process Manager pages can be customized to meet your organization’s specific requirements.

Administrators can perform all of the customization actions and grant customization permissions to other Process Manager users. Non-administrator users typically have fewer options for customizing Process Manager pages.

See “Enabling the customization of a Process Manager page” on page 404.
See “About the Manage Pages page” on page 396.

Customizing Process Manager pages consists of the following actions:

- Adding and deleting pages.
- Specifying which pages can be customized.
- Adding, editing, and deleting the Web parts that appear on a page.
- Sharing pages with other users.

See “Customizing a Process Manager page (administrator)” on page 405.
See “Customizing your Process Manager pages (non-administrator)” on page 406.

Enabling the customization of a Process Manager page

Before anyone can customize a Process Manager page, the administrator must enable that page for customization. Enabling a page for customization consists of setting the appropriate privileges and permissions.

See “About customizing Process Manager pages” on page 404.
See “About the Manage Pages page” on page 396.
### Table 17-3  
Process for enabling the customization of a Process Manager page

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Set customization privileges for a user or group.</td>
<td>The privilege setting for groups is <code>Portal.PersonalCustomization</code>. The privilege setting for users is <code>PersonalCustomization</code>, which is under the Portal category. See “About permissions in Process Manager” on page 509.</td>
</tr>
</tbody>
</table>
| Step 2 | Set customization permissions on the page.   | For each page, set permissions for adding, editing, or deleting the page. On the Admin tab, under Portal > Manage Pages, you can edit the page to enable it for customization as follows:  
  - The **Allow User Personalization** setting enables the **Modify My Page** option on the Process Manager page. This option lets a user edit their own page without affecting that page for other users.  
  - The page’s **Permissions** settings let you allow users, groups, organizations, or permission groups to view, edit, or delete the page. See “About the Manage Pages page” on page 396. |

### Customizing a Process Manager page (administrator)

By default, the administrator can customize any Process Manager page that is able to be customized.

See “About customizing Process Manager pages” on page 404.

See “About the Manage Pages page” on page 396.

**To customize a Process Manager page**

1. In the Process Manager portal, access the page to customize.

2. In the upper right of the page, in the **Site Actions** drop-down list, select an action to perform. See “Options on the Site Actions drop-down list” on page 420.

3. When you finish the customization, you can close the page.
Customizing your Process Manager pages (non-administrator)

You can customize any of your Process Manager pages if you have permission to do so.

See “About customizing Process Manager pages” on page 404.

See “About the Manage Pages page” on page 396.

Before a user can customize a Process Manager page, the administrator must enable that page for customization.

To customize a Process Manager page

1. In the Process Manager portal, go to the page to customize.

2. In the upper right of the page, in the Site Actions drop-down list, select one of the following options:

   - **Modify Page**: Lets you add, edit, and delete the Web Parts that are on the page.
   - **Modify My Page**: The Modify Page option changes the page for everyone who has access to it. The Modify My Page option changes your version of the page only.
     
     See “Adding a Web Part to a Process Manager page” on page 422.

   - **Reset to Default**: Discards any changes that you made to the Process Manager page and reverts it to its original configuration.
   - **Share Page**: Lets you specify a user, group, organization, or permission group that can view your customized version of the Process Manager page.
     
     See “Sharing a Process Manager page” on page 424.

   - **Modify Page**: The Modify Page option changes the page for everyone who has access to it. The Modify My Page option changes your version of the page only.

   - **Reset to Default**: Discards any changes that you made to the Process Manager page and reverts it to its original configuration.

   - **Share Page**: Lets you specify a user, group, organization, or permission group that can view your customized version of the Process Manager page.

   See “Options on the Site Actions drop-down list” on page 420.

3. When you finish the customization, you can close the page.

Process Manager master settings

The Process Manager settings can be changed in the portal in Admin > Portal > Master Settings. The settings appear under a series of headers. To expand any
header and see the details beneath it, click on the blue arrow to the left of the header name. By default, the Account Management settings are expanded when you enter this page.

See “About the Process Manager portal master settings” on page 419.
See “Editing the Process Manager portal master settings” on page 419.

The Account Management settings are used to control the information that is required for new users and how the users are handled.

Table 17-4  Account Management

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Permissions</td>
<td>The set of permissions that are given to a new user by default. The administrator can override these permissions. When you click Pick Permissions, a window appears that lists the available permissions. You can choose directly from this list.</td>
</tr>
<tr>
<td>Default Groups</td>
<td>The groups to which the user is assigned. You can choose from the available groups when you click Pick Groups.</td>
</tr>
<tr>
<td>Default Organizations</td>
<td>The organizations to which the user is assigned if not specified or overridden. The existing organizations can be seen when you click Pick Organizations.</td>
</tr>
<tr>
<td>All Users Group</td>
<td>The users group to which the user is assigned. You can choose from the available groups when you click Pick Groups.</td>
</tr>
<tr>
<td>Password Expire Months</td>
<td>The number of months before the user’s passwords must be changed. The passwords can be changed before this time, but users are forced to change passwords after this number of months.</td>
</tr>
<tr>
<td>Password Expire Days</td>
<td>The number of days to be added to the months before the user’s passwords must be changed. The passwords can be changed before this time, but users are forced to change passwords after this number of days and months.</td>
</tr>
<tr>
<td>Required Phone Number</td>
<td>Forces the user to provide their phone number.</td>
</tr>
<tr>
<td>Required First Name</td>
<td>Forces the user to provide their first name.</td>
</tr>
<tr>
<td>Required Last Name</td>
<td>Forces the user to provide their last name.</td>
</tr>
<tr>
<td>Setting Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Required Address</td>
<td>Forces the user to provide their address.</td>
</tr>
<tr>
<td>Required City</td>
<td>Forces the user to provide their city.</td>
</tr>
<tr>
<td>Required State</td>
<td>Forces the user to provide their state or province.</td>
</tr>
<tr>
<td>Required ZIP Code</td>
<td>Forces the user to provide their ZIP Code.</td>
</tr>
<tr>
<td>Required Country</td>
<td>Forces the user to provide their country.</td>
</tr>
<tr>
<td>Required Password Hint</td>
<td>Forces the user to choose both a password and complete a password hint clue.</td>
</tr>
<tr>
<td>Required Key Value Pairs</td>
<td>Specifies the values that the user must provide that are not already specified.</td>
</tr>
<tr>
<td>Optional Key Value Pairs</td>
<td>Values that the user may elect to complete.</td>
</tr>
<tr>
<td>Register Fail Email</td>
<td>The email address to which notifications of a failed registration attempt are sent.</td>
</tr>
<tr>
<td>Register Fail Email Link</td>
<td>The email address that appears on the screen for a user to request attention when a registration attempt is not completed properly.</td>
</tr>
<tr>
<td>Users First Page</td>
<td>The page to which the user is directed when they log on.</td>
</tr>
<tr>
<td>Users First Page Link</td>
<td>The text of the link that is displayed on the logon page to direct a user to their first page.</td>
</tr>
<tr>
<td>Minimum Security Answers</td>
<td>The minimum number of answers required (if any) for security questions. If set to zero, no security answers are required.</td>
</tr>
<tr>
<td>Security Question 1</td>
<td>The first security question to be asked.</td>
</tr>
<tr>
<td>Security Question 2</td>
<td>The second security question to be asked.</td>
</tr>
<tr>
<td>Security Question 3</td>
<td>The third security question to be asked.</td>
</tr>
<tr>
<td>Security Question 4</td>
<td>The fourth security question to be asked.</td>
</tr>
<tr>
<td>Security Question 5</td>
<td>The fifth security question to be asked.</td>
</tr>
<tr>
<td>Contact Permission Group</td>
<td>The group that a user should contact for the requests that involve permissions.</td>
</tr>
</tbody>
</table>
### Table 17-4  Account Management (continued)

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Contact for New Users</td>
<td>Creates a new contact for a user who registers.</td>
</tr>
<tr>
<td>Force Password Reset Default</td>
<td>Sets the password reset times to default values for all users.</td>
</tr>
<tr>
<td>Session Timeout (days)</td>
<td>The number of days for the session to timeout. After this number of days, the user needs to log on to access Process Manager.</td>
</tr>
</tbody>
</table>

### Table 17-5  Application Management

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceLauncher DocID</td>
<td>The document ID if a service launcher is used.</td>
</tr>
<tr>
<td>LBStudio DocID</td>
<td>The document ID for LBStudio.</td>
</tr>
<tr>
<td>Application Document RootCategoryID</td>
<td>The root category ID for the application.</td>
</tr>
<tr>
<td>Assign Group to Application Document Category</td>
<td>The group name that is used for any application document category to be added to the system.</td>
</tr>
<tr>
<td>Assign Permissions to Applications Document Category</td>
<td>The permissions that are assigned to any application document category to be added to the system.</td>
</tr>
<tr>
<td>Services Root Category ID</td>
<td>The root category ID of all services.</td>
</tr>
<tr>
<td>File lock Duration</td>
<td>The amount of time, in minutes, that a file lock is maintained.</td>
</tr>
<tr>
<td>Default Publishing Server</td>
<td>The URL or IP address of the publishing server.</td>
</tr>
<tr>
<td>Default Directory Service Permission</td>
<td>The permissions user (by default) for directory services.</td>
</tr>
</tbody>
</table>

The Articles settings lets you set up article and bulletin board entries.

### Table 17-6  Articles

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Last Entries to Show on List</td>
<td>A numeric value showing the maximum number of article entries that are retained on the list on the main page.</td>
</tr>
<tr>
<td>Article Number Prefix</td>
<td>The prefix that gets prepended to the article number.</td>
</tr>
</tbody>
</table>
### Table 17-6  Articles (continued)

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Article Entry Number Prefix</td>
<td>The prefix that gets prepended to the entry number.</td>
</tr>
<tr>
<td>Captured Image Category</td>
<td>The default category that is used for the images that are sent from the screen capture utility.</td>
</tr>
<tr>
<td>Bulletin Board Entry End Date</td>
<td>The number of days that the bulletin board entry has before it ends. This setting is based on the creation date of the bulletin board.</td>
</tr>
<tr>
<td>Bulletin Board Entry Priority Low Color</td>
<td>The color for the bulletin board entry low priority.</td>
</tr>
<tr>
<td>Bulletin Board Entry Priority Medium Color</td>
<td>The color for the bulletin board entry medium priority.</td>
</tr>
<tr>
<td>Bulletin Board Entry Priority High Color</td>
<td>The color for the bulletin board entry high priority.</td>
</tr>
<tr>
<td>Bulletin Board Entry Priority Emergency Color</td>
<td>The color for the bulletin board entry emergency priority.</td>
</tr>
<tr>
<td>Hide Recent Articles</td>
<td>Hides or shows the recent articles Web part.</td>
</tr>
</tbody>
</table>

The Chat settings let you control the chat function in Process Manager.

### Table 17-7  Chat

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Retention Time (days)</td>
<td>Sets how long (in days) that a chat message is stored in Exchange.</td>
</tr>
<tr>
<td>Message Heartbeat Expiration Time (min)</td>
<td>Sets how long a user remains active without sending a message.</td>
</tr>
<tr>
<td>Show Chat In Virtual Window</td>
<td>Sets whether the chat screen opens as a virtual window or a regular window.</td>
</tr>
</tbody>
</table>

The Customization settings let you control the Process Manager site's appearance.

### Table 17-8  Customization

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home Page Content</td>
<td>The URL of the site home page. This URL can be an absolute address or a relative address.</td>
</tr>
</tbody>
</table>
Table 17-8  Customization *(continued)*

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logo URL</td>
<td>The URL of any logo to be displayed on the site. The Pick option lets you browse the file system for a logo.</td>
</tr>
<tr>
<td>Edit Page in Header</td>
<td>Displays a link allowing the page to be edited.</td>
</tr>
<tr>
<td>Show Breadcrumbs</td>
<td>Displays the trail of pages to the current location relative to the home page.</td>
</tr>
<tr>
<td>Show Secondary Menu</td>
<td>Causes a drop-down menu to appear when the user hovers the cursor over any section symbol at the top of the page.</td>
</tr>
<tr>
<td>Show Account Link In Header</td>
<td>The Account link displays in the header of the Process Manager page.</td>
</tr>
<tr>
<td>Show Support Link In Footer</td>
<td>The Support link displays in the footer of the Process Manager page.</td>
</tr>
</tbody>
</table>

The Document Management settings let you control the management of documents.

Table 17-9  Document Management

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orphan Category ID</td>
<td>A string that is assigned to any orphan categories.</td>
</tr>
<tr>
<td>Download Document Name Mask</td>
<td>The formatting mask that is used for any documents that the users download.</td>
</tr>
<tr>
<td>Silent Document Type Add</td>
<td>Adds a type to new documents.</td>
</tr>
<tr>
<td>Default Compress for New Document Type</td>
<td>Uses the compression on any new documents.</td>
</tr>
<tr>
<td>Projects Root Category ID</td>
<td>The default category ID for any new project's root.</td>
</tr>
<tr>
<td>Max Categories To Display in Document Tree</td>
<td>The maximum number of categories that can be in a tree structure.</td>
</tr>
<tr>
<td>Show Browse Categories</td>
<td>Displays the categories to be browsed.</td>
</tr>
<tr>
<td>Show Search Categories</td>
<td>Displays the categories to be examined when a search is performed.</td>
</tr>
<tr>
<td>Checkout Functionality Enabled</td>
<td>Lets the users lock files in the document repository.</td>
</tr>
</tbody>
</table>
Table 17-9  Document Management (continued)

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Checkout Lasts(days)</td>
<td>The number of days that a file can be locked in the document repository. After this number of days, the file becomes available for other users to edit.</td>
</tr>
<tr>
<td>Hide Recent Documents</td>
<td>If this setting is checked, the Recent Documents folder does not display in the Browse pane in the Documents window.</td>
</tr>
<tr>
<td>Hide Orphan Documents</td>
<td>If this setting is checked, the Orphan Documents folder does not display in the Browse pane in the Documents window. Orphaned documents are the documents that do not belong to a category.</td>
</tr>
</tbody>
</table>

Table 17-10  Email Settings

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMTP Server</td>
<td>The SMTP server that Process Manager uses.</td>
</tr>
<tr>
<td>SMTP Port</td>
<td>The SMTP port</td>
</tr>
<tr>
<td>Admin Email</td>
<td>The address that receives administration email.</td>
</tr>
</tbody>
</table>

The **Not Logged-In Users** settings control how users who are not logged on to the Process Manager site are handled when they visit. These settings include the ability to block all access to users who do not log on, or allow such users to perform some functions.

If the site forces all users who visit to log on, the **Allow Not Logged-In Users** option should be cleared. All other settings in this section are ignored when this option is not selected.

Table 17-11  Not Logged-in Users

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Not Logged-in Users</td>
<td>Lets the users access the site without logging on. If this setting is not selected, users must log on to perform any actions on the site.</td>
</tr>
</tbody>
</table>
Table 17-11  Not Logged-in Users (continued)

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Logged-in User ID</td>
<td>The user ID for not logged on users. All users need to have a working logon to perform any actions on the site, whether or not they are legitimately logged on users. This option lets a user who does not log on employ a logon while they are in the site. Usually, this option is a logon with restricted rights, such as a guest account.</td>
</tr>
<tr>
<td>Not Logged-in Password</td>
<td>The password that is tied to the Not Logged-In User ID to let visitors to the site access some functions.</td>
</tr>
<tr>
<td>Show Log-in Control in Header</td>
<td>Displays the user's logon name on the header of the site. If not selected, the user name is suppressed.</td>
</tr>
<tr>
<td>Show Link to Log-in in Header</td>
<td>Displays a logon link in the page header if the visitor has not logged on. If not selected, no such logon link is displayed.</td>
</tr>
<tr>
<td>Show Remember Me in Header</td>
<td>Creates the Remember me link that writes a cookie to the user's computer that appears in the header. If this option is not selected, there is no ability to remember the logon name.</td>
</tr>
</tbody>
</table>

The Notifications settings let you set the home URL for the Process Manager site, as well as the locations of plug-ins.

Table 17-12  Notifications

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Service Location URL</td>
<td>The URL or IP address of the site.</td>
</tr>
<tr>
<td>Get Base URL To Process Manager From Request</td>
<td>If this setting is checked, the base URL to Process Manager is retrieved from the HTTP request. This setting is used if you expose Process Manager on multiple URLs. This setting lets you redirect to your public facing URL found in the Base URL To Process Manager setting.</td>
</tr>
<tr>
<td>Base URL To Process Manager</td>
<td>The public facing URL for Process Manager.</td>
</tr>
<tr>
<td>Accounts Plugin</td>
<td>The location of the accounts plug-in.</td>
</tr>
<tr>
<td>Projects Plugin</td>
<td>The location of the projects plug-in.</td>
</tr>
</tbody>
</table>
### Table 17-12  Notifications (continued)

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documents Plugin</td>
<td>The location of the documents plug-in.</td>
</tr>
<tr>
<td>Workflow Plugin</td>
<td>The location of the workflow plug-in.</td>
</tr>
<tr>
<td>Discussions Plugin</td>
<td>The location of the discussions plug-in.</td>
</tr>
<tr>
<td>Calendar Plugin</td>
<td>The location of the calendar plug-in.</td>
</tr>
<tr>
<td>Articles Plugin</td>
<td>The location of the articles plug-in.</td>
</tr>
<tr>
<td>Chat Plugin</td>
<td>The location of the chat plug-in.</td>
</tr>
</tbody>
</table>


### Table 17-13  Process Manager Active Directory Settings

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Directory Authentication</td>
<td>Sets Process Manager to use Active Directory authentication.</td>
</tr>
<tr>
<td>Process AD Changes Using Workflow</td>
<td>Not available.</td>
</tr>
<tr>
<td>AD Sync Process Interval (in mins)</td>
<td>Sets the interval between executions of the Active Directory Sync process.</td>
</tr>
<tr>
<td>AD Sync Process Time</td>
<td>Sets the time of day when the Active Directory synchronization runs to add new users and make changes to existing users.</td>
</tr>
<tr>
<td>Ignore Ad Users (Comma separated)</td>
<td>Lists the users for Process Manager to ignore when the sync process runs.</td>
</tr>
<tr>
<td>Sync Only Users</td>
<td>Leaves out Active Directory groups. You can use this option if you wanted to define or assign groups inside of Process Manager but still get users from Active Directory.</td>
</tr>
</tbody>
</table>

The Process Manager Events settings turn on or off event notifications. You must publish the appropriate event listener processes before you can use event notifications.
### Table 17-14  Process Manager Events

<table>
<thead>
<tr>
<th>Event notification settings</th>
<th>Turns on or off all event notifications. If you want to use event notifications, do the following, in order:</th>
</tr>
</thead>
<tbody>
<tr>
<td>■ Open the event notification processes (located in C:\Program File\Altiris\Workflow Designer\Designer\Templates).</td>
<td></td>
</tr>
<tr>
<td>■ Configure the processes for your environment (change at least the mail server settings).</td>
<td></td>
</tr>
<tr>
<td>■ Publish the processes.</td>
<td></td>
</tr>
<tr>
<td>■ Turn on the appropriate event notifications under this heading in the Process Manager.</td>
<td></td>
</tr>
</tbody>
</table>

The Process Manager settings are general settings for the Process Manager site.

### Table 17-15  Process Manager Settings

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Upload Size (1 - 100 MB)</td>
<td>Lets you define the size for an uploading file. The default and maximum supported file size is 100 MB. Process Manager displays an error if the file upload size is crossed.</td>
</tr>
<tr>
<td>Forgot Password Link</td>
<td>Enables a link to a password recovery page. Otherwise, a user who has forgotten their password needs to communicate with a site administrator for a password reset.</td>
</tr>
<tr>
<td>Register Account Link</td>
<td>Lets a new user create an account for this site. If this option is not selected, only the site administrator can add access for new users.</td>
</tr>
<tr>
<td>Register Account URL</td>
<td>The URL of the register account.</td>
</tr>
<tr>
<td>Enable Lucene Search</td>
<td>Lets you enable Lucene search. By default, Lucene search is disabled. The default search is SQL-based, which is faster than Lucene search.</td>
</tr>
<tr>
<td>Display Time in Local Time Zone</td>
<td>Always displays the time local to user.</td>
</tr>
<tr>
<td>Use translation</td>
<td>This setting is not available.</td>
</tr>
<tr>
<td>Notifications</td>
<td>Sets whether the task notification window appears.</td>
</tr>
<tr>
<td>Show Notification Position</td>
<td>Lets you change the location of the task notification window.</td>
</tr>
</tbody>
</table>
Table 17-15  Process Manager Settings (continued)

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Business Hours</td>
<td>Updates the business hours stored in the task tray application in Process Manager.</td>
</tr>
<tr>
<td>Help Link Url</td>
<td>Sets the URL for the Help link at the bottom of Process Manager.</td>
</tr>
<tr>
<td>Show Help Link</td>
<td>Shows the Help link.</td>
</tr>
<tr>
<td>Enable Project Locking in Repository</td>
<td>Lets you lock the project in the repository.</td>
</tr>
<tr>
<td>Clear Audit History</td>
<td>Lets you clear audit history.</td>
</tr>
<tr>
<td>Clear Audit History Daily at</td>
<td>Lets you set up a daily time to schedule clearing of the audit history.</td>
</tr>
<tr>
<td>Clear Audit History Older than</td>
<td>Lets you configure the days to retain the audit history.</td>
</tr>
<tr>
<td>Clear Login Audit</td>
<td>Lets you clear the login audit data.</td>
</tr>
<tr>
<td>Clear Login Audit Daily at</td>
<td>Lets you set up a daily time schedule clearing of the login audit data.</td>
</tr>
<tr>
<td>Clear Login Audit Older than</td>
<td>Lets you configure the days to retain the login audit data.</td>
</tr>
</tbody>
</table>

The Optimization settings let you control the behavior of the Process Manager.

The cache and the fast cache retention time settings allow a balance between the amount of memory that the application uses to store items in cache and the available memory of the computer. The longer the cache time setting is, the faster the application retrieves previously called pages and the more physical memory or disk space is needed. The default settings are used for most servers. If heavy loads are expected in a system with a shortage of memory, reducing the cache times can help prevent paging.

Table 17-16  Optimization

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clean Cache Time</td>
<td>How often the cache is emptied (in minutes). The higher the number is, the larger the cache is, and the faster the application can be perceived to be.</td>
</tr>
<tr>
<td>Keep Objects Time</td>
<td>The amount of time (in minutes) that objects are kept in memory for fast retrieval.</td>
</tr>
</tbody>
</table>
Table 17-16  Optimization (continued)

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast Cache Objects Time</td>
<td>The amount of time (in minutes) that Fast Cache is used to keep objects in memory.</td>
</tr>
<tr>
<td>Fast Cache Clean Time</td>
<td>The amount of time (in minutes) that the Fast Cache is retained before it is purged.</td>
</tr>
</tbody>
</table>

Table 17-17  Profile

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Count In Profile Tree</td>
<td>Displays the count in the Profile tree.</td>
</tr>
<tr>
<td>Profile Tree Date Not Set Text</td>
<td>The text that appears at the end of the profile tree structure.</td>
</tr>
</tbody>
</table>

Table 17-18  Reports Settings

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Reporting Messages</td>
<td>If this setting is checked, the integration between Process Manager and Workflow processes to capture reporting messages is turned on. See “Setting up workflow task integration between Workflow Designer and Process Manager” on page 436.</td>
</tr>
<tr>
<td>Process Reporting Interval(Sec)</td>
<td>The interval, in seconds, that the Process View page retrieves updated information about a process.</td>
</tr>
<tr>
<td>Message Exchange Name</td>
<td>The name of the message exchange. The message exchange is how processes running on Workflow Server communicate with Process Manager.</td>
</tr>
<tr>
<td>Auto Record User Time</td>
<td>Sets whether the user time that is spent working in a process is stored in Process Manager. Any process that has a Process View page can have user time automatically recorded in Process Manager.</td>
</tr>
<tr>
<td>Suggest Next Process ID Interval (in sec)</td>
<td>Determines the time to wait before to redirecting you to the next process. You can cancel the countdown.</td>
</tr>
</tbody>
</table>

The Workflow settings control the behavior of the workflow module.
### Table 17-19  Workflow Settings

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Lease Time</td>
<td>The amount of time, in minutes, that a task is leased to a user.</td>
</tr>
<tr>
<td>Show Leased Items in Task List</td>
<td>Displays any leased items in the user task list.</td>
</tr>
<tr>
<td>Lease Tasks</td>
<td>Lets the tasks be leased. If this option is not selected, tasks cannot be leased to a user.</td>
</tr>
<tr>
<td>Show Task in New Window</td>
<td>Lets any task the user selects be opened in a new window; otherwise, the same window is used.</td>
</tr>
<tr>
<td>Workflow Leased Error Message</td>
<td>The string that is displayed to a user if there is a problem leasing a task.</td>
</tr>
<tr>
<td>Workflow Task Due Date</td>
<td>The default due date for a task (in days).</td>
</tr>
<tr>
<td>Workflow Task Late Date</td>
<td>The default late date for a task (in days).</td>
</tr>
<tr>
<td>Show Tasks in Different Color</td>
<td>Displays the tasks in a different color than the rest of the screen text.</td>
</tr>
<tr>
<td>Workflow Task Due Date Color</td>
<td>The color (in hex) for a task's due date.</td>
</tr>
<tr>
<td>Workflow Task Late Date Color</td>
<td>The color (in hex) for a task's late date.</td>
</tr>
<tr>
<td>Show Profiles On Task Page</td>
<td>Displays the Profiles section in the left pane on the Task page. This setting lets you filter your task view by profiles you create.</td>
</tr>
<tr>
<td>Show Pager On Task Page</td>
<td>Separates the items on the Task page into pages if there are a certain number of items.</td>
</tr>
<tr>
<td>Show Count On Task Page</td>
<td>Displays the count on the Task page. This setting requires an additional query.</td>
</tr>
<tr>
<td>Workflow Task Number Pad</td>
<td>The number to pad onto each workflow task number. This setting lets you keep all workflow task numbers the same length.</td>
</tr>
<tr>
<td>Workflow Task Number Prefix</td>
<td>The prefix to prepend to each workflow task number.</td>
</tr>
<tr>
<td>Auto Refresh Task Page</td>
<td>Lets the page that is selected in the Default Workflow Task Page setting refresh automatically. Use this setting for non-Ajax pages if you want them to refresh automatically. Ajax pages refresh automatically.</td>
</tr>
</tbody>
</table>
Table 17-19  Workflow Settings (continued)

<table>
<thead>
<tr>
<th>Setting Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Refresh Time</td>
<td>The amount of time, in milliseconds, between page refreshes for the Task page.</td>
</tr>
</tbody>
</table>

About the Process Manager portal master settings

The Process Manager portal master settings determine the behavior of the Process Manager application and portal.

These master settings are established during the installation of Process Manager. You can use the default settings or you can edit them as necessary. Symantec recommends that you review the settings to familiarize yourself with them and then customize them for your organization.

See “Editing the Process Manager portal master settings” on page 419.

Examples of the types of settings that you might change are as follows:

- Settings under the Account Management section
  - Password Expire Months, Register Fail e-mail address, and Security Question 1

- Settings under the Workflow Settings section
  - Workflow Task Due Date (default is seven days) and Workflow Task Late Date (default is 14 days)

Do not change the settings for URLs or disable check boxes without fully understanding the ramifications. Few organizations need to change that type of information.

The portal master settings are arranged in sections. Expand each section to see the settings that appear there.

See “Master settings page” on page 535.

Editing the Process Manager portal master settings

The Process Manager portal master settings determine the behavior of the Process Manager application and portal.

Although default master settings are established during the installation of the Process Manager application, you can edit them to customize them for your organization.

See “About the Process Manager portal master settings” on page 419.
See “Admin tab” on page 528.

Do not change the settings for URLs or disable check boxes without fully understanding the ramifications. Few organizations need to change that type of information.

To edit the Process Manager portal master settings

1. In the Process Manager portal, on the Admin tab, click Portal > Master Settings.

2. On the Master Settings page, expand the section that contains the settings to edit.

3. Change the settings as necessary.

   See “Master settings page” on page 535.

4. Continue to expand and edit additional sections as needed.

5. When you finish reviewing and editing the settings, at the lower right of the page, click Save.

Options on the Site Actions drop-down list

The Site Actions drop-down list contains the options that are available for customizing a Process Manager page. This drop-down list appears only on the pages that you have the permission to customize. The options that are available depend on your permissions.

See “About the Manage Pages page” on page 396.

The options that are available also depend on where you are in the editing process. For example, when you are on a main Process Manager page, the Edit Page option does not appear in the Site Actions drop-down list. However, after you click Site Actions > Modify Page and the page opens for editing, the Edit Page option becomes available.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Root Page</td>
<td>Lets you add a new Process Manager page, which is visible from the top level of the Process Manager portal. The page name appears on the tab bar in the upper area of the Process Manager Portal. Typically, only administrators have permission to create new pages. See &quot;Adding new Process Manager pages&quot; on page 397. See &quot;Adding a root page&quot; on page 401.</td>
</tr>
</tbody>
</table>
Table 17-20  Options on the Site Actions drop-down list (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Sub Page</td>
<td>Lets you add a new sub page, which is one or more levels under a root page. A sub page can appear on the menu of a root page. For example, the Knowledge Base page is a root page. You open it by clicking the Knowledge Base tab in the Process Manager portal. The Discussions page is a sub page. This page is opened when you click Discussions under the Knowledge Base tab. Typically, only administrators have permission to create new pages. See “Adding new Process Manager pages” on page 397. See “Adding a sub-page” on page 403.</td>
</tr>
<tr>
<td>Add Web Part</td>
<td>Lets you add one or more Web Parts to the page. The sections on a Process Manager page are in the form of Web Parts. See &quot;Adding a Web Part to a Process Manager page” on page 422.</td>
</tr>
<tr>
<td>Browse</td>
<td>Exits the editing mode and displays the page with the changes that you made.</td>
</tr>
<tr>
<td>Clear</td>
<td>Deletes all the Web Parts from a Process Manager page. <strong>Warning:</strong> This action cannot be undone. Use caution when you select this option because you are not prompted to confirm this action before the deletion occurs.</td>
</tr>
<tr>
<td>Edit Definition</td>
<td>Lets you configure customization settings and customization privileges for the current Process Manager page. Typically, only administrators have permission to edit page definitions.</td>
</tr>
<tr>
<td>Edit Page</td>
<td>Lets you edit and delete the Web Parts that are on the page. See “Editing a Web Part on a Process Manager page” on page 423.</td>
</tr>
<tr>
<td>Modify Page</td>
<td>Lets you add, edit, and delete the Web Parts that are on the page. The page is changed for everyone who has access to it.</td>
</tr>
<tr>
<td>Modify My Page</td>
<td>Lets you add, edit, and delete the Web Parts that are on the page. Only your page is changed. This option appears only if the page is configured to allow it.</td>
</tr>
<tr>
<td>Page List</td>
<td>(Administrator only) Displays the Pages List page that lets you configure settings and customization permissions for any Process Manager page.</td>
</tr>
<tr>
<td>Reset to Default</td>
<td>Discards any changes that were made to the Process Manager page and reverts it to its original configuration.</td>
</tr>
</tbody>
</table>
Adding a Web Part to a Process Manager page

Many Process Manager pages have Web Parts. You can customize a Process Manager page by adding, editing, or deleting Web Parts.

See “Adding new Process Manager pages” on page 397.

See “About the Manage Pages page” on page 396.

After you add a Web Part, you can edit its properties.

See “Editing a Web Part on a Process Manager page” on page 423.

To add a Web Part to a Process Manager page

1. In the Process Manager portal, access the page that you want to customize.
2. In the upper right of the page, in the Site Actions drop-down list, select one of the following options:

   - **Modify Page**  Changes the page for everyone who has access to it.
   - **Modify My Page**  Changes your version of the page only.

3. After the page refreshes, in the Site Actions drop-down list, click Add Web Part.
4. In the Catalog Zone, select the catalog that contains the Web Part to add.
5. In the Catalog Zone, under Profiles, select the check box for each Web Part to add.

---

**Table 17-20**  Options on the Site Actions drop-down list (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Share Page   | Lets you specify a user, group, organization, or permission group that can view your customized version of a Process Manager page. You can also provide additional permissions for this page as follows:  
- Let others edit this page.  
- Provide view, edit, and delete permissions to a specific user, group, organization, or permission group.  
For example, the administrator customizes a page, lets all users in a group view the page, and then lets a specific user edit the page.  
See “Sharing a Process Manager page” on page 424. |
6 In the Catalog Zone, in the Add to drop-down list, select the page zone to which to add the Web Part.

The zones that are available depend on the page’s Template Page setting, which the administrator sets.

7 Click Add.

8 When you finish adding Web Parts, in the Catalog Zone, click Close.

Editing a Web Part on a Process Manager page

Many Process Manager pages have Web Parts. You can customize a Process Manager page by adding, editing, or deleting Web Parts.

See “Adding new Process Manager pages” on page 397.

See “About the Manage Pages page” on page 396.

See “Adding a Web Part to a Process Manager page” on page 422.

To edit a Web Part on a Process Manager page

1 In the Process Manager portal, access the page that you want to customize.

2 In the upper right of the page, in the Site Actions drop-down list, select one of the following options:

   Modify Page                  Changes the page for everyone who has access to it.
   Modify My Page               Changes your version of the page only.

3 After the page refreshes, in the upper right of the Web Part to edit, click the Verbs symbol.

Select one of the following options:

   Edit                        Lets you edit the properties of the Web Part.
   Delete                      Lets you delete the Web Part.
If you clicked Edit, in the Editor Zone, edit the properties of the Web Part, and then select one of the following options:

- **Apply**: Saves the changes without closing the Editor Zone.
- **OK**: Saves the changes and closes the Editor Zone. Select this option when you finish editing the properties for the current Web Part.

When you finish editing the Web Parts, you can close the page or continue to edit it.

---

**Sharing a Process Manager page**

You can share your version of a Process Manager page with others to let them see any customizations that are on your page. Typically, you share the pages that you or someone else has customized.

See “About the Manage Pages page” on page 396.

You can share pages when you provide view, edit, and delete permissions to specific users, groups, organizations, or permission groups. For example, the administrator can customize a page and let all users in a certain group view the page. Then the administrator can let only one specific user within that group edit the page.

The users’ portal permissions override any share permissions that you might provide. For example, a user who does not normally have permission to view the Documents page cannot view a shared version of that page.

**To share a Process Manager page**

1. In the Process Manager portal, access the page that you want to share.
2. (Optional) Customize the page.
   - See “Customizing a Process Manager page (administrator)” on page 405.
   - See “Customizing your Process Manager pages (non-administrator)” on page 406.
3. In the upper right of the page, in the Site Actions drop-down list, click Share Page.
4. Under Page Permissions, review the users, groups, or other entities that have permissions for this page.
5 Under **Share Page**, select an option in each of the following subsections:

- **Share With**: Select the type of entity to give permissions for sharing this page.
- **Sharing Type**: Select the type of share permissions to give.
  
  The **Custom (Advanced)** option provides additional ways to customize the permissions.

6 Under **Share Page**, click **Next**.

7 Specify the user, group, or other entity with which to share this page, and then click **Share Page**.

8 When you return to the page, you can continue to edit it or close it.

### Editing a Process Manager page

You can edit pages in the Process Manager **Manage Pages** page. If a Process Manager page is set to allow user personalization, you can edit the page to meet your needs. Only the users that are assigned the appropriate permissions for modifying a Process Manager page can edit that page. The permission for modifying Process Manager pages is Portal.Personal.Customization.

See “About the Manage Pages page” on page 396.

#### To edit a page

1 In the Process Manager portal, on the **Admin** tab, click **Portal > Manage Pages**.

2 In the left pane, select the page to edit.

3 In the right pane, click **Edit Page**.
4 Enter the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu name</td>
<td>The name of the page.</td>
</tr>
<tr>
<td>Description</td>
<td>A text description of the purpose of the page.</td>
</tr>
<tr>
<td>Include In Menu</td>
<td>Indicates whether this page should appear in the menu listing.</td>
</tr>
<tr>
<td>Template Page</td>
<td>The template page that is used to lay out the page on the site.</td>
</tr>
<tr>
<td>Help Url</td>
<td>The URL of any help page that is associated with this page.</td>
</tr>
<tr>
<td>Image Url</td>
<td>The URL of any image that is associated with this page.</td>
</tr>
<tr>
<td>Default Parameters</td>
<td>Any parameters that are used for this page.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Whether this page is enabled (viewable).</td>
</tr>
<tr>
<td>Allow User Personalization</td>
<td>Whether users are allowed to personalize this page.</td>
</tr>
</tbody>
</table>

5 Click the Permissions tab and click Add Permission to add permissions for accessing this page.

6 Click Save.

Deleting a page

You can delete pages in the Process Manager Manage Pages page. Administrators and those with the appropriate permissions can delete Process Manager pages. When a Process Manager page is deleted, any users currently viewing the page are not able to save any information on that page. Also, no users can access the page from that point forward.

See “About the Manage Pages page” on page 396.

To delete a Process Manager page

1 In the Process Manager portal, on the Admin tab, click Portal > Manage Pages.

2 From the pages list, select the page that you want to delete.

3 Click Delete Page.

4 Click OK in the confirmation dialog box that appears.
Moving a page up or down

You can move up in a page or down in a page hierarchy in the Process Manager Manage Pages page.

See “About Process Manager pages” on page 387.
See “About the Manage Pages page” on page 396.

To move pages in the pages list

1. In the Process Manager portal, on the Admin tab, click Portal > Manage Pages.
2. In the left pane, select the page that you want to move.
3. To move up the current page one level in the pages list, in the right pane, click Move Up.
4. To move the current page one level down in the pages list, in the right pane, click Move Down.
5. To move up the current page one level in the hierarchy, in the right pane, click Move Level Up.
6. To make the current page a sub-page to another page, in the right pane, click Make As Sub Page.

Exporting a page

In the Manage Pages page in Process Manager, you can export some pages. Exporting a page lets you save it or open it in XML.

See “About Process Manager pages” on page 387.
See “About the Manage Pages page” on page 396.

To export a page

1. In the Process Manager portal, on the Admin tab, click Portal > Manage Pages.
2. In the left pane, select the page that you want to export.
3. In the right pane, click Export Page.

Customizing a Process Manager page list

Several Process Manager pages contain the lists that you use to analyze or perform Process Manager activities. You can customize the lists that appear on your pages so that they display the information in the manner that is most useful to you. For
example, on the **Workflow Task List** page, you might want to change the task list so that it displays only your overdue tasks.

The primary way to customize a Process Manager page list is to change the report that determines the contents of the list. You can also sort and filter the list to display a more specific subset of information. The changes that you make are active for the current session only. When you log off of Process Manager, the changes are lost. However, you can set a new default report that persists beyond a single session.

See “About the Manage Pages page” on page 396.

See “Changing the report for a Process Manager page list” on page 430.

**To customize a Process Manager page list**

1. In the Process Manager portal, click the tab that contains the list to edit.
2. On the page, under the list section, you can customize the list in the following ways:
   - Sort the columns.
   - Search and filter the list.
   - Limit the number of records that appear.
   - Select a new report.
   - Set a new default report.
   - Refresh the report.

   See “Options for customizing a Process Manager page list” on page 428.
3. When you finish customizing the list, you can close the page or work on it.

### Options for customizing a Process Manager page list

You can customize a Process Manager page list so that it displays information in the manner that is most useful to you.

See “About the Manage Pages page” on page 396.

See “Customizing a Process Manager page list” on page 427.

<table>
<thead>
<tr>
<th>Option</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort the columns.</td>
<td>None</td>
<td>You can click any column heading to sort by that heading.</td>
</tr>
</tbody>
</table>
Table 17-21  Options for customizing a Process Manager page list (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search and filter the list.</td>
<td></td>
<td>You can search the list to filter the results. For example, to list only those items that have to do with printers, you can search for printer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can filter a list by using one of the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ The Search symbol.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can click the Search symbol to open a search box.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ The search feature under Report Settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can expand the Report Settings section and click Text contains to open a search dialog box.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You might not see the Support Settings section because it appears for certain reports only.</td>
</tr>
<tr>
<td>Limit the number of records that appear.</td>
<td>Report</td>
<td>Lets you change the number of records that appear in the list.</td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Typically, the list contains the first 50 records that match the report criteria. You can change the number of records that appear by expanding the Report Settings section. Click Return 50 first records and specify a new number.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You might not see the Support Settings section because it appears for certain reports only.</td>
</tr>
<tr>
<td>Select a new report.</td>
<td></td>
<td>You can select a new report to display the list in a different configuration. Let you choose a different configuration. For example, you can select a report that displays all of your open tasks.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can select a new report by clicking one of the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ The Reports symbol</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ The Current report name</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Both options open a list of folders, which contain the reports that are available.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Changing the report for a Process Manager page list” on page 430.</td>
</tr>
<tr>
<td>Set a new default report.</td>
<td></td>
<td>Lets you set the Current report as the default for this page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Changing the report for a Process Manager page list” on page 430.</td>
</tr>
<tr>
<td>Refresh the report.</td>
<td></td>
<td>Lets you refresh the display after you select a new report.</td>
</tr>
</tbody>
</table>
Changing the report for a Process Manager page list

Each list on a Process Manager page is associated with a default report that determines the contents of the list. You can change the report to display the list in a different configuration. For example, you can select a report that displays all of your open tasks.

When you change the report for a list, it is active for the current session only. The next time that you log on, the default report reappears.

You can also set a new default report that persists beyond a single session. You can select a predefined report or a customized report.

See “Options on the Site Actions drop-down list” on page 420.

See “Customizing a Process Manager page list” on page 427.

Setting the default report for a list does not save any additional filtering of the list.

To change the default report for a Process Manager page list

1. In the Process Manager portal, click the tab that contains the list to edit.
2. On the page, under the list section, click either the Current report name or the reports symbol.
3. Select the report group, and then select the report to use.
   To quickly find a report, you can type a search string in the box and click Find.
4. (Optional) To make the new report selection the default report, in the list section, click the orange lightning symbol, and then click Set default report.
5. When you finish customizing the list, you can close the page or work on it.

Uploading plug-ins

You can upload plug-ins into Process Manager in the Plugin Upload page. This page is located in Admin > Portal > Plugin Upload.

On this same page you can upload a Web part, a resource, or a Web page.

See “About the Process Manager portal master settings” on page 419.

To upload plug-ins

1. In the Process Manager portal, on the Admin tab, click Portal > Plugin Upload.
2. Select the type of plug-in to upload.
3. Browse to and select the plug-in to upload.
4. Click Upload.
Adding Web part catalogs

You can manage Web part catalogs in Process Manager in the Webparts Catalog page. This page is located in Admin > Portal > Webparts Catalog.

Process Manager has dozens of the template Web parts that you can choose when you add a Web part. You can pick a template in the Class Name property. For example, if you want to add a Web part that lets users perform a Google search, you can add GoogleSearchWebPart.

After you add a Web part, you can add the Web part to a page in Process Manager.

See “Adding a Web Part to a Process Manager page” on page 422.
See “Editing and deleting Web part catalogs” on page 431.
See “Portal tab” on page 534.

To add Web part catalogs
1. In the Process Manager portal, on the Admin tab, click Portal > Web Parts Catalog.
2. In the left pane, click the Add WebPart Catalog symbol.
3. In the Class name box, select the class name for this Web part catalog to control.
4. In the Friendly name box, enter a user-friendly name for this Web part catalog.
5. In the Category box, enter the browse category into which this Web part catalog is placed.
6. In the Description box, enter a detailed description of this Web part catalog.
7. Click the Permissions tab and click Add Permission to add permissions for accessing this Web part catalog.
8. Click Save.

Editing and deleting Web part catalogs

After you add Web part catalogs in Process Manager, users can perform multiple actions on them.

See “Portal tab” on page 534.
To edit a Web part catalog

1. In the Process Manager portal, on the Admin tab, select Portal > Web Parts Catalog.

2. In the left pane, select the category of the Web part catalog that you want to edit.

3. In the right pane, next to the Web part catalog that you want to edit, click the Edit Parts Catalog symbol.

4. Edit the Web part catalog.

   See “Adding Web part catalogs” on page 431.

5. Click Save.

To delete a Web part catalog

1. In the Process Manager portal, on the Admin tab, select Portal > Web Parts Catalog.

2. In the left pane, select the category of the Web part catalog that you want to delete.

3. In the right pane, next to the Web part catalog that you want to delete, click the Delete Parts Catalog symbol.

4. Click OK.
Managing Workflow processes in Process Manager

This chapter includes the following topics:

- About the Workflow tab
- Delegating tasks
- Opening a task by ID
- Performing an action on multiple tasks at once
- Viewing a task or process in Process Manager
- Setting up users to view the process view page
- Setting up workflow task integration between Workflow Designer and Process Manager

About the Workflow tab

The Workflow tab in Process Manager gives you access to currently-running tasks and processes. By default, you also have access to the Service Catalog.

See “About the service catalog” on page 497.

You can search for running tasks and processes and open them to view their process view pages or to work with them. Typically, users have permissions to view only the tasks that are assigned to them. Users with higher permissions can view their own tasks and the tasks of other users.
The **Workflow** tab gives you access to tasks and processes. You can access most of the functionality of the Workflow tab from the process view page.

See “About the Process View page” on page 390.

See “Viewing a task or process in Process Manager” on page 435.

See “Actions in the Process View page” on page 392.

On the **Workflow** tab you can search for tasks and processes by their ID.

See “Opening a task by ID” on page 434.

### Delegating tasks

Process Manager lets you assign one user's tasks to another user. You can also specify a period for how long the delegation is valid. On the **Manage Delegations** page, you can view, add, and delete delegations.

See “Viewing a task or process in Process Manager” on page 435.

**To delegate tasks**

1. In the Process Manager portal, on the **Admin** tab, click **Users > Manage Delegations**.
2. In the right pane, click the **Add Delegation** symbol.
3. In the **Add Delegation** dialog box, specify the details of the delegation, and then click **Save**.

### Opening a task by ID

In Process Manager, you can open a task by its ID. The ID refers to the exact name of the task. The ID may include a process prefix and a task number.

Open a task by its ID when you know the exact task ID. For example, if you want to return to a specific task after you have worked on it, you can open it directly by its ID.

See “About the Workflow tab” on page 433.

**To open a task by ID**

1. In the Process Manager portal, click the **Workflow** tab.
2. In the **Open Task** search box, enter the ID of the task that you want to open.
3. Click **Open**.

If you entered the correct ID, the task opens.
Performing an action on multiple tasks at once

In Process Manager, you can perform certain actions on a group of tasks at one time. For example, you can reassign a group of tasks. The option to perform group actions can appear on any portal page that contains a task list. By default, the option appears on the **Workflow** tab.

See “About the Workflow tab” on page 433.

**To perform an action on multiple tasks at once**

1. In the Process Manager portal, click the **Workflow** tab.
2. Click the **Select a group action** drop-down list, and then click the action that you want to perform.
3. After the screen refreshes, click the check box to the left of each task on which you want to perform the action.
4. Click **Do action**.

Depending on the action that you selected, a dialog box may appear. To finish performing the action, complete the dialog box.

Viewing a task or process in Process Manager

You can view a workflow task or process in a process view page. You cannot view any task or process for which you do not have permissions.

See “About the Process View page” on page 390.

**To view a task or process**

1. In the Process Manager portal, click the **Workflow** tab.
2. If you want to view a task, click **Workflow Task List**.
3. In the right pane, click on the task that you want to view.
4. If you want to view a process, click **Workflow Process List**.
5. In the right pane, click on the process that you want to view.

Setting up users to view the process view page

Users can view the Process View page by clicking on a task that the process generates. Users must have permission to view the Process View page. The Process Manager server must also have enough concurrent licenses available to run Process Manager. If not, the Process View page is not available for viewing.

See “About the Process View page” on page 390.
To set up users to view the Process View page

1. In the Process Manager portal, on the Admin tab, click Users > Accounts > Manage Users.
2. In the right pane, next to the user to whom you want to give permissions, click the orange lightning symbol and select Manage Permissions.
3. On the Manager User Permissions page, maximize Category: UserLicenseLevel.
4. Check Process Manager.

Setting up workflow task integration between Workflow Designer and Process Manager

You can use the Workflow features of Process Manager to integrate with processes developed with Workflow Designer. To do this, Process Manager and Workflow Designer must be integrated.

See “About using tasks” on page 373.

See “Integrating Process Manager with Workflow Designer” on page 596.

See “Viewing a task or process in Process Manager” on page 435.

See “Setting up users to view the process view page” on page 435.

To set up workflow task integration with Workflow Designer

1. Turn on process reporting messages.
   - In the Process Manager portal, on the Admin tab, click Portal > Master Settings.
   - In the Reports Settings section, check Process Reporting Messages.
2. In Workflow Designer, open a Workflow project.
3. In the Workflow Designer tool, click the project name.
4. Click the Reporting tab.
5. Click Add Process Component.
6. Click on the project's primary model.
   - The Global Logging Capture component is now on your process page. It does not need to be connected to any other component. Do not delete the Global Logging Capture component.
7. Add the Setup Process component to the start of your process.
8 Edit the **Setup Process** component by adding at least the name you want for your process.

9 Add a Workflow component (for example, **Approval Workflow Component**) to your process after the **Setup Process** component.

10 Open the Workflow component for editing.

11 On the **Assignments** tab, for the **Task Source Type**, select **processmanagertasksource**.

   This makes the Workflow component a task in Process Manager.

12 On the **Assignments** tab, in the **Task Assignments** section, select the person, group, organizational unit, or permissions to assign this task to.

   For example, if you added an **Approval Workflow Component** and assigned it to a person; that person receives a task for an approval as part of this process.

13 Publish the project.

   When you publish a Workflow project, every Workflow component in that project sets up a task in Process Manager (if that component's Task Source Type is set to processmanagertasksource).

14 Open the Process View page in Process Manager. This lets you view your processes and their tasks.

   - In the Process Manager portal, on the **Workflow** tab, click the **Workflow Task List** symbol.
   
   - In the left pane, search for the task that was created from your process.
   
   - In the right pane, click the folder symbol.
     
     The **Default Process View** page appears.
Managing documents in Process Manager

This chapter includes the following topics:

- About document management
- About the Documents page
- About the actions that you can perform on documents
- About simple and advanced files in the document manager
- Adding a new document (Simple file)
- Adding a new document (Advanced file)
- Searching for documents
- Adding a document category
- Editing a document category
- Adding a document subcategory
- Category and Subcategory dialog boxes
- Deleting a document category
- Displaying the document category history
- Adding documents to additional categories
- Using the document viewer
- Setting category permissions for a document
About document management

The document manager is one of the modules of Process Manager. You can view the document manager under the Documents tab in Process Manager.

See “Process Manager tabs” on page 387.

See “Opening Process Manager” on page 386.

The document manager contains a document repository that lets you manage files. You can add simple and advanced files, search for files, and download files.

Note: The Documents tab may not be available to you if you do not have permissions to use it. Contact your Process Manager administrator about permissions.

Document management contains the following key features:

- The ability to set permissions at both the category and individual document level.
The ability to add simple documents. This type of document does not contain versioning information and can be searched for by name only.

The ability to add advanced documents. Advanced documents contain versioning information and can be customized with keywords for advanced search.

The ability to add messages to the Documents page. The messages inform a set of users that a document is expected from them by a certain date.

The ability to add the type of document that the user needs to add. Documents are not restricted to a set of defined types.

A name search as well as an advanced keyword search for finding documents.

The ability to set up a nested category hierarchy to better organize documents and make them easier for users to find.

The ability to email documents.

The ability to edit existing documents.

The ability to add additional versions of documents, and to display version and document history.

The ability to download documents and download .zip files of documents.

See “About the Documents page” on page 440.

See “Process Manager master settings” on page 406.

About the Documents page

The Documents page in the Process Manager portal lets you view, download, email, and perform other actions with documents in the document management system.

You can access the Documents page under the Documents tab in Process Manager.

Your permissions determine which documents you can view, and what actions you can take with those documents. For example, you may have permissions to view certain documents, but not to delete or edit the document data for those documents.

See “About document management” on page 439.

If your Documents page has been customized, its appearance and content may vary.
Table 19-1 Sections on the Documents page

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bulletin Board</td>
<td>Lets you view the scrolling messages that other workers post. For example, the messages can advertise current issues, announce outages, or provide information about a change that is planned to take place within the organization. You can also stop the scrolling. Bulletin Board messages can be made public or they can be restricted to specific users, groups, or organizations.</td>
</tr>
<tr>
<td>Search Documents</td>
<td>Lets you search the document management system for documents. You can search by document name and keyword.</td>
</tr>
<tr>
<td>Browse</td>
<td>Lets you select document categories to display on the right side of the page so that you can view the documents in that category. You can also create a new document category. See “Adding a document category” on page 445.</td>
</tr>
<tr>
<td>Advanced Search</td>
<td>Lets you perform a filtered search.</td>
</tr>
<tr>
<td>Service Catalog</td>
<td>Lets you launch the processes that are contained in the Service Catalog, such as submitting a Knowledge Base entry. See “About the service catalog” on page 497.</td>
</tr>
<tr>
<td>Profiles</td>
<td>Lets you sort documents by their profiles. You can expand the nodes to sort through documents or click on the profile values to see documents with those values. When you click on a profile value, the documents with that value appear in the right pane.</td>
</tr>
<tr>
<td>Tag Cloud</td>
<td>Displays the document tags. When you click on a tag, the documents with that tag appear in the right pane. See “About the tag cloud” on page 394.</td>
</tr>
<tr>
<td>Right pane</td>
<td>The right pane of the documents page displays documents. Different documents appear in the right pane based on how you have sorted the data. To display all of the documents, click the Documents tab.</td>
</tr>
</tbody>
</table>

About the actions that you can perform on documents

The Documents page in Process Manager contains the documents that you can work with.

See “About the Documents page” on page 440.

Based on your permissions, you may be able to perform the following actions:
About simple and advanced files in the document manager

You can add simple files in the document manager in Process Manager. This type of file has optional file information and tags. Use this type of file when you do not need to save versions of the file.
You can also add advanced files in the document manager in Process Manager. Advanced files have file information, tags, and version information. Use advanced files when you need to save versions of the file. For example, use an advanced file when you have a spreadsheet that multiple parties edit. You can keep track of how the document changes throughout its lifecycle.

See “About document management” on page 439.

See “About the Documents page” on page 440.

Adding a new document (Simple file)

You can add a Simple file in the document manager in Process Manager. Adding a file means uploading a file to the document repository.

See “About document management” on page 439.

See “About simple and advanced files in the document manager” on page 442.

See “Add Advanced Document dialog box” on page 454.

To add a Simple file in the document manager

1. In the Process Manager portal, click the Documents tab.
   See “About the Documents page” on page 440.

2. On the documents page, under Browse, select the category to which you want to add a document.

3. In the right pane, click the Add Document symbol.

4. Click Add Simple.

5. On the Documents Information tab, choose the file that you want to add.

6. (Optional) On the Optional tab, enter document information:

   - **Document Type**: The document type of the file. This property does not refer to a file type (such as .txt) but to a document type as configured under Admin > Data > Document Type.
     See “About the document type page” on page 487.

   - **Override Name**: The name of the file as it appears in the list of documents.

   - **Description**: A description of your file.
7 (Optional) On the Profiles tab, apply a profile value to your file.

See “About profiles” on page 389.

8 (Optional) On the Tags tab, add a tag to your document.

Adding a new document (Advanced file)

You can add an Advanced file in the document manager in Process Manager. Adding a file means uploading a file to the document repository.

See “About document management” on page 439.

See “About simple and advanced files in the document manager” on page 442.

To add an Advanced file in the document manager
1 In the Process Manager portal, click the Documents tab.

See “About the Documents page” on page 440.

2 On the documents page, under Browse, select the category to which you want to add an Advanced document.

3 In the right pane, click the Add Document symbol.

4 Click Add Advanced.

5 On the Documents Information tab, choose the file that you want to add.

6 (Optional) Set other file information:

   Name
   The name of the file as it appears in the list of documents.

   Document Type
   The document type of the file. This property does not refer to a file type (such as .txt) but to a document type as configured under Admin > Data > Document Type.

   See “About the document type page” on page 487.

   Description
   A description of your file.

   Keywords
   Words that you can add to your file to make it easier to find later. You can search for a file by keyword.

7 (Optional) On the Versions tab, set how many versions of the file the document manager keeps.

8 (Optional) On the Profiles tab, apply a profile value to your file.

See “About profiles” on page 389.
9  (Optional) On the Advanced tab, view the Document ID.
   The Document ID is a read-only GUID of the file.

10  (Optional) On the Tags tab, add a tag to your document.
   You can sort documents by tags in the Tag Cloud.
   See “About the tag cloud” on page 394.

Searching for documents

You can search for documents on the Documents page in Process Manager.

Note: Some documents may not be available to you if you do not have permissions to view them. For example, you may have permission to access only some of the documents in a category. You may have permissions to download all of the documents within a category but you may not have permissions to delete any of those documents. Contact your Process Manager administrator about permissions.

See “About document management” on page 439.
See “About the Documents page” on page 440.

To perform a basic search for documents

1  In the Process Manager portal, click the Documents tab.
2  Under Search Documents, enter the text that you want to search for, and click the Search symbol.
   The search applies to all of the document categories. This search is based on document name and tags only.

Adding a document category

Document categories help you organize all of the documents that are located in the Documents page in Process Manager. By organizing the documents in categories, users can find the documents that they need more easily. You can add new document categories to help organize your documents.

You can also apply permissions to categories that deny or grant access to that category and all of the documents within it.

See “Setting category permissions for a document” on page 452.
To add a document category

1. In the Process Manager portal, click the Documents tab.
   See “About the Documents page” on page 440.

2. On the Documents page, under Browse, click the Add Root Category option.

3. In the Add Category dialog box, define the new category, and then click Save.
   See “Category and Subcategory dialog boxes” on page 447.

Editing a document category

Document categories help you organize all of the documents that are located in the Documents page in Process Manager. By organizing the documents in categories, users can find the documents that they need more easily. You can edit existing document categories if you have the necessary permissions to do so.

You can also apply permissions to categories that deny or grant access to that category and all of the documents within it.

See “Setting category permissions for a document” on page 452.

To edit a document category

1. In the Process Manager portal, click the Documents tab.
   See “About the Documents page” on page 440.

2. On the Documents page, under Browse, select the category that you want to edit.

3. On the right side of the page, click the orange lightning symbol, and then click Edit.

4. In the Edit Category dialog box, make the necessary modifications, and then click Save.
   See “Category and Subcategory dialog boxes” on page 447.
Adding a document subcategory

Document subcategories help you organize all of the documents that are located in the Documents page in Process Manager. By organizing the documents in categories and subcategories, users can find the documents that they need more easily. You can create document subcategories if you have the necessary permissions to do so.

You can also apply permissions to subcategories that deny or grant access to that category and all the documents within it.

See “Setting category permissions for a document” on page 452.

Note: This capability may not be available if you do not have proper permissions. Contact your Process Manager administrator about permissions.

To add a document subcategory

1. In the Process Manager portal, click the Documents tab.
   See “About the Documents page” on page 440.
2. On the Documents page, under Browse, select the category that you want to add a subcategory to.
3. On the right side of the page, click the orange lightning symbol, and then click New Folder.
4. In the Add Sub Category dialog box, define the new subcategory, and then click Save.
   See “Category and Subcategory dialog boxes” on page 447.

Category and Subcategory dialog boxes

The Category and Sub Category dialog boxes appear when you add a document category, edit a document category, or add a document subcategory. The action that you take in Process Manager determines the dialog box that appears.

<table>
<thead>
<tr>
<th>Table 19-2</th>
<th>Actions and resulting dialog boxes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>Dialog box</td>
</tr>
<tr>
<td>Add a document category</td>
<td>Add Category dialog box. See “Adding a document subcategory” on page 447.</td>
</tr>
</tbody>
</table>
Table 19-2  Actions and resulting dialog boxes (continued)

<table>
<thead>
<tr>
<th>Action</th>
<th>Dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit a document category</td>
<td>Edit Category dialog box.</td>
</tr>
<tr>
<td></td>
<td>See “Editing a document category” on page 446.</td>
</tr>
<tr>
<td>Add a document subcategory</td>
<td>Add Subcategory dialog box.</td>
</tr>
<tr>
<td></td>
<td>See “Adding a document subcategory” on page 447.</td>
</tr>
</tbody>
</table>

Some of the options differ depending on the dialog box that appears.

These dialog boxes contain the following tabs:

- **Category Information**: Lets you enter information about the category, some of which is shown in the Documents page.

  Table 19-3

- **Profiles**: Lets you assign a profile to the category.

  See “About profiles” on page 389.

- **Advanced**: Shows the category ID for informational purposes only. No user actions are located on this tab. This tab appears only in the Edit Category dialog box.

Table 19-3 Options on the Category Information tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Lets you type a brief name for the category. This name is displayed in the Browse section and on the left side of the Documents page when a user selects the category.</td>
</tr>
<tr>
<td>Header Text</td>
<td>(Optional) Lets you type the descriptive text that displays under the category name on the right side of the Documents page. The text displays when a user selects the category.</td>
</tr>
<tr>
<td>Category Type</td>
<td>(Optional) Lets you select a category type for the category. If the Process Manager administrator has specified category types, they appear in this drop-down list. Category types further define the category and provide a category hierarchy in the Browse section of the Documents tab.</td>
</tr>
<tr>
<td>Hidden</td>
<td>(Optional) Lets you specify whether this category should be hidden from all other users.</td>
</tr>
</tbody>
</table>
Table 19-3 Options on the Category Information tab (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Notifications</td>
<td>When this option is selected, notifications can be sent on the events that occur on documents in this category. For example, notifications can be sent when a document is added, edited, or deleted. This option is selected by default. If this check box is cleared, no notifications are sent on any events that occur in this category.</td>
</tr>
<tr>
<td>Parent Category</td>
<td>(Optional) Lets you specify a parent category. This option appears only in the Edit Category dialog box</td>
</tr>
</tbody>
</table>

Deleting a document category

Document categories help you organize all of the documents that are located in the Documents page in Process Manager. By organizing the documents in categories and subcategories, users can find the documents that they need more easily. You can delete document categories if you have the necessary permissions to do so.

When you delete document categories, the subcategories and the documents that are contained in that category are not necessarily deleted. You can make selections during the deletion process that determine what happens to the subcategories and the documents that are contained in a document category.

**Note:** This capability may not be available to you if you do not have proper permissions. Contact your Process Manager administrator about permissions.

See “About document management” on page 439.

See “About the Documents page” on page 440.

To delete a document category

1. In the Process Manager portal, click the Documents tab.

   See “About the Documents page” on page 440.

2. On the Documents page, under Browse, select the category that you want to delete.

3. On the right side of the page, click the orange lightning symbol, and then click Delete.
4 In the **Delete Category** dialog box, select one of the following options for handling any subcategories that are contained in the category:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Do not delete Subcategories</strong></td>
<td>Retains all of the subcategories that are contained in the parent category. The subcategories are moved up to the root level.</td>
</tr>
<tr>
<td><strong>Delete Subcategories</strong></td>
<td>Deletes all of the subcategories that are contained in the parent category. If documents in that category also belong to another category, they remain in the other categories. If documents do not belong to other categories, they are moved to the Orphan category.</td>
</tr>
<tr>
<td><strong>Delete Subcategories and all files in them</strong></td>
<td>Deletes all of the subcategories and the documents that they contain.</td>
</tr>
</tbody>
</table>

Select one of the following options for handling any documents that are contained in the category:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Do not delete documents</strong></td>
<td>Retains all of the documents that are contained in the category.</td>
</tr>
<tr>
<td><strong>Delete documents (that are linked only to the deleted category)</strong></td>
<td>Deletes all of the documents that are contained in the category if they are linked only to the deleted category. If the documents are linked to additional categories, they are retained.</td>
</tr>
<tr>
<td><strong>Delete documents even if linked to multiple categories</strong></td>
<td>Deletes all of the documents that are contained in the category, even if they are linked categories other than the one that you delete.</td>
</tr>
</tbody>
</table>

5 Click **Delete**.

### Displaying the document category history

On the **Documents** page of Process Manager, you can display the history for documents. Document history includes creation and change events for each of the categories on the **Documents** tab.

See “About the Documents page” on page 440.
To display document category history

1. In the Process Manager portal, click the **Documents** tab.
   
   See “About the Documents page” on page 440.

2. On the Documents page, under **Browse**, select the category for which you want to view category history.

3. On the right side of the page, click the orange lightning symbol, and then click **History**.

Adding documents to additional categories

On the **Documents** tab in Process Manager, you can add documents to additional categories.

When you initially add documents to the Documents page, they are contained in a single category. Users with the appropriate permissions can add documents to additional categories. The number of categories that a document can belong to is unlimited.

See “About document management” on page 439.

To add documents to additional categories

1. In the Process Manager portal, click the **Documents** tab.
   
   See “About the Documents page” on page 440.

2. On the Documents page, under **Browse**, select the category that contains the document that you want to add to additional categories.

3. Click the orange lightning symbol for the document that you want to add to additional categories, click **Edit**, and then click **Add To Category**.

4. In the **Add to Category** dialog box, click the **Add New Category** tab.

5. In the **Category** text box, type the name of the category to which you want to add the document.
   
   You can also click **Pick** to search for the category.

6. Click **Add**.

Using the document viewer

On the **Documents** tab in Process Manager, you can view documents with the documents viewer. The document viewer lets you preview documents without downloading them. Use the documents viewer to quickly to determine whether you want to download the documents.
When you open the documents viewer, a pop-up window appears. This window displays a list of documents on the left side of the screen. This window also displays a preview of the selected document on the right side of the screen. This preview window lets you see if the document is a document that you want to download. The document viewer displays Microsoft Office documents and image files.

See “Viewing document versions” on page 457.

To open the document viewer

1. In the Process Manager portal, click the Documents tab.
   
   See “About the Documents page” on page 440.

2. On the Documents page, under Browse, select the category for which you want to display the document viewer.

3. On the right side of the page, click the orange lightning symbol, and then click Document Viewer.

Setting category permissions for a document

Administrators can set category permissions for a document on the Documents tab in Process Manager.

Document categories help you organize all of the documents that are located on the Documents page. By organizing the documents in categories, users can find the documents they need more easily. You can apply permissions to categories that deny or grant access to that category and all of the documents within it. By default, the category inherits the permissions of the user who created it. If you want the permissions to be different for other users of the category, you need to modify the category permissions.

See “About document management” on page 439.

To set document category permissions

1. In the Process Manager portal, click the Documents tab.
   
   See “About the Documents page” on page 440.

2. On the Documents page, under Browse, select the category for which you want to set permissions.

3. On the right side of the page, click the orange lightning symbol, and then click Permissions.
4 In the **Permissions** dialog box, add or modify permissions as needed. You can take multiple actions with permissions.

Permissions procedures are as follows:

- **To edit existing permissions**
  - Select the edit icon for the permission that you want to modify. Make the necessary changes to the permission and click **Update**.

- **To remove an existing permission**
  - Click the delete icon for the permission that you want to remove.

- **To add a new permission**
  - Click **Add New Permission**. Select the permission type, and the user, group, permission, or organization for which you want to set permissions. Set the appropriate permissions and click **Add**.

5 Click **Close**.

---

### Creating expected document messages

You can create expected document messages on the **Documents** tab in Process Manager. Expected document messages display a notice to users that they need to provide a document by a certain date. You can select a user, group, or organizational unit to which to display the message.

The message for the expected document is not sent to the user, group, or unit in an email or task. The message appears on the **Documents** tab in Process Manager.

See “About document management” on page 439.

**To create an expected document message**

1. In the Process Manager portal, click the **Documents** tab.

2. On the Documents page, under **Browse**, select the category for which you want to add an expected document message.

3. On the right side of the page, click the orange lightning symbol and click **Expected Documents**.

4. In the **Expected Documents** dialog box, type a name for the document in the **Document Name** text box.

5. (Optional) In the **Group Name** text box, type a group name from which the document is expected.

6. (Optional) In the **Expected Date** text box, type the expected date for the document.
7  (Optional) In the **Document Type** drop-down list, select a document type. This property does not refer to a file type (such as .txt) but to a document type as configured under **Admin > Data > Document Type**.

8  (Optional) In the **Description** text box, type a description of the expected document. This description is displayed with the expected document message.

9  In the **Select Source** drop-down list, select whether you want the message to be shown to a user, group, or organizational unit.

10 Type the user, group, or organizational unit and click **Add Source**.

11 Type additional sources as necessary.

12 Click **Save**.

### Add Advanced Document dialog box

This dialog box appears when you add an advanced document to the Documents page, or when you edit a document’s data.

See “Adding a new document (Advanced file)” on page 444.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Information</td>
<td>File</td>
<td>Lets you enter the file name and path to the file that you want to add to the Documents page, or browse to the file.</td>
</tr>
<tr>
<td>Document Information</td>
<td>Name</td>
<td>(Optional) Lets you type a meaningful name for the document that appears on the Documents page. If you do not enter an override name, the name of the file is the document name.</td>
</tr>
<tr>
<td>Document Information</td>
<td>Document Type</td>
<td>The document type of the file. This property does not refer to a file type (such as .txt) but to a document type as configured under <strong>Admin &gt; Data &gt; Document Type</strong>. See “About the document type page” on page 487.</td>
</tr>
<tr>
<td>Document Information</td>
<td>Description</td>
<td>(Optional) Lets you type a description that appears beneath the document on the Documents page.</td>
</tr>
<tr>
<td>Document Information</td>
<td>Keywords</td>
<td>(Optional) Lets you type the keywords that are associated with the document and that display during a document search.</td>
</tr>
<tr>
<td>Tab</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Versions to Keep</td>
<td>Release</td>
<td>Lets you enter the number of release versions of the document that Process Manager keeps. Any versions beyond this number are removed.</td>
</tr>
<tr>
<td>Versions to Keep</td>
<td>Major</td>
<td>Lets you enter the number of major versions of the document that Process Manager keeps. Any versions beyond this number are removed.</td>
</tr>
<tr>
<td>Versions to Keep</td>
<td>Minor</td>
<td>Lets you enter the number of minor versions of the document that Process Manager keeps. Any versions beyond this number are removed.</td>
</tr>
<tr>
<td>Versions to Keep</td>
<td>Keep major versions</td>
<td>Lets you specify whether you want major versions of previous release versions kept.</td>
</tr>
<tr>
<td></td>
<td>of previous release</td>
<td></td>
</tr>
<tr>
<td></td>
<td>versions</td>
<td></td>
</tr>
<tr>
<td>Versions to Keep</td>
<td>Keep minor versions</td>
<td>Lets you specify whether you want minor versions of previous major versions kept.</td>
</tr>
<tr>
<td></td>
<td>of previous major</td>
<td></td>
</tr>
<tr>
<td></td>
<td>versions</td>
<td></td>
</tr>
<tr>
<td>Version Information</td>
<td>Release version</td>
<td>Lets you type a release version number for the document.</td>
</tr>
<tr>
<td>Version Information</td>
<td>Major version</td>
<td>Lets you type a major version number for the document.</td>
</tr>
<tr>
<td>Version Information</td>
<td>Minor version</td>
<td>Lets you type a minor version number for the document.</td>
</tr>
<tr>
<td>Version Information</td>
<td>Notes</td>
<td>(Optional) Lets you type additional information to display with the document.</td>
</tr>
<tr>
<td>Profiles</td>
<td>Profile definition</td>
<td>(Optional) Lets you apply profiles to the document. See “About profiles” on page 389.</td>
</tr>
<tr>
<td></td>
<td>values</td>
<td></td>
</tr>
<tr>
<td>Tags</td>
<td>Tags</td>
<td>Lets you add tags to the document.</td>
</tr>
</tbody>
</table>

### Downloading documents

The **Documents** tab in Process Manager gives you access to all available documents. Depending on your permissions, you can download any of the documents.
To download a document

1. In the Process Manager portal, click the **Documents** tab.
   
   See “About the Documents page” on page 440.

2. On the Documents page, under **Browse**, select the category that contains the document that you want to download.

3. On the right side of the page, click the **download** icon for the document that you want to download.

4. Follow the prompts in the **File Download** dialog box.

**Downloading ZIP files**

On the **Documents** tab in Process Manager, you can download documents as compressed files. Your permissions may affect which documents you can download. When you download a document, it compresses for a faster download time.

To download a compressed file of a document

1. In the Process Manager portal, click the **Documents** tab.
   
   See “About the Documents page” on page 440.

2. On the Documents page, under **Browse**, select the category that contains the document that you plan to download.

3. On the right side of the page, click the **Action** symbol for the document that you want to download, and then click **Download ZIP**.

4. Follow the prompts in the **File Download** dialog box.

**Viewing documents**

On the **Documents** tab in Process Manager, you can view documents. You can view any of the documents that you have access to from the Documents tab. Only the categories and documents that you have permission to view are visible, so you can view any documents that are displayed.

See “Viewing document versions” on page 457.

See “Using the document viewer” on page 451.

See “Viewing the document history” on page 457.
To view a document
1. In the Process Manager portal, click the Documents tab.
2. On the Documents page, under Browse, select the category that contains the document that you want to view.
3. Click the orange lightning symbol for the document that you want to view, click View, and then click Open Document.
4. Follow the prompts in the File Download dialog box to open the document.

Viewing document versions

You can view all of the available versions of the documents that you have access to from the Documents tab. From the Document Versions dialog box, you can also download any of the available document versions.

See “About document management” on page 439.

To view document version and history
1. In the Process Manager portal, click the Documents tab.
2. On the Documents page, under Browse, select the category that contains the document that you want to view.
3. Click the orange lightning symbol for the document that you want to view, click View, and then click Show Versions.
4. In the Document Versions dialog box, you can do one of the following:
   - Click the download zip icon and follow the prompts in the File download dialog box to download a .zip file of the document version.
   - Click the download icon and follow the prompts in the File download dialog box to download the document version.
   - Click the Delete Version icon and click OK to confirm to delete the document version.

Viewing the document history

You can view history data for the documents that you have access to from the Documents tab.

Document history data includes the following items:
- Actions
- Action by user
To view document history
1. In the Process Manager portal, click the **Documents** tab.
2. On the Documents page, under **Browse**, select the category that contains the document that you want to view.
3. Click the orange lightning symbol for the document that you want to view, click **View**, and then click **History**.

## Editing document data

On the **Documents** tab in Process Manager, you can edit document data. Depending on your permissions, you may not be able to edit document data.

See “**About document management**” on page 439.

To edit document data
1. In the Process Manager portal, click the **Documents** tab.
   
   See “**About the Documents page**” on page 440.
2. On the Documents page, under **Browse**, select the category that contains the document that you want to edit.
3. Click the orange lightning symbol for the document that you want to view, click **Edit**, and then click **Document Data**.
4. In the **Document Data** dialog box, make the necessary changes to the document data, and then click **Save**.
   
   See “**Add Advanced Document dialog box**” on page 454.

## Adding a new document version

On the **Documents** tab in Process Manager, you can add new versions of documents.

Depending on your permission level, you may not be able to add a new document version.
To add a new document version

1. In the Process Manager portal, click the **Documents** tab.
   
   See “About the Documents page” on page 440.

2. On the documents page, under **Browse**, select the category that contains the document for which you want to add a new version.

3. On the right side of the page, click the orange lightning symbol for the document that you want to view. Click **Edit**, and then click **Add New Version**.

4. In the **Document Versions** dialog box, click the **Add New Version** tab.

5. (Optional) In the **Version Type** drop-down list, select one of the following options:
   - Minor
   - Release
   - Major

6. (Optional) In the **Notes** text box, enter notes to give other users more context about the document version.

7. Click **Browse**, and in the **Choose File** dialog box, select a file and click **Open**.

8. Click **Add**.

Promoting a document version

On the **Documents** tab in Process Manager, you can promote a document version. Depending on your permission level, you may not be able to promote a document version.

To promote a document version

1. In the Process Manager portal, click the **Documents** tab.
   
   See “About the Documents page” on page 440.

2. On the Documents page, under **Browse**, select the category that contains the document that you want to promote.

3. Click the orange lightning symbol for the document that you want to view, click **Edit**, and then click **Promote Document Version**.

4. In the **Promote Documents Version** dialog box, click the **Promote This Document Version** tab.
(Optional) In the Notes text box, type notes to give other users more context about the document version.

Click Promote This Version.

Setting document permissions

Users with the appropriate permissions can set permissions on individual documents on the Documents page in Process Manager. Granting or denying permissions for a document controls which users can access the document, and what users can do with the document.

See “About document management” on page 439.

To set document permissions

1. In the Process Manager portal, click the Documents tab.
2. On the Documents page, under Browse, select the category that contains the document for which you want to set permissions.
3. Click the orange lightning symbol for the document that you want to set permissions for, click Edit, and then click Permissions.
4. In the Permissions List dialog box, add or modify permissions as needed. You can take multiple actions with permissions:
   - To edit existing permissions: Select the edit icon for the permission that you want to modify. Make the necessary changes to the permission and click Update.
   - To remove an existing permission: Click the delete icon for the permission that you want to remove.
   - To add a new permission: Click Add New Permission. Select the permission type, and the user, group, permission, or organization for which you want to set permissions. Set the appropriate permissions and click Add.

5. Click Close.

Emailing documents

On the Documents tab in Process Manager, you can email documents. Depending on your permissions, you may not be able to email some documents.

See “About document management” on page 439.
To email a document

1. In the Process Manager portal, click the **Documents** tab. See “About the Documents page” on page 440.

2. On the Documents page, under **Browse**, select the category that contains the document that you want to email.

3. On the right side of the page, click the orange lightning symbol for the document that you want to email, and then click **Send**.

4. In the **Send Document** dialog box, in the **Send To** box, type the email address or addresses of the intended document recipient.

5. (Optional) In the **CC** box, type the email address or addresses of the intended document recipients.

6. (Optional) In the **Subject** box, type a descriptive subject for the email.

7. (Optional) In the **Message** box, type a message for the body of the email.

8. In the **Send Method** drop-down list, select one of the following options:

   - **send as attachment**: Sends the document as an attachment to the email. This option is the default.
   - **send download link**: Sends a link in the body of the email for downloading the document.

9. Click **Send Document**.

Deleting documents

On the **Documents** tab in Process Manager, you can delete documents. Depending on your permissions, you may not be able to delete some documents.

To delete a document

1. In the Process Manager portal, click the **Documents** tab. See “About the Documents page” on page 440.

2. On the Documents page, under **Browse**, select the category that contains the document that you want to delete.

3. On the right side of the page, click the orange lightning symbol for the document that you want to delete, and then click **Delete**.

4. Click **OK** in the confirmation dialog box.
Adding a document with a workflow project

You can add a document on the Documents tab in Process Manager using components in a project that you create in Workflow Designer. You can configure the Add Document component in a workflow project to add a document to Process Manager.

See “About document management” on page 439.

To add a document in Process Manager using components

1 In Workflow Manager, create a Workflow project.
   You can use any project type except the Integration type of project.
   See “Creating a new Project in Workflow Manager” on page 134.

2 Create a document category for the document that you want to add.
   ■ In the project, add a Setup Process component.
   ■ Edit the Setup Process component (double-click to edit).
   ■ On the General tab, enter a name for the process.
   ■ Check Create Document Category.
   ■ In the Header Text box, enter the name of the category that you want.
   ■ In the Output Process CategoryID Name box, accept the default or enter a new output variable name for the category. Write down the name of this box because you need to use the name later.
   ■ Click OK.

3 In the project workspace, add and edit an AddDocument (0) component.
   ■ Add an AddDocument (0) component.
   ■ Edit the AddDocument (0) component (double-click to edit).
   ■ On the Inputs tab, under Service URL Source property, check Use Default.
   ■ For the Category Source property, check From Variable.
   ■ In the Document Category Id box, click the ... symbol.
   ■ In the Document Category Id Variable dialog box, check Process Variables.
   ■ Click Add.
   ■ Select the Output Process CategoryID Name.
   ■ Click OK.
4 Add a document to the AddDocument (0) component.
   - In the component editor of the AddDocument (0) component, click the Inputs tab. Then, in the Document File box, click the ... symbol.
   - Select a Value Source. For example, check Constant Value. Then, click Edit, and in the Contents box, click the ... symbol to search for the file that you want to add.
   - Click OK.
   - Click OK.
   - Click OK to close the AddDocument (0) editor.

5 Publish the Workflow project.
   See “Publishing a project” on page 197.

6 View the document in Process Manager.
   - Open Process Manager.
   - In the Process Manager portal, click the Documents tab.
   - In the left pane, browse to the category with the same name as the Output Process CategoryID Name.
   - In the right pane, view the document.
Managing the Knowledge Base and discussions in Process Manager

This chapter includes the following topics:

■ About the knowledge base and discussions
■ Managing categories
■ Adding a knowledge base article
■ Adding a Bulletin board
■ Adding a Wiki
■ Adding a FAQ
■ Working with articles
■ Adding a new entry to an article
■ Setting permissions for a knowledge base entry
■ Adding a discussion
■ Working with discussions
■ Adding a new thread to a discussion
About the knowledge base and discussions

The knowledge base is a data repository holding information on incidents, problems, and known errors. By collecting information in the knowledge base, organizations can match new articles against previous ones and reuse established solutions and approaches.

<table>
<thead>
<tr>
<th>Knowledge base Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Article</td>
<td>An article is a document that contains a date stamp and an author. It has no restrictions on size, and it can contain images, formatted HTML, and links.</td>
</tr>
<tr>
<td>FAQ</td>
<td>Provides a user with information in a question and an answer format.</td>
</tr>
<tr>
<td>Bulletin Board</td>
<td>An entry that is designed to provide users with time-sensitive, critical information. Bulletin board entries have date restrictions and a priority. Bulletin board entries are shown in the bulletin board in the portal. The bulletin board can be seen from each of the root pages in the Portal.</td>
</tr>
<tr>
<td>Wiki Entry</td>
<td>A group of related pages on a specific topic.</td>
</tr>
</tbody>
</table>

Access to the knowledge base and the information it contains is controlled through the use of permissions. Permissions at the user, group, and organizational unit level can be granted to any entry in the knowledge base.

The key features of the knowledge base are as follows:

- The bulletin board, which facilitates proactive notification to all users.
- The ability for users to rate all of the knowledge base entries based on their usefulness. Process Manager automatically rates articles higher the more frequently an article is used. Reports can then be run against the ratings to determine which knowledge base entries should be removed or modified to improve their content.
- All of the knowledge base content is stored in a content management system and is fully audited. This content can then be reported on to analyze the number of times, and how recently entries were viewed, among other things.

The knowledge base window lets you view, manage, and add content to the repository. This content includes knowledge base articles, bulletin boards, Wikis, and FAQs.

The knowledge base window is divided into two panes. The left pane lists categories of articles and lets you search for articles. The right pane lists the articles that are found in the selected category.
See “Managing categories” on page 466.
See “Adding a knowledge base article” on page 467.
See “Adding a Bulletin board” on page 468.
See “Adding a Wiki” on page 468.
See “Adding a FAQ” on page 469.
See “Working with articles” on page 469.
See “Adding a new entry to an article” on page 470.
See “Setting permissions for a knowledge base entry” on page 471.

The Discussions window lets you view, manage, and add to discussion groups. These discussion groups can be used for a variety of purposes. These purposes include a general discussion area about a process, a technical repository, lists of issues or features, and general information.

The Discussions window has one pane. It lists any discussion that you created. Each entry in the list displays the following information:

■ Discussion name.
■ Date of the last posting on that discussion.
■ Number of the threads that are currently active.
■ Total number of posts in that discussion.
See “Adding a discussion” on page 472.
See “Working with discussions” on page 472.
See “Adding a new thread to a discussion” on page 473.

The Schedules window lets you view, manage, and add to schedules. You can use schedules to plot out tasks, deliverables, and milestones.

The Schedules window has two panes. The left pane displays the schedules and the right pane displays the calendar with the schedule entries.
See “Adding a schedule” on page 475.
See “Working with schedules” on page 477.

Managing categories

Articles are assigned to a category at creation. Categories let you keep track of similar articles. Each article that you create is assigned to the selected category when it is created. Before you add an article, you must create and select the category that you want to add that article to.
A default article category is provided. However, you can create as many categories as you need.

See “About the knowledge base and discussions” on page 465.

See “Adding a knowledge base article” on page 467.

See “Adding a Bulletin board” on page 468.

See “Adding a Wiki” on page 468.

See “Adding a FAQ” on page 469.

To add a root category

1. In the Process Manager portal, click the Knowledge Base tab.
2. In the left pane, click the Add Category symbol.
3. Select Add Root Category.
4. Enter the name and description for this category.
5. Click Add Permission to add permissions for this category.
6. Click Save.

To add a sub-category

1. In the Process Manager portal, click the Knowledge Base tab.
2. In the left pane, select the category to which you want to add a sub-category.
3. Click the Add Category symbol.
4. Select Add Sub Category.
5. Enter the name and description for this sub-category.
6. Click Add Permission to add permissions for accessing this sub-category.
7. Click Save.

Adding a knowledge base article

You can add knowledge base articles to the repository.

Knowledge base articles can also be added by adding a workflow task component in your process in Workflow Designer.

See “Managing categories” on page 466.

To add a knowledge base article

1. In the Process Manager portal, click the Knowledge Base tab.
2. In the left pane, select the category to which you want to add the article.
In the right pane, click Add Article.

Enter the article title and description.

Click the Permissions tab and click Add Permission to add permissions for accessing this article.

Click Save.

Adding a Bulletin board

You can add bulletin boards to the repository. When bulletin boards are added, their names scroll in a box in the left pane of the Documents, KB, and Workflow modules.

Bulletin boards can also be added by adding a workflow task component in your process in Workflow Designer.

See “Managing categories” on page 466.

To add a bulletin board

1. In the Process Manager portal, click the Knowledge Base tab.
2. In the left pane, select the category to which you want to add the bulletin board.
3. In the right pane, click Add Bulletin Board.
4. Enter the bulletin board title and description.

This information creates the first entry for the bulletin board.

When you add a bulletin board entry, a schedule with the bulletin board name is created. The entries that are based on the dates of the bulletin board entry are added to that schedule.

See “Adding a schedule” on page 475.

6. Click the Permissions tab and click Add Permission to add permissions for accessing this bulletin board.

7. Click Save.

Adding a Wiki

Wikis can be added to Process Manager.

Wikis can also be added by adding a workflow task component in your process in Workflow Designer.
See “Managing categories” on page 466.

To add a Wiki

1. In the Process Manager portal, click the Knowledge Base tab.
2. In the left pane, select the category to which you want to add the Wiki.
3. In the right pane, click Add Wiki.
4. Enter the Wiki title and description.
5. Enter the text for the Wiki. The text must be in Wiki format.
6. Click the Permissions tab and click Add Permission to add permissions for accessing this Wiki.
7. Click Save.

Adding a FAQ

FAQs are the frequently asked questions that provide an answer to users.

FAQs can also be added by adding a workflow task component in your process in Workflow Designer.

See “Managing categories” on page 466.

To add a FAQ

1. In the Process Manager portal, click the Knowledge Base tab.
2. In the left pane, select the category to which you want to add the FAQ.
3. In the right pane, click Add FAQ.
4. Enter the FAQ question.
5. Enter the FAQ answer.
6. Maximize the Explanation of the Question section if you want to add more explanation to the question.
7. Click the Permissions tab and click Add Permission to add permissions for accessing this FAQ.
8. Click Save.

Working with articles

After articles are posted in Process Manager, users can perform multiple actions on them.

See “About the knowledge base and discussions” on page 465.
To view an article
1. In the Process Manager portal, click the Knowledge Base tab.
2. In the left pane, select the category of the article that you want to view.
   You can also enter a term to search for the article that you want to view.
3. In the right pane, under an Articles section, click the View symbol next to the article that you want to view.

To edit an article
1. In the Process Manager portal, click the Knowledge Base tab.
2. In the left pane, select the category of the article that you want to edit.
   You can also enter a term to search for the article that you want to edit.
3. In the right pane, under an Articles section, click the lightning symbol next to the article that you want to edit, and then select Edit.
4. Edit the article.
5. Click Save.

To delete an article
1. In the Process Manager portal, click the Knowledge Base tab.
2. In the left pane, select the category of the article that you want to delete.
   You can also enter a term to search for the article that you want to delete.
3. In the right pane, under an Articles section, click the lightning symbol next to the article that you want to delete, and then select Delete.
4. Click OK.

Adding a new entry to an article
After knowledge base articles and bulletin boards are created, users can add entries to them as needed. Additionally, Wikis can have entry information added to them.

See “About the knowledge base and discussions” on page 465.

To add a new entry to a knowledge base article or bulletin board
1. In the Process Manager portal, click the Knowledge Base tab.
2. In the left pane, select the category of the article to which you want to add an entry.
   You can also enter a term to search for the article to which you want to add an entry.
In the right pane, under an Articles section, click the article to which you want to add an entry.

4 Click **Add New Entry**.

5 Enter the entry information.

6 Click **Save**.

When a bulletin board entry is added, entries based on the dates of the entry are added to the schedule of the bulletin board.

See “Adding a schedule” on page 475.

To add entry information to a Wiki

1 In the Process Manager portal, click the **Knowledge Base** tab.

2 In the left pane, select the category of the Wiki to which you want to add an entry.

   You can also enter a term to search for the Wiki to which you want to add an entry.

3 In the right pane, under an Articles section, click the Wiki to which you want to add an entry.

4 Click the orange lightning symbol and then click **Edit Entry**.

   You can also click the Wiki link.

5 Edit the text of the Wiki.

6 Click **Save**.

Setting permissions for a knowledge base entry

Access to knowledge base entries can be controlled through permissions. Permissions can be set on any knowledge base entry at the user, group, or organizational unit level. Only administrators or users with the appropriate permissions can set permissions for a knowledge base entry.

See “About the knowledge base and discussions” on page 465.

To set permissions for a knowledge base entry

1 In the Process Manager portal, click the **Knowledge Base** tab.

2 Locate the knowledge base entry for which you want to set permissions, click the lightning bolt icon, and select **Edit**.

3 In the **Edit Article** dialog box, select **Permissions**.

4 Click **Add New Permission**.
5  Make the wanted modifications to the permissions for the knowledge base article.

6  Click **Save** to implement the changes.

## Adding a discussion

Users can start new discussions and post them to existing discussions.

See “About the knowledge base and discussions” on page 465.

See “Working with discussions” on page 472.

See “Adding a new thread to a discussion” on page 473.

### To add a discussion

1  In the Process Manager portal, on the **Knowledge Base** tab, click **Discussions**.

2  Click **Add Discussion**.

3  Enter the discussion title and description.

4  Click the **Permissions** tab and click **Add Permission** to add permissions for accessing this discussion.

5  Click **Save**.

## Working with discussions

After discussions are posted in Process Manager, users can perform multiple actions on them.

See “About the knowledge base and discussions” on page 465.

See “Adding a discussion” on page 472.

See “Adding a new thread to a discussion” on page 473.

### To edit a discussion

1  In the Process Manager portal, on the **Knowledge Base** tab, click **Discussions**.

2  Click the orange lightning symbol next to the discussion that you want to edit and click **Edit Discussion**.

3  Edit the discussion.

4  Click **Save**.
To delete a discussion

1. In the Process Manager portal, on the Knowledge Base tab, click Discussions.
2. Click the orange lightning symbol next to the discussion that you want to delete and click Delete.
3. Click OK.

Adding a new thread to a discussion

Users can start new discussions and post them to existing discussions. Posts can be replied to or edited.

See “About the knowledge base and discussions” on page 465.

See “Adding a discussion” on page 472.

See “Working with discussions” on page 472.

To add a new thread to a discussion

1. In the Process Manager portal, on the Knowledge Base tab, click Discussions.
2. Click the add thread symbol next to the discussion to which you want to add a thread.
3. Enter the thread name and text.
4. Click Save.
Managing schedules in Process Manager

This chapter includes the following topics:

- About schedules
- Adding a schedule
- Add Schedule dialog box
- Working with schedules

About schedules

In Process Manager, schedules record various date-related events and functions in a calendar. When you consider the scheduled events together instead of in isolation, you can avoid unforeseen conflicts. The schedule also provides the information that you can use to communicate planned downtime to management and to the users who the implementation affects.

Table 21-1 Schedules in Process Manager

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedules</td>
<td>A group of entries that are of a specific type. Each schedule contains entries for the events of the appropriate type. All of the entries in the individual schedules combine on a single calendar. See “Adding a schedule” on page 475.</td>
</tr>
</tbody>
</table>
Table 21-1  Schedules in Process Manager (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule entries</td>
<td>The scheduled time for a specific event. Schedule entries can also be entered manually. For example, you may add a company meeting, a training session, or other non-process event that can affect the process-related schedules. See “Working with schedules” on page 477.</td>
</tr>
</tbody>
</table>
| Calendar      | A page that displays the schedule entries. You can display the entries for all of the schedules or for only the schedules that you select. The format options for viewing the schedule are as follows:  
  - Today  
  - Three days  
  - Work Week  
  - Week  
  - Month  
  - Gantt View  
  Displays the schedule in a Gantt style so that you can see other task dependencies in one view. You can select a start date and an end date, and then click Go to display the interactions. |

---

**Adding a schedule**

You can add as many schedules as you want. Schedules contain the calendar items that are displayed in the calendar. When you create a schedule, it does not contain any calendar items. Schedules can be added manually or automatically by adding an entry to a bulletin board.

See “About the knowledge base and discussions” on page 465.

See “Working with schedules” on page 477.

See “Adding a Bulletin board” on page 468.

**To add a schedule**

1. In the Process Manager portal, on the Knowledge Base tab, click Schedules.
2. In the left pane, click the Add Schedule symbol.
3 Enter the schedule name and description.
4 Select the color background for the items in this schedule.
5 Click the Permissions tab and click Add Permission to add permissions for accessing this schedule.
6 Click Save.

Add Schedule dialog box

This dialog box lets you create a new schedule in the calendar. In Process Manager a schedule represents a certain type of schedule entry.

See “Adding a schedule” on page 475.

The Add Schedule dialog box contains the following tabs:

Schedule Information
- Lets you define the schedule.

Permissions
- Lets you set the permissions for accessing this schedule.
  See “Setting up groups, permissions, and users for the first time” on page 508.

Table 21-2 Options on the Add Schedule Information tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Identifies this schedule in any schedule list or display in the Process Manager portal. For example, if this schedule is for a specific location, you can use the location name.</td>
</tr>
<tr>
<td>Description</td>
<td>Lets you provide additional information to describe the schedule.</td>
</tr>
<tr>
<td>Color</td>
<td>Lets you select the color in which to display the items that appear in this schedule.</td>
</tr>
<tr>
<td>Process Notifications</td>
<td>Sends the email notifications when events occur on this schedule. For example, notifications can be sent when a schedule entry is added, edited, or deleted. The notifications are sent to those who have notify permissions for this schedule.</td>
</tr>
</tbody>
</table>
Working with schedules

After schedules are added in Process Manager, users can perform multiple actions on them.

See “About the knowledge base and discussions” on page 465.

Editing a schedule

1. In the Process Manager portal, on the Knowledge Base tab, click Schedules.
2. In the left pane, click the orange lightning symbol next to the schedule that you want to edit and click Edit.
3. Edit the schedule.
4. Click Save.

Deleting a schedule

1. In the Process Manager portal, on the Knowledge Base tab, click Schedules.
2. In the left pane, click the orange lightning symbol next to the schedule that you want to delete and click Delete.
3. Click OK.
   The schedule and all entries are deleted.

Adding a schedule entry

1. In the Process Manager portal, on the Knowledge Base tab, click Schedules.
2. In the right pane, click the Add Entry symbol.
3. Select the schedule to which to add this entry.
4. Enter the name of this entry.
5. Enter the start and the end dates for this entry. These are the dates that this entry displays on the schedule.
6. (Optional) Enter a pop-up description.
   This description appears when a user hovers over the entry.
7. Select the color background for this entry to use on the calendar.
8. Enter a description for this entry.
9. Click Save.

Editing a schedule entry

1. In the Process Manager portal, on the Knowledge Base tab, click Schedules.
2. In the right pane, double-click the entry in the calendar that you want to edit.
3 Edit the schedule entry.
4 Click Save.

Deleting a schedule entry
1 In the Process Manager portal, on the Knowledge Base tab, click Schedules.
2 In the right pane, double-click the entry in the calendar that you want to delete.
3 Click Delete.
4 Click OK.

Searching for a schedule entry
1 In the Process Manager portal, on the Knowledge Base tab, click Schedules.
2 Under Search Schedule Entry, enter one or more words from the entry’s title or description, and then click the Search symbol.
Managing data in Process Manager

This chapter includes the following topics:

- About data management
- Working with document types
- Working with document category types
- Adding a user relationship type
- About the Lists and Profiles page
- About the Application Properties page
- About the document type page
- About the document category type page
- About the data hierarchy page
- About the User Relationship Type page
- About the Profile Reference Type page
- About the Process Type Actions page

About data management

Process Manager lets you create different types of metadata that can be attached to objects.

When you click the Data sub-tab in the Admin tab, the following options appear:
<table>
<thead>
<tr>
<th>Document Type</th>
<th>Lets you define different types of documents (such as Microsoft Word .DOC files and Adobe Acrobat .PDF files) that are used in Process Manager.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Category Type</td>
<td>Lets you manage document categories by breaking your documents into different categories (not types, such as .PDF or .DOC) for better management.</td>
</tr>
<tr>
<td>User Relationship Type</td>
<td>Lets you manage the relationship between users. For example, you can set up the relationship showing that User1 is the manager of User2. You can also set up the head user for groups and organizations.</td>
</tr>
</tbody>
</table>

The Document Type option window has one pane. It displays the types of documents that are known to Process Manager.

See “Working with document types” on page 480.

The Document Category Type option window has one pane. It lets you manage document categories.

See “Working with document category types” on page 481.

The User Relationship Type option window has one pane. It lets you manage relationship types.

See “Adding a user relationship type” on page 482.

---

**Working with document types**

In Process Manager, on the **Admin** tab, you can add, edit, and delete document types.

See “About data management” on page 479.

See “Admin tab” on page 528.
To work with document types

1. In the Process Manager portal, on the Admin tab, click Data > Document Type.

2. To add a document type, in the Document Type Name section, click the Add Document Type symbol, enter the needed information, and then click Save.

   - **Name**: Name of document type. This name appears in the list of document types.
   - **Extension**: Extension of the document type.
   - **MimeType**: The MIME type that is associated with the document, if any.
   - **Compress**: Select to compress all documents of this type.

3. Click the Edit symbol next to a document type to edit its properties.

4. Click the Delete symbol next to a document type to delete it.

**Working with document category types**

In Process Manager, on the Admin tab, you can add, edit, and delete document category types.

See “About data management” on page 479.

See “Admin tab” on page 528.
To work with document category types

1. In the Process Manager portal, on the Admin tab, click Data > Document Category Type.

2. To add a document category type, in the Type Name section, click the Add Document Category Type symbol, enter the needed information, and then click Save.

   - **Name**: Name of the document category type. This name appears in the list of document category types.
   - **Description**: Description of the document category type.
   - **Add Plugin**: The plug-in that the category type uses.
   - **Plugin Use**: Select how you want the plug-in used.

3. Click the orange lightning symbol next to a document category type to manage it.

   - **Edit**: Edit the properties of this document category type.
   - **Category Type Documents**: Add a document to this category type.
   - **Delete**: Delete this document category type.

Adding a user relationship type

In Process Manager, on the Admin tab, you can set up relationship types between users.

See “About data management” on page 479.

See “Admin tab” on page 528.

To add a user relationship type

1. In the Process Manager portal, on the Admin tab, click Data > User Relationship Type.

2. To add a user relationship type, click the Add symbol.

3. Enter the relationship type name.

4. In the Relates To box, select the relationship.

5. Click Save.
About the Lists and Profiles page

The Lists and Profiles page is available in Process Manager under Admin > Data. See “Data tab” on page 533.

Profiles let you categorize data by adding customizable fields to the default profile reference types. Profiles let you sort data in Process Manager. Profiles are similar to custom data types. They are a way of classifying data for reporting and filtering.

Make a new profile when you have a process that creates or tracks the object that has the same attributes each time. This can be a computer object, a ticket object, or a Workflow task object. The profile populates with the data that is captured each time the process runs.

See “About profiles” on page 389.
See “Adding a profile definition” on page 483.
See “Viewing profiles” on page 486.
See "Editing a profile definition" on page 485.
See "Deleting a profile definition" on page 486.

Adding a profile definition

You can add a profile definition on the Lists and Profiles page in Process Manager. See “About the Lists and Profiles page” on page 483.

To add a profile definition

1 In the Process Manager portal, on the Admin tab, click Data > Lists and Profiles.
2 On the far right, click the Add Profile Definition symbol (the green plus sign).
3 If you want to create a new profile definition, click Add Profile Definition.
If you want to copy a new profile definition from an existing Process Manager database table, click **Add Profile Definition (Existing Table)**.

When you create a profile you create a table in the database. Adding a profile definition from an existing table assumes that data is already there. Usually these are created from ORM types.

In the dialog box that appears, enter the following information:

- **Reference Type**: The kind of profile that you want to create.
- **Profile Definition Name**: The name of the existing profile that you want to copy.
- **Table Name**: The name of the Process Manager table (in the database) that contains the profile that you want to copy. You do not need to include the .dbo syntax.

After you enter the correct information and click **Go**, a new property appears. The property is called **Select ID Field**. Depending on which item you select in the drop-down menu, you can choose from the various fields that are exposed.

Click **Generate** to finish.

If you do not want to copy a profile from an existing table, in the **Add Profile Definition** dialog box, enter the following information:

- **Reference Type**: The kind of profile that you want to create.
- **Name**: The name of your new profile.
- **Description**: A description of your new profile.
- **Hidden**: Sets whether your profile is enabled or disabled.

Click **Next**.
Click **Add Definition Value** to add a profile definition value.

In the **Profile Definition Values** dialog box, enter the following values:

- **Name**: The name of the profile definition value.
- **Category**: The value category that is assigned to your value. These categories appear when you edit the profile definition.
- **Description**: A description of the definition value.
- **Data type**: The data type of the definition value.
- **Is Array**: Sets whether the definition value has an array of values. If you want the definition to have only a single value, do not select this property.
- **Is Default**: Sets whether the value uses the default value.
- **Child Value**: Sets a child value for the definition value. If the profile does not have any other definition values, the drop-down list is empty.
- **Default Value**: Sets a default value for the definition value.
- **Sort Order**: Sets the order in which the definition value appears in the profile.

When you finish adding definition values, click **Finish**.

### Editing a profile definition

You can edit a profile definition on the **Lists and Profiles** page in Process Manager. See “About the Lists and Profiles page” on page 483.

**To edit a profile definition**

1. In the Process Manager portal, on the **Admin** tab, click **Data > Lists and Profiles**.
2. Click the action symbol (the orange lightning symbol) for a profile, and then click **Edit Profile Definition**.
3. Perform the changes to the options. See “Adding a profile definition” on page 483.
4. When you finish editing the profile definition, click **Finish**.
Viewing profiles

You can view a profile definition on the **Lists and Profiles** page in Process Manager.

See “About the Lists and Profiles page” on page 483.

**To view a profile**

1. In the Process Manager portal, on the **Admin** tab, click **Data > Lists and Profiles**.
2. Click a profile in the list to view it.
3. (Optional) Click the action symbol (the orange lightning symbol) for a profile, and then click **Display Definition Values**.

You can see the definitions populate only after the process runs for the first time.

Deleting a profile definition

You can delete a profile definition on the **Lists and Profiles** page in Process Manager.

See “About the Lists and Profiles page” on page 483.

**To delete a profile definition**

1. In the Process Manager portal, on the **Admin** tab, click **Data > Lists and Profiles**.
2. Click the action symbol (the orange lightning symbol) for a profile, and then click **Delete Profile Definition**.

About the Application Properties page

The **Application Properties** page is available in Process Manager under **Admin > Data**.

See “Data tab” on page 533.

Application properties are a type of profile. When you define application properties, you set up the properties that any process in the portal can then use.

See “About application properties” on page 192.

See “Adding application properties” on page 487.

See “Viewing application properties” on page 487.
Adding application properties

You can add new application properties on the **Application Properties** page in Process Manager.

See “About the Application Properties page” on page 486.

To add application properties

1. In the Process Manager portal, on the **Admin** tab, click **Data > Application Properties**.
2. On the far right side, click the **Add Profile Definition** symbol (the green plus sign).
3. In the **Add Profile Definition** page, enter the information for your application properties.

After you add application properties, you can configure them as you configure other profiles.

See “Adding a profile definition” on page 483.

Viewing application properties

You can view application properties on the **Application Properties** page in Process Manager.

See “About the Application Properties page” on page 486.

To view application properties

1. In the Process Manager portal, on the **Admin** tab, click **Data > Application Properties**.
2. Click one of the application properties in the list to view it.
3. (Optional) Click the action symbol (the orange lighting symbol) for a profile, and then click **Display Definition Values**.

About the document type page

The **Document Type** page is available in Process Manager under **Admin > Data**.

See “**Data tab**” on page 533.

Document types are the categories that you can use when you add documents in the **Documents** page.

See “**About the Documents page**” on page 440.

See “**Working with document types**” on page 480.
About the document category type page

The Document Category Type page is available in Process Manager under Admin > Data.

See “Data tab” on page 533.

Document category types let you manage document categories by breaking your documents into different categories. The categories do not represent types, such as .PDF or .DOC.

See “Working with document category types” on page 481.

About the data hierarchy page

The Data Hierarchy page is available in Process Manager under Admin > Data.

See “Data tab” on page 533.

The Data Hierarchy page lets you set up a multi-level classification system. This classification is used in Web form design in Workflow Designer to let users make a classification choice.

See “About data hierarchies” on page 488.

About data hierarchies

In Process Manager, on the Admin tab, you can work with the data hierarchy. The data hierarchy in Process Manager lets you set up a multi-level classification structure that you can use with the Ensemble Menu Select component in Workflow Designer. The Ensemble Menu Select is a Web forms component, so you can use it only in components such as the Form Builder component.

When you set up the data hierarchy, try to achieve a complete categorization system without making it too complex. Provide enough nested levels to make the organization specific, but avoid making the structure overly complex. Too many categories and classifications make it difficult to select the correct one.

See “Creating a new category in the hierarchy tree” on page 489.

See “Adding hierarchy items to a category” on page 490.

See “Deleting hierarchy items from a category” on page 490.

See “Admin tab” on page 528.
Creating a new category in the hierarchy tree

In Process Manager, on the Admin tab, you can create new categories in the hierarchy tree. By adding a category, you create a new organizational unit in which you can create hierarchy items.

See “About data hierarchies” on page 488.
See “Admin tab” on page 528.

To create a new category in the hierarchy tree

1. In the Process Manager portal, on the Admin tab, click Data > Hierarchy Data Service.
2. Under Hierarchy Tree, click the Add New Category symbol (the page with the green plus sign).
3. In the Add Category dialog box, in Hierarchy Category Name, type a name for the category.
4. (Optional) In Description, type a description for the category.
   The description appears in the Hierarchy Data Service area only.
5. In the Add Category dialog box, click the Permissions tab and add or edit permissions as needed.
6. In the Add Category dialog box, click Save.

Deleting a category from the hierarchy tree

In Process Manager, on the Admin tab, you can delete a category in the hierarchy tree. Deleting a category removes it and its hierarchy items.

Symantec recommends not deleting a category unless you know that it is no longer being used.

See “About data hierarchies” on page 488.
See “Admin tab” on page 528.

To delete a category from the hierarchy tree

1. In the Process Manager portal, on the Admin tab, click Data > Hierarchy Data Service.
2. Under Hierarchy Tree, click on the category that you want to delete.
3. In the Hierarchy section, click the Actions symbol (the orange lightning symbol), and then click Delete Category.
4. In the confirmation message, click OK.
Adding hierarchy items to a category

In Process Manager, on the Admin tab, you can add items in the data hierarchy. Hierarchy items refer to the data items that exist in a hierarchy category.

See “About data hierarchies” on page 488.
See “Admin tab” on page 528.

To add hierarchy items to a category

1. In the Process Manager portal, on the Admin tab, click Data > Hierarchy Data Service.
2. Under Hierarchy Tree, click on the category to which you want to add an item.
3. At the far right of the Hierarchy title bar, click the Actions symbol (the orange lightning symbol), and then click Add Hierarchy Items.
4. In the Add Hierarchy Items dialog box, in Add New Hierarchy Item, type one or more hierarchy items.
   To add multiple items, press the Enter key after each item.
5. When you finish adding hierarchy items, click Add Items.

Deleting hierarchy items from a category

Hierarchy items refer to the data items that exist in a hierarchy category. You can delete these items in the data hierarchy in Process Manager.

Symantec recommends that you delete hierarchy items only if you know that the item is not used.

See “About data hierarchies” on page 488.
See “Admin tab” on page 528.

To delete a hierarchy item from a category

1. In the Process Manager portal, on the Admin tab, click Data > Hierarchy Data Service.
2. Under Hierarchy Tree, click on the category from which you want to delete an item.
3. Under Hierarchy, click the Delete symbol (the red X) that appears at the far right of the item to delete.
4. In the confirmation message, click OK.
About the User Relationship Type page

The User Relationship Type page is available in Process Manager under Admin > Data.

See “Data tab” on page 533.

The User Relationship Type page lets you configure how one user relates to another user. For example, you can set up a relationship showing that User1 is the manager of User2. You can also set up the head user for groups and organizations.

See “Adding a user relationship type” on page 482.

About the Profile Reference Type page

The Profile Reference Type page is available in Process Manager under Admin > Data.

See “Data tab” on page 533.

The Profile Reference Type page lets you edit existing profile reference types and add new ones. Profile reference types refer to the highest level of classification for profiles. Process Manager has a number of default profile reference types, such as repository, schedule, article, and so on. You can select from these profile reference types when you edit or create a profile.

See “Adding a profile definition” on page 483.

Symantec recommends that you do not change profile reference types without contacting support.

See “Adding a Profile Reference Type” on page 491.

Adding a Profile Reference Type

In Process Manager, under Admin > Profile Reference Type, you can set up profile reference types.

See “About data management” on page 479.

See “Admin tab” on page 528.
To add a profile reference type

1. In the Process Manager portal, on the Admin tab, click Data > Profile Reference Type.

2. On the far right side, click the Add Reference Type symbol (the green plus sign).

3. In the dialog box that appears, enter a name for the profile reference type, and then click Save.

The new profile reference type appears in the list. You can click on the action symbol (the orange lightning symbol) and then click Edit Reference Type to see the reference ID.

About the Process Type Actions page

The Process Type Actions page is available in Process Manager under Admin > Data.

See "Data tab" on page 533.

The Process Type Actions page lets you create new process types, edit and delete existing process types, and add actions to process types. Process type actions refer to actions that appear in the process view page of certain processes. After you publish a workflow process, you can declare it as a process type, and then you can add process type actions to it. For example, if you want a process of a certain type to have a Send Email action, add this action as a process type action. This action then appears in the process view page of all running instances of the specified process type.

See “About the Process View page” on page 390.

Process types refer to classifications of processes. You can set a process type for processes in the service catalog. For example, if you have a Vacation Request process and a Hardware Request process, you can create a process type called Request. Then, you can add these two processes to the Request process type. In the Process Type Actions page, you can add actions to that process type (for example, Send Email).

See “Adding a process type” on page 493.

See “Editing a process type” on page 493.

See “Deleting a process type” on page 493.

See “Adding an action to a process type” on page 494.
Adding a process type

In Process Manager, under Admin > Process Type Actions, you can set up process types and process actions.

See “About the Process Type Actions page” on page 492.

To add a process type

1. In the Process Manager portal, on the Admin tab, click Data > Process Type Actions.
2. On the far right side, click the Add Process Type symbol (the green plus sign).
3. In the dialog box that appears, enter a name for the profile reference type and a service ID, and then click Save.

The service ID should be a project's GUID. You can view a project's GUID in the project's metadata.

See “Viewing the project metadata” on page 158.

After you add it, the new process type appears in the list.

Editing a process type

In Process Manager, under Admin > Process Type Actions, you can edit process types and process actions.

See “About the Process Type Actions page” on page 492.

To edit a process type

1. In the Process Manager portal, on the Admin tab, click Data > Process Type Actions.
2. Click the action symbol (the orange lightning symbol) for the process type that you want to edit.
3. Click Edit Process Type.
4. In the dialog box that appears, enter a name for the profile reference type and a service ID, and then click Save.

The service ID should be a project's GUID. You can view a project's GUID in the project's metadata.

See “Viewing the project metadata” on page 158.

Deleting a process type

In Process Manager, under Admin > Process Type Actions, you can delete process types and process actions.
To delete a process type
1. In the Process Manager portal, on the Admin tab, click Data > Process Type Actions.
2. Click the action symbol (the orange lightning symbol) for the process type that you want to delete.
3. Click Delete Process Type.
4. In the dialog box that appears, click OK.

Adding an action to a process type

In Process Manager, under Admin > Process Type Actions, you can add process type actions to process types.

To add a process type action to a process type
1. In the Process Manager portal, on the Admin tab, click Data > Process Type Actions.
2. For the process type to which you want to add an action, click the action symbol (the orange lightning symbol).
Click **Add Action**.

In the dialog box that appears, enter the following information about the action:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Action Name</strong></td>
<td>A name for the process type action. You can use any name.</td>
</tr>
<tr>
<td><strong>Action URL</strong></td>
<td>A URL to the process type action. If your process type action is a published workflow project, set this value to the URL of the process as it appears in IIS.</td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td>The height of the action's window (in pixels).</td>
</tr>
<tr>
<td><strong>Width</strong></td>
<td>The width of the action's window (in pixels).</td>
</tr>
<tr>
<td><strong>Is Contact Action</strong></td>
<td>Sets whether the action is a contact action. If you select this property, the action appears in the process view page of any user who is classified as a contact for the process.</td>
</tr>
<tr>
<td><strong>Is View Action</strong></td>
<td>Sets whether the action is a view action. If you select this property, the action appears in the process view page of any user who is qualified to view the process.</td>
</tr>
<tr>
<td><strong>Is Edit Action</strong></td>
<td>Sets whether the action is an edit action. If you select this property, the action appears in the process view page of any user who is qualified to edit the process.</td>
</tr>
<tr>
<td><strong>Is Admin Action</strong></td>
<td>Sets whether the action is an Admin action. If you select this property, the action appears in the process view page of any user who is classified as an Admin for the process.</td>
</tr>
<tr>
<td><strong>Only Valid when process is active</strong></td>
<td>Sets whether the action is still available in the process view page only before it is complete. This property uses a process's percent complete status to make this decision.</td>
</tr>
</tbody>
</table>

### Adding a Timeline to a process type

In Process Manager, under **Admin > Data > Process Type Actions**, you can add a timeline to a process type.

Timelines are the graphical status markers that appear in a process view page. Each individual timeline that you add is a separate graphical step.

See “About the Process Type Actions page” on page 492.
To add a Timeline to a process type

1. In the Process Manager portal, on the **Admin** tab, click **Data > Process Type Actions**.

2. For the process type to which you want to add a Timeline, click the action symbol (the orange lightning symbol).

3. Click **Add TimeLine**.

4. In the dialog box that appears, enter the following information about the action:

   **Timeline Name**
   A title for the timeline. You can set any name.

   **From Percent**
   The percentage complete value at which this timeline is activated.

   **To Percent**
   The percentage complete value at which this timeline ends.

   **Current Color**
   The color of the timeline step when it is activated.

   **Noncurrent Color**
   The color of the timeline step when it is deactivated.
Managing the service catalog in Process Manager

This chapter includes the following topics:

- About the service catalog
- Working with service catalog categories
- Adding a Web form to the service catalog
- Adding a Web service to the service catalog
- Web form settings
- Web service settings

About the service catalog

The Service Catalog Settings page lists all of the Workflow processes that are available to users in Process Manager. This page is located in Admin > Service Catalog Settings. All of the processes that appear in the service catalog were created in Workflow Designer and were published to Process Manager.

See “Creating a new Project in Workflow Manager” on page 134.

You can also set permissions on the processes in the service catalog. The settings permissions for processes determine which users or groups can access the processes.

The service catalog sub-tab window is divided into two panes. The left pane lets you select the view and category of the processes that you want displayed in the right pane. The right pane displays the processes that are running.

See “Working with service catalog categories” on page 498.
See “Adding a Web form to the service catalog” on page 499.
See “Adding a Web service to the service catalog” on page 500.

Working with service catalog categories

The categories that are in the service catalog in Process Manager are organizational containers for your workflow processes. You can work with service catalog categories in Admin > Service Catalog Settings. On the Service Catalog Settings page, categories are displayed in the left pane.

See “About the service catalog” on page 497.

To add a new category
1. In the Process Manager portal, on the Admin tab, click Service Catalog Settings.
2. In the left pane, click Add New Category.
3. Enter a name and description for this category.
4. Click the Permissions tab and click Add Permission to add permissions for accessing this category.
5. Click Save.

To add a new sub-category
1. In the Process Manager portal, on the Admin tab, click Service Catalog Settings.
2. In the left pane, under the Browse Category section, select the category to which you want to add a sub-category.
3. In the right pane, click the orange lightning symbol and select Add Sub Category.
4. Enter a name and description for this sub-category.
5. Click the Permissions tab and click Add Permission to add permissions for accessing this sub-category.
6. Click Save.

To edit a category
1. In the Process Manager portal, on the Admin tab, click Service Catalog Settings.
2. In the left pane, under the Browse Category section, select the category that you want to edit.
3. In the right pane, click the orange lightning symbol and select Edit Category.
4  Edit the name and description that you want.
5  Click the Permissions tab and click Add Permission to add permissions for accessing this category.
6  Click Save.

To delete a category
1  In the Process Manager portal, on the Admin tab, click Service Catalog Settings.
2  In the left pane, under the Browse Category section, select the category that you want to delete.
3  In the right pane, click the orange lightning symbol and select Delete Category.
4  Click OK.

Adding a Web form to the service catalog

You can add Web forms to the service catalog in the Service Catalog Settings page in Process Manager. This page is located in Admin > Service Catalog Settings.

Typically, you add a Web form to the service catalog by publishing a Web-forms type project to Process Manager. However, you can also add Web forms directly without publishing a project.

See "Publishing a project" on page 197.
See "About the service catalog" on page 497.

To add a Web form to the service catalog directly in Process Manager
1  In the Process Manager portal, on the Admin tab, click Service Catalog Settings.
2  In the left pane, under the Browse Category section, select the category to which you want to add a Web form.
3  In the right pane, click the orange lightning symbol and click Add Web Form.
4  Edit the fields that you want.
   See "Web form settings" on page 500.
   Mandatory fields have the * symbol by them.
5  (Optional) Set the service catalog item to use a Server Group for failover.
   See "Directory Servers Groups page" on page 652.
6  Click Save.
Adding a Web service to the service catalog

You can add Web services to the service catalog in the Service Catalog Settings page in Process Manager. This page is located in Admin > Service Catalog Settings.

Typically, you add a Web service to the service catalog by publishing a workflow project to Process Manager. However, you can also add Web services directly without publishing a project.

See “Publishing a project” on page 197.
See “About the service catalog” on page 497.

To add a Web service

1. In the Process Manager portal, on the Admin tab, click Service Catalog Settings.
2. In the left pane, under the Browse Category section, select the category to which you want to add a Web service.
3. In the right pane, click the orange lightning symbol and select Add Web Service.
4. Edit the fields that you want.
   See “Web service settings” on page 502.
   Mandatory fields have the * symbol by them.
5. (Optional) Set the service catalog item to use a Server Group for failover.
   See “Directory Servers Groups page” on page 652.
6. Click Save.

Web form settings

You use Web form settings when you add a Web form to the Process Manager service catalog.

See “Adding a Web form to the service catalog” on page 499.

<table>
<thead>
<tr>
<th>Table 23-1 Web form settings options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
</tr>
<tr>
<td>Form Information</td>
</tr>
<tr>
<td>Form Information</td>
</tr>
<tr>
<td>Tab</td>
</tr>
<tr>
<td>---------------------</td>
</tr>
<tr>
<td>Form Information</td>
</tr>
<tr>
<td>Form Information</td>
</tr>
<tr>
<td>Form Information</td>
</tr>
<tr>
<td>Form Information</td>
</tr>
<tr>
<td>Form Information</td>
</tr>
<tr>
<td>Form Information</td>
</tr>
<tr>
<td>Form Information</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Form Information</td>
</tr>
<tr>
<td>Web part Information</td>
</tr>
<tr>
<td>Web part Information</td>
</tr>
</tbody>
</table>
### Table 23-1 Web form settings options (continued)

<table>
<thead>
<tr>
<th>Tab</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web part Information</td>
<td>Width</td>
<td>The width of the Web part window.</td>
</tr>
<tr>
<td>User Information</td>
<td>Pass User ID</td>
<td>If this option is checked, the User ID (in the <strong>UserID Parameter Name</strong> option) is passed to the Web form.</td>
</tr>
<tr>
<td>User Information</td>
<td>User ID Parameter Name</td>
<td>The User ID to be passed to the Web form.</td>
</tr>
<tr>
<td>Session Information</td>
<td>Pass Session ID</td>
<td>If this option is checked, the Session ID (in the <strong>SessionID Parameter Name</strong> option) is passed to the Web form.</td>
</tr>
<tr>
<td>Session Information</td>
<td>Session ID Parameter Name</td>
<td>The Session ID to be passed to the Web form.</td>
</tr>
<tr>
<td>Permissions</td>
<td>Add Permission</td>
<td>Adds the permissions for accessing this Web form.</td>
</tr>
<tr>
<td>Profiles</td>
<td>Default Form ProfileDefinition</td>
<td>If this option is checked, the default form is used for the profile definition.</td>
</tr>
</tbody>
</table>

### Web service settings

You use Web service settings when you add a Web service to the Process Manager service catalog.

See “Adding a Web service to the service catalog” on page 500.

### Table 23-2 Web service settings options

<table>
<thead>
<tr>
<th>Tab</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main Information</td>
<td>Name</td>
<td>The name of the Web service.</td>
</tr>
<tr>
<td>Main Information</td>
<td>Description</td>
<td>The description of the Web service.</td>
</tr>
<tr>
<td>Main Information</td>
<td>Default URL</td>
<td>The default URL for the Web service.</td>
</tr>
<tr>
<td>Tab</td>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Main Information</td>
<td>Directory service type</td>
<td>The directory service type for the Web service.</td>
</tr>
<tr>
<td>Main Information</td>
<td>Server Group</td>
<td>The group of servers for failover support. When first server in a group is unreachable the user is redirected to the next server in the group. See “Adding server groups” on page 655.</td>
</tr>
<tr>
<td>Main Information</td>
<td>Workflow Type</td>
<td>Workflow type can be set in one of the following ways:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Standard. Web service shows up in Service Catalog.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Process action. Web service does not show up in Service Catalog. This type can be added to the actions Web part in the Process View page.</td>
</tr>
<tr>
<td>Permissions</td>
<td>Add Permission</td>
<td>Adds the permissions for accessing this Web form.</td>
</tr>
<tr>
<td>Profiles</td>
<td>Default Form ProfileDefinition</td>
<td>If this option is checked, the default form is used for the profile definition.</td>
</tr>
</tbody>
</table>
Managing accounts in Process Manager

This chapter includes the following topics:

- About using Active Directory with Process Manager
- About adding Active Directory groups to Process Manager
- About the default user groups and permissions
- Setting up groups, permissions, and users for the first time
- About permissions in Process Manager
- Creating groups
- Add Group dialog box
- Modifying groups
- Deleting groups
- Adding users to groups
- Adding or removing permissions for groups
- Viewing the list of permissions
- Viewing the permissions for a group
- Creating organizational units
- Creating a new user
- Clone User tab
About using Active Directory with Process Manager

Process Manager can use Active Directory users and groups. You can save time by using Active Directory users and groups instead of recreating them in Process Manager. By setting up Process Manager to integrate with Active Directory, you let Process Manager users use their Active Directory credentials for authentication.

When you install Process Manager, you select the authentication method that Process Manager uses. If you select Active Directory authentication, you can choose to use existing users and groups in Active Directory. These users and groups are created in Process Manager and then mapped to the existing users and groups in Active Directory. Mapped users and groups retain their permissions settings from Active Directory.

See “About integrating Process Manager with Active Directory information” on page 597.
The Process Manager users and groups are stored in the Process Manager database. When you use Active Directory authentication, the Active Directory users and groups are added to the Process Manager database.

The Active Directory users and groups can be added to Process Manager in the following ways:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>During synchronization</td>
<td>Periodically, Process Manager synchronizes with Active Directory to obtain new and updated users and groups from Active Directory. During synchronization, the user data and the group data from Active Directory overwrite the user data and the group data that is in Process Manager. By default, Process Manager synchronizes with Active Directory at midnight every night. You can change the synchronization schedule in Workflow Designer. See “Methods for synchronizing Active Directory sync profiles” on page 125.</td>
</tr>
<tr>
<td>Manually</td>
<td>If a new user needs to access Process Manager between synchronizations, you can add the user manually from Active Directory. See “Manually adding new Process Manager users from Active Directory” on page 518.</td>
</tr>
<tr>
<td>Automatically when a user</td>
<td>Users who are in Active Directory but have not yet been added to Process Manager can still access Process Manager. When this user tries to log on to the Process Manager portal, Process Manager checks the credentials against the Process Manager database. If the credentials are not there, Process Manager checks the credentials against Active Directory and adds the user to Process Manager. This method is available only if the option Auto Create Users on Initial Login was selected during the Process Manager installation.</td>
</tr>
<tr>
<td>logs on</td>
<td></td>
</tr>
</tbody>
</table>

The synchronization between Process Manager and Active Directory affects changes and deletions as follows:

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleting a user from within Process Manager</td>
<td>When you delete a user from Process Manager but not from Active Directory, the user is not fully deleted. The users that remain in Active Directory are created again in Process Manager during the next synchronization. To block Process Manager access to an Active Directory user, you must delete the user from Active Directory.</td>
</tr>
</tbody>
</table>
Deleting a user from Active Directory
When you delete a user from Active Directory, the user is disabled but not deleted in Process Manager. To fully delete the user and all of the associated information from Process Manager, you must manually delete the user from Process Manager.

Editing a user in Process Manager
Any changes that you make to a user in Process Manager are overwritten during the next synchronization. Instead, you can edit user information in Active Directory, and the information is updated in Process Manager during the next synchronization. This rule applies to the user’s group, manager, and organizational unit information.

About adding Active Directory groups to Process Manager

When Active Directory authentication is selected during the Process Manager installation, the users and the user groups from Active Directory are imported.

See “About using Active Directory with Process Manager” on page 505.

During the configuration segment of the Process Manager installation, your Active Directory groups can be mapped to the default Process Manager groups. This option lets the Active Directory groups take the permissions of the default Process Manager groups. By mapping the groups, you can benefit from the predefined permissions in the default Process Manager groups and use your organization’s preferred group names.

During the Process Manager installation, the Active Directory groups are added to Process Manager as follows:

- Process Manager imports all of the groups in Active Directory and stores them in the Process Manager database.
  When the Active Directory users are imported to Process Manager, they retain their group associations from Active Directory.

- The Active Directory groups that are mapped to Process Manager groups take the permissions of the groups to which they are mapped.

- Any Active Directory groups that are not mapped to Process Manager groups are added without permissions. You must assign permissions to those groups after the installation.
About the default user groups and permissions

Process Manager comes with the default user groups and permissions that are defined. You can modify the default user groups and permissions, create new groups and permissions, and import groups from Active Directory.

See “Setting up groups, permissions, and users for the first time” on page 508.

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
<th>Tabs accessible</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrators</td>
<td>Contains the users who administer Process Manager.</td>
<td>• Documents</td>
<td>The Administrators group is generally granted all of the permissions that are available.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Knowledge Base</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Workflow</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Admin</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Submit Request</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reports</td>
<td></td>
</tr>
<tr>
<td>All Users</td>
<td>Contains all Process Manager users with valid accounts.</td>
<td>• Submit Request</td>
<td>Users have individually assigned permissions based upon their group membership (users can belong to more than one group).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Knowledge Base</td>
<td></td>
</tr>
<tr>
<td>Application Users</td>
<td>Contains only Process Manager users.</td>
<td>• Submit Request</td>
<td>Users have individually assigned permissions. By default they have very limited access to Process Manager.</td>
</tr>
</tbody>
</table>

Setting up groups, permissions, and users for the first time

When you first use Process Manager, you need to set up groups, permissions, and users. Symantec recommends that you observe the following steps when you set up groups, permissions, and users.
Table 24-2  Process for setting up groups, permissions, and users

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 1 | Set up groups. | You can set up groups in the following ways:  
  ■ Import groups from Active Directory.  
    See “About using Active Directory with Process Manager” on page 505.  
  ■ Create groups manually in the Process Manager portal.  
    See “Creating groups” on page 511. |
| Step 2 | (Optional) Set up organizational units. | If you want to use organizational groups (which are large groups of users or groups), you can do so in Process Manager.  
  See “Creating organizational units” on page 515. |
| Step 3 | Add permissions to each group. | When you add permissions to a group, you define the level of access that the group has to the Process Manager portal.  
  See “Adding or removing permissions for groups” on page 514. |
| Step 4 | Create users. | You can add users to Process Manager in the following ways:  
  ■ Import users from Active Directory.  
    See “About using Active Directory with Process Manager” on page 505.  
  ■ Add users manually from Active Directory.  
    See “Manually adding new Process Manager users from Active Directory” on page 518.  
  ■ Create users manually in the Process Manager portal.  
    See “Creating a new user” on page 516. |
| Step 5 | Add the users to groups. | After you create users and groups, you can add users to the groups.  
  See “Adding users to groups” on page 513. |

About permissions in Process Manager

Permissions determine the access that a user has to Process Manager. Permissions determine what users can view in the Process Manager portal and what functions
they can perform. You can set permissions on two levels: users and groups. As a general rule, permissions are applied to groups in Process Manager.

When you apply permissions at the group level, the permission settings apply to each user that is a member of the group. When you use groups to apply permissions, you do not have to edit the permission settings for each group member. You can make the change at the group level and it is updated for every user that is a member of that group. By using groups, you greatly simplify user management and permission management.

Process Manager manages security by using Active Directory to obtain user authentication and authority information. When the user logs on, an Active Directory page grants them a session token. If this effort fails, the user is directed to another logon page that grants them a session token. This session token is the only item that is passed back and forth between the Web Service layer and the Process Manager user interface.

Within Process Manager, security is controlled as follows:

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>Any user of the portal that can log on. Users can also belong to groups and organizational units, and have permissions assigned to them.</td>
</tr>
<tr>
<td>Group</td>
<td>Collections of users. Users can be members of multiple groups. Groups are used to assign permissions more efficiently. Instead of assigning permissions to each user individually, you can specify the permissions for a group. The permissions for a group are then valid for each user that is a member of that group. Permissions are almost always granted at the group level in Process Manager, rather than at the user level.</td>
</tr>
<tr>
<td>Organizational unit</td>
<td>Collections of users or groups. An organizational unit is generally a very large group. For example, an organizational unit may be a department, office, or division of a company.</td>
</tr>
<tr>
<td>Permission</td>
<td>Permissions control the access to and use of the Process Manager portal. What users can view, and what actions they can perform, are based on permissions. For example, permissions may grant access to certain functions within Process Manager, such as the ability to create users. Permissions may also grant or deny access to view and edit articles in the knowledge base. Permissions control access to every function in Process Manager.</td>
</tr>
</tbody>
</table>

Managing permissions for users, groups, and organizational units can provide a high level of security within Process Manager. Permissions are hierarchical. The permission that is applied at the most specific level takes precedence. For example, a group is denied access to view a knowledge base article. However, a specific
user within that group has permission to view the article. In this case, the user’s specific permission overrides the group setting, and the user is able to view the article.

You can manage security at the page level within Process Manager. For any page, you can manage access to that page at the user, group, or organizational unit level.

See “Managing permissions” on page 525.
See “Adding or removing permissions for groups” on page 514.

Creating groups

Groups are collections of Process Manager users. Groups assist in the security and administration of Process Manager by controlling the permissions that are granted to individual Process Manager users. When you assign permissions for a group, each user that is a member of that group is granted those permissions. Assigning permissions at the group level lets you control the permissions that are granted to many users. You do not have to modify the permissions for each group member individually. The permission for creating groups is AccountManagement.Group.Create.

When Active Directory authentication is selected during the Process Manager installation, the user groups from Active Directory are imported along with the users.

See “About adding Active Directory groups to Process Manager” on page 507.

You can copy permissions from another group and assign them to the new group. If you do not copy the permissions from another group, you must assign the permissions to the new group individually.

See “Adding or removing permissions for groups” on page 514.

To create a group

1. In the Process Manager portal, on the Admin tab, click Users > Accounts > List Groups.
2. In the upper right of the Browse Groups section, click the Add Groups symbol (the green plus sign).
3. In the Add Group dialog box, configure the new group
   Name the new group, copy permissions from another group (optional), and specify the group’s home page and email address.
   See “Add Group dialog box” on page 512.
4. Click Save.
Add Group dialog box

This dialog box lets you add a group to the Process Manager portal. You see the Add Group dialog box when you click Admin > Users > Accounts > List Groups, and then click the Add Group symbol.

See “Creating groups” on page 511.

### Table 24-3 Options in the Add Group dialog box

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>GroupName</strong></td>
<td>The name of the new group. You can use special characters but you cannot enter a name that is already assigned to another group.</td>
</tr>
<tr>
<td><strong>Copy Permissions From Group</strong></td>
<td>Lets you use another group’s permissions for this group. You can type the name of the other group or click Pick to select a group from the Group Picker dialog box. All of the permissions from the group that you specify are replicated for the new group. If you do not copy the permissions from another group, you must assign the permissions to the new group in a separate task. See “Adding or removing permissions for groups” on page 514.</td>
</tr>
<tr>
<td><strong>Home page</strong></td>
<td>Lets you specify the name of the portal page that should appear when users in this group log on to the Process Manager portal.</td>
</tr>
<tr>
<td><strong>Email Address</strong></td>
<td>Lets you specify an email address that represents the group. You can use this email address to give users a support contact.</td>
</tr>
</tbody>
</table>

Modifying groups

Administrators and users with the AccountManagement.Group.Modify permission can modify existing groups in Process Manager.

**To modify groups**

1. In the Process Manager portal, on the Admin tab, click Users > Accounts > List Groups.
2. Select the group that you want to modify from the Browse Groups list.
3. Click the Actions symbol (the orange lighting symbol), and then click Edit.
4 In the **Edit Group** dialog, make the necessary changes to the group.

See “Add Group dialog box” on page 512.

5 Click **Save**.

---

### Deleting groups

Administrators and users with the appropriate permissions can delete groups from Process Manager. Deleting a group does not delete any users. Users that belong to a group are not deleted when the group is deleted.

See “About the default user groups and permissions” on page 508.

See “Creating groups” on page 511.

See “Add Group dialog box” on page 512.

See “Modifying groups” on page 512.

**To delete groups**

1 In the Process Manager portal, on the **Admin** tab, click **Users > Accounts > List Groups**.

2 Select the group that you want to delete from the **Browse Groups** list.

3 Click the **Actions** symbol (the orange lighting symbol), and then click **Delete**.

4 Click **OK** to confirm.

---

### Adding users to groups

Groups are collections of Process Manager users. When you add users to a group, each of the users inherit the permissions that are defined for that group. The permissions at the user level can differ from permissions at the group level. Permissions that are set at the user level override the group-level settings.

See “About the default user groups and permissions” on page 508.

See “Managing a user’s groups” on page 522.

**To add users to a group**

1 In the Process Manager portal, on the **Admin** tab, click **Users > Accounts > List Groups**.

2 In the right pane, click the **Actions** symbol for the group to which you want to add a user, and then click **Add User**.

3 In the **Add User** dialog box, in the **Add user to group** property, type the user’s email address or click **Pick** to search for a user.
4 (Optional) In the Add User dialog box, in Relationship Type, select the type of relationship.

5 Click Add to add the user to the list at the top of the Add User dialog box.

6 (Optional) Add more users.

7 When you finish adding users, click Close.

Adding or removing permissions for groups

In Process Manager, a group’s permissions determine the permissions that are granted to individual Process Manager users. When you assign permissions for a group, each user that is a member of that group is granted those permissions.

See “About the default user groups and permissions” on page 508.

Administrators and users with the appropriate permission can add or remove the permissions that are associated with a group.

To add or remove permissions from a group

1 In the Process Manager portal, on the Admin tab, click Users > Accounts > List Groups.

2 Under Browse Groups, select the group for which you want to modify permissions.

3 Click the Actions symbol (the orange lightning symbol), and then click Permissions.

4 In the Permissions For Group dialog box, select the permissions to assign to this group. Clear the check box for the permissions that you want to remove from this group. Click Select All or Unselect All to add all available permissions to a group, or remove all permissions from a group, respectively.

5 Click Save.

Viewing the list of permissions

Administrators and users with the appropriate permissions can view the permissions.

See “About the default user groups and permissions” on page 508.
To view the list of permissions
1 In the Process Manager portal, on the Admin tab, click Users > Accounts > List Permissions.
2 Under Browse Permissions, select the category of permissions to view.
3 When you finish viewing the permissions, you can go to another page.

Viewing the permissions for a group

In Process Manager, group permissions determine the permissions that are granted to individual Process Manager users. When you assign permissions to a group, each user that is a member of that group is granted those permissions.

See “About the default user groups and permissions” on page 508.

Administrators and users with the appropriate permissions can view the permissions that are associated with a specific group.

To view the permissions for a group
1 In the Process Manager portal, on the Admin tab, click Users > Accounts > List Groups.
2 Under Browse Groups, select the group to view.
3 Click the Actions symbol (the orange lightning symbol), and then click Permissions.
4 When you finish viewing the permissions in the Permissions For Group dialog box, click Cancel.

Creating organizational units

Organizational units are large groups of users or groups. For example, an organizational unit can be a department within an organization.

See “Managing organizations” on page 526.

To create organizational units
1 In the Process Manager portal, on the Admin tab, click Users > Accounts > List Organizations.
2 In the Browse Organizations list, click Add Root Organization.
3. In the **Add Organization** dialog box, in **Organization Name**, enter a name for the organization.

   The name field allows special characters, has a limit of 256 characters, and does not allow duplicate names.

4. (Optional) In **Description**, enter a description of the organization.

5. Click **Save**.

### Creating a new user

Administrators and users with the appropriate permissions can create new Process Manager users.

**To create a new user**

1. In the Process Manager portal, on the **Admin** tab, click **Users**.

2. In the right pane, click the **Add User** icon.

3. In the **Add User** dialog box, on the **Main Information** tab, enter all of the required information for the user. All required fields are marked with a red asterisk.

4. (Optional) Add additional user information on the following tabs:

   - **Clone User**: Lets you clone groups, permissions, or organizations for this user from an existing user.  
     See “Clone User tab” on page 517.
   - **Process Manager Settings**: Options for setting the theme, home page, and time zone.
   - **Email Settings**: Lets you add additional email addresses for the user.
   - **Phone Numbers**: Lets you add phone numbers and other phone details for the user.
   - **Messengers ID**: Lets you add multiple instant messenger IDs for the user, and designate one messenger ID as the primary contact.
   - **Profiles**: Lets you add profile information for the user.

5. Click **Save**.

   The new user is added to the **All Users** list.
If you have not cloned the group settings for the new user, you need to specify the groups to which this user belongs. Locate the new user you added, click the Actions symbol, and then click Manage Groups.

In the Manage User Groups dialog box, select a group that you want to add this user to and click Add.

Select the Relationship type for the user. User relationship types let you define the types of relationships that users can have to other users and to groups.

Add any additional groups that you want to give this user access to and click Close.

If you have not cloned the permissions settings for the new user, you need to specify which permissions are assigned to this user. Locate the user you added, click the Actions symbol, and then click Manage Permissions.

In the Manage User Permissions dialog box, expand the permissions categories that contain the permissions that you want to assign to this user.

Select the check box next to the permissions to assign to this user and click Save.

**Clone User tab**

The Clone User tab is one of the tabs in the Add User dialog box.

See “Creating a new user” on page 516.

<table>
<thead>
<tr>
<th>Table 24-4</th>
<th>Options on the Clone User tab</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>User</td>
<td>Lets you specify the user to clone. You can type the user’s name or click Pick and use the User Picker dialog box to search for a user.</td>
</tr>
<tr>
<td>Clone User’s Groups</td>
<td>Clones the group settings of this user for the new user.</td>
</tr>
<tr>
<td>Clone User’s Permissions</td>
<td>Clones the permissions settings of this user for the new user.</td>
</tr>
<tr>
<td>Clone User’s Organization Units</td>
<td>Clones the organization unit settings of this user for the new user.</td>
</tr>
</tbody>
</table>

**Process Manager Settings tab**

This tab is one of the tabs in the Add User dialog box in Process Manager.
See “Creating a new user” on page 516.

Table 24-5  Options on the Process Manager Settings tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Secondary Menu</td>
<td>Causes a drop-down menu to appear when the user hovers the cursor over any section symbol at the top of the page.</td>
</tr>
<tr>
<td>Home Page</td>
<td>Sets the default Process Manager page for the user.</td>
</tr>
<tr>
<td>Select Time Zone</td>
<td>Sets whether this user sees the Process Manager server time in the portal (such as in a task) instead of the local time zone. If you do not select this property, the user sees the time that is updated to the local time zone.</td>
</tr>
<tr>
<td>Select Time Zone</td>
<td>Sets which time zone the user sees in Process Manager.</td>
</tr>
<tr>
<td>Language</td>
<td>Sets the user’s language. Language packs must be added before languages are available.</td>
</tr>
</tbody>
</table>

Manually adding new Process Manager users from Active Directory

Process Manager is able to use the Active Directory information to authenticate the users. To avoid creating additional user accounts, you can add users from Active Directory.

Note that you can also create users locally in the Process Manager database. When a user logs on, Process Manager checks the Active Directory information to authenticate the user. If the user is not found, Process Manager also checks the same user name in its own database.

See “About using Active Directory with Process Manager” on page 505.

See “About adding Active Directory groups to Process Manager” on page 507.

To manually add a user from Active Directory

1. In the Process Manager portal, on the Admin tab, click Users > AD Users.
2. In the Select Directory Server list, select the server that you want to add a user from.

Note: Servers only appear after they have been added.

See “Adding Active Directory server connections” on page 108.
3 In the **Name** text box, either enter a specific name or click **Search users**.
4 Select the user that you want to add.
5 Click **Add Users**.

### Modifying data for existing users

Administrator users can modify the data for existing Process Manager users. Any of the information that you can set for a user during user creation can be modified from the Manage User dialog.

**To modify data for existing users**

1 In the Process Manager portal, on the **Admin** tab, click **Users**.
2 For the user that you want to modify, click the **Actions** symbol, and then click **Manage User**.
3 In the **Manage User** dialog box, modify the account information for the user as needed.
   
   See “Creating a new user” on page 516.
4 Click **Save**.

### Enabling or disabling a user

You cannot delete a user in Process Manager, but you can disable a user.

By default a user is enabled. This means that the user account is functional. If you no longer need a user account or you want to disable it for any reason, you can disable the account. If a user's account has been disabled, the user cannot save any data or navigate away from the current page in Process Manager. If a user is logged on to Process Manager when you disable the account, the user still has access to the current page.

See “Editing your user account” on page 520.

**To enable or disable a user**

1 In the Process Manager portal, on the **Admin** tab, click **Users > Accounts > Manage Users**.
2 On the right side, click the **User Actions** option, and then click **Enable/Disable**.
3 Enable or disable the user.
Viewing your Process Manager group memberships

You can view your own group membership when you are logged on to Process Manager. Group membership refers to the groups to which your account belongs.

See “Adding users to groups” on page 513.

To view your Process Manager group memberships

1. In the Process Manager portal, in the upper right, click Account.
2. Expand the User Information section.
   - The groups to which you belong are listed to the right of Group.
3. When you finish, you can go to another page.

Editing your user account

In Process Manager, you can add or modify your user account information.

See “Changing your password” on page 520.

See “Managing users” on page 521.

To edit your user account

1. In the Process Manager portal, in the upper right, click Account.
2. At the right of the User Information section, click the Actions symbol (orange lightning), and then click Edit User Information.
3. In the Edit User Information dialog box, edit your information.
4. Click Save.

Changing your password

Your user name and initial password are assigned during the setup of the Process Manager portal. Symantec recommends that you change your password after you log on to the Process Manager portal for the first time.

See “Editing your user account” on page 520.

See “Managing users” on page 521.

To change your password

1. In the Process Manager portal, in the upper right, click Account.
2. At the right of the User Information section, click the Actions symbol (orange lightning), and then click Change Password.
3 In the Change Password dialog box, enter your current password and your new password, and then confirm the new password.

4 Click Change Password.

Sending an email to a Process Manager user

You can send an email to another user of Process Manager.

See “Managing users” on page 521.

To send an email to a user

1 In the Process Manager portal, on the Admin tab, click Users > Accounts > Manage Users.

2 In the left pane, select All Users or browse the Permissions and Groups to find the user to whom to send the email.

3 In the right pane, next to the user to whom you want to send the email, click the Email User symbol.

4 Enter the email information and click Send.

Managing users

After a user is added to Process Manager, you can make changes to the user’s information.

See “Creating a new user” on page 516.

See “Managing a user’s groups” on page 522.

See “Managing a user’s permissions” on page 522.

See “Managing a user’s organizations” on page 523.

To manage a user

1 In the Process Manager portal, on the Admin tab, click Users > Accounts > Manage Users.

2 In the left pane, select All Users or browse the Permissions and Groups to find the user that you want to manage.

3 In the right pane, next to the user that you want to manage, click the orange lightning symbol and select Manage User.

4 Enter or change the information that you want.

5 Click Save.
Managing a user’s groups

Users can belong to groups. Groups are assigned permissions and all users in a group have the permissions assigned to that group.

See “About the default user groups and permissions” on page 508.

To manage a user’s groups

1. In the Process Manager portal, on the Admin tab, click Users > Accounts > Manage Users.

2. In the left pane, select All Users or browse the Permissions and Groups to find the user whose groups you want to manage.

3. In the right pane, next to the user whose groups you want to manage, click the orange lightning symbol and select Manage Groups.
   
The groups to which this user is assigned appear in the Groups section.

4. To delete a group to which the user is assigned, click the Remove symbol next to the group that you want to delete.

5. (Optional) Click Relationship Type to select the relationship type for this group. This option lets you establish relationships between groups.
   
   Relationship types only appear after they have been added.

   See “Adding a user relationship type” on page 482.

6. To add a group to which the user is assigned, in the Select Group To Add box, select the group and click Add.

7. Click Close.

Managing a user’s permissions

After a user is added, you can manage their permissions.

See “About permissions in Process Manager” on page 509.

To manage a user’s permissions

1. In the Process Manager portal, on the Admin tab, click Users > Accounts > Manage Users.

2. In the left pane, select All Users or browse the Permissions and Groups to find the user whose permissions you want to manage.

3. In the right pane, next to the user whose permissions you want to manage, click the orange lightning symbol and select Manage Permissions.
Managing a user’s organizations

Users and groups can belong to organizations. Organizations are assigned permissions and all users and groups in an organization have the permissions assigned to that organization.

See “Setting up groups, permissions, and users for the first time” on page 508.

To manage a user’s organizations

1. In the Process Manager portal, on the Admin tab, click Users > Accounts > Manage Users.

2. In the left pane, select All Users or browse the Permissions and Groups to find the user whose organizations you want to manage.

3. In the right pane, next to the user whose organizations you want to manage, click the orange lightning symbol and select Manage Organizations.

   The organizations to which this user is assigned appear in the Organizational units section.

4. (Optional) Click Relationship Type to select the relationship type for this organization. This option lets you establish relationships between organizations.

   Relationship types only appear after they have been added.

   See “Adding a user relationship type” on page 482.

5. Select Is PrimaryOrganization if this organizational unit is the primary one for this user.

6. In the Select organization to add box, select the organization that you want to assign to this user and click Add.

7. Click Close.

Setting up user's relationships

To set up user's relationships

1. In the Process Manager portal, on the Admin tab, click Users > Accounts > Manage Users.

2. In the left pane, select All Users or browse the Permissions and Groups to find the user whose user relationships you want to manage.
3 In the right pane, next to the user whose user relationships you want to manage, click the orange lightning symbol and select User Relationship.

4 Click Relationship Type to select the relationship type between the users. Relationship types only appear after they have been added. See “Adding a user relationship type” on page 482.

5 In the Pick User To Relates box, enter a user name or click pick to search for the user. Select the user to which to add the relationship and click Add.

6 (Optional) In the Reverse Relationship Type box, select the reverse relationship type. This option lets you establish a two-way relationship. Relationship types only appear after they have been added. See “Adding a user relationship type” on page 482.

7 Click Close.

Setting key value pairs for users

After users are added to Process Manager, multiple actions can be performed on them. See “Managing users” on page 521.

To set key value pairs for user

1 In the Process Manager portal, on the Admin tab, click Users > Accounts > Manage Users.

2 In the left pane, select All Users or browse the Permissions and Groups to find the user whose financial transactions you want to manage.

3 In the right pane, next to the user whose financial transactions you want to manage, click the orange lightning symbol, and select Key Value Pairs.

4 To add a key value pair, click Add Key Value Pair, enter the information and click Save.

5 To edit a key value pair, click the Edit symbol next to the key value pair name, edit the information, and click Save.

6 To delete a key value pair, click the Remove symbol next to the key value pair name and click OK.

7 Click Close.
Managing permissions

Permissions are granted to users, groups, and organizations for accessing Process Manager. You can add or edit permissions. These permissions are also available to use when you design a workflow using Workflow Designer.

See “About permissions in Process Manager” on page 509.

To add a permission

1 In the Process Manager portal, on the Admin tab, click Users > Accounts > List Permissions.
2 In the left pane, click the Add Permission symbol.
3 Enter the name and description of the permission that you want to add.
4 Click Save.

Your permission is placed in the NotSet category until you move it.

To edit a permission

1 In the Process Manager portal, on the Admin tab, click Users > Accounts > List Permissions.
2 In the right pane, next to the permission that you want to edit, click the orange lightning symbol, and then select Edit.
3 Make the changes you want.
4 Click Save.

To grant a permission to a user

1 In the Process Manager portal, on the Admin tab, click Users > Accounts > List Permissions.
2 In the right pane, next to the permission that you want to grant to a user, click the orange lightning symbol, and then select View Users.
3 Click the Permissions tab and enter a user name or click pick to search for and select the user to whom to grant this permission. Then click Add.
4 (Optional) Click Relationship Type to select the relationship type for this permission. This option lets you establish relationships between permissions.

Relationship types only appear after they have been added.

See “Adding a user relationship type” on page 482.
5 When you are finished, close the dialog box.
To grant a permission to a group

1. In the Process Manager portal, on the Admin tab, click Users > Accounts > List Permissions.
2. In the right pane, next to the permission that you want to grant to a group, click the orange lightning symbol, and then select View Groups.
3. Enter a group name or click pick to search for and select the group to grant this permission to, and then click AddGroup.

Managing organizations

Organizations are the logical groups that can be used to provide structure to large Process Manager user groups. Organizations can also be the parent company for all users. Users and groups can be added to organizations.

Process Manager has two levels of organization: root organizations (the highest level) and sub-organizations (subordinate to root organizations).

See “Setting up groups, permissions, and users for the first time” on page 508.

To add a root organization

1. In the Process Manager portal, on the Admin tab, click Users > Accounts > List Organizations.
2. In the left pane, click the Add Root Organization symbol.
3. Enter the name and description.
4. Click Save.

To edit an organization

1. In the Process Manager portal, on the Admin tab, click Users > Accounts > List Organizations.
2. In the left pane, search for and select the organization name that you want to edit.
3. In the right pane, click the orange lightning symbol, and then click Edit Organization.
4. Make the changes that you want.
5. Click Save.
To add users or groups to an organization

1. In the Process Manager portal, on the Admin tab, click Users > Accounts > List Organizations.
2. In the left pane, search for and select the organization name to which you want to add users.
3. In the right pane, click the orange lightning symbol.
4. Click View User.
5. Click the Organization tab and enter a user. You can also click pick to search for and select the user to add to this organization, and then click AddUser.
6. (Optional) Click Relationship Type to select the relationship type for this organization. This option lets you establish relationships between organizations. Relationship types only appear after they have been added. See “Adding a user relationship type” on page 482.
7. Enter a group or click pick to search for and select the group to add to this organization, and then click AddGroup.
8. Close the dialog box when you have finished.

To add a sub-organization

1. In the Process Manager portal, on the Admin tab, click Users > Accounts > List Organizations.
2. In the left pane, search for and select the name of the organization to which you want to add a sub-organization.
3. In the right pane, click the orange lightning symbol, and then click AddSubOrganization.
4. Enter the name and description.
5. Click Save.

To delete an organization

1. In the Process Manager portal, on the Admin tab, click Users > Accounts > List Organizations.
2. In the left pane, search for and select the organization name that you want to delete.
3. In the right pane, click the orange lightning symbol, and then click Delete.
4. Click OK.
Performing administrative tasks in Process Manager

This chapter includes the following topics:

- Admin tab
- Data tab
- Portal tab
- Master settings page

Admin tab

This tab in Process Manager lets users manage permissions. This tab also lets users manage the applications that are used in the process, processes, and the behavior and look of Process Manager. Only users with the appropriate permissions can access this tab.

The Admin tab has multiple subtabs. By default the Admin tab opens to the Portal > Master Settings page.

<table>
<thead>
<tr>
<th>Command</th>
<th>Sub-command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>Lists/Profiles</td>
<td>Lets you add new profile definitions, and view, edit, and delete profile definitions. Profiles let you categorize data by adding customizable fields, which you can use to sort data. See &quot;About the Lists and Profiles page&quot; on page 483.</td>
</tr>
</tbody>
</table>
Table 25-1 Subtabs on the **Admin** menu *(continued)*

<table>
<thead>
<tr>
<th>Command</th>
<th>Sub-command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data</strong></td>
<td><strong>Application Properties</strong></td>
<td>Lets you add, view, edit, and delete application properties. Application properties are a type of profile. When you define application properties, you set up the properties that any process in the portal can then use. See “Creating application properties in Process Manager” on page 529. See “Accessing application properties in Workflow Designer” on page 194.</td>
</tr>
<tr>
<td><strong>Data</strong></td>
<td><strong>Document Type</strong></td>
<td>Lets you add new document types and edit or delete existing document types. Document types that you add appear in the <strong>Document Type</strong> drop-down list in the <strong>Add Documents</strong> dialogs. Users who add documents to the <strong>Documents</strong> page can select one of these document types. However, users can add the documents that are not of the type that is defined in the drop-down list. See “Working with document types” on page 480. See “About document management” on page 439.</td>
</tr>
<tr>
<td><strong>Data</strong></td>
<td><strong>Document Category Type</strong></td>
<td>Lets you define document category types, which assist in the organization of categories in the <strong>Documents</strong> page. Document category types are useful when you have many categories defined in the <strong>Documents</strong> page. Defining document category types lets you sort by type instead of sorting alphabetically. See “Working with document category types” on page 481.</td>
</tr>
<tr>
<td><strong>Data</strong></td>
<td><strong>Hierarchy Data Service</strong></td>
<td>Lets you manage categories in the data hierarchy. See &quot;About data hierarchies&quot; on page 488.</td>
</tr>
<tr>
<td><strong>Data</strong></td>
<td><strong>User Relationship Type</strong></td>
<td>Lets you add new user relationship types, and edit and delete existing user relationship types. User relationship types define the types of relationships that users can have to other users and to groups. For example, a relationship type can identify that one user is the manager of another user. A relationship type can also specify that a user is a member of a group. See “Adding a user relationship type” on page 482. See &quot;About data management&quot; on page 479.</td>
</tr>
<tr>
<td>Command</td>
<td>Sub-command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Data      | Profile Reference Type    | Lets you add a new profile reference type or edit an existing profile reference type. You must have Symantec Workflow installed to see this option. You may want to call support for assistance if you plan to change or add profile reference types.  
Profiles let you define data. When you set up a profile, you set up the pieces of data that you want to see in different Process Manager items. The items in Process Manager include articles, schedules, or documents. For example, if you work with mortgage applications, you might want to know the property address, assessed value, and other information on the properties. Setting up profile reference types lets you define the property-specific data that you want to see.  
See “About the Profile Reference Type page” on page 491. |
| Data      | Process Type Actions      | Lets you add new process type actions, edit and delete existing process type actions, and add actions to process types.  
Sending an email is a common example of an action that you may want to include in multiple processes. When you create process type actions, Process Manager sees x process type running, and adds y action as an option whenever x process is running. Creating process type actions adds an action in multiple places, without having to add the action to each individual workflow.  
See “About the Process Type Actions page” on page 492. |
| Portal    | Master Settings           | Lets you configure the master settings for the Process Manager portal. Master settings are related to Process Manager performance and behavior.  
See “Process Manager master settings” on page 406.  
See “About the Process Manager portal master settings” on page 419. |
<table>
<thead>
<tr>
<th>Command</th>
<th>Sub-command</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Portal**            | **Manage Pages** | Lets you manage the administration of all of the pages in the Process Manager portal. The portal is where you access the Process Manager user interface. Many portal pages are part of the default Process Manager installation. You can import, edit, delete, export, and move pages up and down the menu list. You can also add root and sub pages, and make a root page a sub page.  
See “About the Manage Pages page” on page 396.  
See “Portal tab” on page 534. |
| **Portal**            | **Plug-in Upload** | Lets you upload plug-ins, web parts, resources, or pages. For example, you can create a workflow project that you can upload as a plug in. You can create a workflow for the Document Management process, which requires users to go through several steps before a document is approved. You can load that workflow project into the Process Manager portal as a plug-in.  
See "Uploading plug-ins" on page 430. |
| **Portal**            | **Web Parts Catalog** | Lets you create new Web Parts to add to the catalog, and edit and delete existing Web Parts.  
See "Adding Web part catalogs" on page 431. |
| **Service Catalog Settings** | **Not applicable** | Lets you work with the Service Catalog items. You can set the permissions on which Process Manager users, groups, and organizational units have access to the specific forms. You can also edit, rename, create, and delete Service Catalog items and categories, and modify Service Catalog item attributes such as form size.  
See “About the service catalog” on page 497. |
Table 25-1 Subtabs on the **Admin** menu (continued)

<table>
<thead>
<tr>
<th>Command</th>
<th>Sub-command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Accounts</td>
<td>Lets you manage the various Process Manager user, group, permission, and organization accounts. This command has the following sub-commands:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Manage Users Lets you add new users, and delete and email users. You can also manage groups, organizations, and permissions for users, merge users, and set user relationships. In addition, you can set the user’s password, enable or disable the user, and add credit cards, transactions, and key value pairs for the user.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ List Permissions Lets you add new permissions, delete permissions, edit permissions, and view the users and groups that are assigned a certain permission.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ List Groups Lets you add new groups, edit groups, add users to groups, add permissions to groups, delete groups, and remove users from groups.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ List Organizations Lets you add new organizations, edit organizations, add users to organizations, add permissions to organizations, delete organizations, and remove users from organizations.</td>
</tr>
<tr>
<td>Users</td>
<td>AD Users</td>
<td>Lets you view the list of users currently in Active Directory, and select users to update.</td>
</tr>
<tr>
<td>Users</td>
<td>Manage Delegations</td>
<td>Lets you add and delete delegations for users.</td>
</tr>
<tr>
<td>AD Servers</td>
<td>Not applicable</td>
<td>Lets you add and manage Active Directory servers. See &quot;About using Active Directory with Process Manager&quot; on page 505.</td>
</tr>
<tr>
<td>Reports</td>
<td>Replication Schedule</td>
<td>Used with the Process Manager database replication. Lets you configure the replication schedules that specify the Process Manager data to replicate and when to replicate it.</td>
</tr>
<tr>
<td></td>
<td>List</td>
<td></td>
</tr>
<tr>
<td>Reports</td>
<td>Report Schedule</td>
<td>Lets you configure the schedules that automatically execute and email reports.</td>
</tr>
<tr>
<td></td>
<td>List</td>
<td></td>
</tr>
</tbody>
</table>
Table 25-1 Subtabs on the Admin menu (continued)

<table>
<thead>
<tr>
<th>Command</th>
<th>Sub-command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reports</td>
<td>Connection Context List</td>
<td>Lets you add connection strings for remote reporting. You can use remote reporting only if you have installed Process Manager on another computer. When you create a new report (in the Reports tab), you can choose the source of the report data. If you have registered a remote reporting computer in the Connection Context List, you can select that computer for the report data source. Note: From Workflow Solution 8.0, OLAP connection context type is not available in the Context Type option. An existing OLAP context type is displayed as Standard context type after an upgrade to Workflow Solution 8.0.</td>
</tr>
<tr>
<td>Reports</td>
<td>Report Snapshot List</td>
<td>Lets you view and delete report snapshots.</td>
</tr>
<tr>
<td>Manage KB Synonym</td>
<td>Not applicable</td>
<td>Lets you create synonyms for knowledge base searches.</td>
</tr>
<tr>
<td>Automation Rules</td>
<td>Not applicable</td>
<td>Currently used by ServiceDesk. For more information see Service Desks documentation.</td>
</tr>
</tbody>
</table>

Data tab

The Data tab exists in Process Manager under the Admin tab. Only administrator users have access to this tab.

See “Admin tab” on page 528.

On the Data tab, you can manage how Process Manager handles data. When you click on the Data tab, you can access several pages for data handling.

Table 25-2 Pages on the Data tab

<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lists and Profiles</td>
<td>Lets you add and edit profiles. See “About the Lists and Profiles page” on page 483.</td>
</tr>
<tr>
<td>Application Properties</td>
<td>Lets you add and edit application properties. See “About the Application Properties page” on page 486.</td>
</tr>
</tbody>
</table>
Table 25-2  Pages on the Data tab (continued)

<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Document Type</strong></td>
<td>Lets you add and edit document types.</td>
</tr>
<tr>
<td></td>
<td>See “About the document type page” on page 487.</td>
</tr>
<tr>
<td><strong>Document Category Type</strong></td>
<td>Lets you add and edit document category types.</td>
</tr>
<tr>
<td></td>
<td>See “About the document category type page” on page 488.</td>
</tr>
<tr>
<td><strong>Hierarchy Data Service</strong></td>
<td>Lets you add and edit hierarchy categories and items.</td>
</tr>
<tr>
<td></td>
<td>See “About the data hierarchy page” on page 488.</td>
</tr>
<tr>
<td><strong>User Relationship Type</strong></td>
<td>Lets you add and edit user relationship types.</td>
</tr>
<tr>
<td></td>
<td>See “About the User Relationship Type page” on page 491.</td>
</tr>
<tr>
<td><strong>Profile Reference Type</strong></td>
<td>Lets you add and edit profile reference types.</td>
</tr>
<tr>
<td></td>
<td>See “About the Profile Reference Type page” on page 491.</td>
</tr>
<tr>
<td><strong>Process Type Action</strong></td>
<td>Lets you add and edit process type actions.</td>
</tr>
<tr>
<td></td>
<td>See “About the Process Type Actions page” on page 492.</td>
</tr>
</tbody>
</table>

### Portal tab

You find the **Portal** tab in Process Manager, on the **Admin** tab. Only administrator users have access to this tab.

See “Admin tab” on page 528.

On the **Portal** tab you can edit Process Manager settings, pages, plug-in uploads, and Web parts. When you click the **Portal** tab, you can access a number of pages.

Table 25-3  Pages on the Portal tab

<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Master Settings</strong></td>
<td>Lets you add and edit profiles.</td>
</tr>
<tr>
<td></td>
<td>See &quot;Master settings page&quot; on page 535.</td>
</tr>
<tr>
<td><strong>Manage Pages</strong></td>
<td>Lets you add and edit application properties.</td>
</tr>
<tr>
<td></td>
<td>See “About the Manage Pages page” on page 396.</td>
</tr>
<tr>
<td><strong>Plug-in Upload</strong></td>
<td>Lets you add and edit document types.</td>
</tr>
<tr>
<td></td>
<td>See “Uploading plug-ins” on page 430.</td>
</tr>
</tbody>
</table>
Table 25-3  Pages on the Portal tab (continued)

<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Parts Catalog</td>
<td>Lets you add and edit document category types.</td>
</tr>
<tr>
<td></td>
<td>See “Adding Web part catalogs” on page 431.</td>
</tr>
</tbody>
</table>

Master settings page

The Process Manager master settings are located in Admin > Portal > Master Settings. This page lets you view and edit settings for Process Manager.

See “Process Manager master settings” on page 406.

See “About the Process Manager portal master settings” on page 419.

See “Admin tab” on page 528.

Table 25-4  Categories on the Master Settings page

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Management</td>
<td>Determines the information that is required for new users and how the users are handled.</td>
</tr>
<tr>
<td>Application Management</td>
<td>Sets the global behaviors for the Process Manager application.</td>
</tr>
<tr>
<td>Articles</td>
<td>Controls the appearance of the article site.</td>
</tr>
<tr>
<td>Chat</td>
<td>Controls the settings for the chat feature.</td>
</tr>
<tr>
<td>Customization</td>
<td>Controls the site’s appearance.</td>
</tr>
<tr>
<td>Document Management</td>
<td>Controls the management of documents by the system.</td>
</tr>
<tr>
<td>Email Settings</td>
<td>Sets the email settings for Process Manager, including the SMTP server.</td>
</tr>
<tr>
<td>Not Logged-in Users</td>
<td>Controls how to handle visitors who are not logged on to the site. You can block all access to users who do not log on, or allow such users to perform some functions.</td>
</tr>
<tr>
<td>Notifications</td>
<td>Sets the home URL for the site, as well as the locations of plug-ins.</td>
</tr>
<tr>
<td>Process Manager Active Directory Settings</td>
<td>Lets you edit the settings for using Active Directory to create and authenticate the users who log on to the Process Manager portal.</td>
</tr>
</tbody>
</table>
### Table 25-4  Categories on the **Master Settings** page (continued)

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Manager Events</td>
<td>Controls which event notifications are turned on.</td>
</tr>
<tr>
<td>Process Manager Settings</td>
<td>Sets the various settings for Process Manager, including the URL for the <strong>Forgot Password</strong> link. Do not change these settings without a specific purpose.</td>
</tr>
<tr>
<td>Optimization</td>
<td>Determines the times to keep items in various caches. Controls some of the behavior of the Process Manager engine.</td>
</tr>
<tr>
<td>Profile</td>
<td>Controls the settings for profiles.</td>
</tr>
<tr>
<td>Reports Settings</td>
<td>Controls the behavior, look, and location of reports.</td>
</tr>
<tr>
<td>Workflow Settings</td>
<td>Determines the ability to lease tasks, the appearance of tasks and the <strong>Task</strong> page, and task-related dates and times.</td>
</tr>
</tbody>
</table>
Mobile Process Manager

This chapter includes the following topics:

- About mobile Process Manager
- Defining a mobile Web part
- Adding a mobile Web part to a page
- About setting up phone simulators

About mobile Process Manager

Process Manager provides mobile support. Mobile Process Manager lets users access Process Manager pages from mobile devices. You can set up mobile web parts and add them to pages. Users of mobile devices access pages with mobile Web parts.

See “Defining a mobile Web part” on page 537.
See “Adding a mobile Web part to a page” on page 538.
See “Adding new Process Manager pages” on page 397.
See “About setting up phone simulators” on page 538.

Defining a mobile Web part

You can define a Web part so that it is accessible from mobile devices. After a page is defined as a mobile Web part, the mobile Web part can be added to a page so that mobile devices can view the page.

See “About mobile Process Manager” on page 537.
See “Adding a mobile Web part to a page” on page 538.
To define a mobile Web part
1 In the Process Manager portal, in the Site Actions drop-down list, select Add Root Page.
2 In the New Page Wizard: Step 1, select Web Part.
3 Click Next.
4 In the Add Page page, click Is Mobile Page.
   See “Add Page page” on page 399.
5 Enter all other requested information and click Save Page.

Adding a mobile Web part to a page
You can add a mobile Web part to a page. A mobile Web part allows the page to be accessed from a mobile device.

When a page has a mobile Web part that is added to it, users who have access to that page can access it from a mobile device. When the user logs onto Process Manager from the mobile device, the mobile Web part is viewed.

See “About mobile Process Manager” on page 537.
See “Defining a mobile Web part” on page 537.

To add a mobile Web part to a page
1 In the Process Manager portal, on the Admin tab, click Portal > Manage Pages.
2 In the Pages List pane, select the page to add the Web part to.
3 In the right pane, click Go To Page.
4 In the Site Actions drop-down list, select Modify Page or Modify My Page.
5 Select the mobile Web part you want to add.
6 Click Add.

About setting up phone simulators
You can develop mobile forms to use with mobile Process Manager. To develop mobile forms, you need to download emulators for the type of mobile device being used.

See “About mobile Process Manager” on page 537.
### Table 26-1  Download instructions for the most common device types

<table>
<thead>
<tr>
<th>Mobile device</th>
<th>Information</th>
</tr>
</thead>
</table>
| Blackberry    | Download the emulator at the following location:  
  https://www.blackberry.com/Downloads/entry.do?  
  code=060AD92489947D410D897474079C1477  
  Select the version download and install it.  
  The installation provides two options under Research In Motion. The MDS option provides the necessary service and simulator that provides the user interface to test the emulator.  
  Start MDS before running the emulator. |
| Android       | Download the Android SDK at the following location:  
  http://dl.google.com/android/android-sdk-windows-1.5_r3.zip  
  After you download the SDK, extract the folder and open a command prompt. In the tools folder of the SDK, execute the android create command.  
  For example, if C:\android-sdk-windows-1.5_r3\android-sdk-windows-1.5_r3\tools is the path to the tools folder of the SDK, enter the following command:  
  C:\android-sdk-windows-1.5_r3\android-sdk-windows-1.5_r3\tools>android create avd -n my_android1.5 -t 2  
  When your run android create avd -n my_android1.5 -t 2, an AVD (Android Virtual Device) is created with the name my_android1.5 and a targetID of 2 is used.  
  Next, open the emulator by executing the following command:  
  C:\android-sdk-windows-1.5_r3\android-sdk-windows-1.5_r3\tools>emulator -avd my-android1.5 |
| IPhone        | Download MobiOne Studio at the following location:  
  http://www.genuitec.com/mobile/  
  After installation, an emulator with name MobiOne is available. |
This chapter includes the following topics:

- About Process Manager reporting
- About the Reports page
- Viewing a report
- About creating a new report
- Adding a new sub report
- Creating a standard report
- Setting up or modifying the data in standard reports
- Customizing the layout of grid standard reports
- Setting up or modifying Web Service access for standard reports
- Customizing filtering and sorting for standard reports
- Modifying standard reports
- Setting permissions for reports
- Exporting a report definition
- Copying a report
- Adding reports to a portal page
- Adding report categories
About Process Manager reporting

The reporting feature in Process Manager allows users to have easy access to Process Manager data, in the form of predefined reports. Users can also create custom reports.

The main Process Manager reporting features are as follows:

- The predefined reports that are installed with Process Manager meet the ITIL needs of many users.
- Predefined reports can be easily customized by copying a report and changing a few items so that the new report meets your exact needs.
- A wizard interface is used to create new reports, which eliminates the need to use SQL for report creation. All reports can be included on portal pages and dashboards, and the size and placement of the report is customizable by the administrator.
- During report creation, you can add run-time filters to the report definition. Run-time filters allow users to scope the reports based on the data that they want to see.
- All reports can be configured to represent Process Manager data in a graphical format.

Process Manager contains standard reports that are easily customizable and can contain any Process Manager data.
See “About the Reports page” on page 542.

About the Reports page

The Reports page in the Process Manager portal lets you view, create, delete, copy, email, and perform other actions with reports in Process Manager. Your permissions determine which reports you can view, and what actions you can take with those reports. For example, you might have permission to view certain reports, but not to delete those reports or edit the report definitions.

If your page was customized, its appearance and contents might differ from the default page.

See “About customizing Process Manager pages” on page 404.

<table>
<thead>
<tr>
<th>Table 27-1</th>
<th>Default sections on the Reports page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>Report Search</td>
<td>Lets you search for a specific report. This search is conducted on the report name and the results are shown from all categories.</td>
</tr>
<tr>
<td>Report Categories</td>
<td>Lets you select the category for which to display the reports. You can also import a report category to the list from another Process Manager instance, and you can add a new report category. See “Adding report categories” on page 553. See “Importing report categories” on page 560.</td>
</tr>
<tr>
<td>Report Templates</td>
<td>Lets you create a new report from a predefined template. You can also edit, export, and delete a Report Template.</td>
</tr>
<tr>
<td>Category section</td>
<td>Lets you edit the category that you selected under Report Categories. This title for this section is the same as the selected category name. See “Setting report category permissions” on page 556.</td>
</tr>
</tbody>
</table>
Table 27-1  Default sections on the Reports page (continued)

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reports</td>
<td>Displays the reports that are in the category that you selected under Report Categories. Your permissions determine the reports that appear. You can select a report to view or select any of several report actions. For example, you can edit, print, and export a report. You can also add a new report. See “Viewing a report” on page 543. See “Add/Edit Standard Report dialog box” on page 557. See “Displaying reports in print view” on page 560. See “Exporting a report definition” on page 551.</td>
</tr>
</tbody>
</table>

Viewing a report

In the Reports tab, you can view all of the reports that you have the view report permission for. You also view reports on the portal pages that include reports.

See “About Process Manager reporting” on page 541.

See “About the Reports page” on page 542.

To view a report

1. In the Process Manager portal, click Reports tab.
2. Under Report Categories, select the category that contains the report you want to view.
3. Click the report name, or select the action icon for the report that you want to view, and click View.

About creating a new report

You can create a new report. You can use any of the following methods to create a new report:

- Create a new report in the desired report category with the Add report icon.
- See “Adding reports to additional categories” on page 556.
- Import a report from another Process Manager. See “Importing reports” on page 561.
- Add a sub report for an existing report.
Adding a new sub report

The sub report function lets you create a new report using the base of an existing report. The user designing the report can only add new data, thereby preserving the original data. A new sub report is added to the report category of the selected report.

To add a new sub report

1. In the Process Manager portal, select the Reports tab.
2. In the Report Categories section, select the category that contains the report you want to make the base for a new sub report.
3. Select the action icon for the report, and click Add Sub Report.
4. In the Name box, enter a name for the report.
   Report names must be unique. The Name box has a 100-character limit.
5. In the Report Designer tab, specify the data that you want to include in the report and how that data is displayed.
   See “Setting up or modifying the data in standard reports” on page 546.
6. (Optional) In the Description tab, enter a description for the report.
   The description appears on the Reports portal page under the report.
   The description should make it easy for users to quickly understand the information that the report contains. The description text is also searched when users search for reports. The description has no character limit.
7 In the Permissions tab, you can add or modify permissions for the report as needed.

You can take the following actions with permissions:

- **To edit existing permissions** Select the edit icon for the permission that you want to modify. Make the necessary changes to the permission and click **Update**.

- **To remove an existing permission** Click the delete icon for the permission that you want to remove.

- **To add a new permission** Click **Add New Permission**. Select the permission type, and the user, group, permission, or organization you want to set permissions for. Set the appropriate permissions and click **Add**.

8 (Optional) On the Web Services tab, set up Web Service access for the report.

See “Setting up or modifying Web Service access for standard reports” on page 548.

9 Click **Save**.

Creating a standard report

Administrators and users with the appropriate permissions can create reports.

**To create a new report**

1 In the Process Manager portal, click **Reports** tab.

2 Under **Report Categories**, select the category that you want the report to reside in. The report that you create is added to the category that you select.

3 Click the **Add Report** icon, and select **Add Standard Report**.

4 In the **Name** field, enter a name for the report. Report names must be unique. The **Name** field has a 100 character limit.

5 In the **Report Designer** tab, specify the data that you want included in the report and the display of that data.

See “Setting up or modifying the data in standard reports” on page 546.

6 (Optional) In the **Description** tab, enter a description for the report which appears on the Reports portal page underneath the report. The description should make it easy for users to quickly understand the information that the report contains. The description text is also searched when users search for reports. The description has no character limit.
7 In the Permissions tab and add or modify permissions for the report as needed. You can take multiple actions with permissions.

To edit existing permissions
Select the edit icon for the permission that you want to modify. Make the necessary changes to the permission and click Update.

To remove an existing permission
Click the delete icon for the permission that you want to remove.

To add a new permission
Click Add New Permission. Select the permission type, and the user, group, permission, or organization you want to set permissions for. Set the appropriate permissions and click Add.

8 (Optional) On the Web Services tab, set up Web Service access for the report.
See “Setting up or modifying Web Service access for standard reports” on page 548.

9 Click Save.

Setting up or modifying the data in standard reports

The data that is included and displayed in reports is completely customizable. In the Report Designer tab, you specify the information that should be included in a report, as well as criteria to narrow the report results. The information that you specify in this tab can both add to, and restrict the data that appears in the report.

Selecting a check box for a type of data that you want to add to the report includes all of the fields available for that section in the report. The available fields are displayed in the Data section. Selecting the check box for one of the fields lets you apply filters to the data that is returned in that field.

To set up or modify the data and display of standard reports

1 In the Process Manager portal, click Reports tab.

2 On the Reports page, do one of the following:
   ■ Create a new report.
      See “Creating a standard report” on page 545.
   ■ Modify an existing report.
      See “Modifying standard reports” on page 550.

3 In the Add/Edit Standard Report dialog box, select the Report Designer tab.
See “Add/Edit Standard Report dialog box” on page 557.
4 On the Data tab, select the check box for the type of data that you want to include in the report. When you select a data type, all of the data fields of that type are added to the report. All of the data fields are available for display in the report. Data types that are included in the report have a green check mark next to them. Repeat this step for all of the datatypes that you want to include in the report.

5 (Optional) To filter the data that is included in the report, select the check box next to the field that you want to filter. Fields to which you have applied filtering have a green check mark next to them.

6 In the Columns area, select the check box for the columns that you want to display in the report. Repeat this step for all of the columns that you want to include in the report. Columns that are included in the report have a green check mark next to them, and are displayed at the top of the columns area.

7 (Optional) Customize the layout of the report.

See “Customizing the layout of grid standard reports” on page 547.

8 (Optional) Customize the filtering and sorting of the report.

See “Customizing filtering and sorting for standard reports” on page 549.

9 Click Save.

Customizing the layout of grid standard reports

You can view the layout of the report as you work on it. The report preview pane, in the center of the Report Designer tab, shows you how the report currently looks.

See “Add/Edit Standard Report dialog box” on page 557.

When Auto Preview is selected (it is by default), the changes you make to your report are shown as you make them. If you make a lot of changes, you may want to turn off Auto Preview. When Auto Preview is turned off, you do not have to wait for each change to be reflected in the preview pane. If you have turned off Auto Preview, you can click Generate to see the current report with all of your changes.

When Limit Results is selected (it is by default), the report results are limited to the top 50 results. When you limit results, you can see how the report looks without showing a huge amount of data in the report preview pane.

You can customize the layout of grid standard reports in the following ways:

- To move columns in the report, click the left arrow or right arrow for the column in the report preview pane.
- To delete a column, click the red x for the column in the report preview pane.
To change the name of a column, move your mouse over the column name in the **Columns** section, and click **Edit**. Edit the title of the column and click **OK**.

To adjust column width, place the mouse arrow over the column and drag to get the desired width.

To apply special formatting to columns in the report, add renderers.

## Setting up or modifying Web Service access for standard reports

Setting up web service access for a report allows programmatic access to that report.

**To set up or modify Web Service access for standard reports**

1. In the Process Manager portal, click **Reports** tab.
2. On the Reports page, do one of the following:
   - Create a new report.
     See “Creating a standard report” on page 545.
   - Modify an existing report.
     See “Modifying standard reports” on page 550.
3. In the **Add/Edit Standard Report** dialog box, click the **Web Services** tab.
   See “Add/Edit Standard Report dialog box” on page 557.
4 On the **WebService** tab, click the check box to enable programmatic access to the report. To enable WebService Access, enter data in the following fields:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Namespace</td>
<td>The namespace for the WebService and the objects that are used in the web service.</td>
</tr>
<tr>
<td>Namespace URI</td>
<td>The URI for the namespace.</td>
</tr>
<tr>
<td>WebService Name</td>
<td>A name that describes the service.</td>
</tr>
<tr>
<td>Class Name</td>
<td>The results of the report are an array of the class name that is supplied here. The class name has public properties for each of the columns in the report.</td>
</tr>
</tbody>
</table>

Click **Generate** to compile the WebService and deploy it to a URL. The URL is displayed on the screen and can be used to access the WebService. When report data changes, you need to generate the WebService again to update the class.

5 Click **Save**.

### Customizing filtering and sorting for standard reports

In the **Options** tab, on the **Report Designer** tab of the Add/Edit Standard Report dialog, you specify the grouping, sorting, and paging options for the report.

To customize the filtering, sorting, and grouping for a report

1 In the Process Manager portal, click **Reports** tab.

2 On the Reports page, do one of the following:

   - Create a new report.
     See “Creating a standard report” on page 545.
   - Modify an existing report.
     See “Modifying standard reports” on page 550.

3 In the **Add/Edit Standard Report** dialog box, select the **Report Designer** tab.

See “Add/Edit Standard Report dialog box” on page 557.

4 (Optional) In the **Report Designer** tab, click **Options**.

5 Select the **Limit Rows** check box to limit the number of rows that are returned with the report. The default number of rows that are returned is 50. When you select this option, the user is able to configure the number of rows that are returned at run time.
6 Select the **Use Paging** check box, and specify the number of rows per page for the report.

7 Select a column in the **Sort By** drop-down list to sort the report by that column, and select ascending or descending sort order.

8 Select up to three columns to group the report by in the **Group By** drop-down lists.

9 To add aggregations to your groups, under **Group Aggregations**, select a column to aggregate a group by and the type of aggregation, and then click **Add Aggregation**. Aggregations summarize mathematical data at the group level.

10 Click **Display SQL** to display the SQL statement that the report executes against the database.

11 Click **Save**.

### Modifying standard reports

You can modify any report for which you have the appropriate permissions. You are more likely to spend time modifying existing reports than creating new reports. Process Manager includes many predefined reports that meet most of your reporting needs. When you want to make a small change to an existing report, copy the existing report and make your changes in the new report. By copying the report instead of making modifications directly to a predefined report, you can always go back to the original report.

**To modify a standard report**

1 In the Process Manager portal, click **Reports** tab.

2 Under **Report Categories**, select the category that contains the report that you want to modify.

3 On the right side of the page, click the orange lightning symbol for the report that you want to modify, and then click **Edit**.

4 In the **Edit Standard Report** dialog box, make the necessary changes to the report. The dialog and tabs for editing and adding standard reports are the same.

   See “Creating a standard report” on page 545.

   See “Add/Edit Standard Report dialog box” on page 557.

5 Click **Save**.
Setting permissions for reports

Administrators and users who are assigned the appropriate permissions can set permissions on a report. Specifying permissions on a report controls access to, and use of that report. For example, you can determine through permissions what users or groups can view, edit, delete, or create sub reports for a report.

See “About the Reports page” on page 542.

See “Setting report category permissions” on page 556.

To set permissions for a report

1. In the Process Manager portal, click Reports tab.

2. Under Report Categories, select the category that contains the report you want to set permissions for.

3. Select the action icon for the report that you want to set permissions for, and click Permissions.

4. In the Report Permissions dialog, add, edit, or modify permissions as needed. You can take multiple actions with permissions.

   To edit existing permissions  
   Select the edit icon for the permission that you want to modify. Make the necessary changes to the permission and click Update.

   To remove an existing permission  
   Click the delete icon for the permission that you want to remove.

   To add a new permission  
   Click Add New Permission. Select the permission type, and the user, group, permission, or organization you want to set permissions for. Set the appropriate permissions and click Add.

5. Click Close.

Exporting a report definition

Any report definition can be exported to an .xml schema file. When you export a report definition, the report settings are exported so that the report can be run from another Process Manager system. The actual report data is not exported when you use the export report feature. You have the option of saving or viewing the .xml file. Any user that has access to view a report, has permission to export it.

See “Viewing a report” on page 543.
See “Copying a report” on page 552.

See “Importing reports” on page 561.

To export a report

1. In the Process Manager portal, click Reports tab.
2. Under Report Categories, select the category that contains the report you want to export.
3. Select the action icon for the report that you want to copy, and click Export Report.
4. In the File Download dialog box, click either of the following options:
   - Open Opens the XML file for viewing.
   - Save Saves the file on your computer.

Copying a report

Copying an existing report lets you create a new report that is customized to your needs, without having to recreate the report settings. You can copy a report that has almost all of the information you need, and then add, remove, and edit the report. Modifying the copied report lets you get what you are want in the report. Administrators, and the users with the appropriate permissions can copy reports. By default, Administrators can copy a report that is located in any category. Other users cannot copy a report that is in a category for which they do not have permission to create reports.

See “About creating a new report” on page 543.

See “Deleting reports” on page 557.

See “Add/Edit Standard Report dialog box” on page 557.

To copy a report

1. In the Process Manager portal, click Reports tab.
2. Under Report Categories, select the category that contains the report you want to copy.
3. Select the action icon for the report that you want to copy, and click Copy.
4. In the Report Information dialog, enter a new name for the report in the Report Name field.
Optionally, enter a description for the report in the Report Description field. The description text you enter appears under the report name on the Reports tab, when you expand a report entry.

6 Click Save.

Adding reports to a portal page

Any Process Manager reports can be added to a portal page. Administrators and users with the appropriate permissions to modify portal pages can add reports.

See “About Process Manager reporting” on page 541.

To add a report to a portal page

1 In the Process Manager portal, select the portal page you want to add the report to.

2 Click Site Actions > Modify Page.

3 Click Site Actions > Add Web Part.

4 In the Catalog List, click Reports.

5 Select the Standard Report Viewer check box to add a standard report.

6 Select the zone that you want to add the report to from the Add to drop-down list.

7 Click Add. The Report Viewer Web part is added to the portal page.

8 Click Close.

9 Click the Report Selection icon and select the report that you want to display in the Report Viewer Web part.

Adding report categories

Report categories assist you in organizing all of the reports that are located on the Reports page. Organizing the reports in categories helps users find the reports they need more easily. You can also apply permissions to categories, which deny or grant access to that category and all the reports within it.

See “Setting report category permissions” on page 556.

To add a report category

1 In the Process Manager portal, click Reports tab.

3 In the **Category Information** dialog box, in the **Name** text box, type a name for the category.

4 (Optional) In the **HeaderText** box, type descriptive text. The text is displayed under the category name on the right-hand side of the **Reports** page when a user selects the category.

5 Click **Save**.

---

**Adding report sub categories**

Report sub categories can assist with further organizing the categories and reports that are located on the Reports page. You can add sub categories to any category if you have the necessary permissions to do so.

See “**Adding report categories**” on page 553.

See “**Deleting report categories**” on page 554.

See “**Importing report categories**” on page 560.

**To add a report sub category**

1 In the Process Manager portal, click **Reports** tab.

2 Under **Report Categories**, select the category that you want to add a sub category to.

3 On the right side of the page, click the orange lightning symbol, and then click **New Sub Category**.

4 In the **Category Information** dialog box, in the **Name** text box, type a name for the sub category.

5 (Optional) In the **HeaderText** text box, type some descriptive text. The text is displayed under the category name on the right-hand side of the Reports page when a user selects the category.

6 Click **Save**.

---

**Deleting report categories**

Users with the appropriate permissions can delete report categories. When you delete report categories, the sub categories and the reports that are contained in that category are not necessarily deleted. You can make selections during the deletion process, which determines what happens to the subcategories and the reports that are contained in a report category.

See “**Adding report categories**” on page 553.
To delete a report category

1. In the Process Manager portal, click **Reports** tab.
2. Under **Report Categories**, select the category to delete.
3. On the right side of the page, click the **Actions** symbol (orange lightning), and then click **Delete**.
4. In the **Delete Category** dialog box, select one of the following options for handling any sub categories that are contained in the category:

   - **Don't delete SubCategories**: Retains all sub categories that are contained in the parent category. The sub categories are moved up to the root level.
   - **Delete SubCategories**: Deletes all sub categories that are contained in the parent category. If reports in that category also belong to another category, they remain in the other categories. If reports do not belong to other categories, they are moved to the Orphan category.
   - **Delete SubCategories and all reports in them**: Deletes all sub categories and the reports they contain.

Select one of the following options for handling any reports that are contained in the category:

   - **Don't delete reports**: Retains all reports that are contained in the category.
   - **Delete reports (that are linked only to the deleted category)**: Deletes all the reports that are contained in the category, as long as they are linked only to the deleted category. If the reports are linked to additional categories, they are retained.
   - **Delete reports even if linked to multiple categories**: Deletes all reports that are contained in the category, even if they are linked to categories other than the one being deleted.

5. Click **Delete**.
Setting report category permissions

Report categories assist you in organizing all of the reports that are located on the Reports page. Organizing the reports in categories helps users find the reports they need more easily. You can apply permissions to categories, which deny or grant access to that category and all the reports within it. By default, the category inherits the permissions of the user who created it. If you want the permissions to be different for other users of the category, you need to modify the category permissions.

See “About the Reports page” on page 542.
See “Setting permissions for reports” on page 551.

To set report category permissions

1. In the Process Manager portal, click Reports tab.
2. Under Report Categories, select the category that you want to set permissions for.
3. On the right side of the page, click the orange lightning symbol, and then click Permissions.
4. In the Category Permissions dialog box, add or modify permissions as needed. You can take multiple actions with permissions.
   - To edit existing permissions: Select the edit icon for the permission that you want to modify. Make the necessary changes to the permission and click Update.
   - To remove an existing permission: Click the delete icon for the permission that you want to remove.
   - To add a new permission: Click Add New Permission. Select the permission type, and the user, group, permission, or organization you want to set permissions for. Set the appropriate permissions and click Add.

5. Click Close.

Adding reports to additional categories

When you initially add reports to the Reports page, they are contained in a single category. Users with the appropriate permissions can add reports to additional categories. A report can belong to an unlimited number of categories.

See “About creating a new report” on page 543.
To add a report to additional categories

1. In the Process Manager portal, click the Reports tab.
2. Under Report Categories, select the category that contains the report which you want to add to additional categories.
3. On the right side of the page, click the orange lightning symbol for the report that you want to add to additional categories, and click Categories.
4. In the Report Category Management dialog box, click the Add To Category tab.
5. Select the category that you want to add the report to and click Add.
6. Click Close.

Deleting reports

You can delete any report that you have delete permissions for from the Reports tab.

See “About creating a new report” on page 543.
See “Copying a report” on page 552.
See “Deleting report categories” on page 554.

To delete a report

1. In the Process Manager portal, click Reports tab.
2. Under Report Categories, select the category that contains the report you want to delete.
3. On the right side of the page, click the orange lightning symbol for the report that you want to delete, and click Delete.
4. Click OK in the confirmation dialog box.

Add/Edit Standard Report dialog box

This dialog box appears when you create or edit a standard report.

The Add/Edit Standard Report dialog box has four tabs.
### Table 27-2  Tabs in the *Add/Edit Standard Report* dialog box

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Designer</td>
<td>Lets you specify what data is included in the report and specify options for that data. You can also specify the sorting and grouping of the resulting data, and specify columns for the resulting data set.</td>
</tr>
<tr>
<td></td>
<td><em>Table 27-3</em></td>
</tr>
<tr>
<td>Description</td>
<td>Lets you specify a description of the report which is displayed on the Reports page.</td>
</tr>
<tr>
<td>Permissions</td>
<td>Lets you specify the permissions for the report.</td>
</tr>
<tr>
<td></td>
<td><em>Table 27-4</em></td>
</tr>
<tr>
<td>Web Services</td>
<td>Lets you enable Web Service access to the report.</td>
</tr>
<tr>
<td></td>
<td><em>Table 27-5</em></td>
</tr>
</tbody>
</table>

### Table 27-3  Options on the *Report Designer* tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data tab</td>
<td>Lets you specify the type of data that is included in the report.</td>
</tr>
<tr>
<td>Grid</td>
<td>Displays the current report in grid view in the report preview pane. Whichever pane is displayed when you save the report is the type of report that anyone viewing the report sees.</td>
</tr>
<tr>
<td>Chart</td>
<td>Displays the current report in chart view in the report preview pane. Whichever pane is displayed when you save the report is the type of report that anyone viewing the report sees.</td>
</tr>
<tr>
<td>Auto Preview</td>
<td>Displays a preview of the current report as you build it. Auto Preview is selected by default.</td>
</tr>
<tr>
<td>Limit Results</td>
<td>Limits the result set of the report that is shown in the report preview pane to 50. The Limit Results option is selected by default.</td>
</tr>
<tr>
<td>Generate</td>
<td>When Auto Preview is not selected, clicking Generate lets you view the report in the report preview pane with all the changes you have made.</td>
</tr>
<tr>
<td>Columns</td>
<td>Lets you specify the columns that are displayed in the report.</td>
</tr>
<tr>
<td>Options tab</td>
<td>Lets you specify the grouping and sorting of the data in the report.</td>
</tr>
</tbody>
</table>
### Table 27-3 Options on the Report Designer tab (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Limit Rows</strong></td>
<td>Lets you specify the maximum number of rows that are included in the report. The default number of rows is 50, and users can configure the number of rows they want to see in the report at run time.</td>
</tr>
<tr>
<td><strong>Use Paging</strong></td>
<td>Lets you specify the number of rows per page in the report.</td>
</tr>
<tr>
<td><strong>Sort By</strong></td>
<td>Lets you specify the columns to sort by and whether the data in those columns should be sorted in ascending or descending order.</td>
</tr>
<tr>
<td><strong>Group By</strong></td>
<td>Lets you specify the columns to group by.</td>
</tr>
<tr>
<td><strong>Group Aggregations</strong></td>
<td>Lets you add group aggregations. Group aggregations summarize mathematical data at the group level.</td>
</tr>
<tr>
<td><strong>Add Aggregation</strong></td>
<td>Lets you add aggregations to the report. Any number of aggregations are allowed.</td>
</tr>
<tr>
<td><strong>Display SQL</strong></td>
<td>Displays the SQL statement for the report.</td>
</tr>
</tbody>
</table>

### Table 27-4 Options on the Permissions tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rows in the tab</strong></td>
<td>Lists the current permissions that are assigned to the report.</td>
</tr>
<tr>
<td><strong>Edit icon</strong></td>
<td>Lets you edit the permissions for that user, group, permission, or organization.</td>
</tr>
<tr>
<td><strong>Delete icon</strong></td>
<td>Lets you delete that permission.</td>
</tr>
<tr>
<td><strong>Add New Permission</strong></td>
<td>Lets you add a new permission.</td>
</tr>
</tbody>
</table>

### Table 27-5 Options on the Web Services tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enabled for programmatic access</strong></td>
<td>Lets you enable the report for programmatic access. Selecting this check box displays the fields that you need to specify to set up Web Service access.</td>
</tr>
<tr>
<td><strong>Namespace</strong></td>
<td>The namespace for the WebService and the objects that are used in the Web service.</td>
</tr>
<tr>
<td><strong>Namespace URI</strong></td>
<td>The URI for the namespace.</td>
</tr>
</tbody>
</table>
Table 27-5 Options on the **Web Services** tab (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebService Name</td>
<td>A name that describes the service.</td>
</tr>
<tr>
<td>Class Name</td>
<td>The results of the report are an array of the class name that is supplied here. The class name has public properties for each of the columns in the report.</td>
</tr>
<tr>
<td>Generate</td>
<td>Compiles the Web Service and deploys it to a URL. The URL is displayed on the screen and can be used to access the WebService. When report data changes, you need to generate the WebService again to update the class.</td>
</tr>
</tbody>
</table>

**Displaying reports in print view**

You can display any report that you have permissions to view in print view. Print view shows you how the report looks once it is printed.

See “About the Reports page” on page 542.

To display a report in print view

1. In the Process Manager portal, click **Reports** tab.
2. Under **Report Categories**, select the category that contains the report you want to display in print view.
3. On the right side of the page, click the orange lightning symbol for the report that you want to display in print view, and click **Print View**.

**Importing report categories**

You can import report categories from another instance of Process Manager.

See “Adding report categories” on page 553.

See “Deleting report categories” on page 554.

See “Importing reports” on page 561.

To import a report category

1. In the Process Manager portal, click **Reports** tab.
2. Under **Report Categories**, click **Import Category**.
3. In the **Import** dialog box, click **Browse** and select the report file that you want to import.
4 Select one of the following options to determine whether Process Manager overwrites or copies existing reports:

- Overwrite existing reports - Process Manager overwrites reports with the same report ID
- Create new copy - Process Manager creates new copies of all the reports

5 Click Import.

Importing reports

You can import reports from another instance of Process Manager.

See “About creating a new report” on page 543.
See “Creating a standard report” on page 545.
See “Adding a new sub report” on page 544.
See “Copying a report” on page 552.

To import reports

1 In the Process Manager portal, click Reports tab.

2 Under Report Categories, select the category that you want to import reports into.

3 On the right side of the page, click the Add Report icon, and click Import Reports.

4 In the Import dialog box, click Browse and select the report file that you want to import.

5 Select one of the following options to determine whether Process Manager overwrites or copies existing reports:

- Overwrite existing reports - Process Manager overwrites reports with the same report ID.
- Create new copy - Process Manager creates new copies of all the reports.

6 Click Import.

Adding a report schedule

You can add the schedules that automatically execute and email reports.

See “Applying a schedule to a report” on page 562.
To add a report schedule

1. On the Process Manager home page, on the Admin > Reports tab, click Report Schedule list.

2. Click the Add report Schedule icon.

3. In the New Report Schedule dialog box, specify the following items:

   - **Name**: Enter the new schedule name.
   - **Active**: Check it to let the schedule be applied to a report.
   - **Select type of schedule**: Select one of the following types of the schedule:
     - Daily
     - Weekly
     - Monthly
     - One time only
   - **Select the time and day you want this task to start**: Select the start date and time.
   - **End date**: Check this item if you want to set the end date for using the schedule, and set the date.
   - **Perform this task**: Select one of the following time intervals for performing the task:
     - Every day
     - Weekdays
     - Every n days
       Where n is the number of days, that you can choose.

4. (Optional) Click Advanced to set the task to repeat.
   - Check Repeat task, set the repeating interval, and click Save.

5. Click Save.

---

**Applying a schedule to a report**

You can generate a report on a schedule. To do so, you need to apply an existing schedule to a report. You can use the Admin tab or the Reports tab to apply a schedule to a report.

See “Adding a report schedule” on page 561.
To apply a schedule to a report from the Admin tab


2. Click the action symbol (the orange lightning symbol) for a desired schedule, and then click Reports.

3. Click Add Report.

4. In the Report list, select the report.

5. Click Pick to specify a user from whose account a report should run.
   - In the User Picker dialog box, specify the user by selecting any of the following items:
     - Email: The email address of the user you want to find
     - First Name: The first name of the user
     - Last Name: The last name of the user
     - City: The city of the user
     - State: The state of the user
     - Zip: The ZIP Code of the user
     - Country: The country of the user
     - Group: A user group of the user
     - Organization: The organization of the user
     - Max results: The maximum number of search results on the page
   - Click Search.
   - In the list of search results, select the desired user.

6. In the Destination Type list, select either of the following means to get the report:
   - Email
   - File
7 The destination type of report that you selected determines the option that appears, as follows:

- **Email Addresses**: Type the email addresses that should receive the report.
- **File**: Type a directory to which to write the files. This directory must be writable by the user who runs the Web site. If you specify an empty file path, the following path is used:
  
  C:\ProgramFiles\Symantec\Workflow\ProcessManager\ReportSnapshots

8 Select any of the following output formats for the report:

- Excel
- CSV
- HTML

9 Type a report name if you want to receive it with a different name.

10 (Optional) Check **Make Report Snapshot**.

   Snapshots are copies of the report; they can be useful if you want to look at report data quickly.

   You can access ready snapshots from **Admin > Reports > Reports Snapshot list**.

11 Click **Add**.

**To apply a schedule to a report from the Reports tab**

1 On the Process Manager home page, select the **Reports** tab.

2 Click the action symbol (the orange lightning symbol) for a desired report, and then click **Schedules**.

3 Click **Add Schedule**.

4 In the **Schedule** list, select the schedule.

5 Click **Pick** to specify a user from whose account a report should run.

   - In the **User Picker** dialog box, specify the user by selecting any of the following items:
     
<pre><code> | Field       | Description                     |
 |-------------|---------------------------------|
 | Email       | The email address of the user you want to find |
 | First Name  | The first name of the user       |
 | Last Name   | The last name of the user        |
</code></pre>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>City</td>
<td>The city of the user</td>
</tr>
<tr>
<td>State</td>
<td>The state of the user</td>
</tr>
<tr>
<td>Zip Code</td>
<td>The ZIP Code of the user</td>
</tr>
<tr>
<td>Country</td>
<td>The country of the user</td>
</tr>
<tr>
<td>Group</td>
<td>A user group of the user</td>
</tr>
<tr>
<td>Organization</td>
<td>The organization of the user</td>
</tr>
<tr>
<td>Max results</td>
<td>The maximum number of search results on the page</td>
</tr>
</tbody>
</table>

- Click **Search**.
- In the list of search results, select the desired user.

6. In the **Destination Type** list, select either of the following means to get the report:
   - Email
   - File

7. The destination type of report that you selected determines the option that appears, as follows:

   - **Email Addresses**
     - Type the email addresses that should receive the report.
   - **File**
     - Type a directory to which to write the files. This directory must be writable by the user who runs the Web site. If you specify an empty file path, the following path is used:
       - `C:\Program Files\Symantec\Workflow\ProcessManager\ReportSnapshots`

8. Select any of the following output formats for the report:
   - Excel
   - CSV
   - HTML

9. Type a report name if you want to receive it with a different name.
10  (Optional) Check **Make Report Snapshot**.

Report snapshot is a table in the Process Manager database with fields that are populated with the data from reports. You can use report snapshots to build another report.

You can access the list of ready snapshots from **Admin > Reports > Reports Snapshot List**.

11  Click **Add**.

12  Take one of the following actions:

- Click **Add Schedule**  
  To add another schedule
- Click **close**  
  To return to the **Reports** tab
Chapter 28. Integrating Workflow with the Symantec Management Platform
Chapter 29. Integrating Workflow with Active Directory
Chapter 30. Integrating Workflow with SharePoint
Chapter 31. Integrating Process Manager
Integrating Workflow with the Symantec Management Platform

This chapter includes the following topics:

- About Workflow and the Symantec Management Platform
- Workflow Enterprise Management page
- Default security roles
- Adding a new security role
- About Deployment Server connection settings

About Workflow and the Symantec Management Platform

The Symantec Management Platform architecture consists of several key parts. These parts include the CMDB, Item Object Model, Resource Model, Solution Layer, UI Framework, and ASDK (Altiris Software Development Kit). Workflow interacts with the platform through a web service layer and the custom web services that are installed directly onto the Symantec Management Platform computer.

However, not all workflow processes directly integrate with the Symantec Management Platform. A workflow process may only depend on the platform for a license for the instance of Workflow Server where it is running.

A workflow process can integrate more fully with the Symantec Management Platform or another solution by using web service calls. A workflow process can
work with any standard web service in the Symantec Management Platform or solutions. For example, a process that escalates a ServiceDesk incident can make a web service call to ServiceDesk to change the priority, affect, or urgency.

### Table 28-1 Key interactions between Workflow and the Symantec Management Platform

<table>
<thead>
<tr>
<th>Interaction</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow Servers in the Symantec Management Console</td>
<td>All Workflow Servers should be registered in the Symantec Management Console. You can view registered servers in the console. Registered servers are listed under <strong>Settings &gt; All Settings</strong>, and then in the left pane <strong>Service and Asset Management &gt; Workflow &gt; Manage Workflow Servers</strong>.</td>
</tr>
<tr>
<td>Published workflows in the Symantec Management Console</td>
<td>When you publish a workflow, you can optionally publish it to the Symantec Management Console. The workflow gets published to Workflow Server, but it also appears in the console as one of three items: right-click action, task, or item. All of the workflows that are published to the console appear under <strong>Settings &gt; All Settings</strong>, then <strong>Notification Server</strong>, and then <strong>Published Workflows</strong>. All published workflows fall into one of two categories: Dialog Workflows and Service Workflows. You can invoke a published workflow by right-clicking the workflow and clicking <strong>Open</strong>. Dialog Workflows display a form in the right pane. Service Workflows display only workflow settings.</td>
</tr>
<tr>
<td>Enterprise Management</td>
<td>The Workflow Enterprise Management page in the Symantec Management Console lets you manage Workflow environments, servers, and processes. From this page you can create and configure new environments, publish Workflow processes to servers, and manage all of these interactions. In the Symantec Management Console, the Workflow Enterprise Management page is located in <strong>Manage &gt; Workflows</strong>.</td>
</tr>
</tbody>
</table>

### About how Workflow connects to the Symantec Management Platform

Workflow does not require a connection to the Symantec Management Platform to work. You can open Workflow Manager and create workflow projects without a connection to the Symantec Management Platform.

To connect Workflow to the platform, install Workflow in the same domain in which Symantec Management Platform is installed. During Workflow installation, map the
Workflow Server to the platform so that the platform service account has access
to the target Workflow Server computer.

See “Installing Workflow” on page 74.

Workflow projects that connect to a Symantec Management Platform computer
store the credentials for the connection in their global data.

See “Global Data tab” on page 169.

You can set credentials for the connection in several locations.

Table 28-2 Locations where you can set Symantec Management Platform
credentials

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow installation</td>
<td>You can set Symantec Management Platform credentials when you install Workflow. When you set credentials during installation, the credentials are automatically added to Credentials Manager. See &quot;About Credentials Manager&quot; on page 603.</td>
</tr>
<tr>
<td>Credentials Manager</td>
<td>You can add new credentials or edit old credentials in Credentials Manager. See “About Credentials Manager” on page 603.</td>
</tr>
<tr>
<td>Components in a workflow project</td>
<td>You can set Symantec Management Platform credentials with individual components in a workflow project. For example, the Create Notification Server Credentials component creates credentials for the Symantec Management Platform. Other Symantec Management Platform components (such as Create Purchase Request) have a tab in their component editors that lets you set credentials. You can set different components to connect to different Symantec Management Platform computers. Even if Credentials Manager is set to a different default Symantec Management Platform computer, the settings in the component overrule.</td>
</tr>
</tbody>
</table>

See “About design-time and run-time Symantec Management Platform credentials” on page 572.
### Setting up your first use of Workflow Designer with the Symantec Management Platform

When you first install Workflow Designer on a computer, all of the Symantec integration facilities are included. However, some configuration is required before Workflow Designer can use all of the Symantec Management Platform features.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Create Symantec Management Platform credentials in Credentials Manager</td>
<td>Workflow Designer must have a connection to a licensed Symantec Management Platform computer to access licensed features such as publishing a project. This connection is configured in Credentials Manager. See “Adding credentials in Credentials Manager” on page 604. These settings are also set during installation.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Run the Symantec Management Platform component generators</td>
<td>If your Symantec Management Platform has only default resources, ASDK Web services (and methods), reports, and tasks, then you do not need to run the Symantec Management Platform component generators. Workflow Designer has components for all standard interactions with the Symantec Management Platform. However, if you have customized resources, ASDK Web services (and methods), reports, and tasks, you should run the component generators. See “Running the Symantec Management Platform component generators” on page 573.</td>
</tr>
</tbody>
</table>
Table 28-3 Process for setting up your first use of Workflow Designer with the Symantec Management Platform (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 3</td>
<td>Importing components into a workflow project</td>
<td>This step is specific to an individual project. For each project you must import any non-default component libraries that you want to use. For example, if you want your project to work with NetBackup, import the Symantec.Component.NetBackup.dll library. See “Importing components into a project” on page 215.</td>
</tr>
</tbody>
</table>

The resource components are already available, but to have the task and reporting components, their generators need to be run. The number of components that are created from this process correspond to the tasks and reports that are available on the Symantec Management Console.

The component generators are Integration projects. The following tasks walk you through adding the project through Workflow Designer and running the generator to create the components; regardless of the generator run, the process is the same.

When you use Workflow Designer for the first time, the Task, ASDK, and Report generators need to be run to load components into the component toolbox from the tasks, ASDK methods, and reports available on the Symantec Management Console. Due to the number of potential components added, these generators are not run during installation.

See “Creating a new integration project” on page 247.

See “About design-time and run-time Symantec Management Platform credentials” on page 572.

About design-time and run-time Symantec Management Platform credentials

Design-time refers to the period in the lifecycle of a workflow project when the project is built and tested. Run-time refers to the period in a workflow project's lifecycle when it is running in a production environment. For any project that connects to the platform Symantec recommends using different Symantec Management Platform computers during design-time and run-time. During design-time, Symantec recommends that you use a testing Symantec Management Platform. During
run-time, Symantec recommends that you use a production Symantec Management Platform.

You do not want to connect to production computers as you build workflows. When you have different design-time and run-time Symantec Management Console credentials, you can safely design workflows in a test environment. Having different design-time and run-time credentials also lets you safely run workflows in your production environment.

You can configure Symantec Management Platform credentials in a number of locations.

See “About how Workflow connects to the Symantec Management Platform” on page 569.

You do not need to configure two sets of credentials in Credentials Manager on your development computer and your testing computer. For your development computer and your testing computer, set Credentials Manager to connect to a testing Symantec Management Platform computer. The testing platform computer should be as similar as possible to your production platform computer so that your testing produces realistic results. For your production computer, set Credentials Manager to connect to a production Symantec Management Platform computer.

Every project that connects to a Symantec Management Platform computer stores its connection information in global data variables.

See “Global Data tab” on page 169.

These global variables get their values from the local instance of Credentials Manager. Any project that is published to a production Workflow Server uses production Symantec Management Platform credentials. Any project that is published to a development Workflow Server and a testing Workflow Server uses testing Symantec Management Platform credentials.

Running the Symantec Management Platform component generators

You do not need to run the Symantec Management Platform component generators in a Symantec Management Platform environment that has only default resources, ASDK Web services, reports, and tasks. By default, Workflow Designer has components for all default Symantec Management Platform resources. However, if you have customized resources, ASDK Web services, reports, or tasks, you must run the component generators.

Workflow Designer contains many hand-coded Symantec components. Most are available when Workflow Designer is installed; however, some can only be run based on the data from your Symantec Management Console. This data comes from resources, tasks, reports, and the ASDK on the Symantec Management
Console. Workflow Designer provides the component generators that generate custom libraries of Symantec components based on this data.

Workflow Designer has four Symantec component generators. Each component generator builds or rebuilds custom libraries. When default resources, ASDK Web services, reports, or tasks are modified, you should run the generators again. If a new task instance is created for the Symantec Management Platform, the corresponding component is unavailable for use in a workflow project until the Task Generator runs again.

Each time you run the Symantec Management Platform component generators, the existing component libraries are overwritten by the new ones. You can also create versions of the component libraries in the repository.

See “About the Workflow Repository” on page 138.

See “Symantec workflow component generators” on page 261.

To run the Symantec Management Platform component generators

1. In Workflow Manager, click on the Local folder, and then click New.
2. Select the Integration project type.
3. Enter a name for the new component library, and then click OK.
4. Select the Symantec Management Platform generator that you want to run, and then click OK.
5. If you chose the Report Component generator, select the configuration that you want to find the reports you want to generate.
6. Complete the component generator wizard.
7. Click Recompile and Close.

The components that are generated are saved as custom libraries. Import these libraries into a project to use them.

8. Repeat these steps for each generator that you want to run.

**Workflow Enterprise Management page**

This page in the Symantec Management Console lets you manage Workflow environments, servers, and processes. From this page you can create and configure new environments, register Workflow Servers, publish Workflow processes to Workflow Servers, and manage all of these interactions. In the Symantec Management Console, the Workflow Enterprise Management page is located in Manage > Workflows.

See “About Workflow and the Symantec Management Platform” on page 568.
The **Workflow Enterprise Management** page requires the following solutions:

- CMDB
- Software Management Solution

**Table 28-4** Tabs on the Workflow Enterprise Management page

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment</td>
<td>On this page you can create new environments, edit existing environments, delete environments. You can also add Workflow Servers to or remove Workflow Servers from environments and register Workflow Servers. This page lists all of the available environments and shows you information and a graphical representation of any environment that you select.</td>
</tr>
<tr>
<td>Workflow Servers</td>
<td>On this page you can register Workflow Servers, publish workflows to Workflow Servers, remove workflows from Workflow Servers, and edit project and application properties. This page lists all of the available Workflow Servers and shows you information and a graphical representation of any server that you select. To Register a Workflow Server, both the Workflow Server and Symantec Management Platform must reside in the same domain. The Workflow Server and the Symantec Management Platform service account must have access to each other. See “Installing Workflow” on page 74.</td>
</tr>
<tr>
<td>Published Workflows</td>
<td>On this page you can view all of the published workflows.</td>
</tr>
<tr>
<td>Repository</td>
<td>On this page you can view all of the available Projects, component libraries, and applications.</td>
</tr>
</tbody>
</table>

See “**Workflow Enterprise Management Environment page**” on page 576.
See “**Workflow Enterprise Management Workflow Servers page**” on page 583.
See “**Workflow Enterprise Management Published Workflows page**” on page 587.
See “**Workflow Enterprise Management Repository page**” on page 587.
About Workflow environments

Workflow environments are logical groupings of the Workflow Server computers that you register in the Enterprise Management page in the Symantec Management Console. Workflow environments do not refer to any hardware or software that is related to Workflow. Workflow environments are only the organizational groups that you create to manage your Workflow Server computers and workflow projects.

See “Workflow Enterprise Management Environment page” on page 576.

You can create different types of environments for different purposes. For example, you can create an environment for only testing purposes. Or, you can create a production environment. Create an environment when you need to manage multiple Workflow Server computers that work together.

Workflow environments are either managed or unmanaged.

**Managed environments**

Managed environments are usually used as production environments. Designers can publish projects to managed environments only through the Enterprise Management page.

**Unmanaged environments**

Unmanaged environments are usually used as testing environments. Designers can publish projects directly from Workflow Designer to unmanaged environments.

**Workflow Enterprise Management Environment page**

This page in the Symantec Management Console lets you create new environments and edit existing environments. You can also delete environments, add servers to environments, and remove servers in this page. In the Symantec Management Console, this page is located under Manage > Workflows > Workflow Enterprise Management.

See “Workflow Enterprise Management page” on page 574.

**Table 28-5** 
Headings in the left pane of the Environment page

<table>
<thead>
<tr>
<th>Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Environment</td>
<td>Creates a new environment.</td>
</tr>
<tr>
<td></td>
<td>See “Adding a Workflow Environment” on page 578.</td>
</tr>
<tr>
<td>Environments</td>
<td>Lists all available environments.</td>
</tr>
<tr>
<td>Classification</td>
<td>Lists all available classifications. Classification refers to a logical grouping of environments.</td>
</tr>
</tbody>
</table>
Table 28-6 Options in the top right pane of the Environment page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Environment</td>
<td>Edits the selected environment. You edit all of the settings for the environment as if for the first time.</td>
</tr>
<tr>
<td></td>
<td>See “Editing a Workflow Environment” on page 579.</td>
</tr>
<tr>
<td>Delete Environment</td>
<td>Deletes the selected environment.</td>
</tr>
<tr>
<td></td>
<td>See “Deleting a Workflow Environment” on page 582.</td>
</tr>
<tr>
<td>Validate Environment</td>
<td>Determines whether the environment is valid, or if it has missing servers, missing processes, or some other conflict that could disrupt operation.</td>
</tr>
<tr>
<td></td>
<td>See “Validating a Workflow Environment” on page 581.</td>
</tr>
<tr>
<td>Add Server</td>
<td>Adds an existing server to the selected environment.</td>
</tr>
<tr>
<td></td>
<td>See “Adding a server to a Workflow Environment” on page 582.</td>
</tr>
<tr>
<td></td>
<td>To install (register) a Workflow Server, both the Workflow Server and Symantec Management Platform must reside in the same domain. The Workflow Server and the platform service account must have access to each other.</td>
</tr>
<tr>
<td></td>
<td>See “Installing Workflow” on page 74.</td>
</tr>
<tr>
<td>Remove Server</td>
<td>Removes a server from the selected environment.</td>
</tr>
<tr>
<td></td>
<td>See “Removing a server from a Workflow Environment” on page 583.</td>
</tr>
<tr>
<td>Set As Default PM</td>
<td>Lets you set a default Process Manager server. If you have multiple Process Manager servers in one environment only one can be default.</td>
</tr>
</tbody>
</table>

When you select an environment in the left pane, you see information about the environment in the right pane. Each server in the environment has a representative icon and a series of smaller symbols that represent the software that is installed. For example, SQ represents SQL Server and PM represents Process Manager. The top right pane also displays whether the environment is valid and managed. The bottom right pane displays all of the workflows that are published on the selected environment.
Adding a Workflow Environment

On the Workflow Enterprise Management page in the Symantec Management Console, under the Environment tab you can add a new Workflow Environment. When you add a new Workflow Environment, you create a new logical grouping of Workflow Server computers. For example, you can add a Workflow Environment for testing purposes.

Workflow Environments are only organizational categories; they do not necessarily correspond to any hardware.

See “Workflow Enterprise Management Environment page” on page 576.

To add a Workflow Environment

1. In the Symantec Management Console, click Manage > Workflows > Workflow Enterprise Management.
2. Click the Environments tab.
3. Click Add Environment.
4. In the Add Environment dialog box, configure the environment settings.

The environment settings are as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of your environment. Name your environment based on its function. For example, if you set up an environment for a testing team, you can call the environment Testing Team 1.</td>
</tr>
<tr>
<td>Classification</td>
<td>The classification of your environment. Classification refers to a logical grouping of environments. You can see all of the available classifications by clicking the Classification header at the bottom of the left pane. You can filter environments when you click on a classification.</td>
</tr>
<tr>
<td>Publishing Approval Email</td>
<td>The email address of the administrator who approves permission to publish to a managed environment. The option is used when a user does not have the required permission to publish to a managed environment.</td>
</tr>
</tbody>
</table>
### Color
The background color of the page when you view your environment. Use colors as visual reminders of which environment you view. For example, use blue for all testing environments, and use red for your production environment.

### Is Managed
Sets whether this environment is managed in the Workflow Enterprise Management page.

### Is Auto Publishing Target
Sets whether this environment is an auto publishing target. When you publish a workflow, it is published to all auto publishing targets.

### Send Outage Notification
If this option is checked, all the servers in the environment are periodically pinged to see if they are running. Anytime they do not respond, an email is sent out.
- **Email To** - The email address to which you want to send the email.
- **Email From** - The return email address.
- **SMTP Server** - The SMTP server that handles the email.
- **Outage Notification Interval (min.)** - How often in minutes the servers are checked.

5 Click **Add**.

### Editing a Workflow Environment
This page in the Symantec Management Console lets you edit an existing Workflow Environment.

When you edit an environment, you can edit all of the settings for the environment as if for the first time.

See “Workflow Enterprise Management Environment page” on page 576.

To edit a Workflow Environment

1 In the Symantec Management Console, click **Manage > Workflows > Workflow Enterprise Management**.

2 Click the **Environments** tab.

3 Under the **Environments** header, click the environment that you want to edit.

4 Click **Edit Environment**.

5 Edit the environment settings.
The environment settings are as follows:

**Name**

The name of your environment.

Name your environment based on its function. For example, if you set up an environment for a testing team, call the environment *Testing Team 1*.

**Classification**

The classification of your environment.

Classification refers to a logical grouping of environments. You can see all of the available classifications by clicking the Classification header at the bottom of the left pane.

You can filter environments when you click on a classification.

**Publishing Approval Email**

The email address of the administrator that approves permission to publish to a managed environment. The option is used when a user does not have the required permission to publish to a managed environment.

**Color**

The background color of the page when you view your environment. Use colors as visual reminders of which environment you view. For example, use blue for all of your testing environments, and use red for your production environment.

**Is Managed**

Sets whether this environment is managed in the Workflow Enterprise Management page.

**Is Auto Publishing Target**

Sets whether this environment is an auto publishing target. When you publish a workflow, it is published to all auto publishing targets.
Send Outage Notification

If this option is checked, all the servers in the environment are periodically pinged to see if they are running. Anytime they do not respond, an email is sent out.

- **Email To** - The email address to which you want to send the email.
- **Email From** - The return email address.
- **SMTP Server** - The SMTP server that handles the email.
- **Outage Notification Interval (min.)** - How often in minutes the servers are checked.

6  Click Add.

Validating a Workflow Environment

The validation feature is meant to show what can potentially be problematic in functioning of your environment. For example, an environment could show up as invalid if only one server in the environment can have background processing on it.

To validate a Workflow Environment

1  In the Symantec Management Console, click Manage > Workflows.
2  Click the Environment tab.
3  Click Validate Environment.
4  Depending on the result of validation, do one of the following:

   If environment is validated
   Click OK.

   If environment is not validated
   A text in Validation Errors window tells why an environment is invalid.
   Read carefully the description of the problems and estimate what you can correct.
   Click Close.
   **Note:** Depending on issue you can still deploy workflows to an invalid environment.

See “Workflow Enterprise Management Environment page” on page 576.
Deleting a Workflow Environment

This page in the Symantec Management Console lets you delete an existing Workflow Environment.

See “Workflow Enterprise Management Environment page” on page 576.

To delete a Workflow Environment

1. In the Symantec Management Console, click Manage > Workflows > Workflow Enterprise Management.
2. Click the Environment tab.
3. Under the Environments header, click the environment that you want to delete.
4. Click Delete Environment.

Adding a server to a Workflow Environment

This page in the Symantec Management Console lets you add a server to a Workflow Environment.

When you add a server to a Workflow Environment, the server is managed as part of the environment.

See “Workflow Enterprise Management Environment page” on page 576.

To add a server to a Workflow Environment

1. In the Symantec Management Console, click Manage > Workflows > Workflow Enterprise Management.
2. Click the Environment tab.
3. Under the Environments header, click the environment to which you want to add a server.
4. Click Add Server.
5. Click one of the available servers, and then click Add.

Registering a Server

If you plan to set up a Workflow Server as a deployment target, it must be registered in the Workflow Enterprise Management console. You can register a Workflow Server by using the Register Server option on the Workflow Enterprise Management page.

Registering interrogates the computer to find out which roles are installed. The roles (for example, Process Manager Portal) are selected during the Workflow Server and Designer installation process. A registered server that is not in a managed
environment can be a deployment target from Workflow Designer even if it is remote. They are listed as standalone on the Workflow Designer deployment wizard.

Any processes that are currently published to a newly-registered Workflow Server are not automatically added to the **Published Workflows** list. The Enterprise Manager only recognizes the processes that originate from the Repository, and are published to a managed environment. Thus only processes meeting those criteria appear in the **Published Workflows** list.

**Removing a server from a Workflow Environment**

This page in the Symantec Management Console lets you remove a server from a Workflow Environment.

When you remove a server from a Workflow Environment, the server is no longer managed as part of the environment. When you remove a server from an environment, you do not delete it from the list of available servers.

See “**Workflow Enterprise Management Environment page**” on page 576.

**To remove a server from a Workflow Environment**

1. In the Symantec Management Console, click **Manage > Workflows > Workflow Enterprise Management**.
2. Click the **Environment** tab.
3. Under the **Environments** header, click the environment from which you want to remove a server.
4. In the right pane, click the server that you want to remove.
5. Click **Remove Server**.

**Workflow Enterprise Management Workflow Servers page**

This page in the Symantec Management Console lets you register Workflow Servers. You can also publish workflows to servers, remove workflows from servers, and edit project properties and application properties in this page. In the Symantec Management Console, this page is located under **Manage > Workflows > Workflow Enterprise Management > Workflow Servers**.

See “**About Workflow and the Symantec Management Platform**” on page 568.

This page lists all of the available Workflow Servers, and it shows you information and a graphical representation of any server that you select.

See “**Workflow Enterprise Management page**” on page 574.
To register a Workflow Server, both the Workflow Server and Symantec Management Platform must reside in the same domain. The Workflow Server and the platform service account must have access to each other.

See “Installing Workflow” on page 74.

**Table 28-7**  
Headings in the left pane of the Workflow Servers page

<table>
<thead>
<tr>
<th>Headings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Sets which computers displays, by role. For example, if you select only Workflow Server, computers with only Workflow Server display.</td>
</tr>
<tr>
<td>Servers</td>
<td>Lists all available servers.</td>
</tr>
</tbody>
</table>

**Table 28-8**  
Options in the top right pane of the Workflow Servers page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Details</td>
<td>Displays the information about the selected server in Resource Manager in the Symantec Management Console.</td>
</tr>
<tr>
<td>Publish Workflow</td>
<td>Publishes a workflow to the selected server. See “Publishing a workflow on the Workflow Enterprise Management page” on page 585.</td>
</tr>
<tr>
<td>Unpublish Workflow</td>
<td>Removes a published workflow from the selected server. See “Unpublishing a workflow on the Workflow Enterprise Management page” on page 585.</td>
</tr>
<tr>
<td>Update Project Properties</td>
<td>Lets you edit the project properties of the selected workflow. See “Updating the project properties of a workflow on the Workflow Enterprise Management page” on page 586.</td>
</tr>
<tr>
<td>Edit Application Properties</td>
<td>Lets you edit the application properties in the Process Manager of the selected server. If the selected server does not have Process Manager installed, you cannot edit the application properties. See “Updating the application properties of a Workflow Server on the Workflow Enterprise Management page” on page 586.</td>
</tr>
</tbody>
</table>

When you select a Workflow Server in the left pane, you see information about it in the right pane. Each server has a representative icon and a series of smaller
symbols representing software that is installed. For example, SQ represents SQL Server and PM represents Process Manager.
The bottom right pane displays all of the workflows that are published on the selected server.

Publishing a workflow on the Workflow Enterprise Management page

The Workflow Enterprise Management page in the Symantec Management Console lets you publish a workflow to an existing Workflow Server.
See “About Workflow and the Symantec Management Platform” on page 568.
See “Workflow Enterprise Management Workflow Servers page” on page 583.

To publish a workflow

1. In the Symantec Management Console, click Manage > Workflows > Workflow Enterprise Management.
2. Click the Workflow Servers tab.
3. Click on the server to which you want to publish a workflow.
4. Click Publish Workflow.
5. Configure the installation settings.
   For more information on installation settings, see the following topics:
   See “Installing Workflow” on page 74.
6. Click Install.

Unpublishing a workflow on the Workflow Enterprise Management page

The Workflow Enterprise Management page in the Symantec Management Console lets you unpublish a workflow.
See “Workflow Enterprise Management Workflow Servers page” on page 583.

To unpublish a workflow

1. In the Symantec Management Console, click Manage > Workflows > Workflow Enterprise Management.
2. Click the Workflow Servers tab.
3. Click on the server that has the workflow that you want to unpublish.
4 Click the workflow that you want to unpublish.
5 Click Unpublish Workflow.

Updating the project properties of a workflow on the Workflow Enterprise Management page

The Workflow Enterprise Management page in the Symantec Management Console lets you update the project properties of a workflow. You can also edit these properties in an open workflow project in Workflow Designer.

See “Workflow Enterprise Management Workflow Servers page” on page 583.

To update the project properties of a workflow

1 In the Symantec Management Console, click Manage > Workflows > Workflow Enterprise Management.
2 Click the Workflow Servers tab.
3 Click on the server that has the workflow that you want to edit.
4 Click the workflow that you want to edit.
5 Click Update Project Properties.
6 Click Continue.
7 Edit the values.
   If you click one of the arrow options, the value in that box moves into the Value box.
8 When you are finished editing the values, click Update.

Updating the application properties of a Workflow Server on the Workflow Enterprise Management page

The Workflow Enterprise Management page in the Symantec Management Console lets you update the application properties of a Workflow Server. You can also edit these application properties in Process Manager.

Only servers with Process Manager installed have application properties. If a server does not have Process Manager installed, the Update Application Properties option is disabled.

See “Workflow Enterprise Management Workflow Servers page” on page 583.

See “About project properties” on page 191.
To update the application properties of a Workflow Server

1. In the Symantec Management Console, click Manage > Workflows > Workflow Enterprise Management.

2. Click the Workflow Servers tab.

3. Click on the server that you want to edit.

4. Click Update Application Properties.

   Process Manager opens, showing the application properties.

5. Edit the properties in Process Manager.

Workflow Enterprise Management Published Workflows page

This page in the Symantec Management Console lets you view all of the workflows that have been published through the Workflow Enterprise Management page. In the Symantec Management Console, this page is located under Manage > Workflows > Workflow Enterprise Management > Published Workflows.

This page lists all of the available Workflow Servers, and shows you information and a graphical representation of any server you select.

See “Publishing a workflow on the Workflow Enterprise Management page” on page 585.

See “Workflow Enterprise Management page” on page 574.

Table 28-9 Options in the left pane of the Workflow Servers page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Sets which workflows display by project type. For example, if you select only Decision, only Decision-type workflows display.</td>
</tr>
<tr>
<td>Servers</td>
<td>Lists all of the available workflows.</td>
</tr>
</tbody>
</table>

Workflow Enterprise Management Repository page

This page lets you view existing workflow projects, component libraries, and applications. The workflow repository operates through the Enterprise Management page on the Symantec Management Platform computer.

See “Workflow Enterprise Management Environment page” on page 576.

You can only view projects, component libraries, and applications on this page. You cannot edit these items from the repository. You can access the repository from any computer with access to the Symantec Management Platform computer.
Default security roles

In the Symantec Management Console, Workflow has three default security roles:

- **Workflow Admin Users**
- **Workflow Publishing Users for Managed Environments**
- **Workflow Repository Users**

After you install Workflow Solution, the administrator should add users and groups as members to the security roles. This grants specific privileges to the Enterprise Manager and repository functions. A new role can be created with any combination of the privileges.

**Admin** This role has the most privileges granted. It has full access to the repository, and full access to the Enterprise Manager functions, which includes the ability to publish workflows to managed environments.

**Workflow Publishing Users for Managed Environments** This role allows users to publish to a managed environment in the Enterprise Management Deployment plug-in from the Designer.

When a user does not have this permission, the user can still select a managed environment as a deployment target from the Designer. However, in this case an approval step is added.

**Workflow Repository Users** This role allows users to use the repository functions, such as checking in and out.

A new role can be created with any combination of the privileges.

See “Adding a new security role” on page 589.

**Table 28-10** Privileges that are available for creating new security roles and that involve Workflow functions

<table>
<thead>
<tr>
<th>Privilege category</th>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow Enterprise Management</td>
<td>Access Workflow Enterprise Management</td>
<td>Enables the users to access the workflow enterprise management page. Additional permissions and privileges are required to perform actions.</td>
</tr>
<tr>
<td>Workflow Enterprise Management</td>
<td>Manage Workflow Environments</td>
<td>Enables the users to add, edit, validate, and delete Workflow environments.</td>
</tr>
</tbody>
</table>
Table 28-10  Privileges that are available for creating new security roles and that involve Workflow functions (continued)

<table>
<thead>
<tr>
<th>Privilege category</th>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workflow Enterprise Management</td>
<td>Manage Workflow Servers</td>
<td>Enables the users to add and remove Workflow Servers.</td>
</tr>
<tr>
<td>Workflow Enterprise Management</td>
<td>Publish Workflows to Managed Environments</td>
<td>Enables the users to publish workflows to managed environments.</td>
</tr>
<tr>
<td>Workflow Repository</td>
<td>Access Workflow Repository</td>
<td>Enables the users to access the workflow repository.</td>
</tr>
<tr>
<td>Workflow Repository</td>
<td>Can Create Repository Folders</td>
<td>Enables the users to create repository folders.</td>
</tr>
<tr>
<td>Workflow Repository</td>
<td>Can Unlock Repository Projects</td>
<td>Enables the users to unlock repository projects.</td>
</tr>
<tr>
<td>Workflow Repository</td>
<td>Can Check In</td>
<td>Enables the users to check in projects/libraries/applications/portal elements to repository.</td>
</tr>
<tr>
<td>Workflow Repository</td>
<td>Can Delete</td>
<td>Enables the users to delete projects/libraries/applications/portal elements from repository.</td>
</tr>
</tbody>
</table>

See “About Workflow environments” on page 576.

Adding a new security role

You can create a new role with any combination of privileges.

See “Default security roles” on page 588.

To add a new security role

1. In the Symantec Management Console, click Settings > Security > Account Management.
2. In the left pane, expand Account Management and click Roles.
3. In the right pane, click Add.
4. In the New Role dialog box, type the name for the new role.
5. Click OK.
6. In the right pane, select the role that you added.
7 In the right pane, on the **Privileges** tab, select the privileges that you need.

8 Click **Save Changes**.

### About Deployment Server connection settings

Your workflows can use Deployment Server functionality by using deployment components. Before you use deployment components, you should set up design-time Deployment Server connection settings. Run-time Deployment Server connection settings are set using deployment components.

See “About design-time and run-time Deployment Server connection settings” on page 590.

See “Setting and editing design-time Deployment Server connection settings” on page 591.

See “Configuring run-time Deployment Server connection settings” on page 592.

### About design-time and run-time Deployment Server connection settings

Your workflow uses different Deployment Server connection settings at design-time and at run-time. You do not connect to production computers while you build workflows. Different design-time and run-time Deployment Server connection settings let you safely design workflows in a test environment and run workflows in your production environment.

The design-time and run-time Deployment Servers can be the same Deployment Server. The design-time and run-time Deployment Servers should be very similar or identical Deployment Servers. Generally, your design-time Deployment Server should be in a test environment. Therefore, we recommend that the Deployment Server in your test environments a clone of the Deployment Server in your production environment.

The only way to set run-time connection settings for a workflow is through the variables that are exposed and declared inside of the workflow process.

Design-time and run-time connection settings are as follows:

- All of the deployment components use the connection settings in the Deployment Server Connections plug-in at design-time.

- Deployment components use the connection settings that are in the Create DS Connection Profile component at run-time. This component lets you use the connection settings from the Deployment Server Connections plug-in (by default). You can also use connection settings for another Deployment Solution in this
component. This option lets you use another Deployment Server for run-time instead of the one that the plug-in uses.

- Each deployment component can override the run-time connection settings in the component that you use to create a DS connection profile. This option lets you use multiple Deployment Servers in your workflow.

After you install Workflow, you can set up design-time Deployment Server connection settings.

The Deployment Server that you configure at this time has no effect on workflows at run-time. Workflow Designer uses the Deployment Server during workflow design only. When a project is opened, it recognizes the default design-time Deployment Server connection settings. Deployment components use these connection settings to get required data from Deployment Server during workflow design.

These Deployment Server connection settings can be passed to the Create DS Connection Profile component. This component is used for run-time Deployment Solution connection settings.

See “Setting and editing design-time Deployment Server connection settings” on page 591.

At run-time, every deployment component that communicates with Deployment Server needs run-time Deployment Server connection settings.

Use the Create DS Connection Profile component to set up communication. Place the component before you use any deployment components. The other components that communicate with Deployment Server use the connection settings that you place in this component. You can change these credentials in any deployment component and use multiple Deployment Servers in a single project. You can have multiple components for creating DS connection profiles in a workflow.

Each deployment component has a Deployment Server tab for configuring run-time Deployment Server connection settings for that component. This tab has a DS Connection Profile option and lets you set DS credentials. The connection profile and credentials can come from the variables that you set in the component that you use to create a DS connection profile. The profile and credentials can also come from another variable, a dynamic value, or a constant value.

See “Configuring run-time Deployment Server connection settings” on page 592.

Setting and editing design-time Deployment Server connection settings

During development, or design-time, default Deployment Server connection settings need to be established if you use deployment components. More than one set of
connection settings can be established. However, only one can be designated as the default design-time Deployment Server connection settings.

See “About design-time and run-time Deployment Server connection settings” on page 590.

To set Deployment Server connection settings for workflow design

1. Open Workflow Explorer, and in the toolbar at the top of the page, click **Credentials**.
2. In the left pane, click **Deployment Server**.
3. In the **Deployment Server** pane, click **Add New Connection**.
4. In the **New DS Connections Profile** dialog box, check **Is Security Enabled** if security is enabled on the Deployment Server.
5. In the **Default Credentials** box, click the **ellipse** to configure the settings.
6. In the **Edit Object** dialog box, type **Username**, **Password**, **Domain** for connecting to the Internet.
   
   The credentials that you enter should be to a default administrator account on Deployment Server.
7. Click **OK**.

To edit a Deployment Server connection setting

1. Select a credential row, click **Edit**, and change the values.
2. Click **OK**.

To remove a Deployment Server connection

1. Select a credential row.
2. Click **Delete**.

Configuring run-time Deployment Server connection settings

Each deployment component picks up default run-time connection settings to connect to Deployment Server. The default connections can also be overwritten by individual components.

See “About design-time and run-time Deployment Server connection settings” on page 590.

To configure run-time Deployment Server connection settings

1. In Workflow Designer, right-click on a deployment component and select **Edit Component**.
2. Click the **Deployment Server** tab.
3 To override the DS connection profile for this component, do the following in order:
   ■ In the DS Connection Profile box, click the ... symbol.
   ■ Type or select the DS connection profile as either a Constant Value, Dynamic Value, Dynamic Model, or Process Variable.
   ■ Click OK.

4 To set the DS credentials variable for this component, do the following in order:
   ■ In the DS Credentials box, click the ... symbol.
   ■ Type or select the DS credentials override variable as either a Constant Value, Dynamic Value, Dynamic Model, or Process Variable.
   ■ Click OK.

5 Click OK.
Integrating Workflow with Active Directory

This chapter includes the following topics:

- Integrating Active Directory with a workflow process

Integrating Active Directory with a workflow process

Your workflow process must be integrated with Active Directory before the two systems can work together.

See “About using Active Directory with Process Manager” on page 505.

To integrate Active Directory with a workflow process

1. In your open project, import the Active Directory DLL into your process.
   
   To import the DLL, in your open project, click **Import Components > Active Directory.dll > Add > OK**.

2. In the left panel, click the name of your project.
   
   The name of your project is the top item in the tree structure.

3. Click the **Properties** tab.


   If these properties do not appear in the property list, add a Dialog Workflow component to your process and set it to use the **ActiveDirectoryTaskSource**. The properties are generated automatically. If you do not know how to configure these properties, talk to your network administrator.
Integrating Workflow with SharePoint

This chapter includes the following topics:

- Making a task list from Process Manager appear in SharePoint

Making a task list from Process Manager appear in SharePoint

You can integrate Process Manager with SharePoint so that a task list from Process Manager appears in a SharePoint page. You cannot import the Process Manager Web Part directly into SharePoint. However, you can use a SharePoint Web Part to display a Process Manager task list.

See “About Process Manager and tasks” on page 388.

To make a task list from Process Manager appear in SharePoint

1. In SharePoint, create a new Web Part page to display the Process Manager task list.
2. Add a Page Viewer Web Part to the page.
3. Configure the Web Part to use the following URL:
   
   `http://localhost/ProcessManager/WorkflowTasks/AJAXWorkflowTaskList.aspx?notabs=1&sidebar=false`

   You may have to change this URL if you customized your Process Manager.
Integrating Process Manager

This chapter includes the following topics:

- About Process Manager integration
- Integrating Process Manager with Workflow Designer
- About integrating Process Manager with Active Directory information

About Process Manager integration

Process Manager integrates seamlessly with applications such as Workflow Designer and Active Directory. This section examines integration procedures and issues.

See “Integrating Process Manager with Workflow Designer” on page 596.

See “About integrating Process Manager with Active Directory information” on page 597.

See “Setting up workflow task integration between Workflow Designer and Process Manager” on page 436.

Integrating Process Manager with Workflow Designer

You can integrate Process Manager with Workflow Designer to increase functionality.

See “About Process Manager integration” on page 596.

To integrate Process Manager with Workflow Designer

1. On the task tray, right-click the task tray application and select Settings.
2. Select the Process Manager server that you want to integrate and click Edit.
3 In the Process Manager section, in the Port Number box, enter 80.
   The default port is 11080; the internal web server uses this port. To use the Process Manager in production, change the port number to 80.

4 Click OK.

5 In Workflow Designer, click Tools > Edit Preferences.

6 From the list in the left pane, select Process Manager.

7 In the right pane, enter the actions that you want.
   See “About Process Manager pages” on page 387.

8 Click OK.

9 If you want to use the Process View page in Process Manager, set up Workflow task integration.
   See “Setting up workflow task integration between Workflow Designer and Process Manager” on page 436.

### About integrating Process Manager with Active Directory information

When you enable Active Directory authentication for Process Manager, you can manage your Process Manager user information in Active Directory. You can also import that information into Process Manager automatically.

See “About Process Manager integration” on page 596.

You can configure Process Manager to synchronize with Active Directory on a schedule. The Active Directory synchronization occurs in Workflow. When Process Manager installs, you can base the user and the group assignments on your Active Directory configuration. You set up this configuration when you set up your Active Directory authentication. In addition to the scheduled synchronization, you can also add new users from Active Directory manually. You can use this manual method when you want to give a user access to Process Manager without waiting until the next scheduled synchronization.

Users that are in Active Directory, but that have not yet been added to Process Manager, can still access Process Manager. For example, a user may exist in Active Directory and attempt to log on to Process Manager. If that user is not recognized, Process Manager looks up the user in Active Directory and adds the user as a Process Manager user.
When synchronization occurs, the user and the group data that is stored in Active Directory overwrites the user and the group data in Process Manager. When you work with data from Active Directory users, best practices are as follows:

- When you delete a user from within Process Manager but not from the Active Directory, you do not fully delete the user. Users that remain in Active Directory are created again in Process Manager during the next synchronization. If you want to block access from Process Manager to an Active Directory user, you must delete the user from the Active Directory.
  After you delete a user from Active Directory, you do not delete the user from Process Manager; instead, you disable the user. To fully delete the user and all of their associated information, the administrator must remove the user.

- When you edit information for an Active Directory user from within Process Manager, the synchronization process overwrites it. To avoid this scenario, edit Active Directory users from the Active Directory; Process Manager updates the information during the next synchronization. This rule applies to the group, manager, and organizational unit information of the user.
Using the client tools

- Chapter 32. Business Time Span Editor
- Chapter 33. Credentials Manager
- Chapter 34. License Status Manager
- Chapter 35. Local Machine Info Editor
- Chapter 36. Log Viewer
- Chapter 37. Messaging Console
- Chapter 38. Screen Capture Utility
- Chapter 39. Workflow Server Extensions
- Chapter 40. Task Tray Tool
- Chapter 41. Tool Preferences Editor
- Chapter 42. WebForms Theme Editor
- Chapter 43. Workflow Explorer
Business Time Span Editor

This chapter includes the following topics:

- About the Business TimeSpan Editor
- Opening the Business TimeSpan Editor
- Creating a business time span in the Business TimeSpan Editor

About the Business TimeSpan Editor

The Business TimeSpan Editor lets you define global working days and hours for your organization. You can define daily working hours, weekends, and holidays. You can use the business hours that you define in the Business TimeSpan Editor to restrict when certain events happen in a workflow process.

For example, in a Dialog Workflow component, you can set a Late Date and a Due Date for the task that the component creates. You can use a business time span to define when the task can occur.

See “Opening the Business TimeSpan Editor” on page 600.

See “Creating a business time span in the Business TimeSpan Editor” on page 601.

Opening the Business TimeSpan Editor

You can open the Business TimeSpan Editor only on a computer where it is installed.

See “About the Business TimeSpan Editor” on page 600.
To open the Business TimeSpan Editor

1. Click Start > Programs > Symantec > Workflow Designer > Tools > Business TimeSpan Editor.

2. (Optional) You can also open the Business TimeSpan Editor in the Business TimeSpan Configuration tab in Workflow Explorer. See “About Workflow Explorer” on page 638.

Creating a business time span in the Business TimeSpan Editor

You can create business time spans in the Business TimeSpan Editor. A business time span includes three parts: daily business hours, holidays, and weekends. You can create as many business time spans as you want to, and you can use them for different purposes.

See “About the Business TimeSpan Editor” on page 600.

You can also create business time spans in the Publishing tab of a workflow project, or in individual components.

See “Creating a business time span in the publishing tab” on page 381.

See “Creating a business time span in an individual component” on page 382.

To create a business time span

1. Open the Business TimeSpan Editor.
   See “Opening the Business TimeSpan Editor” on page 600.

2. Click New.

3. Configure the business hours.
   The business hours refer to daily working hours.

   The properties for adding a holiday are as follows:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Holiday ID</td>
<td>The name of the holiday.</td>
</tr>
<tr>
<td>Date</td>
<td>The date on which the holiday occurs.</td>
</tr>
<tr>
<td>Description</td>
<td>An optional description of the holiday. This description appears only in the Business TimeSpan Editor.</td>
</tr>
</tbody>
</table>
5 Add days for weekends.

When you add days to the **Weekends** property, you define which days are considered weekend days every week.

6 When you are finished editing the time span, click **Save**.

Choose a location to save your time span, and then click **Save**.
Credentials Manager

This chapter includes the following topics:

- About Credentials Manager
- Adding credentials in Credentials Manager
- Editing credentials in Credentials Manager

About Credentials Manager

Credentials Manager lets you add, edit, or remove credentials for the Symantec Management Platform and solutions. Credentials Manager handles all of the credentials that you need to create and publish workflow processes. Every Workflow Designer or Workflow Server computer that needs to connect to the Symantec Management Platform computer must have credentials.

Credentials Manager is part of Workflow Explorer, so you can also use it to work with SymQ and logging. You can also work with SymQ and logging from the main Workflow Explorer tool.

See “About Workflow Explorer” on page 638.

By default, there are two side tabs in Credentials Manager: Symantec Management Platform and Deployment Server.

Table 33-1 Side tabs in Credentials Manager

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symantec Management Platform</td>
<td>This tab lets you configure the credentials for Symantec Management Platform computers.</td>
</tr>
<tr>
<td>Deployment Server</td>
<td>This tab lets you configure the credentials for Deployment Server.</td>
</tr>
</tbody>
</table>
Table 33-1  Side tabs in Credentials Manager (continued)

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other tabs</td>
<td>You may have other tabs depending on which solutions are installed the Symantec Management Platform computer to which you connect.</td>
</tr>
<tr>
<td></td>
<td>Use each tab to configure the credentials for each corresponding solution.</td>
</tr>
</tbody>
</table>

By default there are six tabs across the top of Credentials Manager. All credentials information is managed under the Credential tab.

See “About Workflow Explorer” on page 638.

See “Adding credentials in Credentials Manager” on page 604.

See “Editing credentials in Credentials Manager” on page 605.

## Adding credentials in Credentials Manager

You can add credentials in Credentials Manager for the Symantec Management Platform server and solutions. After you have added credentials for certain products, Workflow has access to those products.

See “About Credentials Manager” on page 603.

You can add more than one set of credentials for each product, but you can configure only one set as the default credentials.

**To add credentials in Credentials Manager**

1. Open Credentials Manager (Start > Programs > Symantec > Workflow Designer > Tools).
2. In the left pane, click the product tab for which you want to add credentials (for example, the Symantec Management Platform tab).
3. In the right pane, click Add.
4. In the New SMP Credentials dialog box, enter the credentials information. If you do not know the credential information, ask your network administrator.
5. Click OK.
6. (Optional) Click on the credentials that you created, and then click Test.
Editing credentials in Credentials Manager

You can edit existing credentials in Credentials Manager. See “About Credentials Manager” on page 603.

To edit credentials in Credentials Manager

1. Open Credentials Manager (Start > Programs > Symantec > Workflow Designer > Tools).
2. In the left pane, click the product tab for which you want to edit credentials (for example, the Symantec Management Platform tab).
3. In the right pane, click on the set of credentials that you want to edit.
4. Click Edit.
5. Edit the credential information, and then click OK.
6. (Optional) Click on the credentials that you edited, and then click Test.
License Status Manager

This chapter includes the following topics:

- About the License Status Manager

About the License Status Manager

The License Status Manager lets you view licensing information about Workflow and Workflow-related applications (such as ServiceDesk). This tool also lets you run tests on your license to verify that it works properly. The tool does not create or manage licensing. The Symantec Management Platform manages all licensing. The tool communicates with the Symantec Management Platform to determine licensing information.

See “About Symantec Workflow” on page 28.

The License Status Manager has two tabs: Workflow License and Application Licenses. The Workflow License tab displays license information for Workflow, and the Application Licenses tab displays license information about Workflow-related applications.

On the Workflow License tab, you can run tests on all the licensed features of Workflow. When you run the tests, the Result column displays whether the tests pass or fail.

The Application Licenses tab displays properties about Workflow-related applications such as ServiceDesk.

<table>
<thead>
<tr>
<th>Table 34-1</th>
<th>Properties on the Application Licenses tab</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>Installed Applications</td>
<td>Lists the Workflow-related applications that are installed on the local computer and that are licensed in the Symantec Management Platform.</td>
</tr>
</tbody>
</table>
### Table 34-1  Properties on the Application Licenses tab (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Provider Name</td>
<td>The name of the product for which the license is provided.</td>
</tr>
<tr>
<td>Licensing Authority</td>
<td>The issuing organization.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the license for the selected application.</td>
</tr>
<tr>
<td>Provider Specific Information</td>
<td>Provider specific information for the license.</td>
</tr>
<tr>
<td>Service Prefixes Under Concurrent Use License</td>
<td>License sub-divisions that let multiple users concurrently use different parts of ServiceDesk.</td>
</tr>
<tr>
<td>Service Prefixes Under General Use License</td>
<td>When a process view is opened, the service ID of the process is used to determine whether or not access to that process view is governed by a licensed service context. If the service ID starts with any declared prefix of any registered service contexts, access to it is contingent upon the licensing rules of that service context.</td>
</tr>
</tbody>
</table>
Local Machine Info Editor

This chapter includes the following topics:

■ About the Local Machine Info Editor

About the Local Machine Info Editor

The Local Machine Info Editor lets you configure settings regarding publishing, data persistence, notifications, and other features. The settings in the Local Machine Info Editor apply only to the local computer.

You can open the Local Machine Info Editor through the Task Tray Tool. You can also open it through the Start menu (Start > Programs > Symantec > Workflow Designer > Tools > Local Machine Info Editor).

The Local Machine Info Editor has two tabs: Local Machine Info and Log Settings. The Local Machine Info tab has general settings. The Log Settings tab has the settings that apply specifically to log messages.

See “About the Log Viewer ” on page 611.
### Table 35-1 Properties in the Local Machine Info tab

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Servers</strong></td>
<td>Computers to which the local computer connects for a number of purposes. Each computer that is registered in this list has one or more roles. A server role is a way that the registered computer interacts with the local computer. For example, a registered computer can have a <strong>DeploymentTarget</strong> role. This role means that the local computer can publish workflow projects to the registered computer. You can add and configure any computer that has Workflow installed. See “Adding a server in the task tray application” on page 210.</td>
</tr>
<tr>
<td><strong>Default Server</strong></td>
<td>The computer that Workflow uses by default for Process Manager and publishing. If you use Process Manager components (such as the Get All Related Users component) in your process, by default they connect with the <strong>Default Server</strong>. (You must set the components' <strong>Session IDSource</strong> to <strong>UseGlobalSession</strong> for them to use the settings in the Local Machine Info Editor.)</td>
</tr>
<tr>
<td><strong>Login to Process Manager</strong></td>
<td>Sets whether Workflow automatically logs on to Process Manager on the <strong>Default Server</strong>.</td>
</tr>
<tr>
<td><strong>Workflow Server Configuration</strong></td>
<td>Opens the Workflow Server Extensions Configuration editor. The Server Extensions Configuration editor is a tool that lets you define all the properties for a Workflow Server. See “Server Extensions Configurator” on page 617.</td>
</tr>
<tr>
<td><strong>Default Workflow Persistence</strong></td>
<td>A read-only setting that shows where Workflow saves its persistence data. The default persistence setting is set during installation.</td>
</tr>
<tr>
<td><strong>Notification Events</strong></td>
<td>The events about which you want to be notified. These notifications appear on the local computer as pop-up dialog boxes.</td>
</tr>
<tr>
<td><strong>Only Notify On Specific Messages</strong></td>
<td>Sets only the messages that are specifically sent to appear as notifications. Specifically-sent notifications refer to the notifications that come from components in workflow processes (such as the Simple Post Notification Message component).</td>
</tr>
</tbody>
</table>
Table 35-1  Properties in the Local Machine Info tab (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Object Storage Default Exchange Name</strong></td>
<td>The default exchange that Workflow uses for data objects. New projects in Workflow Designer use this setting in the Storage Preferences tab. If the Store To Exchange Preference tab is set to Default, the storage preference uses the default exchange. See “Storage Preferences tab” on page 168.</td>
</tr>
<tr>
<td><strong>Seconds Between Task Checks</strong></td>
<td>The number of seconds that the job server waits between task checks.</td>
</tr>
<tr>
<td><strong>Hook Print Screen To Capture Application</strong></td>
<td>Sets the Screen Capture utility to open when a user pushes the print screen option. See “About the Screen Capture utility” on page 614.</td>
</tr>
<tr>
<td><strong>Show Only Public Information In Errors</strong></td>
<td>Causes a suppression of information that is provided in the logs in both the Workflow logs and the Log Viewer. It is unchecked by default (displays the maximum amount of information possible).</td>
</tr>
<tr>
<td><strong>Do Not Process Timeouts And Escalations</strong></td>
<td>Causes the server to ignore any timeout or escalations that are set up in your workflows. It is unchecked by default (timeouts and escalations are processed). If you have multiple workflow servers that share the same workflow persistence, only one server should be processing timeouts and escalations.</td>
</tr>
<tr>
<td><strong>Use Windows Integrated Authentication</strong></td>
<td>Sets whether Process Manager uses Windows authentication by default.</td>
</tr>
<tr>
<td><strong>Integrated Authentication URL</strong></td>
<td>The URL that opens Process Manager using Windows authentication.</td>
</tr>
<tr>
<td><strong>Enable Beta Features</strong></td>
<td>Sets whether the beta features of Workflow are turned on. This setting requires a beta key.</td>
</tr>
<tr>
<td><strong>Beta Key</strong></td>
<td>A GUID key to unlock the beta features.</td>
</tr>
</tbody>
</table>
Log Viewer

This chapter includes the following topics:

- About the Log Viewer
- Sorting log messages by header
- Opening the Log Viewer

About the Log Viewer

The Log Viewer is one of the modules of Workflow Explorer. You can view, sort, and save log messages in the Log Viewer.

See “About Workflow Explorer” on page 638.

See “Opening the Log Viewer” on page 612.

Log messages refer to messages that workflow applications create, including published processes. In workflow processes, components such as Create Log Entry create log messages.

The Log Viewer only displays logs. It does not contain the log files. Log files are saved in the file system (C: > Program Files > Symantec > Workflow > Logs).

In the Log Viewer, you can sort by any of the headers (Process ID, Level, and so on).

See “Sorting log messages by header” on page 612.

Table 36-1 Properties in the Log Viewer

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Name</td>
<td>The name of the workflow process or application from which the log message came.</td>
</tr>
</tbody>
</table>
### Table 36-1  Properties in the Log Viewer *(continued)*

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process ID</td>
<td>The process ID of the workflow process or application from which the log message came.</td>
</tr>
<tr>
<td>Date Time</td>
<td>When the log message was created.</td>
</tr>
<tr>
<td>Level</td>
<td>The logging level of the message.</td>
</tr>
<tr>
<td>Log Category</td>
<td>A description of the type of log message. For example, log messages that are created with the Create Log Message component have a log category of <code>LogicBase.Components.Default.Logging.CreateLogEntryComponent</code>.</td>
</tr>
<tr>
<td>Message</td>
<td>The value of the log message.</td>
</tr>
<tr>
<td>Log Details</td>
<td>Additional information on the selected log message.</td>
</tr>
</tbody>
</table>

### Sorting log messages by header

In the Log Viewer, you can sort by any of the headers (*Process ID*, *Level*, and so on). Sorting log messages may help you locate a specific log message.

See “About the Log Viewer” on page 611.

**To sort log messages by header**

1. Open the Log Viewer.
2. Click on one of the headers (such as *Process ID* or *Level*) and drag it to the top of the pane.

### Opening the Log Viewer

The Log Viewer is one of the modules of Workflow Explorer. You can access the Log Viewer only on a computer where it is installed.

See “About the Log Viewer” on page 611.

**To open the Log Viewer**

1. Click `Start > Programs > Symantec > Workflow Designer > Tools > Log Viewer`.
2. (Optional) You can also view the Log Viewer in Workflow Explorer under the *Log Viewer* tab.

See “Viewing Workflow Explorer” on page 639.
Messaging Console

This chapter includes the following topics:

- About the Messaging Console

About the Messaging Console

The Messaging Console is a command line tool for interacting with configured message exchanges. You can use the Messaging Console to view existing exchanges on local and remote computers. The Messaging Console lets you connect to a particular exchange to perform exchange operations. You can send and retrieve messages, list the exchange contents, query the contents, submit a log entry to the exchange, and more.

You can access the Messaging Console in Start > Programs > Symantec > Workflow Designer > Tools > WebForm Theme Editor. The help command displays a list of all of the messaging commands that are available.

See “About Workflow Designer” on page 41.
Screen Capture Utility

This chapter includes the following topics:

- About the Screen Capture utility
- Capturing and editing screen shots

About the Screen Capture utility

You can capture and edit screen shots for use in your workflows or anywhere that you need a screen shot using the Screen Capture utility. Screen shots are saved in the .PNG format. After you capture a screen shot, you can crop, draw boxes, and even add notes.

You can also paste graphic files into the Screen Capture utility so they can be added to your workflows.

See “Capturing and editing screen shots” on page 614.

Capturing and editing screen shots

You can capture and edit a screen shot using the Screen Capture utility.

See “About the Screen Capture utility” on page 614.

To capture a screen shot

1. Open the Screen Capture utility (Start > Programs > Symantec > Workflow Designer > Tools > ScreenCapture Util).
2. Select to capture by region, the whole screen, or set up a delayed capture.
3. To crop your image, click the Crop Image icon and select the region you want to keep.
4 To add a note, click the Add Note icon, select where on the image you want the note, and enter the information you want.
You can change the font, font color, fill color, border color, and border width by clicking on the appropriate icons.

5 To draw a rectangle, click the Draw Rectangle icon and select where on the image you want the rectangle to be drawn.
You can change the font, font color, fill color, border color, and border width by clicking on the appropriate icons.

6 To save the image to your clipboard, click the Copy to Clipboard icon.

7 To save the image to a file, click the Save to File icon.

8 To send the image to a workflow, click the Send to Workflow icon.
Workflow Server Extensions

This chapter includes the following topics:

- Starting Workflow Server Extensions
- Restarting Workflow Server Extensions
- Configuring Server Extensions
- Server Extensions Configurator
- Configuring Server Extensions manually

Starting Workflow Server Extensions

Workflow Server Extensions service must be running for Symantec Workflow to operate. Access the service in your Services Manager. If it is not started, start it and set it to run automatically.

To start Workflow Server Extensions

2. In the Services pane, double-click Symantec Workflow Server.
3. In the General tab, the Service Status should be set to Started. If it says Stopped, click Start.
4. Select Automatic for the Startup Type.

After you have Workflow Server Extensions installed and started, there are two ways to configure Workflow Server Extensions.

You can select one of the following ways:

- See “Server Extensions Configurator” on page 617.
Restarting Workflow Server Extensions

Restart Server Extensions after making changes to the configurations.

See “Starting Workflow Server Extensions” on page 616.

See “Configuring Server Extensions” on page 617.

To restart server extensions
2. In the services pane, click LogicBase 2006 Server Extensions.
3. To the left of the services list, click Restart the Service. You can also right-click on Symantec Workflow Server and click Restart.

Configuring Server Extensions

Workflow Server Extensions uses default settings when first installed with Symantec Workflow. You may not need to change the default settings. If you do need to change them, you can configure these settings based on your publishing, security, licensing, and accessibility needs.

You can configure Workflow Server Extensions in the following two ways:

- See “Server Extensions Configurator” on page 617.
- See “Configuring Server Extensions manually” on page 621.

The Server Extensions configurator tool and the XML file both have access to the same properties for configuration.

After you make changes, restart Workflow Server Extensions.

See “Restarting Workflow Server Extensions” on page 617.

Server Extensions Configurator

The Server Extensions Configurator is a tool that lets you define all the properties for a Workflow Server. You can find it by clicking Start > Programs > Symantec > Workflow Designer > Tools > Server Extensions Configurator.

Restart Server Extensions after making any changes.

See “Restarting Workflow Server Extensions” on page 617.
Table 39-1 Options in the Server Extensions Configurator page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Extensions Port Number</td>
<td>The default remoting port that Workflow Server uses to communicate with Server Extensions in order to publish new projects. The default port is 11434.</td>
</tr>
<tr>
<td>Enable WAS Management Service</td>
<td>Provides support for deployment and Workflow Enterprise Management. This is enabled by default.</td>
</tr>
<tr>
<td>Run Message Server</td>
<td>Sets whether the default exchange server included with Workflow is run. Always leave this turned on unless you have a specific reason for turning it off.</td>
</tr>
<tr>
<td>Run Deployment Server</td>
<td>Sets whether this Workflow Server computer can accept projects. If this setting is turned off, this Workflow Server computer does not accept any projects from any Workflow Designer computers.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Deployment Info</td>
<td>Settings for how this Workflow Server computer manages published projects. Click the ... symbol, to configure the settings. The following list describes each setting:</td>
</tr>
<tr>
<td></td>
<td>■ Physical Root Directory</td>
</tr>
<tr>
<td></td>
<td>The physical directory on this Workflow Server computer where you want to store published projects. In this directory there are Debug and Release folders to store different workflow versions.</td>
</tr>
<tr>
<td></td>
<td>■ Root URL</td>
</tr>
<tr>
<td></td>
<td>The default base URL that Server Extensions uses to configure projects being deployed to this Workflow Server computer. Change this setting to create a different base URL, perhaps one that is externally accessible. This property should almost always be changed on a production server.</td>
</tr>
<tr>
<td></td>
<td>■ IIS Root Path</td>
</tr>
<tr>
<td></td>
<td>The file path that lets Workflow Server create Virtual Directories under a specific Web Site in IIS. Default IIS installations have a Web Site called Default Web Site. If you have another Web Site that you want use instead, change this property. The easiest way to find your Web Site's ID is to open the IIS control panel, choose Properties on the Web Site, and look at the path to your log files.</td>
</tr>
<tr>
<td></td>
<td>■ Create App Name</td>
</tr>
<tr>
<td></td>
<td>The executable that is used to create new virtual directories under your Web server for your projects. CreateVirDirectory is the utility provided by Workflow Server to use with IIS.</td>
</tr>
<tr>
<td></td>
<td>■ Temp App Prefix</td>
</tr>
<tr>
<td></td>
<td>The prefix used to indicate which projects are published to the server on a temporary basis. This is mostly used for testing.</td>
</tr>
<tr>
<td></td>
<td>■ Ds File Name</td>
</tr>
<tr>
<td></td>
<td>The name of the file used to store information about temporary publishing so the temporary projects can be cleaned up later. This is not often used in production computers.</td>
</tr>
<tr>
<td>Remove Deploy Directory Itself</td>
<td>Sets whether the original publishing directory is deleted when you publish a project again. Publishing again deletes the contents of the original publishing folder and puts the new files in its place.</td>
</tr>
<tr>
<td>Run Licensing Server</td>
<td>Sets whether this Server Extensions runs a licensing server. Leave this setting turned on if you want licensing to be enabled.</td>
</tr>
</tbody>
</table>
### Table 39-1  Options in the Server Extensions Configurator page (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Proxy Server</td>
<td>Proxy server refers to Divo projects, which are not available in Workflow. Click the ... symbol, to configure the proxy server.</td>
</tr>
<tr>
<td></td>
<td>■ Default URL</td>
</tr>
<tr>
<td></td>
<td>The proxy server URL.</td>
</tr>
<tr>
<td></td>
<td>■ Host</td>
</tr>
<tr>
<td></td>
<td>The IP Address of the proxy server.</td>
</tr>
<tr>
<td></td>
<td>■ Persistent Applications</td>
</tr>
<tr>
<td></td>
<td>Applications that persist on the proxy server. Click Add to add applications.</td>
</tr>
<tr>
<td></td>
<td>■ Phone Number To Call</td>
</tr>
<tr>
<td></td>
<td>The phone number to the proxy server that gives developers access to their Divo applications.</td>
</tr>
<tr>
<td></td>
<td>■ Port Lower Bound</td>
</tr>
<tr>
<td></td>
<td>The lower boundary of a range of ports that the proxy server can use to dynamically allocate services to a speech application. Make sure that there are no ports in use on your server between the upper and lower bound.</td>
</tr>
<tr>
<td></td>
<td>■ Port Upper Bound</td>
</tr>
<tr>
<td></td>
<td>The upper boundary of a range of ports that the proxy server can use to dynamically allocate services to a speech application. Make sure that there are no ports in use on your server between the upper and lower bound.</td>
</tr>
<tr>
<td>AutoTrigger Info</td>
<td>Settings for automatically invoking local webservice.</td>
</tr>
<tr>
<td></td>
<td>The following list describes each setting:</td>
</tr>
<tr>
<td></td>
<td>■ Run Web Services</td>
</tr>
<tr>
<td></td>
<td>Sets whether local Services are automatically invoked.</td>
</tr>
<tr>
<td></td>
<td>■ Polling Service List Interval Minutes</td>
</tr>
<tr>
<td></td>
<td>The number of minutes Server Extensions waits before polling the Service list.</td>
</tr>
<tr>
<td></td>
<td>■ Polling Interval</td>
</tr>
<tr>
<td></td>
<td>The number of minutes Server Extensions waits before polling the Service.</td>
</tr>
<tr>
<td></td>
<td>■ Delay Seconds</td>
</tr>
<tr>
<td></td>
<td>The number of seconds delaying the automatic invocation of local Services.</td>
</tr>
<tr>
<td></td>
<td>■ Number of Retries</td>
</tr>
<tr>
<td></td>
<td>The number of times Server Extensions tries to automatically invoke local Services.</td>
</tr>
</tbody>
</table>
### Table 39-1 Options in the Server Extensions Configurator page (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Manual Setup Info          | The manual setup info property controls the Workflow Job Server. The Job Server is one of the most basic elements of Workflow. It checks published processes for pending actions (such as task creation, escalations, or timeouts). It discovers Webservices of published workflows, and it can also make calls to configured Webservices outside of workflow.  
  - Run Web Services  
    - Turns the Job Server on or off.  
  - Defined URLs To Invoke  
    - The URLs for Webservices that you want to invoke. The method name is the name of a method you want to run on your Webservice. For a workflow project, the method name refers to an invocable secondary model in your project. Select Auto Scheduled for only Auto Start projects. A Webservice set to Auto Schedule always runs the auto invoke method.  
  - Second Between Service Invokes  
    - The number of second between each Job Service check.  
  - Use Credentials  
    - If necessary, specify the credentials needed to invoke a Webservice. |
| HTTP Authentication        | The Username and Password for the HTTP authentication of this Workflow Server.                                                                |
| Run Debugger               | Sets whether the internal designer debugger runs.                                                                                          |

See “About Workflow Server” on page 42.
See “Setting up Workflow Designer to publish to multiple Workflow Servers” on page 212.

### Configuring Server Extensions manually

Symantec Workflow lets you configure Server Extensions manually. You can directly edit the XML that Server Extensions runs on. After making changes in the code, you must restart Workflow Server Extensions before the changes will take place.

If you prefer, you can configure Server Extensions using a tool instead of directly editing the XML.

See “Server Extensions Configurator” on page 617.
To configure Server Extensions manually

1. Find the XML configuration file `setup.xml` that has settings for both the publishing service and the licensing service.
   By default, you can find this file in C:\Program Files\Altiris\Workflow Designer\Server Extensions.

2. Copy and paste the text from `setup.xml` into a text editor.

3. Edit the code to your desired specifications.
   See “Configuring Server Extensions” on page 617.

4. After saving the changes, restart Server Extensions for your changes to take effect.
   See “Restarting Workflow Server Extensions” on page 617.
Task Tray Tool

This chapter includes the following topics:

■ About the Task Tray Tool

About the Task Tray Tool

The Task Tray Tool gives you easy access to registered Workflow Servers, shortcuts, and settings. When you install Workflow, the Task Tray Tool is added to your start menu.

Right-click the Task Tray Tool to view its options.

Table 40-1 Options in the Task Tray Tool

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Servers</td>
<td>Displays the Workflow Servers that are registered in the Local Machine Info Editor.</td>
</tr>
<tr>
<td></td>
<td>See “About the Local Machine Info Editor” on page 608.</td>
</tr>
<tr>
<td></td>
<td>When you hover over a server, you can log on to its Process Manager, and view the service catalog.</td>
</tr>
<tr>
<td>Shortcuts</td>
<td>Sets the shortcuts to the client tools.</td>
</tr>
<tr>
<td>Restart Server Extensions</td>
<td>Restarts the Server Extensions windows service.</td>
</tr>
<tr>
<td></td>
<td>See “Restarting Workflow Server Extensions” on page 617.</td>
</tr>
<tr>
<td>Settings</td>
<td>Opens the Local Machine Info Editor.</td>
</tr>
<tr>
<td></td>
<td>See “About the Local Machine Info Editor” on page 608.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the Task Tray Tool.</td>
</tr>
</tbody>
</table>
Tool Preferences Editor

This chapter includes the following topics:

- Editing Workflow Designer preferences
- Studio Configuration page
- Designer page
- Debugging page
- Deployment page

Editing Workflow Designer preferences

Workflow Designer preferences refer to the general settings that control how Workflow Designer functions. You can access the Workflow Designer settings in Workflow Manager.

See “About Workflow Manager” on page 132.
See “Studio Configuration page” on page 625.
See “Designer page” on page 626.
See “Debugging page” on page 632.
See “Deployment page” on page 634.

To edit Workflow Designer preferences

1. In Workflow Manager, click Tools > Edit Preferences.
2. In the left pane, click on the preference heading that you want to edit, and then edit the settings in the right pane.
3. When you are finished editing, click OK.
Studio Configuration page

This page lets you edit Studio Configuration settings. In Workflow Manager, you can access this page at **Tools > Edit Preferences**.

See “Editing Workflow Designer preferences” on page 624.

**Table 41-1**  
Options in the Tool Setup page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always Ask for Save</td>
<td>Set to ask the user to save the project before they close it.</td>
</tr>
<tr>
<td>Warn about trusted zones</td>
<td>If an administrator deploys a project to a foreign (remote) server, it is important that the project is secured from outside interference. If this option is selected, the project administrator is notified if a non-trusted entity attempts to interfere with or contact the project illegally.</td>
</tr>
</tbody>
</table>

**Table 41-2**  
Options in the Project Configuration page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary model Node Color</td>
<td>This feature is currently disabled.</td>
</tr>
<tr>
<td>Normal Model Node Color</td>
<td>This feature is currently disabled.</td>
</tr>
<tr>
<td>Invocation Target Model Node Color</td>
<td>This feature is currently disabled.</td>
</tr>
<tr>
<td>Base Project Directory</td>
<td>Set the directory that Workflow Designer uses to store your project's files.</td>
</tr>
<tr>
<td>Default Deploy Directory</td>
<td>Set the directory that Workflow Designer uses to publish projects.</td>
</tr>
<tr>
<td>Default XML Name Space</td>
<td>Set the default namespace that Workflow Designer uses for all of the components that use XML.</td>
</tr>
<tr>
<td>Enable Localization Support</td>
<td>Set to let users select their display language and language settings.</td>
</tr>
<tr>
<td>Project Templates</td>
<td>Click the ... symbol, to add more template packages to the list of templates for the project types that you can use in Workflow Designer.</td>
</tr>
<tr>
<td>Search Paths</td>
<td>Set the default search path on the <strong>Search Path Libraries</strong> tab in Import Components.</td>
</tr>
</tbody>
</table>
Table 41-2  Options in the Project Configuration page (continued)

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Model Documentation</td>
<td>Set the project to display all of the model documentation that is associated with it.</td>
</tr>
<tr>
<td>Show Project Documentation</td>
<td>Set the project to display all of the project documentation that is associated with it.</td>
</tr>
<tr>
<td>Sort Models Alphabetically</td>
<td>Set to display models and sub-models in alphabetical order in the project browser.</td>
</tr>
<tr>
<td>Template Directory</td>
<td>Set the directory in which project templates are saved.</td>
</tr>
</tbody>
</table>

Table 41-3  Options in the Save Settings page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Diagram Window Appearances</td>
<td>Set to save the current window settings in Workflow Designer. When you select this setting, Workflow Designer opens with all of the saved options.</td>
</tr>
<tr>
<td>Save Windows Position and Size</td>
<td>Set to save the position and the size of windows.</td>
</tr>
</tbody>
</table>

Table 41-4  Options in the Backup page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup Directory</td>
<td>Set a directory that Workflow Designer uses to back up project files.</td>
</tr>
<tr>
<td>Do Backups</td>
<td>Set to back up projects regularly.</td>
</tr>
</tbody>
</table>

Table 41-5  Options in the Reports page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate Reports</td>
<td>Set to create reports automatically when the application closes, on every save, manually, or at the exit prompt.</td>
</tr>
<tr>
<td>Zip Reports</td>
<td>Set to compress the generated reports.</td>
</tr>
</tbody>
</table>

Designer page

This page lets you edit Designer settings. In Workflow Manager, you can access this page at Tools > Edit Preferences.
See “Editing Workflow Designer preferences” on page 624.

**Table 41-6  Options in the Designer Configuration page**

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Append Class To Component Name</td>
<td>Select if Workflow Designer should name components based on their classes. For example, a Send Email component may be in the EmailTools class. With this option checked, the Send Email component would be named Send Email-EmailTools.</td>
</tr>
<tr>
<td>Auto Close Wait Windows</td>
<td>Select if Workflow Designer should automatically close certain windows (wait windows) after a certain number of seconds. An example of a wait window is the Session Feedback window that is executed after a project is debugged.</td>
</tr>
<tr>
<td>Default Variable Not Found Text</td>
<td>Select to set the text that displays in a process if a variable value is not found.</td>
</tr>
<tr>
<td>Designer Embedded Property Grid</td>
<td>Sets whether the component editor appears when a user clicks on it.</td>
</tr>
<tr>
<td>Open To</td>
<td>Sets which model first opens in Workflow Designer. By default, Workflow Designer opens the primary model of a project.</td>
</tr>
<tr>
<td>Prepopulate Connection Strings on Generated Components</td>
<td>Sets whether the connection string that is set in the generator is displayed to the user by default. If this setting is not selected, the connection string box in generated components is blank by default.</td>
</tr>
<tr>
<td>Small Nodes</td>
<td>Select if Workflow Designer should display the nodes of project components as small. If this setting is not selected, the small nodes on project components are displayed as larger boxes.</td>
</tr>
</tbody>
</table>

**Table 41-7  Options in the Business Model**

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Business Model</td>
<td>Select to add a business model to new projects as the default.</td>
</tr>
<tr>
<td>Add Business Model to New Projects</td>
<td>Select to add a business model node under the Project Tree automatically.</td>
</tr>
<tr>
<td>Business Model Errors Are Warnings</td>
<td>Select to show a warning on the business model components if the component has not been completed. Selecting this setting does not prevent you from running a project.</td>
</tr>
</tbody>
</table>
### Table 41-7  Options in the Business Model (continued)

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Default Swim Lane</td>
<td>Select to add a default swim lane when you create a business model.</td>
</tr>
</tbody>
</table>

### Table 41-8  Options in the Designer Tooltips page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Designer tool tips</td>
<td>The tool tip for a component is displayed when you hover the cursor over a component. Tool tips can include multiple pieces of information to help you identify or choose components within a project. The tool tip options are a set of check boxes that let you set which pieces of information should be displayed in a component's tool tip. To display information, select the corresponding check box.</td>
</tr>
</tbody>
</table>

### Table 41-9  Options in the Link Configuration page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link 01-10 Color</td>
<td>Set the colors that Workflow Designer uses for various component links. Users can use multiple colors when they design projects.</td>
</tr>
<tr>
<td>Link Selected Color</td>
<td>Set the color that Workflow Designer uses to display a selected link. Links are the lines that connect components in the designer. A link is selected when the user clicks on and highlights the link.</td>
</tr>
<tr>
<td>Orthogonal</td>
<td>Select if Workflow Designer should automatically create right angles out of links in the Designer. If this setting is not selected, links automatically take the shortest path (commonly diagonal lines).</td>
</tr>
<tr>
<td>Scale Style</td>
<td>Select to change the look of the lines that link the components together.</td>
</tr>
<tr>
<td>Stroke Curviness</td>
<td>Enter a value that Workflow Designer uses to curve bending links. Use a setting of 1 to configure the most curvy line. A line with a curviness of 1 can link into circular or semicircular lines.</td>
</tr>
</tbody>
</table>
Table 41-9 Options in the Link Configuration page (continued)

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stroke Style</td>
<td>Select a style that Workflow Designer uses to draw links from this box. You can select <strong>RoundedLineWithJumpOvers</strong> to create jump symbols if two links pass over one another. You can also select <strong>Line</strong>, <strong>RoundedLine</strong>, and <strong>Beziers</strong> (which curve the lines).</td>
</tr>
</tbody>
</table>

Table 41-10 Options in the Component Palette page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Displayed Search Results</td>
<td>Enter the maximum number of components to display from a component search.</td>
</tr>
<tr>
<td>Maximum Recently Used Components</td>
<td>Enter the maximum number of recently used components to display.</td>
</tr>
</tbody>
</table>

Table 41-11 Options in the Component Library page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Number of Components to Save</td>
<td>Enter a maximum number of components that Workflow Designer saves in the user's component library.</td>
</tr>
</tbody>
</table>

Table 41-12 Options in the Component Help page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Assembly Name In Help</td>
<td>Select if Workflow Designer should show the name of a component's assembly (or library) file in the component's help file.</td>
</tr>
</tbody>
</table>

Table 41-13 Options in the Variable Selection page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default to IncludeConvertible Types</td>
<td>Select if Workflow Designer should include convertible types when selecting variables for a component box. Convertible type variables have dynamic datatypes and can be molded to fit many types of data.</td>
</tr>
<tr>
<td>Default to Include Optional Variables</td>
<td>Select if Workflow Designer should show optional data in the variable editors.</td>
</tr>
</tbody>
</table>
### Table 41-14  Options in the Data Configuration page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Data Type</td>
<td>When allowing a user to select a variable datatype, the datatypes must be displayed in a list. They can be displayed in one of the following ways:</td>
</tr>
<tr>
<td>FriendlyName</td>
<td>Displays a common name like Text.</td>
</tr>
<tr>
<td>FullTypeName</td>
<td>Displays the full, technical name for a datatype.</td>
</tr>
<tr>
<td>ShortTypeName</td>
<td>Displays an abbreviated, short version of the datatype.</td>
</tr>
</tbody>
</table>

### Table 41-15  Options in the Text Editor Behavior page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default HTML Font</td>
<td>Select the default HTML font that you want when you use HTML in your project.</td>
</tr>
<tr>
<td>Default HTML Font Size</td>
<td>Select the default HTML font size that you want when you use HTML in your project.</td>
</tr>
<tr>
<td>Show HTML Form Controls in Merge</td>
<td>Select if Workflow Designer should allow users to add HTML form controls when they use the Merge Data option of component editing.</td>
</tr>
<tr>
<td>Show Text Merge Editor Warning</td>
<td>Set to display a warning before the user uses the HTML tab on an editor.</td>
</tr>
</tbody>
</table>

### Table 41-16  Options in the Form Designer page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Component Order on Every Close</td>
<td>Sets whether components on a form have a tab order assigned automatically.</td>
</tr>
<tr>
<td>Auto Tab Order on Every Close</td>
<td>Select to change the tab order to match the component order.</td>
</tr>
<tr>
<td>Composer Controls Text Logically</td>
<td>Select to display the variable name on the text box when you work in designer mode.</td>
</tr>
<tr>
<td>Prompt for Basic Form Data</td>
<td>Select if Workflow Designer should prompt users for form data when they design forms in the form designer.</td>
</tr>
</tbody>
</table>
### Table 41-17  Options in the Component Editor page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Component Name Sync</td>
<td>Select to allow the name on the component label to change when the name in the <strong>Settings</strong> tab of configurator changes.</td>
</tr>
<tr>
<td>Hide Component Class Name Property</td>
<td>Select if Workflow Designer should hide the Component Class Name property in component editors. This property is unchangeable, and can cause confusion if the user does not know what it means.</td>
</tr>
<tr>
<td>Hide Description Property</td>
<td>Select if Workflow Designer should hide the Description property in component editors. Users do not need to give a component a description.</td>
</tr>
<tr>
<td>Hide Location Property</td>
<td>Select if Workflow Designer should hide the Location property in component editors. You can set this property automatically by clicking, dragging, and placing components in the designer window. You do not need to display the coordinates of a component’s location to a user.</td>
</tr>
<tr>
<td>Hide Name Property</td>
<td>Select if Workflow Designer should hide the Name property in component editors. Users do not need to give a component a customized name.</td>
</tr>
<tr>
<td>Hide Override Background Color Property</td>
<td>Select if Workflow Designer should hide the Override Background Color property in component editors. Users do not need to set a background color.</td>
</tr>
</tbody>
</table>

### Table 41-18  Options in the Image Library page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Library Paths</td>
<td>Lets you manage the default library paths and add and remove new library paths.</td>
</tr>
</tbody>
</table>

### Table 41-19  Options in the Cache page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache Timeout In Minutes</td>
<td>Enter the minutes to cache form.</td>
</tr>
</tbody>
</table>

### Table 41-20  Options in the Integration Libraries page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Source With External Program</td>
<td>Sets a programming tool that opens source code from an Integration-type project.</td>
</tr>
</tbody>
</table>
Debugging page

This page lets you edit Debugging settings. In Workflow Manager, you can access this page at **Tools > Edit Preferences**.

See “Editing Workflow Designer preferences” on page 624.

**Table 41-21** Options in the Debugging page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warn on Debugger Close</td>
<td>Sets whether Workflow Designer warns users before they close the debugger window.</td>
</tr>
</tbody>
</table>

**Table 41-22** Options in the Debugging Deployment page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debugging Web Server</td>
<td>Select to use the internal web server that is packaged with Workflow Designer or to use IIS.</td>
</tr>
<tr>
<td>Dynamically Determine Internal Web Service IP Address</td>
<td>Select to find the correct IP address to use for the internal web server when localhost is not the computer default.</td>
</tr>
<tr>
<td>Determine Web Root Dynamically</td>
<td>To access a project, users must locate it using a browser. The web root is the first part of the URL that you use to locate the projects that are published locally. By default, it is <a href="http://localhost/">http://localhost/</a>. If your development computer has a specific web root, select this setting to determine the web root from Windows properties. Or, you can enter it in the Web Root box.</td>
</tr>
<tr>
<td>Deployment App Name</td>
<td>Type a name that Workflow Designer should use for the projects that are published locally. The default is debug, because applications deployed locally to the development computer are commonly deployed for debugging purposes.</td>
</tr>
<tr>
<td>Local Deployment Root</td>
<td>All deployed projects have the files that are required for proper project function. When a project is deployed, these files are moved to a special location. Set the directory that Workflow Designer uses to house these project files.</td>
</tr>
<tr>
<td>Seconds Until Cleanup On Deploy</td>
<td>Set the number of seconds that Workflow Designer waits before it cleans up the publishing files. Publishing files are the temporary files that are created when you publish a project.</td>
</tr>
</tbody>
</table>
### Table 41-22  Options in the Debugging Deployment page (continued)

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sticky Debug URLs</td>
<td>Select to use the defined URL inside of dynamically changing debug URLs.</td>
</tr>
</tbody>
</table>

### Table 41-23  Options in the Debugging Browser page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non Default Browser Exe File</td>
<td>Many computers have multiple web browsers. If the Workflow Designer development computer has multiple web browsers, type the full path to the non-default browser. This non-default browser is used only if the Use Default Browser check box is cleared.</td>
</tr>
<tr>
<td>Use Default Browser</td>
<td>Select if Workflow Designer should use the default Windows browser to open any project-related webpages or websites.</td>
</tr>
<tr>
<td>Use Shell Execute</td>
<td>If a project needs to launch an external application, it can do so in two ways. It can use either a shell execute (open by using a DOS prompt or shell), or it can run the program within Windows. Select this setting if Workflow Designer should (by default) attempt to open external files and applications using a DOS prompt or shell.</td>
</tr>
</tbody>
</table>

### Table 41-24  Options in the Debugging Grid page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debug Log Row Color</td>
<td>Select the row color for the debug logs that are in the debugging grid.</td>
</tr>
<tr>
<td>Error Log Row Color</td>
<td>Select the row color for the error logs that are in the debugging grid.</td>
</tr>
<tr>
<td>Fatal Log Row Color</td>
<td>Select the row color for the fatal logs that are in the debugging grid.</td>
</tr>
<tr>
<td>Info Log Row Color</td>
<td>Select the row color for the information logs that are in the debugging grid.</td>
</tr>
<tr>
<td>Warning Log Row Color</td>
<td>Select the row color for the warning logs that are in the debugging grid.</td>
</tr>
</tbody>
</table>
Deployment page

This page lets you edit Deployment settings. In Workflow Manager, you can access this page at Tools > Edit Preferences.

See “Editing Workflow Designer preferences” on page 624.

Table 41-25 Options in the Deployment page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove Deploy Directory Itself</td>
<td>Select to remove the entire deployment directory and recreate it. If you do not select this setting, the content of the directory is replaced.</td>
</tr>
<tr>
<td>Include Custom Libs</td>
<td>Select to include custom libraries in the directory with the publishing package. If you do not select this setting, the custom libraries are excluded.</td>
</tr>
</tbody>
</table>

Table 41-26 Options in the Deployment: Installer page

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Install Directory</td>
<td>Enter the default directory for creating deployment installers for projects.</td>
</tr>
</tbody>
</table>
WebForms Theme Editor

This chapter includes the following topics:

- About the Web forms theme editor
- Opening the Web forms theme editor

About the Web forms theme editor

You can create new form themes using the Web forms theme editor. After you have created a form theme, you can use your theme in any form component (such as the Form Builder component).

See “Creating a form theme” on page 367.

See “Opening the Web forms theme editor” on page 637.

The editor lets you create the two parts of a form theme: the border style and the control style. The border style determines how the border of the form looks. The control style determines how the form components look.

Table 42-1 Items in the left pane of the Web forms theme editor

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form Style</td>
<td>Contains the definitions for the border style of the theme.</td>
</tr>
<tr>
<td>Control Styles</td>
<td>Contains the definitions for the control styles of the themes. The control styles determine how the form components look.</td>
</tr>
<tr>
<td>Images</td>
<td>Contains all of the images that are available for you to use to design the form style and the control style. You can add the images that you want to use.</td>
</tr>
</tbody>
</table>

See “Creating a form theme” on page 367.
When you click on **Form Style** in the left pane, properties appear in the right pane. These properties define the border style of the theme.

<table>
<thead>
<tr>
<th>Table 42-2 Form style properties in the right pane</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tab</strong></td>
</tr>
<tr>
<td>Border Setup</td>
</tr>
<tr>
<td>Border Setup</td>
</tr>
<tr>
<td>Border Setup</td>
</tr>
<tr>
<td>Border Setup</td>
</tr>
<tr>
<td>Border Setup</td>
</tr>
<tr>
<td>Border Setup</td>
</tr>
<tr>
<td>Border Images</td>
</tr>
<tr>
<td>Background</td>
</tr>
<tr>
<td>Background</td>
</tr>
<tr>
<td>Background</td>
</tr>
</tbody>
</table>
### Table 42-2  Form style properties in the right pane (continued)

<table>
<thead>
<tr>
<th>Tab</th>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Fixed size</td>
<td>Sets whether the designer can stretch or shrink the border in Workflow Designer. If you select this property, you can set a fixed width and height.</td>
</tr>
</tbody>
</table>

When you click the **Control Styles** item in the left pane, no properties immediately appear. When you click **Theme > Add Standard Control Style** (or **Add Custom Style**), properties appear in the right pane.

The properties that appear in the right pane are different based on the kind of control style that you choose. Symantec recommends that you use the sample in the bottom right pane to determine if the control style has the appearance that you want.

---

### Opening the Web forms theme editor

The Web forms theme editor is one of the Workflow client tools. You can open this editor only on computers where it is installed.

See “About the Web forms theme editor” on page 635.

**To open the Web forms theme editor**

- Click **Start > Programs > Symantec > Workflow Designer > Tools > WebForms Theme Editor**.
About Workflow Explorer

Workflow Explorer is the primary client tool of Workflow. Workflow Explorer includes several client tools, such as the Log Viewer, the critical errors viewer, and the credential manager.

See “About the Log Viewer” on page 611.
See “About Credentials Manager” on page 603.
See “Viewing Workflow Explorer” on page 639.
Use Workflow Explorer to configure SymQ exchanges, view currently running processes, view log messages and errors, configure credentials, and configure business hours.

By default, Workflow Explorer has the following tabs:

- **Current Running Processes**
  See “Current Running Processes page” on page 644.

- **SymQ Configuration**
  See “SymQ Configuration page” on page 641.

- **SymQ Explorer**
  See “SymQ Explorer page” on page 645.

- **Log Viewer**
  See “Log Viewer page” on page 651.

- **Credential**
  See “Credential page” on page 651.

- **Business TimeSpan Configuration**
  See “Business TimeSpan Configuration page” on page 652.

- **Directory Servers Groups**
  See “Directory Servers Groups page” on page 652.

---

**Viewing Workflow Explorer**

Workflow Explorer is the primary client tool of Workflow. You can view Workflow Explorer on any computer on which it is installed.

See “About Workflow Explorer” on page 638.

To view Workflow Explorer

1. Click **Start > Programs > Symantec > Workflow Designer > Tools > Workflow Explorer**.

2. Click on the tab that you want to view.

---

**About SymQ**

Symantec Workflow uses a messaging server, SymQ, to handle the exchange of messages between products. SymQ is designed to provide enterprise-class scalability, performance, and failover capabilities for your Workflow-type projects.

You can view SymQ exchanges in the **SymQ Configuration** tab in Workflow Explorer.
SymQ has three main concepts.

Table 43-1  SymQ concepts

<table>
<thead>
<tr>
<th>Concept</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delivery target</td>
<td>The destination of a message.</td>
</tr>
<tr>
<td>Message exchange</td>
<td>Provides the in-process storage and retrieval of messages.</td>
</tr>
<tr>
<td>Transactional message exchange</td>
<td>Provides the transactional methods for message access and manipulation.</td>
</tr>
</tbody>
</table>

SymQ provides point-to-point and publish-subscribe message delivery for workflow applications. The product is highly configurable because its functionality is based on message exchanges (customized message queues) that perform specific tasks. Exchanges can be linked in complex chains to perform complex functions with message data. All of the data that is passed across the message exchange is held in a message envelope. This message envelope has the message ID, the data (payload), and a collection of attributes that can be used to identify and route the object.

SymQ is primarily used in with Workflow-type projects. Workflow-type projects may be the long-running processes that can span an extended period of time. SymQ stores the state data of the workflow during the process. SymQ lets you configure very scalable storage mechanisms to store state data.

**About logging with SymQ**

SymQ facilitates logging on Workflow. SymQ manages log messages from core products and from published workflows. You can customize logging through the LogicBase.Control.exe tool (C:\Program Files\Symantec\Workflow\Tools).

By default, LogicBase.Control.exe is set to handle log messages in the following ways:

- Store log messages in memory temporarily so that you can view them within the tool.
- Send the log messages to a log file. Log messages are saved by default in C:\Program Files\Symantec\Workflow\Data\MQFileStorage.

See “Configuring logging levels” on page 645.
See “Viewing log messages” on page 651.

**SymQ Configuration page**

This page lets you view and configure SymQ exchanges.

See “About SymQ” on page 639.

### Table 43-2 Tabs in the SymQ Configuration page

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SymQ_Local_Defaults</td>
<td>Contains all local exchanges.</td>
</tr>
<tr>
<td>SymQ_Core</td>
<td>Contains exchanges specific to the survival of Server Extensions (for example: logging and caching). These exchanges are always installed.</td>
</tr>
<tr>
<td>Process_Manager</td>
<td>Contains exchanges specific to Process Manager. These exchanges are installed only if the portal is installed.</td>
</tr>
<tr>
<td>Workflow_Core</td>
<td>Contains exchanges specific to the running of projects (for example: tasks).</td>
</tr>
</tbody>
</table>

The right pane of the SymQ Configuration page displays the exchanges for the selected configuration. Six terms are at the top of the right pane: All, Templates, Non Templates, Not Valid, Internal, External. You can click on a term to select which exchanges to show.

**Adding to SymQ configurations**

In Workflow Explorer, in the SymQ Configuration page, you can add new exchanges to a default configuration.

See “About Workflow Explorer” on page 638.

See “SymQ Configuration page” on page 641.

To add a new exchange to a default configuration

1. Click Start > Programs > Symantec > Workflow Designer > Tools > Workflow Explorer.
2. In Workflow Explorer, click the SymQ Configurations tab.
3. In the left pane, select the configuration you want to edit.
4 Click **Add**.

If you want to edit a default configuration instead of adding an exchange, click **Edit** instead of **Add**.

5 Select the exchange that you want to add.

6 Click **Save**.

### Changing an exchange configuration type

You can change the configuration type of SymQ messages based on your access preferences. Configurations are created and modified through Workflow Explorer.

See “About SymQ” on page 639.

**To change an exchange configuration type**

1 Click **Start > Programs > Symantec > Workflow Designer > Tools > Workflow Explorer**.

2 In Workflow Explorer, click the **SymQ Configurations** tab.

3 In the left pane, select the configuration that you want to edit.

4 In the **Configuration Type** list, select a configuration type.

5 Click **Save**.

### Adding a new exchange configuration

In the SymQ Configuration page in Workflow Explorer, you can create a new exchange configuration. Exchange configurations are groups of the exchanges that are based on accessibility. Exchanges configurations simplify exchange management. You can group related collections of exchanges in exchange configurations.

You can also duplicate and delete exchange configurations.

See “About Workflow Explorer” on page 638.
To add a new exchange configuration

1. In Workflow Explorer, click **SymQ Configuration**.
2. In the left pane, click the **Add New Configuration** symbol.
3. Enter information for the new configuration.

The following table describes the properties:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Name</td>
<td>The name of the new configuration. You can give your configuration any name.</td>
</tr>
<tr>
<td>Evaluation Order</td>
<td>The order of preference for identical exchanges. If you have the same exchange in multiple exchange configurations, the evaluation order determines which exchange is preferred.</td>
</tr>
<tr>
<td>Configuration Type</td>
<td>The configuration type of the new configuration. Configuration types refer to the accessibility of the exchanges.</td>
</tr>
</tbody>
</table>

Adding a new exchange in an exchange configuration

In Workflow Explorer, in the **SymQ Configuration** page, you can create new exchanges in exchange configurations.

See “About Workflow Explorer” on page 638.

To add a new exchange in an exchange configuration

1. Open Workflow Explorer.
   
   See “Viewing Workflow Explorer” on page 639.

2. Click on the **SymQ Configuration** tab.

3. In the left pane, click on the exchange configuration in which you want to create an exchange.
   
   See “About exchanges” on page 646.

4. In the right pane, click **Add**.

5. Configure the properties for the exchange.

Editing and deleting exchanges

In Workflow Explorer, in the **SymQ Configuration** page, you can edit, delete, and save existing exchanges.
See “About Workflow Explorer” on page 638.

To edit exchanges

1. Open Workflow Explorer. See “Viewing Workflow Explorer” on page 639.
2. Click on the SymQ Configuration tab.
3. In the left pane, click on the exchange configuration in which you want to edit an exchange. See “About exchanges” on page 646.
4. In the right pane, click on the exchange that you want to edit.
5. Click Edit.
6. Click Save.

To delete exchanges

1. Open Workflow Explorer. See “Viewing Workflow Explorer” on page 639.
2. Click on the SymQ Configuration tab.
3. In the left pane, click on the exchange configuration in which you want to delete an exchange. See “About exchanges” on page 646.
4. In the right pane, click on the exchange that you want to delete.
5. Click Delete.

**Warning:** When you install Symantec Workflow, the default exchanges for SymQ are installed. Do not delete these exchanges; Workflow requires them. If you want to change these exchanges, add your own that override the defaults.

---

**Current Running Processes page**

This page lets you view all of the workflow processes that are running on the local computer. The workflow processes that are published but that are not currently running are not shown.

You can change the logging level for any currently running process by clicking the **Configure Logging** option. If you configure logging for a process, do not change its base directory. You can change the logging level of a currently running process...
to filter logging messages. For example, you can change the logging level from All to a specific logging level that you want to observe.

See “About Workflow Explorer” on page 638.

Configuring logging levels

A log message in Workflow can be one of five different levels: Fatal, Error, Warn, Info, and Debug. You can set the logging level for an individual log message or for an application. You can add log messages and set their levels with a Create Log Entry component in a workflow project.

In Workflow Explorer, the Currently Running Processes tab lists the running applications that are connected to the logging service. This list includes core Symantec Workflow applications, published projects, and the projects that are executed within a Designer debug session. Each process has a current logging level that is associated with it. The logging level is used to filter the messages that the application sends to the logging service. Messages are sent from a process with an assigned logging level.

See “About Workflow Explorer” on page 638.

To configure the logging level for an application

1. Click Start > Programs > Symantec > Workflow Designer > Tools > Workflow Explorer.
2. In Workflow Explorer, click the Current Running Processes tab.
3. Select a running process.
4. Click Configure Logging.
5. Choose your desired logging level, and then click OK.

To configure the logging level for an individual log message

1. In an open project, add a Create Log Entry component to the workspace.
2. Double-click this component to open its editor.
3. Configure the Log Entry Level to the level that you want.

SymQ Explorer page

This page lets you view all of the existing message exchanges by their type. The exchange types are listed in the left pane. Information about the exchanges is listed in the right pane.

See “About exchanges” on page 646.
You can expand the exchange types in the left pane to see individual exchanges. When you click on an exchange, its information appears in the right pane. In the upper right pane, you can click on individual exchange messages to view more information about them in the lower right pane.

See “About Workflow Explorer” on page 638.

Table 43-3  Information about exchanges in the SymQ Explorer page

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>The globally unique identifier (GUID) of the specific exchange message, including the process to which it applies.</td>
</tr>
<tr>
<td>Date</td>
<td>Shows the date and time when the message was created.</td>
</tr>
<tr>
<td>Payload</td>
<td>The value that the message carries. The payload includes different information for different messages, such as date, computer name, ID, and message value. For logs, the payload is the error message. For user logins, the payload is the user ID and login name.</td>
</tr>
<tr>
<td>Attr.</td>
<td>The number of attributes that an exchange message has.</td>
</tr>
<tr>
<td>Key</td>
<td>The name of the attribute.</td>
</tr>
<tr>
<td>Value</td>
<td>The value of the attribute.</td>
</tr>
<tr>
<td>Attribute Type</td>
<td>The data type of the attribute.</td>
</tr>
</tbody>
</table>

About exchanges

Workflow exchanges are the messages that Workflow-type processes send and receive through SymQ. You can view and manage exchanges in Workflow Explorer.

See “About Workflow Explorer” on page 638.

The different exchange types are as follows:

- **Alias**: Provides an alternate name for an exchange. This exchange is helpful if an exchange that is configured on one Exchange server needs to be accessed from a different server. Use the same alias name on both servers so that a program that is written to access the exchange works regardless of where it runs.

- **Async**: Delivers the messages in an asynchronous manner.
<table>
<thead>
<tr>
<th>Exchange Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Branching</td>
<td>Delivers the messages to multiple exchanges at the same time. This exchange is one of the exchange types that enables other exchanges to be linked to perform complex actions.</td>
</tr>
<tr>
<td>Synchronized</td>
<td>This exchange wraps other exchanges to provide the added feature of ensuring autonomous operations. Use this exchange type if you need to prevent multiple programs from simultaneously accessing the exchange.</td>
</tr>
<tr>
<td>Transactional</td>
<td>This exchange wraps around another exchange, and enables transactions-based message delivery and retrieval.</td>
</tr>
<tr>
<td>File Exchange</td>
<td>Writes the messages to a file system.</td>
</tr>
<tr>
<td>File Writer Exchange</td>
<td>Writes the messages as log items to a file system. Provides the built-in log file cleanup capabilities.</td>
</tr>
<tr>
<td>In Memory</td>
<td>In-memory storage.</td>
</tr>
<tr>
<td>Local Interceptor Filter</td>
<td>Used internally by Workflow Server.</td>
</tr>
<tr>
<td>Mail</td>
<td>Sends the messages through SMTP.</td>
</tr>
<tr>
<td>Message Delivery</td>
<td>Used internally by Workflow Server.</td>
</tr>
<tr>
<td>Registration</td>
<td>Used internally by Workflow Server.</td>
</tr>
<tr>
<td>Notification Server Event</td>
<td>Used internally by Workflow Server.</td>
</tr>
<tr>
<td>Null</td>
<td>Throws away the messages.</td>
</tr>
<tr>
<td>Output Writer</td>
<td>Writes the messages to Debug.Out.</td>
</tr>
<tr>
<td>Policy Cache</td>
<td>Wraps another exchange to control the messaging cache. It caches messages according to a defined policy. For example, messages can be removed based on the count or the size of the cache. The policy also provides options (least access, oldest, biggest) to determine which message to get rid of first.</td>
</tr>
<tr>
<td>Reliable</td>
<td>This exchange wraps other exchanges to provide reliable delivery to a target exchange. It defines a storage exchange and error exchange to maintain messages and make multiple delivery attempts.</td>
</tr>
<tr>
<td>Remote Server</td>
<td>Delivers to a remote server by TCP/IP. This exchange is used for access and exchange on a remote Exchange server.</td>
</tr>
<tr>
<td>SQL</td>
<td>Stores the messages in a SQL Server database.</td>
</tr>
</tbody>
</table>
Time Based Cache
This exchange wraps other exchanges to control the messaging cache. It caches messages based on the length of time that the message has been in the queue. This exchange is commonly used with the In Memory exchange to purge old messages from the memory based on time.

Compression
This exchange wraps another exchange to provide message compression and decompression.

Exchanges can be internal or external exchanges.

Table 43-4  Internal and external exchanges

<table>
<thead>
<tr>
<th>Exchange</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal</td>
<td>Can be referred to only by processes and other exchanges in the same application domain and exchange configuration set.</td>
</tr>
<tr>
<td>External</td>
<td>Can be referred to by any other exchange in any configuration set using the syntax <code>lme://servername/exchangename</code>.</td>
</tr>
</tbody>
</table>

Exchanges can be template or non-template exchanges.

Table 43-5  Template and non-template exchanges

<table>
<thead>
<tr>
<th>Exchange</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template</td>
<td>An extensible exchange that follows the syntax <code>exchangename-</code>. (All of the template exchanges must end with a dash.) Template exchanges do not exist as functional exchanges by themselves. You must complete the exchange call with a term after the dash in the template exchange name. For example, a template file exchange that is called <code>file-</code> must complete the syntax <code>file-contract</code>. In this case, the <code>file-</code> exchange is configured to write messages to a certain location in the file system (such as C:\messages\file-). When the <code>file-contract</code> call comes, the exchange creates the directory C:\messages\file-contract, and it delivers the file.</td>
</tr>
</tbody>
</table>
Table 43-5  Template and non-template exchanges (continued)

<table>
<thead>
<tr>
<th>Exchange</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-template</td>
<td>A standard, non-extensible exchange. Non-template exchanges exist as functional exchanges by themselves, and they cannot end with a dash. Use the exchange name exactly as it appears when you call a non-template exchange.</td>
</tr>
</tbody>
</table>

Exchange messages are part of exchange configurations. Exchange configurations are groups of the exchanges that are based on accessibility, and they help to simplify exchange management. You can group related collections of exchanges in exchange configurations.

The configurations are as follows:

Server

A **Server** exchange configuration is a computer-specific configuration. Exchange messages of this type exist in Workflow Server Extensions on the SymQ computer instead of only in the executing application domain.

Exchanges in this type of configuration are available for remote access from client computers or other server computers.

```
lme://servername/exchangename
```

DefaultLocal

A **DefaultLocal** exchange configuration is an application-specific configuration. Any **DefaultLocal** exchange that is instantiated and used exists only in the process that executes it. (The exchange exists only in the local application domain.)

The **DefaultLocal** configuration type is not a designation of the computer on which the exchange exists. Here the term **local** refers to the application that executes the exchange, not the computer.

If you create a **DefaultLocal** exchange message in one instance of the Messaging Console, the message is unavailable in another instance of the console. (It is available if you save the message to an available location, such as the file system.)

See “About the Messaging Console” on page 613.

You can refer to **DefaultLocal** exchanges without any server syntax.
SpecificLocal  

A **SpecificLocal** configuration is a computer-specific and directory-specific configuration. Exchanges in this configuration can be accessed only by the computer on which they are running. Any application that is running in the specific local directory to which the exchange is attached can also access the exchange.

---

**Warning:** When you install Symantec Workflow, the default exchanges for SymQ are installed. Do not delete these exchanges; Workflow requires them. If you want to change these exchanges, add your own exchanges that override the defaults.

---

The **Exchange Configuration** tab lists configurations and the defined exchanges for each configuration. This tab lets you create new configurations and add new exchanges. You can also modify a configuration by adding, editing, or deleting the associated exchanges.

You can add new exchanges to the default configuration or to your own custom configurations. Usually, you only need to add exchanges to the default configuration.

See “Changing an exchange configuration type” on page 642.

See “Monitoring message exchanges” on page 650.

---

**Exchange properties**

When you create new exchanges or edit existing ones in the **SymQ Explorer** tab in Workflow Explorer, each exchange type has its own set of properties.

See “About Workflow Explorer” on page 638.

See “SymQ Configuration page” on page 641.

Each exchange type (such as **Alias** and **Async**) has some properties that it shares with some other exchanges. Each exchange type also has some properties that are unique.

---

**Monitoring message exchanges**

You can monitor SymQ messages in real time in Workflow Explorer.

See “About SymQ” on page 639.
To monitor message exchanges

1. Click Start > Programs > Symantec > Workflow Designer > Tools > Workflow Explorer.
2. In Workflow Explorer, click the SymQ Explorer tab.
3. Select the exchanges that you want to monitor.

Log Viewer page

This page is available in Workflow Explorer. You can view, sort, and save log messages in the Log Viewer. Log messages refer to messages that workflow applications create, including published processes. You can access the Log Viewer only on a computer where it is installed.

See “Opening the Log Viewer” on page 612.
See “About Workflow Explorer” on page 638.
See “About the Log Viewer” on page 611.

Viewing log messages

You can view recent log messages for Workflow applications in Workflow Explorer. You can view older log messages as text files that are saved in a directory.

See “About SymQ” on page 639.

To view log messages as text files

1. Click C: > Program Files > Symantec > Workflow > Logs.
2. Open the folder with the name of the application that you want to view.
3. Locate the log message that you want to see in the text file.

To view messages in Workflow Explorer

1. Click Start > Programs > Symantec > Workflow Designer > Tools > Workflow Explorer.
2. In Workflow Explorer, click the Log Viewer tab.
   The Log Viewer displays messages for all of the processes that are connected to the logging service.

Credential page

This page is available in Workflow Explorer.
See “About Workflow Explorer” on page 638.
On this page you have access to the credential manager module of Workflow Explorer.
See “About Credentials Manager” on page 603.

Business TimeSpan Configuration page

This page is available in Workflow Explorer.
See “About Workflow Explorer” on page 638.
On this page you have access to the Business TimeSpan Editor module of Workflow Explorer.
See “About Credentials Manager” on page 603.

Directory Servers Groups page

This page lets you configure groups of servers for Process Manager Service Catalog item failover. You can configure groups of servers to provide failover support for each of the Service Catalog processes when the primary Process Manager server is unavailable. The servers that you configure in groups act as a series of backup computers; if one fails the next one in line takes its place. The goal is to help ensure the availability of your Service Catalog processes.
See “About Workflow Explorer” on page 638.

The Directory Servers Groups page in Symantec Explorer has a left pane and a right pane. Two tabs are in the left pane: Servers List and Groups List.

Servers List
When you click the Servers List in the left pane, a list of directory servers appears in the right pane.
This list identifies the servers that provide failover support for each of the Service Catalog processes if your primary server fails.
See “Adding the directory servers that provide failover support” on page 654.
When you click the **Groups List** in the left pane, a list of groups appears in the right pane.

The servers that provide failover support should be added as a group because the failover mechanism operates with groups, not with individual servers. Even if you plan to use only one server as a failover support, you must create a group for it.

See "Directory Servers Groups page" on page 652.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Lets you name the server that provides failover support: for example, Failover1.</td>
</tr>
<tr>
<td>FQDN</td>
<td>Lets you specify the fully qualified domain name: for example, <a href="http://www.somehost.symantecexample.com">www.somehost.symantecexample.com</a>.</td>
</tr>
<tr>
<td>Server IP</td>
<td>Lets you specify the IP address of the server that provides failover support.</td>
</tr>
<tr>
<td>Use HTTPS</td>
<td>Lets you use the HTTPS connection.</td>
</tr>
<tr>
<td>Active</td>
<td>Lets the server provide failover support.</td>
</tr>
<tr>
<td>Assigned Groups</td>
<td>Specifies a failover support group or groups to which the server belongs.</td>
</tr>
</tbody>
</table>

### Setting up Service Catalog failover

The failover mechanism lets you to set up a list of servers that provide failover support for each of the Service Catalog processes.

See "Directory Servers Groups page" on page 652.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Add directory servers.</td>
<td>You can add the directory servers that provide failover support for your Service Catalog processes. You can add as many directory servers as you need.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Adding the directory servers that provide failover support” on page 654.</td>
</tr>
</tbody>
</table>
Table 43-7  Process for setting up Service Catalog failover (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Add server groups.</td>
<td>You can add a new group for the servers that you want to use for failover purposes. The servers in the group will be used in their respective order. If the first server where a project is published cannot process the request, the next server in the list runs the published process. See “Adding server groups” on page 655.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Establish failover for the processes.</td>
<td>To finish the process of setting up Service Catalog failover you need establish the group as a failover group for your particular Service Catalog process. See “Establishing failover for Service Catalog processes” on page 656.</td>
</tr>
</tbody>
</table>

Adding the directory servers that provide failover support

You can add the directory servers that provide failover support for your Service Catalog processes. You can add as many directory servers as you need.

This task is a step in the process for setting up Service Catalog failover.

See “Setting up Service Catalog failover” on page 653.

To add the directory servers that provide failover support

1. On the Start menu, click Programs > Symantec > Workflow Designer > Tools > Symantec Explorer.
2. In Symantec Explorer, click the Directory Servers Groups tab.
3. In the left pane, click the Servers List tab.
4. In the right pane, take one of the following actions:
   - Click Add. Lets you add a new server for failover support.
   - Click Edit. Lets you edit the settings of an existing server that provides failover support.
5. In Add Directory Server window provide the respective information in the following fields:
   - Name
FQDN
Server IP
Use HTTPS
Active

See “Directory Servers Groups page” on page 652.

6 In the Assign Group list, select the server group to which the server should relate to.

Click Add.

If there is no assign group available, you can create a new one.

See “Adding server groups” on page 655.

7 Click OK.

Adding server groups

You can add a new group for the servers that you want to use for failover purposes. The servers in the group will be used in their respective order. If the first server where a project is published cannot process the request, the next server in the list runs the published process.

This task is a step in the process for setting up Service Catalog failover.

See “Setting up Service Catalog failover” on page 653.

See “Directory Servers Groups page” on page 652.

To add a new server group

1 On the Start menu, click Programs > Symantec > Workflow Designer > Tools > Symantec Explorer.

2 In Symantec Explorer, click the Directory Groups Servers tab.

3 In the left pane, click the Groups List tab.

4 In the right pane, take one of the following actions:

   Click Add. Lets you add a new server group for failover support.

   Click Edit. Lets you edit the settings of an existing server group that provides failover support.

5 In the Add Directory Group dialog box, in the Name text box, type a name for your group.
In the Assign Server list, select the server that you want to add to the group.

Click Add.

If you want to add more servers, repeat this step.

Click OK.

Establishing failover for Service Catalog processes

After you add the servers and the directories that you want to set up for Service Catalog failover, you can establish failover. To establish failover, you set the server group to provide failover support for Service Catalog processes.

This task is a step in the process for setting up Service Catalog failover.

See “Directory Servers Groups page” on page 652.

See “Setting up Service Catalog failover” on page 653.

To establish failover for Service Catalog processes

1 Log on to Process Manager as Administrator.

See “Opening Process Manager” on page 386.

2 On the Admin tab, click Service Catalog Settings.

3 In the Default pane, right-click on the bent arrow to the right of the desired process to reach the Action menu.

4 In the Action menu, click Edit Form, and then click Edit.

5 In the Service Catalog Edit form dialog box, on the Form information tab, in the Server Group list, select the group that you want to provide failover support.

6 Click Save.
Section 8

Settings and reference material

- Chapter 44. Workflow Designer preferences
- Chapter 45. Symantec Component Datatypes
Workflow Designer preferences

This chapter includes the following topics:

- Editing Workflow Designer preferences

Editing Workflow Designer preferences

You can change the preferences for Workflow Designer. The preferences apply to all Projects on the local computer.

To edit Workflow Designer preferences

1. Click Start > All Programs > Symantec > Workflow Designer > Workflow Manager.

2. Click Tools > Edit Preferences.

3. Make the changes that you want.

   See “Symantec component datatypes” on page 659.

4. Click OK.

   See “Studio Configuration page” on page 625.

   See “Designer page” on page 626.

   See “Debugging page” on page 632.

   See “Deployment page” on page 634.
Symantec Component Datatypes

This chapter includes the following topics:

- Symantec component datatypes

Symantec component datatypes

This section lists the datatypes that are available for Symantec components. See “About data types” on page 182.

Table 45-1  Symantec Incident Status

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Datatype</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Text</td>
</tr>
<tr>
<td>Value</td>
<td>Text</td>
</tr>
</tbody>
</table>

Table 45-2  Item Details

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Datatype</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applied to Collections</td>
<td>Text</td>
</tr>
<tr>
<td>Attributes</td>
<td>Text</td>
</tr>
<tr>
<td>Enabled</td>
<td>Text</td>
</tr>
<tr>
<td>GUID</td>
<td>GUID Format</td>
</tr>
<tr>
<td>Is Scheduled Item</td>
<td>Boolean</td>
</tr>
</tbody>
</table>
### Table 45-2  Item Details (continued)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Datatype</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long Type Name</td>
<td>Text</td>
</tr>
<tr>
<td>Name</td>
<td>Text</td>
</tr>
<tr>
<td>Parent folder GUID</td>
<td>GUID Format</td>
</tr>
<tr>
<td>Parent folder Name</td>
<td>Text</td>
</tr>
<tr>
<td>Schedule Enabled</td>
<td>Boolean</td>
</tr>
<tr>
<td>Schedule XML</td>
<td>Text</td>
</tr>
<tr>
<td>Shared Schedule GUID</td>
<td>GUID Format</td>
</tr>
<tr>
<td>Type GUID</td>
<td>GUID Format</td>
</tr>
<tr>
<td>Type Name</td>
<td>Text</td>
</tr>
</tbody>
</table>

### Table 45-3  Power Management Command (Drop Down)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Datatype</th>
</tr>
</thead>
<tbody>
<tr>
<td>WOL</td>
<td>Text Value</td>
</tr>
<tr>
<td>Get Client Config</td>
<td>Text Value</td>
</tr>
<tr>
<td>Send basic inventory</td>
<td>Text Value</td>
</tr>
</tbody>
</table>

### Table 45-4  Help desk Asset

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Datatype</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>Text</td>
</tr>
<tr>
<td>ID</td>
<td>ID</td>
</tr>
<tr>
<td>Location</td>
<td>Text</td>
</tr>
<tr>
<td>Name</td>
<td>Text</td>
</tr>
<tr>
<td>Resource GUID</td>
<td>GUID Format</td>
</tr>
<tr>
<td>Type_Lookup_Value</td>
<td>?</td>
</tr>
</tbody>
</table>
**Table 45-5**  Help desk Contact

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Datatype</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Email</td>
<td>Text</td>
</tr>
<tr>
<td>Contact ID</td>
<td>ID</td>
</tr>
<tr>
<td>Contact Name</td>
<td>Text</td>
</tr>
<tr>
<td>Contact Resource GUID</td>
<td>GUID Format</td>
</tr>
</tbody>
</table>

**Table 45-6**  Task Details

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Datatype</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Text</td>
</tr>
<tr>
<td>GUID</td>
<td>GUID Format</td>
</tr>
<tr>
<td>Input parameters</td>
<td>Complex Set</td>
</tr>
<tr>
<td>Description</td>
<td>Text</td>
</tr>
<tr>
<td>Display Name</td>
<td>Text</td>
</tr>
<tr>
<td>Internal Name</td>
<td>Text</td>
</tr>
<tr>
<td>Required</td>
<td>Boolean</td>
</tr>
<tr>
<td>Type</td>
<td>Text</td>
</tr>
<tr>
<td>Value</td>
<td>Text</td>
</tr>
<tr>
<td>Name</td>
<td>Text</td>
</tr>
<tr>
<td>Output Properties</td>
<td>Complex Set</td>
</tr>
<tr>
<td>Description</td>
<td>Text</td>
</tr>
<tr>
<td>Display Name</td>
<td>Text</td>
</tr>
<tr>
<td>Internal Name</td>
<td>Text</td>
</tr>
<tr>
<td>Required</td>
<td>Boolean</td>
</tr>
<tr>
<td>Type</td>
<td>Text</td>
</tr>
<tr>
<td>Value</td>
<td>Text</td>
</tr>
<tr>
<td>Type</td>
<td>Text</td>
</tr>
<tr>
<td>Field Name</td>
<td>Datatype</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Is Default</td>
<td>Text</td>
</tr>
<tr>
<td>Name</td>
<td>Text</td>
</tr>
<tr>
<td>Ordinal</td>
<td>Text</td>
</tr>
<tr>
<td>Status</td>
<td>Text</td>
</tr>
<tr>
<td>Ticket Category ID</td>
<td>ID</td>
</tr>
</tbody>
</table>
Workflow support matrix

This appendix includes the following topics:

- Workflow 8.0 support matrix

Workflow 8.0 support matrix

The support matrix provides an overview of the primary Workflow components and their supported operating systems. It displays the versions of the operating systems that are supported and the versions that are not supported in Workflow 8.0.

Table A-1  Workflow 8.0 support matrix

<table>
<thead>
<tr>
<th>Component/Category</th>
<th>Supported in 8.0</th>
<th>Support removed from 7.6 onwards</th>
</tr>
</thead>
</table>
| Workflow Server/Process Manager operating system (OS) | Windows Server 2008 R2  
Must have hot fix 971521 installed. See the Microsoft Support website at the following URL:  
http://support.microsoft.com/kb/971521  
Windows Server 2008 R2 SP1  
Windows Server 2012  
Windows Server 2012 R2 | N/A |
| Workflow Designer operating system (OS)    | Windows 7 x86 and x64  
Windows 7 SP1 x86 and x64  
All Workflow Server supported OS versions  
Windows 8.1 Update 1 x86 and x64  
Windows 8 x86 and x64  
Windows Server 2012  
Windows Server 2012 R2 | N/A |
### Table A-1  
Workflow 8.0 support matrix (continued)

<table>
<thead>
<tr>
<th>Component/Category</th>
<th>Supported in 8.0</th>
<th>Support removed from 7.6 onwards</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Manager browsers</td>
<td>■ Microsoft Internet Explorer 10, 11&lt;br&gt;■ Firefox 13 or later&lt;br&gt;■ Google Chrome 17 or later&lt;br&gt;■ Safari 5 and later</td>
<td>■ Microsoft Internet Explorer 7, 8, and 9</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Active Directory auto-authentication is supported in Internet Explorer, Google Chrome, and Firefox. For any additional configurations that may be required, see the following knowledge base article:</td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="#">Pass-thru Authentication with Chrome &amp; Firefox on ServiceDesk &amp; Workflow</a></td>
<td></td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>Supported 64-bit SQL Server versions are as follows:&lt;br&gt;■ Microsoft SQL Server 2005 SP4&lt;br&gt;■ Microsoft SQL Server 2008 SP2&lt;br&gt;■ Microsoft SQL Server 2008 SP3&lt;br&gt;■ Microsoft SQL Server 2008 R2 SP1&lt;br&gt;■ Microsoft SQL Server 2008 R2 SP2&lt;br&gt;■ Microsoft SQL Server 2012&lt;br&gt;■ Microsoft SQL Server 2012 SP1&lt;br&gt;■ Microsoft SQL Server 2014</td>
<td>■ 32-bit versions of SQL Server</td>
</tr>
<tr>
<td></td>
<td>Supported SQL Server editions are as follows:&lt;br&gt;■ Express&lt;br&gt;■ Workgroup&lt;br&gt;■ Standard&lt;br&gt;■ Developer&lt;br&gt;■ Enterprise&lt;br&gt;■ Datacenter</td>
<td></td>
</tr>
</tbody>
</table>

See "Workflow scalability" on page 50.
Load Balancing

This appendix includes the following topics:

- About load balancing
- Example topology of a load-balanced cluster
- Setting up load balancing
- Installing load balancing
- Things to note during installation
- Reconfiguring the Process Manager Sessions exchange and Workflow Response Queue to persist data to SQL before load balancing
- Editing load balancing cluster nodes
- Configuring Active Directory sync and scheduled reports
- Optional instructions for setting up a dedicated background processing server

About load balancing

You can configure Workflow and ServiceDesk to support configurations where one server provides all of the product capabilities. They can also support the configurations that use load balancing technologies.

If your plans involve only a lab environment or a very small environment, load balancing probably does not apply to you. However, if you plan to set up a medium or a large environment or anticipate aggressive growth in the next three to five years, you should consider configuring load balancing from the outset.

In a large environment, load balancing is recommended to let more users access the Process Manager portal, to relieve pressure on a single-server computer, and to allow for scalability and still maintain a single data source.
The benefits of load balancing are as follows:

- Front-end servers can be added to scale with the needs or your organization
- Additional front-end nodes can be added easily as requirements change
- Front-end servers can be stopped, started, and restarted as needed since there are other nodes to handle service requests when one server is unavailable

Things you should be aware of before you attempt load balancing:

- Load balancing only affects front-end client access. One server is required to handle background processing. This means that any interruptions to the server that handles background processing may cause service interruptions.
- Front-end client access is only one component of system performance. If you have multiple, heavily-used, front-end servers and an under-powered SQL environment, performance is still affected. You should consider all aspects of your environment to ensure optimal performance. You cannot use load balancing to make up for other performance deficiencies.

**Note:** This document only includes the basics of installing load balancing. Before attempting to set up load balancing you should contact your vendor for instructions and for support.

See “Example topology of a load-balanced cluster” on page 666.

See “Setting up load balancing” on page 669.

**Example topology of a load-balanced cluster**

This example implementation may not apply to every environment.
Load Balancing

Example topology of a load-balanced cluster

Platform server
- Symantec Management Platform
- Workflow and ServiceDesk

SQL server of SQL cluster

Front-end servers
- Workflow and ServiceDesk
- Process Manager
- Software-based load balancing
- (optional) Background processing enabled on one

Dedicated background processing server (optional)
- Workflow and ServiceDesk
- Process Manager
<table>
<thead>
<tr>
<th>Device</th>
<th>Connected to</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Platform server</td>
<td>Front-end server computer</td>
<td>Symantec Management Platform server. You need a platform server if you plan to deploy the Workflow projects that can integrate platform functions. You can download the Workflow Installer from the platform server.</td>
</tr>
<tr>
<td>SQL Server or SQL Cluster</td>
<td>Front-end servers</td>
<td>Database and analysis server. Instructions for setting up a SQL Cluster are not covered in this document. Please refer to Microsoft documentation for instructions.</td>
</tr>
<tr>
<td>Front-end servers (2+)</td>
<td>Platform server and SQL server</td>
<td>Process Manager portal: application server. If you do not have a dedicated background processing server or hardware load balancer, select one of these servers to do the background processing. If you are load balancing your ServiceDesk environment, you must enable <strong>Timeouts and Escalations</strong> to enable background processing. See &quot;Things to note during installation&quot; on page 671.</td>
</tr>
<tr>
<td>Dedicated background processing server (optional)</td>
<td>Platform server and SQL server</td>
<td>In some environments it is preferable to have a dedicated background processing server. However, you can also enable background processing on one of your front-end servers. See &quot;Optional instructions for setting up a dedicated background processing server&quot; on page 676.</td>
</tr>
</tbody>
</table>
Note: You can also set up a hardware load balancer. The hardware load balancer is a pair of hardware IP load balancers and connects to the Platform server and front-end server computer. Symantec does not provide steps for setting up a hardware load balancer. Please refer to your vendor documentation for instructions.

See “About load balancing” on page 665.

Setting up load balancing

This section includes instructions for setting up a load-balanced environment for Workflow or ServiceDesk.

Table B-2  
To set up load balancing

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Plan your environment</td>
<td>See the ServiceDesk Implementation Guide.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Install network load balancing</td>
<td>See “Installing load balancing” on page 670.</td>
</tr>
</tbody>
</table>
| Step 3  | Install Workflow and ServiceDesk            | Install Workflow platform and ServiceDesk modules using the ServiceDesk installer. For instructions, see the ServiceDesk Implementation Guide.  
Depending on how you set up background processing you need to complete some additional configuration steps.  
See “Things to note during installation” on page 671.  
See “Optional instructions for setting up a dedicated background processing server” on page 676. |
### Table B-2  
To set up load balancing (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 4 | Reconfigure the Process Manager Sessions exchange before load balancing | Before you can implement load balancing effectively, you must configure Process Manager sessions for the servers. The Process Manager Sessions exchange must be reconfigured to store sessions in the database.  
See “Reconfiguring the Process Manager Sessions exchange and Workflow Response Queue to persist data to SQL before load balancing” on page 673. |
| Step 5 | Edit load balancing cluster nodes                                      | See “Editing load balancing cluster nodes” on page 675.                                                                                                                                                   |
| Step 6 | Configure Active Directory sync and scheduled reports                 | See “Configuring Active Directory sync and scheduled reports” on page 675.                                                                                                                                  |

See “About load balancing” on page 665.

---

### Installing load balancing

Install load balancing on all front-end servers in your environment. Because you can choose between different methods to set up load balancing, contact your vendor for instructions and for support.

These steps are to server as a reference for those who want to install Microsoft Network load balancing. For the complete instructions, see the following link:


---

**Note:** Although instructions for installing Microsoft Network load balancing are provided, Symantec is not responsible for supporting this part of the configuration. Please contact your load balancing software vendor for support.
To install Microsoft Network Load Balancing

1. Install both Windows 2008 Servers and install prerequisites per the normal installation guides. All servers should have static IP addresses assigned.

2. Reserve one static IP address in addition to the ones that are used on the nodes for the virtual IP address of the cluster.

3. Open Server Manager and under Features add the Network Load Balancing feature on all servers that are part of the network load balancing cluster.

4. On one of the servers, open Network Load Balancing Manager. Click Cluster > New. In the Host field, type the name of the server from which you are running the install.

5. Select the Interface for the cluster. Click Next.

   In most situations, the interface is the only one with a valid IP address on the network.

6. Leave the Priority set to the default of 1. Click Next.

7. Click Add and specify the IP address and subnet mask for the reserved address from Step 2. Click Next.

   The address should be a unique address that is not assigned to any of the cluster nodes.

8. Type the name of the fully qualified name of the cluster. Click Next

   This name needs to be set up in DNS to resolve the virtual IP address that was set up in Step 2.

9. Highlight the newly created cluster and then click Cluster > Add Host.

10. Put in the name of one of the other nodes that is added to the cluster.

11. Select the correct interface for that server. Click Next.

12. Click Next and then Finish.

   Wait until both nodes in the cluster show as Converged. This means that the cluster has been successfully created. If there are more than two nodes being added to the cluster, repeat steps 11-15 until all nodes show up as added and converged.

Things to note during installation

When installing Workflow and ServiceDesk you must use the same Root URL on every server. It must match exactly and be the name that resolves to the virtual IP address of your Network load balancing Cluster. For example, you install two nodes named ‘frontend1.symantec.local’ (192.168.1.101) and ‘frontend2.symantec.local’
You then add them to a cluster named ‘cluster.symantec.local’ (192.168.1.10). When you install Workflow on these nodes they must all be installed using the name ‘cluster.symantec.local’.

**Warning:** All nodes must be configured identically and point to the same SQL server and database. If they are not, load balancing may not work and you may have unexpected problems with your system.

### Setting up background processing with ServiceDesk

The current ServiceDesk installation does not have an option to disable background processing. You only want to enable background processing on the dedicated background processor or the one ServiceDesk server that is designated to do background processing. To disable background processing on all other servers, complete the following steps after installation.

See “Example topology of a load-balanced cluster” on page 666.

**To disable background processing**

1. Open **LocalMachineInfo Editor**.
2. In the **Machine Settings** dialog box in the **Local Machine** section, check **Do Not Process Timeouts And Escalations**.
3. Click **OK**.

### Installing the Front End Servers

When you install the Front End Servers, take note of the following steps. These servers should already have access to the supported version instance of SQL Server, since it communicates with an off-box database. The database server should have a fully patched instance of the supported version instance of SQL Server running on it. It should also have mixed mode or SQL-only authentication enabled.

**To install the Front End Servers**

1. Before you begin this process, shut down all nodes except for the one on which you plan to install Workflow Server.
2. Start the installer.

**Note:** On the first computer that you install Front End Server, select **Create** for the database on the **Database Access** page. On all additional Front End Server installations, select **Update** since the database has already been created.
3 On the Server Roles page, check everything except Background Processing. You must select background processing on the dedicated background processing server or Workflow Server that performs background processing. See “Example topology of a load-balanced cluster” on page 666.

4 Set the Base URL to the address or the domain name of the load balancer.

5 On the Database Connection page, configure the data source to point to your database server.

6 Make sure that Workflow Persistence is set to use SQL persistence (is based on SQL Server Database). Make sure that the database connection is set to Use Process Manager Settings.

7 Wait for the Workflow environment to completely install on the Front End Server before continuing.

Reconfiguring the Process Manager Sessions exchange and Workflow Response Queue to persist data to SQL before load balancing

Before you can implement load balancing effectively, you need to configure Process Manager Sessions for the Workflow and dedicated background processing servers. The Process Manager Sessions exchange must be reconfigured to store sessions in the database. You must also configure the Workflow Response Queue to persist data to SQL.

To reconfigure the Process Manager Sessions exchange

1 Open Workflow Explorer, and in the toolbar at the top of the page, click the SymQ Configuration.

2 In the SymQConfiguration section, click Process Manager.

3 In the Process Manager section, click Add.

4 In the Select Exchange Type dialog box, click SqlExchangeConfiguration and then click OK.

5 In the Edit Exchange dialog box in the Exchange Name field, type the name ProcessManagerSqlStorage.

6 In the SQL section, type the SQL connections details.

7 To the right of the Sql Connection String field, click the ellipsis.

8 In the Connection String Editor dialog box, click Test Connection. Do not go to the next step until the SQL connection is verified.
9 In the **Edit Exchange** dialog box in the **Global Settings** section, check **Is Template Configuration** and uncheck **Is External Config**.

10 Click **OK**.

**ProcessManagerSqlStorage** appears in the list of exchanges.

11 In the **Process_Manager** section, click **LBME.ProcessManagerSessions** and then click **Edit**.

12 In the **Deliver to Queue** drop-down list, click **ProcessManagerSqlStorage-**.

13 In the **Deliver to Queue** field at the end of **ProcessManagerSqlStorage-**, type **ProcessManagerSessions**.

   The cache name should look like the following:

   **ProcessManagerSqlStorage- ProcessManagerSessions**

14 Click **OK**.

15 In the **Process_Manager** section, click **Save**.

**To reconfigure the Workflow Response Queue**

1 Open **Workflow Explorer**, and in the toolbar at the top of the page, click the **SymQ Configuration**.

2 In the **SymQConfigurations** section, click **Workflow_Core**.

3 In the **Workflow_Core** section, select **LBME-WorkflowResponseQueue** and then click **Edit**.

4 In the **Edit Exchange** dialog box, in the **Deliver To** section, in the **Deliver To Queue** drop-down, click **local.workflowsqlexchange-**.

5 In the **Deliver To Queue** box, at the end of **local.workflowsqlexchange-**, type **LBME.WorkflowResponseQueue**.

   The **Deliver To Queue** should be

   **local.workflowsqlexchange-LBME.WorkflowResponseQueue**

6 Click **OK**.

7 In the **Workflow_Core** section, click **Save**.

8 Repeat these steps for each node of the load-balanced cluster.

**To edit the Workflow dialog session timeout**

1 Open **Workflow Explorer**, and in the toolbar at the top of the page, click the **SymQ Configuration**.

2 In the **SymQConfigurations** section, click **SymQ_Local_Defaults**.
3 In the `SymQ_Local_Defaults` section, click `local.sessions` and then click `Edit`.

4 In the `Edit Exchange` dialog box in the `Max Object Life Time` field, type the amount of time that you want the object to stay cached.

---

**Note:** If you are running a cluster, this value should be less than the session stickiness timeout that you set at the load balancer.

---

5 Click `OK`.

6 In the `SymQ_Local_Defaults` section, click `Save`.

---

**Editing load balancing cluster nodes**

The other difference is that each node in a load balancing cluster needs to be edited in a specific place to point to itself rather than the cluster name.

You must do this action on every node that is part of a Network load balancing cluster.

**To edit load balancing cluster nodes**

1 Open `LocalMachineInfo Editor`.

2 In the `Machine Settings` dialog box, select `(local)` and click `Edit`.

3 In the `Edit Object` dialog box in the `IPAddress` field, type `127.0.0.1`.

4 Both the IP address and the Deployment Root URL point to the cluster name that was used during the install. The Deployment Root URL should not be changed, but the IP address should be changed to `127.0.0.1` to force it to perform operations locally.

5 Click `OK`.

6 In the `Machine Settings` dialog box, click `OK`.

---

**Configuring Active Directory sync and scheduled reports**

This option in `Portal Master Settings` must be configured in a load-balanced environment. It affects scheduled events such as Active Directory sync and scheduled reports. This option designates a specific server to execute those types of functions. You should not have Active Directory sync configured on all Front End servers. Only one server should be configured to run Active Directory sync.
To configure a Background Server for Active Directory sync and scheduled reports

1 In Process Manager, click **Admin > Portal > Master Settings**.

2 On the **Process Manager Settings** page, expand the **Process Manager Settings** section.

3 In the **Background Server** field, type the name of the server that you set up to handle background processing and Timeouts and Escalations during installation.

4 Scroll to the bottom of the page and click **Save**.

5 Restart IIS on all Process Manager servers.

Optional instructions for setting up a dedicated background processing server

Considering the high load environments, you can off load the work of background processing from any of your your Front End servers, by configuring a dedicated background processing server. This may improve Process Manager portal performance. The dedicated background server is an additional server that you add to your environment to handle only background processing. This server does not handle any front-end portal traffic.

The dedicated background processing server is set up the same as your front-end servers. The only differences are that this server exists outside the load balancing cluster, and it has background processing enabled.

After you set up your dedicated background processing server, you must disable background processing on all other servers.

See “Setting up background processing with ServiceDesk” on page 672.
Create your first project with the Web Application Project Type

This appendix includes the following topics:

- About the Service Catalog Request Template
- Part 1: Planning your process
- Part 2: Creating a request process
- Part 3: Setting up the process and creating the approval and the implementation tasks
- Part 4: Debugging the process, creating a process profile, and creating a report

About the Service Catalog Request Template

The Service Catalog Request Template is a template that you can import into Workflow Designer and use to create your own process. The Service Catalog Request Template contains most of the required aspects of a "simple" process that you can modify to meet your needs. The purpose of the Service Catalog Request Template is to provide you with a way to create and deploy processes in less time.

Note: The Service Catalog Request Template is built using the Web Application Project Type; therefore, you can only install it in Workflow 7.5 and later environments.

The template contains the following pre-built components: request, approval, implementation, fulfillment, and reporting/audit trail. The template has two models.
These instructions provide an example of how to use this template to build a full Request - Approval - Fulfillment process in Workflow. You can reuse these same steps to plan design and implement similar processes. In this example, you can create an example process for a vendor request. This example demonstrates how to create a fully functional process from start to finish. It also reveals best practices for using the Workflow Designer tool and creating processes and reports.


See “Part 2: Creating a request process” on page 683.

See “Part 3: Setting up the process and creating the approval and the implementation tasks” on page 695.

See “Part 4: Debugging the process, creating a process profile, and creating a report” on page 706.

You can access four videos on Symantec Connect that walk you through this process. These videos contain all of the steps in this document as well as some additional tips. However, the videos do not contain the example process planning and blank process planning tables that are included in these instructions.

### Table C-1

<table>
<thead>
<tr>
<th>Video</th>
<th>Length</th>
</tr>
</thead>
</table>
Part 1: Planning your process

Before you create your process, you should scope the project and collect all the necessary data. This section includes tips on scoping and provides a sample process planning table for the Vendor Request process.

Keep your processes small and uncomplicated, especially if it is your first time creating a process. Symantec recommends creating phases for processes rather than creating a huge process initially. Using this method can make your processes more useful and successful.

Another benefit to the phasing process is that you can use metrics to see if your process is successful. You can also get user feedback and improve the process as you expand it.

Table C-2  Process for planning your Vendor Request process

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Scope your process and collect necessary data.</td>
<td>Use the process planning tables to scope and collect the necessary data for your Vendor Request process. Use the Identify the participants table, Table C-4, to identify the participants in the process. Use Identify the process table, Table C-5, to identify the key parts of the process.</td>
</tr>
</tbody>
</table>

Table C-3  Creating a Workflow using the Service Catalog Request template

<table>
<thead>
<tr>
<th>Video</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a Workflow using the Service Catalog Request Template - Part 1</td>
<td>8:35</td>
</tr>
</tbody>
</table>

Step 1: Creating a process plan for your Vendor Request process

Table C-4  Identify the participants

<table>
<thead>
<tr>
<th>Question</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who is this process for?</td>
<td>■ Individual employees who need services from vendors  ■ Managers who need services from vendors</td>
</tr>
<tr>
<td>Who makes these requests?</td>
<td>■ Employees  ■ Managers</td>
</tr>
</tbody>
</table>
### Table C-4  Identify the participants (continued)

<table>
<thead>
<tr>
<th>Question</th>
<th>Notes</th>
</tr>
</thead>
</table>
| What are the levels of approval? | ■ Approval Task  
■ Fulfillment Task: Create Active Directory Account  
■ Fulfillment Task: Create Purchase Order |
| Who is the approver (person, group, organizational unit, or permission) for each level of approval? | ■ Approval Task : admin@symantec.com  
■ Fulfillment Task to create an Active Directory account : admin@symantec.com  
■ Fulfillment Task to create a purchase order : admin@symantec.com |
| Who fulfills these requests? | ■ admin@symantec.com |
| What are the requirements for each participant in the process? Can I automate any parts of my process to make the process run smoother? | ■ Employee  
Have a form available that is easy to access and fill out.  
Make sure that the form does not ask for more information than they have or want to provide.  
■ Approver  
See information about the vendor.  
Understand why a request has been submitted for the item.  
Be able to reassign the request to someone else. |

### Table C-5  Identify the process

<table>
<thead>
<tr>
<th>Question</th>
<th>Notes</th>
</tr>
</thead>
</table>
| What data will this process capture? | Data:  
■ Vendor information  
■ Contact information  
■ Contract information |
| What are the steps in this process? | Request form:  
■ Vendor information  
■ Contract information  
■ Cost center and project  
■ Documents  
Approval Task:  
■ Does the approver have the ability to alter the request?  
Implementation Tasks:  
■ Add vendor to Active Directory.  
■ Create purchase order. |
<table>
<thead>
<tr>
<th>Question</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>What components does this process need?</td>
<td>Fields already built in to the template:</td>
</tr>
<tr>
<td></td>
<td>■ Title</td>
</tr>
<tr>
<td></td>
<td>■ Description</td>
</tr>
<tr>
<td></td>
<td>■ Comments</td>
</tr>
<tr>
<td></td>
<td>■ Status</td>
</tr>
<tr>
<td></td>
<td>■ Start date</td>
</tr>
<tr>
<td></td>
<td>■ Complete date</td>
</tr>
<tr>
<td></td>
<td>■ Process Contacts:</td>
</tr>
<tr>
<td></td>
<td>■ Submitter</td>
</tr>
<tr>
<td></td>
<td>■ Primary contact</td>
</tr>
<tr>
<td></td>
<td>■ Approver</td>
</tr>
<tr>
<td></td>
<td>■ Implementor</td>
</tr>
<tr>
<td></td>
<td>The additional fields that are specific to this process and need to be added:</td>
</tr>
<tr>
<td></td>
<td>■ Company name</td>
</tr>
<tr>
<td></td>
<td>■ Company address</td>
</tr>
<tr>
<td></td>
<td>■ Contact name</td>
</tr>
<tr>
<td></td>
<td>■ Contact email</td>
</tr>
<tr>
<td></td>
<td>■ Contact phone number</td>
</tr>
<tr>
<td></td>
<td>■ Contract start date</td>
</tr>
<tr>
<td></td>
<td>■ Contract end date</td>
</tr>
<tr>
<td></td>
<td>■ Active Directory account required</td>
</tr>
<tr>
<td></td>
<td>■ Estimated contract value</td>
</tr>
<tr>
<td></td>
<td>■ Cost center</td>
</tr>
<tr>
<td></td>
<td>■ Documents</td>
</tr>
<tr>
<td>What data points do I need to add to enable long-term reporting?</td>
<td>Data points:</td>
</tr>
<tr>
<td></td>
<td>■ Report process ID</td>
</tr>
<tr>
<td></td>
<td>■ Process started</td>
</tr>
<tr>
<td></td>
<td>■ Process ended</td>
</tr>
<tr>
<td></td>
<td>■ Status</td>
</tr>
<tr>
<td></td>
<td>■ Process actions</td>
</tr>
<tr>
<td></td>
<td>■ Company name</td>
</tr>
<tr>
<td></td>
<td>■ Contact name</td>
</tr>
<tr>
<td></td>
<td>■ Cost center</td>
</tr>
<tr>
<td></td>
<td>■ Estimated contract value</td>
</tr>
</tbody>
</table>

See “About the Service Catalog Request Template” on page 677.
See “Part 2: Creating a request process” on page 683.

Blank process planning tables

Table C-6 Identify the participants

<table>
<thead>
<tr>
<th>Question</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Who is this process for?</td>
<td></td>
</tr>
<tr>
<td>Who makes these requests?</td>
<td></td>
</tr>
<tr>
<td>What are the levels of approval?</td>
<td></td>
</tr>
<tr>
<td>Who is the approver (person, group, organizational unit, or permission) for each level of approval?</td>
<td></td>
</tr>
<tr>
<td>Who fulfills these requests?</td>
<td></td>
</tr>
<tr>
<td>What are the requirements for each participant in the process?</td>
<td></td>
</tr>
<tr>
<td>Can I automate any parts of my process to make the process run smoother?</td>
<td></td>
</tr>
</tbody>
</table>

Table C-7 Identify the process

<table>
<thead>
<tr>
<th>Question</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>What data will this process capture?</td>
<td></td>
</tr>
<tr>
<td>What are the steps in this process?</td>
<td></td>
</tr>
<tr>
<td>What components does this process need?</td>
<td></td>
</tr>
<tr>
<td>What data points do I need to add to enable long-term reporting?</td>
<td></td>
</tr>
</tbody>
</table>
Part 2: Creating a request process

After you have finished planning out your vendor request process, you can download the ServiceCatalog.Request.Template.zip file, extract the files, and load the template. Then, you can begin creating your vendor request process.

### Table C-8  Process for creating a request process

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 1 | Download and install the template. | Download and install the ServiceCatalog.Request.Template.zip file and extract the files.  
Step 1: To download and install the Service Catalog Request template |
| Step 2 | Change the name of the process. | Change the name of the template to match the name of your process: VendorRequest and load the template.  
Step 2: To rename and load the template |
| Step 3 | Configure the template deploy option. | Change the process prefix to VR - for Vendor Request.  
Step 3: To configure the template deploy option |
| Step 4 | Configure the request form. | Start configuring the New Request Form.  
Step 4: To start configuring the New Request Form |
| Step 5 | Create a single request ORM data type. | Instead of building each required field individually, you can create an ORM data type to house all of the fields. The ORM data type lets the process pass a single request variable that includes all the fields of the request.  
Step 5: To create a single request ORM Data Type |
| Step 6 | Configure the request form. | Finish configuring the New Request Form.  
Step 6: To finish configuring the New Request Form |
| Step 7 | Configure the request confirmation form. | Configure the Request Confirmation page so the user can see all of the details that they entered in the New Request Form before they submit it.  
Step 7: To Configure the Request Confirmation Form |
Table C-9  Creating a Workflow using the Service Catalog Request template

<table>
<thead>
<tr>
<th>Video</th>
<th>Length</th>
</tr>
</thead>
</table>

Step 1: To download and install the Service Catalog Request template

1. Download the ServiceCatalog.Request.Template.zip file that is attached to the following video:

   Create a Workflow using the Service Catalog Request Template - Part 1 at www.symantec.com/connect/videos/create-workflow-using-service-catalog-request-template

2. Extract the file and save the ServiceCatalog.Request.Template.package file in the following location on the Workflow Designer computer:

   Program Files > Symantec > Workflow > Designer > Templates

Step 2: To rename and load the template

1. In Workflow Manager, click File > New Project.

2. In the New Project dialog box, on the Template Projects tab, in the Name text box, type the name of your process.

   For example, type VendorRequest.

3. Click OK.

Step 3: To configure the template deploy option

1. In Workflow Designer, in the Project pane, click the top level of the project tree: (VendorRequest).

2. On the Reporting tab, in the Process Prefix text box, change the prefix to VR- for Vendor Request

Step 4: To start configuring the New Request Form

1. In the Project pane, in the project tree, click Model: RequestForm.

2. In the project workspace, double-click the Create New Request Form component.

3. In the Web Form Editor dialog box, to configure the template header theme, double-click the Service Catalog Request field.

4. In the Template Editor dialog box, double-click the Service Catalog Request field.
5 In the **Edit Component** dialog box, on the **Appearance** tab, in the **Text** box, replace *Service Catalog Request* with *Vendor Request*. Then click **OK**.

6 In the **Template Editor** dialog box, click **OK**.

The new template theme title now appears on all of the process pages.

7 In the **Web Form Editor** dialog box, delete the **Request Title** field.

This field is not needed for this process.

- Press **Ctrl** and select the **Request Title** label and its information field.
- Right-click one of the selected items and click **Delete**.

8 Double-click the **Who is this request for?** field.

9 In the **Edit Component** dialog box, on the **Appearance** tab, in the **Text** box, replace *Who is this request for?* with *Primary Internal Contact:*. Then click **OK**.

10 In the **Web Form Editor** dialog box, double-click the **Request Information** field.

11 In the **Edit Component** dialog box, on the **Appearance** tab, in the **Text** box, replace *Request Information: with Additional Details:* with *Additional Details:*. Then click **OK**.

12 In the **Web Form Editor** dialog box, to return to the project workspace, click **OK**.

**Step 5: To create a single request ORM Data Type**

1 In Workflow Designer, in the **Toolbox** pane, click **New Integration Library**.

2 In the **New Library** dialog box, in the **Name** box, for the name of the library, type *VendorRequestLib*, and then click **OK**.

3 In the **Create Generator** dialog box, in the **Name** box, for the name of the generator, type *VendorRequest*.

4 In the **Generator types** section, under **Authoring**, select **User Defined Type with DB Mapping**, and then click **OK**.

   This step creates a table in the Process Manager database to house all of the data that this process collects. This table lets you see the data in the **Process View** pages, as well as stores it for long-term reporting.

5 In the **VendorRequest** create generator wizard, on the **Type Designer** page, click **Add > Add Class**.

6 In the **Add Type** dialog box, in the **Name** box, for the name of the class, type *VendorRequest*, and then click **Add**.

7 In the wizard, select the *VendorRequest* class that you created, and then click **Add Property**.
8 In the Add Property dialog box, perform the following actions:

- In the Name box, for the name of the field, type SessionID.

Note: Symantec recommends that when you use the ORM Data Type that you first create a SessionID field.

- In the Type drop-down list, click Text.

- Click Add Another.
  In the wizard, the SessionID field now appears in the VendorRequest tree.
9  Add the fields for the data that the process is to collect and assign each field its corresponding type as follows:

In the Name box, type: **CompanyName**
In the Type drop-down list, click **Text**, and then click **Add Another**.

In the Name box, type: **CompanyAddress**
In the Type drop-down list, click **Text**, and then click **Add Another**.

In the Name box, type: **ContractName**
In the Type drop-down list, click **Text**, and then click **Add Another**.

In the Name box, type: **ContractEmail**
In the Type drop-down list, click **Text**, and then click **Add Another**.

In the Name box, type: **ContractPhone**
In the Type drop-down list, click **Date** (DateTime), and then click **Add Another**.

In the Name box, type: **ContractStartDate**
In the Type drop-down list, click **Date** (DateTime), and then click **Add Another**.

In the Name box, type: **ContractEndDate**
In the Type drop-down list, click **Logical** (true/false), and then click **Add Another**.

In the Name box, type: **ADAccountRequired**
In the Type drop-down list, click **Number** (decimal), and then click **Add Another**.

In the Name box, type: **EstimatedContractValue**
In the Type drop-down list, click **Text**, and then click **Add**.

In the Name box, type: **CostCenter**

**Note:** The documents field is to be added later.

10  In the wizard, click **Next** until you reach the **Components** page.

11  On the **Components** page, check **VendorRequest**, and then click **Finish**.

12  In the **Generators Management** dialog box, click **OK**.

13  In the **Integration Library** dialog box, double-click **Compile and close**.
14 Close the VendorRequestLib - Help Editor, and in the VendorRequestLib dialog box, to save the file click Yes.

15 In the Configure Relational Types dialog box, to save the data to the Process Manager database, check Generated.VendorRequestLib.VendorRequest. Then, click OK.

16 In the Project pane, in the project tree, click Model: RequestForm.

17 In the project workspace, double-click the Initialize Data component.

18 In the Initialize Data Variable dialog box, on the Configuration tab, to create a container variable, click Add.

19 In the Edit Object dialog box, next to the Data Type box, click the … symbol.

20 In the Select Data Type dialog box, expand VendorRequestLib, click VendorRequest, and then click OK.

21 In the Edit Object dialog box, in Variable Name box, for the name of the variable, type Request, and then click OK.

22 In the Initialize Data Editor dialog box, click OK.

Step 6: To finish configuring the New Request Form

1 In the Project pane, in the project tree, click Model: RequestForm.

2 In the project workspace, double-click the Create New Request Form component.

3 In the Web Form Editor dialog box, in the left pane under Variables, expand Request.

4 Check the following data fields, drag them to the center pane, and then complete the steps in the Build Wizard as follows:

Check ContractEndDate.  
- Drag the data field and position it on the form.  
- In the Build Wizard, click DatePickerBuilder [DateTime].  
- Click Next.  
- Click Required, and then click Finish.

Check ContractStartDate.  
- Drag the data field and position it on the form.  
- In the Build Wizard, click DatePickerBuilder [DateTime].  
- Click Next.  
- Click Required, and then click Finish.
Check **ADAccountRequired**
- Drag the data field and position it on the form.
- In the **Build Wizard**, click `CheckBoxBuilder [Boolean]`.
- Click **Next**.
- Click **Required**, and then click **Finish**.

Check **CompanyAddress**
- Drag the data field and position it on the form.
- In the **Build Wizard**, click `InputBuilder [String]`.
- Click **Next**.
- Click **Required**, and then click **Finish**.

Check **CompanyName**
- Drag the data field and position it on the form.
- In the **Build Wizard**, click `InputBuilder [String]`.
- Click **Next**.
- Click **Required**, and then click **Finish**.

Check **ContractEmail**
- Drag the data field and position it on the form.
- In the **Build Wizard**, click `InputBuilder [String]`.
- Click **Next**.
- Click **Required**, and then click **Finish**.

Check **ContractName**
- Drag the data field and position it on the form.
- In the **Build Wizard**, click `InputBuilder [String]`.
- Click **Next**.
- Click **Required**, and then click **Finish**.

Check **ContractPhone**
- Drag the data field and position it on the form.
- In the **Build Wizard**, click `InputBuilder [String]`.
- Click **Next**.
- Click **Required**, and then click **Finish**.
Check CostCenter

- Drag the data field and position it on the form.
- In the Build Wizard, click InputBuilder [String].
- Click Next.
- Click Required, and then click Finish.

Check EstimatedContractValue

- Drag the data field and position it on the form.
- In the Build Wizard, click InputBuilder [Decimal].
- Click Next.
- Click Required, and then click Finish.

5 In the form, organize the vendor request fields.

6 Add labels for the ContractStartDate and ContractEndDate variables.

For example, in the form, copy an existing label and change the text as follows:
- Right-click the **CompanyAddress** field and click **Copy**.
- Right-click a blank area of the form, and click **Paste**.
- Double-click the **CompanyAddress** field.
- In the **Edit Component** dialog box, on the **Appearance** tab, in the **Text** box, replace **CompanyAddress** with **ContractStartDate**: or with **ContractEndDate**.
- Click **OK**.
- Position the label next to the appropriate variable.

7 Edit the labels of the variables to include spaces and colons as follows:

The users see the labels when they fill out the form.
- Double-click a label.
- In the **Edit Component** dialog box, on the **Appearance** tab, in the **Text** box, modify the label.
- Click **OK**.

8 Edit the text style of the labels of the variables as follows:
- Double-click a label.
- In the **Edit Component** dialog box, on the **Appearance** tab, in the **Theme Style** drop-down list, select a style.
  - To duplicate the text style of the **Primary Internal Contact** label, click **.Field Label Required**.
- Click **OK**.

9 Add additional labels (headings) as follows:

You can use labels to create headings for the different components. In this case, you can add **Vendor Details** and **Contract Details** headings.
- In the **Toolbox** pane, on the **Components** tab, in the search field, type **label**.
- Drag the **Label** component and position it on the form.
  - Repeat this action for each label that you want to create.
- Double-click the label.
- In the **Edit Component** dialog box, on the **Appearance** tab, in the **Text** box, replace - **label** - with **Vendor Details:** or with **Contract Details:**.
- In the **Theme Style** drop-down list, select a style.
  - For example, click **.Subtitle big**.
10 Add the document component as follows:
- In the Toolbox pane on the Components tab, in the search field, type file.
- Drag the InputFile component and position it on the form.
- In the Edit Object dialog box, in the Output Name box, type ContractDocument.
- Click OK.

11 Create a label for the document component as follows:
- In the Toolbox pane, on the Components tab, in the search field, type label.
- Drag the Label component and position it on the form.
- Double-click the label.
- In the Edit Component dialog box, on the Appearance tab, in the Text box, replace - label - with Contract Document:
- In the Theme Style drop-down list, select a style.
  To duplicate the text style of the Primary Internal Contact label, click .Field Label Required.
- Click OK.

12 In the Web Form Editor dialog box, click OK.

Step 7: To Configure the Request Confirmation Form
1 In the Project pane, in the project tree, click Model: RequestForm.
2 In the project workspace, double-click the Request Confirmation Form component.
3 In the Web Form Editor dialog box, right-click the Request Title field and click Delete.
4 Right-click the ![RequestTitle!] field and click Delete.
5 In the left pane, under Variables, expand Request.
6 Check the following data fields, drag them to the center pane, and then complete the steps in the Build Wizard as follows:
Check **ContractEndDate**.

- Drag the data field and position it on the form.
- In the Build Wizard, click FieldBuilder [Sting].
- Click Finish.

Check **ContractStartDate**.

- Drag the data field and position it on the form.
- In the Build Wizard, click FieldBuilder [Sting].
- Click Finish.

Check **ADAccountRequired**.

- Drag the data field and position it on the form.
- In the Build Wizard, click FieldBuilder [Sting].
- Click Finish.

Check **CompanyAddress**.

- Drag the data field and position it on the form.
- In the Build Wizard, click FieldBuilder [Sting].
- Click Finish.

Check **CompanyName**.

- Drag the data field and position it on the form.
- In the Build Wizard, click FieldBuilder [Sting].
- Click Finish.

Check **ContractEmail**.

- Drag the data field and position it on the form.
- In the Build Wizard, click FieldBuilder [Sting].
- Click Finish.

Check **ContractName**.

- Drag the data field and position it on the form.
- In the Build Wizard, click FieldBuilder [Sting].
- Click Finish.
Check **ContractPhone**  
- Drag the data field and position it on the form.  
- In the **Build Wizard**, click **FieldBuilder [String]**.  
- Click **Finish**.

Check **CostCenter**  
- Drag the data field and position it on the form.  
- In the **Build Wizard**, click **FieldBuilder [String]**.  
- Click **Finish**.

Check **EstimatedContractValue**  
- Drag the data field and position it on the form.  
- In the **Build Wizard**, click **FieldBuilder [String]**.  
- Click **Finish**.

7 In the form, organize the vendor request fields.
8 Edit the labels of the variables to include spaces and colons as follows:

- The users see the labels when they fill out the form.
- Double-click a label.
- In the Edit Component dialog box, on the Appearance tab, in the Text box, modify the label.
- Click OK.

9 Edit the text style of the labels of the variables as follows:

- Double-click a label.
- In the Edit Component dialog box, on the Appearance tab, in the Theme Style drop-down list, select a style.
  To duplicate the text style of the Primary Internal Contact label, click .Field Label Required.
- Click OK.

10 In the Web Form Editor dialog box, click OK.

See “About the Service Catalog Request Template” on page 677.

See “Part 3: Setting up the process and creating the approval and the implementation tasks” on page 695.

## Part 3: Setting up the process and creating the approval and the implementation tasks

After you create the vendor request process, you can set up the process and create the approval and the implementation tasks.

### Table C-10

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Define the data mappings.</td>
<td>Set up the template and the passing of request variables to the Approval Task component.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Step 1: To define data mapping</strong></td>
</tr>
<tr>
<td>Step 2</td>
<td>Set up the workflow process data.</td>
<td>Set up the SessionID.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Step 2: To set up workflow process data</strong></td>
</tr>
</tbody>
</table>
Table C-10  Process for setting up the process and creating the approval and the implementation task (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 3 | Configure the Approval Task.                                           | Configure the **Approval Task** component.  
  **Step 3: To configure the Approval Task component**                                                                                   |
| Step 4 | Configure the Fulfillment Task.                                        | The template contains only one Fulfillment Task. The Vendor Request process requires two Fulfillment Tasks: one task to create the PO in the ERP system and one task to create an Active Directory account for the user.  
  **Step 4: To configure the Fulfillment Task components**                                                                               |
| Step 5 | Create an Active Directory Account rule.                               | Not every Vendor Request may require an Active Directory account. You can use the True False Rule component to let the process know when an Active Directory Account is required.  
  **Step 5: To configure an AD Account rule**                                                                                              |

Table C-11  Creating a Workflow using the Service Catalog Request template

<table>
<thead>
<tr>
<th>Video</th>
<th>Length</th>
</tr>
</thead>
</table>

Step 1: To define data mapping

1. In the **Project** pane, in the project tree, expand **VendorRequest > Model: RequestManagement**, and then click **Input Data**.

2. In the project workspace, on the **Model Input Data: Request Management** tab, click **Add**.

3. In the new Input Data row, in the **Name** field, type **Request**.

4. In the **Type** field, click the … symbol.

5. In the **Select Data Type** dialog box, expand **VendorRequestLib**, click **VendorRequest**, and then click **OK**.  
   This action lets you set the data type and pass all of the request sub-variables.

6. Click **Add**.

7. In the new Input Data row, in the **Name** field, type **ContractDocument**.

8. In the **Type** field, click the … symbol.
9 In the **Select Data Type** dialog box, expand LogicBase.Core, click LogicBase.Core.Data.DataTypes.FileDataType, and then click OK. This action lets you set the data type and create a variable for the contract document.

10 In the **Project** pane, in the project tree, click Model: RequestForm.

11 In the project workspace, double-click the **Start Workflow** component.

12 In the **Start Workflow Editor** dialog box, on the **General** tab, next to the Request box, click the … symbol.

13 In the **Select Output - Request** dialog box, click Value From Data, and then click the … symbol.

14 In the **Select Variable** dialog box, click Request, and then click OK.

15 In the **Select Output - Request** dialog box, click OK.

16 In the **Start Workflow Editor** dialog box, on the **General** tab, next to the ContractDocument box, click the … symbol.

17 In the **Select Output - ContractDocument** dialog box, click Value From Data, and then click the … symbol.

18 In the **Select Variable** dialog box, click ContractDocument, and then click OK.

19 In the **Select Output - ContractDocument** dialog box, click OK.

20 In the **Start Workflow Editor** dialog box, on the **General** tab, next to the RequestTitle box, click the … symbol.

21 In the **Select Output - RequestTitle** dialog box, click Create Value.

22 Under Data, in the Value box, type VendorRequest, and then click OK.

23 In the **Start Workflow Editor** dialog box, click OK.

**Step 2: To set up workflow process data**

1 In the **Project** pane, in the project tree, click Model: RequestManagement.

2 In the project workspace, double-click the **Setup Process** component.

3 In the **Setup Process Editor** dialog box, on the **General** tab, under Docman Integration, check Create Document Category, and then click OK. This action lets you attach documents to the process profile.

4 In the project workspace, double-click the **Set Session ID** component.

5 In the **Set Session ID Editor** dialog box, on the **Output Variables** tab, next to the Tracking ID Variable Name box, click the … symbol.
6 In the **Select Variable** dialog box, expand **Request**, click **SessionID**, and then click **OK**.

This action lets you map this variable to the Session ID of the process and automatically associate it with the Document Category Id’ Variable any reporting material.

7 In the **Set Session ID Editor** dialog box, click **OK**.

8 In the Toolbox pane, on the **Components** tab, in the search field, type *add document*.

9 Drag the **Add Document (0)** component into the project workspace, and place it in the process between **Set Process Priority** and **Submitted**.

10 Double-click the **Add Document** component.

11 In the **Add Document Editor** dialog box, on the **Inputs** tab, under **Parameters**, next to the **Document File** box, click the … symbol.

12 In the ‘**Document File’ Variable** dialog box, click **Process Variables**, and then click **Add**.

13 In the **Select Variable** dialog box, click **ContractDocument**, and then click **OK**.

14 In the ‘**Document File’ Variable** dialog box, click **OK**.

15 In the **Add Document Editor** dialog box, under **Parameters**, next to the **Document Category Id** box, click the … symbol.

16 In the ‘**Document Category Id’ Variable’ dialog box, click **Process Variables**, and then click **Add**.

17 In the **Select Variable** dialog box, click **outProcessCategoryId**, and then click **OK**.

18 In the dialog box, click **OK**.

19 In the **Add Document Editor** dialog box, click **OK**.

**Step 3: To configure the Approval Task component**

1 In the **Project** pane, in the project tree, click **Model: RequestManagement**.

2 In the project workspace, double-click the **Approval Task** component.

3 In the **Approval Task Editor** dialog box, on the **Assignments** tab, under **Task Information**, in the **Task Name** box, replace **Service Request Approval** with **Vendor Request Approval**.

4 Under **Task Assignments**, set the assignee.

For example, you can hard code in the task assignment to an admin account as follows:
Create your first project with the Web Application Project Type

Part 3: Setting up the process and creating the approval and the implementation tasks

- Next to the **Person Assignment** box, click the ... Symbol.
- In the **Assignment Editor** dialog box, click **Add > From List**.
- In the **Assignment Reference Editor** dialog box, click admin@symantec.com, and then click **OK**.
- In the **Assignment Editor** dialog box, click **OK**.

5 To enable the reviewer to edit the task, on the **Interaction Setup** tab, under **User Interaction**, in the **Dialog Models** area, click **Edit Request**, and then click **Edit**.

6 In the **Edit Object** dialog box, under **Dialog Model**, next to the **Dialog Model** box, click the ... symbol.

In this template, a form has already been created for an edit request.

7 On the **Edit Embedded Decision Model** page, in the model workspace, double-click **Edit Request**.

8 In the **Web Form Editor** dialog box, delete the **Request Title** and **Request Details** fields.
   - Press Ctrl key and select **Request Title**, **Request Details**, and both their information fields.
   - Right-click the selections, and then click **Delete**.

9 In the left pane under **Variables**, expand **Request**.

10 Check the following data fields, drag them to the center pane, and then complete the steps in the **Build Wizard** as follows:

   **Check CompanyAddress**
   - Drag the data field and position it on the form.
   - In the **Build Wizard**, click **FieldBuilder [String]**.
   - Click **Finish**.

   **Check CompanyName**
   - Drag the data field and position it on the form.
   - In the **Build Wizard**, click **FieldBuilder [String]**.
   - Click **Finish**.
Check **ContractEmail**
- Drag the data field and position it on the form.
- In the **Build Wizard**, click **FieldBuilder [Sting]**.
- Click **Finish**.

Check **ContractName**
- Drag the data field and position it on the form.
- In the **Build Wizard**, click **FieldBuilder [Sting]**.
- Click **Finish**.

Check **ContractPhone**
- Drag the data field and position it on the form.
- In the **Build Wizard**, click **FieldBuilder [Sting]**.
- Click **Finish**.

11 In the left pane under **Variables**, expand **Request**

12 Check the following data fields, drag them to the center pane, and then complete the steps in the **Build Wizard** as follows:

Check **ADAccountRequired**
- Drag the data field and position it on the form.
- In the **Build Wizard**, click **CheckBoxBuilder [Boolean]**.
- Click **Next**.
- Next to **Approve**, click **Required**.
- Next to **Update Request**, click **Required**.
- Click **Finish**.

Check **CostCenter**
- Drag the data field and position it on the form.
- In the **Build Wizard**, click **InputBuilder [Sting]**.
- Click **Next**.
- Next to **Approve**, click **Required**.
- Next to **Update Request**, click **Required**.
- Click **Finish**.

13 Rename the **ADAccountRequired**: field to **Create AD Account**.
14 In the workspace, double-click the **ADAccountRequired** field.

15 In the **Edit Component** dialog box, on the **Appearance** tab, under **Appearance**, next to the **Text** box, replace `Request.ADAccountRequired:` with **Create AD Account:**.

- Click **OK**.

16 Edit the labels of the variables to include spaces and colons as follows:

   The users see the labels when they fill out the form.

   - Double-click a label.

   - In the **Edit Component** dialog box, on the **Appearance** tab, in the **Text** box, modify the label.

   - Click **OK**.

17 Edit the text style of the labels of the variables as follows:
Double-click a label.

In the **Edit Component** dialog box, on the **Appearance** tab, in the **Theme Style** drop-down list, select a style.

To duplicate the text style of the **Primary Internal Contact** label, click **.Field Label Required**.

Click **OK**.

17 On the **Edit Embedded Decision Model** page, click **OK**.

18 In the **Edit Object** dialog box, click **OK**.

19 In the **Approval Task Editor** dialog box, click **OK**.

**Step 4: To configure the Fulfillment Task components**

1 In the **Project** pane, in the project tree, click **Model: RequestManagement**.

2 In the project workspace, copy and paste the **Fulfillment Task** component and the **Time Out** and **Complete** items along with the arrows that link them. Then, position them to the right of the existing **Fulfillment Task** component.

   - Press **Ctrl** and select the **Fulfillment Task** component, **Time Out**, **Complete**, and the arrows that link them.
   
   - Right-click one of the selected items, and then click **Copy**.
   
   - In the project workspace, right-click, and then click **Paste**.
   
   - Drag and position the items to the right of the existing **Fulfillment Task** component.

3 Rename the first **Fulfillment Task** component to **Fulfillment Task - Create PO**.

   - On the leftmost **Fulfillment Task** component, click the **Fulfillment Task** name.
   
   - Replace **Fulfillment Task** with **Fulfillment Task - Create PO**.
   
   - Press **Enter**.

4 Double-click the **Fulfillment Task - Create PO** component.

5 In the **Fulfillment Task - Create PO Editor** dialog box, on the **Assignments** tab, under **Task Information**, in the **Task Name** box, replace **Service Request Fulfillment** with **Create PO**.

6 Under **Task Assignments**, set the assignee.

For example, you can hard code in the task assignment to an admin account as follows:

   - Next to the **Person Assignment** box, click the ... Symbol.
In the Assignment Editor dialog box, click Add > From List.

In the Assignment Reference Editor dialog box, click admin@symantec.com, and then click OK.

In the Assignment Editor dialog box, click OK.

7 Rename the second Fulfillment Task component to Fulfillment Task - Create AD Account.

- On the rightmost Fulfillment Task component, click the Fulfillment Task name.
- Replace Fulfillment Task with Fulfillment Task - Create PO.
- Press Enter.

8 Double-click Fulfillment Task - Create AD Account component.

9 In the Fulfillment Task - Create AD Account Editor dialog box, on the Assignments tab, under Task Information, in the Task Name box, replace Service Request Fulfillment with Create AD Account for Vendor.

10 Under Task Assignments, set the assignee.

For example, you can hard code in the task assignment to an admin account as follows:

- Next to the Person Assignment box, click the ... Symbol.
- In the Assignment Editor dialog box, click Add > From List.
- In the Assignment Reference Editor dialog box, click admin@symantec.com, and then click OK.
- In the Assignment Editor dialog box, click OK.

11 Arrange the Fulfillment Task components’ paths as follows:

Link Complete to Fulfillment Task - Create AD Account.

- Click the arrow that links Complete and Complete Notification.
- Drag the arrow and link Complete to Fulfillment Task - Create AD Account.

Link Timed Out to Timed Out Notification.

- Click Timed Out; the one that is connected to Fulfillment Task - Create AD Account.
- Click one of the connection points and drag the arrow to link Timed Out to Timed Out Notification.
Link **Complete** to **Complete Notification**.  
- Click **Complete**; the one that is connected to **Fulfillment Task - Create AD Account**.  
- Click one of the connection points and drag the arrow to link **Complete** to **Complete Notification**.

---

**Step 5: To configure an AD Account rule**

1. In the **Project** pane, in the project tree, click **Model: RequestManagement**.
2. In the **Toolbox** pane, on the **Components** tab, in the search field, type *true false rule*.
3. Drag the **True False Rule** component into the project workspace, and place it in the process between **Complete** and the **Fulfillment Task - Create AD** component.
4. On the **True False Rule** component, connect **false** to **Complete**; the one that is connected to the **Fulfillment Task - Create AD** component.
On the True False Rule component, click the arrow that connects false to the Fulfillment Task - Create AD component.

Drag the arrow to link it to Complete; the one that is connected to the Fulfillment Task - Create AD component.

5 Rename the True False Rule component to AD Account Needed.
   - Click the True False Rule name.
   - Replace True False Rule with AD Account Needed.
   - Press Enter.

6 Double-click the AD Account Needed component.

7 In the AD Account Needed Editor dialog box, on the Configuration tab, next to the Value box, click the … symbol.

8 In the ‘Value’ Variable dialog box, click Process Variables, and then click Add.
9 In the **Select Variable** dialog box, expand **Request**, click **ADAccountRequired**, and then click **OK**.

10 In the ‘**Value**’ **Variable** dialog box, click **OK**.

11 In the **AD Account Needed Editor** dialog box, click **OK**.

See “About the Service Catalog Request Template” on page 677.

See “Part 4: Debugging the process, creating a process profile, and creating a report” on page 706.

## Part 4: Debugging the process, creating a process profile, and creating a report

After you set up the process and create the approval and the implementation task, you can debug the process. When you run the process in debug, you test the process and everything that you built to make sure that it works correctly. It also lets you create a variable table to hold your custom variable data. Next, you can create a process profile to link the variable table so that you can see all the values on the **Process View** page. Then, you can create a report that uses the process data.

### Table C-12 Process for debugging the process, creating a process profile, and creating a report

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Step 1 | Debug the process. | After you complete the Vendor Request process, you need to run it in Debug Mode to verify that it works. When you run the process in Debug Mode, you also create the variable table in the database that holds custom variable data.  
  **Step 1: To run the process in Debug Mode** |
| Step 2 | Create a process profile for the new ORM Data Type. | You need to create a process profile so that you can associate the date to the **Process View** page to make it available for reporting.  
  **Step 2: To create a process profile for the new ORM Data Type** |
| Step 3 | Create a report for the ORM data. | You can create a report for the ORM data for long-term reporting.  
  **Step 3: To create a report for the ORM data** |
Step 1: To run the process in Debug Mode

1. In the Project pane, in the project tree, click **Model: RequestForm**.

2. In the Workflow Designer toolbar, click the **Run Project** symbol (bug with green arrow).

3. On the **Debugging Form** page, in the top section in the left pane, double-click **RequestForm.aspx**.
   
   The form opens in a browser.

4. (Optional) Log in to ServiceDesk.
   - Type your credentials in the **Login Name** and **Password** boxes.
   - Click **Login**.

5. Fill out the **Create a New Request** form. When you are finished, click **Continue**.

6. On the **Review Request** page, verify that the information is correct, and then click **Submit**.
   
   When your request has been submitted, a **Thank you** page is displayed.

7. Open Process Manager and click **Workflow > Workflow Task List**.
   
   If you installed ServiceDesk on the server, in the Process Manager portal, click **My Task List**.

8. In the **Task Viewer** section, expand **VendorRequest**, and then click **VR-000001.1** (ID number link).
   
   If you do not see the task, refresh the page.


10. In the Documents section, you can view an attachment or add an attachment.

11. In Workflow Designer, on the **Debugging Form** page, you can verify that the process ran, and view the path that it took.
Step 2: To create a process profile for the new ORM Data Type

1. In Process Manager, click **Admin > Data > Lists and Profiles**.
2. On the **List and Profiles** page, under **Profile Definitions**, click the **Add Profile Definition** symbol (green plus sign), and then click **Add Profile Definition (Existing Table)**.
3. In the **Add Profile Definition** dialog box, in the **Reference Type** drop-down list, click **Workflow Process**.
4. In the **Profile Definition Name** box, type **VendorRequest**.
5. In the **TableName** box, type **Vendor_Request**, and then click **Go**.
6. In the **Select ID Field** drop-down, click **session_id**.
7. In the **Select Fields** area, select the fields that you want to display.
   For example, check the following options:
   - **company_name**
   - **company_address**
   - **contract_name**
   - **contract_email**
   - **contract_phone**
   - **contract_start_date**
   - **contract_end_date**
   - **a_daccount_required**
   - **estimated_contract_value**
   - **cost_center**
8. Click **Generate**.
9. Click **Workflow > Workflow Task List**.
   If you installed ServiceDesk on the server, in the Process Manager portal, click **My Task List**.
10. In the **Task Viewer** section, expand **VendorRequest**, and then click **VR-000001.1** (ID number link).
11. On the **Process View** page, in the **Additional** section, you can view the request data for this session.
12. Under **My Actions**, expand **Other Actions**, and then click **Edit Request**.
In the EditRequest dialog box, uncheck Create AD Account, and then click Update and Approve.

On the Process View page, under My Actions, click Mark Complete.

In Workflow Designer, on the Debugging Form page, you can verify that the process ran, and view the path that it took.

Step 3: To create a report for the ORM data

1. In Process Manager, click Reports.
2. On the Reports page, in the Report Categories section, select the category to which you want to add the Vendor Request Report.
3. Click the Add Report symbol (paper with plus sign), and then click Add Standard Report.
5. In the left pane, click Select Data Source.
6. In the Select Data Source dialog box, in the Data Sources drop-down list, click Default, and then click OK.
8. In the Add Process To Report dialog box, click OK.
9. In the right pane, select the fields that you want to display in the report.
   For example, click the following options:
   - Process Ended
   - Process Started
   - Report Process ID
   - Status
10. In the left pane, select the options that you want to use to filter the report.
    For example:
    - To turn the Report Process ID numbers into links, under Units, click Include Process Actions.
      This action creates links to the Process View page that created the entry.
    - To filter the results of the report, under Units, click Report Process ID.
    - In the Report Process ID dialog box, in the ReportProcessID box, type VR-, and then click OK.
11 In the left pane, under Units, click Workflow Profile.

12 In the Workflow Profile dialog box, in the Editor Data drop-down list, click Vendor_Request, and then click OK.

This action adds the Vendor_Request folder and its associated custom data points that are in the process to the list in the right pane.

13 In the right pane under Vendor_Request, select the additional fields that you want to display in your report.

For example, click the following options:
- company name
- contract name
- cost center
- estimated contract value

14 (Optional) Rearrange the columns in the report.
- In the Columns section, select the column that you want to move.
- To the right of your selection, select one of the arrows to reposition the column in the list.

15 (Optional) Edit the columns in the report.
- In the Columns section, select the column that you want rename.
- To the right of your selection, click the Edit symbol (pencil).
- In the Process dialog box, use the options to edit the column, and then click OK.

16 On the Add Standard Report page, when you are finished, click Save.

17 On the Reports page, in the Report Categories section, click the category in which you added the report.

In the Reports section, the report appears in the list of reports.

See “About the Service Catalog Request Template” on page 677.
### Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Directory sync profile</td>
<td>A grouping of components that are needed to start and maintain Workflow capture and regular update of the selected Active Directory data. The sync profiles are used to import the entire Active Directory domain or specific organizational units and groups to the Process Manager database.</td>
</tr>
<tr>
<td>Active Directory sync profile schedule</td>
<td>A schedule that is used to set up automatic updates and full synchronization between the sync profiles and the Active Directory servers to which the profiles are connected.</td>
</tr>
<tr>
<td>Advanced Check Box List</td>
<td>A component of Workflow Solution that is used to add a check box to a form that has advanced functionality. This component is used when the users are expected to answer a series of customized yes or no questions.</td>
</tr>
<tr>
<td>ASCII Merge Label</td>
<td>A component of Workflow Solution that lets the user merge and display the combination of regular text and multiple ASCII text variables.</td>
</tr>
<tr>
<td>ASDK (Altiris Software Development Kit)</td>
<td>A set of application programming interfaces that access the functionality of NS (Notification Server), site servers, and various NS solutions.</td>
</tr>
<tr>
<td>ASDK component generator</td>
<td>A tool that creates components out of ASDK (Altiris Software Development Kit) method calls.</td>
</tr>
<tr>
<td>Auto Complete Text Box</td>
<td>A field in which the users can type a text with the autocomplete suggestions that appear as they type.</td>
</tr>
<tr>
<td>Auto Exit Page On Timer</td>
<td>A component of Workflow Solution that exits a page on the basis of a user-defined timeframe.</td>
</tr>
<tr>
<td>business time span</td>
<td>An operating variable that the Workflow Solution uses to define the working days and hours of an organization.</td>
</tr>
<tr>
<td>Business Time Span Editor</td>
<td>A component of Workflow Solution that is used to define global working days and hours of an organization.</td>
</tr>
<tr>
<td>Check Box</td>
<td>A component of Workflow Solution that is used to add a check box to a form.</td>
</tr>
<tr>
<td>Check Box List</td>
<td>A component of Workflow Solution that is used to add a list of Check Boxes to a form.</td>
</tr>
<tr>
<td>component</td>
<td>A piece of functionality that is contained in a graphical representation in Workflow Designer.</td>
</tr>
<tr>
<td>component generator</td>
<td>A tool that is used to create customized components with specific functionality.</td>
</tr>
<tr>
<td><strong>component model</strong></td>
<td>A property of the Dynamic Linked Model component that tells the component which secondary model it represents.</td>
</tr>
<tr>
<td><strong>variable name</strong></td>
<td>component toolbox An element of Workflow Solution that contains all of the components that are available for use in a particular project.</td>
</tr>
<tr>
<td><strong>Credentials Manager</strong></td>
<td>A component that allows to add, edit, or remove credentials for the Symantec Management Platform and solutions.</td>
</tr>
<tr>
<td><strong>Critical Errors model</strong></td>
<td>A default model in all Workflow projects. This model handles all the unhandled exceptions for a project. If there is no error handling in the project, the Critical Errors model handles all of the errors.</td>
</tr>
<tr>
<td><strong>custom events</strong></td>
<td>A custom JavaScript that can be implemented either on individual form components (such as a text box) or on the form itself.</td>
</tr>
<tr>
<td><strong>Custom Workflow Interaction generator</strong></td>
<td>A tool that is used to create a Workflow component with multiple output paths.</td>
</tr>
<tr>
<td><strong>data hierarchy</strong></td>
<td>A multi-level data classification system.</td>
</tr>
<tr>
<td><strong>data mapping</strong></td>
<td>A process of copying the value of one variable into another variable.</td>
</tr>
<tr>
<td><strong>data mapping assignment</strong></td>
<td>A process of configuring a data mapping definition to use an alternate source for input data.</td>
</tr>
<tr>
<td><strong>data mapping conversion</strong></td>
<td>A process of converting the data mapping definitions and setting the definitions to use the new source data.</td>
</tr>
<tr>
<td><strong>Date Picker</strong></td>
<td>A component of Workflow Solution that allows users to pick a date from a calendar pop-up that appears when they click a drop-down list.</td>
</tr>
<tr>
<td><strong>Date Time Picker</strong></td>
<td>A component of Workflow Solution that allows the users to pick a date and time from a calendar that appears when they click a drop-down list and time.</td>
</tr>
<tr>
<td><strong>Decision Only project type</strong></td>
<td>An element that is used for the projects that require all of the logic capabilities of Workflow, but no user input.</td>
</tr>
<tr>
<td><strong>Deployment Server</strong></td>
<td>A site server that is installed with the Deployment Plug-in and lets the user execute deployment-related tasks.</td>
</tr>
<tr>
<td><strong>deployment type</strong></td>
<td>The way in which a Workflow application can be installed.</td>
</tr>
<tr>
<td><strong>designer configuration</strong></td>
<td>A type of configuration when only Workflow Server and Workflow Designer are installed on a development computer.</td>
</tr>
<tr>
<td><strong>design-time</strong></td>
<td>A period in the lifecycle of a workflow project when the project is built and tested.</td>
</tr>
<tr>
<td><strong>Dialog Workflow component</strong></td>
<td>A component of Workflow Solution that creates and assigns tasks.</td>
</tr>
<tr>
<td><strong>document manager</strong></td>
<td>A component of Workflow Solution that contains a document repository and allows managing files.</td>
</tr>
<tr>
<td><strong>DTD generator</strong></td>
<td>A component of Workflow Solution that creates read and write components based on a user-specified document type definition file (.DTD).</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Dynamic Button</strong></td>
<td>A component of Workflow Solution that displays a drop-down menu.</td>
</tr>
<tr>
<td><strong>Dynamic Linked Model component</strong></td>
<td>A component of Workflow Solution that can represent any secondary model in the project tree structure.</td>
</tr>
<tr>
<td><strong>Dynamic Update panel</strong></td>
<td>A component of Workflow Solution that is used to create a section in a form that refreshes the components that it contains without the necessity to exit the form.</td>
</tr>
<tr>
<td><strong>Embedded Model component</strong></td>
<td>A component of Workflow Solution that points to a model in a project tree structure.</td>
</tr>
<tr>
<td><strong>Embedded Rule Model component</strong></td>
<td>A component of Workflow Solution that functions similarly to the Embedded Model component, but with multiple outcome paths.</td>
</tr>
<tr>
<td><strong>escalation</strong></td>
<td>A process that raises the urgency and visibility of the necessary user input as a workflow nears the timeout.</td>
</tr>
<tr>
<td><strong>Excel generator</strong></td>
<td>A component of Workflow Solution that generates the read and write components on the basis of a user-specified Excel spreadsheet file.</td>
</tr>
<tr>
<td><strong>exchange</strong></td>
<td>A message handler that a Workflow-type process sends and receives through the SymQ.</td>
</tr>
<tr>
<td><strong>exchange configuration</strong></td>
<td>A group of message handlers that are based on accessibility. Components of Workflow Solution.</td>
</tr>
<tr>
<td><strong>filter generator</strong></td>
<td>A tool that creates a data set that can be used to build Process Manager reports. A component of Workflow Solution.</td>
</tr>
<tr>
<td><strong>fixed-length generator</strong></td>
<td>A tool that creates data types and read and write components based on a specific fixed-length file. A component of Workflow Solution.</td>
</tr>
<tr>
<td><strong>form component</strong></td>
<td>The control that is used to design forms with such tools as Form Builder or Terminating Form Builder. A component of Workflow Solution.</td>
</tr>
<tr>
<td><strong>form template</strong></td>
<td>A standard for the form layout and style. A component of Workflow Solution.</td>
</tr>
<tr>
<td><strong>form theme</strong></td>
<td>A style for the form that includes background, control, and text formatting. A component of Workflow Solution.</td>
</tr>
<tr>
<td><strong>Forms (Web) Project Type</strong></td>
<td>A type of Workflow project that is used when the user interaction is needed immediately.</td>
</tr>
<tr>
<td><strong>global data tab</strong></td>
<td>An element of Workflow Solution that contains the data that is available everywhere in the project.</td>
</tr>
<tr>
<td><strong>image map</strong></td>
<td>A component of Workflow Solution that is used to display an image with hotspots, i.e. the areas on the image that a user can click.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>input data mapping</strong></td>
<td>A process of copying the value of the process variable into its corresponding data variable.</td>
</tr>
<tr>
<td><strong>input file</strong></td>
<td>A component of Workflow Solution that lets the user upload the files.</td>
</tr>
<tr>
<td><strong>item</strong></td>
<td>Any object that belongs to CMDB (Configuration Management Database), such as a policy, a folder, or a computer that can be managed. Each item has a name, description, GUID, and attributes, and can be cloned, imported, exported, presented, and secured. Items can be linked with references or named relations between them.</td>
</tr>
<tr>
<td><strong>License Status Manager</strong></td>
<td>A component of Workflow Solution that is used to view licensing information about Workflow and Workflow-related applications. This component is also used to test a license to verify that it works properly.</td>
</tr>
<tr>
<td><strong>List Box component</strong></td>
<td>A component of Workflow Solution that lets the user select one or more items from a fully visible list.</td>
</tr>
<tr>
<td><strong>load balancing</strong></td>
<td>A process of configuring Workflow so that the workload is distributed between several server computers.</td>
</tr>
<tr>
<td><strong>Log Viewer</strong></td>
<td>A tool that lets the user monitor several locations of logs for different components.</td>
</tr>
<tr>
<td><strong>Mask Edit Text Box</strong></td>
<td>A component of Workflow Solution that is used to create a customized text box for the users to fill.</td>
</tr>
<tr>
<td><strong>Messaging Console</strong></td>
<td>A client tool for Workflow Solution that is used to connect to Workflow Exchange through a command line interface.</td>
</tr>
<tr>
<td><strong>Monitoring Project Type</strong></td>
<td>A type of Workflow project that is used when the logic capabilities of Workflow are needed without user interaction, and the project must run on a schedule.</td>
</tr>
<tr>
<td><strong>Multiline Text Box</strong></td>
<td>An element of Workflow Solution that lets the user enter the text that is more than one line long.</td>
</tr>
<tr>
<td><strong>Multiple generator container</strong></td>
<td>A component of Workflow Solution that puts the components that other generators create into a single DLL file.</td>
</tr>
<tr>
<td><strong>Multiple Value Mapping component</strong></td>
<td>A component of Workflow Solution that is used to map the array values into other array values using the full data mapping editor.</td>
</tr>
<tr>
<td><strong>Multi-State Image</strong></td>
<td>A component of Workflow Solution that is used to display multiple images based on the customized rules.</td>
</tr>
<tr>
<td><strong>Not Logged-In Users settings</strong></td>
<td>The settings in the Process Manager that control how the users who are not logged on to the Process Manager site are handled when they visit.</td>
</tr>
<tr>
<td><strong>Numeric Text Box</strong></td>
<td>A component of Workflow Solution that lets the user enter only a numeric value into the text box.</td>
</tr>
<tr>
<td><strong>organizational group</strong></td>
<td>A set of resources that are grouped by common properties or similar features for management and security purposes.</td>
</tr>
<tr>
<td>Glossary Term</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ORM (object-relational mapping) data type</td>
<td>The data type that is mapped to the data in the database. A component of Workflow Solution.</td>
</tr>
<tr>
<td>output data mapping</td>
<td>A process of copying the value of a variable into its corresponding process variable. Mapping output data is done in the Link Model component editor and in the End components inside the Linked Model.</td>
</tr>
<tr>
<td>Page Refresh Check</td>
<td>A component of Workflow Solution that is used to refresh a form based on the configurable rules.</td>
</tr>
<tr>
<td>Process Manager</td>
<td>A web-based interface that provides access to any Workflow-based processes, including the ServiceDesk application (if installed).</td>
</tr>
<tr>
<td>Process Manager database</td>
<td>A component of Workflow Solution that stores the Process Manager details such as groups, users and permissions, and permanent Workflow data.</td>
</tr>
<tr>
<td>Process Type Action page</td>
<td>A page in the Process Manager on which the user can create new process types, edit and delete existing process types, and add actions to these process types.</td>
</tr>
<tr>
<td>Process View page</td>
<td>A page in the Process Manager that displays the status of the running workflow if the project is configured to display status data.</td>
</tr>
<tr>
<td>Profile Reference Type page</td>
<td>A page in the Process Manager on which the user can edit the existing profile reference types and add the new ones.</td>
</tr>
<tr>
<td>project deployment</td>
<td>A process of publishing a project to a local server or to a remote server, or generating an installer file for deployment.</td>
</tr>
<tr>
<td>project model</td>
<td>A container of process logic in a project. When a new project is opened in a Workflow Designer, two models are created automatically: the primary model and the Critical Errors model.</td>
</tr>
<tr>
<td>project property</td>
<td>The value that can be used in a Workflow project.</td>
</tr>
<tr>
<td>project publication</td>
<td>A process of moving the project from the Workflow Designer to the Workflow Server either using the publishing wizard or manually.</td>
</tr>
<tr>
<td>project start type</td>
<td>A way in which a process in a Workflow project is invoked.</td>
</tr>
<tr>
<td>project workspace</td>
<td>The main section on Workflow Designer page. The workspace is used to add and configure the components of a workflow project.</td>
</tr>
<tr>
<td>publishing format</td>
<td>An option for publishing a Workflow project: as a compressed file, a directory, a server, or as an installer.</td>
</tr>
<tr>
<td>Query/Script generator wizard</td>
<td>A tool that generates the components that submit and process the user-specified SQL against a user-specified database.</td>
</tr>
<tr>
<td>Radio Button List</td>
<td>A component of Workflow Solution that is used to select one item out of a list of items that are displayed as radio buttons.</td>
</tr>
<tr>
<td>report component</td>
<td>A SQL query that retrieves and stores structured data in a collection within a workflow.</td>
</tr>
</tbody>
</table>
Report generator
A component of Workflow Solution that gathers all of the reports that are available in the Symantec Management Console and creates a component for each report.

Resource generator
An element of Workflow Solution that gathers all of the resources that are available on the Symantec Management Console, and can generate components to manage these resources.

Run-time
A period in the lifecycle of a workflow project when the project is running in a production environment.

Server Extensions Configurator
A client tool for Workflow Solution that is used to define the properties for a Workflow Server.

Service Catalog failover
A customized list of servers that provide failover support for each of the Service Catalog processes.

Single Value Mapping component
An element of Workflow Solution that is used to map single values into other single values.

Smart task
A component of ServiceDesk or any other custom Workflow application. Smart task is an action that is connected to an incident. It is created to allow users to redirect to another URL.

Start and End components
Elements of Workflow Solution that begin and end workflow projects.

Storage preferences
The settings of the specific parameters of the data that are used within a Workflow project.

Stored procedure caller generator
A component of Workflow Solution that is used to create the components that run a user-specified stored procedure against a user-specified database.

SymQ
A messaging server that the Workflow Solution uses to handle the exchange of messages between products.

SymQ Configuration page
A page in the Workflow Explorer that is used to view and configure SymQ exchanges.

table generator
An element of Workflow Solution that generates table-related components from a user-specified table in a user-specified database.

task
An action that is performed on a client computer or a group of client computers. Server tasks are run on Notification Server. Client tasks are run on managed computers.

Task generator
An element of Workflow Solution that gathers ASDK (Altiris Software Development Kit) tasks on the Symantec Management Console.

task integration
The process of setting up a workflow process to communicate with a task handling system, such as Process Manager.
<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Tray Tool</td>
<td>A client tool for Workflow Solution that runs in the task tray and provides quick access to shortcuts and settings of a registered Workflow Server.</td>
</tr>
<tr>
<td>template component model</td>
<td>A type of configuration when all of the components of Workflow are installed on a single server.</td>
</tr>
<tr>
<td>ThisFormData</td>
<td>A type of variable that is used to configure the processes that are based on data variables specific to the form that they edit, such as a Text Box.</td>
</tr>
<tr>
<td>timeout</td>
<td>An element of Workflow Solution that redirects, restarts, or closes a workflow if it has not received any necessary user input by the defined deadline.</td>
</tr>
<tr>
<td>user relationship type</td>
<td>A specific configurable connection between users, groups, permissions, or organizational units.</td>
</tr>
<tr>
<td>user-defined type generator</td>
<td>An element of Workflow Solution that is used to create the user-defined types for the Workflow projects.</td>
</tr>
<tr>
<td>user-defined type with database mapping generator</td>
<td>An element of Workflow Solution that is used to create the user-defined object-relational mapping data types for the Workflow projects.</td>
</tr>
<tr>
<td>Web Application project type</td>
<td>A feature of Workflow Solution that lets the user employ multiple models in the same project.</td>
</tr>
<tr>
<td>Web service</td>
<td>A tool that is used to design, test, and publish workflow projects. It contains the Workflow components that can be arranged into processes.</td>
</tr>
<tr>
<td>Web Service Caller generator</td>
<td>A process development framework that is used to create the processes that are based on the existing Web services. The generator provides the components to populate the variables that are required for the Web service to operate.</td>
</tr>
<tr>
<td>workflow</td>
<td>A process that is created in Workflow Designer.</td>
</tr>
<tr>
<td>Workflow Process Manager</td>
<td>A web portal that lets the user manage various parts of a workflow process such as tasks, documents, data, etc.</td>
</tr>
<tr>
<td>Workflow component</td>
<td>A graphical representation of a single function in a workflow. The components can be used to create a workflow process.</td>
</tr>
<tr>
<td>Workflow Designer</td>
<td>A GUI-based development tool that is used to design Workflow processes. Workflow Designer contains the components that can be configured to build a business process and publish it to a Workflow Server.</td>
</tr>
<tr>
<td>Workflow Enterprise Management page</td>
<td>A page in the Symantec Management Console on which the user can manage Workflow environments, servers, and processes.</td>
</tr>
<tr>
<td>Workflow environment</td>
<td>A logical grouping of the Workflow Server computers that is registered on the Enterprise Management page in the Symantec Management Console.</td>
</tr>
<tr>
<td>Workflow Explorer</td>
<td>The primary client tool of Workflow Solution that includes several client tools, such as the Log Viewer, the critical error Viewer, and the Credentials Manager.</td>
</tr>
<tr>
<td><strong>Workflow Manager</strong></td>
<td>A tool that is used to manage the existing workflow projects, create new projects, and configure and manage specific settings, such as tool preferences and server information.</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Workflow Repository</strong></td>
<td>A central location on the Symantec Management Platform that is used to store, access, create, and view versions of the workflow project and component libraries.</td>
</tr>
<tr>
<td><strong>workflow resource</strong></td>
<td>A physical object that the system can manage. A resource can be a computer, a device, a person, printers, routers, contracts, software packages, etc. A resource is composed out of resource type, data classes, and associations.</td>
</tr>
<tr>
<td><strong>workflow rule</strong></td>
<td>A type of Event Console rule that lets the user forward the received alerts into a deployed workflow.</td>
</tr>
<tr>
<td><strong>Workflow Server</strong></td>
<td>A web server that runs and manages published workflows as Internet services in IIS. Workflow Server is any computer that serves as publishing destinations for the Workflow projects. A project can also be published without moving it to a Workflow Server.</td>
</tr>
<tr>
<td><strong>XML Schema generator</strong></td>
<td>A component of Workflow Solution that creates read and write components based on the user-specified XML files.</td>
</tr>
</tbody>
</table>
A
about text box components 362
About Workflow environments 576
accessing
  component help 176
  component wiki pages 176
account management settings 409
actions that you can perform on documents 441
Active Directory 594
  authentication method, selecting 112
  integrating with 594
  manually adding users to Process Manager 518
  sync profile, deleting 124
  sync profile schedule, deleting 116
  sync profile schedule, editing 115
  sync profile schedules, adding 113
  sync profile schedules, managing 112
  sync profile, adding 119
  sync profile, editing 122
  synchronization methods 125
active directory
  how groups are added to Process Manager 507
active directory generator
  about 283
  connection page 283
Active Directory server
  connection, testing 111
  testing connection 111
Active Directory server connection
  adding 108
  deleting connection 110
  editing settings 109
Active Directory server connections
  management 107
Active Directory sync profile
  full synchronization 126
  settings 124
Active Directory sync profiles
  configuring 105
  management 117
Active Directory synchronization
  about 104
  all sync profiles 128
  effect on user accounts 104
  status check 129
  update synchronization 127
add page page 399
add user
  Process Manager settings tab 517
adding 468
adding a data type in the user defined type generator 299, 305
adding a document category in Process Manager 445
adding a document with components in a workflow project 462
adding a new document version in process manager 458
adding a server
  task tray 210
adding an assembly to a generator 262
adding components to library 180
adding credentials 604
adding documents to additional categories in process manager 451
adding output data to a secondary model 228
admin tab
  about 528
  data subtab 533
  portal subtab 534
Advanced Check Box List 340
Ajax Label 329
application
  logging 645
application management settings 409
application properties
  about 192
  accessing 194
  best practices 193
  creating 193
application properties page
  about 486
  adding application properties 487
application properties page  (continued)
  viewing application properties 487
Arrow Up Down 360
article
  adding 467
  adding a new entry 470
articles
  working with 469
articles settings 410
ASCII Merge Label 329
asdk generator 261
assembly
  adding to a generator 262
authentication method
  Active Directory, selecting 112
Auto Complete Text Box 352
Auto Exit Page On Timer 319

B
bulletin board 468
business hours
  about 380
business time span 600–601
  creating in an individual component 382
  creating in the publishing tab 381
business time span editor
  about 600
  creating business time spans 601
  opening 600
business time spans
  about 380
Button Download 356
Button Group 320

C
Calendar 343
categories
  managing 466
  working with 498
chat management settings 410
Check Box 341
Check Box List 342
check in 458
check out 458
client tools  (continued)
  business timespan configuration page 652
  license status manager 606, 608
  log viewer 611
client tools
  log viewer page 611
  messaging console 613
  task tray tool 623
  webforms theme editor 635, 637
  workflow explorer 638–639
  workflow explorer credential page 651
  workflow explorer current running processes page 644
  workflow explorer log viewer page 651
  workflow explorer symq configuration page 641–643
  workflow explorer symq explorer page 645
comparing projects in Workflow Manager 137
component
datatypes 659
dynamic linked model 236
embedded model 233
embedded rule model 237
end 174
help 176
start 174
component editors 176
component generators 240
  about 261
  active directory 283
  adding an assembly 262
  custom workflow interaction 306–307
  DTD 278–279
  excel 280–282
  fast table 278
  filter 263
  filter generator 263
  fixed length generator 287–289
  fixed length generator (extended) 289–291
  LDAP generator 294
  multiple generator container 273–274
  query/script 265–269
  script 309–311
  separated values 291–294
  separated values (extended) 294
  sharepoint lists 284–286
  stored procedure caller 269, 271–273
  table 274–278
  user defined type generator 299, 303–306
  user defined type with data base mapping generator 301
  user defined type with database mapping generator 298–300, 302–303
component generators  (continued)
  web service caller 294–295, 297
  XML schema 280
component help
  accessing 176
component model variable name 237
component toolbox 154
  searching for components 154
component wiki pages
  accessing 176
  adding content to 177
  contributing to 177
components 179
  adding to a project 175
  connecting 175
  copy properties 179
  editors 176
  generate 259
  importing 215
  input and output variables 184
  linked and embedded model 226
  searching for in an open workflow project 156
  setting credentials 592
  workflow 173
configuration
  servers 60
configure database types
  storage preferences tab 196
configuring
  dedicated service account 92
  run-time service account 92
configuring IIS 213
configuring root URL 208
configuring Workflow
  process 99
context-sensitive help 36
copy components to model 179
copy properties 179
copy to model 179
create assignment (data mapping) 189–190
create integration library 259
creating
  reports 543
  creating a project model 223
  creating expected document messages in process manager 453
  creating versions of Projects
    checking in Projects
    to the Repository 142
credentials 572, 590, 603
  creating Deployment Server 591
  setting component 592
Credentials Manager
  adding credentials 604
  editing credentials 605
credentials manager
  about 603
critical errors 223
critical errors model 223
custom events 315
custom events on forms 315
custom workflow interaction generator
  about 306
    expose data from component page 307
    general information page 307
    result paths page 307
customization
  Process Manager page lists 427
  Process Manager pages 405–406
customization settings 411
D
data
  datatypes 182
  document 458
  input and output 183
  workflow designer 181
data hierarchy
  about 488
  creating a new category 489
  deleting a category 489–490
data hierarchy page
  about 488
data in building a Webform
  about 314
data management 479
data mapping
  about 185
  about data mapping assignments 189
  about data mapping conversions 189
  about the data mapping editor 186
  creating data mapping assignments 190
  opening the data mapping editor 187
data mapping assignments
  about 189
  creating 190
data mapping conversions
  about 189
datatype
- Help Desk asset 660
- Help Desk contact 661
- incident status 659
- item details 660
- power management command 660
- task details 661
- ticket category 662

datatypes
- about 182
- component 659

Date Picker 344
Date Time Picker 345
debugging configuration 632
Decision Only project type 149
deleting documents in process manager 461
Delivering a task
  - in an email 377
  - in Process Manager 377
deploying a project
  - Enterprise Management Deployment 203
deployment configuration 634
Deployment Server
  - connection settings 590
  - creating credential 591
Deployment Server credentials 590
design-time credentials 572, 590
Designer 152
designer
  - preferences 658
designer configuration 625–626
Dialog Workflow 373–375
  - delivering a task in an email 377
  - delivering a task in Process Manager 377
  - task assignment 376
directory
  - publishing 205
directory group
    - adding 655
directory servers
    - adding 654
Directory Servers Group
  - page 652
discussion
  - adding 472
  - adding a new thread 473
discussions 465
  - working with 472
displaying document history in process manager 450
document
  - add advanced 454
  - category and sub category 447
  - check in and check out 458
document category type page
  - about 488
document category types
  - working with 481
document management settings 412
document manager
  - about simple and advanced files 442
  - actions that you can perform on documents 441
  - adding a category 445
  - adding a document with components in a workflow project 462
  - adding a new document version 458
  - adding a simple file 443
  - adding an advanced file 444
  - adding documents to additional categories 451
  - creating expected document messages 453
  - deleting documents 461
  - displaying document history 450
  - documents page 440
  - downloading documents 455
  - downloading ZIP files of documents 456–457
  - editing a category 446–447, 449
  - editing document data 458
  - emailing documents 460
  - promoting a document version 459
  - searching for documents 445
  - setting category permissions for a document 452
  - setting document permissions 460
  - using the document viewer 451
  - viewing document versions 457
  - viewing documents 456
document sharing with Process Manager 433, 439–440
document type page
  - about 487
document types
  - about 392
  - working with 480
documentation 36, 214
documents tab
  - actions that you can perform 441
  - adding a document category 445
  - adding a document with components in a workflow project 462
  - adding a new document version 458
documents tab (continued)
   adding documents to additional categories 451
   creating expected document messages 453
   deleting documents 461
   displaying document history 450
   documents page 440
   downloading documents 455
   downloading ZIP files of documents 456–457
   editing a document category 446–447, 449
   editing document data 458
   emailing documents 460
   promoting a document version 459
   searching for documents 445
   setting category permissions for a document 452
   setting document permissions 460
   using the document viewer 451
   viewing document versions 457
   viewing documents 456

downloading
   Workflow Installer 74
   downloading documents in process manager 455
   downloading ZIP files of documents in process
      manager 456–457
Drop Down List 346
Drop Down Menu 321
DTD generator
   about 278
   file selecting page 279
   read/write components 279
   schema editing page 279
Dynamic Button 322
dynamic linked model component 236
Dynamic Update Panel 358

e 
edit tool preferences 212, 658
editing a document category in process
   manager 446–447, 449
editing credentials 605
editing document data in process manager 458
editing project information
   project description 136
   project name 136
   project tags 136
editing Workflow Designer preferences 624
email settings 412
emailing documents in process manager 460
embedded model (continued)
   set up 234
   embedded model component 233
   embedded rule 238
   embedded rule model component 237
   end component 174
   end components 238
   Enterprise Management Deployment 203
   escalation 378
   escalations 378
   escalations and timeouts 378
   escalations 379
   excel generator
      about 280
      customize columns page 282
      definitions editing 282
      definitions page 280
      null strings page 280
      read/write components 281
      rows 281
   exchange
      logging using workflow 640
      properties 650
      workflow configurations 641
   exchange configuration
      changing 642
   exchange properties 650
   exchanges
      about 646
      monitoring message 650
      symq 639
   extensions
      configuring 616
      configuring manually 621
F
failover
   for Service Catalog process 652
   mechanism 652
   setting up 653
failover group
   adding 655
FAQ
   adding 469
fast table generator
   about 278
files
   viewing messages in 651
filter generator
about 263
   types designer page 263
filtering and searching in Workflow Manager 135
filtering in Workflow Manager 135
fixed length generator
about 287
   date masks page 288
   definitions editing page 289
   null strings page 288
   read/write components page 289
fixed length generator (extended)
about 289
   date masks page 290
   definitions editing page 290
   read/write components page 291
form components
about 316
   common properties 316
form templates 370
   applying 371
   creating 370
form themes
about 365
   adding to a form 366
   best practices 369
   creating a theme 367
   editing a theme 367
Forms (Web) project type 150

G
generate components 259
generate reports 170
generating components 259
generator
   asdk 261
   report 262
   resource 262
   task 261
generators
about 261
   component 240
   Symantec Management Platform 573
global data tab 158, 169
Google Maps 339
Grid 354
group action 435
group membership
   viewing in Process Manager 520

H
help
   component 176
   context-sensitive 36
Help Desk asset datatype 660
Help Desk contact datatype 661
Hover Button 327
HTML Merge 330
HTMLEditor 330
HTMLEditorComponent 330

I
IIS
   configuring 213
Image Button 325
Image Button List 331
Image Map 326
import model 215
importing components 215
incident status datatype 659
input data 183
   adding 227
   mapping 229
Input File 357
input variables for components 184
installation
   information to collect 66
   installation configurations 49
   installer
      creating and running 205
   installing 65
      Process Manager 74
      Process Manager database 74
      Workflow 71, 73–74, 92
      Workflow Designer 74
      Workflow Server 74
Integrating 594
integating
   process manager with workflow designer 596
Integrating a workflow process with Active Directory 594
Integration 594
integration
   process manager 596
   workflow task with workflow designer 436
integration method
   Process Manager 436
integration project
   creating 247
Integration project type 152
item details datatype 660

K
knowledge base 465
   adding an article 467

L
LDAP generator
   about 294
libraries tab 158, 162
library
   adding components 180
license status manager
   about 606, 608
Line 353
Link Button 326
linked model 226
   set up 233
linked model component 228
List Box component 347
List Items 332
List Select 348
lists and profiles page 483
   adding a profile definition 483
   editing profiles 485–486
   viewing profiles 486
load balancing
   reconfigure Process Manager Sessions exchange to persist data to SQL 673
   reconfigure Workflow response queue to persist data to SQL 673
   Workflow environment 53
load testing
   running a load test 218
locking a project in the Repository 144
log viewer
   about 611
   opening 612
   sorting log messages by header 612
logging
   application 645

M
Mail to Button 333
managing credentials 603
manual publishing 207
mapping data
   about 185
   about data mapping assignments 189
   about data mapping conversions 189
   about the data mapping editor 186
   creating data mapping assignments 190
   object-relational mapping data types 195–196
   opening the data mapping editor 187
mapping input data 229
mapping output data 231
Mask Edit 334
master settings 406
message exchanges
   monitoring 650
messages
   viewing in files 651
messaging console
   about 613
metadata
   project 157
   mobile page 537
   creating 537
   mobile portal 537
model
   creating 223
   data contracts 227
   importing 215
   parent and child 225
   secondary 224
model components 225, 236
models 225
   about project models 222
   where they exist 225
models tab 158, 163
monitoring message exchanges 650
monitoring project
   starting and stopping as a task tray application 220
   Monitoring project type 152
   Monitoring Windows service
   starting and stopping 219
Monitoring-type project
   installing as a task tray application 206
   installing as a Windows service application 216
Monitoring-type Windows service
   starting and stopping 219
Multi State Image 360
Multiline Text Box 335
multiple generator container
  creating components in 273
  editing components in 274
multiple generator container generator
  generators management page 273
Multiple Value Mapping component
  opening the data mapping editor 188

N
new model 223
new project
  creating 134
not logged-in users settings 413
Notification Server computer
  configuration options 60
notifications settings 414
Numeric Stepper 336
Numeric Text Box 337

O
object-relational mapping data types
  about 194
  configuring 196
  using in a project 195
off-box SQL Server
  about hard drive configuration 55
opening an existing project in Workflow Manager 135
opening the data mapping editor 188
opening the log viewer 612
operating systems
  supported 60, 663
optimization settings 417
organizations
  managing 526
ORM data types
  about 194
  configuring 196
  using in a project 195
output data
  adding 234
output data 183
  configure 233
  mapping 231, 235
output variables for components 184

P
package project 216
Page Refresh Check 354
pages
  adding a root page 401
  importing 402–403
  managing 396
  viewing the settings of 401
Panel 333
permissions
  document 458
  managing 525
permissions in Process Manager 509
planning
  SQL Server configuration 54
plug-ins
  uploading 430
power management command datatype 660
preferences
  edit designer 658
process
  viewing 435
Process Manager 377
  about 385
  about permissions 509
  active directory groups 507
  adding a category in the documents tab 445
  adding a document category 445
  adding a document with components in a
    workflow project 462
  adding a new document version 458
  adding a new document version in the documents
    tab 458
  adding a new tab 401
  adding a web form to the service catalog 499
  adding a webservice to the service catalog 500
  adding documents to additional categories 451
  adding documents to additional categories in the
    documents tab 451
  adding or removing permissions for groups 514
  adding pages 397
  adding users to groups 513
  changing your password 520
  creating a new user 516
  creating expected document messages 453
  creating expected document messages in the
    documents tab 453
  creating groups 511
    add group dialog box 512
  customizing pages 404
  data hierarchy 488–490
  default groups and permissions 508
### Process Manager (continued)

- deleting documents 461
- deleting documents in the documents tab 461
- deleting groups 513
- displaying document history 450
- displaying document history in the documents tab 450
- document manager 433, 439, 442–444
- document manager documents page 440
- documents tab documents page 440
- downloading documents 455
- downloading documents in the documents tab 455
- downloading ZIP files of documents 456–457
- downloading ZIP files of documents in the documents tab 456–457
- editing a category in the documents tab 446–447, 449
- editing a document category 446–447, 449
- editing document data 458
- editing document data in the documents tab 458
- editing your user account 520
- emailing documents 460
- emailing documents in the documents tab 460
- group action 435
- integration method 436
- manage pages 396
- managing a user's groups 522
- managing a user's organizations 523
- managing a user's permissions 522
- managing users 521
- master settings 419, 535
- modifying groups 512
- opening 386
- opening a task by ID 434
- organizational units 515
- process view page 390, 392–393
- profiles 389
- promoting a document version 459
- promoting a document version in the documents tab 459
- run-time service account 73
- searching for documents 445
- searching for documents in the documents tab 445
- sending an email to a user 521
- service catalog 497
- setting category permissions for a document 452
- setting category permissions for a document in the documents tab 452
- setting document permissions 460
- setting document permissions in the documents tab 460
- setting up groups, permissions, and users 508
- setting your opening portal page 389
- settings 406, 416
- site actions 420
- symbols 389
- tabs 387
- tasks 388
- using the document viewer 451
- using the document viewer in the documents tab 451
- using with active directory 505
- viewing document versions 457
- viewing document versions in the documents tab 457
- viewing documents 456
- viewing documents in the documents tab 456
- viewing group membership 520
- viewing permissions 514
- viewing permissions for a group 515
- working with documents 441
- working with documents in the documents tab 441
- process manager integration 596
- Process Manager master settings about 419

### Process Manager master settings page 419, 535

### Process Manager page

- about 387
- adding web parts 422
- customizing 405–406
- editing web parts 423
- sharing 424
- process manager page customizing 404

### Process Manager page list

- customization options 428
- customizing 427
- report, changing 430

### Process Manager pages

- add page 399
- add page page 399
- adding 397
- customizing 404
Process Manager pages (continued)
deleting 426
exporting 427
modifying 425
moving up or down 427
Process Manager portal
pages 387
Process Manager task list
using in SharePoint 595
process type
creating 493
deleting 493
editing 493
process type action
adding to a process type 494
process type actions page
about 492
Process View page 436, 596
process view page 435
actions in 392
setting to automatically open the next task 393
setting up users to view 435
Process View pages
default sections 392
process view pages
about 390
profile reference type page
about 491
adding a profile reference type 491
profile settings 417
profiles
about 389
project
creating 134
creating integration 247
packaging 216
reloading 219
reports 170
testing 217
project data 158
project data tabs 158
viewing 170
project metadata
about 156
viewing 158
workflow designer 157
project metadata and property tabs
about 156
project model
creating 223
validate 214
project models
about 222
project properties
about 191
best practices 193
project start types 198
project tree
workflow designer 157
project type
decision only 149
Forms (Web) 150
Integration 152
Monitoring 152
Workflow 150
project types
Web Application 148
workflow designer 147
Project workspace 153
promoting a document version in process manager 459
properties
change workflow model 208
properties tab 167
property tabs
about 156
publish
to multiple Symantec Management Platform servers 212
publish application to server 197
publishing
formats 201
publishing a project manually 207
publishing a project
Enterprise Management Deployment 203
publishing a workflow 197
publishing an application manually 205
publishing directory 205
publishing formats 205
publishing tab 158, 164
Q
query/script generator
about 265
connection page 266
connection string page 267
query/script generator  (continued)
   fields page 269
   properties name page 268

R
Radio Button List 350
relationship types
   adding 482
Release Notes 36
reload project 219
report dialog box
   add/edit 557
report generator 262
report schedules
   adding 561
reporting tab 169
reports
   creating 543
   generating project 170
Reports page 542
reports settings 417
Repository
   adding a Project 141
   checking in a Project 141
   checking in a project 142
   checking out a Project 144
   configuring 145
   copying a Project to the Workflow Server 144
   importing a Project 141
   locking and unlocking a project 144
   viewing 140
   viewing changes to a Project 144
repository 587
resource generator 262
resource tab 158
resources tab 161
root URL
   configuring 208
run project 217
run time credentials 590
run-time credentials 572
run-time service account
   creating 73

S
scaling  (continued)
   Workflow server 52
schedule
   adding 475
   schedule to report
      applying 562
schedules
   working with 477
schedules to reports
   adding 562
screen capture 614
script generator
   about 309
   general information page 310
   input page 309
   result paths page 310
   script code page 311
   static variables page 310
searching for components in an open workflow
   project 156
searching for components in the component
   toolbox 154
searching for documents in Process Manager 445
searching in Workflow Manager 135
secondary model
   adding input data 227
secondary models 224
   adding output data to 228
security roles
   default 588
   default Workflow
      Symantec Management Console 588
      Workflow Enterprise Management page
      Symantec Management Console 588
separated values
   about 291
   definitions page 292
separated values (extended)
   about 294
separated values generator
   date masks page 293
   null strings page 292
   read/write components page 293–294
server
   add 654
   configuration options 60
   SQL 71
Server Extensions
   configuring 617
Server Extensions  
(configured)  
configuring with the configuration tool 617  
restarting 617  
Server Extensions Configurator 617  
service group  
adding 655  
service catalog 497  
Service Catalog failover  
setting up 653  
Service Catalog Request Template  
about 677  
part 1: planning your process 679  
part 2: creating a request process 683  
part 3: setting up the process and creating the  
aview and implementation tasks 695  
part 4: debugging the process, creating a process  
profile, and creating a report 706  
service catalog web form settings 500  
setting category permissions for a document in process  
manager 452  
setting document permissions in process  
manager 460  
settings  
Process Manager 406  
Share Page 424  
sharepoint lists generator  
about 284  
components page 286  
select lists page 285  
setup connection page 285  
Signal Dot Dashboard 361  
Single Value Mapping component  
opening the data mapping editor 188  
site aggregator page  
creating 400  
sizing  
Workflow for installation 50  
Solution Center  
download content 31  
Spell Check 328  
Spell Check Button 328  
SQL Server  
about database sizing 57  
about hard drive configuration for off-box 55  
about scaling 52  
memory management 58  
recommended hardware 59  
throughput metrics 56  
SQL server  
configuration options 60  
requirements 71  
SQL Server configuration  
planning 54  
start component 174  
start type 198  
start types 198  
status tracking 212  
storage preferences tab 168  
storage tab 158  
stored procedure caller generator  
about 269, 273  
connection page 269  
connection string page 271  
fields page 273  
properties name page 272  
studio configuration 625  
sub Dialog 359  
sub report  
adding 544  
sub-page  
adding 403  
support matrix  
Workflow 8.0 663  
supported operating systems  
Process Manager database 60  
Process Manager portal 60  
SQL Server 60  
Workflow 7.5 60  
Workflow Designer 60  
Workflow Server 60  
Symantec Deployment Server credentials 591  
Symantec Management Console 568  
Workflow Enterprise Management 574  
Symantec Management Console credentials 572  
Symantec Management Platform  
connecting with Workflow 569  
setting up Workflow Designer with 571  
symantec management platform  
credentials 603  
Symantec Management Platform generators 573  
Symantec Workflow 39  
about 39  
about installing 46  
installing for the first time 65  
process for configuring 99  
process for installing 65
symbols
  Process Manager 389
symq 646
  about 639
symq configuration page
  adding a new exchange 643
  adding a new exchange configuration 642
  managing exchanges 643
sync profile
  Active Directory, adding 119
  Active Directory, deleting 124
  Active Directory, editing 122
sync profile schedule
  Active Directory, editing 115
sync profile schedules
  Active Directory, adding 113
  Active Directory, deleting 116
  Active Directory, managing 112
synchronization methods
  Active Directory 125
synchronization of Active Directory. See Active Directory synchronization

T
table generator
  about 274
  components page 277
  connection page 275
  connection string page 276
  select components page 278
tabs
  global data 169
  libraries 162
  models 163
  properties 167
  publishing 164
  resources 161
  storage preferences 168
tag cloud 394
task 373
  delegating 434
Task assignment 376
task details datatype 661
task generator 261
task integration 373–374
  workflow 436
task source 373, 375
task tray application
  (continued)
  monitoring project 220
  Monitoring-type project 206
task tray tool
  about 623
tasks 373
  escalations and timeouts 378
  opening in Process Manager by ID 434
  performing an action on more than one at a time 435
template component model 236
testing a project 217
Text Box 338
text box components
  about 362
  themes 365–367, 369
thisformdata
  about 315
ticket category datatype 662
Time Picker 351
timeline
  adding to a process type 495
timeout 378
timeouts 378–379
toolbox
  component 154
  track status 212
tree
  workflow designer project 157
types
  workflow 171

U
unlocking a project in the Repository 144
upgrading
  process for 94
  Workflow 96
user
  adding 516
  enabling or disabling in Process Manager 519
user defined type generator
  about 303
  adding a property to a data type 305
  adding a sub data type to a data type 305
  settings page 306
  types designer page 304
user defined type with data base mapping generator
  adding a sub data type to a data type 301
user defined type with database mapping generator
  about 298
  adding a choice list 302
  adding a property to a data type 300
  components page 303
  indexes page 302
  settings page 303
  types designer page 299
user relationship type page
  about 491
user relationship types
  adding 482
users
  changing your password in Process Manager 520
  editing your account in Process Manager 520
  managing groups 522
  managing in Process Manager 521
  managing organizations 523
  managing permissions 522
  manually adding to Process Manager from Active Directory 518
  modifying data in Process Manager 519
  working with 524
using tasks 373
using the document viewer in process manager 451

V
validate
  project model 214
version
  document 458
viewing document versions in process manager 457
viewing documents in process manager 456
viewing project data tabs 170
viewing project metadata 158
viewing the Repository 140

W
Web Application
  project types 148
web form
  adding 499
web part
  adding to Process Manager page 422
  editing on Process Manager page 423
web part catalogs
  adding 431
  working with 431
web service caller generator
  about 294
  namespaces and categories page 295
  properties page 297
  select components page 297
  select URLs page 295
Webforms
  about 313
  about creating 313
webforms theme editor
  about 635
  opening 637
webservice
  adding 500
webservice settings 502
what you can do with Workflow 30
wiki
  adding 468
Windows service application
  Monitoring-type project 216
Workflow 568
  about 28, 30
  about load balancing 53
  about scaling 50
  how it works 29
  installing 74
  project type 150
  sizing to meet organizational needs 50
workflow
  exchange configurations 641
  exchange logging 640
  installing 65
  publishing 197
  running on NS 171
  status tracking 212
  types 171
Workflow 6.x
  process for upgrading 94
Workflow 7.x
  process for upgrading 94
workflow components
  about 173
Workflow computer
  accounts 69
  firewall security 69
  server roles 69
  setting up 69
  web services 69
Workflow Designer
  about 41
  setting up to use with the Symantec Management Platform 571
  tool 152
workflow designer 214
  data 181
  documentation 214
  preferences 658
  project tree 157
  project types 147
Workflow Designer preferences
  debugging page 632
  deployment page 634
  designer page 626
  editing 624
  studio configuration page 625
Workflow Designer tool 152
Workflow Enterprise Management
  repository page 587
Workflow Enterprise Management page 574
  adding a server to a Workflow Environment 582
  adding a Workflow Environment 578
  deleting a Workflow Environment 582
  editing a Workflow Environment 579
  environment page 576
  published workflows page 587
  publishing a workflow 585
  removing a server from a Workflow Environment 583
  unpublishing a workflow 585
  updating the project properties of a workflow 586
workflow servers page 583
workflow environment
  validate 581
Workflow environments
  About 576
workflow explorer
  about 638
  adding a new exchange 643
  adding a new exchange configuration 642
  business timespan configuration page 652
  credential page 651
  current running processes page 644
  log viewer page 611, 651
  managing exchanges 643
  symq configuration page 641
  symq explorer page 645
  viewing 639
Workflow Installer
  downloading 74
Workflow Manager
  about 132
  comparing projects 137
  creating a new folder 134
  editing project information 136
  filtering and searching 135
  opening 133
  opening an existing project 135
workflow model
  change properties 208
  importing 215
workflow project
  packaging 216
  reloading 219
  reports 170
Workflow Repository
  about 138
Workflow Server
  about 42
Workflow server
  about scaling 52
  configuration options 60
workflow settings 419
workflow task 373
workflow task integration 436
workflow tasks 373
Workspace 153
X
XML schema generator
  about 280
Z
zip file
  publishing 205